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Installing and upgrading (V5.2.6 or later)

Guidance and instructions are provided for installing or upgrading Sterling B2B
Integrator V5.2.6 or later on all supported platforms.

Installing (V5.2.6 or later)
Install the Sterling B2B Integrator V5.2.6 release.

Windows Cluster Environment Installation (V5.2.6 or later)
You will follow different installation and upgrade scenarios when you install and
upgrade Sterling B2B Integrator in a Windows Cluster (multiple node)
environment, depending on the version you currently have installed.

Installation Scenarios

Review the following installation scenarios and decide which one matches your
current installation, and upgrade path.

Scenario Instructions

Version 5.1.x is installed and it needs to be
upgraded to V5.2.6.

See “Upgrading (V5.2.6 or later)” on page
320

Version 5.2.x is installed and it needs to be
upgraded to V5.2.6.

See Applying a fix pack (V5.2.6 or later)

Version 5.2.6 is being installed as the base
release.

Review this document and use the
installation instructions.

Prerequisite Knowledge for Windows Installation
Before you begin the installation, you should be knowledgeable on the following
topics:
v Application servers
v Database administration
v System Requirements for this release of Sterling B2B Integrator.

Intended audience:

This document can be used by different members of your organization.

This document is intended for use by:
v System administrators
v Installation engineers
v Database administrators.

Assumptions for this guide:

The procedures in this guide are accurate as of the publication date and are
specific to this version of the document.
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Before You Begin the Installation in a Windows Environment
Before you begin the installation, you need to:
v Perform some system verification tasks.
v Obtain the correct version of the JDK, JCE, and JDBC drivers required. Most

Java files required are provided with the product download or media. See the
System Requirements for more information.

System Verification Tasks for a Windows Environment: Before you begin an
installation, you need to:

# System Verification Items Your Notes

1 Use the system requirements to verify that your
system hardware and software meet the
requirements specified for this release.

Verify you have the correct:

v Patches required by Java™ for the operation
system

v Version of the JDK

v Absolute path to JDK and patches

2 Verify the file system has adequate free disk space.

3 Verify that your database has been installed and
configured.

If you are going to manually apply DDL
statements, you need to complete the data base
schema work before you begin the installation.

4 If you are using a non-English environment,
confirm that you are using the appropriate
character set.

Verification of the system requirements:

Before you begin the installation, verify that your system meets the hardware and
software requirements that are specified for this release.

The hardware requirements that are listed in the System Requirements are the
minimum requirements. Your system requirements might exceed these
requirements if you are running other applications on the same machine as Sterling
B2B Integrator.

The installation strictly enforces the following system requirements:
v Operating system version must match requirement exactly.
v The minimum patch level for the operating system is enforced, but you can

apply higher patch levels.
v JDK version must match requirement exactly.
v The disk space is a minimum for the installation. The system must be separately

sized to handle whatever load is going to be put on the system.
v Database version must match exactly.
v JDBC driver version supports exact matches and wildcard matches.

If any of these requirements are not met, the installation fails. If the installation
fails, review the installation log for a list of non-compliant items.
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Upgrading your JDK (Windows and UNIX):

Sometimes you need to upgrade your JDK version to support a new version of
Sterling B2B Integrator.

About this task

If you have V5.2.4.1 or higher installed, you can use the upgradeJDK script to
upgrade your version of the JDK. See bin Directory Files for more information.

If you have V5.2.4.0 or lower installed, follow the steps below to upgrade your
JDK.

Procedure

1. Download the new JCE file. For example, the UnrestrictedPolicy.zip policy
file for the IBM JDK.

2. Back up the existing JDK in <Install Dir>/jdk. Change the folder name to
jdk_back)

3. Copy the new IBM JDK (1.7.0 ) folder to the installation Directory. Directory
Name should be jdk )

4. Copy all the jars present in <Install Dir >jdk_back\jre\lib\ext to <install
Dir>jdk\jre\lib\ext directory.

5. If your installation of V5.2.4 or lower was built using the Oracle (SUN) JDK,
continue to the next step. Otherwise skip to step 6.
a. Edit the sandbox.cfg property file.
b. Set JCE_DIST_FILE=<New Path of Supported JCE File>. For example,

JCE_DIST_FILE=D\:\\IBM\\unrestrictedpolicyfiles.zip.
c. Back up the local_policy.jar and US_export_policy.jar files present in

<Install Dir>jdk\jre\lib\security.
d. Unzip the new JCE file. For example, Unrestrictedpolicyfiles.zip file.

Copy local_policy.jar and US_export_policy.jar to <Install
Dir>jdk\jre\lib\security.

6. Run updateJavaSecurity.cmd <path_to_new_jdk><Install Dir>/jdk.
7. Verify that security providers have been updated in <Install

Dir>\jdk\jre\lib\security\java.security.
8. Follow the Upgrade Guide instructions for your upgrade scenario.

Configure the Database
You must install, create, and configure a database so that each Sterling B2B
Integrator instance has a dedicated schema and login for the database.

In a clustered environment, Sterling B2B Integrator can support the following
databases:
v DB2®

v Oracle®

v Microsoft SQL Server

See System Requirements for supported version information.
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Required database information before you install Sterling B2B Integrator in a
cluster environment:

Before you begin to install Sterling B2B Integrator, you need to install and
configure your database.

Review and gather the following information. An x indicates that the information
is required.

Information to Gather Oracle DB2

Microsoft
SQL
Server

Record Information
Here

Application Instance Host

Application Instance Port

Database User Name x x x

Database Password x x x

Database Catalog Name x x x

Database Host x x x

Database Port x x x

JDBC Driver #1 x x x

Use BLOB data? x x

Enable Multibyte Support? x x x

Database sizing and capacity planning:

Database sizing is designed to give you estimates of the database growth and to
help you plan the disk requirements.

There are many factors to consider when you are estimating the amount of disk
space that is required for Sterling B2B Integrator. As a result, trying to consider all
growth factors is impractical because the user might not know the answers to
many questions that are required to do a detailed forecast. Over the years the cost
of disks has dramatically decreased, and the capacity and speed of disks has
increased. The method of how information system managers order disk capacity
also has changed, from purchasing disk arrays that are dedicated to a particular
database server and project, to the concept of SANS (storage area networks).

Consider the confidence that you have in your data estimates when you are
making the final purchase decision and adjust accordingly. After the initial
purchase and production deployment, disk growth should be tracked for future
purchase forecasts.

You should track your actual database storage usage and the number of database
records regularly. Correlating these two metrics enabled you to plan your future
disk requirements. Moreover, determining the average amount of space used for
each order line or shipment line, enables you to accurately predict your future
growth requirements.

Database Definition Language (DDL) Statements: When you install Sterling B2B
Integrator, you can manually apply Database Definition Language (DDL)
statements to your database tables instead of requiring the installation process to
do it directly.
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This feature increases database security by reducing the database permissions of
the Sterling B2B Integrator database user. The rights to database objects can be
reserved for a secure user like a customer database administrator (DBA). A
business can require that only a DBA with the proper permissions can make
database changes.

Configuring the DB2 Database:

Before you install Sterling B2B Integrator with the DB2 database, you must
configure the database.

Before you begin:
v If you do not have DB2 installed, follow the procedures in the DB2 installation

manual.
v The installation script creates tables and indexes. Certain tables require a page

size of 32 KB. You must have a temporary table space to accommodate such
tables. DB2 automatically places tables and indexes in the available table spaces.
You can move the tables to a different table space after the installation is
complete.

v If you are reinstalling the software, be aware that data in your existing database
is deleted. To preserve the data, either back up the existing database or save it
under a different name.

v After you create and configure your database, recycle the database. Then, stop
and restart the database to apply the changes.

Use the following checklist to configure DB2 for Sterling B2B Integrator:

Item DB2 Database Configuration Checklist Your Notes

1 Create the database.

Refer to the DB2 documentation on creating the
database, including creating a schema repository,
login, and table space.
Important: In V5.2.6.2 or later you must ensure
that all tablespaces used by Sterling B2B
Integrator tables have a minimum page size of
8K. Otherwise installation will fail.

Be sure to install the correct version and patches.
See the System Requirements for supported
version information.

3 Review the DB2 parameters.

4 Ensure that the DB2 user privileges are set.

5 Install the JDBC drivers for DB2.

DB2 database user privileges:

The DBADM role is required to perform administrative operations in DB2
database.

DB2 parameters:

When you install Sterling B2B Integrator with the DB2 database, you must set
certain DB2 parameters. Other DB2 parameter settings are recommended for the
efficient performance of Sterling B2B Integrator.
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When you install Sterling B2B Integrator with DB2, you must set the DB2
parameters that are listed in the following topics:
v “Mandatory settings for IBM DB2 registry variables”
v “Mandatory settings for DB CFG parameters”

After you install Sterling B2B Integrator with DB2, you can improve the DB2
database performance by setting the recommended parameters that are listed in the
performance documentation for the following items:
v DB2 registry variables
v DBM CFG parameters
v DB CFG parameters
v DB2 for Linux on System z®

v DB2 for LUW configuration and monitoring

Mandatory settings for IBM DB2 registry variables:

Mandatory IBM® DB2 registry values are critical for IBM DB2 performance with
Sterling B2B Integrator.

Variable Mandatory value

DB2_SKIPDELETED ON

Allows index-range queries or table-scan queries to skip
records that are in an uncommitted delete state. This
reduces the amount of lock contention from Read Share
and Next Key Share locks from range queries in tables
with a high frequency of deletes.

When enabled, DB2_SKIPDELETED allows, where
possible, table or index access scans to defer or avoid
row locking until a data record is known to satisfy
predicate evaluation. This allows predicate evaluation
to occur on uncommitted data.

This variable is applicable only to statements using
either Cursor Stability or Read Stability isolation levels.
For index scans, the index must be a type-2 index.
Deleted rows are skipped unconditionally on table scan
access while deleted keys are not skipped for type-2
index scans unless DB2_SKIPDELETED is also set.

Recommended value: ON

DB2_SKIPINSERTED ON

Allows SELECTs with Cursor Stability or Read Stability
isolation levels to skip uncommitted inserted rows. This
reduces record lock contention on tables with heavy
insert rates.

Mandatory settings for DB CFG parameters:

For optimal performance, certain parameters and values are mandatory for DB2.

Parameter Mandatory value

Database Code Set UTF-8
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Installing JDBC drivers for DB2:

When you install Sterling B2B Integrator with the DB2 database, you must install a
JDBC driver for the database.

About this task

For DB2, install the appropriate DB2 JDBC Type 4 driver and any correlating
patches. For the supported version information, see System Requirements.

You can obtain these files from the IBM website. After you obtain this JDBC driver,
record the absolute path to its location on your system. You must supply this
absolute path during installation.

If the JDBC driver provided by your database vendor is distributed among
multiple files, you must place all the files that comprise the JDBC driver into one
JAR file. Follow these steps to create one JAR file:

Procedure

To install a JDBC driver for the DB2 database:
1. Identify all the vendor database JAR files for the JDBC driver.
2. Record the absolute path to the JAR file you created on the Preinstallation

Checklist.
The Type 4 driver does not require a separate Java™ listener to be running on
the database server. Instead, connect directly to the DB2 port.

Upgrading DB2 to version 10.1 or 10.5:

To upgrade from DB2 9.5 or 9.7 to 10.1 or 10.5, you must make configuration
changes.

Procedure

To upgrade from DB2 9.5 or 9.7 to 10.1 or 10.5:
1. Copy your DB2 9.5 or 9.7 database content to DB2 10.1 or 10.5.

Attention: Back up all files before you change any settings.
2. Back up the database driver in the /install_dir/dbjar/jdbc/DB2/ directory

and replace it with the DB2 10.1 or 10.5 version.
3. Update the following sandbox.cfg file fields with your environment-specific

parameters:
DB_PASS=
DB_SCHEMA_OWNER=
DB_DRIVERS_VERSION=
YANTRA_DB_PORT=
DB_DATA=
DB_HOST=
YANTRA_DB_USER=
DB_PORT=
YANTRA_DB_PASS=
YANTRA_DB_DATA=
YANTRA_DB_HOST=
DB_DRIVERS=
DB_USER=

DB2_PORT=
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DB2_USER=
DB2_PASS=
DB2_DATA=
DB2_HOST=

4. Edit the following value in the activemq.xml file:
activemq.xml: <value>jdbc:db2//DB_HOST:DB_PORT/DB_DATA</value>

5. Run the setupfiles script.
6. Run the deployer script.
7. Start Sterling B2B Integrator.

Configuring the Oracle Database:

Before you install Sterling B2B Integrator with the Oracle database, you must
configure the database.

Before you begin

v If you are reinstalling the software, be aware that data in your existing database
is deleted. To prevent this deletion, either back up the existing database or save
it under a different name.

v After you create and configure your database, recycle the database. Then, stop
and restart to apply the changes.

About this task

Use the following checklist to configure Oracle for Sterling B2B Integrator:

Item
Oracle Database Configuration
Checklist Your Notes

1 Create the database.

Refer to the Oracle documentation
on creating the database, including
creating a schema repository, login,
and table space.

Be sure to install the correct version
and patches.

See the System Requirements for the
supported version information.

2 Configure an Oracle Instance.

3 Configure Oracle Rollback.

4 Install the Oracle JDBC Driver.

5 Enable Failover in a Multiple Node
Oracle RAC Database Cluster.

6 After Sterling B2B Integrator is
installed, if you want to encrypt the
data traffic, perform one of the
following tasks:

v Configure Sterling B2B Integrator
for Data Traffic Encryption

v Configure Sterling B2B Integrator
for Data Traffic Encryption with
SSL
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Configuring an Oracle instance:

An Oracle database requires certain parameter settings and other configurations.

Before you begin

v You must have the Oracle database installed. Ensure that you have installed the
correct versions and patches. See System Requirements for supported version
information.

v Ensure that the user responsible for creating and modifying the Oracle database
has a specified quota (extent) assigned in the table space, even if the user was
assigned an unlimited table space. Otherwise, the installer might display the
error ORA-09150: no privileges on tablespace name.

Procedure

1. Run the create instance procedure. Use AL32UTF8 as the character set.
2. Configure the INIT<INSTANCE_NAME>.ORA file with the recommended and

mandatory settings in the Performance Management guide. See the Oracle init
parameter configuration checklist for specific settings.

Note: After you complete the installation of Sterling B2B Integrator with
Oracle, you can improve the performance of the database with the settings
listed in the Performance Management guide.

3. Identify or create a table space for user tables and indexes.
4. Create a user. Unless stated for a task, the user does not require database

administrator (DBA) privileges.
5. Grant permissions to the user. The following permissions are required for the

administrative user for creating and modifying the Oracle database:
v GRANT "CONNECT" TO SI_USER

v ALTER USER SI_USER DEFAULT ROLE "CONNECT"

v GRANT CREATE SEQUENCE TO SI_USER

v GRANT CREATE TABLE TO SI_USER

v GRANT CREATE TRIGGER TO SI_USER

v GRANT SELECT ON CTXSYS.CTX_USER_INDEXES TO SI_USER

v GRANT SELECT ON SYS.DBA_DATA_FILES TO SI_USER

v GRANT SELECT ON SYS.DBA_FREE_SPACE TO SI_USER

v GRANT SELECT ON SYS.DBA_USERS TO SI_USER

v GRANT SELECT ON SYS.V_$PARAMETER TO SI_USER

v GRANT SELECT ANY DICTIONARY TO SI_USER

v GRANT ALTER SESSION TO SI_USER

v GRANT CREATE SESSION TO SI_USER

6. If you are using Oracle AQ, grant the AQ_ADMINISTRATOR_ROLE
permission.

7. If you plan to use EBICS Client, grant the GRANT CREATE VIEW TO SI_USER
permission.

Configuring Oracle rollback:

The configuration of rollback in an Oracle database helps you manage database
transactions.
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About this task

You can roll back changes in Oracle by using AUTO UNDO management. IBM
recommends that you use this option. This practice avoids any manual monitoring
of UNDO segments.

Installation of the Oracle JDBC driver:

Sterling B2B Integrator requires the appropriate JDBC driver for the Oracle
database.

The JDBC drivers are thin client-based pure Java JDBC drivers. See System
Requirements for supported version information. The supported versions of the
JDBC driver build the correct Sterling B2B Integrator directory structure.

Enabling failover in a multiple node Oracle RAC database cluster:

You can enable failover in a multiple node Oracle RAC database cluster in
UNIX/Linux by using traditional RAC or RAC with SCAN.

Procedure

To enable failover in a multiple node Oracle RAC database cluster:
1. Open the /install_dir/install/properties directory to modify the

sandbox.cfg file.
2. In the sandbox.cfg file, add a ORACLE_JDBC_URL property, which contains the

Oracle RAC connection URL.
Choose one of the following depending on whether you are using traditional
RAC or RAC with SCAN. The property value must be one string of text that
starts with ORACLE_JDBC_URL=. Your database administrator (DBA) can modify
this URL as needed:
v To configure traditional RAC, use this format:

jdbc:oracle:thin:@
(DESCRIPTION=
(ADDRESS_LIST=
(FAILOVER=ON)
(LOAD_BALANCE=OFF)
(ADDRESS=(PROTOCOL=TCP)(HOST=myhost1)(PORT=1521))
(ADDRESS=(PROTOCOL=TCP)(HOST=myhost2)(PORT=1521))
)
(CONNECT_DATA = (SERVER = DEDICATED)(SERVICE_NAME=myservicename OR mySID))
)

Note: This method uses the default Oracle RAC service that is provided by
Oracle.

v To configure RAC with SCAN, use this format:
jdbc:oracle:thin:@host:port/service

For example:
jdbc:oracle:thin:@RAC-SCAN:1521/ORCL

Where:
– RAC-SCAN is resolved to an IP address by DNS
– 1521 = Port number
– ORCL = the name of your Oracle RAC service
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Important: To use RAC with SCAN, you must also define a new Oracle
RAC service (you cannot use the default service) that defines one node as
the preferred node and at least one node as a failover node.

3. Open the /install_dir/install/bin directory.
4. Enter the command ./setupfiles.sh.

Data traffic encryption in the Oracle database:

You can encrypt transactions between Sterling B2B Integrator and the Oracle
database. Encryption prevents anyone who is outside the system from viewing the
data that flows between Sterling B2B Integrator and the database.

The following list describes important aspects of enabling database encryption:
v At installation, encryption is turned off by default. If you want your database

transactions to be encrypted, you must enable encryption.
v The encryption can be enabled at any time.
v Encryption applies to all database transactions between Sterling B2B Integrator

and the database.

System performance might be impacted when encryption is enabled. The extent of
this impact depends on your hardware, database configuration, transaction
volume, and the relative amount of processing time that is spent by the system
against other activities.

For more information on data traffic configuration, see SSL With Oracle JDBC Thin
Driver.

Before you encrypt data traffic for the Oracle database:

The decision to encrypt data traffic for the Oracle database includes several
considerations.

Consider the following items when you configure database traffic encryption:
v Sterling B2B Integrator must be installed in TCP (clear) mode before you can

configure encryption.
v Perform these changes to your database before you install Sterling B2B

Integrator.
v Configure wallets for encryption-only mode even if the wallet that is used is

empty. Enable auto login for all wallets.
v If you want to use SSL for encryption only, it is recommended to follow the

instructions in the "CASE #1: USE SSL FOR ENCRYPTION ONLY" section of the
Oracle documentation. It is not necessary to configure certificates for the wallet.
In this mode, Diffie-Hellman ciphers are used. The server and the client are not
authenticated through SSL. You must authenticate by using a user name and a
password. However, if you are running Sterling B2B Integrator on an operating
system that requires an IBM JDK, you cannot use this mode, as IBM JSSE
TrustManager does not permit anonymous ciphers. You must configure wallets
with certificates.

v If you want to use SSL for encryption and for server authentication, it is
recommended to follow the instructions in the "CASE #2: USE SSL FOR
ENCRYPTION AND SERVER AUTHENTICATION" section of the Oracle
documentation.
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v If you want to use SSL for encryption and for server authentication of both tiers,
it is recommended to follow the instructions in the Oracle "CASE #3: USE SSL
FOR ENCRYPTION AND AUTHENTICATION OF BOTH TIERS" section of the
Oracle documentation, depending on how you intend to configure client or
server authentication.

v After you configure your database for data traffic encryption, the database
accepts both TCP (clear) and TCPS (encrypted) connections.

v There is a known issue in the Oracle 11g database when the listener is
configured only for TCPS. The lsnrctl utility that is used to start and stop
database listeners attempts to contact the listener, which is enabled first. You
should define the address list of the listener to contact either TCP or IPC before
it contacts TCPS.

Configuring Sterling B2B Integrator for data traffic encryption in Oracle:

You can enable data traffic encryption-only, with anonymous authentication, and
not SSL authentication.

About this task

If you want to use SSL for encryption only, it is recommended to follow the
instructions in the "CASE #1: USE SSL FOR ENCRYPTION ONLY" section of the
Oracle documentation. It is not necessary to configure certificates for the wallet. In
this mode, Diffie-Hellman ciphers are used, and the server and the client are not
authenticated through SSL. You must authenticate by using a user name and a
password.

However, if you are running Sterling B2B Integrator on a system that requires an
IBM JDK, you cannot use this mode, as IBM JSSE TrustManager does not permit
anonymous ciphers. You must configure wallets with certificates.

This procedure is applicable only if you are running Sterling B2B Integrator on a
system that requires Sun JDK. The IBM JSSE TrustManager does not permit
anonymous ciphers.

If your Sterling B2B Integrator is a cluster installation, you need to perform this
procedure on each node, starting with node 1.

Procedure

To configure Sterling B2B Integrator for data traffic encryption in Oracle:
1. Install Sterling B2B Integrator in TCP (clear) mode.
2. Stop Sterling B2B Integrator.
3. Open the /install_dir/install/properties directory.
4. Open the customer_overrides.properties file and add the following database

connection information:
jdbcService.oraclePool.prop_oracle.net.ssl_cipher_suites=
(SSL_DH_anon_WITH_3DES_EDE_CBC_SHA, SSL_DH_anon_WITH_DES_CBC_SHA)
jdbcService.oraclePool.prop_oracle.net.ssl_server_dn_match=false

If you have a configured container, ensure that the same database information
is added to the customer_overrides.properties.in file. To locate the file,
navigate to the /install_dir/install/properties/nodexACy directory, where x
gives the node number and y gives the container number. Perform this step
for all the containers configured in the system.
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5. Repeat Step 4 for the following Oracle connection pools by changing only the
pool name:
v oraclePool_local

v oraclePool_NoTrans

v oracleArchivePool

v oracleUIPool

If you have any other database pools, you need to add the properties for those
pools.

6. Open the sandbox.cfg file and change the database connection information as
shown:
ORACLE_JDBC_URL= jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS=(PROTOCOL=tcps)
(HOST=<DB host>)(PORT=<TCPS port as configured in DB config section above>))
(CONNECT_DATA=(SERVICE_NAME=<service name>)))

Make sure that you enter values for the HOST, PORT, and SERVICE_NAME
parameters.

7. Open the activemqconfig.xml.in file and modify the following database
connection information:
v Remove or comment out the following default ActiveMQ database

configuration information:
<bean id="gis-ds" class="org.apache.commons.dbcp.BasicDataSource"
destroy-method="close" singleton="true" lazy-init="default"
autowire="default" dependency-check="default"
SCIOverrideName="persistence-bean">

<property name="driverClassName">
<value>oracle.jdbc.driver.OracleDriver</value>
</property>
<property name="url">
#:ifdef ORACLE_JDBC_URL
<value>&ORACLE_JDBC_URL;</value>
#:else
<value>jdbc:oracle:thin:@&ORA_HOST;:&ORA_PORT;:&ORA_DATA;</value>
#:endif
</property>
<property name="username">
<value>&ORA_USER;</value>
</property>
<property name="password">
<value>&ORA_PASS;</value>
</property>
<property name="maxActive">
<value>32</value>
</property>
</bean>

v Add the following ActiveMQ database configuration information:
<bean id="gis-ds"
class="oracle.jdbc.pool.OracleDataSource" destroy-method="close"
singleton="true" lazy-init="default"
autowire="default"
dependency-check="default">
<property name="URL"><value>&ORACLE_JDBC_URL;</value></property>
<property name="user"><value>&ORA_USER;</value></property>
<property name="password"><value>&ORA_PASS;</value></property>
<property name="connectionProperties">
<value> oracle.net.ssl_cipher_suites:

(SSL_DH_anon_WITH_3DES_EDE_CBC_SHA, SSL_DH_anon_WITH_DES_CBC_SHA)
oracle.net.ssl_client_authentication: false
oracle.net.ssl_version: 3.0
driverClassName:oracle.jdbc.driver.OracleDriver

Installing and upgrading (V5.2.6 or later) 13



maxActive: 32
</value>

</property>
</bean>

8. Open the /install_dir/install/bin directory.
9. Enter the command ./setupfiles.sh.

10. Restart Sterling B2B Integrator. All the database connections from Sterling B2B
Integrator are now connected through TCPS (encrypted) mode.

Configuring Sterling B2B Integrator for data traffic encryption with SSL authentication in
Oracle:

You can enable data traffic encryption and SSL authentication.

About this task

This procedure is applicable if you are running Sterling B2B Integrator on a system
that requires either Sun JDK or IBM JDK.

The example in this procedure uses two-way SSL authentication. It is
recommended to follow the instructions in the "CASE #2: USE SSL FOR
ENCRYPTION AND SERVER AUTHENTICATION" section of the Oracle
documentation.

You can also configure one-way SSL authentication. If you want to use SSL for
encryption and for server authentication of both tiers, it is recommended to follow
the instructions in the "CASE #3: USE SSL FOR ENCRYPTION AND
AUTHENTICATION OF BOTH TIERS" section of the Oracle documentation.

If your installation of Sterling B2B Integrator is a cluster installation, you need to
perform this procedure on each node, starting with node 1.

Procedure

To configure Sterling B2B Integrator for data traffic encryption with SSL
authentication in Oracle:
1. Install Sterling B2B Integrator in TCP (clear) mode.
2. Stop Sterling B2B Integrator.
3. Open the /install_dir/install/properties directory.
4. Open the customer_overrides.properties file and add the following database

connection information:
jdbcService.oraclePool.prop_javax.net.ssl.trustStore=/.../path/.../ClientKeyStore.jks
jdbcService.oraclePool.prop_javax.net.ssl.trustStoreType=JKS
jdbcService.oraclePool.prop_javax.net.ssl.trustStorePassword=password
jdbcService.oraclePool.prop_oracle.net.ssl_version=3.0
jdbcService.oraclePool.prop_javax.net.ssl.keyStore=/.../path/.../ClientKeyStore.jks
jdbcService.oraclePool.prop_javax.net.ssl.keyStoreType=JKS
jdbcService.oraclePool.prop_javax.net.ssl.keyStorePassword=password

5. Repeat step 4 for the following Oracle connection pools by changing only the
pool name:
v oraclePool_local

v oraclePool_NoTrans

v oracleArchivePool

v oracleUIPool
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If you have any other database pools, you need to add the properties for those
pools.

6. Open the sandbox.cfg file and change the database connection information to
the following value:
ORACLE_JDBC_URL= jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS=(PROTOCOL=tcps)
(HOST=<DB host>)(PORT=<TCPS port as configured in DB config section above>))
(CONNECT_DATA=(SERVICE_NAME=<service name>)))

7. Open the /install_dir/install/activemq/conf directory.
8. Open the activemqconfig.xml.in file and modify the database connection

information:
v Remove or comment out the following default ActiveMQ database

configuration information:
#:ifdef ORACLE
<bean id="gis-ds" class="org.apache.commons.dbcp.BasicDataSource"

destroy-method="close" singleton="true" lazy-init="default"
autowire="default" dependency-check="default"

SCIOverrideName="persistence-bean">
<property name="driverClassName">
<value>oracle.jdbc.driver.OracleDriver</value>
</property>
<property name="url">
#:ifdef ORACLE_JDBC_URL
<value>&ORACLE_JDBC_URL;</value>
#:else
<value>jdbc:oracle:thin:@&ORA_HOST;:&ORA_PORT;:&ORA_DATA;</value>
#:endif
</property>
<property name="username">
<value>&ORA_USER;</value>
</property>
<property name="password"><value>&ORA_PASS;</value>
</property>
<property name="maxActive"><value>32</value>
</property>
</bean>
#:endif

v Add the following ActiveMQ database configuration information:
<bean id="gis-ds"
class="oracle.jdbc.pool.OracleDataSource" destroy-method="close"
singleton="true" lazy-init="default" autowire="default"
dependency-check="default">
<property name="URL"><value>&ORACLE_JDBC_URL;</value></property>
<property name="user"><value>&ORA_USER;</value></property>
<property name="password"><value>&ORA_PASS;</value></property>
<property name="connectionProperties"><value>
javax.net.ssl.trustStore: /.../path/.../ClientKeyStore.jks
javax.net.ssl.trustStoreType:JKS
javax.net.ssl.trustStorePassword:password
oracle.net.ssl_version:3.0
javax.net.ssl.keyStore: /.../path/.../ClientKeyStore.jks
javax.net.ssl.keyStoreType:JKS
javax.net.ssl.keyStorePassword: password
driverClassName:oracle.jdbc.driver.OracleDriver
maxActive:32
</value>
</property>
</bean>

9. Enter the command ./setupfiles.sh.
10. Restart Sterling B2B Integrator. All the database connections from Sterling B2B

Integrator are now connected through TCPS (encrypted) mode.

Installing and upgrading (V5.2.6 or later) 15



Configuring the Microsoft SQL Server Database:

Before you install Sterling B2B Integrator with the Microsoft SQL Server database,
you must configure the database.

Before you begin

v If you are reinstalling the software, be aware that data in your existing database
is deleted. To preserve your data, either back up the existing database or save it
under a different name.

v After you create and configure your database, recycle the database. Then, stop
and restart to apply the changes.

About this task

Use the following checklist to configure Microsoft SQL Server for Sterling B2B
Integrator:

Item
Microsoft SQL Server Database
Configuration Checklist Your Notes

1 If you do not have Microsoft SQL
Server installed, follow the installation
procedures in the SQL Server
installation manual.

Refer to the Microsoft SQL Server
documentation on creating the
database, including creating a schema
repository, login, and table space.

Be sure to install the correct version
and patches.

See System Requirements for supported
version information.

3 “Microsoft SQL Server database
parameters”

4 “Microsoft SQL Server database user
privileges”

5 “Configuring the snapshot feature for
Microsoft SQL Server” on page 18

Microsoft SQL Server database user privileges:

In Microsoft SQL Server, you must grant DBO (Database Owner) permission to the
user. The DB_DDLADMIN role is required for creating objects in the SQL Server
database.

Microsoft SQL Server database parameters:

When you install Sterling B2B Integrator with the Microsoft SQL Server database,
you must set certain Microsoft SQL Server parameters. Other Microsoft SQL Server
parameter settings are recommended for the efficient performance of Sterling B2B
Integrator.
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When you install Sterling B2B Integrator with Microsoft SQL Server, you must set
the Microsoft SQL Server parameters that are listed in “Mandatory settings for
Microsoft SQL Server.”

After you install Sterling B2B Integrator with Microsoft SQL Server, you can
improve the database performance by setting the recommended parameters that
are listed in the performance documentation for the following items:
v Instance-specific settings for Microsoft SQL Server
v Database-specific settings for Microsoft SQL Server

Mandatory settings for Microsoft SQL Server:

The default collation of Microsoft SQL Server must match the collation for the
Sterling B2B Integrator database to prevent collation conversions.

The tempdb database that is used by Microsoft SQL Server must be created with the
same collation as the default collation of Microsoft SQL Server. The Microsoft SQL
Server uses the tempdb database for results that are too large to fit in memory.

If the collations of the tempdb database and the Sterling B2B Integrator database
differ, the database engine must convert from the Sterling B2B Integrator collation
to the tempdb collation, and then back again before it sends the results to the
Sterling B2B Integrator server. These conversions might lead to severe performance
issues.

The collation that is required for the Sterling B2B Integrator database is a collation
that most closely matches the character set used by Java. By using this collation,
you can avoid character data conversions before the data is stored in the database
tables. Use the mandatory parameter that is described in the following table when
you configure the collation setting:

Parameter Value

Database Collation SQL_Latin1_General_CP850_Bin

Additionally, you must perform these tasks:
v Allow Microsoft SQL Server to manage memory dynamically (default).
v Disable any antivirus software that is running on the Microsoft SQL Server

data, transaction log, and binary files directory.

Installing the JDBC driver in Microsoft SQL Server:

The use of a SQL Server database with Sterling B2B Integrator requires the
installation of a JDBC driver.

About this task

Sterling B2B Integrator requires the correct Microsoft SQL Server driver. See the
System Requirements for the supported version information.

Download the driver and any appropriate patches from the Microsoft website.
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Procedure

To install the JDBC driver in Microsoft SQL Server:
1. Download the sqljdbc_version_language.tar.gz file to a temporary directory.
2. To unpack the compressed TAR file, open the directory where you want the

driver unpacked and type the following command:
gzip -d sqljdbc_version_language.tar.gz

3. To unpack the TAR file, open the directory where you want the driver installed
and type the following command:
tar –xf sqljdbc_version_language.tar

After the package unpacks, you can find out more information about using this
driver by opening the JDBC Help System in the /absolutePath/
sqljdbc_version/language/help/default.htm file. This file displays the help
system in your web browser.

4. When the Sterling B2B Integrator installation asks for the location of the JDBC
drivers, specify the extracted JAR file created after you unpack the archive,
which is usually named sqljdbc.jar. The JDBC driver version is the same as
the version of the drivers that are downloaded from Microsoft.

Configuring the snapshot feature for Microsoft SQL Server:

The snapshot feature in Microsoft SQL Server allows you to view a read-only copy
of the database even when it is locked. Configuring the snapshot feature can also
reduce deadlocks. To enable the snap shot feature, enter the following command:
ALTER DATABASE db_name SET READ_COMMITTED_SNAPSHOT ON;

Managing Database Passwords:

A password is used by the system to connect to its database. The password is
stored as clear text in a system property file.

If the security policies at your company require you to encrypt these passwords,
you can do so after you install the system. Encrypting these passwords is optional.

Database passwords encryption methods:

Database passwords are encrypted with one of two methods: OBSCURED or
ENCRYPTED.

The encryption method is decided by the value of the encryptionPrefix property
in the propertyEncryption.properties or the
propertyEncryption.properties_platform_security_ext file.

Encrypting database passwords:

Use commands to encrypt database passwords.

Procedure

To encrypt the database password:
1. Stop Sterling B2B Integrator.
2. Open the /install_dir/install/bin directory.
3. Enter the command ./enccfgs.sh.
4. Enter the command ./setupfiles.sh.
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5. Enter the command ./deployer.sh.
6. Enter the command ./run.sh to start Sterling B2B Integrator.
7. Enter your passphrase.

Decrypting database passwords:

Use properties files and commands to decrypt database passwords.

Procedure

To decrypt the database password:
1. Stop Sterling B2B Integrator.
2. Open the /install_dir/install/properties directory.
3. Open the sandbox.cfg file.
4. Copy the encrypted password from the database_PASS property.

Use the text that appears after the database_PASS=text. For example, if
database_PASS= OBSCURED:123ABCxyz321, you would copy the text
OBSCURED:123ABCxyz321. (OBSCURED is the encryption method for the password.)

5. Open the /install_dir/install/bin directory.
6. Enter the command ./decrypt_string.sh encrypted_password.

For encrypted_password, use the text that you copied in Step 4. You are
prompted for the system passphrase. After you enter the passphrase, your
decrypted password appears.

7. Open the /install_dir/install/properties directory.
8. Edit the sandbox.cfg file to replace the encrypted password with the

password that was returned in Step 6.
9. You need to decrypt the entries for the YANTRA_DB_PASS and DB_PASS

properties. Repeat Steps 4 - 8 to decrypt these entries. You must also decrypt
any passwords present in the property files. Encrypted passwords typically
exist in the following property files:
v sandbox.cfg

v apservsetup

v jdbc.properties

v jdbc.properties.in

v customer_overrides.properties

v customer_overrides.properties.in

10. Open the /install_dir/install/bin directory.
11. Enter the command ./setupfiles.sh.
12. Enter the command ./deployer.sh.
13. Enter the command ./run.sh to start Sterling B2B Integrator.
14. Enter your passphrase.

Preparing for Installation
To help ensure a trouble-free installation, you should complete the installation
checklist and understand some concepts.

Installation Checklist for a Windows Cluster Environment: The installation
checklist contains the items you need to gather and tasks you need to complete
prior to installing the Sterling B2B Integrator. The checklist contains:
v Brief descriptions for tasks (detailed procedures are provided after the checklist)
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v Information you need to gather to complete the installation

You may want to make a copy of the following checklist and use it to record the
information you collect for each node in the cluster.

The cluster environment does not support the following items:
v MySQL database
v AS2 Edition

#
Installation Checklist for a
Windows Cluster Node 1 Node 2 Your Notes

1 Review your IBM contract to
determine what software you
have licensed. You need to
know this License Information
so that you can select the
correct components and
features to install.

2 Determine which installation
method you are going to use:

v IBM Installation Manager
(Graphical User Interface)

v IBM Installation Manager
(Response File)

3 Decide which type of security
certificates you will use:

v The default self-signed SSL
(Secure Sockets Layer)
certificate that is
automatically installed.

v A Certificate
Authority-related certificate
that you install before
installing the software.

4 If you are using an Oracle,
Microsoft SQL Server, or DB2
database, decide if you are
going to manually or
automatically apply Database
Definition Language (DDL)
Statements (schema) to the
database.

5 If you are using an Oracle
11.1 database, you must set it
up for native compilation by
allocating space and by
setting the
plsql_native_library_dir
parameter.

6 Determine if the database
password needs to be
encrypted.

7 Record the Hostname on
which you plan to install the
software.
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#
Installation Checklist for a
Windows Cluster Node 1 Node 2 Your Notes

8 Record the Directory Name
where you plan to install the
software.

9 Record the Login to host
machine.

10 Record the Password to the
host machine.

11 Record the path to JDK.

12 Record the path to JCE file.

13 Record the Host IP address.

14 Record the Initial Port
Number.

15 Record the System
passphrase.

16 Record the Database vendor
name.

17 Record the Database user
name.

18 Record the Database
password.

19 Record the Database (catalog)
name.

20 Record the Database host
name.

21 Record the Path and file
name for the JDBC Driver(s).

22 Ensure you have read and
write privileges on the parent
installation directory.

License information:

A separate license is required for each Sterling B2B Integrator feature that you
purchased. During installation, you must choose the license files according to what
you purchased. Product licenses do not require an activation key.

IBM assumes customers will only install and use the products they purchased. IBM
reserves the right to inspect installs for compliance at any time.

After the installation finishes, if you determine that you need to modify licenses
files, see “License modifications” on page 58.

Product Licenses for Sterling B2B Integrator

Sterling B2B Integrator Standard and Enterprise Edition includes:
v MESA Studio
v eInvoicing
v Report Services
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v all services and adapters not listed below

Sterling B2B Integrator Standard and Enterprise Financial Edition includes
everything listed above plus:
v CHIPS
v SWIFTNet
v NACHA ACH CTX adapter
v FEDWIRE
v Fin Serv XML standard
v FIPS Mode
v Image Cash Letter service
v EBICS

Multicast ports in node to node communications:

Cluster nodes are configured to communicate with each other using JGroups, an
open source toolkit that provides flexibility for protocol configuration.

JGroups provides rich open management features, along with multiple protocol
support. JGroups supports multicast (UDP) and TCP-based communication
protocols.

When JGroups is configured to use multicast (UDP), all cluster nodes communicate
with each other on a specific IP address and port. The configuration of multicast
ports is based on the installation base port. All clusters that are on the same subnet
that is configured on the same base port send multicasting messages on the same
multicast IP address and port.

To avoid this situation, each cluster on the same subnet needs to be configured on
different base ports. Install your clusters on different port ranges or on different
network segments with multicast forwarding restricted, so that they do not
interfere with each other. The default multicast address is 239.255.166.17. This
address is configurable, with a port range of 10 ports, starting with the multicast
base port for the instance.

All nodes that are participating in the same cluster must be installed on the same
multicast base port (the multicastBasePort property in the
noapp.properties_platform_ifcresources_ext.in file). This value is usually
computed from the system base (non-multicast) port, but can be configured
separately in the noapp.properties_platform_ifcresources_ext.in file, to allow
different nodes in a cluster to be installed at different (non-multicast) port ranges.
Also, all the nodes in the cluster must be installed in the same subnet.

For node to node communications, the properties are defined in the
jgroups_cluster.properties file. The following attributes are used to define
communications:
v property_string - default value is UDP.
v distribution_property_string - default value is TCP. This attribute must never

be set to UDP.

If you want to change the communication for cluster multicast from the UDP
protocol to TCP, you need to change the value of the property_string property in
the jgroups_cluster.properties.in file (after you back up the file). Then, run the
setupfiles command. You can change this value right after the installation or after
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you start running the cluster. If you change the file after you start the cluster, you
need to stop all nodes of the cluster, change the value on each node, and then
restart your cluster.

To change the communication for cluster multicast from the UDP protocol to TCP,
use the following value for the property_string property in the
jgroups_cluster.properties.in file:
property_string=TCP(start_port=any_available_port_number):
TCPPING (initial_hosts=this_instance_host_ip[start_port_number],
theothernode_instance_host_ip[theothernode_start_port_number];port_range=2;
timeout=5000;num_initial_members=3;up_thread=true;down_thread=true):
VERIFY_SUSPECT(timeout=1500):pbcast.NAKACK(down_thread=true;up_thread=true;
gc_lag=100;retransmit_timeout=3000):pbcast.GMS(join_timeout=5000;
join_retry_timeout=2000;shun=false;print_local_addr=true;
down_thread=true;up_thread=true)

For more information about UDP, TCP, and JGroups communications, see the
Sterling B2B Integrator Clustering documentation.

Port Numbers in a Windows Environment: During installation or an upgrade,
you are prompted to specify the initial port number for Sterling B2B Integrator.

To specify an initial port number, follow these guidelines:
v Sterling B2B Integrator requires a range of 200 consecutive open ports between

1025 and 65535. The port range starts with the initial port number and ends
with the number that equals the initial port number plus 200. For example, if
you specify 10100, then you need to make sure that 10100 through 10199 are not
used by any other applications on your system.

Note: Because of RMI, on occasion, a port number outside the range may be
assigned.

v The initial port number represents the beginning port number in the range.
v Make sure that port numbers in the port range are not used by any other

applications on your system.

During the upgrade, about 50 default ports are pre-assigned for different services.
For example, if you do not want xxx32 (10132) to be a default port, you could
assign that port to xxx97 or another number within the port range.

After your installation or upgrade, refer to the \install_dir\install\properties\
sandbox.cfg file for all of the port assignments.

Security certificates:

You can choose between different security certificates before you install Sterling
B2B Integrator.

Before you begin the installation, you must decide which of the following security
certificates to use:
v The default self-signed SSL (Secure Sockets Layer) certificate that is

automatically generated by the installation.
v A Certificate Authority-related certificate that you generate before you install the

software.
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If you install with the default SSL certificate, but you later want to switch to a
CA-related certificate, you can change the certificate with the sslCert property in
the noapp.properties_platform_ifcresources_ext.in file.

Installing the Software
After you have configured the database and prepared your system, you are ready
to install Sterling B2B Integrator.

General Installation Information for a Windows Cluster Environment:

CAUTION:
Sterling B2B Integrator should be installed behind a company firewall for
security purposes. See the Perimeter Server and Security topics in the Sterling
B2B Integrator documentation library for more information on secure
deployment options.

The cluster environment does not support the following items:
v MySQL database
v AS2 Edition

Installation Scenarios

It is important to review the following installation scenarios:

Scenario Instructions

Version 5.1.x is installed and it needs to be
upgraded to V5.2.6.

See “Upgrading (V5.2.6 or later)” on page
320

Version 5.2.x is installed and it needs to be
upgraded to V5.2.6.

See Applying a fix pack (V5.2.6 or later)

Version 5.2.6 is being installed as the base
release.

Review this document and use the
installation instructions.

Installation Methods

Use one of the following methods to install your system:
v IBM Installation Manager (Graphical User Interface)
v IBM Installation Manager (Response file)

General Installation Guidelines

General installation guidelines include the following:
v Do not create the installation directory manually before the start of the

installation. If you create the installation directory before you begin, the
installation will fail.
The server on which you are installing must have adequate free disk space.

v The installation directory must have adequate free disk space.
v The name of the directory cannot include spaces and must be less than 30

characters long excluding separators. Using a directory name of more than 30
characters could create an install that is impossible to delete. An example of an
installation directory is C:\SI_52\install_dir\install.

v All nodes must use the same database.
v All nodes must use the same passphrase.
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v All nodes must use the same operating system.
v When installing nodes on different machines, the initial port numbers must be

the same. Installing nodes are different machines helps you take advantage of
cluster features such as, reliability, availability, scalability, and failover.

v When installing nodes on the same machine, you must install node 2 and higher
in different directories. Each initial port must be at least 200 higher or lower
than the initial port for the other nodes.

v If you need to install more than one instance of Sterling B2B Integrator on the
same Windows server, you must install the second instance in a different
directory.

v If you are installing Sterling B2B Integrator on VMware, provide the IP address
of the virtual machine, not the IP address of the VMware host. For example, if
10.251.124.160 is the IP address of the VMware host and 10.251.124.156 is the IP
address of the Windows 2003 server it is hosting, you should use 10.251.124.156
as the correct IP address to install Sterling B2B Integrator.

v Sterling B2B Integrator does not support IPv6 installation on Windows. Before
applying an IPv6 address, see the IPv6 Capabilities section in the System
Requirements.

v The installation creates subsequent ports based on the initial port number. For
all of the port assignments, see the \install_dir\install\properties\sandbox.cfg
file.

General IBM Installation Manager information:

IBM Installation Manager V1.8.2 is required to install Sterling B2B Integrator on all
supported platforms.

Installation Manager is a Java based multiplatform installation application and
provides a consistent approach across various platforms. It does not rely on
platform-specific installation technology or mechanism.

Installation Manager uses the local Sterling B2B Integrator offering repositories to
install or update Sterling B2B Integrator and its add-on features. It determines the
packages that must be installed and displays them including the products, fix
packs, and interim fixes. It checks that all prerequisites and interdependencies are
met before installing the selected product package and feature sets.

Important: The Uninstall option only unregisters Sterling B2B Integrator from
Installation Manager. The uninstall procedure as described in the related sections
must be performed to completely uninstall Sterling B2B Integrator.

Installation Manager must be installed on each computer on which Sterling B2B
Integrator is being installed. If you already have Installation Manager installed on
your computer for use with other IBM applications, it can be used with installing
Sterling B2B Integrator as long as it's the correct version. If you do not have
Installation Manager installed, it is provided as part of the Sterling B2B Integrator
installation media.

Supported bit-versions

A 64-bit version of IBM Installation Manager V 1.8.2 is provided with the Sterling
B2B Integrator installation package. However, you can also install with a 32-bit
version of Installation Manager.

Before you start the installation, consider the following options:
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v If you are a new customer, use the version of Installation Manager that is
provided with the Sterling B2B Integrator installation package and install
Sterling B2B Integrator.

v If you have an earlier version of Installation Manager, you can update it to
V1.8.2 using the Installation Manager that is provided with the installation
package, then install Sterling B2B Integrator .

v If you are a current customer who did not use Installation Manager earlier,
install the version of Installation Manager that is provided with the installation
package, then upgrade your Sterling B2B Integrator installation.

v If you have a 32-bit Installation Manager installed, you must download the
32-bit Installation Manager V1.8.2 from Fix Central or IBM Passport Advantage,
upgrade it, then proceed with the installation of Sterling B2B Integrator. Ensure
you have the required libraries that support screen presentation of the text.

Checking for updates

To check for Installation Manager updates, select Search for Installation Manager
updates on the File > Preferences > Updates page. When the check box is
selected, Installation Manager searches for updates when any one of the following
pages are opened from the Installation Manager start page:
v Install Packages
v Modify Packages
v Update Packages

Installation Manager also searches for updates when you click the Check for Other
Versions, Fixes, and Extensions button on the Install Packages page.

Starting Installation Manager

You should start the Installation Manager (and also install Sterling B2B Integrator)
as a non-administrator user.

How you start Installation Manager depends on whether you are using the
Installation Manager agent that is provided with Sterling B2B Integrator or if you
have an Installation Manager instance that is installed on your system. It also
depends on whether you have 32-bit or 64-bit Installation Manager.

Open a command prompt and do one of the following tasks to start the
Installation Manager in GUI mode:
v Go to the IM_<operating_system> directory and type ./userinst or userinst.exe

(Windows) for the following scenario:
– If you do not have Installation Manager installed and are using the

Installation Manager agent that is provided with the Sterling B2B Integrator
media.

– If you have a 64-bit Installation Manager installed.
– If you have Installation Manager installed on a platform that has only one

download available for Installation Manager. For example, AIX, Solaris, HP,
zLinux.

v Go to <installation directory>/Installation Manager/eclipse (for Windows
system, replace / with \) and type ./IBMIM or IBMIM.exe if you have 32-bit
Installation Manager installed on a Linux or Windows system.
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For information on starting Installation Manager in command mode for silent
installation, see the Installing or updating with a response file.

For information on starting Installation Manager in command mode to record a
response file, see Recording a response file.

Additional heap memory parameters

The heap memory parameters specify the amount of memory Installation Manager
can use during the installation process. The heap memory pool sizes that are used
by Installation Manager are hardcoded defaults. If these defaults are not sufficient
for your environment, you can specify different values by adding parameters to
the Installation Managerconfig.ini file.

Important: These additional parameters are required only if you are experiencing
Out Of Memory errors during the installation process.

The following parameters can be added:
v memoryMin=user.sb.INSTALL_<OS>_INIT_HEAP.<amount_of_memory>

v memoryMax=user.sb.INSTALL_<OS>_MAX_HEAP.<amount_of_memory>

Where <OS> is your operating system and <amount_of_memory> is the specified
amount of memory.

Operating
System Parameter Example Entry

Sun-Solaris Initial Heap Size

INSTALL_SUN_INIT_HEAP

memoryMin=user.sb.INSTALL_SUN_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_SUN_MAX_HEAP

memoryMax=user.sb.INSTALL_SUN_MAX_HEAP.3072m

Linux Initial Heap Size

INSTALL_LINUX_INIT_HEAP

memoryMin=user.sb.INSTALL_LINUX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_LINUX_MAX_HEAP

memoryMax=user.sb.INSTALL_LINUX_MAX_HEAP.3072m

AIX® Initial Heap Size

INSTALL_AIX_INIT_HEAP

memoryMin=user.sb.INSTALL_AIX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_AIX_MAX_HEAP

memoryMax=user.sb.INSTALL_AIX_MAX_HEAP.3072m

HP-UX Initial Heap Size

INSTALL_HPUX_INIT_HEAP

memoryMin=user.sb.INSTALL_HPUX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_HPUX_MAX_HEAP

memoryMax=user.sb.INSTALL_HPUX_MAX_HEAP.3072m

Windows Initial Heap Size

INSTALL_WIN_INIT_HEAP

memoryMin=user.sb.INSTALL_WIN_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_WIN_MAX_HEAP

memoryMax=user.sb.INSTALL_WIN_MAX_HEAP.3072m
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Installing or updating with a response file (V5.2.6 or later):

You can install or update (apply fix pack or interim fix) Sterling B2B Integrator
with silent mode by using the sample response files or converting your existing
response file to the required format.

Installing in a Windows cluster environment with the IBM Installation Manager
in GUI mode:

You can install Sterling B2B Integrator in a Windows cluster environment with the
IBM Installation Manager in a graphical user interface (GUI) mode.

Before you begin

v Complete the “Installation Checklist for a Windows Cluster Environment” on
page 19.

v If you are use the Standards Processing Engine (SPE) application with Sterling
B2B Integrator, you must install SPE before you install Sterling B2B Integrator.

v If you are using the EBICS Banking Server application with Sterling B2B
Integrator, the data encryption for storage within the installation location is not
supported.

About this task

To install Sterling B2B Integrator in a Windows cluster environment with the
Installation Manager in GUI mode:

Important: Following is a list of changes related to installing or upgrading to
Sterling B2B Integrator V5.2.6:
v You can install and upgrade through the user interface or silent installation

mode (response files). Console mode installation and upgrade is not supported.
v Sterling B2B Integrator JAR file is included in the repository. Therefore it is not

required to manually select the JAR file when installing or upgrading.
v You must use Installation Manager V1.8.2. to install or upgrade Sterling B2B

Integrator. InstallService is disabled, and cannot be used. You can use
InstallService only for a specific scenario related to Sterling File Gateway. For
more information, see step 13.

Procedure

1. Close all open Windows programs and any command prompt windows.
2. From the installation media, copy the compressed installation package to a

location on your desktop.
3. Decompress the installation package.
4. Open the InstallationManager folder in the directory structure that is created

when the installation package is decompressed. Several
IM_OperatingSystem.zip files are displayed.

5. Decompress the IM_Win.zip file. This action creates a new IM_Win folder.

Important: Installation Manager V1.8.2 is required to install Sterling B2B
Integrator V5.2.6.

28 Installing and upgrading (V5.2.6 or later):



6. Decompress the Common_Repo.zip from the installation package. The action
creates two new folders b2birepo and gmrepo. The IM_Win, b2birepo, and
gmrepo folders must be at the same level in a directory.

Important: gmrepo contains the repository file required to install Global
Mailbox. For information about Global Mailbox, see Global Mailbox overview.

7. Do one of the following tasks to start the Installation Manager:
a. Go to the IM_Win directory and double-click userinst.exe for the following

scenarios:
v If you do not have the Installation Manager installed and are using the

Installation Manager agent provided with V5.2.6.
v If you have a 64-bit Installation Manager installed.

b. Go to <installation directory>\Installation Manager\eclipse and
double-click IBMIM.exe, if you have 32-bit Installation Manager installed on
your Windows system.

Important: It is suggested to record a response file. The response file can be
used to install Sterling B2B Integrator after applying database schema
manually or install second and subsequent nodes in a cluster. For more
information, see Installing or updating with a response file.

8. On the Installation Manager home page, click Install.

Important: If IM_<operating_system> and b2birepo directories are not in the
same directory or if you already have Installation Manager installed, then you
get a message saying that there no packages to install or Installation Manager
could not connect to the repositories. You must add the Sterling B2B
Integrator repository files to the Installation Manager repository. For more
information about adding repository files, see Repository preferences.

9. On the Install Packages screen, select IBM Sterling B2B Integrator. This
action selects the versions also. Click Next.

10. Review the license agreement and select the option I accept the terms in the
license agreement.
If you do not accept the agreement, the installation process does not continue.

11. Select the location for the shared resources directory and click Next. This
directory is used by the Installation Manager for the Sterling B2B Integrator
installation and other installations.
The shared resources directory cannot be a subdirectory of the directory for
the installation of Sterling B2B Integrator. The shared resources directory must
be empty.

12. Choose Create a new package group and specify the path to Sterling B2B
Integrator installation directory.

13. Select the required features to be installed. The available options are:
v IBM Sterling B2B Integrator

v IBM Sterling File Gateway

Important: For Sterling B2B Integrator V5.2.6 or later, Sterling File Gateway
is automatically installed if IBM Sterling File Gateway is selected. Any
additional post installation tasks are not required to start Sterling File
Gateway. It is strongly suggested to install Sterling File Gateway when
installing Sterling B2B Integrator. If for any reason Sterling File Gateway is
not installed with Sterling B2B Integrator, you cannot install Sterling File
Gateway later using the Installation Manager. You must use InstallService
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to install it. For information about installing Sterling File Gateway by using
InstallService, see Installing Sterling File Gateway (V2.2.6 or later).

v FIPS Module

v AS2 Edition Module

v Financial Services Module

v EBICS Banking Server Module

v B2B Advanced Communications Integration Module

Important: When installing Sterling B2B Integrator, select B2B Advanced
Communications Integration Module to install Sterling B2B Integrator bridge.
Sterling B2B Integrator bridge is required for communication between Sterling
B2B Integrator and B2B Advanced Communications. If you are installing
Global Mailbox and Sterling B2B Integrator, then B2B Advanced
Communications Integration Module (Sterling B2B Integrator bridge) is
installed by default, because Global Mailbox uses the storage module of B2B
Advanced Communications. However, you must configure the adapter
containers and adapters for Sterling B2B Integrator bridge after installing.

Important: Sterling B2B Integrator is selected by default. Select only the
licenses and features that were defined by your IBM contract. If you are
unsure which to select, the installation can proceed without a selection and
complete successfully. Startup and operation of the software however, requires
one of the licenses to be selected. See “License modifications” on page 58 to
apply licenses after the installation.

14. Type the path to your JDK directory and click Next.
15. Specify the configuration for the features to install and click Next.

v FIPS Compliance Mode (Must enable FIPS Module)

v NIST 800-131a Compliance Mode

– off (default value)
– strict

v SPE Integration Module (Requires pre-install of SPE, WTX optional)

If you select the SPE option, you are prompted for the following
information:
– SPE installation directory
– (Optional) WebSphere® Transformation Extender (WTX) installation

directory
– SPE UI port
For more information, see the documentation for the integration of Sterling
B2B Integrator and SPE.

16. Type the path to the JCE policy file and click Next.
17. Enter the following server location information and click Next:

a. Type the explicit IP address or host name for the server or use the default
value of localhost.

b. Type the initial port number or use the default value of 8080.

Important: For node 2 and higher, you must use a different unique port
number.

18. Enter the system passphrase information and click Next:
a. Type a passphrase.
b. Confirm the passphrase.
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19. Type the email information and click Next:
a. Type the email address to which you want system alert messages sent.
b. Type the SMTP mail server (IP address or host name) that you want to use

for system alert messages and other administrative notices.
20. Enter the following database information and click Next.

a. Select the database vendor that you want to use:
v Oracle
v Microsoft SQL Server
v DB2
v MySQL

Important: You cannot use a MySQL database in a cluster installation.
b. Select all of the following options that apply to this installation:

Choices: Action

(Not for MySQL) This installation is for a
cluster node 2 or higher

If you are installing node 2 or higher in the
cluster setup, select the check box and
specify the node number.
Important: In a cluster setup, run the
startCluster command after installing the
first node (node 1) from the
\install_dir\install\bin directory, on the
host where you installed the node. The
syntax is startCluster.sh nodeNumber true.
Replace nodeNumber with 1. After you run
the startCluster command for the first
node, the subsequent nodes will have
clustering automatically started by the
installer when they are installed.

(Not for MySQL) Apply database schema
automatically?

The default is to automatically apply the
DDL (Data Definition Language) statements
that apply the database schema.

If you want to manually create the database
schema, then clear the Apply database
schema automatically check box and
continue with the remaining installation
steps.
Important: If you manually apply the
schema, the installation stops without error
later in the installation process so that you
can manually apply the schema.

21. Type the following database connection information. Do not click Next until
you configure the JDBC driver in the next steps.
v User name
v Password (and confirmation)
v Catalog name
v Host
v Port

22. Select a JDBC driver or drivers and click Next:
a. Click Add to browse to the file location for the appropriate JDBC driver or

drivers:
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v (Oracle and Microsoft SQL Server only) Absolute path and file name for
one JDBC driver file.

v (DB2 only) Absolute paths and file names for two JDBC driver files. Use
the Type-4 JDBC driver. This type of driver converts JDBC calls into the
network protocol that is used directly by DB2, allowing a direct call
from the system to the DB2 server.

b. Click Test to confirm that the driver is supported for the database and
Sterling B2B Integrator.

Tip: Make sure that you select the driver path in the Database driver field
before you click Test.
The Installation Manager must successfully validate the connection to the
database before you can continue with the installation. If there is a
validation failure, you can view the system log to determine more
information about the failure. Perform the following tasks:
1) Identify the location of the user’s application directory. Click Start >

Run and enter the command %APPDATA%.
2) Open the user’s application directory: local_path\IBM\Installation

Manager\logs

3) Open theindex.xml file in a browser.
4) Identify the log file that is based on the time stamp of when you

started the installation.
5) Click the installation file to view a listing of errors that occurred

during that installation.
23. Determine which of the following options apply to this installation. Select the

applicable options and click Next:
v Verbose install?

v This installation is an upgrade from a prior version

Do not select this option because this installation is a new installation.

Important: For node 2 and higher, this option might be selected by default.
This default selection causes the display of the option Would you like to
run upgrade pre-check?. Clear the check box before you continue.

24. Determine what performance configurations apply to this installation and
click Next. Accept the default value or type the appropriate value.
v Number of Processor Cores

v Physical Memory (MB) allocated to Sterling B2B Integrator

25. Review the installation package summary information. Click Install to apply
your installation settings to the installation.
If you did not select the option to automatically apply the database schema,
the installation stops and you must perform these additional steps to complete
the installation with manual DDL statements:
a. Open the installation directory.
b. Locate the InstallSI.log file and open it with a file editor.
c. Search the file for these error messages:
v <SI_Install>/repository/scripts/EFrame_IndexAdds.sql must be

applied to the database.

v <SI_Install>//repository/scripts/EFrame_Sequence.sql must be
applied to the database.
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v <SI_Install>//repository/scripts/EFrame_TableChanges.sql must be
applied to the database. Exiting installation..."

Important: If you do not find these error messages in the log file, the
installation failed because of another reason and you must resolve that
error and attempt the installation again. If you find these messages,
continue with the remaining steps.

d. Edit each .sql script for the database. These changes might include
changing the SQL delimiter or adding table space options.

e. Log in to the database as the database schema user.
f. Run the following SQL files manually in this order:

Important: When you are running the scripts, you must run the SQL
scripts in the specified order.
v EFrame_IndexDrops.sql

v EFrame_TableChanges.sql

v EFrame_IndexAdds.sql

v EFrame_TextIndexAdds.sql

v EFrame_Sequence.sql

v EFrame_TextIndexModify.sql

v EFrame_TextIndexUpdates.sql

v EFrame_TextIndexUpgrade.sql

v EFrame_Static.sql

Important: ActiveMQ uses dynamically generated table names that are
based on the name of the installation node. Table generation is not
included in these SQL scripts, but is performed automatically during the
initial start of Sterling B2B Integrator or when a new cluster node is added.
Table generation might fail if security restrictions reduced the Sterling B2B
Integrator database user permissions. To avoid this issue, ensure that the
DBADM role permissions are enabled during the initial startup. If further
issues arise, contact IBM customer support for guidance.

g. Exit from the database.
h. Open the parent directory of the Sterling B2B Integrator installation

directory.
i. Unisntall the Sterling B2B Integrator offering to clear out the Installation

Manager metadata about the installation, and the delete (or rename as a
backup) the Sterling B2B Integrator installation directory.

j. Restart the installation wizard and provide the same installation options
that you provided before you cleared the Apply database schema
automatically check box. If you have recorded a response file (as suggested
in step 8), you can use the response file to install Sterling B2B Integrator.

The Installation Progress screen indicates which component of the installation
is in process.
A status bar below the Repository Information heading displays the progress
of the component installation. When the installation completes, a large green
circle with a check mark displays with the message The packages are
installed. A link is provided to view the installation log file.

26. Click Finish. The Installation Manager closes and you are returned to your
desktop.
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Check the InstallSI.log file to verify that all of the components were
installed properly.
If you are installing on Windows 2008, see “Configure the Sterling B2B
Integrator Desktop Icon for Windows Server 2008.”

27. To install each additional node, open the Installation Manager folder and start
a new installation. See step 8.
For node 2 and higher, follow the same steps as you did for node 1 until you
get to the step with the This installation is for a cluster node 2 or higher
check box. Select that box.

28. If you installed multiple nodes on the same server or used different base ports
for node 2 onward, you need to complete the following steps:

Step Action Your Notes

1 Open the install_dir\install\properties directory for node
1.

2 In the noapp.properies_platform_ifcresources_ext file,
record the value for multicastBasePort.

3 In thejgroup_cluster.properties file, record the values for
the mcast_port parameters of the property_string and
lock.protocolStack properties.

4 For each subsequent node, perform the remaining steps.

5 Open the \install_dir\install\properties directory for each
node (node 2 and higher).

6 In thenoapp.properies_platform_ifcresources_ext.in file,
update the value of the multicastBasePort property to match
the value for node 1.

For example, replace the string &MULTICAST_NODE_PORT1; with
the port number 45460:

v (before) multicastBasePort=&MULTICAST_NODE_PORT1;

v (after) multicastBasePort=45460

7 In the jgroups_cluster.properties.in file, update all
occurrences of mcast_port to match the values for node 1.

8 After you updated the attributes for all of the nodes, enter the
command \install_dir\install\bin\setupfiles.cmd for
node 2 and higher.

29. Determine whether you need to apply a fix pack or interim fix to the
installation. For information about fix pack or interim fix installation, see
“Applying a Fix Pack (V5.2.6 or later)” on page 625 and “Applying an interim
fix (V5.2.6 or later)” on page 635.

Configure the Sterling B2B Integrator Desktop Icon for Windows Server 2008:
About this task

User Access Control (UAC) is a security component in Windows Server 2008. If
you enable the UAC, it affects the installation process and the daily processing for
Sterling B2B Integrator. If you disable the UAC, which requires a reboot, the
installation process and daily processing for Sterling B2B Integrator remains the
same as in previously supported Windows version.
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If you installed or upgraded Sterling B2B Integrator on a Windows Server 2008 and
you created a desktop icon for Sterling B2B Integrator, you must complete this task
in order for the desktop icon to work.

Procedure

1. Right-click on the Sterling B2B Integrator desktop icon.
2. Click Properties.
3. In the Shortcut tab, click Advanced.
4. Select the check box for Run as Administrator.
5. Click OK to apply the changes to Advanced Properties.
6. Click OK.

Validating the Installation
After installing Sterling B2B Integrator, you should validate the installation to
ensure that everything is working according to your needs.

Validation of the installation checklist in a cluster environment:

As part of the installation, you need to run several tests to ensure that the software
installation was successful.

# Validate Installation Task Completed

1 Configure the Nodes in the Cluster.

2 Verify the Cluster Environment Settings in Property Files.

3 Start the Cluster.

4 Access Sterling B2B Integrator.

5 Validate the Installation (Sample Business Process).

6 Verify the Cluster is Running from the User Interface.

7 Stop a Node (Hard Stop or Soft Stop) or Stop the Cluster.

Verifying the cluster environment settings in the properties files:

Procedure

To verify the cluster environment is correct, check these properties file settings on
node 2:
1. Verify that the value CLUSTER=true is in the sandbox.cfg property file.
2. Verify that the value CLUSTER=true is in the centralops.properties property

file.
3. Verify that the value CLUSTER=true is in the noapp.properties property file.
4. Verify that the value cluster_env property=true is in the ui.properties

property file.

Configure the Nodes in Windows Cluster:

The first time that you configure a cluster, you need to use the startCluster
command with true option (startCluster.sh nodeNumber true).
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About this task

The first time you configure a cluster, you need to use the startCluster command
with true option (startCluster.sh nodeNumber true). Initial configuration should
be the only time you need to use the startCluster command. However. if you
need to use the command again, use the startCluster command with the false
option (startCluster.sh nodeNumber false). The false option prevents any
configuration changes from affecting the system, especially after installation of a fix
pack or interim fix.

Important: For Sterling B2B Integrator V5.2.6 or later, you must run the
startCluster command after installing the first node (node 1) on the host where
you have installed the node. After you run the startCluster command for the first
node, the subsequent nodes will have clustering automatically started by the
installer when they are installed.

To configure the nodes in a Windows cluster environment, you need to perform
the following task for each node, starting with node 1:

Procedure

1. Navigate to \install_dir\install\bin for the node.
2. Enter startCluster.cmd <nodeNumber> <true or false>. Where

<nodeNumber> is the number of the node, true performs database updates and
false prevents database updates. For example for node 1, enter
startCluster.cmd 1 true.

3. Enter startWindowsService.cmd. Perform this step for each node. The final
startup processes run, concluding with the following message: Open your Web
browser to http://host:port/dashboard where host:port is the IP address and
port number on your system.

4. Record the URL address so that you can access Sterling B2B Integrator.

Starting Sterling B2B Integrator in a Windows cluster environment:

After you run the upgrade software, you can start Sterling B2B Integrator.

Before you begin

If you are starting Sterling B2B Integrator after you upgrade the application from
version 5.1.0.4, change the values of the following properties in the
centralops.properties file to 600. This action prevents the
StartWindowsService.cmd command from timing out before Sterling B2B Integrator
starts. The centralops.properties file is in the install_dir\install\properties
directory.
v OpsServer.commandTimeout

v PassPhrase.urlTimeout

About this task

Perform this task for each node in the cluster, starting with node 1.

Procedure

1. Open the \install_dir\install\bin directory.
2. Enter startWindowsService.cmd.
3. Enter your passphrase.
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4. The final startup processes run, concluding with the following message: Open
your Web browser to http://host:port/dashboard

Where host:port is the IP address and port number where Sterling B2B
Integrator is located on your system.
Depending on system load, it might take several minutes for the UI to be ready.

5. Record the URL address so that you can access Sterling B2B Integrator.

What to do next

If you need to release all the locks in a cluster and both nodes are down, use the
restart parameter for node 1.

Note: The restart parameter can be used on only node 1. It cannot be used on
any other nodes.

For example:

For node 1, enter:

startWindowsService.cmd restart

For node 2 and higher, enter:

startWindowsService.cmd

Accessing Sterling B2B Integrator:

You can access Sterling B2B Integrator through a web browser.

Procedure

1. Open a browser window and enter the address that is displayed at the end of
the start.

2. On the login page, enter the default user ID and password. The default login is
at an administrative level. One of your first tasks as an administrator is to
change the administrative password and to register other users with other
levels of permission.

Validating the installation with a sample business process:

You can validate the installation by testing a sample business process.

Procedure

1. From the Administration Menu, click Business Process > Manager.
2. In the Process Name field, type Validation_Sample_BPML and click Go!

3. Click execution manager.
4. Click execute.
5. Click Go! The Status: Success message is displayed on the upper left side of

the page.

Verifying from the user interface that the cluster is running:

You can use the user interface to verify that the cluster is running, including queue
information and adapter status.
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Procedure

1. From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the Queue information for each node.

2. From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the JNDI Tree for each node.

3. From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the host, state, status, adapters, and memory usage
information for each node.

4. From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the adapter status for each node.

Stop a Node in the Windows Cluster Configuration (Hard Stop):
About this task

You can stop a single node Sterling B2B Integrator in a Windows cluster
environment. To run a hardstop, perform this task for each node:

Procedure

1. Navigate to \install_dir\install\bin.
2. Enter StopWindowsService.cmd.
3. Enter your passphrase. You can also perform this task by selecting Operations

> System > Troubleshooter. Then click the shutdown link for the node you
want to stop.

Stop Sterling B2B Integrator (Windows Cluster):
About this task

To stop the entire cluster in a Windows environment:

Procedure

1. From the Administration Menu, select Operations > System > Troubleshooter.
2. Click Stop the System and wait for shutdown to complete.

Stop Sterling B2B Integrator (Hardstop Windows):
About this task

To stop Sterling B2B Integrator in a Windows environment:

Procedure

1. Navigate to \install_dir\install\bin.
2. Enter StopWindowsService.cmd. Your should receive a message that services

have been stopped. Services include Noapps, Opsserver, WebDav, and
Database-related service.

Stop Cluster (Softstop Windows):
About this task

Soft stop in a cluster environment suspends all scheduled bushiness processes. It is
recommended to run the hardstop command on each of the nodes.

To soft stop the cluster:
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Procedure

1. Navigate to \install_dir\install\bin.
2. Enter softstop.cmd. You should receive a message that services have been

stopped. Services include Noapps, Opsserver, WebDav, and Database-related
service.
For more information about the softstop command line options, refer to the
performance management documentation.

Restart the Windows Cluster:
About this task

To restart the entire cluster in a Windows environment:

Procedure

1. Navigate to \install_dir\install\bin.
2. Enter startWindowsService.cmd restart.

What to do next

If you need to release all the locks in a cluster and both nodes are down, use the
restart parameter for Node 1.

Note: The restart parameter can only be used on Node 1. It cannot be used on
any other nodes.

For example:

For Node 1, enter:

startWindowsService.cmd restart

For Nodes 2 and higher, enter:

startWindowsService.cmd

Post-Installation Configuration
After installing Sterling B2B Integrator and validating the installation, you may
need to do additional configuration depending on your system and business needs.

Post Installation Configuration Checklist for Cluster Environment (Windows):
After you have installed the Sterling B2B Integrator, you need to complete the post
installation configuration checklist. Review all of the tasks, but note, some tasks
may not be required for your system installation.

# Post Installation Configuration Checklist Your Notes

1 Upon installation, several default user accounts
are automatically created to get you started. For
security purposes, the system administrator
should update all default user account passwords
immediately after installation is completed. See
“Changing default user account passwords” on
page 40.

2 “JMS Cluster Configuration for Failover” on page
41
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# Post Installation Configuration Checklist Your Notes

3 Configure ActiveMQ for a cluster environment.

4 Update the sandbox.cfg file for an IPv4 Address

5 Download Sterling B2B Integrator Tools.

6 Determine if you need to modify any Property
Files.

7 Configure Shared File System as Document
Storage.

8 Add host[port] from all the nodes to the
jgroups_cluster.property.in for each node.

9 “Manage Nodes in a Cluster” on page 45

10 “Services and Adapters Associated with Node 1 in
a Cluster” on page 46

11 Configure Customer Overrides File with a
Firewall between Nodes.

12 “Configure a Non-English Environment” on page
47

13 “Configure Browser Settings for a Different
Language” on page 50

Changing default user account passwords:

When you install Sterling B2B Integrator, several default user accounts are
automatically created to get you started. One of the first actions you must take
after installation is to update these accounts with unique passwords, because the
default ones can be known by all Sterling B2B Integrator customers.

About this task

Default user account passwords are preset at installation. For security purposes,
the system administrator should update all default user account passwords
immediately after installation is completed.

Default user accounts are listed below in the same order as they appear in the UI
under Accounts > User Accounts > List All. You can use this table to track the
user accounts you want to update.

User Account Name Update password

MBX_daemon

admin (*)

aft_user (*)

anon

as2_user

commandlineuser

dash_oper (*)

dash_part (*)

dash_prtspon (*)

dash_sponsor (*)
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User Account Name Update password

fg_architect

fg_operator

fg_provisioner

fg_sysadmin (*)

gmbx_user

ja_turbine

jane

jane_doe

joe_employee

joe_manager

joe_supplier

john

sd_buyer

sd_supplier

turbine

ws_buyer

ws_director

ws_employee

ws_finance

ws_hr

ws_manager

ws_purchaser

ws_supplier

(*) denotes a super user

To change the password for a user account, perform the following tasks.

Procedure

1. Log into Sterling B2B Integrator using ID = admin and password = password.
2. Go to Accounts > User Accounts. Under the List section click Go! All default

user account names are listed.
3. Click Edit next to the user account name you want to update the password for.
4. In the New Password and Confirm New Password fields, enter a new, secure

password for this User ID.

Note: Passwords must be at least six characters long.
5. Click Save and Finish.

What to do next

Repeat steps 3 - 5 for all user account names you want to update.

JMS Cluster Configuration for Failover: To allow proper JMS execution and
failover in the Sterling B2B Integrator cluster environment, you must configure an
external ActiveMQ using the Configure ActiveMQ for a Cluster Environment task.
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The following diagram illustrates how the ActiveMQ can be configured to increase
availability and failover.

Configure ActiveMQ for a Cluster Environment (Windows):
About this task

To configure ActiveMQ for the windows cluster environment:

Procedure

1. Download ActiveMQ 5.2 from http://activemq.apache.org/activemq-520-
release.html for the appropriate OS.

2. Deploy an instance of ActiveMQ 5.2. This can be on the same machine as
Sterling B2B Integrator or on a separate machine.

3. Navigate to \install_dir\install\properties.
4. Copy the activemq.xml file to the AMQ conf directory. This file configures the

ActiveMQ to:
v Use failover clustering,
v Use the SI database for storage
v Configures the AMQ port usage

By default, ActiveMQ is configured to listen at the Sterling B2B Integrator base
port + 64 and the ActiveMQ interface will be at base port + 65
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(http://server:base port + 66/admin). The port can be changed by editing the
config file directly. The port number must be higher than 1024.

5. Navigate to \install_dir\install\properties.
6. On each Sterling B2B Integrator node and each Sterling B2B Integrator

container node, the queue configuration must be re-directed to utilize the
ActiveMQ cluster. In each node, add the following to the
customer_overrides.properties:
For FIFO Processing:
fifo.broker.username=
fifo.broker.password=
fifo.broker.url=failover:(tcp://amq_master_hostname:amq_master_port,
tcp://amq_slave_hostname:amq_slave_port)

For adapters running in separate JVM containers:
iwfcqueue.username=
iwfcqueue.password=
iwfcqueue.protocol_config=failover:(tcp://amq_master_hostname:amq_master_port,
tcp://amq_slave_hostname:amq_slave_port)

7. Start the ActiveMQ instances. To start ActiveMQ, it is necessary to supply the
activemq.hostname property with the hostname for the current system. For
example:
activemq.bat -Dactivemq.hostname=ExampleHostname

See http://activemq.org for additional information about running an ActiveMQ
instance.

8. Start Sterling B2B Integrator.

Update the sandbox.cfg file for an IPv4 Address:
About this task

To update the sandbox.cfg file for an IPv4 address (complete this task for each
node in the cluster):

Procedure

1. Navigate to the properties file directory for each node.
2. Open the sandbox.cfg file.
3. Add the following line to the file.

IPV4STACK=true

4. Save and close the file.
5. Navigate to the bin directory for your installation.
6. Run setupfiles.cmd to update your installation.

Download of the Sterling B2B Integrator tools:

After you install Sterling B2B Integrator, you can install tools like the Map Editor
and the Graphical Process Modeler (GPM).

Sterling B2B Integrator includes tools that run on a desktop or personal computer.
After you install Sterling B2B Integrator, you can install the following tools:
v Map Editor and associated standards

Note: The Map Editor requires a 32-bit JDK. This JDK is not provided with the
product download or media. For more information, see System Requirements.

v Graphical Process Modeler (GPM)
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v Web Template Designer
v (If licensed) MESA Developer Studio plug-ins, including MESA Developer

Studio Software Development Kit (SDK) and MESA Developer Studio Skin
Editor

v (If licensed) Reporting Services, which require MESA Developer Studio if you
want to use the plug-ins to create fact models and custom reports

Attention: Conflicting IP addresses can cause problems when you download a
desktop tool.

Property files configuration in a Windows environment: Property files contain
properties that control the operation of Sterling B2B Integrator. For example, the
REINIT_DB property in the sandbox.cfg file controls whether or not a database is
initialized when you install Sterling B2B Integrator.

By modifying the values of these properties, you can customize the Sterling B2B
Integrator to suit your business and technical needs. Most property files are in the
\install_dir\install\properties directory.

After installing Sterling B2B Integrator, most property files and scripts do not need
any further configuration for basic operation. However, if you want to customize
any specific operations, for example setting a different logging level - you will
need to edit ( or in some cases, create) certain property or .xml files.

Before changing any property files, refer to the Working with Property Files
documentation for general information about how to work with Property Files.

Areas where you might need to make specific property files changes after an
installation include:
v LDAP user authentication
v Prevention of cross-site script vulnerabilities
v Logging configuration
v Process-specific property file settings

Configure Shared File Systems as Document Storage (Windows Cluster):
About this task

To configure the shared file systems as document storage:

Procedure

1. Navigate to \install_dir\install\properties.
2. Open the jdbc.properties.in file.
3. Update the value of the document_dir attribute to point to the shared files

system directory where you store documents.
4. Save and close the file.
5. Navigate to \install_dir\install\bin.
6. Enter setupfiles.cmd.
7. Restart Sterling B2B Integrator.

Add host[port] From all the Nodes to the jgroups_cluster.property.in for Each
Node:
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About this task

Complete this task for both vertical and horizontal clusters. You will need to
complete this task for each node, starting with node 1.

Before you begin, it is important to note that you should never override
mcast_addr in the jgroup_cluster.properties.

To add the host [port] to the jgroups_cluster.property.in file:

Procedure

1. Navigate to the properties file directory for the node.
2. Determine the initial_hosts port for each node:
v Navigate to the properties file directory for the node.
v Find the initial_hosts from the jgroups_cluster.property

(initial_hosts=host{port}).
v Record the value from the initial_hosts for each node.

3. Open the jgroups_cluster.property.in file.
4. Add the initial_hosts property to the file. For example, if node 1 is on host1

and node 2 is on host2. For node 1, you would add:
initial_hosts=host1[port1],host2[port2]

For node 2, you would add:
initial_hosts=host2[port2],host1[port1]

5. Save and close the file.

Manage Nodes in a Cluster:
About this task

You can add or remove nodes in a cluster environment. The following
prerequisites should be considered before performing any modification in the
cluster environment:
v New nodes should have the same range of ports available as the current nodes.
v Sterling B2B Integrator license file should be updated to include the IP address

of the new nodes.
v Directory structure on the new nodes should match with the directory structure

of the existing nodes.
v Perimeter servers should be updated with the new IP addresses to ensure proper

configuration.
v Any adapters, services, or business processes assigned to or scheduled to run on

the node being removed should be assigned to run on other nodes.

Add a Node to the Cluster (Windows):

You do not need to stop the cluster environment while adding a new node.

About this task

To add a node into the cluster:
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Procedure

1. Install a new Sterling B2B Integrator node to be added into the cluster during
installation. Ensure that the new node being added is not a primary node.

2. Update the jgroups_cluster.properties file and the
jgroups_cluster.properties.in file with the new node details.

3. Configure the new node by running the startcluster.cmd nodeNumber from the
\install_dir\install\bin directory. The node number should be greater than
1.
You should run startCluster.cmd only after you install Sterling B2B Integrator.
You should not run startCluster.cmd when you restart a Sterling B2B
Integrator instance.

4. Start the new node.

Remove a Node from the Cluster:
About this task

To remove a node from the cluster:

Procedure

1. Reassign or stop any adapters, services, or business processes assigned to or
scheduled to run on the node being removed.

2. Perform backup of the node being removed.
3. Edit the jgroups_cluster.properties file and the

jgroups_cluster.properties.in file in all nodes to remove the IP address of
the node being removed.

4. Restart the cluster environment.

Important: Start node 1 with the restart option to update the node
information.

Services and Adapters Associated with Node 1 in a Cluster: The following
services and adapters are associated with node 1 in the cluster:
v File System adapter
v Command Line 2 Adapter
v Connect::Direct Server Adapter
v Connect::Direct Requester Adapter
v Connect:Enterprise for UNIX Server Adapter
v HTTP Server adapter
v HTTP Client adapter
v FTP Client adapter
v FTP Server adapter
v SFTP Client adapter

The following services and adapters have storage set to database:
v HTTP Server adapter
v Connect:Enterprise for UNIX Extract Service
v Connect::Direct Server Adapter

The default storage for all of the workflows is set to database.

Configure Customer Overrides File with a Firewall between Nodes:
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About this task

If you have configured a firewall between nodes that blocks ports outside of the
port range assigned to Sterling B2B Integrator, perform the following task on all
nodes:

Procedure

1. Navigate to the Sterling B2B Integrator installation directory.
2. Navigate to the properties directory and locate (or create, if necessary) the

customer_overrides.properties file.
3. Open the customer_overrides.properties file using a text editor.
4. Add the following properties:

noapp.jnp_host= <host_name>
noapp.jnprmiport=<port_number_1>
noapp.jnprmiport2=<port_number_2>
noapp.useSocketFactories=true
noapp.jndirmiport=<port_number_3>
ops.jnp_host= <host_name>
ops.jnprmiport=<port_number_1>
ops.useSocketFactories=true
ops.jndirmiport=<port_number_2>
ops.jnprmiport2=<port_number_3>

This increases the number of threads used by the system.
5. Save and close the customer_overrides.properties file.
6. Stop Sterling B2B Integrator and restart it to apply the changes.

Configure a Non-English Environment:

You can install Sterling B2B Integrator in an English or a non-English environment.
The base language for the Configurator can be switched only once.

Use the following checklist to change to a non-English environment:

# Non-English Environment Checklist Your Notes

1 Install the Sterling B2B Integrator Language Pack.

2 Load the Sterling B2B Integrator Language Pack
Factory Defaults.

3 Load the Sterling B2B Integrator Language Pack
translators.

4 Configure Encodings.

5 Configure Locales.

Language Settings in a Windows Environment: Language settings for Java
applications involve both character sets and encoding:
v A character set is a set of characters (letters, numbers, and symbols such as #, $,

and &) that are recognized by computer hardware and software.
v An encoding is a representation of data in a particular character set. An

encoding set is a group of encodings.

For information about basic and extended encoding sets, see .http://
download.oracle.com/javase/1.5.0/docs/guide/intl/encoding.doc.html

The default encoding set includes:
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v UTF-8 (default)
v IS0-8859-1
v ISO-8859-5
v US-ASCII
v ISO_8859-1
v EUC-JP
v UTF-16
v ISO-2022-JP

Sterling B2B Integrator provides two property files that contain supported
encoding sets. These properties files reside in the \install_dir\install\properties
directory.
v encodings.properties – Contains the default encoding set used in the user

interface.
v encodings_large.properties – Contains all supported encoding sets.

You are not limited to the encodings in the encoding.properties file. Sterling B2B
Integrator enables you to configure the encodings properties files to expand the
number of encodings you can use.

Install the Language Pack (Windows):
About this task

Before installing the language pack be sure that you have successfully installed
Sterling B2B Integrator.

To install Sterling B2B Integrator language pack:

Procedure

1. Insert the language CD into your CD-ROM drive.
2. Complete the following steps:

a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Navigate to Win Directory.

3. Run the setup.exe command.

Load the Language Pack Translations (Windows):
About this task

Prior to loading the Sterling B2B Integrator Language Pack factory defaults, be sure
that you have successfully completed all instructions in the database chapter.

To load the language pack translation with custom localization literals:

Procedure

1. Complete the following steps:
a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Navigate to \install_dir\install\bin.
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2. Run the LocalizedStringReconciler tool in the IMPORT mode, enter: ant.cmd
-f localizedstringreconciler.xml import -Dsrc=install_dir\database\
FactorySetup\XMLS

This tool first inserts the value specified in the
<from_language>_<from_country>_ycplocalizedstrings_<to_language>_
<to_country>.properties file present in the install_dir\database\FactorySetup\
XMLS\<language>_<country> directory into the database.
The basefilename refers to the file present in the \database\FactorySetup\
XMLS directory, for which the translations are to be imported into the database.

3. Verify that your locale settings such as currency, time format, and date are
correct.

Configure Encodings for Sterling B2B Integrator (Windows):
About this task

To configure your encoding set:

Procedure

1. Stop Sterling B2B Integrator and wait for shutdown to complete.
2. Complete the following steps:

a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Navigate to \install_dir\install\bin.

3. Open the encodings_large.properties file.
4. Select the encodings you want to add to the encodings.properties file.
5. Open the encodings.properties.in file.
6. At the end of the encodings.properties.in file, add the encodings you selected

from the encodings_large.properties file. When adding encodings from one file
to the other, first copy the encodings as they appear in the
encodings_large.properties file. After adding the new encodings, ensure that
the index numbers are consecutive. If the index numbers are not consecutive,
change the index number or numbers as needed. For example, encoding54
cannot follow encoding6. In this example, change encoding54 to encoding7.
The first name in the definition (before the comma) is the name that will
appear in the Sterling B2B Integrator user interface. You can change this name
to make it more descriptive. For example: encoding4 = 819,ISO8859_1 may be
changed to encoding4 = WesternEurope,ISO8859_1. ISO8859_1 is the Java
canonical name and should not be changed.

7. Update the first line in the encodings.properties.in file (numberof). Change
numberof to the number of encodings added to the file. For example, if the
current value is numberof = 6 and you add 5 new encodings, the new value is
numberof = 11.
numberof indicates the total number of encodings located in the file. You must
update numberof to ensure that the encodings you added will be visible in the
user interface.

8. Complete the following steps:
a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Navigate to \install_dir\install\bin.
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9. Enter setupfiles.cmd.
10. Start Sterling B2B Integrator.

Configure Locales (Windows):
About this task

Sterling B2B Integrator runs in any locale that Java supports. If you want to run in
a non-default locale, then configure your environment to the specific locale you
want to use.

To determine and set your locale in a Windows environment:

Procedure

1. Select Control Panel > Regional Options > General.
2. From the Your locale (location) list, select the language and location.
3. Click Set Default and select the locale from the Set the appropriate locale list.
4. To configure your operating system as a non-English environment, consult your

operating system's documentation.

Load the Language Pack Factory Defaults (Windows):
About this task

To load the language-specific factory defaults, use the loadDefaults.cmd script
available in the install_dir\install\bin directory and pass the locale-specific
installer file.

For example:

loadDefaults.cmd \install_dir\install\database\FactorySetup\install\
<language>_<country>_locale_installer.xml

The default locale that is shipped with the CD is ja_JP.

Configure Browser Settings for a Different Language:

Some browsers and operating systems require additional configuration in order to
correctly render the Sterling B2B Integrator user interface in certain languages.

Use the procedures provided in this section to properly configure a browser to
display the Sterling B2B Integrator user interface in the appropriate language.

Tip: If your browser is unable to display the user interface properly or you see a
mixture of English and another language, this is an indication that the browser is
configured incorrectly. You may also need to install additional fonts on the Sterling
B2B Integrator server.

Support for other languages:

The Sterling B2B Integrator user interface includes support for several languages.

Attention: Sterling B2B Integrator product code is designed to work with Latin
based English only input. The use of any other type of input might have uncertain
results and is not supported.
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The Sterling B2B Integrator user interface includes support for the following
languages:
v French
v German
v Italian
v Japanese
v Korean
v Polish
v Portuguese (Brazilian)
v Simplified Chinese
v Traditional Chinese
v Dutch

Four of these languages involve expanded Unicode character sets:
v Japanese
v Korean
v Simplified Chinese
v Traditional Chinese

The implementation of these languages in your environment might require the
addition of new Unicode fonts on your server:

If... then...

Sterling B2B Integrator is on a server that
already supports these languages

You do not need to install any additional
fonts.

You are installing on a server that is only
setup for the Latin alphabet and you have
users who need to view the Sterling B2B
Integrator user interface in any of the Asian
languages

You need to have the fonts for these
languages installed.

A way to test the implementation of a language is to create a user with one of the
new languages and setup their browser to use that language as it's primary
language. Log in to the system and review the user interface. If you see a mixture
of English and the new language, your configuration is not correct. You need to
verify that the browser is set up correctly and review the fonts that are installed on
the server.

The installation of more fonts/languages on the server should be done in
coordination with your technical support team. Be sure to include a Unicode Sans
Serif font on your server.

Important: While multiple languages are supported, a user account should be
configured to use one specific language to avoid user interface display issues.

Add a Custom Language Preference Code:
About this task

In order for your browser to display the Sterling B2B Integrator user interface and
address bar text correctly in a foreign language, you must specify the appropriate
language preference code for the browser.
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Sterling B2B Integrator supports the following language preference codes:
v de
v en
v en-US
v es
v fr
v it
v ja
v ko
v pt-BR
v zh
v zh-TW
v du

Your browser must be configured to use one of these specific language preference
codes to view the Sterling B2B Integrator user interface.

Note: Most browsers provide a default listing of language preference codes.
However, Sterling B2B Integrator requires the use of the specific codes as listed
here. For example, you cannot use the default German (Germany) [de-DE], you
must use [de].

You may need to add these supported codes as a custom language preference code
in your browser.

Note: The instructions for configuring a browser’s display will differ for each
browser. Refer to your chosen browser’s documentation for specific instructions on
configuring that browser’s display.

The following is an example of how to configure a client machine display for an IE
window.

Procedure

1. Open a browser window.
2. Select Tools > Internet Options.
3. At the bottom of the window under Appearance, click Languages.
4. Click Add to display the Add Language window.
5. In the User defined: text box, enter the appropriate language preference code.
6. Click OK. The added code should display in the Language: listing in the

Language Preference window. An example entry would be, User Defined
[de].

7. (Optional) Move the added language up to be the first one listed if there are
multiple languages listed.
a. Select the newly added language.
b. Click Move up.

The newly added language should now appear first in the Language
listing.

8. Click OK to save your Language Preference settings.
9. Click OK to close the Internet Options window.

10. Close your browser window.
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11. Open a new browser window and access the Sterling B2B Integrator user
interface to verify your changes have been applied.

Change Default Browser Font:
About this task

Some languages require the use of special fonts to properly display the Sterling
B2B Integrator user interface. The client computer must be configured to display
these types of fonts. Each Windows client must be configured appropriately.

Note: The instructions for configuring a browser’s display will differ for each
browser. Refer to your chosen browser’s documentation for specific instructions on
configuring that browser’s display.

The following is an example of how to change the default browser font for an
Internet Explorer (IE) window.

To configure a client machines display for IE:

Procedure

1. Determine which fonts are needed to support your needed language and
verify they are installed on the server.

Note: The installation of additional fonts/languages on the server should be
done in coordination with your technical support team. Be sure to include a
Unicode Sans Serif font on your server.

2. Open an IE browser window.
3. Select Tools > Internet Options.
4. At the bottom of the window under Appearance, click Fonts.
5. From the Language Script drop-down menu, change the Latin based value to

the appropriate script for your needed language.

Note: If your encoding is not available, you may need to install a new
version of Internet Explorer, but make sure you install the appropriate
international options.

6. Select a Webpage font and a Plain text font appropriate for the new language.
A Plain text font is one in which all the characters take up the same amount
of space and is associated with older computer terminals.

Note: If no fonts are listed in the menus, then you need to install fonts
designed for that encoding.

7. Click OK to close the Fonts window.
8. Click OK again to close the Internet Options window.
9. Close your browser window.

10. Open a new browser window and access the Sterling B2B IntegratorSterling
B2B Integrator user interface to verify your changes have been applied.

Set the Client Character Display:
About this task

To use special characters, such as for various languages, the client computer must
be configured to display these types of characters. In order for Unicode characters
to display correctly in the application, each Windows client must be configured
appropriately.
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Note: The instructions for configuring a browser’s display will differ for each
browser. Refer to your chosen browser’s documentation for specific instructions on
configuring that browser’s display.

The following is an example of how to configure a client machine display for an
Internet Explorer (IE) window.

To configure a client machines display for IE:

Procedure

1. Open an IE browser window.
2. Select View > Encoding > Auto-Select.

Clearing Browser and Java Plugin Caches Before Initial Deployment:
About this task

Once the Sterling B2B Integrator is ready for deployment, each user must clear the
browser and Java Plugin caches on their client machines before launching Sterling
B2B Integrator. This requirement applies to all browsers.

To clear the browser and java caches, do the following:

Procedure

1. From the browser menu bar, select Settings > Control Panel > Internet
Options.

2. Select the General tab, and in the Temporary Internet Files panel, click Delete
Files. The Delete Files dialog displays.

3. Check the Delete All Offline Content checkbox. Click OK until the Internet
Properties window closes. The browser cache is cleared.

4. From the Windows start menu, select Settings > Control Panel > Java.
5. Select the General tab, and in the Temporary Internet Files panel, click Settings.

The Temporary Files Settings dialog displays.
6. In the Disk Space panel, click Delete Files. The Delete Temporary Files pop-up

window displays.
7. Click OK until the Java Control Panel window closes.

General Internet Explorer Browser Settings: When using Sterling B2B Integrator
without any customizations, you need to set the General Browser settings for your
Internet Explorer in order to obtain the best browser performance.

Note: This can impact the display of reports and search listings.

To set your general browser settings:
1. From the Internet Explorer menu, select Tools > Internet Options.

The Internet Options window opens to the General tab.
2. Locate the Browsing history section and click Settings.

The Temporary Internet Files and History Settings window opens.
3. Below Check for newer versions of stored pages: select the Everytime I visit

the webpage option.
4. Click OK to save your changes.
5. Click OK to apply the changes.
6. Close the browser window and re-open it.
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The browser is now set to check for updates to pages everytime a page is
accessed rather than relying upon a cached version.

Internet Explorer Security Settings:
About this task

When using Sterling B2B Integrator without any customizations, you need to set
security settings for your Internet Explorer to obtain the best browser performance.

To configure the Internet Explorer security and privacy settings:

Procedure

1. From the Internet Explorer menu, select Tools > Internet Options.
2. Click the Security tab.
3. Select the Web content zone from which Sterling B2B Integrator is accessed.
4. Set the security level to Medium-low.
5. Click Custom Level and set your security settings according to the following

table:

Internet Explorer Security Setting Sterling B2B Integrator

.NET Framework

Loose XAML Enable

XAML browser applications Enable

XPS documents Enable

.NET Framework-reliant Components

Permissions for components with manifests High Safety

Run components not signed with Authenticode Enable

Run components signed with Authenticode Enable

ActiveX Controls and Plugins

Allow previously unused ActiveX controls to run
without prompt

Enable

Allow Scriptlets Enable

Automatic prompting for ActiveX controls Enable

Binary and script behaviors Enabled

Display video and animation on a webpage that
does not use external media player

Disable

Download signed ActiveX controls Prompt

Download unsigned ActiveX controls Prompt

Initialize and script ActiveX controls not marked as
safe for scripting

Prompt

Run ActiveX controls and plugins Prompt/Enable

Script ActiveX controls marked as safe for scripting Enable

Downloads

Automatic prompting for file downloads Enable

File download Enable

Font download Prompt

Enable .NET Framework setup Enable
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Internet Explorer Security Setting Sterling B2B Integrator

Java VM

Java permissions Medium safety

Miscellaneous

Access data sources across domains Enable

Allow META REFRESH Enable

Allow scripting of Internet Explorer web browser
control

Enable

Allow script-initiated windows without size or
position constraints

Enable

Allow webpages to use restricted protocols for
active contents

Prompt

Allow websites to open windows without address
or status bars

Enable

Display mixed content Prompt

Do not prompt for client certificate selection when
no certificates or only one certificate exists

Enable

Drag and drop or copy and paste files Prompt

Include local directory path when uploading files
to a server

Enable

Installation of desktop items Prompt

Launching applications and unsafe files Prompt

Launching programs and files in an IFRAME Prompt

Navigate sub-frames across different domains Enable

Open files based on content, not file extension Enable

Software channel permissions Medium safety

Submit non-encrypted form data Prompt

Use Phishing Filter Disable

Use Pop-up Blocker Disable

Userdata persistence Enable

Websites in less privilged web content zone can
navigate into this zone

Prompt

Scripting

Active scripting Enable

Allow Programmatic clipboard access Prompt

Allow status bar updates via script Enable

Allow websites to prompt for information using
scripted windows

Enable

Scripting of Java applets Enable

User Authentication

Logon Prompt for user name and password

6. Click OK to save your settings.
7. Click OK to save the new settings and Apply to implement the settings. The

new settings are applied when a new browser window is opened.
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System Maintenance
From time to time, you might need to perform system maintenance activities.

These activities might include:
v Performing a Checksum
v Adding or removing a license

System Maintenance:

From time to time, you may need to perform system maintenance activities.

These activities might include any or all of the following:
v Performing a Checksum
v Adding or removing a license

DB Checksum Tool:

A checksum is a simple redundancy check used to detect errors in data. The DB
Checksum tool generates the difference in resource checksum between the default
resource and the latest system resource from the database.

In Sterling B2B Integrator, a verification process compares the checksum between
the existing default resource and the resource that was added after applying a fix
pack or upgrading. The DB Checksum tool, a resource difference tool generates a
granular report of the changes in the system that was not permitted to be set as
defaults.

Perform a Checksum (Windows):
About this task

To run the DB Checksum tool in the Windows environment:

Procedure

1. Navigate to \install_dir\bin.
2. Enter db_checksum_tool.cmd [-d] [-i [1 | 2 | 3 | 4 | 5]] [-r [wfd | map

| schema | sii | template]] [-o <output file>] [-g]

Where:
-d is the mode to dump the difference of resource checksum between the
default resource and latest system resource.
-i is the resource type integer (optional).
1 is WFD.
2 is MAP.
3 is SCHEMA.
4 is SII.
5 is TEMPLATE.
-r is the resource name (optional). For example, wfd, map, schema, sii, or
template.
-o is the file name to output all the messages (optional).
-g is the file name that lists all the ignored resources (optional).
-h is the help screen.
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The DB Checksum tool performs the relevant checksum operation based on the
command options and generates the output message.

License modifications:

After the installation finishes, you can modify the software licenses that you
loaded with the AddLicenseSet command.

The AddLicenseSet command is in the bin directory of your UNIX or Windows
installation. After the initial installation, the license files are in the following
directories:
v UNIX - /install_dir/install/properties/licensefiles
v Windows - \install_dir\install\properties\licensefiles
v iSeries - /install_dir/properties/licensefiles

You can add licenses or review the license list from the UI. On the Administration
Menu, click System > B2B Console > Operations > System > Licenses.

AddLicenseSet Command Parameters

Use the AddLicenseSet command to modify a single license file or the entire license
file directory.

To use the AddLicenseSet command, you must do the following:
v Open the bin directory
v Include the absolute path to the license file directory or to a license file

The AddLicenseSet command has the following parameters:

AddLicenseSet Parameter Description

-reload Use this parameter to reload the license files.

This parameter deletes all of the license files from the
database before the new files are loaded. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/
old_licenses

v Windows - \install_dir\install\logs\security\
old_licenses

v iSeries - /install_dir/logs/security/old_licenses

-upgrade Use this parameter during an upgrade only.

This parameter deletes all of the old license files from the
database and installs the new license files. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/upgrade

v Windows -\install_dir\install\logs\security\upgrade

v iSeries -/install_dir/logs/security/old_licenses

The AddLicenseSet command will check if Sterling B2B Integrator is running. If it
is running, the command will call the Ops server to refresh the license from the
database. If you have any problems with your licenses after running the
AddLicenseSet command, stop and restart Sterling B2B Integrator.
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License Modification: Examples:

There are several different ways you can use the AddLicenseSet command to
modify your licenses.

UNIX Examples

From the install_dir/bin directory:

Scenario Command usage (UNIX example)

Reload a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -reload

Reload all of the license files
in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -reload

Upgrade a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -upgrade

Windows Examples

From the install_dir\bin directory:

Scenario Command usage (Windows example)

Reload a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -reload

Reload all of the license files
in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -reload

Upgrade a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -upgrade

Installing and Configuring Perimeter Servers
A perimeter server is an optional software tool for communications management.
A perimeter server can be installed in a demilitarized zone (DMZ). A DMZ is a
computer host or small network inserted as a neutral zone between a company's
private network and their public network. A perimeter server requires a
corresponding perimeter client.

The perimeter server manages the communications flow between outer layers of
your network and the TCP-based transport adapters. A perimeter server can solve
problems with network congestion, security, and scalability, especially in
high-volume, Internet-gateway environments.

Installation Guidelines for Perimeter Servers with Sterling B2B Integrator: The
installation program installs a perimeter client and a local mode server. The local
mode server is useful for testing purposes or in environments that do not require a
secure solution. However, if you require high-volume, secure connections, you
must install a perimeter server in a remote zone, either a more secure or less
secure network than your integration server.

Consider the following before you install a perimeter server:

Installing and upgrading (V5.2.6 or later) 59



v Licensing for a perimeter server is determined by the licensing restrictions on
the corresponding B2B adapters.

v Each perimeter server is limited to two TCP/IP addresses:
– Internal interface is the TCP/IP address that the perimeter server uses to

communicate with Sterling B2B Integrator.
– External interface is the TCP/IP address that the perimeter server uses to

communicate with trading partners. To use additional TCP/IP addresses,
install additional perimeter servers.

v You can have multiple perimeter servers installed on the same computer
interacting with one instance of Sterling B2B Integrator. To install a perimeter
server on a computer with an existing instance, install the new perimeter server
in a different installation directory.

v The combination of internal TCP/IP address and port must be unique for all
perimeter servers installed on one computer.
– If a perimeter server is installed using the wildcard address, then all ports

must be unique. The assigned ports are not available for use by adapters that
use the server or any other perimeter server on that computer.

– The internal and external interface may use the same TCP/IP address.
However, the port used by the perimeter server is not available to the
adapters that use the server.

Perimeter Server Installation Methods: You can install perimeter server either in
silent mode or in interactive mode. The default installation mode is silent. In the
silent mode, you should specify the details in a silent file, whereas in the
interactive mode, you should enter the value each time a prompt appears.

Perimeter Server Information Gathering Checklist: Before you install the
perimeter server, you need to gather the following information and answer the
following questions:

Perimeter Server Information Gathering
Checklist Your Notes

Path to java

Path to the Sterling B2B Integrator
installation directory

Will this perimeter server be installed in a
less secure network?

TCP/IP address or the DNS address that the
perimeter server will listen on.

Listening port for the perimeter server.

Local port that the perimeter server will use
to connect to Sterling B2B Integrator.

Port number must be higher than 1024.

Perimeter Server Security Vulnerabilities: When Sterling B2B Integrator is
deployed with a remote perimeter server in a more secure network zone, there is a
security vulnerability. An intruder may compromise the host where the proxy
resides, and take over the persistent connection to the perimeter server residing in
the more secure zone. If this happens, the perimeter server will relay all the
intruder's network requests past the firewall into this internal zone.
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To prevent an intrusion, limit the activities the remote perimeter server can
perform on behalf of the proxy to specifically those activities that the proxy needs
to do for its operation.

Control these limitations by using a configuration residing in the secure network
zone with the remote perimeter server, inaccessible by the proxy that could become
compromised.

Installing a perimeter server in a less secure network (Windows):
About this task

Install a perimeter server in a Windows environment in interactive mode.

Procedure

1. Close all open Windows programs.
2. Copy the .jar installation files from the installation media to a Windows

directory. If you are using FTP to copy the file, make sure that your session is
set to binary mode.

3. Complete the following steps:
a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Enter the following command:\path_to_java\java -jar

\install_dir\install\packages\ps_filename.jar –interactive

4. Enter the full path name of the installation directory.
5. If there is an existing installation in the directory you specify, you can update

it using the same settings. Answer the question:
There is an existing install at that location, update it while keeping
existing settings?

If yes, the installation proceeds without more entries.

Note: If you want to change any of the settings, you must use a new
directory, or delete the old installation before you reinstall the perimeter
server. You cannot overwrite an existing installation, and you cannot use an
existing directory that does not contain a valid installation. The existing
installation must be Sterling B2B Integrator V5.2.x or later.

6. Confirm that the installation directory is correct.
The program verifies the amount of available disk space.

7. Answer the question:
Is this server in a less secure network than the integration server?

Yes

8. Answer the question:
Will this server need to operate on specific network interfaces?

If yes, the program returns a list of the network interfaces available on your
host. Select the interfaces for the server to use.

9. Enter the TCP/IP address or DNS name for the internal interface to use to
communicate with the integration server (Sterling B2B Integrator). Press Enter
to use a wildcard for this address.

10. Verify the TCP/IP address or DNS name for the internal interface.
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11. Enter the TCP/IP address or DNS name for the external interface to use to
communicate with trading partners. Press Enter to use a wildcard for this
address.

12. Verify the TCP/IP address or DNS name for the external interface.
13. Enter the port that the perimeter server listens on for the connection from the

integration server (Sterling B2B Integrator). The port number must be higher
than 1024.

14. Verify the port.
When the perimeter server is installed, the following message is displayed:
Installation of Perimeter Service is finished

15. Change to the installation directory.
16. Enter startupPs.cmd to start the perimeter server.

Installing a perimeter server in a more secure network (Windows):

Install a perimeter server in a more secure network in a Windows environment in
interactive mode.

Before you begin

v Sterling B2B Integrator must be installed.
v Complete the Perimeter Server information gathering checklist.

Procedure

1. Close all open Windows programs.
2. Copy the .jar installation files from the installation media to a Windows

directory. If you are using FTP to copy the file, be sure that your session is set
to binary mode.

3. Complete the following steps:
a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Enter the following command:\path_to_java\java -jar

\install_dir\install\packages\ps_filename.jar –interactive

4. Enter the full path name for the Sterling B2B Integrator installation directory
and press Enter.
If there is an existing installation in the directory you specify, you can update
it using the same settings. Enter yes, and the installation proceeds without
more entries.

5. Enter yes to confirm that the installation directory is correct.
The program verifies the amount of available disk space.

6. Answer the question:
Is this server in a less secure network than the integration server?

Yes

7. Answer the question: Will this server need to operate on specific
network interfaces?

v Enter yes to select from a list network interfaces available.
v Enter no.

8. Enter the TCP/IP address or DNS name that the integration server listens on
for the connection from this perimeter server.

62 Installing and upgrading (V5.2.6 or later):



9. Enter yes to confirm the TCP/IP address or DNS name.
10. Enter the port that the integration server listens on for the connection from

this server. The port number must be higher than 1024.
11. Enter the local port number that the perimeter server uses for the connection

to the integration server.
The port number must be higher than 1024. Specify a port of zero for the
operating system to select any unused port.

12. Enter yes to confirm the port number.
After the installation is complete, the following messages are displayed:
Installation of Perimeter Service is finished

To start this Perimeter Server change to the install directory and run
the startup script.

You will also need to configure this server in your integration server
(SI) UI.

Silent Installation Method for an External Perimeter Server: You can install an
external perimeter server using a silent install file. The perimeter server can be
installed on the same machine where you have installed Sterling B2B Integrator or
on a separate machine. It is recommended to install the perimeter server on an
separate machine.

To use the silent installation method, you first create the silent install file and then
you use to complete the installation.

Create the Silent Installation File for an External Perimeter Server:
About this task

Create a silent installation file with the following variables:

Entry Description

INSTALL_DIR (Required) The installation directory that stores perimeter server
files and related directories. This directory must exist prior to
running the silent install.

REVERSE_CONNECT (Optional) Determines if the perimeter server is to be installed in a
more secure network zone. Valid values:

v Y - more secure network zone

v N - less secure network zone

PS_PORT (Required) Determines the perimeter server port to interact with
the system.

PS_SECURE_IF (Required) Determines the TCP/IP address or DNS name for the
internal interface to communicate with the integration server
(Sterling B2B Integrator). You can use a wildcard (*) for this
address.

PS_EXTERNAL_IF (Required) Determines the TCP/IP address or DNS name for the
external interface to communicate with the trading partners. You
can use a wildcard (*) for this address.

REMOTE_ADDR (Optional) Determines the remote perimeter server address.

(Not required if REVERSE_CONNECT=N)

REMOTE_PORT (Optional) Determines the remote perimeter server port.

(Not required if REVERSE_CONNECT=N)
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Entry Description

MAX_JVM_HEAP (Required) Determines the maximum Java heap size allocated to
the JVM.

Installing an external perimeter server with a silent installation file (Windows):

Install an external perimeter server with a silent installation file.

About this task

Before you begin, create the silent installation file.

Procedure

1. From the installation media, copy SI.jar to a Windows directory.
2. Set up your silent installation file and record the file location.
3. Complete the following steps:

a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Enter the following command:\path_to_java\java -Xmx512m -jar

\install_dir\install\packages\ps_filename.jar –f silent.txt

Install a Fix Pack in a Remote Perimeter Server (Windows):
About this task

Remote perimeter servers are not automatically updated by a fix pack. You must
reinstall the perimeter server using the new perimeter server installation file
supplied with the fix pack.

To update a Remote Perimeter Server:

Procedure

1. Update your installation with the latest fix pack. Obtain the fix pack from the
Support Center web site.

2. Locate your perimeter server file in the install_dir\install\packages directory of
your installation. For fix packs, obtain the file from the Support Center web
site. These files have a name that identifies a version number. For example,
ps_2006.jar.

3. Copy the file to a directory on the remote server.
4. Stop the perimeter server.
5. Complete the following steps:

a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Enter the following command:\absolutePath\bin\java -jar filename.jar

-interactive

Where the absolutePath is the directory name where the Java version is
installed.

6. Enter the full path to the installation directory. If you do not want to change
any settings for your perimeter server, specify the same directory where the
remote perimeter server was originally installed.
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7. Answer the question:
There is an existing install at that location, update it while keeping
existing settings?

If yes, the installation will proceed without additional entries.

Note: If you want to change any of the settings, you must use a new directory,
or delete the old installation before performing the new installation. You cannot
overwrite an existing installation, and you cannot use an existing directory that
does not contain a valid installation. The existing installation must be V5.2 or
later.
When the perimeter server is installed, the following message is displayed:
Installation of Perimeter Service is finished

8. Change to the installation directory.
9. Start the perimeter server.

Grant Permissions for Specific Activities for a Perimeter Server:
About this task

Before you begin:
v Remote perimeter server must be installed for a more secure zone.
v Know what permissions you want to grant
v Understand the content of the restricted.policy file. The first two grant sections

in the restricted.policy file are required for correct perimeter server operation.
Do not modify these sections.

Procedure

1. Install a remote perimeter server, choosing the option for a more secure
network zone.

2. At the installation prompt Is this server in a less secure network than the integration
server?, select No, which is the option for a more secure network zone.

3. Navigate to the perimeter server installation directory.
4. Open the restricted.policy file.
5. Add permission lines for each back-end server that you intend to allow the

proxy to access. There are commented out examples for each type of server.
The first two grant sections are required for correct perimeter server operation.
Do not modify these sections.
For example, you can grant permission to a target FTP Server. In the example,
servers are configured to listen on the following ports: 33001 (for FTP), 33002
(for HTTP), and 1364 (for C:D). These port numbers can be edited.
// To restrict or permit the required Host/Server to communicate with the
PS, update the “ftphost/htttphost/snode” with that of the Server IP and
provide the appropriate PORT number where the Server will listen. //
// For each target FTP Server
// permission java.net.SocketPermission "10.117.15.87:33001", "connect"; //
Control connection.
// permission java.net.SocketPermission "10.117.15.87:lowPort-highPort",

"connect"; // Passive data connections.
// 10.117.15.87 indicates IP of the FTP Server for which the permission is

granted by PS for communicating with client //
// For each target HTTP Server
//
// permission java.net.SocketPermission "10.117.15.87:33002", "connect";
// 10.117.15.87 indicates IP of the HTTP Server for which the permission

is granted by PS for communicating with client //
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// For each target C:D snode
//
// permission java.net.SocketPermission "snode:1364", "connect";
// 10.117.15.87 indicates IP of the Connect Direct Node for which

the permission is granted by PS for communication //

6. In the perimeter server installation directory, there is the perimeter server
settings file called remote_perimeter.properties. Edit it to change the "restricted"
setting to a value of true to turn on restrictions.

7. In the future, any attempt by the perimeter server to access disallowed network
resources will be rejected and logged in the perimeter server log written to the
perimeter server installation directory.

Perform DNS Lookup on Remote Perimeter Server:
About this task

By default, a perimeter server performs DNS lookup in the main server JVM. If
you have limited DNS in your secure area, you can configure the remote perimeter
server to look up trading partner addresses in the DMZ.

To enable DNS lookup, add the following property to
customer_overrides.properties. Set the value to true:

Property Name Description

perimeter.*.forceRemoteDNS=true Forces resolution of DNS names at remote
perimeter server.

Set the value to true to configure remote
perimeter servers to look up trading partner
addresses.

Start Perimeter Servers (Windows):
About this task

To start a perimeter server in Windows:

Procedure

1. Navigate to the perimeter server installation directory.
2. Complete the following steps:

a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
3. Enter startPSService.cmd.

Stop Perimeter Servers in (Windows):
About this task

To stop a perimeter server in Windows:

Procedure

1. Complete the following steps:
a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
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2. Enter stopPSService.cmd.

Uninstall Sterling B2B Integrator from a Windows Cluster
Environment
Before you begin

If you have installed Sterling B2B Integrator software using IIM, then perform
these steps to unregister Sterling B2B Integrator packages from the IIM registry:
v Launch IIM.
v Click Uninstall and select the required Sterling B2B Integrator package (Media,

FixPack, or Interim Fix).
v Confirm and click Uninstall.

About this task

To uninstall Sterling B2B Integrator from a Windows environment, perform the
following steps for each node:

Procedure
1. Navigate to \install_dir\install\bin.
2. Enter StopWindowsService.cmd. Wait for the shutdown to complete. If you begin

removing files before all business processes and the system is stopped, you
may be unable to remove the software successfully.

3. Back up the file system and database.
This step is optional. However, by backing up the file system and database,
you are ensured that Sterling B2B Integrator is completely recoverable.

4. Remove the installation directory by entering the following command in the
parent directory of your installation directory: rd /s /q \install_dir\install

5. If you use an Oracle, Microsoft SQL Server, or DB2 database, these remain
intact even after you remove Sterling B2B Integrator from the server. If you no
longer want to reference the data, contact your database administrator about
removing unwanted tables and recovering the database space where Sterling
B2B Integrator used to reside.

6. Navigate into the _uninst subdirectory of your JDK installation directory.
7. To manually remove the JDK, enter uninstall.cmd.
8. After you remove Sterling B2B Integrator from the server, you can remove

Eclipse, and any tools that were downloaded to the desktop, including the
following:
v Map Editor and associated standards

Refer to the Map Editor Guide for information about removing the Map
Editor.

v Graphical Process Modeler
Refer to the Graphical Process Modeler Guide for information about removing
the Graphical Process Modeler.

v Web Template Designer
Refer to the Web Extensions Guide for information about removing the Web
Template Designer.

v (If licensed) MESA Developer Studio plug-ins, including:
– MESA Developer Studio Software Development Kit (SDK)
– MESA Developer Studio Skin Editor
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Refer to the MESA Developer Studio guide for information about removing
MESA Developer Studio.

v (If licensed) Reporting Services, which requires MESA Developer Studio if
you want to use the plug-ins to create fact models and custom reports. Refer
to the MESA Developer Studio guide for information about removing
Reporting Services.

User Documentation
The user documentation is available from an online documentation site on the
web.

Providing the documentation in an online environment allows for frequent updates
of content that is based on user feedback and usability.

If you need a printed copy of the documentation, you can print topics of
information through your Internet browser, or you can download documents in
PDF format, after you add it to a collection on IBM Knowledge Center.

To access the documentation site from within Sterling B2B Integrator or one of its

tools, select the help 
 

icon. The system must reside on a computer that supports
Internet access and an Internet browser.

Improving your access to online documentation:

You can improve your access to online documentation by using several methods.

About this task

After you access the IBM Knowledge Center, you can perform the following tasks:
v Enter a word or phrase and search the entire library for information.
v Move through a hierarchy of contents pages to identify the topic you want to

read or print.
v Print topics by using your browser's Print function.
v Add documents to your collection and download them in PDF format.

Troubleshooting Tips for Windows Environment

Situation Message or Symptom Explanation/Resolution

Installing You encounter errors or problems during
installation.

Explanation

The installation creates several log files that
you can use to diagnose problems like the
failure of an installation.

Resolution

Examine the log files generated during
installation:

v ant.install.log (in the install_dir directory)

v install_dir\PreInstallSI.log
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Situation Message or Symptom Explanation/Resolution

Installing When you entered an absolute path during
installation, a message indicated that the
command was not found.

Explanation

You entered an incorrect path. Check the
information entered.

Resolution

Enter the correct path.

Installing IM is installed successfully, but SI Fails to
install.

Go to Start Open IM select Help and then
Export logs to a file for analysis.

Installing a desktop
tool or resource

Cannot download any of the following:

v Map Editor and associated standards

v Graphical Process Modeler

v Web Template Designer

v (If licensed) MESA Developer Studio
plug-ins, including:

– MESA Developer Studio Software
Development Kit (SDK)

– MESA Developer Studio Skin Editor

v (If licensed) Reporting Services, which
requires MESA Developer Studio if you
want to use the plug-ins to create fact
models and custom reports.

Explanation

When you install Sterling B2B Integrator,
system files are created that contain an
internal IP address. If you install Sterling
B2B Integrator behind a firewall, and your
firewall is configured to accept an external IP
address from a client computer, you may not
be able to download the desktop tools and
resources. The firewall will reject the internal
IP address from a client residing outside of
the firewall.

Resolution

Modify the system files that contain the
invalid IP address. Follow these steps:

1. Navigate to \install_dir\install\bin.

2. Stop Sterling B2B Integrator.

3. Enter the following command followed
by the external IP address:

patchJNLP.cmd external_IP_address

4. Restart Sterling B2B Integrator.

Cluster Installation or
Upgrade

When configuring TCPS the following
warning can be found in the
activemqbroker.log:

sun.security.provider.certpath.
SunCertPathBuilderException:
unable to find valid certification
path to requested target

Resolution

Add the system certificate to the trust store
using the KeyTool command.

Cluster Installation or
Upgrade

When configuring TCPS the following
warning can be found in the
activemqbroker.log:

Do not mention any
SSL cipher in the ActiveMQconfig.
xml. oracle.net.ns.NetException:
Invalid cipher suites specified.

Resolution

Do not mention any SSL cipher in the
ActiveMQconfig.xml.
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Situation Message or Symptom Explanation/Resolution

e-Invoice Upgrade:
Oracle Add Constraint
Error

When you upgrade Sterling e-Invoicing and
are using an Oracle database, if the upgrade
fails with the error message name is already
used by an existing object, this occurs
because the default behavior for the drop
constraint command changed in Oracle 10.

Explanation

The index that is used to support the
constraint is now only removed if the index
was generated by the create constraint
command. The indexes for Sterling
e-Invoicing are always generated from
constraints during an install. If you receive
this error during a Sterling e-Invoicing
upgrade, it is because of how the database
was restored, the version of Oracle you are
using, and because the Oracle imp command
exported the indexes and constraints
separately. There is no way to determine
when the imp command will not add a
create index command to the export file if it
was generated by a constraint – but if it does
add the command, the database restore
process loses the association of the constraint
and its underlying index. The database script
that runs during a Sterling e-Invoicing
upgrade executes two steps: 1. First, it drops
the unique constraint so the next step can
redefine it using additional columns.
However, the drop constraint command does
not remove the underlying index if the
association with its index was lost. 2. The
next command that redefines this constraint
requires a different index definition, but in
this scenario the name of the index the
constraint wants to use already exists, which
causes the name is already used by an
existing object error.

Resolution

If you receive this error message, the
solution for this problem is to drop the index
and rerun the Sterling e-Invoicing upgrade.
The drop index command you should use is:
drop index UNQ_EINV_CANON
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Situation Message or Symptom Explanation/Resolution

Apply a fix pack or
Upgrade

The \install_dir\install\installed_data
directory is created (if clustered, on each
node) during an upgrade or applying a fix
pack.

This directory can become very large and
take up needed space on the file system.

Explanation

The information in this directory is used
during upgrade or applying a fix pack, but is
not required afterward. The
deployment/cleanup tasks for the upgrade
or fix pack do not remove this directory.

Resolution

The directory can be manually removed to
increase the available space for the file
system:

1. Navigate to \install_dir\install

2. Enter

rd /S installed_data

3. If prompted to confirm deletion, enter Y
for yes.

Windows Non-Cluster Environment Installation (V5.2.6 or later)
You may follow different installation and upgrade scenarios when you install and
upgrade Sterling B2B Integrator in a Windows Non-Cluster (single node)
environment.

Installation Scenarios

It is important to review the following installation scenarios:

Scenario Instructions

Version 5.1.x is installed and it needs to be
upgraded to V5.2.6.

See “Upgrading (V5.2.6 or later)” on page
320

Version 5.2.x is installed and it needs to be
upgraded to V5.2.6.

See Applying a fix pack (V5.2.6 or later)

Version 5.2.6 is being installed as the base
release.

Review this document and use the
installation instructions.

Prerequisite Knowledge for Windows Installation
Before you begin the installation, you should be knowledgeable on the following
topics:
v Application servers
v Database administration
v System Requirements for this release of Sterling B2B Integrator.

Intended audience:

This document can be used by different members of your organization.

This document is intended for use by:
v System administrators
v Installation engineers
v Database administrators.
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Assumptions for this guide:

The procedures in this guide are accurate as of the publication date and are
specific to this version of the document.

Before You Begin the Installation in a Windows Environment
Before you begin the installation, you need to:
v Perform some system verification tasks.
v Obtain the correct version of the JDK, JCE, and JDBC drivers required. Most

Java files required are provided with the product download or media. See the
System Requirements for more information.

System Verification Tasks for a Windows Environment: Before you begin an
installation, you need to:

# System Verification Items Your Notes

1 Use the system requirements to verify that your
system hardware and software meet the
requirements specified for this release.

Verify you have the correct:

v Patches required by Java™ for the operation
system

v Version of the JDK

v Absolute path to JDK and patches

2 Verify the file system has adequate free disk space.

3 Verify that your database has been installed and
configured.

If you are going to manually apply DDL
statements, you need to complete the data base
schema work before you begin the installation.

4 If you are using a non-English environment,
confirm that you are using the appropriate
character set.

Verification of the system requirements:

Before you begin the installation, verify that your system meets the hardware and
software requirements that are specified for this release.

The hardware requirements that are listed in the System Requirements are the
minimum requirements. Your system requirements might exceed these
requirements if you are running other applications on the same machine as Sterling
B2B Integrator.

The installation strictly enforces the following system requirements:
v Operating system version must match requirement exactly.
v The minimum patch level for the operating system is enforced, but you can

apply higher patch levels.
v JDK version must match requirement exactly.
v The disk space is a minimum for the installation. The system must be separately

sized to handle whatever load is going to be put on the system.
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v Database version must match exactly.
v JDBC driver version supports exact matches and wildcard matches.

If any of these requirements are not met, the installation fails. If the installation
fails, review the installation log for a list of non-compliant items.

Upgrading your JDK (Windows and UNIX):

Sometimes you need to upgrade your JDK version to support a new version of
Sterling B2B Integrator.

About this task

If you have V5.2.4.1 or higher installed, you can use the upgradeJDK script to
upgrade your version of the JDK. See bin Directory Files for more information.

If you have V5.2.4.0 or lower installed, follow the steps below to upgrade your
JDK.

Procedure

1. Download the new JCE file. For example, the UnrestrictedPolicy.zip policy
file for the IBM JDK.

2. Back up the existing JDK in <Install Dir>/jdk. Change the folder name to
jdk_back)

3. Copy the new IBM JDK (1.7.0 ) folder to the installation Directory. Directory
Name should be jdk )

4. Copy all the jars present in <Install Dir >jdk_back\jre\lib\ext to <install
Dir>jdk\jre\lib\ext directory.

5. If your installation of V5.2.4 or lower was built using the Oracle (SUN) JDK,
continue to the next step. Otherwise skip to step 6.
a. Edit the sandbox.cfg property file.
b. Set JCE_DIST_FILE=<New Path of Supported JCE File>. For example,

JCE_DIST_FILE=D\:\\IBM\\unrestrictedpolicyfiles.zip.
c. Back up the local_policy.jar and US_export_policy.jar files present in

<Install Dir>jdk\jre\lib\security.
d. Unzip the new JCE file. For example, Unrestrictedpolicyfiles.zip file.

Copy local_policy.jar and US_export_policy.jar to <Install
Dir>jdk\jre\lib\security.

6. Run updateJavaSecurity.cmd <path_to_new_jdk><Install Dir>/jdk.
7. Verify that security providers have been updated in <Install

Dir>\jdk\jre\lib\security\java.security.
8. Follow the Upgrade Guide instructions for your upgrade scenario.

Configure the Database
You must install, create, and configure a database so that each Sterling B2B
Integrator instance has a dedicated schema and login for the database.

In a non-clustered environment, the Sterling B2B Integrator can support the
following databases:
v DB2
v Oracle®

v Microsoft SQL Server
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v MySQL
Attention: MySQL will not be supported in Sterling B2B Integrator after V5.2.6.
See http://www.ibm.com/support/knowledgecenter/SS3JSW_5.2.0/
com.ibm.help.sb2bi_overview.doc/com.ibm.help.whats_new.doc/
526_next_retirement_list.html for more information.

See System Requirements for supported version information.

Database Information You Need Before You Install Sterling B2B Integrator in a
Non-Cluster Environment: Before you begin to install Sterling B2B Integrator, you
need to install and configure your database. Review and gather the following
information. An “x” indicates the information is required.

Information to Gather Oracle DB2
Microsoft SQL
Server MySQL

Record Information
Here

Database User Name x x x x

Database Password x x x x

Database Catalog
Name

x x x x

Database Host x x x x

Database Port x x x x

JDBC Driver #1 x x x x

Use BLOB data? x x

Enable Multibyte
Support?

x x x

Database sizing and capacity planning:

Database sizing is designed to give you estimates of the database growth and to
help you plan the disk requirements.

There are many factors to consider when you are estimating the amount of disk
space that is required for Sterling B2B Integrator. As a result, trying to consider all
growth factors is impractical because the user might not know the answers to
many questions that are required to do a detailed forecast. Over the years the cost
of disks has dramatically decreased, and the capacity and speed of disks has
increased. The method of how information system managers order disk capacity
also has changed, from purchasing disk arrays that are dedicated to a particular
database server and project, to the concept of SANS (storage area networks).

Consider the confidence that you have in your data estimates when you are
making the final purchase decision and adjust accordingly. After the initial
purchase and production deployment, disk growth should be tracked for future
purchase forecasts.

You should track your actual database storage usage and the number of database
records regularly. Correlating these two metrics enabled you to plan your future
disk requirements. Moreover, determining the average amount of space used for
each order line or shipment line, enables you to accurately predict your future
growth requirements.
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Database Definition Language (DDL) Statements: When you install Sterling B2B
Integrator, you can manually apply Database Definition Language (DDL)
statements to your database tables instead of requiring the installation process to
do it directly.

This feature increases database security by reducing the database permissions of
the Sterling B2B Integrator database user. The rights to database objects can be
reserved for a secure user like a customer database administrator (DBA). A
business can require that only a DBA with the proper permissions can make
database changes.

Configuring the DB2 Database:

Before you install Sterling B2B Integrator with the DB2 database, you must
configure the database.

Before you begin:
v If you do not have DB2 installed, follow the procedures in the DB2 installation

manual.
v The installation script creates tables and indexes. Certain tables require a page

size of 32 KB. You must have a temporary table space to accommodate such
tables. DB2 automatically places tables and indexes in the available table spaces.
You can move the tables to a different table space after the installation is
complete.

v If you are reinstalling the software, be aware that data in your existing database
is deleted. To preserve the data, either back up the existing database or save it
under a different name.

v After you create and configure your database, recycle the database. Then, stop
and restart the database to apply the changes.

Use the following checklist to configure DB2 for Sterling B2B Integrator:

Item DB2 Database Configuration Checklist Your Notes

1 Create the database.

Refer to the DB2 documentation on creating the
database, including creating a schema repository,
login, and table space.
Important: In V5.2.6.2 or later you must ensure
that all tablespaces used by Sterling B2B
Integrator tables have a minimum page size of
8K. Otherwise installation will fail.

Be sure to install the correct version and patches.
See the System Requirements for supported
version information.

3 Review the DB2 parameters.

4 Ensure that the DB2 user privileges are set.

5 Install the JDBC drivers for DB2.

DB2 database user privileges:

The DBADM role is required to perform administrative operations in DB2
database.
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DB2 parameters:

When you install Sterling B2B Integrator with the DB2 database, you must set
certain DB2 parameters. Other DB2 parameter settings are recommended for the
efficient performance of Sterling B2B Integrator.

When you install Sterling B2B Integrator with DB2, you must set the DB2
parameters that are listed in the following topics:
v “Mandatory settings for IBM DB2 registry variables” on page 6
v “Mandatory settings for DB CFG parameters” on page 6

After you install Sterling B2B Integrator with DB2, you can improve the DB2
database performance by setting the recommended parameters that are listed in the
performance documentation for the following items:
v DB2 registry variables
v DBM CFG parameters
v DB CFG parameters
v DB2 for Linux on System z
v DB2 for LUW configuration and monitoring

Mandatory settings for IBM DB2 registry variables:

Mandatory IBM DB2 registry values are critical for IBM DB2 performance with
Sterling B2B Integrator.

Variable Mandatory value

DB2_SKIPDELETED ON

Allows index-range queries or table-scan queries to skip
records that are in an uncommitted delete state. This
reduces the amount of lock contention from Read Share
and Next Key Share locks from range queries in tables
with a high frequency of deletes.

When enabled, DB2_SKIPDELETED allows, where
possible, table or index access scans to defer or avoid
row locking until a data record is known to satisfy
predicate evaluation. This allows predicate evaluation
to occur on uncommitted data.

This variable is applicable only to statements using
either Cursor Stability or Read Stability isolation levels.
For index scans, the index must be a type-2 index.
Deleted rows are skipped unconditionally on table scan
access while deleted keys are not skipped for type-2
index scans unless DB2_SKIPDELETED is also set.

Recommended value: ON

DB2_SKIPINSERTED ON

Allows SELECTs with Cursor Stability or Read Stability
isolation levels to skip uncommitted inserted rows. This
reduces record lock contention on tables with heavy
insert rates.
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Mandatory settings for DB CFG parameters:

For optimal performance, certain parameters and values are mandatory for DB2.

Parameter Mandatory value

Database Code Set UTF-8

Installing DB2 client components, compilers, and fix pack:

The use of Sterling B2B Integrator with the DB2 database requires the installation
of different items for the database.

About this task

Sterling B2B Integrator uses stored procedures for DB2. For more information
about these tasks, see the IBM documentation for DB2.

Procedure

You must install or set up the following DB2 components to use Sterling B2B
Integrator with DB2:
1. Install the Administration client.
2. Install the necessary fix pack after you install the client components and

compilers. Otherwise, the clients overwrite the fix pack binary files.
3. Set the path for the compiler by entering the db2set command.

Installing JDBC drivers for DB2:

When you install Sterling B2B Integrator with the DB2 database, you must install a
JDBC driver for the database.

About this task

For DB2, install the appropriate DB2 JDBC Type 4 driver and any correlating
patches. For the supported version information, see System Requirements.

You can obtain these files from the IBM website. After you obtain this JDBC driver,
record the absolute path to its location on your system. You must supply this
absolute path during installation.

If the JDBC driver provided by your database vendor is distributed among
multiple files, you must place all the files that comprise the JDBC driver into one
JAR file. Follow these steps to create one JAR file:

Procedure

To install a JDBC driver for the DB2 database:
1. Identify all the vendor database JAR files for the JDBC driver.
2. Record the absolute path to the JAR file you created on the Preinstallation

Checklist.
The Type 4 driver does not require a separate Java listener to be running on the
database server. Instead, connect directly to the DB2 port.
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Upgrading DB2 to version 10.1 or 10.5:

To upgrade from DB2 9.5 or 9.7 to 10.1 or 10.5, you must make configuration
changes.

Procedure

To upgrade from DB2 9.5 or 9.7 to 10.1 or 10.5:
1. Copy your DB2 9.5 or 9.7 database content to DB2 10.1 or 10.5.

Attention: Back up all files before you change any settings.
2. Back up the database driver in the /install_dir/dbjar/jdbc/DB2/ directory

and replace it with the DB2 10.1 or 10.5 version.
3. Update the following sandbox.cfg file fields with your environment-specific

parameters:
DB_PASS=
DB_SCHEMA_OWNER=
DB_DRIVERS_VERSION=
YANTRA_DB_PORT=
DB_DATA=
DB_HOST=
YANTRA_DB_USER=
DB_PORT=
YANTRA_DB_PASS=
YANTRA_DB_DATA=
YANTRA_DB_HOST=
DB_DRIVERS=
DB_USER=

DB2_PORT=
DB2_USER=
DB2_PASS=
DB2_DATA=
DB2_HOST=

4. Edit the following value in the activemq.xml file:
activemq.xml: <value>jdbc:db2//DB_HOST:DB_PORT/DB_DATA</value>

5. Run the setupfiles script.
6. Run the deployer script.
7. Start Sterling B2B Integrator.

Configuring the Oracle Database:

Before you install Sterling B2B Integrator with the Oracle database, you must
configure the database.

Before you begin

v If you are reinstalling the software, be aware that data in your existing database
is deleted. To prevent this deletion, either back up the existing database or save
it under a different name.

v After you create and configure your database, recycle the database. Then, stop
and restart to apply the changes.
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About this task

Use the following checklist to configure Oracle for Sterling B2B Integrator:

Item
Oracle Database Configuration
Checklist Your Notes

1 Create the database.

Refer to the Oracle documentation
on creating the database, including
creating a schema repository, login,
and table space.

Be sure to install the correct version
and patches.

See the System Requirements for the
supported version information.

2 Configure an Oracle Instance.

3 Configure Oracle Rollback.

4 Install the Oracle JDBC Driver.

5 Enable Failover in a Multiple Node
Oracle RAC Database Cluster.

6 After Sterling B2B Integrator is
installed, if you want to encrypt the
data traffic, perform one of the
following tasks:

v Configure Sterling B2B Integrator
for Data Traffic Encryption

v Configure Sterling B2B Integrator
for Data Traffic Encryption with
SSL

Configuring an Oracle instance:

An Oracle database requires certain parameter settings and other configurations.

Before you begin

v You must have the Oracle database installed. Ensure that you have installed the
correct versions and patches. See System Requirements for supported version
information.

v Ensure that the user responsible for creating and modifying the Oracle database
has a specified quota (extent) assigned in the table space, even if the user was
assigned an unlimited table space. Otherwise, the installer might display the
error ORA-09150: no privileges on tablespace name.

Procedure

1. Run the create instance procedure. Use AL32UTF8 as the character set.
2. Configure the INIT<INSTANCE_NAME>.ORA file with the recommended and

mandatory settings in the Performance Management guide. See the Oracle init
parameter configuration checklist for specific settings.
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Note: After you complete the installation of Sterling B2B Integrator with
Oracle, you can improve the performance of the database with the settings
listed in the Performance Management guide.

3. Identify or create a table space for user tables and indexes.
4. Create a user. Unless stated for a task, the user does not require database

administrator (DBA) privileges.
5. Grant permissions to the user. The following permissions are required for the

administrative user for creating and modifying the Oracle database:
v GRANT "CONNECT" TO SI_USER

v ALTER USER SI_USER DEFAULT ROLE "CONNECT"

v GRANT CREATE SEQUENCE TO SI_USER

v GRANT CREATE TABLE TO SI_USER

v GRANT CREATE TRIGGER TO SI_USER

v GRANT SELECT ON CTXSYS.CTX_USER_INDEXES TO SI_USER

v GRANT SELECT ON SYS.DBA_DATA_FILES TO SI_USER

v GRANT SELECT ON SYS.DBA_FREE_SPACE TO SI_USER

v GRANT SELECT ON SYS.DBA_USERS TO SI_USER

v GRANT SELECT ON SYS.V_$PARAMETER TO SI_USER

v GRANT SELECT ANY DICTIONARY TO SI_USER

v GRANT ALTER SESSION TO SI_USER

v GRANT CREATE SESSION TO SI_USER

6. If you are using Oracle AQ, grant the AQ_ADMINISTRATOR_ROLE
permission.

7. If you plan to use EBICS Client, grant the GRANT CREATE VIEW TO SI_USER
permission.

Configuring Oracle rollback:

The configuration of rollback in an Oracle database helps you manage database
transactions.

About this task

You can roll back changes in Oracle by using AUTO UNDO management. IBM
recommends that you use this option. This practice avoids any manual monitoring
of UNDO segments.

Installation of the Oracle JDBC driver:

Sterling B2B Integrator requires the appropriate JDBC driver for the Oracle
database.

The JDBC drivers are thin client-based pure Java JDBC drivers. See System
Requirements for supported version information. The supported versions of the
JDBC driver build the correct Sterling B2B Integrator directory structure.

Enabling failover in a multiple node Oracle RAC database cluster:

You can enable failover in a multiple node Oracle RAC database cluster in
UNIX/Linux by using traditional RAC or RAC with SCAN.
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Procedure

To enable failover in a multiple node Oracle RAC database cluster:
1. Open the /install_dir/install/properties directory to modify the

sandbox.cfg file.
2. In the sandbox.cfg file, add a ORACLE_JDBC_URL property, which contains the

Oracle RAC connection URL.
Choose one of the following depending on whether you are using traditional
RAC or RAC with SCAN. The property value must be one string of text that
starts with ORACLE_JDBC_URL=. Your database administrator (DBA) can modify
this URL as needed:
v To configure traditional RAC, use this format:

jdbc:oracle:thin:@
(DESCRIPTION=
(ADDRESS_LIST=
(FAILOVER=ON)
(LOAD_BALANCE=OFF)
(ADDRESS=(PROTOCOL=TCP)(HOST=myhost1)(PORT=1521))
(ADDRESS=(PROTOCOL=TCP)(HOST=myhost2)(PORT=1521))
)
(CONNECT_DATA = (SERVER = DEDICATED)(SERVICE_NAME=myservicename OR mySID))
)

Note: This method uses the default Oracle RAC service that is provided by
Oracle.

v To configure RAC with SCAN, use this format:
jdbc:oracle:thin:@host:port/service

For example:
jdbc:oracle:thin:@RAC-SCAN:1521/ORCL

Where:
– RAC-SCAN is resolved to an IP address by DNS
– 1521 = Port number
– ORCL = the name of your Oracle RAC service

Important: To use RAC with SCAN, you must also define a new Oracle
RAC service (you cannot use the default service) that defines one node as
the preferred node and at least one node as a failover node.

3. Open the /install_dir/install/bin directory.
4. Enter the command ./setupfiles.sh.

Data traffic encryption in the Oracle database:

You can encrypt transactions between Sterling B2B Integrator and the Oracle
database. Encryption prevents anyone who is outside the system from viewing the
data that flows between Sterling B2B Integrator and the database.

The following list describes important aspects of enabling database encryption:
v At installation, encryption is turned off by default. If you want your database

transactions to be encrypted, you must enable encryption.
v The encryption can be enabled at any time.
v Encryption applies to all database transactions between Sterling B2B Integrator

and the database.
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System performance might be impacted when encryption is enabled. The extent of
this impact depends on your hardware, database configuration, transaction
volume, and the relative amount of processing time that is spent by the system
against other activities.

For more information on data traffic configuration, see SSL With Oracle JDBC Thin
Driver.

Before you encrypt data traffic for the Oracle database:

The decision to encrypt data traffic for the Oracle database includes several
considerations.

Consider the following items when you configure database traffic encryption:
v Sterling B2B Integrator must be installed in TCP (clear) mode before you can

configure encryption.
v Perform these changes to your database before you install Sterling B2B

Integrator.
v Configure wallets for encryption-only mode even if the wallet that is used is

empty. Enable auto login for all wallets.
v If you want to use SSL for encryption only, it is recommended to follow the

instructions in the "CASE #1: USE SSL FOR ENCRYPTION ONLY" section of the
Oracle documentation. It is not necessary to configure certificates for the wallet.
In this mode, Diffie-Hellman ciphers are used. The server and the client are not
authenticated through SSL. You must authenticate by using a user name and a
password. However, if you are running Sterling B2B Integrator on an operating
system that requires an IBM JDK, you cannot use this mode, as IBM JSSE
TrustManager does not permit anonymous ciphers. You must configure wallets
with certificates.

v If you want to use SSL for encryption and for server authentication, it is
recommended to follow the instructions in the "CASE #2: USE SSL FOR
ENCRYPTION AND SERVER AUTHENTICATION" section of the Oracle
documentation.

v If you want to use SSL for encryption and for server authentication of both tiers,
it is recommended to follow the instructions in the Oracle "CASE #3: USE SSL
FOR ENCRYPTION AND AUTHENTICATION OF BOTH TIERS" section of the
Oracle documentation, depending on how you intend to configure client or
server authentication.

v After you configure your database for data traffic encryption, the database
accepts both TCP (clear) and TCPS (encrypted) connections.

v There is a known issue in the Oracle 11g database when the listener is
configured only for TCPS. The lsnrctl utility that is used to start and stop
database listeners attempts to contact the listener, which is enabled first. You
should define the address list of the listener to contact either TCP or IPC before
it contacts TCPS.

Configuring Sterling B2B Integrator for data traffic encryption in Oracle:

You can enable data traffic encryption-only, with anonymous authentication, and
not SSL authentication.
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About this task

If you want to use SSL for encryption only, it is recommended to follow the
instructions in the "CASE #1: USE SSL FOR ENCRYPTION ONLY" section of the
Oracle documentation. It is not necessary to configure certificates for the wallet. In
this mode, Diffie-Hellman ciphers are used, and the server and the client are not
authenticated through SSL. You must authenticate by using a user name and a
password.

However, if you are running Sterling B2B Integrator on a system that requires an
IBM JDK, you cannot use this mode, as IBM JSSE TrustManager does not permit
anonymous ciphers. You must configure wallets with certificates.

This procedure is applicable only if you are running Sterling B2B Integrator on a
system that requires Sun JDK. The IBM JSSE TrustManager does not permit
anonymous ciphers.

If your Sterling B2B Integrator is a cluster installation, you need to perform this
procedure on each node, starting with node 1.

Procedure

To configure Sterling B2B Integrator for data traffic encryption in Oracle:
1. Install Sterling B2B Integrator in TCP (clear) mode.
2. Stop Sterling B2B Integrator.
3. Open the /install_dir/install/properties directory.
4. Open the customer_overrides.properties file and add the following database

connection information:
jdbcService.oraclePool.prop_oracle.net.ssl_cipher_suites=
(SSL_DH_anon_WITH_3DES_EDE_CBC_SHA, SSL_DH_anon_WITH_DES_CBC_SHA)
jdbcService.oraclePool.prop_oracle.net.ssl_server_dn_match=false

If you have a configured container, ensure that the same database information
is added to the customer_overrides.properties.in file. To locate the file,
navigate to the /install_dir/install/properties/nodexACy directory, where x
gives the node number and y gives the container number. Perform this step
for all the containers configured in the system.

5. Repeat Step 4 for the following Oracle connection pools by changing only the
pool name:
v oraclePool_local

v oraclePool_NoTrans

v oracleArchivePool

v oracleUIPool

If you have any other database pools, you need to add the properties for those
pools.

6. Open the sandbox.cfg file and change the database connection information as
shown:
ORACLE_JDBC_URL= jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS=(PROTOCOL=tcps)
(HOST=<DB host>)(PORT=<TCPS port as configured in DB config section above>))
(CONNECT_DATA=(SERVICE_NAME=<service name>)))

Make sure that you enter values for the HOST, PORT, and SERVICE_NAME
parameters.
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7. Open the activemqconfig.xml.in file and modify the following database
connection information:
v Remove or comment out the following default ActiveMQ database

configuration information:
<bean id="gis-ds" class="org.apache.commons.dbcp.BasicDataSource"
destroy-method="close" singleton="true" lazy-init="default"
autowire="default" dependency-check="default"
SCIOverrideName="persistence-bean">

<property name="driverClassName">
<value>oracle.jdbc.driver.OracleDriver</value>
</property>
<property name="url">
#:ifdef ORACLE_JDBC_URL
<value>&ORACLE_JDBC_URL;</value>
#:else
<value>jdbc:oracle:thin:@&ORA_HOST;:&ORA_PORT;:&ORA_DATA;</value>
#:endif
</property>
<property name="username">
<value>&ORA_USER;</value>
</property>
<property name="password">
<value>&ORA_PASS;</value>
</property>
<property name="maxActive">
<value>32</value>
</property>
</bean>

v Add the following ActiveMQ database configuration information:
<bean id="gis-ds"
class="oracle.jdbc.pool.OracleDataSource" destroy-method="close"
singleton="true" lazy-init="default"
autowire="default"
dependency-check="default">
<property name="URL"><value>&ORACLE_JDBC_URL;</value></property>
<property name="user"><value>&ORA_USER;</value></property>
<property name="password"><value>&ORA_PASS;</value></property>
<property name="connectionProperties">
<value> oracle.net.ssl_cipher_suites:

(SSL_DH_anon_WITH_3DES_EDE_CBC_SHA, SSL_DH_anon_WITH_DES_CBC_SHA)
oracle.net.ssl_client_authentication: false
oracle.net.ssl_version: 3.0
driverClassName:oracle.jdbc.driver.OracleDriver
maxActive: 32

</value>
</property>
</bean>

8. Open the /install_dir/install/bin directory.
9. Enter the command ./setupfiles.sh.

10. Restart Sterling B2B Integrator. All the database connections from Sterling B2B
Integrator are now connected through TCPS (encrypted) mode.

Configuring Sterling B2B Integrator for data traffic encryption with SSL authentication in
Oracle:

You can enable data traffic encryption and SSL authentication.

About this task

This procedure is applicable if you are running Sterling B2B Integrator on a system
that requires either Sun JDK or IBM JDK.
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The example in this procedure uses two-way SSL authentication. It is
recommended to follow the instructions in the "CASE #2: USE SSL FOR
ENCRYPTION AND SERVER AUTHENTICATION" section of the Oracle
documentation.

You can also configure one-way SSL authentication. If you want to use SSL for
encryption and for server authentication of both tiers, it is recommended to follow
the instructions in the "CASE #3: USE SSL FOR ENCRYPTION AND
AUTHENTICATION OF BOTH TIERS" section of the Oracle documentation.

If your installation of Sterling B2B Integrator is a cluster installation, you need to
perform this procedure on each node, starting with node 1.

Procedure

To configure Sterling B2B Integrator for data traffic encryption with SSL
authentication in Oracle:
1. Install Sterling B2B Integrator in TCP (clear) mode.
2. Stop Sterling B2B Integrator.
3. Open the /install_dir/install/properties directory.
4. Open the customer_overrides.properties file and add the following database

connection information:
jdbcService.oraclePool.prop_javax.net.ssl.trustStore=/.../path/.../ClientKeyStore.jks
jdbcService.oraclePool.prop_javax.net.ssl.trustStoreType=JKS
jdbcService.oraclePool.prop_javax.net.ssl.trustStorePassword=password
jdbcService.oraclePool.prop_oracle.net.ssl_version=3.0
jdbcService.oraclePool.prop_javax.net.ssl.keyStore=/.../path/.../ClientKeyStore.jks
jdbcService.oraclePool.prop_javax.net.ssl.keyStoreType=JKS
jdbcService.oraclePool.prop_javax.net.ssl.keyStorePassword=password

5. Repeat step 4 for the following Oracle connection pools by changing only the
pool name:
v oraclePool_local

v oraclePool_NoTrans

v oracleArchivePool

v oracleUIPool

If you have any other database pools, you need to add the properties for those
pools.

6. Open the sandbox.cfg file and change the database connection information to
the following value:
ORACLE_JDBC_URL= jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS=(PROTOCOL=tcps)
(HOST=<DB host>)(PORT=<TCPS port as configured in DB config section above>))
(CONNECT_DATA=(SERVICE_NAME=<service name>)))

7. Open the /install_dir/install/activemq/conf directory.
8. Open the activemqconfig.xml.in file and modify the database connection

information:
v Remove or comment out the following default ActiveMQ database

configuration information:
#:ifdef ORACLE
<bean id="gis-ds" class="org.apache.commons.dbcp.BasicDataSource"

destroy-method="close" singleton="true" lazy-init="default"
autowire="default" dependency-check="default"

SCIOverrideName="persistence-bean">
<property name="driverClassName">
<value>oracle.jdbc.driver.OracleDriver</value>
</property>
<property name="url">
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#:ifdef ORACLE_JDBC_URL
<value>&ORACLE_JDBC_URL;</value>
#:else
<value>jdbc:oracle:thin:@&ORA_HOST;:&ORA_PORT;:&ORA_DATA;</value>
#:endif
</property>
<property name="username">
<value>&ORA_USER;</value>
</property>
<property name="password"><value>&ORA_PASS;</value>
</property>
<property name="maxActive"><value>32</value>
</property>
</bean>
#:endif

v Add the following ActiveMQ database configuration information:
<bean id="gis-ds"
class="oracle.jdbc.pool.OracleDataSource" destroy-method="close"
singleton="true" lazy-init="default" autowire="default"
dependency-check="default">
<property name="URL"><value>&ORACLE_JDBC_URL;</value></property>
<property name="user"><value>&ORA_USER;</value></property>
<property name="password"><value>&ORA_PASS;</value></property>
<property name="connectionProperties"><value>
javax.net.ssl.trustStore: /.../path/.../ClientKeyStore.jks
javax.net.ssl.trustStoreType:JKS
javax.net.ssl.trustStorePassword:password
oracle.net.ssl_version:3.0
javax.net.ssl.keyStore: /.../path/.../ClientKeyStore.jks
javax.net.ssl.keyStoreType:JKS
javax.net.ssl.keyStorePassword: password
driverClassName:oracle.jdbc.driver.OracleDriver
maxActive:32
</value>
</property>
</bean>

9. Enter the command ./setupfiles.sh.
10. Restart Sterling B2B Integrator. All the database connections from Sterling B2B

Integrator are now connected through TCPS (encrypted) mode.

Configuring the Microsoft SQL Server Database:

Before you install Sterling B2B Integrator with the Microsoft SQL Server database,
you must configure the database.

Before you begin

v If you are reinstalling the software, be aware that data in your existing database
is deleted. To preserve your data, either back up the existing database or save it
under a different name.

v After you create and configure your database, recycle the database. Then, stop
and restart to apply the changes.

About this task

Use the following checklist to configure Microsoft SQL Server for Sterling B2B
Integrator:
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Item
Microsoft SQL Server Database
Configuration Checklist Your Notes

1 If you do not have Microsoft SQL
Server installed, follow the installation
procedures in the SQL Server
installation manual.

Refer to the Microsoft SQL Server
documentation on creating the
database, including creating a schema
repository, login, and table space.

Be sure to install the correct version
and patches.

See System Requirements for supported
version information.

3 “Microsoft SQL Server database
parameters” on page 16

4 “Microsoft SQL Server database user
privileges” on page 16

5 “Configuring the snapshot feature for
Microsoft SQL Server” on page 18

Microsoft SQL Server database user privileges:

In Microsoft SQL Server, you must grant DBO (Database Owner) permission to the
user. The DB_DDLADMIN role is required for creating objects in the SQL Server
database.

Microsoft SQL Server database parameters:

When you install Sterling B2B Integrator with the Microsoft SQL Server database,
you must set certain Microsoft SQL Server parameters. Other Microsoft SQL Server
parameter settings are recommended for the efficient performance of Sterling B2B
Integrator.

When you install Sterling B2B Integrator with Microsoft SQL Server, you must set
the Microsoft SQL Server parameters that are listed in “Mandatory settings for
Microsoft SQL Server” on page 17.

After you install Sterling B2B Integrator with Microsoft SQL Server, you can
improve the database performance by setting the recommended parameters that
are listed in the performance documentation for the following items:
v Instance-specific settings for Microsoft SQL Server
v Database-specific settings for Microsoft SQL Server

Mandatory settings for Microsoft SQL Server:

The default collation of Microsoft SQL Server must match the collation for the
Sterling B2B Integrator database to prevent collation conversions.

The tempdb database that is used by Microsoft SQL Server must be created with the
same collation as the default collation of Microsoft SQL Server. The Microsoft SQL
Server uses the tempdb database for results that are too large to fit in memory.
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If the collations of the tempdb database and the Sterling B2B Integrator database
differ, the database engine must convert from the Sterling B2B Integrator collation
to the tempdb collation, and then back again before it sends the results to the
Sterling B2B Integrator server. These conversions might lead to severe performance
issues.

The collation that is required for the Sterling B2B Integrator database is a collation
that most closely matches the character set used by Java. By using this collation,
you can avoid character data conversions before the data is stored in the database
tables. Use the mandatory parameter that is described in the following table when
you configure the collation setting:

Parameter Value

Database Collation SQL_Latin1_General_CP850_Bin

Additionally, you must perform these tasks:
v Allow Microsoft SQL Server to manage memory dynamically (default).
v Disable any antivirus software that is running on the Microsoft SQL Server

data, transaction log, and binary files directory.

Installing the JDBC driver in Microsoft SQL Server:

The use of a SQL Server database with Sterling B2B Integrator requires the
installation of a JDBC driver.

About this task

Sterling B2B Integrator requires the correct Microsoft SQL Server driver. See the
System Requirements for the supported version information.

Download the driver and any appropriate patches from the Microsoft website.

Procedure

To install the JDBC driver in Microsoft SQL Server:
1. Download the sqljdbc_version_language.tar.gz file to a temporary directory.
2. To unpack the compressed TAR file, open the directory where you want the

driver unpacked and type the following command:
gzip -d sqljdbc_version_language.tar.gz

3. To unpack the TAR file, open the directory where you want the driver installed
and type the following command:
tar –xf sqljdbc_version_language.tar

After the package unpacks, you can find out more information about using this
driver by opening the JDBC Help System in the /absolutePath/
sqljdbc_version/language/help/default.htm file. This file displays the help
system in your web browser.

4. When the Sterling B2B Integrator installation asks for the location of the JDBC
drivers, specify the extracted JAR file created after you unpack the archive,
which is usually named sqljdbc.jar. The JDBC driver version is the same as
the version of the drivers that are downloaded from Microsoft.
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Configuring the snapshot feature for Microsoft SQL Server:

The snapshot feature in Microsoft SQL Server allows you to view a read-only copy
of the database even when it is locked. Configuring the snapshot feature can also
reduce deadlocks. To enable the snap shot feature, enter the following command:
ALTER DATABASE db_name SET READ_COMMITTED_SNAPSHOT ON;

Configuring the MySQL Database:

You can use a MySQL database for maintaining information on Sterling B2B
Integrator. Only non-clustered installations of Sterling B2B Integrator can use the
MySQL database.

MySQL is case-insensitive for searches with string values. For example, the search
results will be the same when you search for users 'Admin' and 'admin'. As a
result, it impacts searches for maps, business processes, services, mailboxes, user
names, and other data stored in the database.

Use the following checklist to configure the MySQL database for Sterling B2B
Integrator:

# MySQL Database Configuration Checklist Your Notes

1 Install MySQL database.

Refer to MySQL documentation for information about
installing the MySQL database. Be sure to install
correct version and patches.

See System Requirements for supported version
information.

2 Set the MySQL Parameters.

3
Create the database.

For example, you can run the following command to
create the database:

CREATE DATABASE database_name

Refer to MySQL documentation for more information
about creating the database.

4 Create a user account and grant permissions.

5 Install the JDBC Drivers for MySQL.

If you need additional MySQL database information, see the documentation
provided by the vendor at http:////dev.mysql.com/doc/refman/5.0/en/.

Update the MySQL Parameters: Sterling B2B Integrator requires the following
parameter settings in your MySQL database.

The parameter values recommended are minimum values. You can increase the
values based on your requirements or if the database server is used by more than
one instance of Sterling B2B Integrator.

It is recommended to configure a data file for auto extension
(innodb_data_file_path = ibdata1:400M:autoextend).

Installing and upgrading (V5.2.6 or later) 89

http:////dev.mysql.com/doc/refman/5.0/en/


Parameter Value

max_connections 500

max_allowed_packet 100M

default-table-type INNODB

wait_timeout 31536000

max_write_lock_count 500000

transaction-isolation READ-COMMITTED

character-set-server utf8

binlog_format mixed

table_open_cache 512

key_buffer_size 384M

sort_buffer 512K

connect_timeout 15

innodb_data_file_path ibdata1:400M:autoextend

innodb_data_home_dir /install_dir/mysql/var/

innodb_log_group_home_dir /install_dir/mysql/var/

innodb_flush_log_at_trx_commit 1

innodb_mirrored_log_groups 1

innodb_log_files_in_group 3

innodb_file_io_threads 4

innodb_lock_wait_timeout 600

innodb_log_file_size 5M

innodb_log_buffer_size 8M

innodb_buffer_pool_size 128M

innodb_additional_mem_pool_size 32M

Review the innodb_buffer_pool_size and the innodf_additional_mem_pool_size in
the /install_dir/install/mysql/data my.cnf. If the values from the previous Sterling
B2B Integrator tuning.properties are larger than what is in your new my.ini file,
you need to adjust them accordingly.

Install the JDBC Drivers for MySQL:
About this task

Sterling B2B Integrator requires appropriate JDBC driver for MySQL database.
These drivers are platform independent and architecture independent drivers. See
System Requirements for supported version information.

After obtaining the correct JDBC driver, record the absolute path to its location on
your system. You must supply this absolute path when installing Sterling B2B
Integrator.

Create User Account and Grant MySQL Database User Privileges:
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About this task

You must grant all privileges on the MySQL database to the Sterling B2B Integrator
administrative user. The following example creates and grants all privileges to the
user in the MySQL database:
GRANT ALL PRIVILEGES ON database_name.* TO user@localhost IDENTIFIED BY 'password’
WITH GRANT OPTION

Where:
v database_name - refers to the name of the database created.
v user - refers to the database user account that will be used by Sterling B2B

Integrator.
v password - refers to the password associated with the database user account.

Once you have granted all the privileges, you will need to FLUSH the privileges to
complete the setup. For example, run this command from the SQL prompt:
FLUSH PRIVILEGES;

Managing Database Passwords:

A password is used by the system to connect to its database. The password is
stored as clear text in a system property file.

If the security policies at your company require you to encrypt these passwords,
you can do so after you install the system. Encrypting these passwords is optional.

Database passwords encryption methods:

Database passwords are encrypted with one of two methods: OBSCURED or
ENCRYPTED.

The encryption method is decided by the value of the encryptionPrefix property
in the propertyEncryption.properties or the
propertyEncryption.properties_platform_security_ext file.

Encrypt Database Passwords (Windows):
About this task

To encrypt the database password:

Procedure

1. Stop Sterling B2B Integrator.
2. Complete the following steps:

a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Navigate to \install_dir\install\bin.

3. Enter enccfgs.cmd.
4. Enter setupfiles.cmd.
5. Enter deployer.cmd.
6. Enter startWindowsService.cmd to start Sterling B2B Integrator.
7. Enter your passphrase.
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Decrypt Database Passwords (Windows):
About this task

To decrypt the database password:

Procedure

1. Stop Sterling B2B Integrator.
2. Complete the following steps:

a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Navigate to \install_dir\install\properties.

3. Open the sandbox.cfg file.
4. Copy encrypted password from the database_PASS property.

Use the text that appears after the database_PASS= text. For example, if
database_PASS= OBSCURED:123ABCxyz321, you would copy the text
OBSCURED:123ABCxyz321. (OBSCURED is the encryption method for the
password.)

5. Complete the following steps:
a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Navigate to \install_dir\install\bin.

6. Enter decrypt_string.cmd encrypted _password.
For encrypted_password, use the text that you copied in Step 4.
You are prompted for the system passphrase.
Your decrypted password appears.

7. Complete the following steps:
a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Navigate to \install_dir\install\properties.

8. Edit the sandbox.cfg file to replace the encrypted password with the password
that was returned in Step 6.

9. You need to decrypt the entries for YANTRA_DB_PASS and DB_PASS. Repeat
Steps 4 to 8 to decrypt these entries. You should also decrypt any passwords
present in the property files. Encrypted passwords typically reside in the
following property files:
v sandbox.cfg
v apservsetup
v jdbc.properties/.in
v customer_overrides.properties/.in

10. Complete the following steps:
a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Navigate to \install_dir\install\bin.

11. Enter setupfiles.cmd.
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12. Enter deployer.cmd.
13. Enter startWindowsService.cmd to start Sterling B2B Integrator.

Preparing for Installation
To help ensure a trouble-free installation, you should complete the installation
checklist and understand some concepts.

Installation Checklist for a Windows Non-Cluster Environment: The installation
checklist contains the items you need to gather and tasks you need to complete
prior to installing Sterling B2B Integrator. The checklist contains:
v Brief descriptions for tasks (detailed procedures are provided after the checklist)
v Information you need to gather to complete the installation

You may want to make a copy of the following checklist and use it to record the
information you collect.

# Installation Checklist for Windows Your Notes

1 Review your IBM contract to determine what
software you have licensed. You need to know this
License Information so that you can select the correct
components/features to install.

2 Determine which installation method you are going
to use:

v IBM Installation Manager (Graphical User
Interface)

v IBM Installation Manager (Response File)

3 Decide which type of security certificates you will
use:

v The default self-signed SSL (Secure Sockets Layer)
certificate that is automatically installed.

v A Certificate Authority-related certificate that you
install before installing Sterling B2B Integrator.

4 If you are using an Oracle, Microsoft SQL Server, or
DB2 database, decide if you are going to manually or
automatically apply Database Definition Language
(DDL) Statements (schema) to the database.

5 If you are using an Oracle 11.1 database, you must set
it up for native compilation by allocating space and
by setting the plsql_native_library_dir parameter.

6 Determine if the database password needs to be
encrypted.

7 Record the Hostname on which you plan to install
the software.

8 Record the Directory Name where you plan to install
the software.

9 Record the Login to host machine.

10 Record the Password to the host machine.

11 Record the path to the Installation Manager and the
installation package file name.

12 Record the path to JDK.

12 Record the path to JCE file.
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# Installation Checklist for Windows Your Notes

14 Record the Host IP address.

15 Record the Initial Port Number.

16 Record the System passphase.

17 Record the Database vendor name.

18 Record the Database user name.

19 Record the Database password.

20 Record the Database (catalog) name.

21 Record the Database host name.

22 Record the Path and file name for the JDBC Driver(s).

23 Ensure you have read and write privileges on the
parent installation directory.

License information:

A separate license is required for each Sterling B2B Integrator feature that you
purchased. During installation, you must choose the license files according to what
you purchased. Product licenses do not require an activation key.

IBM assumes customers will only install and use the products they purchased. IBM
reserves the right to inspect installs for compliance at any time.

After the installation finishes, if you determine that you need to modify licenses
files, see “License modifications” on page 58.

Product Licenses for Sterling B2B Integrator

Sterling B2B Integrator Standard and Enterprise Edition includes:
v MESA Studio
v eInvoicing
v Report Services
v all services and adapters not listed below

Sterling B2B Integrator Standard and Enterprise Financial Edition includes
everything listed above plus:
v CHIPS
v SWIFTNet
v NACHA ACH CTX adapter
v FEDWIRE
v Fin Serv XML standard
v FIPS Mode
v Image Cash Letter service
v EBICS

Port Numbers in a Windows Environment: During installation or an upgrade,
you are prompted to specify the initial port number for Sterling B2B Integrator.

To specify an initial port number, follow these guidelines:
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v Sterling B2B Integrator requires a range of 200 consecutive open ports between
1025 and 65535. The port range starts with the initial port number and ends
with the number that equals the initial port number plus 200. For example, if
you specify 10100, then you need to make sure that 10100 through 10199 are not
used by any other applications on your system.

Note: Because of RMI, on occasion, a port number outside the range may be
assigned.

v The initial port number represents the beginning port number in the range.
v Make sure that port numbers in the port range are not used by any other

applications on your system.

During the upgrade, about 50 default ports are pre-assigned for different services.
For example, if you do not want xxx32 (10132) to be a default port, you could
assign that port to xxx97 or another number within the port range.

After your installation or upgrade, refer to the \install_dir\install\properties\
sandbox.cfg file for all of the port assignments.

Security certificates:

You can choose between different security certificates before you install Sterling
B2B Integrator.

Before you begin the installation, you must decide which of the following security
certificates to use:
v The default self-signed SSL (Secure Sockets Layer) certificate that is

automatically generated by the installation.
v A Certificate Authority-related certificate that you generate before you install the

software.

If you install with the default SSL certificate, but you later want to switch to a
CA-related certificate, you can change the certificate with the sslCert property in
the noapp.properties_platform_ifcresources_ext.in file.

Installing the Software
After you have configured the database and prepared your system, you are ready
to install Sterling B2B Integrator.

General Installation/Upgrade Information for a Non-Cluster Environment:

CAUTION:
Sterling B2B Integrator should be installed behind a company firewall for
security purposes. See the Perimeter Server and Security topics in the Sterling
B2B Integrator documentation library for more information on secure
deployment options.

Installation Scenarios

It is important to review the following installation scenarios:

Scenario Instructions

Version 5.1.x is installed and it needs to be
upgraded to V5.2.6.

See “Upgrading (V5.2.6 or later)” on page
320
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Scenario Instructions

Version 5.2.x is installed and it needs to be
upgraded to V5.2.6.

See Applying a fix pack (V5.2.6 or later)

Version 5.2.6 is being installed as the base
release.

Review this document and use the
installation instructions.

Installation Methods

Use one of the following methods to install your system:
v IBM Installation Manager (Graphical User Interface)
v IBM Installation Manager (Response file)

General Installation Guidelines

General installation guidelines include the following:
v Do not create the installation directory manually before the start of the

installation. If you create the installation directory before you begin, the
installation will fail. The directory name provided during the installation process
is used to create the new installation directory.

v The name of the directory cannot include spaces and must be less than 30
characters long excluding separators. Using a directory name of more than 30
characters could create an install that is impossible to delete. An example of an
installation directory is C:\SI_52\install.

v The server on which you are installing must have adequate free disk space.
v install_dir refers to the installation directory where the new software will be

installed. Do not use any pre-existing directory name or an old version of the
Sterling B2B Integrator installation directory. If you do, you could inadvertently
overwrite the existing installation. You should create a new installation directory
before you begin the installation.

v parent_install is the directory one level above the install_dir directory.
v Ensure that the parent_install directory has the proper read/write permissions.
v If you need to install more than one instance of Sterling B2B Integrator on the

same Windows server, you must install the second instance in a different
directory.

v If you are installing Sterling B2B Integrator on VMware, provide the IP address
of the virtual machine, not the IP address of the VMware host. For example, if
10.251.124.160 is the IP address of the VMware host and 10.251.124.156 is the IP
address of the Windows 2003 server it is hosting, you should use 10.251.124.156
as the correct IP address to install Sterling B2B Integrator.

v Sterling B2B Integrator does not support IPv6 installation on Windows. Before
applying an IPv6 address, see the IPv6 Capabilities section in System Requirements.

v The installation creates subsequent ports based on the initial port number. For
all of the port assignments, see the \install_dir\install\properties\sandbox.cfg
file.

General IBM Installation Manager information:

IBM Installation Manager V1.8.2 is required to install Sterling B2B Integrator on all
supported platforms.
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Installation Manager is a Java based multiplatform installation application and
provides a consistent approach across various platforms. It does not rely on
platform-specific installation technology or mechanism.

Installation Manager uses the local Sterling B2B Integrator offering repositories to
install or update Sterling B2B Integrator and its add-on features. It determines the
packages that must be installed and displays them including the products, fix
packs, and interim fixes. It checks that all prerequisites and interdependencies are
met before installing the selected product package and feature sets.

Important: The Uninstall option only unregisters Sterling B2B Integrator from
Installation Manager. The uninstall procedure as described in the related sections
must be performed to completely uninstall Sterling B2B Integrator.

Installation Manager must be installed on each computer on which Sterling B2B
Integrator is being installed. If you already have Installation Manager installed on
your computer for use with other IBM applications, it can be used with installing
Sterling B2B Integrator as long as it's the correct version. If you do not have
Installation Manager installed, it is provided as part of the Sterling B2B Integrator
installation media.

Supported bit-versions

A 64-bit version of IBM Installation Manager V 1.8.2 is provided with the Sterling
B2B Integrator installation package. However, you can also install with a 32-bit
version of Installation Manager.

Before you start the installation, consider the following options:
v If you are a new customer, use the version of Installation Manager that is

provided with the Sterling B2B Integrator installation package and install
Sterling B2B Integrator.

v If you have an earlier version of Installation Manager, you can update it to
V1.8.2 using the Installation Manager that is provided with the installation
package, then install Sterling B2B Integrator .

v If you are a current customer who did not use Installation Manager earlier,
install the version of Installation Manager that is provided with the installation
package, then upgrade your Sterling B2B Integrator installation.

v If you have a 32-bit Installation Manager installed, you must download the
32-bit Installation Manager V1.8.2 from Fix Central or IBM Passport Advantage,
upgrade it, then proceed with the installation of Sterling B2B Integrator. Ensure
you have the required libraries that support screen presentation of the text.

Checking for updates

To check for Installation Manager updates, select Search for Installation Manager
updates on the File > Preferences > Updates page. When the check box is
selected, Installation Manager searches for updates when any one of the following
pages are opened from the Installation Manager start page:
v Install Packages
v Modify Packages
v Update Packages

Installation Manager also searches for updates when you click the Check for Other
Versions, Fixes, and Extensions button on the Install Packages page.
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Starting Installation Manager

You should start the Installation Manager (and also install Sterling B2B Integrator)
as a non-administrator user.

How you start Installation Manager depends on whether you are using the
Installation Manager agent that is provided with Sterling B2B Integrator or if you
have an Installation Manager instance that is installed on your system. It also
depends on whether you have 32-bit or 64-bit Installation Manager.

Open a command prompt and do one of the following tasks to start the
Installation Manager in GUI mode:
v Go to the IM_<operating_system> directory and type ./userinst or userinst.exe

(Windows) for the following scenario:
– If you do not have Installation Manager installed and are using the

Installation Manager agent that is provided with the Sterling B2B Integrator
media.

– If you have a 64-bit Installation Manager installed.
– If you have Installation Manager installed on a platform that has only one

download available for Installation Manager. For example, AIX, Solaris, HP,
zLinux.

v Go to <installation directory>/Installation Manager/eclipse (for Windows
system, replace / with \) and type ./IBMIM or IBMIM.exe if you have 32-bit
Installation Manager installed on a Linux or Windows system.

For information on starting Installation Manager in command mode for silent
installation, see the Installing or updating with a response file.

For information on starting Installation Manager in command mode to record a
response file, see Recording a response file.

Additional heap memory parameters

The heap memory parameters specify the amount of memory Installation Manager
can use during the installation process. The heap memory pool sizes that are used
by Installation Manager are hardcoded defaults. If these defaults are not sufficient
for your environment, you can specify different values by adding parameters to
the Installation Managerconfig.ini file.

Important: These additional parameters are required only if you are experiencing
Out Of Memory errors during the installation process.

The following parameters can be added:
v memoryMin=user.sb.INSTALL_<OS>_INIT_HEAP.<amount_of_memory>

v memoryMax=user.sb.INSTALL_<OS>_MAX_HEAP.<amount_of_memory>

Where <OS> is your operating system and <amount_of_memory> is the specified
amount of memory.
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Operating
System Parameter Example Entry

Sun-Solaris Initial Heap Size

INSTALL_SUN_INIT_HEAP

memoryMin=user.sb.INSTALL_SUN_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_SUN_MAX_HEAP

memoryMax=user.sb.INSTALL_SUN_MAX_HEAP.3072m

Linux Initial Heap Size

INSTALL_LINUX_INIT_HEAP

memoryMin=user.sb.INSTALL_LINUX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_LINUX_MAX_HEAP

memoryMax=user.sb.INSTALL_LINUX_MAX_HEAP.3072m

AIX Initial Heap Size

INSTALL_AIX_INIT_HEAP

memoryMin=user.sb.INSTALL_AIX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_AIX_MAX_HEAP

memoryMax=user.sb.INSTALL_AIX_MAX_HEAP.3072m

HP-UX Initial Heap Size

INSTALL_HPUX_INIT_HEAP

memoryMin=user.sb.INSTALL_HPUX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_HPUX_MAX_HEAP

memoryMax=user.sb.INSTALL_HPUX_MAX_HEAP.3072m

Windows Initial Heap Size

INSTALL_WIN_INIT_HEAP

memoryMin=user.sb.INSTALL_WIN_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_WIN_MAX_HEAP

memoryMax=user.sb.INSTALL_WIN_MAX_HEAP.3072m

Installing or updating with a response file (V5.2.6 or later):

You can install or update (apply fix pack or interim fix) Sterling B2B Integrator
with silent mode by using the sample response files or converting your existing
response file to the required format.

Installing in a Windows non-cluster environment with the IBM Installation
Manager in GUI mode:

You can install Sterling B2B Integrator in a Windows non-cluster environment with
the IBM Installation Manager in a graphical user interface (GUI) mode.

Before you begin

v Complete the “Installation Checklist for a Windows Non-Cluster Environment”
on page 93.

v If you are using the Standards Processing Engine (SPE) application with Sterling
B2B Integrator, you must install SPE before you install Sterling B2B Integrator.

v If you are using the EBICS Banking Server application with Sterling B2B
Integrator, the data encryption for storage within the installation location is not
supported.
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About this task

To install Sterling B2B Integrator in a Windows non-cluster environment with the
Installation Manager in GUI mode:

Important: Following is a list of changes related to installing or upgrading to
Sterling B2B Integrator V5.2.6:
v You can install and upgrade through the user interface or silent installation

mode (response files). Console mode installation and upgrade is not supported.
v Sterling B2B Integrator JAR file is included in the repository. Therefore it is not

required to manually select the JAR file when installing or upgrading.
v You must use Installation Manager V1.8.2 to install or upgrade Sterling B2B

Integrator. InstallService is disabled, and cannot be used. You can use
InstallService, only for a specific scenario related to Sterling File Gateway. For
more information, see step 13.

Procedure

1. Close all open Windows programs and any command prompt windows.
2. From the installation media, copy the compressed installation package to a

location on your desktop.
3. Decompress the installation package.
4. Open the InstallationManager folder in the directory structure that is created

when the installation package is decompressed. Several
IM_OperatingSystem.zip files are displayed.

5. Decompress the IM_Win.zip file. This action creates a new IM_Win folder.

Important: Installation Manager V1.8.2 is required to install Sterling B2B
Integrator V5.2.6.

6. Decompress the Common_Repo.zip from the installation package. The action
creates two new folders b2birepo and gmrepo. The IM_Win, b2birepo, and
gmrepo folders must be at the same level in a directory.

Important: gmrepo contains the repository file required to install Global
Mailbox. For information about Global Mailbox, see Global Mailbox overview.

7. Do one of the following tasks to start the Installation Manager:
a. Go to the IM_Win directory and double-click userinst.exe for the following

scenarios:
v If you do not have the Installation Manager installed and are using the

Installation Manager agent provided with V5.2.6.
v If you have a 64-bit Installation Manager installed.

b. Go to <installation directory>\Installation Manager\eclipse and
double-click IBMIM.exe, if you have 32-bit Installation Manager installed on
your Windows system.

8. On the Installation Manager home page, click Install.

Important: If IM_<operating_system> and b2birepo directories are not in the
same directory or if you already have Installation Manager installed, then you
get a message saying that there no packages to install or Installation Manager
could not connect to the repositories. You must add the Sterling B2B
Integrator repository files to the Installation Manager repository. For more
information about adding repository files, see Repository preferences.
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9. On the Install Packages screen, select IBM Sterling B2B Integrator. This
action selects the versions also. Click Next.

10. Review the license agreement and select the option I accept the terms in the
license agreement.
If you do not accept the agreement, the installation process does not continue.

11. Select the location for the shared resources directory and click Next. This
directory is used by the Installation Manager for the Sterling B2B Integrator
installation and other installations.
The shared resources directory cannot be a subdirectory of the directory for
the installation of Sterling B2B Integrator. The shared resources directory must
be empty.

12. Choose Create a new package group and specify the path to Sterling B2B
Integrator installation directory.

13. Select the required features to be installed. The available options are:
v IBM Sterling B2B Integrator

v IBM Sterling File Gateway

Important: For Sterling B2B Integrator V5.2.6 or later, Sterling File Gateway
is automatically installed if IBM Sterling File Gateway is selected. Any
additional post installation tasks are not required to start Sterling File
Gateway. It is strongly suggested to install Sterling File Gateway when
installing Sterling B2B Integrator. If for any reason Sterling File Gateway is
not installed with Sterling B2B Integrator, you cannot install Sterling File
Gateway later using the Installation Manager. You must use InstallService
to install it. For information about installing Sterling File Gateway by using
InstallService, see Installing Sterling File Gateway (V2.2.6 or later).

v FIPS Module

v AS2 Edition Module

v Financial Services Module

v EBICS Banking Server Module

v B2B Advanced Communications Integration Module

Important: When installing Sterling B2B Integrator V5.2.6, select B2B
Advanced Communications Integration Module to install Sterling B2B
Integrator bridge. Sterling B2B Integrator bridge is required for
communication between Sterling B2B Integrator and B2B Advanced
Communications. If you are installing Global Mailbox and Sterling B2B
Integrator, then B2B Advanced Communications Integration Module
(Sterling B2B Integrator bridge) is installed by default, because Global Mailbox
uses the storage module of B2B Advanced Communications. However, you
must configure the adapter containers and adapters for Sterling B2B Integrator
bridge after installing.

Important: Sterling B2B Integrator is selected by default. Select only the
licenses and features that were defined by your IBM contract. If you are
unsure which to select, the installation can proceed without a selection and
complete successfully. Startup and operation of the software, however,
requires one of the licenses to be selected. See “License modifications” on
page 58 to apply licenses after the installation.

Important: If you are upgrading to Sterling B2B Integrator from a previous
version, you must manually install the EBICS client. For more information
about installing the EBICS Client manually, see the EBICS Client User Guide.
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14. Type the path to your JDK directory and click Next.
15. Specify the configuration for the features to install and click Next.

v FIPS Compliance Mode (Must enable FIPS Module)

v NIST 800-131a Compliance Mode

– off (default value)
– strict

v SPE Integration Module (Requires pre-install of SPE, WTX optional)

If you select the SPE option, you are prompted for the following
information:
– SPE installation directory
– (Optional) WebSphere Transformation Extender (WTX) installation

directory
– SPE UI port
For more information, see the documentation for the integration of Sterling
B2B Integrator and SPE.

16. Type the path to the JCE policy file and click Next.
17. Enter the following server location information and click Next:

a. Type the explicit IP address or host name for the server or use the default
value of localhost.

b. Type the initial port number or use the default value of 8080.
18. Enter the system passphrase information and click Next:

a. Type a passphrase.
b. Confirm the passphrase.

19. Type the email information and click Next:
a. Type the email address to which you want system alert messages sent.
b. Type the SMTP mail server (IP address or host name) that you want to use

for system alert messages and other administrative notices.
20. Enter the following database information and click Next.

a. Select the database vendor that you want to use:
v Oracle
v Microsoft SQL Server
v DB2
v MySQL

b. Select all of the following options that apply to this installation:

Choices: Action

(Not for MySQL) This installation is for a
cluster node 2 or higher

Do not select this option because this
installation is a non-cluster installation.
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Choices: Action

(Not for MySQL) Apply database schema
automatically?

The default is to automatically apply the
DDL (Data Definition Language) statements
that apply the database schema.

If you want to manually create the database
schema, then clear the Apply database
schema automatically check box and
continue with the remaining installation
steps.
Important: If you manually apply the
schema, the installation stops without error
later in the installation process so that you
can manually apply the schema.

21. Type the following database connection information. Do not click Next until
you configure the JDBC driver in the next steps.
v User name
v Password (and confirmation)
v Catalog name
v Host
v Port

22. Select a JDBC driver or drivers and click Next:
a. Click Add to browse to the file location for the appropriate JDBC driver or

drivers:
v (Oracle, Microsoft SQL Server, and MySQL only) Absolute path and file

name for one JDBC driver file.
v (DB2 only) Absolute paths and file names for two JDBC driver files. Use

the Type-4 JDBC driver. This type of driver converts JDBC calls into the
network protocol that is used directly by DB2, allowing a direct call
from the system to the DB2 server.

b. Click Test to confirm that the driver is supported for the database and
Sterling B2B Integrator.

Tip: Make sure that you select the driver path in the Database driver field
before you click Test.
The Installation Manager must successfully validate the connection to the
database before you can continue with the installation. If there is a
validation failure, you can view the system log to determine more
information about the failure. Perform the following tasks:
1) Identify the location of the user’s application directory. Click Start >

Run and enter the command %APPDATA%.
2) Open the user’s application directory: local_path\IBM\Installation

Manager\logs

3) Open theindex.xml file in a browser.
4) Identify the log file that is based on the time stamp of when you

started the installation.
5) Click the installation file to view a listing of errors that occurred

during that installation.
23. Determine which of the following options apply to this installation. Select the

applicable options and click Next:
v Verbose install?
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v This installation is an upgrade from a prior version

Do not select this option because this installation is a new installation.
24. Determine what performance configurations apply to this installation and

click Next. Accept the default value or type the appropriate value.
v Number of Processor Cores

v Physical Memory (MB) allocated to Sterling B2B Integrator

25. Review the installation package summary information. Click Install to apply
your installation settings to the installation.
If you did not select the option to automatically apply the database schema,
the installation stops and you must perform these additional steps to complete
the installation with manual DDL statements:
a. Open the installation directory.
b. Locate the InstallSI.log file and open it with a file editor.
c. Search the file for these error messages:
v <SI_Install>/repository/scripts/EFrame_IndexAdds.sql must be

applied to the database.

v <SI_Install>//repository/scripts/EFrame_Sequence.sql must be
applied to the database.

v <SI_Install>//repository/scripts/EFrame_TableChanges.sql must be
applied to the database. Exiting installation..."

Important: If you do not find these error messages in the log file, the
installation failed because of another reason and you must resolve that
error and attempt the installation again. If you find these messages,
continue with the remaining steps.

d. Edit each .sql script for the database. These changes might include
changing the SQL delimiter or adding table space options.

e. Log in to the database as the database schema user.
f. Run the following SQL files manually in this order:

Important: When you are running the scripts, you must run the SQL
scripts in the specified order.
v EFrame_IndexDrops.sql

v EFrame_TableChanges.sql

v EFrame_IndexAdds.sql

v EFrame_TextIndexAdds.sql

v EFrame_Sequence.sql

v EFrame_TextIndexModify.sql

v EFrame_TextIndexUpdates.sql

v EFrame_TextIndexUpgrade.sql

v EFrame_Static.sql

Important: ActiveMQ uses dynamically generated table names that are
based on the name of the installation node. Table generation is not
included in these SQL scripts, but is performed automatically during the
initial start of Sterling B2B Integrator or when a new cluster node is added.
Table generation might fail if security restrictions reduced the Sterling B2B
Integrator database user permissions. To avoid this issue, ensure that the
DBADM role permissions are enabled during the initial startup. If further
issues arise, contact IBM customer support for guidance.
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g. Exit from the database.
h. Open the parent directory of the Sterling B2B Integrator installation

directory.
i. Delete (or rename as a backup) the installation directory.
j. Unisntall the Sterling B2B Integrator offering to clear out the Installation

Manager metadata about the installation, and the delete (or rename as a
backup) the Sterling B2B Integrator installation directory.

k. Restart the installation wizard and provide the same installation options
that you provided before you cleared the Apply database schema
automatically check box. If you have recorded a response file (as
suggested in step 8), you can use the response file to install Sterling B2B
Integrator.

The Installation Progress screen indicates which component of the installation
is in process.
A status bar below the Repository Information heading displays the progress
of the component installation. When the installation completes, a large green
circle with a check mark displays with the message The packages are
installed. A link is provided to view the installation log file.

26. Click Finish. The Installation Manager closes and you are returned to your
desktop.
Check the InstallSI.log file to verify that all of the components were
installed properly.
If you are installing on Windows 2008, see “Configure the Sterling B2B
Integrator Desktop Icon for Windows Server 2008” on page 34.

27. Determine whether you need to apply a fix pack or interim fix to the
installation. For information about fix pack or interim fix installation, see
“Applying a Fix Pack (V5.2.6 or later)” on page 625 and “Applying an interim
fix (V5.2.6 or later)” on page 635.

Configure the Sterling B2B Integrator Desktop Icon for Windows Server 2008:
About this task

User Access Control (UAC) is a security component in Windows Server 2008. If
you enable the UAC, it affects the installation process and the daily processing for
Sterling B2B Integrator. If you disable the UAC, which requires a reboot, the
installation process and daily processing for Sterling B2B Integrator remains the
same as in previously supported Windows version.

If you installed or upgraded Sterling B2B Integrator on a Windows Server 2008 and
you created a desktop icon for Sterling B2B Integrator, you must complete this task
in order for the desktop icon to work.

Procedure

1. Right-click on the Sterling B2B Integrator desktop icon.
2. Click Properties.
3. In the Shortcut tab, click Advanced.
4. Select the check box for Run as Administrator.
5. Click OK to apply the changes to Advanced Properties.
6. Click OK.
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Validating the Installation
After installing Sterling B2B Integrator, you should validate the installation to
ensure that everything is working according to your needs.

Installation validation checklist:

As part of the installation, you need to run validation tests to ensure that the
software installation was successful.

Complete the following tasks:

# Validate Installation Checklist Your Notes

1 Start Sterling B2B Integrator.

2 Access Sterling B2B Integrator.

3 Validate the installation.

4 Stop Sterling B2B Integrator.

Starting Sterling B2B Integrator in a Windows non-cluster environment:

After you install the software, you can start Sterling B2B Integrator.

Before you begin

If you are starting Sterling B2B Integrator after you upgrade the application from
V5.1, change the values of the following properties in the centralops.properties
file to 600. This action prevents the StartWindowsService.cmd command from
timing out before Sterling B2B Integrator starts. The centralops.properties file is
in the install_dir\install\properties directory.
v OpsServer.commandTimeout

v PassPhrase.urlTimeout

Procedure

1. Open the \install_dir\install\bin directory.
2. Enter StartWindowsService.cmd. The final start processes run, concluding with

the following messages:
Open your Web browser to http://host:port/dashboard

where host:port is the IP address and port number on your system.
3. Record the URL address so that you can access Sterling B2B Integrator.

Accessing Sterling B2B Integrator:

You can access Sterling B2B Integrator through a web browser.

Procedure

1. Open a browser window and enter the address that is displayed at the end of
the start.

2. On the login page, enter the default user ID and password. The default login is
at an administrative level. One of your first tasks as an administrator is to
change the administrative password and to register other users with other
levels of permission.
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Validating the installation with a sample business process:

You can validate the installation by testing a sample business process.

Procedure

1. From the Administration Menu, click Business Process > Manager.
2. In the Process Name field, type Validation_Sample_BPML and click Go!

3. Click execution manager.
4. Click execute.
5. Click Go! The Status: Success message is displayed on the upper left side of

the page.

Stop Sterling B2B Integrator (Windows):
About this task

To stop Sterling B2B Integrator in a Windows environment:

Procedure

1. From the Administration Menu, select Operations > System > Troubleshooter.
2. Click Stop the System and wait for shutdown to complete.

Stop Sterling B2B Integrator (Hardstop Windows):
About this task

To stop Sterling B2B Integrator in a Windows environment:

Procedure

1. Navigate to \install_dir\install\bin.
2. Enter StopWindowsService.cmd. Your should receive a message that services

have been stopped. Services include Noapps, Opsserver, WebDav, and
Database-related service.

Post-Installation Configuration
After installing Sterling B2B Integrator and validating the installation, you may
need to do additional configuration depending on your system and business needs.

Post Installation Configuration Checklist (Windows): After you install Sterling
B2B Integrator you need to complete some post installation configuration.
Complete the items listed in the post installation checklist:

# Post Installation Configuration Checklist Your Notes

1 Upon installation, several default user accounts
are automatically created to get you started. For
security purposes, the system administrator
should update all default user account passwords
immediately after installation is completed. See
“Changing default user account passwords” on
page 40.

2 Download Sterling B2B Integrator Tools.

3 Determine if you need to modify any Property
Files.

4 “Configure a Non-English Environment” on page
47
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# Post Installation Configuration Checklist Your Notes

5 “Configure Browser Settings for a Different
Language” on page 50

Changing default user account passwords:

When you install Sterling B2B Integrator, several default user accounts are
automatically created to get you started. One of the first actions you must take
after installation is to update these accounts with unique passwords, because the
default ones can be known by all Sterling B2B Integrator customers.

About this task

Default user account passwords are preset at installation. For security purposes,
the system administrator should update all default user account passwords
immediately after installation is completed.

Default user accounts are listed below in the same order as they appear in the UI
under Accounts > User Accounts > List All. You can use this table to track the
user accounts you want to update.

User Account Name Update password

MBX_daemon

admin (*)

aft_user (*)

anon

as2_user

commandlineuser

dash_oper (*)

dash_part (*)

dash_prtspon (*)

dash_sponsor (*)

fg_architect

fg_operator

fg_provisioner

fg_sysadmin (*)

gmbx_user

ja_turbine

jane

jane_doe

joe_employee

joe_manager

joe_supplier

john

sd_buyer

sd_supplier
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User Account Name Update password

turbine

ws_buyer

ws_director

ws_employee

ws_finance

ws_hr

ws_manager

ws_purchaser

ws_supplier

(*) denotes a super user

To change the password for a user account, perform the following tasks.

Procedure

1. Log into Sterling B2B Integrator using ID = admin and password = password.
2. Go to Accounts > User Accounts. Under the List section click Go! All default

user account names are listed.
3. Click Edit next to the user account name you want to update the password for.
4. In the New Password and Confirm New Password fields, enter a new, secure

password for this User ID.

Note: Passwords must be at least six characters long.
5. Click Save and Finish.

What to do next

Repeat steps 3 - 5 for all user account names you want to update.

Download of the Sterling B2B Integrator tools:

After you install Sterling B2B Integrator, you can install tools like the Map Editor
and the Graphical Process Modeler (GPM).

Sterling B2B Integrator includes tools that run on a desktop or personal computer.
After you install Sterling B2B Integrator, you can install the following tools:
v Map Editor and associated standards

Note: The Map Editor requires a 32-bit JDK. This JDK is not provided with the
product download or media. For more information, see System Requirements.

v Graphical Process Modeler (GPM)
v Web Template Designer
v (If licensed) MESA Developer Studio plug-ins, including MESA Developer

Studio Software Development Kit (SDK) and MESA Developer Studio Skin
Editor

v (If licensed) Reporting Services, which require MESA Developer Studio if you
want to use the plug-ins to create fact models and custom reports
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Attention: Conflicting IP addresses can cause problems when you download a
desktop tool.

Property files configuration in a Windows environment: Property files contain
properties that control the operation of Sterling B2B Integrator. For example, the
REINIT_DB property in the sandbox.cfg file controls whether or not a database is
initialized when you install Sterling B2B Integrator.

By modifying the values of these properties, you can customize the Sterling B2B
Integrator to suit your business and technical needs. Most property files are in the
\install_dir\install\properties directory.

After installing Sterling B2B Integrator, most property files and scripts do not need
any further configuration for basic operation. However, if you want to customize
any specific operations, for example setting a different logging level - you will
need to edit ( or in some cases, create) certain property or .xml files.

Before changing any property files, refer to the Working with Property Files
documentation for general information about how to work with Property Files.

Areas where you might need to make specific property files changes after an
installation include:
v LDAP user authentication
v Prevention of cross-site script vulnerabilities
v Logging configuration
v Process-specific property file settings

Configure a Non-English Environment:

You can install Sterling B2B Integrator in an English or a non-English environment.
The base language for the Configurator can be switched only once.

Use the following checklist to change to a non-English environment:

# Non-English Environment Checklist Your Notes

1 Install the Sterling B2B Integrator Language Pack.

2 Load the Sterling B2B Integrator Language Pack
Factory Defaults.

3 Load the Sterling B2B Integrator Language Pack
translators.

4 Configure Encodings.

5 Configure Locales.

Language Settings in a Windows Environment: Language settings for Java
applications involve both character sets and encoding:
v A character set is a set of characters (letters, numbers, and symbols such as #, $,

and &) that are recognized by computer hardware and software.
v An encoding is a representation of data in a particular character set. An

encoding set is a group of encodings.

For information about basic and extended encoding sets, see .http://
download.oracle.com/javase/1.5.0/docs/guide/intl/encoding.doc.html
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The default encoding set includes:
v UTF-8 (default)
v IS0-8859-1
v ISO-8859-5
v US-ASCII
v ISO_8859-1
v EUC-JP
v UTF-16
v ISO-2022-JP

Sterling B2B Integrator provides two property files that contain supported
encoding sets. These properties files reside in the \install_dir\install\properties
directory.
v encodings.properties – Contains the default encoding set used in the user

interface.
v encodings_large.properties – Contains all supported encoding sets.

You are not limited to the encodings in the encoding.properties file. Sterling B2B
Integrator enables you to configure the encodings properties files to expand the
number of encodings you can use.

Install the Language Pack (Windows):
About this task

Before installing the language pack be sure that you have successfully installed
Sterling B2B Integrator.

To install Sterling B2B Integrator language pack:

Procedure

1. Insert the language CD into your CD-ROM drive.
2. Complete the following steps:

a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Navigate to Win Directory.

3. Run the setup.exe command.

Load the Language Pack Factory Defaults (Windows):
About this task

To load the language-specific factory defaults, use the loadDefaults.cmd script
available in the install_dir\install\bin directory and pass the locale-specific
installer file.

For example:

loadDefaults.cmd \install_dir\install\database\FactorySetup\install\
<language>_<country>_locale_installer.xml

The default locale that is shipped with the CD is ja_JP.
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Load the Language Pack Translations (Windows):
About this task

Prior to loading the Sterling B2B Integrator Language Pack factory defaults, be sure
that you have successfully completed all instructions in the database chapter.

To load the language pack translation with custom localization literals:

Procedure

1. Complete the following steps:
a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Navigate to \install_dir\install\bin.

2. Run the LocalizedStringReconciler tool in the IMPORT mode, enter: ant.cmd
-f localizedstringreconciler.xml import -Dsrc=install_dir\database\
FactorySetup\XMLS

This tool first inserts the value specified in the
<from_language>_<from_country>_ycplocalizedstrings_<to_language>_
<to_country>.properties file present in the install_dir\database\FactorySetup\
XMLS\<language>_<country> directory into the database.
The basefilename refers to the file present in the \database\FactorySetup\
XMLS directory, for which the translations are to be imported into the database.

3. Verify that your locale settings such as currency, time format, and date are
correct.

Configure Encodings for Sterling B2B Integrator (Windows):
About this task

To configure your encoding set:

Procedure

1. Stop Sterling B2B Integrator and wait for shutdown to complete.
2. Complete the following steps:

a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Navigate to \install_dir\install\bin.

3. Open the encodings_large.properties file.
4. Select the encodings you want to add to the encodings.properties file.
5. Open the encodings.properties.in file.
6. At the end of the encodings.properties.in file, add the encodings you selected

from the encodings_large.properties file. When adding encodings from one file
to the other, first copy the encodings as they appear in the
encodings_large.properties file. After adding the new encodings, ensure that
the index numbers are consecutive. If the index numbers are not consecutive,
change the index number or numbers as needed. For example, encoding54
cannot follow encoding6. In this example, change encoding54 to encoding7.
The first name in the definition (before the comma) is the name that will
appear in the Sterling B2B Integrator user interface. You can change this name
to make it more descriptive. For example: encoding4 = 819,ISO8859_1 may be
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changed to encoding4 = WesternEurope,ISO8859_1. ISO8859_1 is the Java
canonical name and should not be changed.

7. Update the first line in the encodings.properties.in file (numberof). Change
numberof to the number of encodings added to the file. For example, if the
current value is numberof = 6 and you add 5 new encodings, the new value is
numberof = 11.
numberof indicates the total number of encodings located in the file. You must
update numberof to ensure that the encodings you added will be visible in the
user interface.

8. Complete the following steps:
a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Navigate to \install_dir\install\bin.

9. Enter setupfiles.cmd.
10. Start Sterling B2B Integrator.

Configure Locales (Windows):
About this task

Sterling B2B Integrator runs in any locale that Java supports. If you want to run in
a non-default locale, then configure your environment to the specific locale you
want to use.

To determine and set your locale in a Windows environment:

Procedure

1. Select Control Panel > Regional Options > General.
2. From the Your locale (location) list, select the language and location.
3. Click Set Default and select the locale from the Set the appropriate locale list.
4. To configure your operating system as a non-English environment, consult your

operating system's documentation.

Configure Browser Settings for a Different Language:

Some browsers and operating systems require additional configuration in order to
correctly render the Sterling B2B Integrator user interface in certain languages.

Use the procedures provided in this section to properly configure a browser to
display the Sterling B2B Integrator user interface in the appropriate language.

Tip: If your browser is unable to display the user interface properly or you see a
mixture of English and another language, this is an indication that the browser is
configured incorrectly. You may also need to install additional fonts on the Sterling
B2B Integrator server.

Support for other languages:

The Sterling B2B Integrator user interface includes support for several languages.

Attention: Sterling B2B Integrator product code is designed to work with Latin
based English only input. The use of any other type of input might have uncertain
results and is not supported.
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The Sterling B2B Integrator user interface includes support for the following
languages:
v French
v German
v Italian
v Japanese
v Korean
v Polish
v Portuguese (Brazilian)
v Simplified Chinese
v Traditional Chinese
v Dutch

Four of these languages involve expanded Unicode character sets:
v Japanese
v Korean
v Simplified Chinese
v Traditional Chinese

The implementation of these languages in your environment might require the
addition of new Unicode fonts on your server:

If... then...

Sterling B2B Integrator is on a server that
already supports these languages

You do not need to install any additional
fonts.

You are installing on a server that is only
setup for the Latin alphabet and you have
users who need to view the Sterling B2B
Integrator user interface in any of the Asian
languages

You need to have the fonts for these
languages installed.

A way to test the implementation of a language is to create a user with one of the
new languages and setup their browser to use that language as it's primary
language. Log in to the system and review the user interface. If you see a mixture
of English and the new language, your configuration is not correct. You need to
verify that the browser is set up correctly and review the fonts that are installed on
the server.

The installation of more fonts/languages on the server should be done in
coordination with your technical support team. Be sure to include a Unicode Sans
Serif font on your server.

Important: While multiple languages are supported, a user account should be
configured to use one specific language to avoid user interface display issues.

Add a Custom Language Preference Code:
About this task

In order for your browser to display the Sterling B2B Integrator user interface and
address bar text correctly in a foreign language, you must specify the appropriate
language preference code for the browser.
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Sterling B2B Integrator supports the following language preference codes:
v de
v en
v en-US
v es
v fr
v it
v ja
v ko
v pt-BR
v zh
v zh-TW
v du

Your browser must be configured to use one of these specific language preference
codes to view the Sterling B2B Integrator user interface.

Note: Most browsers provide a default listing of language preference codes.
However, Sterling B2B Integrator requires the use of the specific codes as listed
here. For example, you cannot use the default German (Germany) [de-DE], you
must use [de].

You may need to add these supported codes as a custom language preference code
in your browser.

Note: The instructions for configuring a browser’s display will differ for each
browser. Refer to your chosen browser’s documentation for specific instructions on
configuring that browser’s display.

The following is an example of how to configure a client machine display for an IE
window.

Procedure

1. Open a browser window.
2. Select Tools > Internet Options.
3. At the bottom of the window under Appearance, click Languages.
4. Click Add to display the Add Language window.
5. In the User defined: text box, enter the appropriate language preference code.
6. Click OK. The added code should display in the Language: listing in the

Language Preference window. An example entry would be, User Defined
[de].

7. (Optional) Move the added language up to be the first one listed if there are
multiple languages listed.
a. Select the newly added language.
b. Click Move up.

The newly added language should now appear first in the Language
listing.

8. Click OK to save your Language Preference settings.
9. Click OK to close the Internet Options window.

10. Close your browser window.
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11. Open a new browser window and access the Sterling B2B Integrator user
interface to verify your changes have been applied.

Change Default Browser Font:
About this task

Some languages require the use of special fonts to properly display the Sterling
B2B Integrator user interface. The client computer must be configured to display
these types of fonts. Each Windows client must be configured appropriately.

Note: The instructions for configuring a browser’s display will differ for each
browser. Refer to your chosen browser’s documentation for specific instructions on
configuring that browser’s display.

The following is an example of how to change the default browser font for an
Internet Explorer (IE) window.

To configure a client machines display for IE:

Procedure

1. Determine which fonts are needed to support your needed language and
verify they are installed on the server.

Note: The installation of additional fonts/languages on the server should be
done in coordination with your technical support team. Be sure to include a
Unicode Sans Serif font on your server.

2. Open an IE browser window.
3. Select Tools > Internet Options.
4. At the bottom of the window under Appearance, click Fonts.
5. From the Language Script drop-down menu, change the Latin based value to

the appropriate script for your needed language.

Note: If your encoding is not available, you may need to install a new
version of Internet Explorer, but make sure you install the appropriate
international options.

6. Select a Webpage font and a Plain text font appropriate for the new language.
A Plain text font is one in which all the characters take up the same amount
of space and is associated with older computer terminals.

Note: If no fonts are listed in the menus, then you need to install fonts
designed for that encoding.

7. Click OK to close the Fonts window.
8. Click OK again to close the Internet Options window.
9. Close your browser window.

10. Open a new browser window and access the Sterling B2B IntegratorSterling
B2B Integrator user interface to verify your changes have been applied.

Set the Client Character Display:
About this task

To use special characters, such as for various languages, the client computer must
be configured to display these types of characters. In order for Unicode characters
to display correctly in the application, each Windows client must be configured
appropriately.
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Note: The instructions for configuring a browser’s display will differ for each
browser. Refer to your chosen browser’s documentation for specific instructions on
configuring that browser’s display.

The following is an example of how to configure a client machine display for an
Internet Explorer (IE) window.

To configure a client machines display for IE:

Procedure

1. Open an IE browser window.
2. Select View > Encoding > Auto-Select.

Clearing Browser and Java Plugin Caches Before Initial Deployment:
About this task

Once the Sterling B2B Integrator is ready for deployment, each user must clear the
browser and Java Plugin caches on their client machines before launching Sterling
B2B Integrator. This requirement applies to all browsers.

To clear the browser and java caches, do the following:

Procedure

1. From the browser menu bar, select Settings > Control Panel > Internet
Options.

2. Select the General tab, and in the Temporary Internet Files panel, click Delete
Files. The Delete Files dialog displays.

3. Check the Delete All Offline Content checkbox. Click OK until the Internet
Properties window closes. The browser cache is cleared.

4. From the Windows start menu, select Settings > Control Panel > Java.
5. Select the General tab, and in the Temporary Internet Files panel, click Settings.

The Temporary Files Settings dialog displays.
6. In the Disk Space panel, click Delete Files. The Delete Temporary Files pop-up

window displays.
7. Click OK until the Java Control Panel window closes.

General Internet Explorer Browser Settings: When using Sterling B2B Integrator
without any customizations, you need to set the General Browser settings for your
Internet Explorer in order to obtain the best browser performance.

Note: This can impact the display of reports and search listings.

To set your general browser settings:
1. From the Internet Explorer menu, select Tools > Internet Options.

The Internet Options window opens to the General tab.
2. Locate the Browsing history section and click Settings.

The Temporary Internet Files and History Settings window opens.
3. Below Check for newer versions of stored pages: select the Everytime I visit

the webpage option.
4. Click OK to save your changes.
5. Click OK to apply the changes.
6. Close the browser window and re-open it.
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The browser is now set to check for updates to pages everytime a page is
accessed rather than relying upon a cached version.

Internet Explorer Security Settings:
About this task

When using Sterling B2B Integrator without any customizations, you need to set
security settings for your Internet Explorer to obtain the best browser performance.

To configure the Internet Explorer security and privacy settings:

Procedure

1. From the Internet Explorer menu, select Tools > Internet Options.
2. Click the Security tab.
3. Select the Web content zone from which Sterling B2B Integrator is accessed.
4. Set the security level to Medium-low.
5. Click Custom Level and set your security settings according to the following

table:

Internet Explorer Security Setting Sterling B2B Integrator

.NET Framework

Loose XAML Enable

XAML browser applications Enable

XPS documents Enable

.NET Framework-reliant Components

Permissions for components with manifests High Safety

Run components not signed with Authenticode Enable

Run components signed with Authenticode Enable

ActiveX Controls and Plugins

Allow previously unused ActiveX controls to run
without prompt

Enable

Allow Scriptlets Enable

Automatic prompting for ActiveX controls Enable

Binary and script behaviors Enabled

Display video and animation on a webpage that
does not use external media player

Disable

Download signed ActiveX controls Prompt

Download unsigned ActiveX controls Prompt

Initialize and script ActiveX controls not marked as
safe for scripting

Prompt

Run ActiveX controls and plugins Prompt/Enable

Script ActiveX controls marked as safe for scripting Enable

Downloads

Automatic prompting for file downloads Enable

File download Enable

Font download Prompt

Enable .NET Framework setup Enable
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Internet Explorer Security Setting Sterling B2B Integrator

Java VM

Java permissions Medium safety

Miscellaneous

Access data sources across domains Enable

Allow META REFRESH Enable

Allow scripting of Internet Explorer web browser
control

Enable

Allow script-initiated windows without size or
position constraints

Enable

Allow webpages to use restricted protocols for
active contents

Prompt

Allow websites to open windows without address
or status bars

Enable

Display mixed content Prompt

Do not prompt for client certificate selection when
no certificates or only one certificate exists

Enable

Drag and drop or copy and paste files Prompt

Include local directory path when uploading files
to a server

Enable

Installation of desktop items Prompt

Launching applications and unsafe files Prompt

Launching programs and files in an IFRAME Prompt

Navigate sub-frames across different domains Enable

Open files based on content, not file extension Enable

Software channel permissions Medium safety

Submit non-encrypted form data Prompt

Use Phishing Filter Disable

Use Pop-up Blocker Disable

Userdata persistence Enable

Websites in less privilged web content zone can
navigate into this zone

Prompt

Scripting

Active scripting Enable

Allow Programmatic clipboard access Prompt

Allow status bar updates via script Enable

Allow websites to prompt for information using
scripted windows

Enable

Scripting of Java applets Enable

User Authentication

Logon Prompt for user name and password

6. Click OK to save your settings.
7. Click OK to save the new settings and Apply to implement the settings. The

new settings are applied when a new browser window is opened.
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System Maintenance
From time to time, you might need to perform system maintenance activities.

These activities might include:
v Performing a Checksum
v Adding or removing a license

System Maintenance: From time to time, you may need to perform system
maintenance activities. These activities might include any or all of the following:
v Performing a checksum
v Modifying the license files

DB Checksum Tool:

A checksum is a simple redundancy check used to detect errors in data. The DB
Checksum tool generates the difference in resource checksum between the default
resource and the latest system resource from the database.

In Sterling B2B Integrator, a verification process compares the checksum between
the existing default resource and the resource that was added after applying a fix
pack or upgrading. The DB Checksum tool, a resource difference tool generates a
granular report of the changes in the system that was not permitted to be set as
defaults.

Perform a Checksum (Windows):
About this task

To run the DB Checksum tool in the Windows environment:

Procedure

1. Navigate to \install_dir\bin.
2. Enter db_checksum_tool.cmd [-d] [-i [1 | 2 | 3 | 4 | 5]] [-r [wfd | map

| schema | sii | template]] [-o <output file>] [-g]

Where:
-d is the mode to dump the difference of resource checksum between the
default resource and latest system resource.
-i is the resource type integer (optional).
1 is WFD.
2 is MAP.
3 is SCHEMA.
4 is SII.
5 is TEMPLATE.
-r is the resource name (optional). For example, wfd, map, schema, sii, or
template.
-o is the file name to output all the messages (optional).
-g is the file name that lists all the ignored resources (optional).
-h is the help screen.
The DB Checksum tool performs the relevant checksum operation based on the
command options and generates the output message.
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License modifications:

After the installation finishes, you can modify the software licenses that you
loaded with the AddLicenseSet command.

The AddLicenseSet command is in the bin directory of your UNIX or Windows
installation. After the initial installation, the license files are in the following
directories:
v UNIX - /install_dir/install/properties/licensefiles
v Windows - \install_dir\install\properties\licensefiles
v iSeries - /install_dir/properties/licensefiles

You can add licenses or review the license list from the UI. On the Administration
Menu, click System > B2B Console > Operations > System > Licenses.

AddLicenseSet Command Parameters

Use the AddLicenseSet command to modify a single license file or the entire license
file directory.

To use the AddLicenseSet command, you must do the following:
v Open the bin directory
v Include the absolute path to the license file directory or to a license file

The AddLicenseSet command has the following parameters:

AddLicenseSet Parameter Description

-reload Use this parameter to reload the license files.

This parameter deletes all of the license files from the
database before the new files are loaded. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/
old_licenses

v Windows - \install_dir\install\logs\security\
old_licenses

v iSeries - /install_dir/logs/security/old_licenses

-upgrade Use this parameter during an upgrade only.

This parameter deletes all of the old license files from the
database and installs the new license files. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/upgrade

v Windows -\install_dir\install\logs\security\upgrade

v iSeries -/install_dir/logs/security/old_licenses

The AddLicenseSet command will check if Sterling B2B Integrator is running. If it
is running, the command will call the Ops server to refresh the license from the
database. If you have any problems with your licenses after running the
AddLicenseSet command, stop and restart Sterling B2B Integrator.
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License Modification: Examples:

There are several different ways you can use the AddLicenseSet command to
modify your licenses.

UNIX Examples

From the install_dir/bin directory:

Scenario Command usage (UNIX example)

Reload a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -reload

Reload all of the license files
in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -reload

Upgrade a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -upgrade

Windows Examples

From the install_dir\bin directory:

Scenario Command usage (Windows example)

Reload a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -reload

Reload all of the license files
in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -reload

Upgrade a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -upgrade

Installing and Configuring Perimeter Servers
A perimeter server is an optional software tool for communications management.
A perimeter server can be installed in a demilitarized zone (DMZ). A DMZ is a
computer host or small network inserted as a neutral zone between a company's
private network and their public network. A perimeter server requires a
corresponding perimeter client.

The perimeter server manages the communications flow between outer layers of
your network and the TCP-based transport adapters. A perimeter server can solve
problems with network congestion, security, and scalability, especially in
high-volume, Internet-gateway environments.

Installation Guidelines for Perimeter Servers with Sterling B2B Integrator: The
installation program installs a perimeter client and a local mode server. The local
mode server is useful for testing purposes or in environments that do not require a
secure solution. However, if you require high-volume, secure connections, you
must install a perimeter server in a remote zone, either a more secure or less
secure network than your integration server.

Consider the following before you install a perimeter server:
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v Licensing for a perimeter server is determined by the licensing restrictions on
the corresponding B2B adapters.

v Each perimeter server is limited to two TCP/IP addresses:
– Internal interface is the TCP/IP address that the perimeter server uses to

communicate with Sterling B2B Integrator.
– External interface is the TCP/IP address that the perimeter server uses to

communicate with trading partners. To use additional TCP/IP addresses,
install additional perimeter servers.

v You can have multiple perimeter servers installed on the same computer
interacting with one instance of Sterling B2B Integrator. To install a perimeter
server on a computer with an existing instance, install the new perimeter server
in a different installation directory.

v The combination of internal TCP/IP address and port must be unique for all
perimeter servers installed on one computer.
– If a perimeter server is installed using the wildcard address, then all ports

must be unique. The assigned ports are not available for use by adapters that
use the server or any other perimeter server on that computer.

– The internal and external interface may use the same TCP/IP address.
However, the port used by the perimeter server is not available to the
adapters that use the server.

Perimeter Server Installation Methods: You can install perimeter server either in
silent mode or in interactive mode. The default installation mode is silent. In the
silent mode, you should specify the details in a silent file, whereas in the
interactive mode, you should enter the value each time a prompt appears.

Perimeter Server Information Gathering Checklist: Before you install the
perimeter server, you need to gather the following information and answer the
following questions:

Perimeter Server Information Gathering
Checklist Your Notes

Path to java

Path to the Sterling B2B Integrator
installation directory

Will this perimeter server be installed in a
less secure network?

TCP/IP address or the DNS address that the
perimeter server will listen on.

Listening port for the perimeter server.

Local port that the perimeter server will use
to connect to Sterling B2B Integrator.

Port number must be higher than 1024.

Perimeter Server Security Vulnerabilities: When Sterling B2B Integrator is
deployed with a remote perimeter server in a more secure network zone, there is a
security vulnerability. An intruder may compromise the host where the proxy
resides, and take over the persistent connection to the perimeter server residing in
the more secure zone. If this happens, the perimeter server will relay all the
intruder's network requests past the firewall into this internal zone.
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To prevent an intrusion, limit the activities the remote perimeter server can
perform on behalf of the proxy to specifically those activities that the proxy needs
to do for its operation.

Control these limitations by using a configuration residing in the secure network
zone with the remote perimeter server, inaccessible by the proxy that could become
compromised.

Installing a perimeter server in a more secure network (Windows):

Install a perimeter server in a more secure network in a Windows environment in
interactive mode.

Before you begin

v Sterling B2B Integrator must be installed.
v Complete the Perimeter Server information gathering checklist.

Procedure

1. Close all open Windows programs.
2. Copy the .jar installation files from the installation media to a Windows

directory. If you are using FTP to copy the file, be sure that your session is set
to binary mode.

3. Complete the following steps:
a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Enter the following command:\path_to_java\java -jar

\install_dir\install\packages\ps_filename.jar –interactive

4. Enter the full path name for the Sterling B2B Integrator installation directory
and press Enter.
If there is an existing installation in the directory you specify, you can update
it using the same settings. Enter yes, and the installation proceeds without
more entries.

5. Enter yes to confirm that the installation directory is correct.
The program verifies the amount of available disk space.

6. Answer the question:
Is this server in a less secure network than the integration server?

Yes

7. Answer the question: Will this server need to operate on specific
network interfaces?

v Enter yes to select from a list network interfaces available.
v Enter no.

8. Enter the TCP/IP address or DNS name that the integration server listens on
for the connection from this perimeter server.

9. Enter yes to confirm the TCP/IP address or DNS name.
10. Enter the port that the integration server listens on for the connection from

this server. The port number must be higher than 1024.
11. Enter the local port number that the perimeter server uses for the connection

to the integration server.
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The port number must be higher than 1024. Specify a port of zero for the
operating system to select any unused port.

12. Enter yes to confirm the port number.
After the installation is complete, the following messages are displayed:
Installation of Perimeter Service is finished

To start this Perimeter Server change to the install directory and run
the startup script.

You will also need to configure this server in your integration server
(SI) UI.

Installing a perimeter server in a less secure network (Windows):
About this task

Install a perimeter server in a Windows environment in interactive mode.

Procedure

1. Close all open Windows programs.
2. Copy the .jar installation files from the installation media to a Windows

directory. If you are using FTP to copy the file, make sure that your session is
set to binary mode.

3. Complete the following steps:
a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Enter the following command:\path_to_java\java -jar

\install_dir\install\packages\ps_filename.jar –interactive

4. Enter the full path name of the installation directory.
5. If there is an existing installation in the directory you specify, you can update

it using the same settings. Answer the question:
There is an existing install at that location, update it while keeping
existing settings?

If yes, the installation proceeds without more entries.

Note: If you want to change any of the settings, you must use a new
directory, or delete the old installation before you reinstall the perimeter
server. You cannot overwrite an existing installation, and you cannot use an
existing directory that does not contain a valid installation. The existing
installation must be Sterling B2B Integrator V5.2.x or later.

6. Confirm that the installation directory is correct.
The program verifies the amount of available disk space.

7. Answer the question:
Is this server in a less secure network than the integration server?

Yes

8. Answer the question:
Will this server need to operate on specific network interfaces?

If yes, the program returns a list of the network interfaces available on your
host. Select the interfaces for the server to use.

9. Enter the TCP/IP address or DNS name for the internal interface to use to
communicate with the integration server (Sterling B2B Integrator). Press Enter
to use a wildcard for this address.
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10. Verify the TCP/IP address or DNS name for the internal interface.
11. Enter the TCP/IP address or DNS name for the external interface to use to

communicate with trading partners. Press Enter to use a wildcard for this
address.

12. Verify the TCP/IP address or DNS name for the external interface.
13. Enter the port that the perimeter server listens on for the connection from the

integration server (Sterling B2B Integrator). The port number must be higher
than 1024.

14. Verify the port.
When the perimeter server is installed, the following message is displayed:
Installation of Perimeter Service is finished

15. Change to the installation directory.
16. Enter startupPs.cmd to start the perimeter server.

Silent Installation Method for an External Perimeter Server: You can install an
external perimeter server using a silent install file. The perimeter server can be
installed on the same machine where you have installed Sterling B2B Integrator or
on a separate machine. It is recommended to install the perimeter server on an
separate machine.

To use the silent installation method, you first create the silent install file and then
you use to complete the installation.

Create the Silent Installation File for an External Perimeter Server:
About this task

Create a silent installation file with the following variables:

Entry Description

INSTALL_DIR (Required) The installation directory that stores perimeter server
files and related directories. This directory must exist prior to
running the silent install.

REVERSE_CONNECT (Optional) Determines if the perimeter server is to be installed in a
more secure network zone. Valid values:

v Y - more secure network zone

v N - less secure network zone

PS_PORT (Required) Determines the perimeter server port to interact with
the system.

PS_SECURE_IF (Required) Determines the TCP/IP address or DNS name for the
internal interface to communicate with the integration server
(Sterling B2B Integrator). You can use a wildcard (*) for this
address.

PS_EXTERNAL_IF (Required) Determines the TCP/IP address or DNS name for the
external interface to communicate with the trading partners. You
can use a wildcard (*) for this address.

REMOTE_ADDR (Optional) Determines the remote perimeter server address.

(Not required if REVERSE_CONNECT=N)

REMOTE_PORT (Optional) Determines the remote perimeter server port.

(Not required if REVERSE_CONNECT=N)
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Entry Description

MAX_JVM_HEAP (Required) Determines the maximum Java heap size allocated to
the JVM.

Installing an external perimeter server with a silent installation file (Windows):

Install an external perimeter server with a silent installation file.

About this task

Before you begin, create the silent installation file.

Procedure

1. From the installation media, copy SI.jar to a Windows directory.
2. Set up your silent installation file and record the file location.
3. Complete the following steps:

a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Enter the following command:\path_to_java\java -Xmx512m -jar

\install_dir\install\packages\ps_filename.jar –f silent.txt

Install a Fix Pack in a Remote Perimeter Server (Windows):
About this task

Remote perimeter servers are not automatically updated by a fix pack. You must
reinstall the perimeter server using the new perimeter server installation file
supplied with the fix pack.

To update a Remote Perimeter Server:

Procedure

1. Update your installation with the latest fix pack. Obtain the fix pack from the
Support Center web site.

2. Locate your perimeter server file in the install_dir\install\packages directory of
your installation. For fix packs, obtain the file from the Support Center web
site. These files have a name that identifies a version number. For example,
ps_2006.jar.

3. Copy the file to a directory on the remote server.
4. Stop the perimeter server.
5. Complete the following steps:

a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
c. Enter the following command:\absolutePath\bin\java -jar filename.jar

-interactive

Where the absolutePath is the directory name where the Java version is
installed.

6. Enter the full path to the installation directory. If you do not want to change
any settings for your perimeter server, specify the same directory where the
remote perimeter server was originally installed.
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7. Answer the question:
There is an existing install at that location, update it while keeping
existing settings?

If yes, the installation will proceed without additional entries.

Note: If you want to change any of the settings, you must use a new directory,
or delete the old installation before performing the new installation. You cannot
overwrite an existing installation, and you cannot use an existing directory that
does not contain a valid installation. The existing installation must be V5.2 or
later.
When the perimeter server is installed, the following message is displayed:
Installation of Perimeter Service is finished

8. Change to the installation directory.
9. Start the perimeter server.

Grant Permissions for Specific Activities for a Perimeter Server:
About this task

Before you begin:
v Remote perimeter server must be installed for a more secure zone.
v Know what permissions you want to grant
v Understand the content of the restricted.policy file. The first two grant sections

in the restricted.policy file are required for correct perimeter server operation.
Do not modify these sections.

Procedure

1. Install a remote perimeter server, choosing the option for a more secure
network zone.

2. At the installation prompt Is this server in a less secure network than the integration
server?, select No, which is the option for a more secure network zone.

3. Navigate to the perimeter server installation directory.
4. Open the restricted.policy file.
5. Add permission lines for each back-end server that you intend to allow the

proxy to access. There are commented out examples for each type of server.
The first two grant sections are required for correct perimeter server operation.
Do not modify these sections.
For example, you can grant permission to a target FTP Server. In the example,
servers are configured to listen on the following ports: 33001 (for FTP), 33002
(for HTTP), and 1364 (for C:D). These port numbers can be edited.
// To restrict or permit the required Host/Server to communicate with the
PS, update the “ftphost/htttphost/snode” with that of the Server IP and
provide the appropriate PORT number where the Server will listen. //
// For each target FTP Server
// permission java.net.SocketPermission "10.117.15.87:33001", "connect"; //
Control connection.
// permission java.net.SocketPermission "10.117.15.87:lowPort-highPort",

"connect"; // Passive data connections.
// 10.117.15.87 indicates IP of the FTP Server for which the permission is

granted by PS for communicating with client //
// For each target HTTP Server
//
// permission java.net.SocketPermission "10.117.15.87:33002", "connect";
// 10.117.15.87 indicates IP of the HTTP Server for which the permission

is granted by PS for communicating with client //
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// For each target C:D snode
//
// permission java.net.SocketPermission "snode:1364", "connect";
// 10.117.15.87 indicates IP of the Connect Direct Node for which

the permission is granted by PS for communication //

6. In the perimeter server installation directory, there is the perimeter server
settings file called remote_perimeter.properties. Edit it to change the "restricted"
setting to a value of true to turn on restrictions.

7. In the future, any attempt by the perimeter server to access disallowed network
resources will be rejected and logged in the perimeter server log written to the
perimeter server installation directory.

Perform DNS Lookup on Remote Perimeter Server:
About this task

By default, a perimeter server performs DNS lookup in the main server JVM. If
you have limited DNS in your secure area, you can configure the remote perimeter
server to look up trading partner addresses in the DMZ.

To enable DNS lookup, add the following property to
customer_overrides.properties. Set the value to true:

Property Name Description

perimeter.*.forceRemoteDNS=true Forces resolution of DNS names at remote
perimeter server.

Set the value to true to configure remote
perimeter servers to look up trading partner
addresses.

Start Perimeter Servers (Windows):
About this task

To start a perimeter server in Windows:

Procedure

1. Navigate to the perimeter server installation directory.
2. Complete the following steps:

a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
3. Enter startPSService.cmd.

Stop Perimeter Servers in (Windows):
About this task

To stop a perimeter server in Windows:

Procedure

1. Complete the following steps:
a. Click Start.
b. Right-click Command Prompt and select Run as administrator. The

Administrator: Command Prompt dialog box is displayed.
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2. Enter stopPSService.cmd.

User Documentation
The user documentation is available from an online documentation site on the
web.

Providing the documentation in an online environment allows for frequent updates
of content that is based on user feedback and usability.

If you need a printed copy of the documentation, you can print topics of
information through your Internet browser, or you can download documents in
PDF format, after you add it to a collection on IBM Knowledge Center.

To access the documentation site from within Sterling B2B Integrator or one of its

tools, select the help 
 

icon. The system must reside on a computer that supports
Internet access and an Internet browser.

Improving your access to online documentation:

You can improve your access to online documentation by using several methods.

About this task

After you access the IBM Knowledge Center, you can perform the following tasks:
v Enter a word or phrase and search the entire library for information.
v Move through a hierarchy of contents pages to identify the topic you want to

read or print.
v Print topics by using your browser's Print function.
v Add documents to your collection and download them in PDF format.

Uninstall Sterling B2B Integrator from a Windows Non-Cluster
Environment
Before you begin

If you have installed Sterling B2B Integrator software using IIM, then perform
these steps to unregister Sterling B2B Integrator packages from the IIM registry:
v Launch IIM.
v Click Uninstall and select the required Sterling B2B Integrator package (Media,

FixPack, or Interim Fix).
v Confirm and click Uninstall.

About this task

To uninstall Sterling B2B Integrator from a Windows environment:

Procedure
1. Stop Sterling B2B Integrator and wait for shutdown to complete. Navigate to

the install_dir\install\bin directory and enter StopWindowsService.cmd If
you begin removing files before all business processes and the system is
stopped, you may be unable to remove the software successfully.

2. Back up the file system and database.
This step is optional. However, by backing up the file system and database,
you are ensured that Sterling B2B Integrator is completely recoverable.
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3. Remove the installation directory by entering the following command in the
parent directory of your installation directory: rd /s /q \install_dir\install

4. If you use an Oracle, Microsoft SQL Server, or DB2 database, these remain
intact even after you remove Sterling B2B Integrator from the server. If you no
longer want to reference the data, contact your database administrator about
removing unwanted tables and recovering the database space where Sterling
B2B Integrator used to reside.

5. Manually remove the JDK:
a. Navigate into the _uninst subdirectory of your JDK installation directory
b. Enter uninstall.cmd

6. After you remove Sterling B2B Integrator from the server, you can remove
Eclipse, and any tools that were downloaded to the desktop, including the
following:
v Map Editor and associated standards

Refer to the Map Editor Guide for information about removing the Map
Editor.

v Graphical Process Modeler
Refer to the Graphical Process Modeler Guide for information about removing
the Graphical Process Modeler.

v Web Template Designer
Refer to the Web Extensions Guide for information about removing the Web
Template Designer.

v (If licensed) MESA Developer Studio plug-ins, including:
– MESA Developer Studio Software Development Kit (SDK)
– MESA Developer Studio Skin Editor
Refer to the MESA Developer Studio guide for information about removing
MESA Developer Studio.

v (If licensed) Reporting Services, which requires MESA Developer Studio if
you want to use the plug-ins to create fact models and custom reports.
Refer to the MESA Developer Studio guide for information about removing
Reporting Services.

Troubleshooting Tips for Windows Environment

Situation Message or Symptom Explanation/Resolution

Installing You encounter errors or problems during
installation.

Explanation

The installation creates several log files that
you can use to diagnose problems like the
failure of an installation.

Resolution

Examine the log files generated during
installation:

v ant.install.log (in the install_dir directory)

v install_dir\PreInstallSI.log
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Situation Message or Symptom Explanation/Resolution

Installing When you entered an absolute path during
installation, a message indicated that the
command was not found.

Explanation

You entered an incorrect path. Check the
information entered.

Resolution

Enter the correct path.

Installing IM is installed successfully, but SI Fails to
install.

Go to Start Open IM select Help and then
Export logs to a file for analysis.

Installing a desktop
tool or resource

Cannot download any of the following:

v Map Editor and associated standards

v Graphical Process Modeler

v Web Template Designer

v (If licensed) MESA Developer Studio
plug-ins, including:

– MESA Developer Studio Software
Development Kit (SDK)

– MESA Developer Studio Skin Editor

v (If licensed) Reporting Services, which
requires MESA Developer Studio if you
want to use the plug-ins to create fact
models and custom reports.

Explanation

When you install Sterling B2B Integrator,
system files are created that contain an
internal IP address. If you install Sterling
B2B Integrator behind a firewall, and your
firewall is configured to accept an external IP
address from a client computer, you may not
be able to download the desktop tools and
resources. The firewall will reject the internal
IP address from a client residing outside of
the firewall.

Resolution

Modify the system files that contain the
invalid IP address. Follow these steps:

1. Navigate to \install_dir\install\bin.

2. Stop Sterling B2B Integrator.

3. Enter the following command followed
by the external IP address:

patchJNLP.cmd external_IP_address

4. Restart Sterling B2B Integrator.

Cluster Installation or
Upgrade

When configuring TCPS the following
warning can be found in the
activemqbroker.log:

sun.security.provider.certpath.
SunCertPathBuilderException:
unable to find valid certification
path to requested target

Resolution

Add the system certificate to the trust store
using the KeyTool command.

Cluster Installation or
Upgrade

When configuring TCPS the following
warning can be found in the
activemqbroker.log:

Do not mention any
SSL cipher in the ActiveMQconfig.
xml. oracle.net.ns.NetException:
Invalid cipher suites specified.

Resolution

Do not mention any SSL cipher in the
ActiveMQconfig.xml.
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Situation Message or Symptom Explanation/Resolution

e-Invoice Upgrade:
Oracle Add Constraint
Error

When you upgrade Sterling e-Invoicing and
are using an Oracle database, if the upgrade
fails with the error message name is already
used by an existing object, this occurs
because the default behavior for the drop
constraint command changed in Oracle 10.

Explanation

The index that is used to support the
constraint is now only removed if the index
was generated by the create constraint
command. The indexes for Sterling
e-Invoicing are always generated from
constraints during an install. If you receive
this error during a Sterling e-Invoicing
upgrade, it is because of how the database
was restored, the version of Oracle you are
using, and because the Oracle imp command
exported the indexes and constraints
separately. There is no way to determine
when the imp command will not add a
create index command to the export file if it
was generated by a constraint – but if it does
add the command, the database restore
process loses the association of the constraint
and its underlying index. The database script
that runs during a Sterling e-Invoicing
upgrade executes two steps: 1. First, it drops
the unique constraint so the next step can
redefine it using additional columns.
However, the drop constraint command does
not remove the underlying index if the
association with its index was lost. 2. The
next command that redefines this constraint
requires a different index definition, but in
this scenario the name of the index the
constraint wants to use already exists, which
causes the name is already used by an
existing object error.

Resolution

If you receive this error message, the
solution for this problem is to drop the index
and rerun the Sterling e-Invoicing upgrade.
The drop index command you should use is:
drop index UNQ_EINV_CANON
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Situation Message or Symptom Explanation/Resolution

Apply a fix pack or
Upgrade

The \install_dir\install\installed_data
directory is created (if clustered, on each
node) during an upgrade or applying a fix
pack.

This directory can become very large and
take up needed space on the file system.

Explanation

The information in this directory is used
during upgrade or applying a fix pack, but is
not required afterward. The
deployment/cleanup tasks for the upgrade
or fix pack do not remove this directory.

Resolution

The directory can be manually removed to
increase the available space for the file
system:

1. Navigate to \install_dir\install

2. Enter

rd /S installed_data

3. If prompted to confirm deletion, enter Y
for yes.

UNIX/Linux Cluster Environment Installation (V5.2.6 or later)
You may follow different installation and upgrade scenarios when you install and
upgrade Sterling B2B Integrator in a UNIX/Linux Cluster environment.

Installation Scenarios

It is important to review the following installation scenarios:

Scenario Instructions

Version 5.1.x is installed and it needs to be
upgraded to V5.2.6.

See “Upgrading (V5.2.6 or later)” on page
320

Version 5.2.x is installed and it needs to be
upgraded to V5.2.6.

See Applying a fix pack (V5.2.6 or later)

Version 5.2.6 is being installed as the base
release.

Review this document and use the
installation instructions.

Prerequisite knowledge for installation in the UNIX environment
The installation of Sterling B2B Integrator requires background knowledge in
different areas.

Before you begin the installation, you must be knowledgeable on the following
topics:
v Application servers
v Operating system on which you plan to install
v Database administration
v VI or another text editor
v System Requirements for this release of Sterling B2B Integrator.
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Intended audience:

This document can be used by different members of your organization.

This document is intended for use by:
v System administrators
v Installation engineers
v Database administrators.

Assumptions for this guide:

The procedures in this guide are accurate as of the publication date and are
specific to this version of the document.

Before you begin the installation
Before you install Sterling B2B Integrator, you must perform certain tasks.

Before you begin the software installation, you need to perform the following
tasks:
v Perform system verification tasks
v Perform operating system verification tasks
v Obtain the correct version of the JDK, JCE, and JDBC drivers required. Most

Java files required are provided with the product download or media. See the
System Requirements for more information.

System verification tasks:

Before you install Sterling B2B Integrator, you must perform certain system
verification tasks.

Item System Verification Task Your Notes®

1 Use the System Requirements to verify that your
system hardware and software meet the
requirements that are specified for this release.

For HP, you must run the HP JConfig utility to
obtain the required patches and kernel
modifications.

2 Verify that the file system has adequate free disk
space.

3 Verify the following items:

v An operating system user account exists on the
host server.

v User account has permissions to run the
commands for the operating environment.

4 Verify that your database was installed and
configured. See the Configure the Database chapter
for more information.

If you are going to manually apply DDL
statements, you need to complete the database
schema work before you begin the installation.
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Item System Verification Task Your Notes®

5 If you are using a non-English-language
environment, confirm that you are using the
appropriate character set.

Operating system verification:

Before you install Sterling B2B Integrator, you must perform certain operating
system verification tasks.

You must verify your operating system configuration by using the following
checklist:

For the Operating System Operating System Configuration Checklist Your Notes

HP-UX Establish these settings:

v Verify kernel parameters and establish the following
minimum settings by running kctune command:

– kctune max_thread_proc 1024

– kctune maxdsiz 2147483648

– kctune maxdsiz_64bit 8589934592

– kctune maxssiz 369098752

– kctune maxssiz_64bit 536870912

v Run the ulimit utility, verify, and establish the
following minimum settings:

– ulimit -d = 2097152 KB or higher

– ulimit -s = 360448 KB or higher
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For the Operating System Operating System Configuration Checklist Your Notes

AIX To ensure that /install_dir/install directory has the
necessary permissions, AIX users must run the
following command on the parent directory of the
/install_dir/install directory before installation:

chmod -R a-s <absolute path>/install_dir_parent

where install_dir_parent is the directory in which
/install_dir/install is created.

For example, to specify

AIX_1/applications/test1/my_install as your
installation directory, run the command from the
AIX_1/applications directory (directly above the test1
directory):

chmod -R a-s test1

or from another location on the file system:

chmod -R a-s /AIX_1/applications/test1

This command ensures that when the my_install
directory is created during installation, it inherits the
correct permissions from the test1 directory.

The ncargs parameter specifies the maximum allowable
size of the ARG/ENV list (in 4 KB blocks) when the
exec() subroutines are run. Set the ncargs parameter to
16 or higher.

To display the current value of ncargs, enter the
command lsattr -El sys0 -a ncargs.

To change the current value of ncargs, enter the
command chdev -l sys0 -a ncargs=NewValue.

Note: The lsattr command option is –El (lowercase L)
and the chdev command option is –l (lowercase L).

Change the following default entries in the
/etc/security/limits file:

v fsize = -1

v core = 2097151

v cpu = -1

v data = 262144

v rss = 65536

v stack = 65536

v nofiles = 4096
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For the Operating System Operating System Configuration Checklist Your Notes

Linux You must disable SE Linux by entering the following
text:

/etc/sysconfig/selinux: SELINUX=disabled

Ensure that /etc/hosts has short-names first for all
entries. For example,
127.0.0.1localhostlocalhost.localdomain

If the base locale is English, verify the following values:

v LANG variable is en_US

v LANG variable is exported
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For the Operating System Operating System Configuration Checklist Your Notes

Red Hat Enterprise Linux Make the following system changes:

1. If the base locale for the system is English, edit the
/etc/sysconfig/i18n file by changing the SUPPORTED
variable from en_US.utf8 to en_US. You can also
allow multiple support with the following format:
en_US.utf8:en_US

2. Save and close the /etc/sysconfig/i18n file.

3. Edit the /etc/security/limits.conf file by adding
the following lines:

v * hard nofile 8196

v * soft nofile 4096

v * hard memlock 3000000

v * soft memlock 3000000

v * hard nproc 16000

v * soft nproc 16000

v * hard stack 512000

v * soft stack 512000

This change updates the system ulimits. For nofile,
set the value to unlimited.

4. Save and close the /etc/security/limits.conf file.

5. Restart the system.

IBM Installation Manager in UI mode might fail to start
on an RHEL 6.1 or higher x86_64 (64-bit) OS because
Installation Manager is a 32-bit application and depends
on some of the 32-bit libraries.

For information about installing the required 32-bit OS
libraries, refer to the IBM Support website
(https://www-304.ibm.com/support/
docview.wss?uid=swg21459143)

CAUTION:
Because of a known issue with the IBM JDK on RHEL
6.1 or higher, a performance degradation might be seen
in comparison to previous RHEL releases. To avoid
this issue, disable the CFS on RHEL 6.1 or higher.

To disable CFS:

1. Log in as root

2. Edit /etc/sysctl.conf and add
"kernel.sched_compat_yield = 1"

3. Restart the system

For more information, go to the IBM SDK and
Runtime Environment Java Technology Edition
Version 6 information Center and search for known
limitations on Linux.
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For the Operating System Operating System Configuration Checklist Your Notes

Solaris Set the following entries in the /etc/security/limits
file:

nofiles = 4096 (recommended value is unlimited)

set rlim_fd_max=4096 (limit is 65535) - hard limit

set rlim_fd_cur=4096 - soft limit

v To make the setting effective as the hard limit, restart
the server or run the following command:

kill -1 inetd

v To make the setting effective as the soft limit, use the
parent shell configuration (for example, .profile).
Then, restart the server.

SUSE Linux Make the following system changes:

1. If the base locale for the system is English:

v For the individual user, edit the $HOME/.i18n file
by setting export LANG="en_US".

v For a system-wide change, edit the
/etc/sysconfig/language file by setting
RC_LANG="en_US". You must also set
ROOT_USES_LANG="yes".

2. You can also allow multiple support with the
following format: RC_LANG="en_US.utf8:en_US"

3. Save and close the file. Language settings take effect
on your next session.

4. Edit the /etc/security/limits.conf file by adding
the following lines:

v * hard nofile 8196

v * soft nofile 4096

v * hard memlock 3000000

v * soft memlock 3000000

v * hard nproc 16000

v * soft nproc 16000

v * hard stack 512000

v * soft stack 512000

This change updates the system ulimits. For nofile,
set the value to unlimited.

5. Save and close the /etc/security/limits.conf file.

6. Restart the system.

Verification of the system requirements:

Before you begin the installation, verify that your system meets the hardware and
software requirements that are specified for this release.

The hardware requirements that are listed in the System Requirements are the
minimum requirements. Your system requirements might exceed these
requirements if you are running other applications on the same machine as Sterling
B2B Integrator.

The installation strictly enforces the following system requirements:
v Operating system version must match requirement exactly.
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v The minimum patch level for the operating system is enforced, but you can
apply higher patch levels.

v JDK version must match requirement exactly.
v The disk space is a minimum for the installation. The system must be separately

sized to handle whatever load is going to be put on the system.
v Database version must match exactly.
v JDBC driver version supports exact matches and wildcard matches.

If any of these requirements are not met, the installation fails. If the installation
fails, review the installation log for a list of non-compliant items.

Upgrading your JDK (Windows and UNIX):

Sometimes you need to upgrade your JDK version to support a new version of
Sterling B2B Integrator.

About this task

If you have V5.2.4.1 or higher installed, you can use the upgradeJDK script to
upgrade your version of the JDK. See bin Directory Files for more information.

If you have V5.2.4.0 or lower installed, follow the steps below to upgrade your
JDK.

Procedure

1. Download the new JCE file. For example, the UnrestrictedPolicy.zip policy
file for the IBM JDK.

2. Back up the existing JDK in <Install Dir>/jdk. Change the folder name to
jdk_back)

3. Copy the new IBM JDK (1.7.0 ) folder to the installation Directory. Directory
Name should be jdk )

4. Copy all the jars present in <Install Dir >jdk_back\jre\lib\ext to <install
Dir>jdk\jre\lib\ext directory.

5. If your installation of V5.2.4 or lower was built using the Oracle (SUN) JDK,
continue to the next step. Otherwise skip to step 6.
a. Edit the sandbox.cfg property file.
b. Set JCE_DIST_FILE=<New Path of Supported JCE File>. For example,

JCE_DIST_FILE=D\:\\IBM\\unrestrictedpolicyfiles.zip.
c. Back up the local_policy.jar and US_export_policy.jar files present in

<Install Dir>jdk\jre\lib\security.
d. Unzip the new JCE file. For example, Unrestrictedpolicyfiles.zip file.

Copy local_policy.jar and US_export_policy.jar to <Install
Dir>jdk\jre\lib\security.

6. Run updateJavaSecurity.cmd <path_to_new_jdk><Install Dir>/jdk.
7. Verify that security providers have been updated in <Install

Dir>\jdk\jre\lib\security\java.security.
8. Follow the Upgrade Guide instructions for your upgrade scenario.

Configure the Database
You must install, create, and configure a database so that each Sterling B2B
Integrator instance has a dedicated schema and login for the database.
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In a clustered environment, Sterling B2B Integrator can support the following
databases:
v DB2
v Oracle®

v Microsoft SQL Server

See System Requirements for supported version information.

Required database information before you install Sterling B2B Integrator in a
cluster environment:

Before you begin to install Sterling B2B Integrator, you need to install and
configure your database.

Review and gather the following information. An x indicates that the information
is required.

Information to Gather Oracle DB2

Microsoft
SQL
Server

Record Information
Here

Application Instance Host

Application Instance Port

Database User Name x x x

Database Password x x x

Database Catalog Name x x x

Database Host x x x

Database Port x x x

JDBC Driver #1 x x x

Use BLOB data? x x

Enable Multibyte Support? x x x

Database sizing and capacity planning:

Database sizing is designed to give you estimates of the database growth and to
help you plan the disk requirements.

There are many factors to consider when you are estimating the amount of disk
space that is required for Sterling B2B Integrator. As a result, trying to consider all
growth factors is impractical because the user might not know the answers to
many questions that are required to do a detailed forecast. Over the years the cost
of disks has dramatically decreased, and the capacity and speed of disks has
increased. The method of how information system managers order disk capacity
also has changed, from purchasing disk arrays that are dedicated to a particular
database server and project, to the concept of SANS (storage area networks).

Consider the confidence that you have in your data estimates when you are
making the final purchase decision and adjust accordingly. After the initial
purchase and production deployment, disk growth should be tracked for future
purchase forecasts.

You should track your actual database storage usage and the number of database
records regularly. Correlating these two metrics enabled you to plan your future
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disk requirements. Moreover, determining the average amount of space used for
each order line or shipment line, enables you to accurately predict your future
growth requirements.

Database Definition Language (DDL) statements:

When you install Sterling B2B Integrator, you can manually apply Database
Definition Language (DDL) statements to your database tables instead of requiring
the installation process to do it directly.

This feature increases database security by reducing the database permissions of
the Sterling B2B Integrator database user. The rights to database objects can be
reserved for a secure user like a customer database administrator (DBA). A
business can require that only a DBA with the proper permissions can make
database changes.

Configuring the DB2 Database:

Before you install Sterling B2B Integrator with the DB2 database, you must
configure the database.

Before you begin:
v If you do not have DB2 installed, follow the procedures in the DB2 installation

manual.
v The installation script creates tables and indexes. Certain tables require a page

size of 32 KB. You must have a temporary table space to accommodate such
tables. DB2 automatically places tables and indexes in the available table spaces.
You can move the tables to a different table space after the installation is
complete.

v If you are reinstalling the software, be aware that data in your existing database
is deleted. To preserve the data, either back up the existing database or save it
under a different name.

v After you create and configure your database, recycle the database. Then, stop
and restart the database to apply the changes.

Use the following checklist to configure DB2 for Sterling B2B Integrator:

Item DB2 Database Configuration Checklist Your Notes

1 Create the database.

Refer to the DB2 documentation on creating the
database, including creating a schema repository,
login, and table space.
Important: In V5.2.6.2 or later you must ensure
that all tablespaces used by Sterling B2B
Integrator tables have a minimum page size of
8K. Otherwise installation will fail.

Be sure to install the correct version and patches.
See the System Requirements for supported
version information.

3 Review the DB2 parameters.

4 Ensure that the DB2 user privileges are set.

5 Install the JDBC drivers for DB2.
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DB2 database user privileges:

The DBADM role is required to perform administrative operations in DB2
database.

DB2 parameters:

When you install Sterling B2B Integrator with the DB2 database, you must set
certain DB2 parameters. Other DB2 parameter settings are recommended for the
efficient performance of Sterling B2B Integrator.

When you install Sterling B2B Integrator with DB2, you must set the DB2
parameters that are listed in the following topics:
v “Mandatory settings for IBM DB2 registry variables” on page 6
v “Mandatory settings for DB CFG parameters” on page 6

After you install Sterling B2B Integrator with DB2, you can improve the DB2
database performance by setting the recommended parameters that are listed in the
performance documentation for the following items:
v DB2 registry variables
v DBM CFG parameters
v DB CFG parameters
v DB2 for Linux on System z
v DB2 for LUW configuration and monitoring

Mandatory settings for IBM DB2 registry variables:

Mandatory IBM DB2 registry values are critical for IBM DB2 performance with
Sterling B2B Integrator.

Variable Mandatory value

DB2_SKIPDELETED ON

Allows index-range queries or table-scan queries to skip
records that are in an uncommitted delete state. This
reduces the amount of lock contention from Read Share
and Next Key Share locks from range queries in tables
with a high frequency of deletes.

When enabled, DB2_SKIPDELETED allows, where
possible, table or index access scans to defer or avoid
row locking until a data record is known to satisfy
predicate evaluation. This allows predicate evaluation
to occur on uncommitted data.

This variable is applicable only to statements using
either Cursor Stability or Read Stability isolation levels.
For index scans, the index must be a type-2 index.
Deleted rows are skipped unconditionally on table scan
access while deleted keys are not skipped for type-2
index scans unless DB2_SKIPDELETED is also set.

Recommended value: ON
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Variable Mandatory value

DB2_SKIPINSERTED ON

Allows SELECTs with Cursor Stability or Read Stability
isolation levels to skip uncommitted inserted rows. This
reduces record lock contention on tables with heavy
insert rates.

Mandatory settings for DB CFG parameters:

For optimal performance, certain parameters and values are mandatory for DB2.

Parameter Mandatory value

Database Code Set UTF-8

Installing DB2 client components, compilers, and fix pack:

The use of Sterling B2B Integrator with the DB2 database requires the installation
of different items for the database.

About this task

Sterling B2B Integrator uses stored procedures for DB2. For more information
about these tasks, see the IBM documentation for DB2.

Procedure

You must install or set up the following DB2 components to use Sterling B2B
Integrator with DB2:
1. Install the Administration client.
2. Install the necessary fix pack after you install the client components and

compilers. Otherwise, the clients overwrite the fix pack binary files.
3. Set the path for the compiler by entering the db2set command.

Installing JDBC drivers for DB2:

When you install Sterling B2B Integrator with the DB2 database, you must install a
JDBC driver for the database.

About this task

For DB2, install the appropriate DB2 JDBC Type 4 driver and any correlating
patches. For the supported version information, see System Requirements.

You can obtain these files from the IBM website. After you obtain this JDBC driver,
record the absolute path to its location on your system. You must supply this
absolute path during installation.

If the JDBC driver provided by your database vendor is distributed among
multiple files, you must place all the files that comprise the JDBC driver into one
JAR file. Follow these steps to create one JAR file:
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Procedure

To install a JDBC driver for the DB2 database:
1. Identify all the vendor database JAR files for the JDBC driver.
2. Record the absolute path to the JAR file you created on the Preinstallation

Checklist.
The Type 4 driver does not require a separate Java listener to be running on the
database server. Instead, connect directly to the DB2 port.

Upgrading DB2 to version 10.1 or 10.5:

To upgrade from DB2 9.5 or 9.7 to 10.1 or 10.5, you must make configuration
changes.

Procedure

To upgrade from DB2 9.5 or 9.7 to 10.1 or 10.5:
1. Copy your DB2 9.5 or 9.7 database content to DB2 10.1 or 10.5.

Attention: Back up all files before you change any settings.
2. Back up the database driver in the /install_dir/dbjar/jdbc/DB2/ directory

and replace it with the DB2 10.1 or 10.5 version.
3. Update the following sandbox.cfg file fields with your environment-specific

parameters:
DB_PASS=
DB_SCHEMA_OWNER=
DB_DRIVERS_VERSION=
YANTRA_DB_PORT=
DB_DATA=
DB_HOST=
YANTRA_DB_USER=
DB_PORT=
YANTRA_DB_PASS=
YANTRA_DB_DATA=
YANTRA_DB_HOST=
DB_DRIVERS=
DB_USER=

DB2_PORT=
DB2_USER=
DB2_PASS=
DB2_DATA=
DB2_HOST=

4. Edit the following value in the activemq.xml file:
activemq.xml: <value>jdbc:db2//DB_HOST:DB_PORT/DB_DATA</value>

5. Run the setupfiles script.
6. Run the deployer script.
7. Start Sterling B2B Integrator.

Configuring the Oracle Database:

Before you install Sterling B2B Integrator with the Oracle database, you must
configure the database.
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Before you begin

v If you are reinstalling the software, be aware that data in your existing database
is deleted. To prevent this deletion, either back up the existing database or save
it under a different name.

v After you create and configure your database, recycle the database. Then, stop
and restart to apply the changes.

About this task

Use the following checklist to configure Oracle for Sterling B2B Integrator:

Item
Oracle Database Configuration
Checklist Your Notes

1 Create the database.

Refer to the Oracle documentation
on creating the database, including
creating a schema repository, login,
and table space.

Be sure to install the correct version
and patches.

See the System Requirements for the
supported version information.

2 Configure an Oracle Instance.

3 Configure Oracle Rollback.

4 Install the Oracle JDBC Driver.

5 Enable Failover in a Multiple Node
Oracle RAC Database Cluster.

6 After Sterling B2B Integrator is
installed, if you want to encrypt the
data traffic, perform one of the
following tasks:

v Configure Sterling B2B Integrator
for Data Traffic Encryption

v Configure Sterling B2B Integrator
for Data Traffic Encryption with
SSL

Configuring an Oracle instance:

An Oracle database requires certain parameter settings and other configurations.

Before you begin

v You must have the Oracle database installed. Ensure that you have installed the
correct versions and patches. See System Requirements for supported version
information.

v Ensure that the user responsible for creating and modifying the Oracle database
has a specified quota (extent) assigned in the table space, even if the user was
assigned an unlimited table space. Otherwise, the installer might display the
error ORA-09150: no privileges on tablespace name.
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Procedure

1. Run the create instance procedure. Use AL32UTF8 as the character set.
2. Configure the INIT<INSTANCE_NAME>.ORA file with the recommended and

mandatory settings in the Performance Management guide. See the Oracle init
parameter configuration checklist for specific settings.

Note: After you complete the installation of Sterling B2B Integrator with
Oracle, you can improve the performance of the database with the settings
listed in the Performance Management guide.

3. Identify or create a table space for user tables and indexes.
4. Create a user. Unless stated for a task, the user does not require database

administrator (DBA) privileges.
5. Grant permissions to the user. The following permissions are required for the

administrative user for creating and modifying the Oracle database:
v GRANT "CONNECT" TO SI_USER

v ALTER USER SI_USER DEFAULT ROLE "CONNECT"

v GRANT CREATE SEQUENCE TO SI_USER

v GRANT CREATE TABLE TO SI_USER

v GRANT CREATE TRIGGER TO SI_USER

v GRANT SELECT ON CTXSYS.CTX_USER_INDEXES TO SI_USER

v GRANT SELECT ON SYS.DBA_DATA_FILES TO SI_USER

v GRANT SELECT ON SYS.DBA_FREE_SPACE TO SI_USER

v GRANT SELECT ON SYS.DBA_USERS TO SI_USER

v GRANT SELECT ON SYS.V_$PARAMETER TO SI_USER

v GRANT SELECT ANY DICTIONARY TO SI_USER

v GRANT ALTER SESSION TO SI_USER

v GRANT CREATE SESSION TO SI_USER

6. If you are using Oracle AQ, grant the AQ_ADMINISTRATOR_ROLE
permission.

7. If you plan to use EBICS Client, grant the GRANT CREATE VIEW TO SI_USER
permission.

Configuring Oracle rollback:

The configuration of rollback in an Oracle database helps you manage database
transactions.

About this task

You can roll back changes in Oracle by using AUTO UNDO management. IBM
recommends that you use this option. This practice avoids any manual monitoring
of UNDO segments.

Installation of the Oracle JDBC driver:

Sterling B2B Integrator requires the appropriate JDBC driver for the Oracle
database.

The JDBC drivers are thin client-based pure Java JDBC drivers. See System
Requirements for supported version information. The supported versions of the
JDBC driver build the correct Sterling B2B Integrator directory structure.
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Enabling failover in a multiple node Oracle RAC database cluster:

You can enable failover in a multiple node Oracle RAC database cluster in
UNIX/Linux by using traditional RAC or RAC with SCAN.

Procedure

To enable failover in a multiple node Oracle RAC database cluster:
1. Open the /install_dir/install/properties directory to modify the

sandbox.cfg file.
2. In the sandbox.cfg file, add a ORACLE_JDBC_URL property, which contains the

Oracle RAC connection URL.
Choose one of the following depending on whether you are using traditional
RAC or RAC with SCAN. The property value must be one string of text that
starts with ORACLE_JDBC_URL=. Your database administrator (DBA) can modify
this URL as needed:
v To configure traditional RAC, use this format:

jdbc:oracle:thin:@
(DESCRIPTION=
(ADDRESS_LIST=
(FAILOVER=ON)
(LOAD_BALANCE=OFF)
(ADDRESS=(PROTOCOL=TCP)(HOST=myhost1)(PORT=1521))
(ADDRESS=(PROTOCOL=TCP)(HOST=myhost2)(PORT=1521))
)
(CONNECT_DATA = (SERVER = DEDICATED)(SERVICE_NAME=myservicename OR mySID))
)

Note: This method uses the default Oracle RAC service that is provided by
Oracle.

v To configure RAC with SCAN, use this format:
jdbc:oracle:thin:@host:port/service

For example:
jdbc:oracle:thin:@RAC-SCAN:1521/ORCL

Where:
– RAC-SCAN is resolved to an IP address by DNS
– 1521 = Port number
– ORCL = the name of your Oracle RAC service

Important: To use RAC with SCAN, you must also define a new Oracle
RAC service (you cannot use the default service) that defines one node as
the preferred node and at least one node as a failover node.

3. Open the /install_dir/install/bin directory.
4. Enter the command ./setupfiles.sh.

Data traffic encryption in the Oracle database:

You can encrypt transactions between Sterling B2B Integrator and the Oracle
database. Encryption prevents anyone who is outside the system from viewing the
data that flows between Sterling B2B Integrator and the database.

The following list describes important aspects of enabling database encryption:
v At installation, encryption is turned off by default. If you want your database

transactions to be encrypted, you must enable encryption.
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v The encryption can be enabled at any time.
v Encryption applies to all database transactions between Sterling B2B Integrator

and the database.

System performance might be impacted when encryption is enabled. The extent of
this impact depends on your hardware, database configuration, transaction
volume, and the relative amount of processing time that is spent by the system
against other activities.

For more information on data traffic configuration, see SSL With Oracle JDBC Thin
Driver.

Before you encrypt data traffic for the Oracle database:

The decision to encrypt data traffic for the Oracle database includes several
considerations.

Consider the following items when you configure database traffic encryption:
v Sterling B2B Integrator must be installed in TCP (clear) mode before you can

configure encryption.
v Perform these changes to your database before you install Sterling B2B

Integrator.
v Configure wallets for encryption-only mode even if the wallet that is used is

empty. Enable auto login for all wallets.
v If you want to use SSL for encryption only, it is recommended to follow the

instructions in the "CASE #1: USE SSL FOR ENCRYPTION ONLY" section of the
Oracle documentation. It is not necessary to configure certificates for the wallet.
In this mode, Diffie-Hellman ciphers are used. The server and the client are not
authenticated through SSL. You must authenticate by using a user name and a
password. However, if you are running Sterling B2B Integrator on an operating
system that requires an IBM JDK, you cannot use this mode, as IBM JSSE
TrustManager does not permit anonymous ciphers. You must configure wallets
with certificates.

v If you want to use SSL for encryption and for server authentication, it is
recommended to follow the instructions in the "CASE #2: USE SSL FOR
ENCRYPTION AND SERVER AUTHENTICATION" section of the Oracle
documentation.

v If you want to use SSL for encryption and for server authentication of both tiers,
it is recommended to follow the instructions in the Oracle "CASE #3: USE SSL
FOR ENCRYPTION AND AUTHENTICATION OF BOTH TIERS" section of the
Oracle documentation, depending on how you intend to configure client or
server authentication.

v After you configure your database for data traffic encryption, the database
accepts both TCP (clear) and TCPS (encrypted) connections.

v There is a known issue in the Oracle 11g database when the listener is
configured only for TCPS. The lsnrctl utility that is used to start and stop
database listeners attempts to contact the listener, which is enabled first. You
should define the address list of the listener to contact either TCP or IPC before
it contacts TCPS.

Configuring Sterling B2B Integrator for data traffic encryption in Oracle:

You can enable data traffic encryption-only, with anonymous authentication, and
not SSL authentication.
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About this task

If you want to use SSL for encryption only, it is recommended to follow the
instructions in the "CASE #1: USE SSL FOR ENCRYPTION ONLY" section of the
Oracle documentation. It is not necessary to configure certificates for the wallet. In
this mode, Diffie-Hellman ciphers are used, and the server and the client are not
authenticated through SSL. You must authenticate by using a user name and a
password.

However, if you are running Sterling B2B Integrator on a system that requires an
IBM JDK, you cannot use this mode, as IBM JSSE TrustManager does not permit
anonymous ciphers. You must configure wallets with certificates.

This procedure is applicable only if you are running Sterling B2B Integrator on a
system that requires Sun JDK. The IBM JSSE TrustManager does not permit
anonymous ciphers.

If your Sterling B2B Integrator is a cluster installation, you need to perform this
procedure on each node, starting with node 1.

Procedure

To configure Sterling B2B Integrator for data traffic encryption in Oracle:
1. Install Sterling B2B Integrator in TCP (clear) mode.
2. Stop Sterling B2B Integrator.
3. Open the /install_dir/install/properties directory.
4. Open the customer_overrides.properties file and add the following database

connection information:
jdbcService.oraclePool.prop_oracle.net.ssl_cipher_suites=
(SSL_DH_anon_WITH_3DES_EDE_CBC_SHA, SSL_DH_anon_WITH_DES_CBC_SHA)
jdbcService.oraclePool.prop_oracle.net.ssl_server_dn_match=false

If you have a configured container, ensure that the same database information
is added to the customer_overrides.properties.in file. To locate the file,
navigate to the /install_dir/install/properties/nodexACy directory, where x
gives the node number and y gives the container number. Perform this step
for all the containers configured in the system.

5. Repeat Step 4 for the following Oracle connection pools by changing only the
pool name:
v oraclePool_local

v oraclePool_NoTrans

v oracleArchivePool

v oracleUIPool

If you have any other database pools, you need to add the properties for those
pools.

6. Open the sandbox.cfg file and change the database connection information as
shown:
ORACLE_JDBC_URL= jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS=(PROTOCOL=tcps)
(HOST=<DB host>)(PORT=<TCPS port as configured in DB config section above>))
(CONNECT_DATA=(SERVICE_NAME=<service name>)))

Make sure that you enter values for the HOST, PORT, and SERVICE_NAME
parameters.
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7. Open the activemqconfig.xml.in file and modify the following database
connection information:
v Remove or comment out the following default ActiveMQ database

configuration information:
<bean id="gis-ds" class="org.apache.commons.dbcp.BasicDataSource"
destroy-method="close" singleton="true" lazy-init="default"
autowire="default" dependency-check="default"
SCIOverrideName="persistence-bean">

<property name="driverClassName">
<value>oracle.jdbc.driver.OracleDriver</value>
</property>
<property name="url">
#:ifdef ORACLE_JDBC_URL
<value>&ORACLE_JDBC_URL;</value>
#:else
<value>jdbc:oracle:thin:@&ORA_HOST;:&ORA_PORT;:&ORA_DATA;</value>
#:endif
</property>
<property name="username">
<value>&ORA_USER;</value>
</property>
<property name="password">
<value>&ORA_PASS;</value>
</property>
<property name="maxActive">
<value>32</value>
</property>
</bean>

v Add the following ActiveMQ database configuration information:
<bean id="gis-ds"
class="oracle.jdbc.pool.OracleDataSource" destroy-method="close"
singleton="true" lazy-init="default"
autowire="default"
dependency-check="default">
<property name="URL"><value>&ORACLE_JDBC_URL;</value></property>
<property name="user"><value>&ORA_USER;</value></property>
<property name="password"><value>&ORA_PASS;</value></property>
<property name="connectionProperties">
<value> oracle.net.ssl_cipher_suites:

(SSL_DH_anon_WITH_3DES_EDE_CBC_SHA, SSL_DH_anon_WITH_DES_CBC_SHA)
oracle.net.ssl_client_authentication: false
oracle.net.ssl_version: 3.0
driverClassName:oracle.jdbc.driver.OracleDriver
maxActive: 32

</value>
</property>
</bean>

8. Open the /install_dir/install/bin directory.
9. Enter the command ./setupfiles.sh.

10. Restart Sterling B2B Integrator. All the database connections from Sterling B2B
Integrator are now connected through TCPS (encrypted) mode.

Configuring Sterling B2B Integrator for data traffic encryption with SSL authentication in
Oracle:

You can enable data traffic encryption and SSL authentication.

About this task

This procedure is applicable if you are running Sterling B2B Integrator on a system
that requires either Sun JDK or IBM JDK.
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The example in this procedure uses two-way SSL authentication. It is
recommended to follow the instructions in the "CASE #2: USE SSL FOR
ENCRYPTION AND SERVER AUTHENTICATION" section of the Oracle
documentation.

You can also configure one-way SSL authentication. If you want to use SSL for
encryption and for server authentication of both tiers, it is recommended to follow
the instructions in the "CASE #3: USE SSL FOR ENCRYPTION AND
AUTHENTICATION OF BOTH TIERS" section of the Oracle documentation.

If your installation of Sterling B2B Integrator is a cluster installation, you need to
perform this procedure on each node, starting with node 1.

Procedure

To configure Sterling B2B Integrator for data traffic encryption with SSL
authentication in Oracle:
1. Install Sterling B2B Integrator in TCP (clear) mode.
2. Stop Sterling B2B Integrator.
3. Open the /install_dir/install/properties directory.
4. Open the customer_overrides.properties file and add the following database

connection information:
jdbcService.oraclePool.prop_javax.net.ssl.trustStore=/.../path/.../ClientKeyStore.jks
jdbcService.oraclePool.prop_javax.net.ssl.trustStoreType=JKS
jdbcService.oraclePool.prop_javax.net.ssl.trustStorePassword=password
jdbcService.oraclePool.prop_oracle.net.ssl_version=3.0
jdbcService.oraclePool.prop_javax.net.ssl.keyStore=/.../path/.../ClientKeyStore.jks
jdbcService.oraclePool.prop_javax.net.ssl.keyStoreType=JKS
jdbcService.oraclePool.prop_javax.net.ssl.keyStorePassword=password

5. Repeat step 4 for the following Oracle connection pools by changing only the
pool name:
v oraclePool_local

v oraclePool_NoTrans

v oracleArchivePool

v oracleUIPool

If you have any other database pools, you need to add the properties for those
pools.

6. Open the sandbox.cfg file and change the database connection information to
the following value:
ORACLE_JDBC_URL= jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS=(PROTOCOL=tcps)
(HOST=<DB host>)(PORT=<TCPS port as configured in DB config section above>))
(CONNECT_DATA=(SERVICE_NAME=<service name>)))

7. Open the /install_dir/install/activemq/conf directory.
8. Open the activemqconfig.xml.in file and modify the database connection

information:
v Remove or comment out the following default ActiveMQ database

configuration information:
#:ifdef ORACLE
<bean id="gis-ds" class="org.apache.commons.dbcp.BasicDataSource"

destroy-method="close" singleton="true" lazy-init="default"
autowire="default" dependency-check="default"

SCIOverrideName="persistence-bean">
<property name="driverClassName">
<value>oracle.jdbc.driver.OracleDriver</value>
</property>
<property name="url">
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#:ifdef ORACLE_JDBC_URL
<value>&ORACLE_JDBC_URL;</value>
#:else
<value>jdbc:oracle:thin:@&ORA_HOST;:&ORA_PORT;:&ORA_DATA;</value>
#:endif
</property>
<property name="username">
<value>&ORA_USER;</value>
</property>
<property name="password"><value>&ORA_PASS;</value>
</property>
<property name="maxActive"><value>32</value>
</property>
</bean>
#:endif

v Add the following ActiveMQ database configuration information:
<bean id="gis-ds"
class="oracle.jdbc.pool.OracleDataSource" destroy-method="close"
singleton="true" lazy-init="default" autowire="default"
dependency-check="default">
<property name="URL"><value>&ORACLE_JDBC_URL;</value></property>
<property name="user"><value>&ORA_USER;</value></property>
<property name="password"><value>&ORA_PASS;</value></property>
<property name="connectionProperties"><value>
javax.net.ssl.trustStore: /.../path/.../ClientKeyStore.jks
javax.net.ssl.trustStoreType:JKS
javax.net.ssl.trustStorePassword:password
oracle.net.ssl_version:3.0
javax.net.ssl.keyStore: /.../path/.../ClientKeyStore.jks
javax.net.ssl.keyStoreType:JKS
javax.net.ssl.keyStorePassword: password
driverClassName:oracle.jdbc.driver.OracleDriver
maxActive:32
</value>
</property>
</bean>

9. Enter the command ./setupfiles.sh.
10. Restart Sterling B2B Integrator. All the database connections from Sterling B2B

Integrator are now connected through TCPS (encrypted) mode.

Configuring the Microsoft SQL Server Database:

Before you install Sterling B2B Integrator with the Microsoft SQL Server database,
you must configure the database.

Before you begin

v If you are reinstalling the software, be aware that data in your existing database
is deleted. To preserve your data, either back up the existing database or save it
under a different name.

v After you create and configure your database, recycle the database. Then, stop
and restart to apply the changes.

About this task

Use the following checklist to configure Microsoft SQL Server for Sterling B2B
Integrator:
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Item
Microsoft SQL Server Database
Configuration Checklist Your Notes

1 If you do not have Microsoft SQL
Server installed, follow the installation
procedures in the SQL Server
installation manual.

Refer to the Microsoft SQL Server
documentation on creating the
database, including creating a schema
repository, login, and table space.

Be sure to install the correct version
and patches.

See System Requirements for supported
version information.

3 “Microsoft SQL Server database
parameters” on page 16

4 “Microsoft SQL Server database user
privileges” on page 16

5 “Configuring the snapshot feature for
Microsoft SQL Server” on page 18

Microsoft SQL Server database user privileges:

In Microsoft SQL Server, you must grant DBO (Database Owner) permission to the
user. The DB_DDLADMIN role is required for creating objects in the SQL Server
database.

Microsoft SQL Server database parameters:

When you install Sterling B2B Integrator with the Microsoft SQL Server database,
you must set certain Microsoft SQL Server parameters. Other Microsoft SQL Server
parameter settings are recommended for the efficient performance of Sterling B2B
Integrator.

When you install Sterling B2B Integrator with Microsoft SQL Server, you must set
the Microsoft SQL Server parameters that are listed in “Mandatory settings for
Microsoft SQL Server” on page 17.

After you install Sterling B2B Integrator with Microsoft SQL Server, you can
improve the database performance by setting the recommended parameters that
are listed in the performance documentation for the following items:
v Instance-specific settings for Microsoft SQL Server
v Database-specific settings for Microsoft SQL Server

Mandatory settings for Microsoft SQL Server:

The default collation of Microsoft SQL Server must match the collation for the
Sterling B2B Integrator database to prevent collation conversions.

The tempdb database that is used by Microsoft SQL Server must be created with the
same collation as the default collation of Microsoft SQL Server. The Microsoft SQL
Server uses the tempdb database for results that are too large to fit in memory.
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If the collations of the tempdb database and the Sterling B2B Integrator database
differ, the database engine must convert from the Sterling B2B Integrator collation
to the tempdb collation, and then back again before it sends the results to the
Sterling B2B Integrator server. These conversions might lead to severe performance
issues.

The collation that is required for the Sterling B2B Integrator database is a collation
that most closely matches the character set used by Java. By using this collation,
you can avoid character data conversions before the data is stored in the database
tables. Use the mandatory parameter that is described in the following table when
you configure the collation setting:

Parameter Value

Database Collation SQL_Latin1_General_CP850_Bin

Additionally, you must perform these tasks:
v Allow Microsoft SQL Server to manage memory dynamically (default).
v Disable any antivirus software that is running on the Microsoft SQL Server

data, transaction log, and binary files directory.

Installing the JDBC driver in Microsoft SQL Server:

The use of a SQL Server database with Sterling B2B Integrator requires the
installation of a JDBC driver.

About this task

Sterling B2B Integrator requires the correct Microsoft SQL Server driver. See the
System Requirements for the supported version information.

Download the driver and any appropriate patches from the Microsoft website.

Procedure

To install the JDBC driver in Microsoft SQL Server:
1. Download the sqljdbc_version_language.tar.gz file to a temporary directory.
2. To unpack the compressed TAR file, open the directory where you want the

driver unpacked and type the following command:
gzip -d sqljdbc_version_language.tar.gz

3. To unpack the TAR file, open the directory where you want the driver installed
and type the following command:
tar –xf sqljdbc_version_language.tar

After the package unpacks, you can find out more information about using this
driver by opening the JDBC Help System in the /absolutePath/
sqljdbc_version/language/help/default.htm file. This file displays the help
system in your web browser.

4. When the Sterling B2B Integrator installation asks for the location of the JDBC
drivers, specify the extracted JAR file created after you unpack the archive,
which is usually named sqljdbc.jar. The JDBC driver version is the same as
the version of the drivers that are downloaded from Microsoft.
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Configuring the snapshot feature for Microsoft SQL Server:

The snapshot feature in Microsoft SQL Server allows you to view a read-only copy
of the database even when it is locked. Configuring the snapshot feature can also
reduce deadlocks. To enable the snap shot feature, enter the following command:
ALTER DATABASE db_name SET READ_COMMITTED_SNAPSHOT ON;

Managing Database Passwords:

A password is used by the system to connect to its database. The password is
stored as clear text in a system property file.

If the security policies at your company require you to encrypt these passwords,
you can do so after you install the system. Encrypting these passwords is optional.

Database passwords encryption methods:

Database passwords are encrypted with one of two methods: OBSCURED or
ENCRYPTED.

The encryption method is decided by the value of the encryptionPrefix property
in the propertyEncryption.properties or the
propertyEncryption.properties_platform_security_ext file.

Encrypting database passwords:

Use commands to encrypt database passwords.

Procedure

To encrypt the database password:
1. Stop Sterling B2B Integrator.
2. Open the /install_dir/install/bin directory.
3. Enter the command ./enccfgs.sh.
4. Enter the command ./setupfiles.sh.
5. Enter the command ./deployer.sh.
6. Enter the command ./run.sh to start Sterling B2B Integrator.
7. Enter your passphrase.

Decrypting database passwords:

Use properties files and commands to decrypt database passwords.

Procedure

To decrypt the database password:
1. Stop Sterling B2B Integrator.
2. Open the /install_dir/install/properties directory.
3. Open the sandbox.cfg file.
4. Copy the encrypted password from the database_PASS property.

Use the text that appears after the database_PASS=text. For example, if
database_PASS= OBSCURED:123ABCxyz321, you would copy the text
OBSCURED:123ABCxyz321. (OBSCURED is the encryption method for the password.)
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5. Open the /install_dir/install/bin directory.
6. Enter the command ./decrypt_string.sh encrypted_password.

For encrypted_password, use the text that you copied in Step 4. You are
prompted for the system passphrase. After you enter the passphrase, your
decrypted password appears.

7. Open the /install_dir/install/properties directory.
8. Edit the sandbox.cfg file to replace the encrypted password with the

password that was returned in Step 6.
9. You need to decrypt the entries for the YANTRA_DB_PASS and DB_PASS

properties. Repeat Steps 4 - 8 to decrypt these entries. You must also decrypt
any passwords present in the property files. Encrypted passwords typically
exist in the following property files:
v sandbox.cfg

v apservsetup

v jdbc.properties

v jdbc.properties.in

v customer_overrides.properties

v customer_overrides.properties.in

10. Open the /install_dir/install/bin directory.
11. Enter the command ./setupfiles.sh.
12. Enter the command ./deployer.sh.
13. Enter the command ./run.sh to start Sterling B2B Integrator.
14. Enter your passphrase.

Preparing for Installation
To help ensure a trouble-free installation, you should complete the installation
checklist and understand some concepts.

Installation checklist for UNIX/Linux cluster:

The installation checklist contains the items that you need to gather and the tasks
you need to complete before installing Sterling B2B Integrator in a cluster
environment.

The checklist contains:
v Brief descriptions for tasks (detailed procedures are provided after the checklist)
v Information that you need to gather to complete the installation

You might want to make a copy of the following checklist and use it to record the
information you collect.

The cluster environment does not support the following items:
v MySQL database
v AS2 Edition
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#
Installation Checklist for
UNIX/Linux Cluster Node 1 Node 2 Node 3 Your Notes

1 Review your IBM contract to
determine what software you
are licensed to use. You need to
know this “License
information” on page 21 so that
you can select the correct
components/features to install.

2 Determine which installation
method you are going to use:

v IBM Installation Manager
(Graphical User Interface)

v IBM Installation Manager
(Response File)

3 Decide which type of security
certificates to use:

v The default self-signed SSL
(Secure Sockets Layer)
certificate that is
automatically installed.

v A Certificate
Authority-related certificate
that you install before you
install Sterling B2B
Integrator.

4 If you are using an Oracle,
Microsoft SQL Server, or DB2
database, decide whether to
manually or automatically
apply Database Definition
Language (DDL) statements
(schema) to the database.

5 If you are using an Oracle 11.1
database, you must set it up for
native compilation by
allocating space and by setting
the plsql_native_library_dir
parameter.

6 Determine whether the
database password needs to be
encrypted.

7 Record the host name on which
you plan to install the software.

8 Record the name of the
directory where you plan to
install the software.

9 Record the login name to the
host server.

10 Record the password to the
host server.

11 Record the path to the
installation wizard and file
name.
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#
Installation Checklist for
UNIX/Linux Cluster Node 1 Node 2 Node 3 Your Notes

12 Record the path to the JDK.

13 Record the path to the JCE file.

14 Record the host IP address.

15 Record the initial port number.

16 Record the system passphrase.

17 Record the database vendor
name.

18 Record the database user name.

19 Record the database password.

20 Record the database (catalog)
name.

21 Record the database host name.

22 Record the path and file name
for the JDBC driver or drivers.

License information:

A separate license is required for each Sterling B2B Integrator feature that you
purchased. During installation, you must choose the license files according to what
you purchased. Product licenses do not require an activation key.

IBM assumes customers will only install and use the products they purchased. IBM
reserves the right to inspect installs for compliance at any time.

After the installation finishes, if you determine that you need to modify licenses
files, see “License modifications” on page 58.

Product Licenses for Sterling B2B Integrator

Sterling B2B Integrator Standard and Enterprise Edition includes:
v MESA Studio
v eInvoicing
v Report Services
v all services and adapters not listed below

Sterling B2B Integrator Standard and Enterprise Financial Edition includes
everything listed above plus:
v CHIPS
v SWIFTNet
v NACHA ACH CTX adapter
v FEDWIRE
v Fin Serv XML standard
v FIPS Mode
v Image Cash Letter service
v EBICS
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Multicast ports in node to node communications:

Cluster nodes are configured to communicate with each other using JGroups, an
open source toolkit that provides flexibility for protocol configuration.

JGroups provides rich open management features, along with multiple protocol
support. JGroups supports multicast (UDP) and TCP-based communication
protocols.

When JGroups is configured to use multicast (UDP), all cluster nodes communicate
with each other on a specific IP address and port. The configuration of multicast
ports is based on the installation base port. All clusters that are on the same subnet
that is configured on the same base port send multicasting messages on the same
multicast IP address and port.

To avoid this situation, each cluster on the same subnet needs to be configured on
different base ports. Install your clusters on different port ranges or on different
network segments with multicast forwarding restricted, so that they do not
interfere with each other. The default multicast address is 239.255.166.17. This
address is configurable, with a port range of 10 ports, starting with the multicast
base port for the instance.

All nodes that are participating in the same cluster must be installed on the same
multicast base port (the multicastBasePort property in the
noapp.properties_platform_ifcresources_ext.in file). This value is usually
computed from the system base (non-multicast) port, but can be configured
separately in the noapp.properties_platform_ifcresources_ext.in file, to allow
different nodes in a cluster to be installed at different (non-multicast) port ranges.
Also, all the nodes in the cluster must be installed in the same subnet.

For node to node communications, the properties are defined in the
jgroups_cluster.properties file. The following attributes are used to define
communications:
v property_string - default value is UDP.
v distribution_property_string - default value is TCP. This attribute must never

be set to UDP.

If you want to change the communication for cluster multicast from the UDP
protocol to TCP, you need to change the value of the property_string property in
the jgroups_cluster.properties.in file (after you back up the file). Then, run the
setupfiles command. You can change this value right after the installation or after
you start running the cluster. If you change the file after you start the cluster, you
need to stop all nodes of the cluster, change the value on each node, and then
restart your cluster.

To change the communication for cluster multicast from the UDP protocol to TCP,
use the following value for the property_string property in the
jgroups_cluster.properties.in file:
property_string=TCP(start_port=any_available_port_number):
TCPPING (initial_hosts=this_instance_host_ip[start_port_number],
theothernode_instance_host_ip[theothernode_start_port_number];port_range=2;
timeout=5000;num_initial_members=3;up_thread=true;down_thread=true):
VERIFY_SUSPECT(timeout=1500):pbcast.NAKACK(down_thread=true;up_thread=true;
gc_lag=100;retransmit_timeout=3000):pbcast.GMS(join_timeout=5000;
join_retry_timeout=2000;shun=false;print_local_addr=true;
down_thread=true;up_thread=true)
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For more information about UDP, TCP, and JGroups communications, see the
Sterling B2B Integrator Clustering documentation.

Port numbers:

During installation, you are prompted to specify the initial port number.

Use the following guidelines for port numbers:
v A range of 200 consecutive open ports (1025 - 65535) is required for this

installation.

Important: Because of RMI, on occasion, a port number outside the range can
be assigned.

v The initial port number represents the beginning port number in the range.
v Make sure that port numbers in the port range are not used by any other

applications on your system.

After your installation, refer to the /install_dir/install/properties/sandbox.cfg
file for all of the port assignments.

Security certificates:

You can choose between different security certificates before you install Sterling
B2B Integrator.

Before you begin the installation, you must decide which of the following security
certificates to use:
v The default self-signed SSL (Secure Sockets Layer) certificate that is

automatically generated by the installation.
v A Certificate Authority-related certificate that you generate before you install the

software.

If you install with the default SSL certificate, but you later want to switch to a
CA-related certificate, you can change the certificate with the sslCert property in
the noapp.properties_platform_ifcresources_ext.in file.

UNIX accounts:

In a UNIX or Linux environment, create one UNIX administrative account on the
host server for all of the installations.

For example, if you want to create a test environment and a production
environment, create one UNIX account on the host server. For more information
about creating UNIX accounts, see your operating system documentation.

Installing the Software
After you have configured the database and prepared your system, you are ready
to install Sterling B2B Integrator.

General UNIX/Linux installation information:

You can install Sterling B2B Integrator on UNIX or Linux as either a new
installation or as an upgrade from a previous version of Sterling B2B Integrator.
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CAUTION:
IBM Sterling B2B Integrator for Financial Services should be installed behind a
company firewall for security purposes. For more information on secure
deployment options, see the Perimeter Server and Security topics in the Sterling
B2B Integrator documentation library .

Installation Scenarios

It is important to review the following installation scenarios:

Scenario Instructions

Version 5.1.x is installed and it needs to be
upgraded to V5.2.6.

See “Upgrading (V5.2.6 or later)” on page
320

Version 5.2.x is installed and it needs to be
upgraded to V5.2.6.

See Applying a fix pack (V5.2.6 or later)

Version 5.2.6 is being installed as the base
release.

Review this document and use the
installation instructions.

Installation Methods

Use one of the following methods to install your system:
v IBM Installation Manager (graphical user interface)
v IBM Installation Manager (response file)

Important: Install and run Sterling B2B Integrator as a non-root user.

General Installation Guidelines

The following are some general installation guidelines:
v Do not create the installation directory manually before the start of the

installation. If you create the installation directory before you begin, the
installation fails. The directory name that is provided during the installation
process is used to create the new installation directory.

v The server on which you are installing must have adequate free disk space.
v install_dir refers to the installation directory where the new software is

installed. Do not use any pre-existing directory name or an old version of the
Sterling B2B Integrator installation directory; other wise, you could inadvertently
overwrite the existing installation.

v parent_install is the directory one level above the install_dir directory.
v Ensure that the parent_install directory has the proper read/write permissions.
v If you need to install more than one instance of Sterling B2B Integrator on the

same server, you must install the second instance in a different directory.
v The directory path to the SI_<build_number>.jar file cannot include any spaces.
v If you are using FTP to copy the files, verify that your session is set to binary

mode.
v If you are using AIX with the DB2 database, the directory path cannot be longer

than 108 bytes.
v The installation program validates the initial port number and confirms that you

have enough disk space for the installation. These port assignments are written
to the /install_dir/install/properties/sandbox.cfg file.
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v If you are using an IPv6 address, see “Guidelines for IPv6 addresses” on page
167.

v If you are installing Sterling B2B Integrator on VMware, provide the IP address
of the virtual machine, and not the IP address of the VMware host. For example,
if 10.251.124.160 is the IP address of the VMware host and 10.251.124.156 is the
IP address of the Windows 2003 server it is hosting, use 10.251.124.156 as the
correct IP address to install Sterling B2B Integrator.

General IBM Installation Manager information:

IBM Installation Manager V1.8.2 is required to install Sterling B2B Integrator on all
supported platforms.

Installation Manager is a Java based multiplatform installation application and
provides a consistent approach across various platforms. It does not rely on
platform-specific installation technology or mechanism.

Installation Manager uses the local Sterling B2B Integrator offering repositories to
install or update Sterling B2B Integrator and its add-on features. It determines the
packages that must be installed and displays them including the products, fix
packs, and interim fixes. It checks that all prerequisites and interdependencies are
met before installing the selected product package and feature sets.

Important: The Uninstall option only unregisters Sterling B2B Integrator from
Installation Manager. The uninstall procedure as described in the related sections
must be performed to completely uninstall Sterling B2B Integrator.

Installation Manager must be installed on each computer on which Sterling B2B
Integrator is being installed. If you already have Installation Manager installed on
your computer for use with other IBM applications, it can be used with installing
Sterling B2B Integrator as long as it's the correct version. If you do not have
Installation Manager installed, it is provided as part of the Sterling B2B Integrator
installation media.

Supported bit-versions

A 64-bit version of IBM Installation Manager V 1.8.2 is provided with the Sterling
B2B Integrator installation package. However, you can also install with a 32-bit
version of Installation Manager.

Before you start the installation, consider the following options:
v If you are a new customer, use the version of Installation Manager that is

provided with the Sterling B2B Integrator installation package and install
Sterling B2B Integrator.

v If you have an earlier version of Installation Manager, you can update it to
V1.8.2 using the Installation Manager that is provided with the installation
package, then install Sterling B2B Integrator .

v If you are a current customer who did not use Installation Manager earlier,
install the version of Installation Manager that is provided with the installation
package, then upgrade your Sterling B2B Integrator installation.

v If you have a 32-bit Installation Manager installed, you must download the
32-bit Installation Manager V1.8.2 from Fix Central or IBM Passport Advantage,
upgrade it, then proceed with the installation of Sterling B2B Integrator. Ensure
you have the required libraries that support screen presentation of the text.
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Checking for updates

To check for Installation Manager updates, select Search for Installation Manager
updates on the File > Preferences > Updates page. When the check box is
selected, Installation Manager searches for updates when any one of the following
pages are opened from the Installation Manager start page:
v Install Packages
v Modify Packages
v Update Packages

Installation Manager also searches for updates when you click the Check for Other
Versions, Fixes, and Extensions button on the Install Packages page.

Starting Installation Manager

You should start the Installation Manager (and also install Sterling B2B Integrator)
as a non-administrator user.

How you start Installation Manager depends on whether you are using the
Installation Manager agent that is provided with Sterling B2B Integrator or if you
have an Installation Manager instance that is installed on your system. It also
depends on whether you have 32-bit or 64-bit Installation Manager.

Open a command prompt and do one of the following tasks to start the
Installation Manager in GUI mode:
v Go to the IM_<operating_system> directory and type ./userinst or userinst.exe

(Windows) for the following scenario:
– If you do not have Installation Manager installed and are using the

Installation Manager agent that is provided with the Sterling B2B Integrator
media.

– If you have a 64-bit Installation Manager installed.
– If you have Installation Manager installed on a platform that has only one

download available for Installation Manager. For example, AIX, Solaris, HP,
zLinux.

v Go to <installation directory>/Installation Manager/eclipse (for Windows
system, replace / with \) and type ./IBMIM or IBMIM.exe if you have 32-bit
Installation Manager installed on a Linux or Windows system.

For information on starting Installation Manager in command mode for silent
installation, see the Installing or updating with a response file.

For information on starting Installation Manager in command mode to record a
response file, see Recording a response file.

Additional heap memory parameters

The heap memory parameters specify the amount of memory Installation Manager
can use during the installation process. The heap memory pool sizes that are used
by Installation Manager are hardcoded defaults. If these defaults are not sufficient
for your environment, you can specify different values by adding parameters to
the Installation Managerconfig.ini file.

Important: These additional parameters are required only if you are experiencing
Out Of Memory errors during the installation process.
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The following parameters can be added:
v memoryMin=user.sb.INSTALL_<OS>_INIT_HEAP.<amount_of_memory>

v memoryMax=user.sb.INSTALL_<OS>_MAX_HEAP.<amount_of_memory>

Where <OS> is your operating system and <amount_of_memory> is the specified
amount of memory.

Operating
System Parameter Example Entry

Sun-Solaris Initial Heap Size

INSTALL_SUN_INIT_HEAP

memoryMin=user.sb.INSTALL_SUN_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_SUN_MAX_HEAP

memoryMax=user.sb.INSTALL_SUN_MAX_HEAP.3072m

Linux Initial Heap Size

INSTALL_LINUX_INIT_HEAP

memoryMin=user.sb.INSTALL_LINUX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_LINUX_MAX_HEAP

memoryMax=user.sb.INSTALL_LINUX_MAX_HEAP.3072m

AIX Initial Heap Size

INSTALL_AIX_INIT_HEAP

memoryMin=user.sb.INSTALL_AIX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_AIX_MAX_HEAP

memoryMax=user.sb.INSTALL_AIX_MAX_HEAP.3072m

HP-UX Initial Heap Size

INSTALL_HPUX_INIT_HEAP

memoryMin=user.sb.INSTALL_HPUX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_HPUX_MAX_HEAP

memoryMax=user.sb.INSTALL_HPUX_MAX_HEAP.3072m

Windows Initial Heap Size

INSTALL_WIN_INIT_HEAP

memoryMin=user.sb.INSTALL_WIN_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_WIN_MAX_HEAP

memoryMax=user.sb.INSTALL_WIN_MAX_HEAP.3072m

Guidelines for a UNIX/Linux cluster environment installation:

A UNIX/Linux cluster environment installation has certain restrictions and
guidelines.

The cluster environment does not support the following items:
v MySQL database
v AS2 Edition

The following are installation guidelines for cluster environments:
v All nodes must use the same database.
v All nodes must use the same passphrase.
v All nodes must use the same operating system.
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v When you install nodes on different servers, the initial port numbers must be
the same. Installing nodes are different servers helps you take advantage of
cluster features such as reliability, availability, scalability, and failover.

v You must install the nodes sequentially, one at time, starting with the first node.
v When you install nodes on the same server, you must install node 2 and higher

in different directories. Each initial port must be at least 200 higher or lower
than the initial port for the other nodes.

v After you install the nodes, you must start the nodes sequentially, one at a time,
starting with the first node.

Guidelines for IPv6 addresses:

The use of IPv6 addresses in an installation of Sterling B2B Integrator requires
certain guidelines.

Before you use an IPv6 address during an installation, see the IPv6 Capabilities
section in System Requirements.

Consider the following IPv6 address information when you plan the installation:
v If you use an IPv6 address, use a fully qualified address that includes square

brackets around the address, and a zero (0) between colons where there are no
other numbers. For example, use [fe80:0:0:0:213:72ff:fe3c:21bf] instead of
fe80::213:72ff:fe3c:21bf.

v If you are installing with an IPv6 address, comment out the host name mapping
to the IPv4 address and retain the mapping to the IPv6 address in the host file
in the /etc/sysconfig/networking/profiles/default/hosts directory.

v You must install with a host name, not an IPv6 address, otherwise the
Lightweight JDBC adapter and Graphical Process Modeler (GPM) do not work.

v If you are using an Oracle database, do not use an IPv6 address for the host
name.

v If you are using an IPv6 address and are going to configure Sterling B2B
Integrator as a dual stack host, after you complete the installation, you need to
add the IPv6 address (as the admin_host.3 property) to the
noapp.properties_platform_ifcresources_ext .in file.

Installing or updating with a response file (V5.2.6 or later):

You can install or update (apply fix pack or interim fix) Sterling B2B Integrator
with silent mode by using the sample response files or converting your existing
response file to the required format.

Installing in a UNIX/Linux cluster environment with the IBM Installation
Manager in GUI mode:

You can install Sterling B2B Integrator in a UNIX/Linux cluster environment with
the IBM Installation Manager in a graphical user interface (GUI) mode. Use the X
Window System for this installation.

Before you begin

v Complete the “Installation checklist for UNIX/Linux cluster” on page 158.
v Install an X Window windowing system (for example, Cygwin or Xming) for the

UNIX/Linux operating systems on your PC.
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v Install and configure a Telnet client (for example, PuTTY) for use with X
Window System. The following parameters must be set:
– X-11 forwarding must be enabled.
– X display location must be set to localhost.

v If you are using the Standards Processing Engine (SPE) application with Sterling
B2B Integrator, you must install SPE before you install Sterling B2B Integrator.

v If you are using the EBICS Banking Server application with Sterling B2B
Integrator, the data encryption for storage within the installation location is not
supported.

v Set the ulimit and language as follows:
– ulimit -n 4096
– ulimit -u 16000
– export LANG=en_US

About this task

To install Sterling B2B Integrator in a Unix/Linux cluster environment with the
Installation Manager in GUI mode:

Important: Following is a list of changes related to installing or upgrading to
Sterling B2B Integrator V5.2.6:
v You can install and upgrade through the user interface or silent installation

mode (response files). Console mode installation and upgrade is not supported.
v Sterling B2B Integrator JAR file is included in the repository. Therefore it is not

required to manually select the JAR file when installing or upgrading.
v You must use Installation Manager V1.8.2 to install or upgrade Sterling B2B

Integrator. InstallService is disabled, and cannot be used. You can use
InstallService, only for a specific scenario related to Sterling File Gateway. For
more information, see step 15.

Procedure

1. Start the X Window System client on your PC.
Minimize the window after it opens.

2. Open a console window and log on to the UNIX/Linux host server where
Sterling B2B Integrator must be installed.

3. From the installation media, copy the compressed installation package to a
UNIX/Linux directory on the host where Sterling B2B Integrator must be
installed.

4. Decompress the installation package on the host server.
5. Open the InstallationManager folder in the directory structure that is created

when the installation package is decompressed. Several
IM_OperatingSystem.zip files are displayed.

6. Decompress the file for your operating system.
v IM_AIX.zip (for AIX)
v IM_HPIA.zip (for HP-UX Itanium)
v IM_Linux.zip (for Linux)
v IM_Solaris.zip (for Solaris)
v IM_zLinux.zip (for Linux for System z)

This action creates a new IM_OperatingSystem folder.
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Important: Installation Manager V1.8.2 is required to install Sterling B2B
Integrator.

7. Decompress the Common_Repo.zip from the installation package. The action
creates two new folders b2birepo and gmrepo. The IM_OperatingSystem,
b2birepo, and gmrepo folders must be at the same level in a directory.

Important: gmrepo contains the repository file required to install Global
Mailbox. For information about Global Mailbox, see Global Mailbox overview.

8. Open a command prompt and do one of the following tasks to start the
Installation Manager:
a. Go to the IM_<operating_system> directory and type ./userinst for the

following scenarios:
v If you do not have the Installation Manager installed and are using the

Installation Manager agent provided with V5.2.6.
v If you have a 64-bit Installation Manager installed.
v If you have the Installation Manager installed on a platform that has

only one download available for Installation Manager. For example, AIX,
Solaris, HP, zLinux.

b. Go to <installation directory>/Installation Manager/eclipse and type
./IBMIM, if you have 32-bit Installation Manager installed on your Linux
system.

9. On the Installation Manager home page, click Install.

Important: If IM_<operating_system> and b2birepo directories are not in the
same directory or if you already have Installation Manager installed, then you
get a message saying that there no packages to install or Installation Manager
could not connect to the repositories. You must add the Sterling B2B
Integrator repository files to the Installation Manager repository. For more
information about adding repository files, see Repository preferences.

10. On the Install Packages screen, select IBM Sterling B2B Integrator. This
action selects the versions also. Click Next.

11. Review the license agreement and select the option I accept the terms in the
license agreement.
If you do not accept the agreement, the installation process does not continue.

12. Select the location for the shared resources directory and click Next. This
directory is used by the Installation Manager for Sterling B2B Integrator
installation and other installations.
The shared resources directory cannot be a subdirectory of the directory for
the installation of Sterling B2B Integrator. The shared resources directory must
be empty.

13. Choose Create a new package group and specify the path to Sterling B2B
Integrator installation directory.

14. Select the required features to be installed. The available options are:
v IBM Sterling B2B Integrator

v IBM Sterling File Gateway

Important: From Sterling B2B Integrator V5.2.6 onward, Sterling File
Gateway V2.2.6 is automatically installed if IBM Sterling File Gateway is
selected. Any additional post installation tasks are not required to start
Sterling File Gateway. It is strongly suggested to install Sterling File
Gateway when installing Sterling B2B Integrator V5.2.6. If for any reason
Sterling File Gateway is not installed with Sterling B2B Integrator, you
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cannot install Sterling File Gateway later using the Installation Manager.
You must use InstallService to install it. For information about installing
Sterling File Gateway by using InstallService, see Installing Sterling File
Gateway (V2.2.6 or later).

v FIPS Module

v AS2 Edition Module

v Financial Services Module

v EBICS Banking Server Module

v B2B Advanced Communications Integration Module

Important: When installing Sterling B2B Integrator, select B2B Advanced
Communications Integration Module to install Sterling B2B Integrator bridge.
Sterling B2B Integrator bridge is required for communication between Sterling
B2B Integrator and B2B Advanced Communications. If you are installing
Global Mailbox and Sterling B2B Integrator, then B2B Advanced
Communications Integration Module (Sterling B2B Integrator bridge) is
installed by default, because Global Mailbox uses the storage module of B2B
Advanced Communications. However, you must configure the adapter
containers and adapters for Sterling B2B Integrator bridge after installing.

Important: Sterling B2B Integrator is selected by default. Select only the
licenses and features that were defined by your IBM contract. If you are
unsure which to select, the installation can proceed without a selection and
complete successfully. Startup and operation of the software, however,
requires one of the licenses to be selected. See “License modifications” on
page 58 to apply licenses after the installation.

15. Type the path to your JDK directory and click Next.
16. Specify the configuration for the features to install and click Next.

v FIPS Compliance Mode (Must enable FIPS Module)

v NIST 800-131a Compliance Mode

– off (default value)
– strict

v SPE Integration Module (Requires pre-install of SPE, WTX optional)

If you select the SPE option, you are prompted for the following
information:
– SPE installation directory
– (Optional) WebSphere Transformation Extender (WTX) installation

directory
– SPE UI port
For more information, see the documentation for the integration of Sterling
B2B Integrator and SPE.

17. Type the path to the JCE policy file and click Next.
18. Enter the following server location information and click Next:

a. Type the explicit IP address or host name for the server or use the default
value of localhost.

b. Type the initial port number or use the default value of 8080.
19. Enter the system passphrase information and click Next:

a. Type a passphrase.
b. Confirm the passphrase.

20. Type the email information and click Next:
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a. Type the email address to which you want system alert messages sent.
b. Type the SMTP mail server (IP address or host name) that you want to use

for system alert messages and other administrative notices.
21. Enter the following database information and click Next.

a. Select the database vendor that you want to use:
v Oracle
v Microsoft SQL Server
v DB2
v MySQL

b. Select all of the following options that apply to this installation:

Choices: Action

(Not for MySQL) This installation is for a
cluster node 2 or higher

If you are installing node 2 or higher in the
cluster setup, select the check box and
specify the node number.
Important: In a cluster setup, run the
startCluster command after installing the
first node (node 1) from the
/install_dir/install/bin directory, on the
host where you installed the node. The
syntax is startCluster.sh nodeNumber true.
Replace nodeNumber with 1. After you run
the startCluster command for the first
node, the subsequent nodes will have
clustering automatically started by the
installer when they are installed.

(Not for MySQL) Apply database schema
automatically?

The default is to automatically apply the
DDL (Data Definition Language) statements
that apply the database schema.

If you want to manually create the database
schema, then clear the Apply database
schema automatically check box and
continue with the remaining installation
steps.
Important: If you manually apply the
schema, the installation stops without error
later in the installation process so that you
can manually apply the schema.

22. Type the following database connection information. Do not click Next until
you configure the JDBC driver in the next steps.
v User name
v Password (and confirmation)
v Catalog name
v Host
v Port

23. Select a JDBC driver or drivers and click Next:
a. Click Add to browse to the file location for the appropriate JDBC driver or

drivers:
v (Oracle, Microsoft SQL Server, and MySQL only) Absolute path and file

name for one JDBC driver file.
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v (DB2 only) Absolute paths and file names for two JDBC driver files. Use
the Type-4 JDBC driver. This type of driver converts JDBC calls into the
network protocol that is used directly by DB2, allowing a direct call
from the system to the DB2 server.

b. Click Test to confirm that the driver is supported for the database and
Sterling B2B Integrator.

Tip: Make sure that you select the driver path in the Database driver field
before you click Test.
The Installation Manager must successfully validate the connection to the
database before you can continue with the installation. If there is a
validation failure, you can view the system log to determine more
information about the failure. Perform the following tasks:
1) Open the user's application directory: local_path/IBM/Installation

Manager/logs

2) Open theindex.xml file in a browser.
3) Identify the log file that is based on the time stamp of when you

started the installation.
4) Click the installation file to view a listing of errors that occurred

during that installation.
24. Determine which of the following options apply to this installation. Select the

applicable options and click Next:
v Verbose install?

v This installation is an upgrade from a prior version

Do not select this option because this installation is a new installation.
25. Determine what performance configurations apply to this installation and

click Next. Accept the default value or type the appropriate value.
v Number of Processor Cores

v Physical Memory (MB) allocated to Sterling B2B Integrator

26. Review the installation package summary information. Click Install to apply
your installation settings to the installation.
If you did not select the option to automatically apply the database schema,
the installation stops and you must perform these additional steps to complete
the installation with manual DDL statements:
a. Open the installation directory.
b. Locate the InstallSI.log file and open it with a file editor.
c. Search the file for these error messages:
v <SI_Install>/repository/scripts/EFrame_IndexAdds.sql must be

applied to the database.

v <SI_Install>//repository/scripts/EFrame_Sequence.sql must be
applied to the database.

v <SI_Install>//repository/scripts/EFrame_TableChanges.sql must be
applied to the database. Exiting installation..."

Important: If you do not find these error messages in the log file, the
installation failed because of another reason and you must resolve that
error and attempt the installation again. If you find these messages,
continue with the remaining steps.

d. Edit each .sql script for the database. These changes might include
changing the SQL delimiter or adding table space options.
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e. Log in to the database as the database schema user.
f. Run the following SQL files manually in this order:

Important: When you are running the scripts, you must run the SQL
scripts in the specified order.
v EFrame_IndexDrops.sql

v EFrame_TableChanges.sql

v EFrame_IndexAdds.sql

v EFrame_TextIndexAdds.sql

v EFrame_Sequence.sql

v EFrame_TextIndexModify.sql

v EFrame_TextIndexUpdates.sql

v EFrame_TextIndexUpgrade.sql

v EFrame_Static.sql

Important: ActiveMQ uses dynamically generated table names that are
based on the name of the installation node. Table generation is not
included in these SQL scripts, but is performed automatically during the
initial start of Sterling B2B Integrator or when a new cluster node is added.
Table generation might fail if security restrictions reduced the Sterling B2B
Integrator database user permissions. To avoid this issue, ensure that the
DBADM role permissions are enabled during the initial startup. If further
issues arise, contact IBM customer support for guidance.

g. Exit from the database.
h. Open the parent directory of the Sterling B2B Integrator installation

directory.
i. Uninstall the Sterling B2B Integrator offering to clear out the Installation

Manager metadata about the installation, and the delete (or rename as a
backup) the Sterling B2B Integrator installation directory.

j. Restart the installation wizard and provide the same installation options
that you provided before you cleared the Apply database schema
automatically check box. If you have recorded a response file (as suggested
in step 9), you can use the response file to install Sterling B2B Integrator.

The Installation Progress screen indicates which component of the installation
is in process.
A status bar below the Repository Information heading displays the progress
of the component installation. When the installation completes, a large green
circle with a check mark displays with the message The packages are
installed. A link is provided to view the installation log file.

27. Click Finish. The Installation Manager closes and you are returned to your
desktop.
Check the InstallSI.log file to verify that all of the components were
installed properly.

28. If you are using the AIX operating system and are using IPv6:
a. Open the /install_dir/install/properties directory.
b. Add the following value to the sandbox.config file: IPV4STACK=false
c. Open the /install_dir/install/bin directory.
d. Enter the ./setupfiles.sh command.

29. Install each subsequent node, from node 2 on. Open your working directory.
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30. Start the Installation Manager for each additional node and follow most of the
same steps as you did for node 1. When prompted, select the This
installation is for a cluster node 2 or higher check box.

31. If you installed multiple nodes on the same server or used different base ports
for node 2 onward, you need to complete the following steps:

Step Action Your Notes

1 Open the /install_dir/install/properties
directory for node 1.

2 In thenoapp.properies_platform_ifcresources_ext
file, record the value for the multicastBasePort
property.

3 In the jgroup_cluster.properties file, record the
values for the mcast_port parameters of the
property_string and lock.protocolStack
properties.

4 For each subsequent node, you need to perform the
remaining steps.

5 Open the /install_dir/install/properties
directory for each node (node 2 and higher).

6 In the
noapp.properies_platform_ifcresources_ext.in
file, update the value of the multicastBasePort
property to match the value for node 1.

For example, replace the string
&MULTICAST_NODE_PORT1; with the port number
45460.

v (before) multicastBasePort=
&MULTICAST_NODE_PORT1;

v (after) multicastBasePort=45460

7 In the jgroups_cluster.properties.in file, update
all occurrences of the mcast_port property to match
the values for node 1.

8 After you update the attributes for all of the nodes,
enter the following command for node 2 and
higher:

/install_dir/install/bin/setupfiles.sh

32. Determine whether you need to apply a fix pack or interim fix to the
installation. For information about fix pack or interim fix installation, see
“Applying a Fix Pack (V5.2.6 or later)” on page 625 and “Applying an interim
fix (V5.2.6 or later)” on page 635.

Validating the Installation
After installing Sterling B2B Integrator, you should validate the installation to
ensure that everything is working according to your needs.

Validation of the installation checklist in a cluster environment:

As part of the installation, you need to run several tests to ensure that the software
installation was successful.
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# Validate Installation Task Completed

1 Configure the Nodes in the Cluster.

2 Verify the Cluster Environment Settings in Property Files.

3 Start the Cluster.

4 Access Sterling B2B Integrator.

5 Validate the Installation (Sample Business Process).

6 Verify the Cluster is Running from the User Interface.

7 Stop a Node (Hard Stop or Soft Stop) or Stop the Cluster.

Verifying the cluster environment settings in the properties files:

Procedure

To verify the cluster environment is correct, check these properties file settings on
node 2:
1. Verify that the value CLUSTER=true is in the sandbox.cfg property file.
2. Verify that the value CLUSTER=true is in the centralops.properties property

file.
3. Verify that the value CLUSTER=true is in the noapp.properties property file.
4. Verify that the value cluster_env property=true is in the ui.properties

property file.

Configuring the nodes in the cluster:

The first time that you configure a cluster, you need to use the startCluster
command with true option (startCluster.sh nodeNumber true).

About this task

Initial configuration is the only time that you need to use the startcluster
command. However, if you need to use the startcluster command again, use the
false option (startCluster.sh nodeNumber false). The false option prevents any
configuration changes from affecting the system, especially after the installation of
a fix pack or interim fix.

Important: You must run the startCluster command after installing the first node
(node 1) on the host where you have installed the node. After you run the
startCluster command for the first node, the subsequent nodes are automatically
clustered by the installer when they are installed.

Procedure

To configure the nodes, starting with node 1:
1. Open the /install_dir/install/bin directory.
2. Enter ./startCluster.sh nodeNumber <true or false>. Where nodeNumber is

the number of the node, the true option performs database updates and the
false option prevents database updates. For node 1, enter ./startCluster.sh 1
true, and so on.

3. If you are starting node 2 or higher, enter your passphrase. For node 1, you are
not prompted to enter your passphrase.

4. After the cluster starts, the following message is displayed:
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BUILD SUCCESSFUL
Total time nn minutes nn seconds
Done with ant script
Running setup files

You can proceed to the next node after the command line appears.

What to do next

After all the nodes are configured, the following message is displayed:
Deployment to application server successful.

Starting Sterling B2B Integrator in a UNIX/Linux cluster environment:

After you run the upgrade software, you can start Sterling B2B Integrator.

Before you begin

If you are starting Sterling B2B Integrator after you upgraded the application from
V5.1, change the values of the following properties in the centralops.properties
file to 600. This action prevents the run.sh command from timing out before
Sterling B2B Integrator starts. The centralops.properties file is in the
install_dir/install/properties directory.
v OpsServer.commandTimeout

v PassPhrase.urlTimeout

About this task

Perform this task for each node in the cluster, starting with node 1.

Procedure

1. Open the /install_dir/install/bin directory on a command line.
2. Enter ./run.sh.
3. Enter your passphrase.
4. After the final start processes run, the following message is displayed:

Open your Web browser to http://host:port/dashboard

The host:port variable is the IP address and port number where Sterling B2B
Integrator is installed on your system.
Depending on system load, it might take several minutes for the UI to be ready.

5. Record the URL address so that you can access Sterling B2B Integrator.

What to do next

If you need to release all the locks in a cluster and both nodes are down, use the
restart parameter for node 1. The restart parameter can be used on only node 1.
It cannot be used on any other nodes.

For example:
v For node 1, enter the following command:

./run.sh restart

v For nodes 2 and higher, enter the following command:
./run.sh
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Accessing Sterling B2B Integrator:

You can access Sterling B2B Integrator through a web browser.

Procedure

1. Open a browser window and enter the address that is displayed at the end of
the start.

2. On the login page, enter the default user ID and password. The default login is
at an administrative level. One of your first tasks as an administrator is to
change the administrative password and to register other users with other
levels of permission.

Validating the installation with a sample business process:

You can validate the installation by testing a sample business process.

Procedure

1. From the Administration Menu, click Business Process > Manager.
2. In the Process Name field, type Validation_Sample_BPML and click Go!

3. Click execution manager.
4. Click execute.
5. Click Go! The Status: Success message is displayed on the upper left side of

the page.

Verifying from the user interface that the cluster is running:

You can use the user interface to verify that the cluster is running, including queue
information and adapter status.

Procedure

1. From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the Queue information for each node.

2. From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the JNDI Tree for each node.

3. From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the host, state, status, adapters, and memory usage
information for each node.

4. From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the adapter status for each node.

Stop a Node in a Cluster Environment (Soft Stop):
About this task

A soft stop halts the system after all the business processes finish running. In a
cluster environment, you need to perform this task on each node, starting with
node 1.

Running the soft stop command in a clustered environment suspends all of the
scheduled business processes. It is recommended to run the hard stop command
when stopping individual nodes of a cluster.

To soft stop in a UNIX or Linux environment:
v You can select Operations > System > Troubleshooter and click Soft Stop.
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v You can perform the soft stop from the command line interface.

For more information about the softstop user interface and command line options,
refer to the performance management documentation.

To run a soft stop, from the command line:

Procedure

1. Navigate to /install_dir/install/bin.
2. Enter ./softstop.sh.
3. Enter your passphrase.

Stopping a node in a cluster environment with a hard stop:

A hard stop halts the system immediately, including all of the business processes
that are currently running.

About this task

You can stop a single node Sterling B2B Integrator in an UNIX or Linux cluster
environment.

To run a hard stop on the entire cluster, you must perform this task for each node.

Procedure

1. Open the /install_dir/install/bin directory on a command line.
2. Enter ./hardstop.sh.

Stopping the cluster:

You can use the UI to stop a cluster installation.

Procedure

1. From the Administration Menu, click Operations > System >
Troubleshooting.

2. Click Stop the System.

Post-Installation Configuration
After installing Sterling B2B Integrator and validating the installation, you may
need to do additional configuration depending on your system and business needs.

Postinstallation configuration checklist for cluster environment:

After you have install Sterling B2B Integrator, you need to complete the
postinstallation configuration checklist.

Review all of the tasks, but note that some tasks might not be required for your
system installation.
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# Postinstallation Configuration Checklist Your Notes

1 Upon installation, several default user accounts
are automatically created to get you started. For
security purposes, the system administrator
should update all default user account passwords
immediately after installation is completed. See
“Changing default user account passwords” on
page 40.

2 “JMS Cluster Configuration for Failover” on page
41

3 Configure ActiveMQ for a cluster environment.

4 If you are using an IPv6 address in a dual stack
configuration, complete the Add the IPv6 Address
for the Dual Stack Configuration task.

5 Download Sterling B2B Integrator Tools.

6 Determine whether you need to modify any
property files.

7 Configure Shared File System as Document
Storage.

8 Add host[port] from all the nodes to the
jgroups_cluster.property.in for each node.

9 If you are using an IPv6 address, you need to
complete the Update the sandbox.cfg File for IPv6
Address task.

10 “Manage Nodes in a Cluster” on page 45

11 “Services and Adapters Associated with Node 1 in
a Cluster” on page 46

12 Configure Customer Overrides File with a
Firewall between Nodes.

13 “Configure a Non-English Environment” on page
47

14 “Configure Browser Settings for a Different
Language” on page 50

Changing default user account passwords:

When you install Sterling B2B Integrator, several default user accounts are
automatically created to get you started. One of the first actions you must take
after installation is to update these accounts with unique passwords, because the
default ones can be known by all Sterling B2B Integrator customers.

About this task

Default user account passwords are preset at installation. For security purposes,
the system administrator should update all default user account passwords
immediately after installation is completed.

Default user accounts are listed below in the same order as they appear in the UI
under Accounts > User Accounts > List All. You can use this table to track the
user accounts you want to update.
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User Account Name Update password

MBX_daemon

admin (*)

aft_user (*)

anon

as2_user

commandlineuser

dash_oper (*)

dash_part (*)

dash_prtspon (*)

dash_sponsor (*)

fg_architect

fg_operator

fg_provisioner

fg_sysadmin (*)

gmbx_user

ja_turbine

jane

jane_doe

joe_employee

joe_manager

joe_supplier

john

sd_buyer

sd_supplier

turbine

ws_buyer

ws_director

ws_employee

ws_finance

ws_hr

ws_manager

ws_purchaser

ws_supplier

(*) denotes a super user

To change the password for a user account, perform the following tasks.

Procedure

1. Log into Sterling B2B Integrator using ID = admin and password = password.
2. Go to Accounts > User Accounts. Under the List section click Go! All default

user account names are listed.
3. Click Edit next to the user account name you want to update the password for.
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4. In the New Password and Confirm New Password fields, enter a new, secure
password for this User ID.

Note: Passwords must be at least six characters long.
5. Click Save and Finish.

What to do next

Repeat steps 3 - 5 for all user account names you want to update.

JMS Cluster Configuration for Failover: To allow proper JMS execution and
failover in the Sterling B2B Integrator cluster environment, you must configure an
external ActiveMQ using the Configure ActiveMQ for a Cluster Environment task.

The following diagram illustrates how the ActiveMQ can be configured to increase
availability and failover.

Configure ActiveMQ for a Cluster Environment:
About this task

To configure the ActiveMQ for the cluster environment:
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Procedure

1. Download the ActiveMQ 5.2 from http://activemq.apache.org/activemq-520-
release.html for the appropriate OS.

2. Deploy an instance of ActiveMQ 5.2. This can be on the same machine as
Sterling B2B Integrator or on a separate machine.

3. Navigate to /install_dir/install/properties.
4. Copy the activemq.xml file to the AMQ conf directory. This file configures the

ActiveMQ to:
v Use failover clustering
v Use the SI database for storage
v Configures the AMQ port usage

By default, ActiveMQ is configured to listen at the Sterling B2B Integrator base
port + 64 and the ActiveMQ interface will be at base port + 65
(http://server:base port + 66/admin). The port can be changed by editing the
config file. The port number must be higher than 1024.

5. Navigate to /install_dir/install/properties.
6. On each Sterling B2B Integrator application node and each Sterling B2B

Integrator container node, the queue configuration must be re-directed to utilize
the ActiveMQ cluster. In each node, add the following to the
customer_overrides.properties:
For FIFO Processing:
fifo.broker.username=
fifo.broker.password=
fifo.broker.url=failover:(tcp://amq_master_hostname:amq_master_port,
tcp://amq_slave_hostname:amq_slave_port)

For adapters running in separate JVM containers:
iwfcqueue.username=
iwfcqueue.password=
iwfcqueue.protocol_config=failover:(tcp://amq_master_hostname:amq_master_port,
tcp://amq_slave_hostname:amq_slave_port)

7. Start the ActiveMQ instances. To start ActiveMQ, it is necessary to supply the
activemq.hostname property with the hostname for the current system. For
example:
activemq -Dactivemq.hostname=ExampleHostname

See http://activemq.org for additional information about running an ActiveMQ
instance.

8. Start Sterling B2B Integrator.

Add the IPv6 Address for Dual Stack Configuration:
About this task

If you are using IPv6 and have Sterling B2B Integrator configured in a dual stack,
you need to add the IPv6 address to the admin host list.

To add the IPv6 address:

Procedure

1. Navigate to the installation directory that contains the noapp.properties file.
2. Open the noapp.properties_platform_ifcresources_ext .in file.
3. Add following line to the properties file:

admin_host.3=FULL_IPv6_ADDRESS
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Where FULL_IPv6_ADDRESS is the IPv6 address of the machine. (Make sure
you surround the IPv6 address with square brackets.)

4. Save and close the file.
5. Run the setupfiles.sh.
6. Start Sterling B2B Integrator.

Download of the Sterling B2B Integrator tools:

After you install Sterling B2B Integrator, you can install tools like the Map Editor
and the Graphical Process Modeler (GPM).

Sterling B2B Integrator includes tools that run on a desktop or personal computer.
After you install Sterling B2B Integrator, you can install the following tools:
v Map Editor and associated standards

Note: The Map Editor requires a 32-bit JDK. This JDK is not provided with the
product download or media. For more information, see System Requirements.

v Graphical Process Modeler (GPM)
v Web Template Designer
v (If licensed) MESA Developer Studio plug-ins, including MESA Developer

Studio Software Development Kit (SDK) and MESA Developer Studio Skin
Editor

v (If licensed) Reporting Services, which require MESA Developer Studio if you
want to use the plug-ins to create fact models and custom reports

Attention: Conflicting IP addresses can cause problems when you download a
desktop tool.

Property files configuration in a UNIX environment: Property files contain
properties that control the operation of Sterling B2B Integrator. For example, the
REINIT_DB property in the sandbox.cfg file controls whether or not a database is
initialized when you install Sterling B2B Integrator.

By modifying the values of these properties, you can customize Sterling B2B
Integrator to suit your business and technical needs. Most property files are in the:
v For UNIX, /install_dir/install/properties directory
v For Windows, \install_dir\install\properties directory

After installing Sterling B2B Integrator, most property files and scripts do not need
any further configuration for basic operation. However, if you want to customize
any specific operations, for example setting a different logging level - you will
need to edit ( or in some cases, create) certain property or .xml files.

Before changing any property files, refer to Working with Property Files
documentation for general information about how to work with Property Files.

Areas where you might need to make specific property files changes after an
installation include:
v LDAP user authentication
v Prevention of cross-site script vulnerabilities
v Logging configuration
v Process-specific property file settings
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Configure Shared File Systems as Document Storage:
About this task

To configure the shared file systems as document storage:

Procedure

1. Navigate to /install_dir/install/properties.
2. Open the jdbc.properties.in file.
3. Update the value of the document_dir attribute to point to the shared files

system directory where you store documents.
4. Save and close the file.
5. Navigate to /install_dir/install/bin.
6. Enter ./setupfiles.sh.
7. Restart Sterling B2B Integrator.

Add host[port] From all the Nodes to the jgroups_cluster.property.in for Each
Node:
About this task

Complete this task for both vertical and horizontal clusters. You will need to
complete this task for each node, starting with node 1.

Before you begin, it is important to note that you should never override
mcast_addr in the jgroup_cluster.properties.

To add the host [port] to the jgroups_cluster.property.in file:

Procedure

1. Navigate to the properties file directory for the node.
2. Determine the initial_hosts port for each node:
v Navigate to the properties file directory for the node.
v Find the initial_hosts from the jgroups_cluster.property

(initial_hosts=host{port}).
v Record the value from the initial_hosts for each node.

3. Open the jgroups_cluster.property.in file.
4. Add the initial_hosts property to the file. For example, if node 1 is on host1

and node 2 is on host2. For node 1, you would add:
initial_hosts=host1[port1],host2[port2]

For node 2, you would add:
initial_hosts=host2[port2],host1[port1]

5. Save and close the file.

Update the sandbox.cfg file for an IPv6 address:
About this task

Before you begin, it is important to note that you should never override
mcast_addr in the jgroup_cluster.properties.

To update the sandbox.cfg file for an IPv6 address (complete this task for each
node in the cluster):
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Procedure

1. Navigate to the properties file directory for each node.
2. Open the sandbox.cfg file.
3. Add the following line to the file.

IPV4STACK=false

4. Save and close the file.
5. Navigate to the bin directory for your installation.
6. Enter setupfiles.sh (UNIX) or setupfiles.cmd (Windows).

Manage Nodes in a Cluster:
About this task

You can add or remove nodes in a cluster environment. The following
prerequisites should be considered before performing any modification in the
cluster environment:
v New nodes should have the same range of ports available as the current nodes.
v Sterling B2B Integrator license file should be updated to include the IP address

of the new nodes.
v Directory structure on the new nodes should match with the directory structure

of the existing nodes.
v Perimeter servers should be updated with the new IP addresses to ensure proper

configuration.
v Any adapters, services, or business processes assigned to or scheduled to run on

the node being removed should be assigned to run on other nodes.

Add a Node to the Cluster (UNIX or Linux):

You do not need to stop the cluster environment while adding a new node.

About this task

To add a node into the cluster:

Procedure

1. Install a new Sterling B2B Integrator node to be added into the cluster during
installation. Ensure that the new node being added is not a primary node.

2. Update the jgroups_cluster.properties file and the
jgroups_cluster.properties.in file with the new node details.

3. Configure the new node by running startcluster.cmd nodeNumber from the
/<install_dir>/install/bin directory. The node number should be greater
than 1.
You should run startCluster.sh only after you install Sterling B2B Integrator.
You should not run startCluster.sh when you restart a Sterling B2B Integrator
instance.

4. Start the new node.

Remove a Node from the Cluster:
About this task

To remove a node from the cluster:
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Procedure

1. Reassign or stop any adapters, services, or business processes assigned to or
scheduled to run on the node being removed.

2. Perform backup of the node being removed.
3. Edit the jgroups_cluster.properties file and the

jgroups_cluster.properties.in file in all nodes to remove the IP address of
the node being removed.

4. Restart the cluster environment.

Important: Start node 1 with the restart option to update the node
information.

Services and Adapters Associated with Node 1 in a Cluster: The following
services and adapters are associated with node 1 in the cluster:
v File System adapter
v Command Line 2 Adapter
v Connect::Direct Server Adapter
v Connect::Direct Requester Adapter
v Connect:Enterprise for UNIX Server Adapter
v HTTP Server adapter
v HTTP Client adapter
v FTP Client adapter
v FTP Server adapter
v SFTP Client adapter

The following services and adapters have storage set to database:
v HTTP Server adapter
v Connect:Enterprise for UNIX Extract Service
v Connect::Direct Server Adapter

The default storage for all of the workflows is set to database.

Configure Customer Overrides File with a Firewall between Nodes:
About this task

If you have configured a firewall between nodes that blocks ports outside of the
port range assigned to Sterling B2B Integrator, perform the following task on all
nodes:

Procedure

1. Navigate to the Sterling B2B Integrator installation directory.
2. Navigate to the properties directory and locate (or create, if necessary) the

customer_overrides.properties file.
3. Open the customer_overrides.properties file using a text editor.
4. Add the following properties:

noapp.jnp_host= <host_name>
noapp.jnprmiport=<port_number_1>
noapp.jnprmiport2=<port_number_2>
noapp.useSocketFactories=true
noapp.jndirmiport=<port_number_3>
ops.jnp_host= <host_name>
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ops.jnprmiport=<port_number_1>
ops.useSocketFactories=true
ops.jndirmiport=<port_number_2>
ops.jnprmiport2=<port_number_3>

This increases the number of threads used by the system.
5. Save and close the customer_overrides.properties file.
6. Stop Sterling B2B Integrator and restart it to apply the changes.

Configure a Non-English Environment:

You can install Sterling B2B Integrator in an English or a non-English environment.
The base language for the Configurator can be switched only once.

Use the following checklist to change to a non-English environment:

# Non-English Environment Checklist Your Notes

1 Install the Sterling B2B Integrator Language Pack.

2 Load the Sterling B2B Integrator Language Pack
Factory Defaults.

3 Load the Sterling B2B Integrator Language Pack
translators.

4 Configure Encodings.

5 Configure Locales.

Language Settings: Language settings for Java applications involve both character
sets and encoding:
v A character set is a set of characters (letters, numbers, and symbols such as #, $,

and &) that are recognized by computer hardware and software.
v An encoding is a representation of data in a particular character set. An

encoding set is a group of encodings.

For information about basic and extended encoding sets, see http://
download.oracle.com/javase/1.5.0/docs/guide/intl/encoding.doc.html.

The default encoding set includes:
v UTF-8 (default)
v IS0-8859-1
v ISO-8859-5
v US-ASCII
v ISO_8859-1
v EUC-JP
v UTF-16
v ISO-2022-JP

Sterling B2B Integrator provides two property files that contain supported
encoding sets. These properties files reside in the /install_dir/install/properties
directory.
v encodings.properties – Contains the default encoding set used in the user

interface.
v encodings_large.properties – Contains all supported encoding sets.

Installing and upgrading (V5.2.6 or later) 187

http://download.oracle.com/javase/1.5.0/docs/guide/intl/encoding.doc.html
http://download.oracle.com/javase/1.5.0/docs/guide/intl/encoding.doc.html


You are not limited to the encodings in the encoding.properties file. Sterling B2B
Integrator enables you to configure the encodings properties files to expand the
number of encodings you can use.

Install the Language Pack:
About this task

Before installing the language pack be sure that you have successfully installed
Sterling B2B Integrator.

To install the Sterling B2B Integrator language pack:

Procedure

1. Insert the language CDs into your CD-ROM drive.
2. Navigate to the directory that is appropriate for your operating system.
v If you are using AIX, open the AIX directory.
v If you are using HP-UX, open the HP directory.
v If you are using Solaris, open the Sun directory.
v If you are using Red Hat Linux, open the Linux directory.
v If you are using SUSE Linux, open the Linux directory.

3. Enter ./setup.bin.

Load the Language Pack Translations:
About this task

Prior to loading the Sterling B2B Integrator Language Pack factory defaults, be sure
that you have successfully completed all instructions in the database chapter.

To load the language pack translation with custom localization literals:

Procedure

1. Run the LocalizedStringReconciler tool in the IMPORT mode from the
/install_dir/install/bin directory. Enter: ./ant.sh -f
localizedstringreconciler.xml import -Dsrc=/install_dir/database/
FactorySetup/XMLS This tool first inserts the value specified in the
<from_language>_<from_country>_ycplocalizedstrings_<to_language>
_<to_country>.properties file present in the /install_dir/database/FactorySetup/
XMLS/<language>_<country> directory into the database.
The basefilename refers to the file present in the /database/FactorySetup/XMLS
directory, for which the translations are to be imported into the database.

2. Verify that your locale settings such as currency, time format, and date are
correct.

Configure Encodings:
About this task

To configure your encoding set:

Procedure

1. Stop Sterling B2B Integrator and wait for shutdown to complete.
2. Navigate to /install_dir/install/properties.
3. Open the encodings_large.properties file.
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4. Select the encodings you want to add to the encodings.properties file.
5. Open the encodings.properties.in file.
6. At the end of the encodings.properties.in file, add the encodings you selected

from the encodings_large.properties file. When adding encodings from one file
to the other, first copy the encodings as they appear in the
encodings_large.properties file. After adding the new encodings, ensure that
the index numbers are consecutive. If the index numbers are not consecutive,
change the index number or numbers as needed. For example, encoding54
cannot follow encoding6. In this example, change encoding54 to encoding7.
The first name in the definition (before the comma) is the name that will
appear in the Sterling B2B Integrator user interface. You can change this name
to make it more descriptive. For example: encoding4 = 819,ISO8859_1 may be
changed to encoding4 = WesternEurope,ISO8859_1. ISO8859_1 is the Java
canonical name and should not be changed.

7. Update the first line in the encodings.properties.in file (numberof). Change
numberof to the number of encodings added to the file. For example, if the
current value is numberof = 6 and you add 5 new encodings, the new value is
numberof = 11.
numberof indicates the total number of encodings located in the file. You must
update numberof to ensure that the encodings you added will be visible in the
user interface.

8. Navigate to /install_dir/install/bin.
9. Enter ./setupfiles.sh.

10. Start Sterling B2B Integrator.

Configure Locale:
About this task

Sterling B2B Integrator runs in any locale that Java supports. If you want to run
the in a non-default locale, then configure your environment to the specific locale
you want to use.

To configure locale (default is English):

Procedure

1. Enter local-a. A list of locales is displayed.
2. Enter export LANG <locale>. Where <locale> is the language, for example to set

the locale to Japanese, locale = ja_JP.
3. Enter export LC_ALL <locale>. Some UNIX shells require the setenv command

instead of the export command.

Configure Browser Settings for a Different Language:

Some browsers and operating systems require additional configuration in order to
correctly render the Sterling B2B Integrator user interface in certain languages.

Use the procedures provided in this section to properly configure a browser to
display the Sterling B2B Integrator user interface in the appropriate language.

Tip: If your browser is unable to display the user interface properly or you see a
mixture of English and another language, this is an indication that the browser is
configured incorrectly. You may also need to install additional fonts on the Sterling
B2B Integrator server.
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Support for other languages:

The Sterling B2B Integrator user interface includes support for several languages.

Attention: Sterling B2B Integrator product code is designed to work with Latin
based English only input. The use of any other type of input might have uncertain
results and is not supported.

The Sterling B2B Integrator user interface includes support for the following
languages:
v French
v German
v Italian
v Japanese
v Korean
v Polish
v Portuguese (Brazilian)
v Simplified Chinese
v Traditional Chinese
v Dutch

Four of these languages involve expanded Unicode character sets:
v Japanese
v Korean
v Simplified Chinese
v Traditional Chinese

The implementation of these languages in your environment might require the
addition of new Unicode fonts on your server:

If... then...

Sterling B2B Integrator is on a server that
already supports these languages

You do not need to install any additional
fonts.

You are installing on a server that is only
setup for the Latin alphabet and you have
users who need to view the Sterling B2B
Integrator user interface in any of the Asian
languages

You need to have the fonts for these
languages installed.

A way to test the implementation of a language is to create a user with one of the
new languages and setup their browser to use that language as it's primary
language. Log in to the system and review the user interface. If you see a mixture
of English and the new language, your configuration is not correct. You need to
verify that the browser is set up correctly and review the fonts that are installed on
the server.

The installation of more fonts/languages on the server should be done in
coordination with your technical support team. Be sure to include a Unicode Sans
Serif font on your server.

Important: While multiple languages are supported, a user account should be
configured to use one specific language to avoid user interface display issues.
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Add a Custom Language Preference Code:
About this task

In order for your browser to display the Sterling B2B Integrator user interface and
address bar text correctly in a foreign language, you must specify the appropriate
language preference code for the browser.

Sterling B2B Integrator supports the following language preference codes:
v de
v en
v en-US
v es
v fr
v it
v ja
v ko
v pt-BR
v zh
v zh-TW
v du

Your browser must be configured to use one of these specific language preference
codes to view the Sterling B2B Integrator user interface.

Note: Most browsers provide a default listing of language preference codes.
However, Sterling B2B Integrator requires the use of the specific codes as listed
here. For example, you cannot use the default German (Germany) [de-DE], you
must use [de].

You may need to add these supported codes as a custom language preference code
in your browser.

Note: The instructions for configuring a browser’s display will differ for each
browser. Refer to your chosen browser’s documentation for specific instructions on
configuring that browser’s display.

The following is an example of how to configure a client machine display for an IE
window.

Procedure

1. Open a browser window.
2. Select Tools > Internet Options.
3. At the bottom of the window under Appearance, click Languages.
4. Click Add to display the Add Language window.
5. In the User defined: text box, enter the appropriate language preference code.
6. Click OK. The added code should display in the Language: listing in the

Language Preference window. An example entry would be, User Defined
[de].

7. (Optional) Move the added language up to be the first one listed if there are
multiple languages listed.
a. Select the newly added language.
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b. Click Move up.
The newly added language should now appear first in the Language
listing.

8. Click OK to save your Language Preference settings.
9. Click OK to close the Internet Options window.

10. Close your browser window.
11. Open a new browser window and access the Sterling B2B Integrator user

interface to verify your changes have been applied.

Change Default Browser Font:
About this task

Some languages require the use of special fonts to properly display the Sterling
B2B Integrator user interface. The client computer must be configured to display
these types of fonts. Each Windows client must be configured appropriately.

Note: The instructions for configuring a browser’s display will differ for each
browser. Refer to your chosen browser’s documentation for specific instructions on
configuring that browser’s display.

The following is an example of how to change the default browser font for an
Internet Explorer (IE) window.

To configure a client machines display for IE:

Procedure

1. Determine which fonts are needed to support your needed language and
verify they are installed on the server.

Note: The installation of additional fonts/languages on the server should be
done in coordination with your technical support team. Be sure to include a
Unicode Sans Serif font on your server.

2. Open an IE browser window.
3. Select Tools > Internet Options.
4. At the bottom of the window under Appearance, click Fonts.
5. From the Language Script drop-down menu, change the Latin based value to

the appropriate script for your needed language.

Note: If your encoding is not available, you may need to install a new
version of Internet Explorer, but make sure you install the appropriate
international options.

6. Select a Webpage font and a Plain text font appropriate for the new language.
A Plain text font is one in which all the characters take up the same amount
of space and is associated with older computer terminals.

Note: If no fonts are listed in the menus, then you need to install fonts
designed for that encoding.

7. Click OK to close the Fonts window.
8. Click OK again to close the Internet Options window.
9. Close your browser window.

10. Open a new browser window and access the Sterling B2B IntegratorSterling
B2B Integrator user interface to verify your changes have been applied.
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Set the Client Character Display:
About this task

To use special characters, such as for various languages, the client computer must
be configured to display these types of characters. In order for Unicode characters
to display correctly in the application, each Windows client must be configured
appropriately.

Note: The instructions for configuring a browser’s display will differ for each
browser. Refer to your chosen browser’s documentation for specific instructions on
configuring that browser’s display.

The following is an example of how to configure a client machine display for an
Internet Explorer (IE) window.

To configure a client machines display for IE:

Procedure

1. Open an IE browser window.
2. Select View > Encoding > Auto-Select.

Clearing Browser and Java Plugin Caches Before Initial Deployment:
About this task

Once the Sterling B2B Integrator is ready for deployment, each user must clear the
browser and Java Plugin caches on their client machines before launching Sterling
B2B Integrator. This requirement applies to all browsers.

To clear the browser and java caches, do the following:

Procedure

1. From the browser menu bar, select Settings > Control Panel > Internet
Options.

2. Select the General tab, and in the Temporary Internet Files panel, click Delete
Files. The Delete Files dialog displays.

3. Check the Delete All Offline Content checkbox. Click OK until the Internet
Properties window closes. The browser cache is cleared.

4. From the Windows start menu, select Settings > Control Panel > Java.
5. Select the General tab, and in the Temporary Internet Files panel, click Settings.

The Temporary Files Settings dialog displays.
6. In the Disk Space panel, click Delete Files. The Delete Temporary Files pop-up

window displays.
7. Click OK until the Java Control Panel window closes.

General Internet Explorer Browser Settings: When using Sterling B2B Integrator
without any customizations, you need to set the General Browser settings for your
Internet Explorer in order to obtain the best browser performance.

Note: This can impact the display of reports and search listings.

To set your general browser settings:
1. From the Internet Explorer menu, select Tools > Internet Options.

The Internet Options window opens to the General tab.
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2. Locate the Browsing history section and click Settings.
The Temporary Internet Files and History Settings window opens.

3. Below Check for newer versions of stored pages: select the Everytime I visit
the webpage option.

4. Click OK to save your changes.
5. Click OK to apply the changes.
6. Close the browser window and re-open it.

The browser is now set to check for updates to pages everytime a page is
accessed rather than relying upon a cached version.

Internet Explorer Security Settings:
About this task

When using Sterling B2B Integrator without any customizations, you need to set
security settings for your Internet Explorer to obtain the best browser performance.

To configure the Internet Explorer security and privacy settings:

Procedure

1. From the Internet Explorer menu, select Tools > Internet Options.
2. Click the Security tab.
3. Select the Web content zone from which Sterling B2B Integrator is accessed.
4. Set the security level to Medium-low.
5. Click Custom Level and set your security settings according to the following

table:

Internet Explorer Security Setting Sterling B2B Integrator

.NET Framework

Loose XAML Enable

XAML browser applications Enable

XPS documents Enable

.NET Framework-reliant Components

Permissions for components with manifests High Safety

Run components not signed with Authenticode Enable

Run components signed with Authenticode Enable

ActiveX Controls and Plugins

Allow previously unused ActiveX controls to run
without prompt

Enable

Allow Scriptlets Enable

Automatic prompting for ActiveX controls Enable

Binary and script behaviors Enabled

Display video and animation on a webpage that
does not use external media player

Disable

Download signed ActiveX controls Prompt

Download unsigned ActiveX controls Prompt

Initialize and script ActiveX controls not marked as
safe for scripting

Prompt
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Internet Explorer Security Setting Sterling B2B Integrator

Run ActiveX controls and plugins Prompt/Enable

Script ActiveX controls marked as safe for scripting Enable

Downloads

Automatic prompting for file downloads Enable

File download Enable

Font download Prompt

Enable .NET Framework setup Enable

Java VM

Java permissions Medium safety

Miscellaneous

Access data sources across domains Enable

Allow META REFRESH Enable

Allow scripting of Internet Explorer web browser
control

Enable

Allow script-initiated windows without size or
position constraints

Enable

Allow webpages to use restricted protocols for
active contents

Prompt

Allow websites to open windows without address
or status bars

Enable

Display mixed content Prompt

Do not prompt for client certificate selection when
no certificates or only one certificate exists

Enable

Drag and drop or copy and paste files Prompt

Include local directory path when uploading files
to a server

Enable

Installation of desktop items Prompt

Launching applications and unsafe files Prompt

Launching programs and files in an IFRAME Prompt

Navigate sub-frames across different domains Enable

Open files based on content, not file extension Enable

Software channel permissions Medium safety

Submit non-encrypted form data Prompt

Use Phishing Filter Disable

Use Pop-up Blocker Disable

Userdata persistence Enable

Websites in less privilged web content zone can
navigate into this zone

Prompt

Scripting

Active scripting Enable

Allow Programmatic clipboard access Prompt

Allow status bar updates via script Enable
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Internet Explorer Security Setting Sterling B2B Integrator

Allow websites to prompt for information using
scripted windows

Enable

Scripting of Java applets Enable

User Authentication

Logon Prompt for user name and password

6. Click OK to save your settings.
7. Click OK to save the new settings and Apply to implement the settings. The

new settings are applied when a new browser window is opened.

System Maintenance
From time to time, you might need to perform system maintenance activities.

These activities might include:
v Performing a Checksum
v Adding or removing a license

System Maintenance:

From time to time, you may need to perform system maintenance activities.

These activities might include any or all of the following:
v Performing a Checksum
v Adding or removing a license

DB Checksum Tool:

A checksum is a simple redundancy check used to detect errors in data. The DB
Checksum tool generates the difference in resource checksum between the default
resource and the latest system resource from the database.

In Sterling B2B Integrator, a verification process compares the checksum between
the existing default resource and the resource that was added after applying a fix
pack or upgrading. The DB Checksum tool, a resource difference tool generates a
granular report of the changes in the system that was not permitted to be set as
defaults.

Performing a checksum:

Use a command to run the DB Checksum tool.

Procedure

To run the DB Checksum tool:
1. Open the /install_dir/install/bin directory.
2. Enter the following command:

./db_checksum_tool.sh [-d] [-i [1 | 2 | 3 | 4 | 5]]
[-r [wfd | map | schema | sii | template]] [-o <output file>] [-g]

Where:
v -d is the mode to dump the difference of resource checksum between the

default resource and latest system resource.
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v -i is the resource type integer (optional).
v 1 is WFD.
v 2 is MAP.
v 3 is SCHEMA.
v 4 is SII.
v 5 is TEMPLATE.
v -r is the resource name (optional). For example, wfd, map, schema, sii, or

template.
v -o is the file name to output all the messages (optional).
v -g is the file name that lists all the ignored resources (optional).
v -h is the help screen.

The DB Checksum tool performs the relevant checksum operation that is based
on the command options and generates the output message.

License modifications:

After the installation finishes, you can modify the software licenses that you
loaded with the AddLicenseSet command.

The AddLicenseSet command is in the bin directory of your UNIX or Windows
installation. After the initial installation, the license files are in the following
directories:
v UNIX - /install_dir/install/properties/licensefiles
v Windows - \install_dir\install\properties\licensefiles
v iSeries - /install_dir/properties/licensefiles

You can add licenses or review the license list from the UI. On the Administration
Menu, click System > B2B Console > Operations > System > Licenses.

AddLicenseSet Command Parameters

Use the AddLicenseSet command to modify a single license file or the entire license
file directory.

To use the AddLicenseSet command, you must do the following:
v Open the bin directory
v Include the absolute path to the license file directory or to a license file

The AddLicenseSet command has the following parameters:

AddLicenseSet Parameter Description

-reload Use this parameter to reload the license files.

This parameter deletes all of the license files from the
database before the new files are loaded. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/
old_licenses

v Windows - \install_dir\install\logs\security\
old_licenses

v iSeries - /install_dir/logs/security/old_licenses
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AddLicenseSet Parameter Description

-upgrade Use this parameter during an upgrade only.

This parameter deletes all of the old license files from the
database and installs the new license files. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/upgrade

v Windows -\install_dir\install\logs\security\upgrade

v iSeries -/install_dir/logs/security/old_licenses

The AddLicenseSet command will check if Sterling B2B Integrator is running. If it
is running, the command will call the Ops server to refresh the license from the
database. If you have any problems with your licenses after running the
AddLicenseSet command, stop and restart Sterling B2B Integrator.

License Modification: Examples:

There are several different ways you can use the AddLicenseSet command to
modify your licenses.

UNIX Examples

From the install_dir/bin directory:

Scenario Command usage (UNIX example)

Reload a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -reload

Reload all of the license files
in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -reload

Upgrade a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -upgrade

Windows Examples

From the install_dir\bin directory:

Scenario Command usage (Windows example)

Reload a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -reload

Reload all of the license files
in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -reload

Upgrade a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -upgrade

Installing and Configuring Perimeter Servers
A perimeter server is an optional software tool for communications management.
A perimeter server can be installed in a demilitarized zone (DMZ). A DMZ is a
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computer host or small network inserted as a neutral zone between a company's
private network and their public network. A perimeter server requires a
corresponding perimeter client.

The perimeter server manages the communications flow between outer layers of
your network and the TCP-based transport adapters. A perimeter server can solve
problems with network congestion, security, and scalability, especially in
high-volume, Internet-gateway environments.

Installation Guidelines for Perimeter Servers with Sterling B2B Integrator: The
installation program installs a perimeter client and a local mode server. The local
mode server is useful for testing purposes or in environments that do not require a
secure solution. However, if you require high-volume, secure connections, you
must install a perimeter server in a remote zone, either a more secure or less
secure network than your integration server.

Consider the following before you install a perimeter server:
v Licensing for a perimeter server is determined by the licensing restrictions on

the corresponding B2B adapters.
v Each perimeter server is limited to two TCP/IP addresses:

– Internal interface is the TCP/IP address that the perimeter server uses to
communicate with Sterling B2B Integrator.

– External interface is the TCP/IP address that the perimeter server uses to
communicate with trading partners. To use additional TCP/IP addresses,
install additional perimeter servers.

v You can have multiple perimeter servers installed on the same computer
interacting with one instance of Sterling B2B Integrator. To install a perimeter
server on a computer with an existing instance, install the new perimeter server
in a different installation directory.

v The combination of internal TCP/IP address and port must be unique for all
perimeter servers installed on one computer.
– If a perimeter server is installed using the wildcard address, then all ports

must be unique. The assigned ports are not available for use by adapters that
use the server or any other perimeter server on that computer.

– The internal and external interface may use the same TCP/IP address.
However, the port used by the perimeter server is not available to the
adapters that use the server.

Perimeter Server Installation Methods: You can install perimeter server either in
silent mode or in interactive mode. The default installation mode is silent. In the
silent mode, you should specify the details in a silent file, whereas in the
interactive mode, you should enter the value each time a prompt appears.

Perimeter Server Information Gathering Checklist: Before you install the
perimeter server, you need to gather the following information and answer the
following questions:

Perimeter Server Information Gathering
Checklist Your Notes

Path to java

Path to the Sterling B2B Integrator
installation directory
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Perimeter Server Information Gathering
Checklist Your Notes

Will this perimeter server be installed in a
less secure network?

TCP/IP address or the DNS address that the
perimeter server will listen on.

Listening port for the perimeter server.

Local port that the perimeter server will use
to connect to Sterling B2B Integrator.

Port number must be higher than 1024.

Perimeter Server Security Vulnerabilities: When Sterling B2B Integrator is
deployed with a remote perimeter server in a more secure network zone, there is a
security vulnerability. An intruder may compromise the host where the proxy
resides, and take over the persistent connection to the perimeter server residing in
the more secure zone. If this happens, the perimeter server will relay all the
intruder's network requests past the firewall into this internal zone.

To prevent an intrusion, limit the activities the remote perimeter server can
perform on behalf of the proxy to specifically those activities that the proxy needs
to do for its operation.

Control these limitations by using a configuration residing in the secure network
zone with the remote perimeter server, inaccessible by the proxy that could become
compromised.

Installing a perimeter server in a more secure network in a UNIX or Linux
environment:

Install a perimeter server in a more secure network in a UNIX or Linux
environment in interactive mode

Before you begin

v Sterling B2B Integrator must be installed.
v Complete the Perimeter Server information gathering checklist.

Procedure

1. Enter: /path_to_java/java -jar /install_dir/install/packages/
ps_filename.jar –interactive

The installation program verifies the operating system, minimum fix pack
level, and the location and version of the JDK.

2. Enter the full path name for the Sterling B2B Integrator installation directory
and press Enter.
If there is an existing installation in the directory you specify, you can update
it using the same settings. Enter yes, and installation proceeds without more
entries.

3. Enter yes to confirm that the installation directory is correct.
The program verifies the amount of available disk space.

4. Is this server in a less secure network than the integration server, enter no.
This installation is for a more secure network.
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5. Answer the question: Will this perimeter server need to operate on
specific network interface?

v Enter yes to select from a list network interfaces available.
v Enter no.

6. Enter the TCP/IP address or DNS name that the integration server listens on
for the connection from this perimeter server.

7. Enter yes to confirm the TCP/IP address or DNS name.
8. Enter the port that the integration server listens on for the connection from

this server. The port number must be higher than 1024.
9. Enter the local port number that the perimeter server uses for the connection

to the integration server.
The port number must be higher than 1024. Specify a port number of zero for
the operating system to select any unused port.

10. Enter yes to confirm the port number.
After the installation is complete, the following messages are displayed:
Installation of Perimeter Service is finished

To start this Perimeter Server change to the install directory and run
the startup script.

You will also need to configure this server in your integration server
(SI) UI.

Installing a perimeter server in a less secure network in a UNIX or Linux
environment:

Install a perimeter server in a UNIX or Linux environment in interactive mode.

Procedure

1. Copy the .jar installation files from the installation media to a UNIX/Linux
directory. If you are using FTP to copy the file, make sure that your session is
set to binary mode.

2. Enter: /path_to_java/java -jar /install_dir/install/packages/
ps_filename.jar –interactive

The program verifies the operating system, minimum fix pack level, and the
location and version of the JDK.

3. Enter the full path name of the installation directory.
4. If there is an existing installation in the directory you specify, you can update

it using the same settings. Answer the question:
There is an existing install at that location, update it while keeping
existing settings?

If yes, the installation proceeds without more entries.

Note: If you want to change any of the settings, you must use a new
directory, or delete the old installation before you reinstall the perimeter
server. You cannot overwrite an existing installation, and you cannot use an
existing directory that does not contain a valid installation.

5. Confirm that the installation directory is correct.
The program verifies the amount of available disk space.

6. Answer the question:
Is this server in a less secure network than the integration server?

Yes
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7. Answer the question:
Will this server need to operate on specific network interfaces?

If yes, the program returns a list of the network interfaces available on your
host. Select the interfaces for the server to use.

8. Enter the TCP/IP address or DNS name for the internal interface to use to
communicate with the integration server (Sterling B2B Integrator). Press Enter
to use a wildcard for this address.

9. Verify the TCP/IP address or DNS name for the internal interface.
10. Enter the TCP/IP address or DNS name for the external interface to use to

communicate with trading partners. Press Enter to use a wildcard for this
address.

11. Verify the TCP/IP address or DNS name for the external interface.
12. Enter the port that the perimeter server listens on for the connection from the

integration server (Sterling B2B Integrator). The port number must be higher
than 1024.

13. Verify the port.
When the perimeter server is installed, the following message is displayed:
Installation of Perimeter Service is finished

14. Change to the installation directory.
15. Enter ./startupPs.sh to start the perimeter server.

Silent Installation Method for an External Perimeter Server: You can install an
external perimeter server using a silent install file. The perimeter server can be
installed on the same machine where you have installed Sterling B2B Integrator or
on a separate machine. It is recommended to install the perimeter server on an
separate machine.

To use the silent installation method, you first create the silent install file and then
you use to complete the installation.

Create the Silent Installation File for an External Perimeter Server:
About this task

Create a silent installation file with the following variables:

Entry Description

INSTALL_DIR (Required) The installation directory that stores perimeter server
files and related directories. This directory must exist prior to
running the silent install.

REVERSE_CONNECT (Optional) Determines if the perimeter server is to be installed in a
more secure network zone. Valid values:

v Y - more secure network zone

v N - less secure network zone

PS_PORT (Required) Determines the perimeter server port to interact with
the system.

PS_SECURE_IF (Required) Determines the TCP/IP address or DNS name for the
internal interface to communicate with the integration server
(Sterling B2B Integrator). You can use a wildcard (*) for this
address.

PS_EXTERNAL_IF (Required) Determines the TCP/IP address or DNS name for the
external interface to communicate with the trading partners. You
can use a wildcard (*) for this address.
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Entry Description

REMOTE_ADDR (Optional) Determines the remote perimeter server address.

(Not required if REVERSE_CONNECT=N)

REMOTE_PORT (Optional) Determines the remote perimeter server port.

(Not required if REVERSE_CONNECT=N)

MAX_JVM_HEAP (Required) Determines the maximum Java heap size allocated to
the JVM.

Installing an external perimeter server with a silent installation file:

Install an external perimeter server with a silent installation file.

About this task

Before you begin, create the silent installation file.

Procedure

1. From the installation media, copy SI.jar to a UNIX/Linux directory.
2. Set up your silent installation file and record its location.
3. Go to your working directory.
4. To start the installation, enter: /absolutePath/bin/java -jar

/install_dir/install/packages/ps_filename.jar -f silent.txt

The installation starts. You can follow the progress of the installation on screen.
The installation program verifies support for your operating system and JDK. It
also verifies that you have enough space for the installation.
When the installation is finished, the system displays the following message:
Installation has completed successfully.

5. Determine whether you must apply any fix packs to the installation. Refer to
Installation Maintenance to install the latest fix pack.

Install a Fix Pack in a Remote Perimeter Server UNIX or Linux Environment:
About this task

Remote perimeter servers are not automatically updated by a fix pack. You must
reinstall the perimeter server using the new perimeter server installation file
supplied with the fix pack.

To update a Remote Perimeter Server:

Procedure

1. Update your installation with the latest fix pack. Obtain the fix pack from the
Support Center web site.

2. Locate your perimeter server fix pack in the /install_dir/install/packages
directory of your installation. Download the file from the Support Center web
site. These files have a name that identifies a version number. For example,
ps_2006.jar.

3. Copy the file to a directory on the remote server.
4. Stop the perimeter server, enter ./stopPs.sh.
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5. To begin the installation, enter : /absolutePath/bin/java -jar filename.jar
-interactive

absolutePath is the directory name where the Java version is installed.
The program verifies the operating system, required patch level, and the
location and version of the JDK.

6. Enter the full path to the installation directory. If you do not want to change
any settings for your perimeter server, specify the same directory where the
remote perimeter server was originally installed.

7. Answer the question:
There is an existing install at that location, update it while keeping
existing settings?

If yes, the installation will proceed without additional entries.

Note: If you want to change any of the settings, you must use a new directory,
or delete the old installation before performing the new installation. You cannot
overwrite an existing installation, and you cannot use an existing directory that
does not contain a valid installation. The existing installation must be Sterling
B2B Integrator 5.0 or later.
When the perimeter server is installed, the following message is displayed:
Installation of Perimeter Service is finished

8. Change to the installation directory.
9. Enter ./startupPs.sh to start the perimeter server.

Grant Permissions for Specific Activities for a Perimeter Server:
About this task

Before you begin:
v Remote perimeter server must be installed for a more secure zone.
v Know what permissions you want to grant
v Understand the content of the restricted.policy file. The first two grant sections

in the restricted.policy file are required for correct perimeter server operation.
Do not modify these sections.

Procedure

1. Install a remote perimeter server, choosing the option for a more secure
network zone.

2. At the installation prompt Is this server in a less secure network than the integration
server?, select No, which is the option for a more secure network zone.

3. Navigate to the perimeter server installation directory.
4. Open the restricted.policy file.
5. Add permission lines for each back-end server that you intend to allow the

proxy to access. There are commented out examples for each type of server.
The first two grant sections are required for correct perimeter server operation.
Do not modify these sections.
For example, you can grant permission to a target FTP Server. In the example,
servers are configured to listen on the following ports: 33001 (for FTP), 33002
(for HTTP), and 1364 (for C:D). These port numbers can be edited.
// To restrict or permit the required Host/Server to communicate with the
PS, update the “ftphost/htttphost/snode” with that of the Server IP and
provide the appropriate PORT number where the Server will listen. //
// For each target FTP Server
// permission java.net.SocketPermission "10.117.15.87:33001", "connect"; //

204 Installing and upgrading (V5.2.6 or later):



Control connection.
// permission java.net.SocketPermission "10.117.15.87:lowPort-highPort",

"connect"; // Passive data connections.
// 10.117.15.87 indicates IP of the FTP Server for which the permission is

granted by PS for communicating with client //
// For each target HTTP Server
//
// permission java.net.SocketPermission "10.117.15.87:33002", "connect";
// 10.117.15.87 indicates IP of the HTTP Server for which the permission

is granted by PS for communicating with client //

// For each target C:D snode
//
// permission java.net.SocketPermission "snode:1364", "connect";
// 10.117.15.87 indicates IP of the Connect Direct Node for which

the permission is granted by PS for communication //

6. In the perimeter server installation directory, there is the perimeter server
settings file called remote_perimeter.properties. Edit it to change the "restricted"
setting to a value of true to turn on restrictions.

7. In the future, any attempt by the perimeter server to access disallowed network
resources will be rejected and logged in the perimeter server log written to the
perimeter server installation directory.

Perform DNS Lookup on Remote Perimeter Server:
About this task

By default, a perimeter server performs DNS lookup in the main server JVM. If
you have limited DNS in your secure area, you can configure the remote perimeter
server to look up trading partner addresses in the DMZ.

To enable DNS lookup, add the following property to
customer_overrides.properties. Set the value to true:

Property Name Description

perimeter.*.forceRemoteDNS=true Forces resolution of DNS names at remote
perimeter server.

Set the value to true to configure remote
perimeter servers to look up trading partner
addresses.

Start Perimeter Servers in UNIX or Linux:
About this task

To start a perimeter server in UNIX or Linux:

Procedure

1. Navigate to the perimeter server installation directory.
2. Enter ./startPSService.sh.

Stop Perimeter Servers in UNIX or Linux:
About this task

To stop a perimeter server in UNIX or Linux:
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Procedure

1. Navigate to the perimeter server installation directory.
2. Enter ./stopPSService.sh.

Using IBM Sterling Gentran:Server for UNIX with Sterling B2B
Integrator
Sterling B2B Integrator has the ability to access information located in Sterling
Gentran:Server® for UNIX. You can configure this immediately following the
installation or at a later date.

By configuring Sterling B2B Integrator to run with Sterling Gentran:Server for
UNIX, you can:
v View data from your Sterling Gentran:Server trading partners
v Start or stop Sterling Gentran:Server data managers
v View which data managers are running
v View, search, and track Sterling Gentran:Server Life Cycle event records

The following restrictions apply:
v You must have an UNIX or Linux environment
v You must be using one of the following Sterling Gentran:Server for UNIX

products:
– Sterling Gentran:Server for UNIX with Process Control Manager (PCM)
– Sterling Gentran:Server for UNIX with EC Workbench (ECW)
– Sterling Gentran:Server for UNIX with Advanced Data Distribution (ADD)

Install and Configure Attunity® Data Connect:
About this task

If you want Sterling B2B Integrator to use the trading partner information in your
Sterling Gentran:Server for UNIX, you must install and configure Attunity Data
Connect. The Attunity Data Connect software provides JDBC access to the Gentran
DISAM database fields where the trading partner information is stored.

To install and configure Attunity Data Connect:

Procedure

1. Install Attunity Data Connect 3.3 or later using the installation procedures
provided with the Attunity Data Connect software.

2. Ensure the Attunity Data Connect software runs as expected.
3. Create a new DISAM data source and refresh the Attunity Data Connect

server. See the Attunity Data Connect documentation for the procedure.
4. Locate the following metadata description files in the /install_dir/tp_import/

gentran/disam_mapping directory:

Find this file

Replace this string
$YOUR_DATASOURCE
with ..

Replace this string
$YOUR_GENTRAN with ..

TP_MAST.XML the name of the data source
for your Sterling
Gentran:Server for UNIX
system

the path to the root directory
of Sterling Gentran:Server for
UNIX
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Find this file

Replace this string
$YOUR_DATASOURCE
with ..

Replace this string
$YOUR_GENTRAN with ..

TRADACOM.XML the name of the data source
for your Sterling
Gentran:Server for UNIX
system

the path to the root directory
of Sterling Gentran:Server for
UNIX

ORGANIZATION.XML the name of the data source
for your Sterling
Gentran:Server for UNIX
system

the path to the root directory
of Sterling Gentran:Server for
UNIX

TP_MISC.XML the name of the data source
for your Sterling
Gentran:Server for UNIX
system

the path to the root directory
of Sterling Gentran:Server for
UNIX

5. Run the Attunity Data Connect Dictionary (ADD) Editor.
6. Select the DISAM data source you created in Step 3.
7. Import the metadata description files you updated in Step 4. See the Attunity

Data Connect documentation for the procedure.
8. Verify that the metadata description files are included in the list of tables.
9. Save your changes.

10. Exit the Attunity Data Connect Dictionary (ADD) Editor.

Configure Sterling B2B Integrator To Run with IBM Sterling Gentran:Server for
UNIX:
About this task

To configure Sterling B2B Integrator to run with Sterling Gentran:Server:

Procedure

1. Set the umask to 002 in Sterling B2B Integrator.
2. Is Sterling B2B Integrator installed on a different computer than Sterling

Gentran:Server?
v If No, then continue to Step 3.
v If Yes, then NFS mount the $EDI_ROOT of Sterling Gentran:Server onto the

Sterling B2B Integrator host. Continue to Step 3.
3. Verify that the remote shell (rsh or remsh) is working. If you are unable to use

the rsh/rmesh shell and can only use ssh shell, change the GS_RSHELL
variable located in sandbox.cfg file.

4. Navigate to /install_dir/bin.
5. Stop Sterling B2B Integrator, enter ./softstop.sh.

For more information about the softstop command line options, refer to the
performance management documentation.

Note: If you are in a clustered environment, softstop suspends all the
scheduled business processes. It is recommended to run a hardstop when
stopping individual nodes in a cluster.

6. Enter ./configGSUnix.sh. This command starts the configuration.
7. Press Enter to continue the configuration.

Installing and upgrading (V5.2.6 or later) 207



8. If you currently use Sterling Gentran:Server Life Cycle and want to configure
Tracking and Ops, then you need to enter the following the database
information:
v Database vendor
v Absolute path to the JDBC drivers
v Database user name
v Database password
v Database (catalog) name
v Database host name using either the IP address or name of the computer

where the data base is installed
v Database port number

9. Is Sterling Gentran:Server installed on the same computer as Sterling B2B
Integrator?
v If Yes, enter EDI_ROOT for the local computer and continue with next step.
v If No, enter the host name where Sterling Gentran:Server is installed, and

the EDI root where Sterling Gentran:ServerSterling Gentran:Server is
mounted. Verify the EDI root is installed.

10. Enter the version number for Sterling Gentran:Server.
v Enter 1 for version 5.3.
v Enter 2 for version 6.0.

11. If you want to configure Sterling B2B Integrator to view Trading Partner
Administration, then you need to enter the following Sterling Gentran:Server
database information:
v Absolute path to the JDBC drivers (for example, /attunity_install_dir/java
v Database user name
v Database password
v Database (catalog) name
v Database host name where Attunity Data Connect is installed
v Attunity port number

12. Enter yes and press Enter to continue the configuration. After the installation
completed, the following message is displayed: Deployment to the application
server successful.

13. Enter ./run.sh.

IBM Sterling Gentran:Server for UNIX and Sterling B2B Integrator Migration
Information: When you are migrating maps and setting up processes in Sterling
B2B Integrator from Sterling Gentran:Server for UNIX, Sterling Gentran:Server for
UNIX now displays translation errors, if any, in the envelope segments and does
not process the erroneous envelope segments.

Sterling Gentran:Server for UNIX 6.0 and 6.1 allowed EDI envelope segments (ISA,
GS, ST, SE, GE, IEA, UNB, UNH, UNT, and UNZ) with errors to be processed
successfully. This has been corrected and Sterling Gentran:Server for UNIX now
issues translation errors when using X12 or EDIFACT deenvelope processes. The
functional acknowledgments display the errors in the envelope segments.

The following examples illustrate scenarios where Sterling Gentran:Server for
UNIX allowed successful processing of EDI segments with errors:
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v Sterling Gentran:Server for UNIX did not display an error when the segment
count in the UNT or SE segments did not reflect the correct count of segments in
a transaction.

v Sterling Gentran:Server for UNIX did not display an error when the use of
segment delimiters in the Map Input properties did not match the data. The user
could not specify a delimiter in a map with multiple data files that used
different delimiters. The user had to use the Syntax Record and specify the
positions of the delimiters.

Uninstall Sterling B2B Integrator from a UNIX/Linux Cluster
Environment
Before you begin

If you have installed Sterling B2B Integrator software using IIM, then perform
these steps to unregister Sterling B2B Integrator packages from the IIM registry:
v Launch IIM.
v Click Uninstall and select the required Sterling B2B Integrator package (Media,

FixPack, or Interim Fix).
v Confirm and click Uninstall.

About this task

To uninstall Sterling B2B Integrator from a UNIX/Linux cluster environment,
perform the following procedure on each node, starting with node 1:

Procedure
1. Stop Sterling B2B Integrator and wait for shutdown to complete. If you begin

removing files before all business processes and Sterling B2B Integrator are
stopped, you may be unable to remove Sterling B2B Integrator successfully.
To stop Sterling B2B Integrator, navigate to /install_dir/install/bin and run the
following command:
./hardstop.sh

2. Back up the file system and database.
This step is optional. However, by backing up the file system and database,
you are ensured that Sterling B2B Integrator is completely recoverable.

3. Remove the installation directory by entering the following command in the
parent directory of your installation directory: rm -rf install_dir

4. If you use an Oracle, Microsoft SQL Server, or DB2 database, these remain
intact even after you remove Sterling B2B Integrator from the server. If you no
longer want to reference the data, contact your database administrator about
removing unwanted tables and recovering the database space where Sterling
B2B Integrator used to reside.

5. (Optional) To remove the JDK, review and perform the uninstall procedure for
the JDK you are using.

6. After you remove Sterling B2B Integrator from the server, you can remove
Eclipse, and any tools that were downloaded to the desktop, including the
following:
v Map Editor and associated standards

Refer to the Map Editor Guide for information about removing the Map
Editor.

v Graphical Process Modeler
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Refer to the Graphical Process Modeler Guide for information about removing
the Graphical Process Modeler.

v Web Template Designer
Refer to the Web Extensions Guide for information about removing the Web
Template Designer.

v (If licensed) MESA Developer Studio plug-ins, including:
– MESA Developer Studio Software Development Kit (SDK)
– MESA Developer Studio Skin Editor
Refer to the MESA Developer Studio guide for information about removing
MESA Developer Studio.

v (If licensed) Reporting Services, which requires MESA Developer Studio if
you want to use the plug-ins to create fact models and custom reports.
Refer to the MESA Developer Studio guide for information about removing
Reporting Services.

User Documentation
The user documentation is available from an online documentation site on the
web.

Providing the documentation in an online environment allows for frequent updates
of content that is based on user feedback and usability.

If you need a printed copy of the documentation, you can print topics of
information through your Internet browser, or you can download documents in
PDF format, after you add it to a collection on IBM Knowledge Center.

To access the documentation site from within Sterling B2B Integrator or one of its

tools, select the help 
 

icon. The system must reside on a computer that supports
Internet access and an Internet browser.

Improving your access to online documentation:

You can improve your access to online documentation by using several methods.

About this task

After you access the IBM Knowledge Center, you can perform the following tasks:
v Enter a word or phrase and search the entire library for information.
v Move through a hierarchy of contents pages to identify the topic you want to

read or print.
v Print topics by using your browser's Print function.
v Add documents to your collection and download them in PDF format.
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Troubleshooting Tips for Cluster Environment

Situation Message or Symptom Explanation/Resolution

Installing You encounter errors or problems
during installation.

Explanation

The installation creates several log files that you
can use to diagnose problems like the failure of
an installation.

Resolution

Examine the log files generated during
installation:

v ant.install.log (in the parent_install directory)

v /install_dir/PreInstallSI.log

v /install_dir/InstallSI.log

Installing When you entered an absolute path
during installation, a message
indicated that the command was not
found.

Explanation

You entered an incorrect path. Check the
information entered.

Resolution

Enter the correct path.

Installing a desktop tool
or resource

Cannot download any of the
following:

v Map Editor and associated
standards

v Graphical Process Modeler

v Web Template Designer

v (If licensed) MESA Developer
Studio plug-ins, including:

– MESA Developer Studio
Software Development Kit
(SDK)

– MESA Developer Studio Skin
Editor

v (If licensed) Reporting Services,
which requires MESA Developer
Studio if you want to use the
plug-ins to create fact models and
custom reports.

Explanation

When you install Sterling B2B Integrator, system
files are created that contain an internal IP
address. If you install Sterling B2B Integrator
behind a firewall, and your firewall is configured
to accept an external IP address from a client
computer, you may not be able to download the
desktop tools and resources. The firewall will
reject the internal IP address from a client residing
outside of the firewall.

Resolution

Modify the system files that contain the invalid IP
address. Follow these steps:

1. Navigate to /install_dir/install/bin.

2. Stop Sterling B2B Integrator.

3. Enter the following command followed by the
external IP address:

./patchJNLP.sh external_IP_address

4. Restart Sterling B2B Integrator.

Installing Memory and ulimit errors. Explanation

The installation fails with memory and ulimit
errors.

Resolution

v Refer to the Viewing and Editing Performance
Configuration Settings in the Performance
Management documentation. Modify your
memory setting accordingly.

v Refer to the Operating System Configuration
Checklist and tune the ulimit settings.
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Situation Message or Symptom Explanation/Resolution

Accessing the URL Attempts to access the URL for
Sterling B2B Integrator display the
message: Page cannot be displayed

Resolution

See the information on Changes to Network Interface
Bindings to update either the property file or the
dashboard.

Node status on a
dual-stack machine

Displays Node went down status in
Node Status page, but the node is up
and running.

Explanation

Sterling B2B Integrator is configured using an
IPv4 address on a dual-stack machine. The Node
Status page displays Node went down status, but
the node is up and running.

Resolution

Modify the
noapp.properties_platform_ifcresources_ext.in and
jgroups_cluster.properties.in files by performing
the following:

1. Identify the IPv6 address of the host machine
from the /etc/hosts file.

2. Navigate to the /install_dir/properties
directory.

3. Edit
noapp.properties_platform_ifcresources_ext.in
file and add the IPv6 address: admin_host.2 =
<IPv6 address>

4. Edit jgroups_cluster.properties.in and modify
the following:

v &HOST_NAME=<IPv6 address>

v mcast_addr=FFFF::<IPv4 address

5. Run the ./setupfiles.sh script to apply the
changes.

Installing (HP-UX 11.31) When entering your email address
the @ key is not recognized.

Explanation

The @ key is being mapped to kill or eol, it needs
to be mapped to another character.

Resolution

This resolution only applies to HP-UX 11.31.

Map the @ key to another character.

Note: If you need want to see what the key is
mapped to, use the stty -a command.
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Situation Message or Symptom Explanation/Resolution

Cluster Installation Cluster is not working properly and
your machine is running dual-stack -
ipv4 and ipv6.

Explanation

You can see the node went down from User
Interface, but the node is running.

Resolution

v Find your ipv6 address in the /etc/hosts file
and update noapp.properties.in file
admin_host.2 = <ipv6_address>.

v Edit jgroups_cluster.properties.in file and
replace &HOST_NAME with the ipv6 address
string and change
mcast_addr=FFFF::239.255.166.17.

v Enter setupfiles.sh.

Cluster Installation or
Upgrade

When configuring TCPS the
following warning can be found in
the activemqbroker.log:

sun.security.provider.certpath.
SunCertPathBuilderException:
unable to find valid certification
path to requested target.

Resolution

Add the system certificate to the trust store using
the KeyTool command.

Cluster Installation or
Upgrade

When configuring TCPS the
following warning can be found in
the activemqbroker.log:
oracle.net.ns.NetException: Invalid
cipher suites specified.

Resolution

Do not mention any SSL cipher in the
ActiveMQconfig.xml.
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Situation Message or Symptom Explanation/Resolution

e-Invoice Upgrade:
Oracle Add Constraint
Error

When you upgrade Sterling
e-Invoicing and are using an Oracle
database, if the upgrade fails with
the error message name is already
used by an existing object, this
occurs because the default behavior
for the drop constraint command
changed in Oracle 10.

Explanation

The index that is used to support the constraint is
now only removed if the index was generated by
the create constraint command. The indexes for
Sterling e-Invoicing are always generated from
constraints during an install. If you receive this
error during a Sterling e-Invoicing upgrade, it is
because of how the database was restored, the
version of Oracle you are using, and because the
Oracle imp command exported the indexes and
constraints separately. There is no way to
determine when the imp command will not add a
create index command to the export file if it was
generated by a constraint – but if it does add the
command, the database restore process loses the
association of the constraint and its underlying
index. The database script that runs during a
Sterling e-Invoicing upgrade executes two steps:
1. First, it drops the unique constraint so the next
step can redefine it using additional columns.
However, the drop constraint command does not
remove the underlying index if the association
with its index was lost. 2. The next command that
redefines this constraint requires a different index
definition, but in this scenario the name of the
index the constraint wants to use already exists,
which causes the name is already used by an
existing object error.

Resolution

If you receive this error message, the solution for
this problem is to drop the index and rerun the
Sterling e-Invoicing upgrade. The drop index
command you should use is: drop index
UNQ_EINV_CANON

Applying a fix pack or
upgrading

The /install_dir/install/
installed_data directory is created
(if clustered, on each node) during
upgrade or applying a fix pack.

This directory can become very large
and take up needed space on the file
system.

Explanation

The information in this directory is used during
upgrade or when applying a fix pack, but is not
required afterward. The deployment/cleanup
tasks for the upgrade do not remove this
directory.

Resolution

The directory can be manually removed to
increase the available space for the file system:

1. Navigate to /install_dir/install

2. Enter

rm -r installed_data

214 Installing and upgrading (V5.2.6 or later):



UNIX/Linux Non-Cluster Environment Installation (V5.2.6 or
later)

You may follow different installation and upgrade scenarios when you install and
upgrade Sterling B2B Integrator in a UNIX/Linux non-cluster (single node)
environment.

Installation Scenarios

It is important to review the following installation scenarios:

Scenario Instructions

Version 5.1.x is installed and it needs to be
upgraded to V5.2.6.

See “Upgrading (V5.2.6 or later)” on page
320

Version 5.2.x is installed and it needs to be
upgraded to V5.2.6.

See Applying a fix pack (V5.2.6 or later)

Version 5.2.6 is being installed as the base
release.

Review this document and use the
installation instructions.

Prerequisite knowledge for installation in the UNIX environment
The installation of Sterling B2B Integrator requires background knowledge in
different areas.

Before you begin the installation, you must be knowledgeable on the following
topics:
v Application servers
v Operating system on which you plan to install
v Database administration
v VI or another text editor
v System Requirements for this release of Sterling B2B Integrator.

Intended audience:

This document can be used by different members of your organization.

This document is intended for use by:
v System administrators
v Installation engineers
v Database administrators.

Assumptions for this guide:

The procedures in this guide are accurate as of the publication date and are
specific to this version of the document.

Before you begin the installation
Before you install Sterling B2B Integrator, you must perform certain tasks.

Before you begin the software installation, you need to perform the following
tasks:
v Perform system verification tasks
v Perform operating system verification tasks
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v Obtain the correct version of the JDK, JCE, and JDBC drivers required. Most
Java files required are provided with the product download or media. See the
System Requirements for more information.

System verification tasks:

Before you install Sterling B2B Integrator, you must perform certain system
verification tasks.

Item System Verification Task Your Notes

1 Use the System Requirements to verify that your
system hardware and software meet the
requirements that are specified for this release.

For HP, you must run the HP JConfig utility to
obtain the required patches and kernel
modifications.

2 Verify that the file system has adequate free disk
space.

3 Verify the following items:

v An operating system user account exists on the
host server.

v User account has permissions to run the
commands for the operating environment.

4 Verify that your database was installed and
configured. See the Configure the Database chapter
for more information.

If you are going to manually apply DDL
statements, you need to complete the database
schema work before you begin the installation.

5 If you are using a non-English-language
environment, confirm that you are using the
appropriate character set.

Operating system verification:

Before you install Sterling B2B Integrator, you must perform certain operating
system verification tasks.

You must verify your operating system configuration by using the following
checklist:
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For the Operating System Operating System Configuration Checklist Your Notes

HP-UX Establish these settings:

v Verify kernel parameters and establish the following
minimum settings by running kctune command:

– kctune max_thread_proc 1024

– kctune maxdsiz 2147483648

– kctune maxdsiz_64bit 8589934592

– kctune maxssiz 369098752

– kctune maxssiz_64bit 536870912

v Run the ulimit utility, verify, and establish the
following minimum settings:

– ulimit -d = 2097152 KB or higher

– ulimit -s = 360448 KB or higher
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For the Operating System Operating System Configuration Checklist Your Notes

AIX To ensure that /install_dir/install directory has the
necessary permissions, AIX users must run the
following command on the parent directory of the
/install_dir/install directory before installation:

chmod -R a-s <absolute path>/install_dir_parent

where install_dir_parent is the directory in which
/install_dir/install is created.

For example, to specify

AIX_1/applications/test1/my_install as your
installation directory, run the command from the
AIX_1/applications directory (directly above the test1
directory):

chmod -R a-s test1

or from another location on the file system:

chmod -R a-s /AIX_1/applications/test1

This command ensures that when the my_install
directory is created during installation, it inherits the
correct permissions from the test1 directory.

The ncargs parameter specifies the maximum allowable
size of the ARG/ENV list (in 4 KB blocks) when the
exec() subroutines are run. Set the ncargs parameter to
16 or higher.

To display the current value of ncargs, enter the
command lsattr -El sys0 -a ncargs.

To change the current value of ncargs, enter the
command chdev -l sys0 -a ncargs=NewValue.

Note: The lsattr command option is –El (lowercase L)
and the chdev command option is –l (lowercase L).

Change the following default entries in the
/etc/security/limits file:

v fsize = -1

v core = 2097151

v cpu = -1

v data = 262144

v rss = 65536

v stack = 65536

v nofiles = 4096
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For the Operating System Operating System Configuration Checklist Your Notes

Linux You must disable SE Linux by entering the following
text:

/etc/sysconfig/selinux: SELINUX=disabled

Ensure that /etc/hosts has short-names first for all
entries. For example,
127.0.0.1localhostlocalhost.localdomain

If the base locale is English, verify the following values:

v LANG variable is en_US

v LANG variable is exported
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For the Operating System Operating System Configuration Checklist Your Notes

Red Hat Enterprise Linux Make the following system changes:

1. If the base locale for the system is English, edit the
/etc/sysconfig/i18n file by changing the SUPPORTED
variable from en_US.utf8 to en_US. You can also
allow multiple support with the following format:
en_US.utf8:en_US

2. Save and close the /etc/sysconfig/i18n file.

3. Edit the /etc/security/limits.conf file by adding
the following lines:

v * hard nofile 8196

v * soft nofile 4096

v * hard memlock 3000000

v * soft memlock 3000000

v * hard nproc 16000

v * soft nproc 16000

v * hard stack 512000

v * soft stack 512000

This change updates the system ulimits. For nofile,
set the value to unlimited.

4. Save and close the /etc/security/limits.conf file.

5. Restart the system.

IBM Installation Manager in UI mode might fail to start
on an RHEL 6.1 or higher x86_64 (64-bit) OS because
Installation Manager is a 32-bit application and depends
on some of the 32-bit libraries.

For information about installing the required 32-bit OS
libraries, refer to the IBM Support website
(https://www-304.ibm.com/support/
docview.wss?uid=swg21459143)

CAUTION:
Because of a known issue with the IBM JDK on RHEL
6.1 or higher, a performance degradation might be seen
in comparison to previous RHEL releases. To avoid
this issue, disable the CFS on RHEL 6.1 or higher.

To disable CFS:

1. Log in as root

2. Edit /etc/sysctl.conf and add
"kernel.sched_compat_yield = 1"

3. Restart the system

For more information, go to the IBM SDK and
Runtime Environment Java Technology Edition
Version 6 information Center and search for known
limitations on Linux.
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For the Operating System Operating System Configuration Checklist Your Notes

Solaris Set the following entries in the /etc/security/limits
file:

nofiles = 4096 (recommended value is unlimited)

set rlim_fd_max=4096 (limit is 65535) - hard limit

set rlim_fd_cur=4096 - soft limit

v To make the setting effective as the hard limit, restart
the server or run the following command:

kill -1 inetd

v To make the setting effective as the soft limit, use the
parent shell configuration (for example, .profile).
Then, restart the server.

SUSE Linux Make the following system changes:

1. If the base locale for the system is English:

v For the individual user, edit the $HOME/.i18n file
by setting export LANG="en_US".

v For a system-wide change, edit the
/etc/sysconfig/language file by setting
RC_LANG="en_US". You must also set
ROOT_USES_LANG="yes".

2. You can also allow multiple support with the
following format: RC_LANG="en_US.utf8:en_US"

3. Save and close the file. Language settings take effect
on your next session.

4. Edit the /etc/security/limits.conf file by adding
the following lines:

v * hard nofile 8196

v * soft nofile 4096

v * hard memlock 3000000

v * soft memlock 3000000

v * hard nproc 16000

v * soft nproc 16000

v * hard stack 512000

v * soft stack 512000

This change updates the system ulimits. For nofile,
set the value to unlimited.

5. Save and close the /etc/security/limits.conf file.

6. Restart the system.

Verification of the system requirements:

Before you begin the installation, verify that your system meets the hardware and
software requirements that are specified for this release.

The hardware requirements that are listed in the System Requirements are the
minimum requirements. Your system requirements might exceed these
requirements if you are running other applications on the same machine as Sterling
B2B Integrator.

The installation strictly enforces the following system requirements:
v Operating system version must match requirement exactly.
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v The minimum patch level for the operating system is enforced, but you can
apply higher patch levels.

v JDK version must match requirement exactly.
v The disk space is a minimum for the installation. The system must be separately

sized to handle whatever load is going to be put on the system.
v Database version must match exactly.
v JDBC driver version supports exact matches and wildcard matches.

If any of these requirements are not met, the installation fails. If the installation
fails, review the installation log for a list of non-compliant items.

Upgrading your JDK (Windows and UNIX):

Sometimes you need to upgrade your JDK version to support a new version of
Sterling B2B Integrator.

About this task

If you have V5.2.4.1 or higher installed, you can use the upgradeJDK script to
upgrade your version of the JDK. See bin Directory Files for more information.

If you have V5.2.4.0 or lower installed, follow the steps below to upgrade your
JDK.

Procedure

1. Download the new JCE file. For example, the UnrestrictedPolicy.zip policy
file for the IBM JDK.

2. Back up the existing JDK in <Install Dir>/jdk. Change the folder name to
jdk_back)

3. Copy the new IBM JDK (1.7.0 ) folder to the installation Directory. Directory
Name should be jdk )

4. Copy all the jars present in <Install Dir >jdk_back\jre\lib\ext to <install
Dir>jdk\jre\lib\ext directory.

5. If your installation of V5.2.4 or lower was built using the Oracle (SUN) JDK,
continue to the next step. Otherwise skip to step 6.
a. Edit the sandbox.cfg property file.
b. Set JCE_DIST_FILE=<New Path of Supported JCE File>. For example,

JCE_DIST_FILE=D\:\\IBM\\unrestrictedpolicyfiles.zip.
c. Back up the local_policy.jar and US_export_policy.jar files present in

<Install Dir>jdk\jre\lib\security.
d. Unzip the new JCE file. For example, Unrestrictedpolicyfiles.zip file.

Copy local_policy.jar and US_export_policy.jar to <Install
Dir>jdk\jre\lib\security.

6. Run updateJavaSecurity.cmd <path_to_new_jdk><Install Dir>/jdk.
7. Verify that security providers have been updated in <Install

Dir>\jdk\jre\lib\security\java.security.
8. Follow the Upgrade Guide instructions for your upgrade scenario.

Configure the Database
You must install, create, and configure a database so that each Sterling B2B
Integrator instance has a dedicated schema and login for the database.
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In a non-clustered environment, the Sterling B2B Integrator can support the
following databases:
v DB2
v Oracle®

v Microsoft SQL Server
v MySQL

Attention: MySQL will not be supported in Sterling B2B Integrator after V5.2.6.
See http://www.ibm.com/support/knowledgecenter/SS3JSW_5.2.0/
com.ibm.help.sb2bi_overview.doc/com.ibm.help.whats_new.doc/
526_next_retirement_list.html for more information.

See System Requirements for supported version information.

Database Information You Need Before You Install Sterling B2B Integrator in a
Non-Cluster Environment: Before you begin to install Sterling B2B Integrator, you
need to install and configure your database. Review and gather the following
information. An “x” indicates the information is required.

Information to Gather Oracle DB2
Microsoft SQL
Server MySQL

Record Information
Here

Database User Name x x x x

Database Password x x x x

Database Catalog
Name

x x x x

Database Host x x x x

Database Port x x x x

JDBC Driver #1 x x x x

Use BLOB data? x x

Enable Multibyte
Support?

x x x

Database sizing and capacity planning:

Database sizing is designed to give you estimates of the database growth and to
help you plan the disk requirements.

There are many factors to consider when you are estimating the amount of disk
space that is required for Sterling B2B Integrator. As a result, trying to consider all
growth factors is impractical because the user might not know the answers to
many questions that are required to do a detailed forecast. Over the years the cost
of disks has dramatically decreased, and the capacity and speed of disks has
increased. The method of how information system managers order disk capacity
also has changed, from purchasing disk arrays that are dedicated to a particular
database server and project, to the concept of SANS (storage area networks).

Consider the confidence that you have in your data estimates when you are
making the final purchase decision and adjust accordingly. After the initial
purchase and production deployment, disk growth should be tracked for future
purchase forecasts.

You should track your actual database storage usage and the number of database
records regularly. Correlating these two metrics enabled you to plan your future
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disk requirements. Moreover, determining the average amount of space used for
each order line or shipment line, enables you to accurately predict your future
growth requirements.

Database Definition Language (DDL) statements:

When you install Sterling B2B Integrator, you can manually apply Database
Definition Language (DDL) statements to your database tables instead of requiring
the installation process to do it directly.

This feature increases database security by reducing the database permissions of
the Sterling B2B Integrator database user. The rights to database objects can be
reserved for a secure user like a customer database administrator (DBA). A
business can require that only a DBA with the proper permissions can make
database changes.

Configuring the DB2 Database:

Before you install Sterling B2B Integrator with the DB2 database, you must
configure the database.

Before you begin:
v If you do not have DB2 installed, follow the procedures in the DB2 installation

manual.
v The installation script creates tables and indexes. Certain tables require a page

size of 32 KB. You must have a temporary table space to accommodate such
tables. DB2 automatically places tables and indexes in the available table spaces.
You can move the tables to a different table space after the installation is
complete.

v If you are reinstalling the software, be aware that data in your existing database
is deleted. To preserve the data, either back up the existing database or save it
under a different name.

v After you create and configure your database, recycle the database. Then, stop
and restart the database to apply the changes.

Use the following checklist to configure DB2 for Sterling B2B Integrator:

Item DB2 Database Configuration Checklist Your Notes

1 Create the database.

Refer to the DB2 documentation on creating the
database, including creating a schema repository,
login, and table space.
Important: In V5.2.6.2 or later you must ensure
that all tablespaces used by Sterling B2B
Integrator tables have a minimum page size of
8K. Otherwise installation will fail.

Be sure to install the correct version and patches.
See the System Requirements for supported
version information.

3 Review the DB2 parameters.

4 Ensure that the DB2 user privileges are set.

5 Install the JDBC drivers for DB2.
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DB2 database user privileges:

The DBADM role is required to perform administrative operations in DB2
database.

DB2 parameters:

When you install Sterling B2B Integrator with the DB2 database, you must set
certain DB2 parameters. Other DB2 parameter settings are recommended for the
efficient performance of Sterling B2B Integrator.

When you install Sterling B2B Integrator with DB2, you must set the DB2
parameters that are listed in the following topics:
v “Mandatory settings for IBM DB2 registry variables” on page 6
v “Mandatory settings for DB CFG parameters” on page 6

After you install Sterling B2B Integrator with DB2, you can improve the DB2
database performance by setting the recommended parameters that are listed in the
performance documentation for the following items:
v DB2 registry variables
v DBM CFG parameters
v DB CFG parameters
v DB2 for Linux on System z
v DB2 for LUW configuration and monitoring

Mandatory settings for IBM DB2 registry variables:

Mandatory IBM DB2 registry values are critical for IBM DB2 performance with
Sterling B2B Integrator.

Variable Mandatory value

DB2_SKIPDELETED ON

Allows index-range queries or table-scan queries to skip
records that are in an uncommitted delete state. This
reduces the amount of lock contention from Read Share
and Next Key Share locks from range queries in tables
with a high frequency of deletes.

When enabled, DB2_SKIPDELETED allows, where
possible, table or index access scans to defer or avoid
row locking until a data record is known to satisfy
predicate evaluation. This allows predicate evaluation
to occur on uncommitted data.

This variable is applicable only to statements using
either Cursor Stability or Read Stability isolation levels.
For index scans, the index must be a type-2 index.
Deleted rows are skipped unconditionally on table scan
access while deleted keys are not skipped for type-2
index scans unless DB2_SKIPDELETED is also set.

Recommended value: ON
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Variable Mandatory value

DB2_SKIPINSERTED ON

Allows SELECTs with Cursor Stability or Read Stability
isolation levels to skip uncommitted inserted rows. This
reduces record lock contention on tables with heavy
insert rates.

Mandatory settings for DB CFG parameters:

For optimal performance, certain parameters and values are mandatory for DB2.

Parameter Mandatory value

Database Code Set UTF-8

Installing DB2 client components, compilers, and fix pack:

The use of Sterling B2B Integrator with the DB2 database requires the installation
of different items for the database.

About this task

Sterling B2B Integrator uses stored procedures for DB2. For more information
about these tasks, see the IBM documentation for DB2.

Procedure

You must install or set up the following DB2 components to use Sterling B2B
Integrator with DB2:
1. Install the Administration client.
2. Install the necessary fix pack after you install the client components and

compilers. Otherwise, the clients overwrite the fix pack binary files.
3. Set the path for the compiler by entering the db2set command.

Installing JDBC drivers for DB2:

When you install Sterling B2B Integrator with the DB2 database, you must install a
JDBC driver for the database.

About this task

For DB2, install the appropriate DB2 JDBC Type 4 driver and any correlating
patches. For the supported version information, see System Requirements.

You can obtain these files from the IBM website. After you obtain this JDBC driver,
record the absolute path to its location on your system. You must supply this
absolute path during installation.

If the JDBC driver provided by your database vendor is distributed among
multiple files, you must place all the files that comprise the JDBC driver into one
JAR file. Follow these steps to create one JAR file:
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Procedure

To install a JDBC driver for the DB2 database:
1. Identify all the vendor database JAR files for the JDBC driver.
2. Record the absolute path to the JAR file you created on the Preinstallation

Checklist.
The Type 4 driver does not require a separate Java listener to be running on the
database server. Instead, connect directly to the DB2 port.

Upgrading DB2 to version 10.1 or 10.5:

To upgrade from DB2 9.5 or 9.7 to 10.1 or 10.5, you must make configuration
changes.

Procedure

To upgrade from DB2 9.5 or 9.7 to 10.1 or 10.5:
1. Copy your DB2 9.5 or 9.7 database content to DB2 10.1 or 10.5.

Attention: Back up all files before you change any settings.
2. Back up the database driver in the /install_dir/dbjar/jdbc/DB2/ directory

and replace it with the DB2 10.1 or 10.5 version.
3. Update the following sandbox.cfg file fields with your environment-specific

parameters:
DB_PASS=
DB_SCHEMA_OWNER=
DB_DRIVERS_VERSION=
YANTRA_DB_PORT=
DB_DATA=
DB_HOST=
YANTRA_DB_USER=
DB_PORT=
YANTRA_DB_PASS=
YANTRA_DB_DATA=
YANTRA_DB_HOST=
DB_DRIVERS=
DB_USER=

DB2_PORT=
DB2_USER=
DB2_PASS=
DB2_DATA=
DB2_HOST=

4. Edit the following value in the activemq.xml file:
activemq.xml: <value>jdbc:db2//DB_HOST:DB_PORT/DB_DATA</value>

5. Run the setupfiles script.
6. Run the deployer script.
7. Start Sterling B2B Integrator.

Configuring the Oracle Database:

Before you install Sterling B2B Integrator with the Oracle database, you must
configure the database.
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Before you begin

v If you are reinstalling the software, be aware that data in your existing database
is deleted. To prevent this deletion, either back up the existing database or save
it under a different name.

v After you create and configure your database, recycle the database. Then, stop
and restart to apply the changes.

About this task

Use the following checklist to configure Oracle for Sterling B2B Integrator:

Item
Oracle Database Configuration
Checklist Your Notes

1 Create the database.

Refer to the Oracle documentation
on creating the database, including
creating a schema repository, login,
and table space.

Be sure to install the correct version
and patches.

See the System Requirements for the
supported version information.

2 Configure an Oracle Instance.

3 Configure Oracle Rollback.

4 Install the Oracle JDBC Driver.

5 Enable Failover in a Multiple Node
Oracle RAC Database Cluster.

6 After Sterling B2B Integrator is
installed, if you want to encrypt the
data traffic, perform one of the
following tasks:

v Configure Sterling B2B Integrator
for Data Traffic Encryption

v Configure Sterling B2B Integrator
for Data Traffic Encryption with
SSL

Configuring an Oracle instance:

An Oracle database requires certain parameter settings and other configurations.

Before you begin

v You must have the Oracle database installed. Ensure that you have installed the
correct versions and patches. See System Requirements for supported version
information.

v Ensure that the user responsible for creating and modifying the Oracle database
has a specified quota (extent) assigned in the table space, even if the user was
assigned an unlimited table space. Otherwise, the installer might display the
error ORA-09150: no privileges on tablespace name.

228 Installing and upgrading (V5.2.6 or later):



Procedure

1. Run the create instance procedure. Use AL32UTF8 as the character set.
2. Configure the INIT<INSTANCE_NAME>.ORA file with the recommended and

mandatory settings in the Performance Management guide. See the Oracle init
parameter configuration checklist for specific settings.

Note: After you complete the installation of Sterling B2B Integrator with
Oracle, you can improve the performance of the database with the settings
listed in the Performance Management guide.

3. Identify or create a table space for user tables and indexes.
4. Create a user. Unless stated for a task, the user does not require database

administrator (DBA) privileges.
5. Grant permissions to the user. The following permissions are required for the

administrative user for creating and modifying the Oracle database:
v GRANT "CONNECT" TO SI_USER

v ALTER USER SI_USER DEFAULT ROLE "CONNECT"

v GRANT CREATE SEQUENCE TO SI_USER

v GRANT CREATE TABLE TO SI_USER

v GRANT CREATE TRIGGER TO SI_USER

v GRANT SELECT ON CTXSYS.CTX_USER_INDEXES TO SI_USER

v GRANT SELECT ON SYS.DBA_DATA_FILES TO SI_USER

v GRANT SELECT ON SYS.DBA_FREE_SPACE TO SI_USER

v GRANT SELECT ON SYS.DBA_USERS TO SI_USER

v GRANT SELECT ON SYS.V_$PARAMETER TO SI_USER

v GRANT SELECT ANY DICTIONARY TO SI_USER

v GRANT ALTER SESSION TO SI_USER

v GRANT CREATE SESSION TO SI_USER

6. If you are using Oracle AQ, grant the AQ_ADMINISTRATOR_ROLE
permission.

7. If you plan to use EBICS Client, grant the GRANT CREATE VIEW TO SI_USER
permission.

Configuring Oracle rollback:

The configuration of rollback in an Oracle database helps you manage database
transactions.

About this task

You can roll back changes in Oracle by using AUTO UNDO management. IBM
recommends that you use this option. This practice avoids any manual monitoring
of UNDO segments.

Installation of the Oracle JDBC driver:

Sterling B2B Integrator requires the appropriate JDBC driver for the Oracle
database.

The JDBC drivers are thin client-based pure Java JDBC drivers. See System
Requirements for supported version information. The supported versions of the
JDBC driver build the correct Sterling B2B Integrator directory structure.
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Enabling failover in a multiple node Oracle RAC database cluster:

You can enable failover in a multiple node Oracle RAC database cluster in
UNIX/Linux by using traditional RAC or RAC with SCAN.

Procedure

To enable failover in a multiple node Oracle RAC database cluster:
1. Open the /install_dir/install/properties directory to modify the

sandbox.cfg file.
2. In the sandbox.cfg file, add a ORACLE_JDBC_URL property, which contains the

Oracle RAC connection URL.
Choose one of the following depending on whether you are using traditional
RAC or RAC with SCAN. The property value must be one string of text that
starts with ORACLE_JDBC_URL=. Your database administrator (DBA) can modify
this URL as needed:
v To configure traditional RAC, use this format:

jdbc:oracle:thin:@
(DESCRIPTION=
(ADDRESS_LIST=
(FAILOVER=ON)
(LOAD_BALANCE=OFF)
(ADDRESS=(PROTOCOL=TCP)(HOST=myhost1)(PORT=1521))
(ADDRESS=(PROTOCOL=TCP)(HOST=myhost2)(PORT=1521))
)
(CONNECT_DATA = (SERVER = DEDICATED)(SERVICE_NAME=myservicename OR mySID))
)

Note: This method uses the default Oracle RAC service that is provided by
Oracle.

v To configure RAC with SCAN, use this format:
jdbc:oracle:thin:@host:port/service

For example:
jdbc:oracle:thin:@RAC-SCAN:1521/ORCL

Where:
– RAC-SCAN is resolved to an IP address by DNS
– 1521 = Port number
– ORCL = the name of your Oracle RAC service

Important: To use RAC with SCAN, you must also define a new Oracle
RAC service (you cannot use the default service) that defines one node as
the preferred node and at least one node as a failover node.

3. Open the /install_dir/install/bin directory.
4. Enter the command ./setupfiles.sh.

Data traffic encryption in the Oracle database:

You can encrypt transactions between Sterling B2B Integrator and the Oracle
database. Encryption prevents anyone who is outside the system from viewing the
data that flows between Sterling B2B Integrator and the database.

The following list describes important aspects of enabling database encryption:
v At installation, encryption is turned off by default. If you want your database

transactions to be encrypted, you must enable encryption.

230 Installing and upgrading (V5.2.6 or later):



v The encryption can be enabled at any time.
v Encryption applies to all database transactions between Sterling B2B Integrator

and the database.

System performance might be impacted when encryption is enabled. The extent of
this impact depends on your hardware, database configuration, transaction
volume, and the relative amount of processing time that is spent by the system
against other activities.

For more information on data traffic configuration, see SSL With Oracle JDBC Thin
Driver.

Before you encrypt data traffic for the Oracle database:

The decision to encrypt data traffic for the Oracle database includes several
considerations.

Consider the following items when you configure database traffic encryption:
v Sterling B2B Integrator must be installed in TCP (clear) mode before you can

configure encryption.
v Perform these changes to your database before you install Sterling B2B

Integrator.
v Configure wallets for encryption-only mode even if the wallet that is used is

empty. Enable auto login for all wallets.
v If you want to use SSL for encryption only, it is recommended to follow the

instructions in the "CASE #1: USE SSL FOR ENCRYPTION ONLY" section of the
Oracle documentation. It is not necessary to configure certificates for the wallet.
In this mode, Diffie-Hellman ciphers are used. The server and the client are not
authenticated through SSL. You must authenticate by using a user name and a
password. However, if you are running Sterling B2B Integrator on an operating
system that requires an IBM JDK, you cannot use this mode, as IBM JSSE
TrustManager does not permit anonymous ciphers. You must configure wallets
with certificates.

v If you want to use SSL for encryption and for server authentication, it is
recommended to follow the instructions in the "CASE #2: USE SSL FOR
ENCRYPTION AND SERVER AUTHENTICATION" section of the Oracle
documentation.

v If you want to use SSL for encryption and for server authentication of both tiers,
it is recommended to follow the instructions in the Oracle "CASE #3: USE SSL
FOR ENCRYPTION AND AUTHENTICATION OF BOTH TIERS" section of the
Oracle documentation, depending on how you intend to configure client or
server authentication.

v After you configure your database for data traffic encryption, the database
accepts both TCP (clear) and TCPS (encrypted) connections.

v There is a known issue in the Oracle 11g database when the listener is
configured only for TCPS. The lsnrctl utility that is used to start and stop
database listeners attempts to contact the listener, which is enabled first. You
should define the address list of the listener to contact either TCP or IPC before
it contacts TCPS.

Configuring Sterling B2B Integrator for data traffic encryption in Oracle:

You can enable data traffic encryption-only, with anonymous authentication, and
not SSL authentication.
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About this task

If you want to use SSL for encryption only, it is recommended to follow the
instructions in the "CASE #1: USE SSL FOR ENCRYPTION ONLY" section of the
Oracle documentation. It is not necessary to configure certificates for the wallet. In
this mode, Diffie-Hellman ciphers are used, and the server and the client are not
authenticated through SSL. You must authenticate by using a user name and a
password.

However, if you are running Sterling B2B Integrator on a system that requires an
IBM JDK, you cannot use this mode, as IBM JSSE TrustManager does not permit
anonymous ciphers. You must configure wallets with certificates.

This procedure is applicable only if you are running Sterling B2B Integrator on a
system that requires Sun JDK. The IBM JSSE TrustManager does not permit
anonymous ciphers.

If your Sterling B2B Integrator is a cluster installation, you need to perform this
procedure on each node, starting with node 1.

Procedure

To configure Sterling B2B Integrator for data traffic encryption in Oracle:
1. Install Sterling B2B Integrator in TCP (clear) mode.
2. Stop Sterling B2B Integrator.
3. Open the /install_dir/install/properties directory.
4. Open the customer_overrides.properties file and add the following database

connection information:
jdbcService.oraclePool.prop_oracle.net.ssl_cipher_suites=
(SSL_DH_anon_WITH_3DES_EDE_CBC_SHA, SSL_DH_anon_WITH_DES_CBC_SHA)
jdbcService.oraclePool.prop_oracle.net.ssl_server_dn_match=false

If you have a configured container, ensure that the same database information
is added to the customer_overrides.properties.in file. To locate the file,
navigate to the /install_dir/install/properties/nodexACy directory, where x
gives the node number and y gives the container number. Perform this step
for all the containers configured in the system.

5. Repeat Step 4 for the following Oracle connection pools by changing only the
pool name:
v oraclePool_local

v oraclePool_NoTrans

v oracleArchivePool

v oracleUIPool

If you have any other database pools, you need to add the properties for those
pools.

6. Open the sandbox.cfg file and change the database connection information as
shown:
ORACLE_JDBC_URL= jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS=(PROTOCOL=tcps)
(HOST=<DB host>)(PORT=<TCPS port as configured in DB config section above>))
(CONNECT_DATA=(SERVICE_NAME=<service name>)))

Make sure that you enter values for the HOST, PORT, and SERVICE_NAME
parameters.
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7. Open the activemqconfig.xml.in file and modify the following database
connection information:
v Remove or comment out the following default ActiveMQ database

configuration information:
<bean id="gis-ds" class="org.apache.commons.dbcp.BasicDataSource"
destroy-method="close" singleton="true" lazy-init="default"
autowire="default" dependency-check="default"
SCIOverrideName="persistence-bean">

<property name="driverClassName">
<value>oracle.jdbc.driver.OracleDriver</value>
</property>
<property name="url">
#:ifdef ORACLE_JDBC_URL
<value>&ORACLE_JDBC_URL;</value>
#:else
<value>jdbc:oracle:thin:@&ORA_HOST;:&ORA_PORT;:&ORA_DATA;</value>
#:endif
</property>
<property name="username">
<value>&ORA_USER;</value>
</property>
<property name="password">
<value>&ORA_PASS;</value>
</property>
<property name="maxActive">
<value>32</value>
</property>
</bean>

v Add the following ActiveMQ database configuration information:
<bean id="gis-ds"
class="oracle.jdbc.pool.OracleDataSource" destroy-method="close"
singleton="true" lazy-init="default"
autowire="default"
dependency-check="default">
<property name="URL"><value>&ORACLE_JDBC_URL;</value></property>
<property name="user"><value>&ORA_USER;</value></property>
<property name="password"><value>&ORA_PASS;</value></property>
<property name="connectionProperties">
<value> oracle.net.ssl_cipher_suites:

(SSL_DH_anon_WITH_3DES_EDE_CBC_SHA, SSL_DH_anon_WITH_DES_CBC_SHA)
oracle.net.ssl_client_authentication: false
oracle.net.ssl_version: 3.0
driverClassName:oracle.jdbc.driver.OracleDriver
maxActive: 32

</value>
</property>
</bean>

8. Open the /install_dir/install/bin directory.
9. Enter the command ./setupfiles.sh.

10. Restart Sterling B2B Integrator. All the database connections from Sterling B2B
Integrator are now connected through TCPS (encrypted) mode.

Configuring Sterling B2B Integrator for data traffic encryption with SSL authentication in
Oracle:

You can enable data traffic encryption and SSL authentication.

About this task

This procedure is applicable if you are running Sterling B2B Integrator on a system
that requires either Sun JDK or IBM JDK.
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The example in this procedure uses two-way SSL authentication. It is
recommended to follow the instructions in the "CASE #2: USE SSL FOR
ENCRYPTION AND SERVER AUTHENTICATION" section of the Oracle
documentation.

You can also configure one-way SSL authentication. If you want to use SSL for
encryption and for server authentication of both tiers, it is recommended to follow
the instructions in the "CASE #3: USE SSL FOR ENCRYPTION AND
AUTHENTICATION OF BOTH TIERS" section of the Oracle documentation.

If your installation of Sterling B2B Integrator is a cluster installation, you need to
perform this procedure on each node, starting with node 1.

Procedure

To configure Sterling B2B Integrator for data traffic encryption with SSL
authentication in Oracle:
1. Install Sterling B2B Integrator in TCP (clear) mode.
2. Stop Sterling B2B Integrator.
3. Open the /install_dir/install/properties directory.
4. Open the customer_overrides.properties file and add the following database

connection information:
jdbcService.oraclePool.prop_javax.net.ssl.trustStore=/.../path/.../ClientKeyStore.jks
jdbcService.oraclePool.prop_javax.net.ssl.trustStoreType=JKS
jdbcService.oraclePool.prop_javax.net.ssl.trustStorePassword=password
jdbcService.oraclePool.prop_oracle.net.ssl_version=3.0
jdbcService.oraclePool.prop_javax.net.ssl.keyStore=/.../path/.../ClientKeyStore.jks
jdbcService.oraclePool.prop_javax.net.ssl.keyStoreType=JKS
jdbcService.oraclePool.prop_javax.net.ssl.keyStorePassword=password

5. Repeat step 4 for the following Oracle connection pools by changing only the
pool name:
v oraclePool_local

v oraclePool_NoTrans

v oracleArchivePool

v oracleUIPool

If you have any other database pools, you need to add the properties for those
pools.

6. Open the sandbox.cfg file and change the database connection information to
the following value:
ORACLE_JDBC_URL= jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS=(PROTOCOL=tcps)
(HOST=<DB host>)(PORT=<TCPS port as configured in DB config section above>))
(CONNECT_DATA=(SERVICE_NAME=<service name>)))

7. Open the /install_dir/install/activemq/conf directory.
8. Open the activemqconfig.xml.in file and modify the database connection

information:
v Remove or comment out the following default ActiveMQ database

configuration information:
#:ifdef ORACLE
<bean id="gis-ds" class="org.apache.commons.dbcp.BasicDataSource"

destroy-method="close" singleton="true" lazy-init="default"
autowire="default" dependency-check="default"

SCIOverrideName="persistence-bean">
<property name="driverClassName">
<value>oracle.jdbc.driver.OracleDriver</value>
</property>
<property name="url">
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#:ifdef ORACLE_JDBC_URL
<value>&ORACLE_JDBC_URL;</value>
#:else
<value>jdbc:oracle:thin:@&ORA_HOST;:&ORA_PORT;:&ORA_DATA;</value>
#:endif
</property>
<property name="username">
<value>&ORA_USER;</value>
</property>
<property name="password"><value>&ORA_PASS;</value>
</property>
<property name="maxActive"><value>32</value>
</property>
</bean>
#:endif

v Add the following ActiveMQ database configuration information:
<bean id="gis-ds"
class="oracle.jdbc.pool.OracleDataSource" destroy-method="close"
singleton="true" lazy-init="default" autowire="default"
dependency-check="default">
<property name="URL"><value>&ORACLE_JDBC_URL;</value></property>
<property name="user"><value>&ORA_USER;</value></property>
<property name="password"><value>&ORA_PASS;</value></property>
<property name="connectionProperties"><value>
javax.net.ssl.trustStore: /.../path/.../ClientKeyStore.jks
javax.net.ssl.trustStoreType:JKS
javax.net.ssl.trustStorePassword:password
oracle.net.ssl_version:3.0
javax.net.ssl.keyStore: /.../path/.../ClientKeyStore.jks
javax.net.ssl.keyStoreType:JKS
javax.net.ssl.keyStorePassword: password
driverClassName:oracle.jdbc.driver.OracleDriver
maxActive:32
</value>
</property>
</bean>

9. Enter the command ./setupfiles.sh.
10. Restart Sterling B2B Integrator. All the database connections from Sterling B2B

Integrator are now connected through TCPS (encrypted) mode.

Configuring the Microsoft SQL Server Database:

Before you install Sterling B2B Integrator with the Microsoft SQL Server database,
you must configure the database.

Before you begin

v If you are reinstalling the software, be aware that data in your existing database
is deleted. To preserve your data, either back up the existing database or save it
under a different name.

v After you create and configure your database, recycle the database. Then, stop
and restart to apply the changes.

About this task

Use the following checklist to configure Microsoft SQL Server for Sterling B2B
Integrator:
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Item
Microsoft SQL Server Database
Configuration Checklist Your Notes

1 If you do not have Microsoft SQL
Server installed, follow the installation
procedures in the SQL Server
installation manual.

Refer to the Microsoft SQL Server
documentation on creating the
database, including creating a schema
repository, login, and table space.

Be sure to install the correct version
and patches.

See System Requirements for supported
version information.

3 “Microsoft SQL Server database
parameters” on page 16

4 “Microsoft SQL Server database user
privileges” on page 16

5 “Configuring the snapshot feature for
Microsoft SQL Server” on page 18

Microsoft SQL Server database user privileges:

In Microsoft SQL Server, you must grant DBO (Database Owner) permission to the
user. The DB_DDLADMIN role is required for creating objects in the SQL Server
database.

Microsoft SQL Server database parameters:

When you install Sterling B2B Integrator with the Microsoft SQL Server database,
you must set certain Microsoft SQL Server parameters. Other Microsoft SQL Server
parameter settings are recommended for the efficient performance of Sterling B2B
Integrator.

When you install Sterling B2B Integrator with Microsoft SQL Server, you must set
the Microsoft SQL Server parameters that are listed in “Mandatory settings for
Microsoft SQL Server” on page 17.

After you install Sterling B2B Integrator with Microsoft SQL Server, you can
improve the database performance by setting the recommended parameters that
are listed in the performance documentation for the following items:
v Instance-specific settings for Microsoft SQL Server
v Database-specific settings for Microsoft SQL Server

Mandatory settings for Microsoft SQL Server:

The default collation of Microsoft SQL Server must match the collation for the
Sterling B2B Integrator database to prevent collation conversions.

The tempdb database that is used by Microsoft SQL Server must be created with the
same collation as the default collation of Microsoft SQL Server. The Microsoft SQL
Server uses the tempdb database for results that are too large to fit in memory.
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If the collations of the tempdb database and the Sterling B2B Integrator database
differ, the database engine must convert from the Sterling B2B Integrator collation
to the tempdb collation, and then back again before it sends the results to the
Sterling B2B Integrator server. These conversions might lead to severe performance
issues.

The collation that is required for the Sterling B2B Integrator database is a collation
that most closely matches the character set used by Java. By using this collation,
you can avoid character data conversions before the data is stored in the database
tables. Use the mandatory parameter that is described in the following table when
you configure the collation setting:

Parameter Value

Database Collation SQL_Latin1_General_CP850_Bin

Additionally, you must perform these tasks:
v Allow Microsoft SQL Server to manage memory dynamically (default).
v Disable any antivirus software that is running on the Microsoft SQL Server

data, transaction log, and binary files directory.

Installing the JDBC driver in Microsoft SQL Server:

The use of a SQL Server database with Sterling B2B Integrator requires the
installation of a JDBC driver.

About this task

Sterling B2B Integrator requires the correct Microsoft SQL Server driver. See the
System Requirements for the supported version information.

Download the driver and any appropriate patches from the Microsoft website.

Procedure

To install the JDBC driver in Microsoft SQL Server:
1. Download the sqljdbc_version_language.tar.gz file to a temporary directory.
2. To unpack the compressed TAR file, open the directory where you want the

driver unpacked and type the following command:
gzip -d sqljdbc_version_language.tar.gz

3. To unpack the TAR file, open the directory where you want the driver installed
and type the following command:
tar –xf sqljdbc_version_language.tar

After the package unpacks, you can find out more information about using this
driver by opening the JDBC Help System in the /absolutePath/
sqljdbc_version/language/help/default.htm file. This file displays the help
system in your web browser.

4. When the Sterling B2B Integrator installation asks for the location of the JDBC
drivers, specify the extracted JAR file created after you unpack the archive,
which is usually named sqljdbc.jar. The JDBC driver version is the same as
the version of the drivers that are downloaded from Microsoft.
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Configuring the snapshot feature for Microsoft SQL Server:

The snapshot feature in Microsoft SQL Server allows you to view a read-only copy
of the database even when it is locked. Configuring the snapshot feature can also
reduce deadlocks. To enable the snap shot feature, enter the following command:
ALTER DATABASE db_name SET READ_COMMITTED_SNAPSHOT ON;

Configuring the MySQL Database:

You can use a MySQL database for maintaining information on Sterling B2B
Integrator. Only non-clustered installations of Sterling B2B Integrator can use the
MySQL database.

MySQL is case-insensitive for searches with string values. For example, the search
results will be the same when you search for users 'Admin' and 'admin'. As a
result, it impacts searches for maps, business processes, services, mailboxes, user
names, and other data stored in the database.

Use the following checklist to configure the MySQL database for Sterling B2B
Integrator:

# MySQL Database Configuration Checklist Your Notes

1 Install MySQL database.

Refer to MySQL documentation for information about
installing the MySQL database. Be sure to install
correct version and patches.

See System Requirements for supported version
information.

2 Set the MySQL Parameters.

3
Create the database.

For example, you can run the following command to
create the database:

CREATE DATABASE database_name

Refer to MySQL documentation for more information
about creating the database.

4 Create a user account and grant permissions.

5 Install the JDBC Drivers for MySQL.

If you need additional MySQL database information, see the documentation
provided by the vendor at http:////dev.mysql.com/doc/refman/5.0/en/.

Update the MySQL Parameters: Sterling B2B Integrator requires the following
parameter settings in your MySQL database.

The parameter values recommended are minimum values. You can increase the
values based on your requirements or if the database server is used by more than
one instance of Sterling B2B Integrator.

It is recommended to configure a data file for auto extension
(innodb_data_file_path = ibdata1:400M:autoextend).
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Parameter Value

max_connections 500

max_allowed_packet 100M

default-table-type INNODB

wait_timeout 31536000

max_write_lock_count 500000

transaction-isolation READ-COMMITTED

character-set-server utf8

binlog_format mixed

table_open_cache 512

key_buffer_size 384M

sort_buffer 512K

connect_timeout 15

innodb_data_file_path ibdata1:400M:autoextend

innodb_data_home_dir /install_dir/mysql/var/

innodb_log_group_home_dir /install_dir/mysql/var/

innodb_flush_log_at_trx_commit 1

innodb_mirrored_log_groups 1

innodb_log_files_in_group 3

innodb_file_io_threads 4

innodb_lock_wait_timeout 600

innodb_log_file_size 5M

innodb_log_buffer_size 8M

innodb_buffer_pool_size 128M

innodb_additional_mem_pool_size 32M

Review the innodb_buffer_pool_size and the innodf_additional_mem_pool_size in
the /install_dir/install/mysql/data my.cnf. If the values from the previous Sterling
B2B Integrator tuning.properties are larger than what is in your new my.ini file,
you need to adjust them accordingly.

Install the JDBC Drivers for MySQL:
About this task

Sterling B2B Integrator requires appropriate JDBC driver for MySQL database.
These drivers are platform independent and architecture independent drivers. See
System Requirements for supported version information.

After obtaining the correct JDBC driver, record the absolute path to its location on
your system. You must supply this absolute path when installing Sterling B2B
Integrator.

Create User Account and Grant MySQL Database User Privileges:
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About this task

You must grant all privileges on the MySQL database to the Sterling B2B Integrator
administrative user. The following example creates and grants all privileges to the
user in the MySQL database:
GRANT ALL PRIVILEGES ON database_name.* TO user@localhost IDENTIFIED BY 'password’
WITH GRANT OPTION

Where:
v database_name - refers to the name of the database created.
v user - refers to the database user account that will be used by Sterling B2B

Integrator.
v password - refers to the password associated with the database user account.

Once you have granted all the privileges, you will need to FLUSH the privileges to
complete the setup. For example, run this command from the SQL prompt:
FLUSH PRIVILEGES;

Managing Database Passwords:

A password is used by the system to connect to its database. The password is
stored as clear text in a system property file.

If the security policies at your company require you to encrypt these passwords,
you can do so after you install the system. Encrypting these passwords is optional.

Database passwords encryption methods:

Database passwords are encrypted with one of two methods: OBSCURED or
ENCRYPTED.

The encryption method is decided by the value of the encryptionPrefix property
in the propertyEncryption.properties or the
propertyEncryption.properties_platform_security_ext file.

Encrypting database passwords:

Use commands to encrypt database passwords.

Procedure

To encrypt the database password:
1. Stop Sterling B2B Integrator.
2. Open the /install_dir/install/bin directory.
3. Enter the command ./enccfgs.sh.
4. Enter the command ./setupfiles.sh.
5. Enter the command ./deployer.sh.
6. Enter the command ./run.sh to start Sterling B2B Integrator.
7. Enter your passphrase.

Decrypting database passwords:

Use properties files and commands to decrypt database passwords.
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Procedure

To decrypt the database password:
1. Stop Sterling B2B Integrator.
2. Open the /install_dir/install/properties directory.
3. Open the sandbox.cfg file.
4. Copy the encrypted password from the database_PASS property.

Use the text that appears after the database_PASS=text. For example, if
database_PASS= OBSCURED:123ABCxyz321, you would copy the text
OBSCURED:123ABCxyz321. (OBSCURED is the encryption method for the password.)

5. Open the /install_dir/install/bin directory.
6. Enter the command ./decrypt_string.sh encrypted_password.

For encrypted_password, use the text that you copied in Step 4. You are
prompted for the system passphrase. After you enter the passphrase, your
decrypted password appears.

7. Open the /install_dir/install/properties directory.
8. Edit the sandbox.cfg file to replace the encrypted password with the

password that was returned in Step 6.
9. You need to decrypt the entries for the YANTRA_DB_PASS and DB_PASS

properties. Repeat Steps 4 - 8 to decrypt these entries. You must also decrypt
any passwords present in the property files. Encrypted passwords typically
exist in the following property files:
v sandbox.cfg

v apservsetup

v jdbc.properties

v jdbc.properties.in

v customer_overrides.properties

v customer_overrides.properties.in

10. Open the /install_dir/install/bin directory.
11. Enter the command ./setupfiles.sh.
12. Enter the command ./deployer.sh.
13. Enter the command ./run.sh to start Sterling B2B Integrator.
14. Enter your passphrase.

Change the MySQL Database Password:
About this task

If you changed the MySQL hostname after installing, you should change the
MySQL database password.

To change the MySQL database password:

Procedure

1. Start the MySQL database. Enter:
./control_mysql.sh start

2. Change the root user password to <new_hostname + old_mysqlport>. For
example:
<absolute path>/mysql/bin/mysqladmin --port=43003

--socket=/tmp/mysql.43003.sock -- user=root --
password=blriedlin0143003

Installing and upgrading (V5.2.6 or later) 241



password “blriedlin01Temp43003”

3. Stop the MySQL database. Enter:
./control_mysql.sh stop

Preparing for Installation
To help ensure a trouble-free installation, you should complete the installation
checklist and understand some concepts.

Installation Checklist for UNIX/Linux Non-Cluster Environment: The
installation checklist contains the items you need to gather and tasks you need to
complete prior to installing Sterling B2B Integrator. The checklist contains:
v Brief descriptions for tasks (detailed procedures are provided after the checklist)
v Information you need to gather to complete the installation

You may want to make a copy of the following checklist and use it to record the
information you collect.

#
Installation Checklist for UNIX/Linux Non-Cluster
Environment Your Notes

1 Review your IBM contract to determine what
software you have licensed. You need to know this
License Information so that you can select the correct
components/features to install.

2 Determine which installation method you are going
to use:

v IBM Installation Manager (Graphical User
Interface)

v IBM Installation Manager (Text Based)

v Silent Installation

3 Decide which type of security certificates you will
use:

v The default self-signed SSL (Secure Sockets Layer)
certificate that is automatically installed.

v A Certificate Authority-related certificate that you
install before installing the software.

4 If you are using an Oracle, Microsoft SQL Server, or
DB2 database, decide if you are going to manually or
automatically apply Database Definition Language
(DDL) Statements (schema) to the database.

5 If you are using an Oracle 11.1 database, you must set
it up for native compilation by allocating space and
by setting the plsql_native_library_dir parameter.

6 Determine if the database password needs to be
encrypted.

7 Record the Hostname on which you plan to install
the software.

8 Record the Directory Name where you plan to install
the software.

9 Record the Login to host machine.

10 Record the Password to the host machine.

11 Record the path to the Installation Manager and the
installation package file name.
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12 Record the path to JDK.

13 Record the path to JCE file.

14 Record the Host IP address.

15 Record the Initial Port Number.

16 Record the System passphase.

17 Record the Database vendor name.

18 Record the Database user name.

19 Record the Database password.

20 Record the Database (catalog) name.

21 Record the Database host name.

22 Record the Path and file name for the JDBC Driver(s).

23 Ensure you have read and write privileges on the
parent installation directory.

License information:

A separate license is required for each Sterling B2B Integrator feature that you
purchased. During installation, you must choose the license files according to what
you purchased. Product licenses do not require an activation key.

IBM assumes customers will only install and use the products they purchased. IBM
reserves the right to inspect installs for compliance at any time.

After the installation finishes, if you determine that you need to modify licenses
files, see “License modifications” on page 58.

Product Licenses for Sterling B2B Integrator

Sterling B2B Integrator Standard and Enterprise Edition includes:
v MESA Studio
v eInvoicing
v Report Services
v all services and adapters not listed below

Sterling B2B Integrator Standard and Enterprise Financial Edition includes
everything listed above plus:
v CHIPS
v SWIFTNet
v NACHA ACH CTX adapter
v FEDWIRE
v Fin Serv XML standard
v FIPS Mode
v Image Cash Letter service
v EBICS
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Security certificates:

You can choose between different security certificates before you install Sterling
B2B Integrator.

Before you begin the installation, you must decide which of the following security
certificates to use:
v The default self-signed SSL (Secure Sockets Layer) certificate that is

automatically generated by the installation.
v A Certificate Authority-related certificate that you generate before you install the

software.

If you install with the default SSL certificate, but you later want to switch to a
CA-related certificate, you can change the certificate with the sslCert property in
the noapp.properties_platform_ifcresources_ext.in file.

Port numbers:

During installation, you are prompted to specify the initial port number.

Use the following guidelines for port numbers:
v A range of 200 consecutive open ports (1025 - 65535) is required for this

installation.

Important: Because of RMI, on occasion, a port number outside the range can
be assigned.

v The initial port number represents the beginning port number in the range.
v Make sure that port numbers in the port range are not used by any other

applications on your system.

After your installation, refer to the /install_dir/install/properties/sandbox.cfg
file for all of the port assignments.

UNIX accounts:

In a UNIX or Linux environment, create one UNIX administrative account on the
host server for all of the installations.

For example, if you want to create a test environment and a production
environment, create one UNIX account on the host server. For more information
about creating UNIX accounts, see your operating system documentation.

Installing the Software
After you have configured the database and prepared your system, you are ready
to install Sterling B2B Integrator.

General UNIX/Linux installation information:

You can install Sterling B2B Integrator on UNIX or Linux as either a new
installation or as an upgrade from a previous version of Sterling B2B Integrator.
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CAUTION:
IBM Sterling B2B Integrator for Financial Services should be installed behind a
company firewall for security purposes. For more information on secure
deployment options, see the Perimeter Server and Security topics in the Sterling
B2B Integrator documentation library .

Installation Scenarios

It is important to review the following installation scenarios:

Scenario Instructions

Version 5.1.x is installed and it needs to be
upgraded to V5.2.6.

See “Upgrading (V5.2.6 or later)” on page
320

Version 5.2.x is installed and it needs to be
upgraded to V5.2.6.

See Applying a fix pack (V5.2.6 or later)

Version 5.2.6 is being installed as the base
release.

Review this document and use the
installation instructions.

Installation Methods

Use one of the following methods to install your system:
v IBM Installation Manager (graphical user interface)
v IBM Installation Manager (response file)

Important: Install and run Sterling B2B Integrator as a non-root user.

General Installation Guidelines

The following are some general installation guidelines:
v Do not create the installation directory manually before the start of the

installation. If you create the installation directory before you begin, the
installation fails. The directory name that is provided during the installation
process is used to create the new installation directory.

v The server on which you are installing must have adequate free disk space.
v install_dir refers to the installation directory where the new software is

installed. Do not use any pre-existing directory name or an old version of the
Sterling B2B Integrator installation directory; other wise, you could inadvertently
overwrite the existing installation.

v parent_install is the directory one level above the install_dir directory.
v Ensure that the parent_install directory has the proper read/write permissions.
v If you need to install more than one instance of Sterling B2B Integrator on the

same server, you must install the second instance in a different directory.
v The directory path to the SI_<build_number>.jar file cannot include any spaces.
v If you are using FTP to copy the files, verify that your session is set to binary

mode.
v If you are using AIX with the DB2 database, the directory path cannot be longer

than 108 bytes.
v The installation program validates the initial port number and confirms that you

have enough disk space for the installation. These port assignments are written
to the /install_dir/install/properties/sandbox.cfg file.
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v If you are using an IPv6 address, see “Guidelines for IPv6 addresses” on page
167.

v If you are installing Sterling B2B Integrator on VMware, provide the IP address
of the virtual machine, and not the IP address of the VMware host. For example,
if 10.251.124.160 is the IP address of the VMware host and 10.251.124.156 is the
IP address of the Windows 2003 server it is hosting, use 10.251.124.156 as the
correct IP address to install Sterling B2B Integrator.

General IBM Installation Manager information:

IBM Installation Manager V1.8.2 is required to install Sterling B2B Integrator on all
supported platforms.

Installation Manager is a Java based multiplatform installation application and
provides a consistent approach across various platforms. It does not rely on
platform-specific installation technology or mechanism.

Installation Manager uses the local Sterling B2B Integrator offering repositories to
install or update Sterling B2B Integrator and its add-on features. It determines the
packages that must be installed and displays them including the products, fix
packs, and interim fixes. It checks that all prerequisites and interdependencies are
met before installing the selected product package and feature sets.

Important: The Uninstall option only unregisters Sterling B2B Integrator from
Installation Manager. The uninstall procedure as described in the related sections
must be performed to completely uninstall Sterling B2B Integrator.

Installation Manager must be installed on each computer on which Sterling B2B
Integrator is being installed. If you already have Installation Manager installed on
your computer for use with other IBM applications, it can be used with installing
Sterling B2B Integrator as long as it's the correct version. If you do not have
Installation Manager installed, it is provided as part of the Sterling B2B Integrator
installation media.

Supported bit-versions

A 64-bit version of IBM Installation Manager V 1.8.2 is provided with the Sterling
B2B Integrator installation package. However, you can also install with a 32-bit
version of Installation Manager.

Before you start the installation, consider the following options:
v If you are a new customer, use the version of Installation Manager that is

provided with the Sterling B2B Integrator installation package and install
Sterling B2B Integrator.

v If you have an earlier version of Installation Manager, you can update it to
V1.8.2 using the Installation Manager that is provided with the installation
package, then install Sterling B2B Integrator .

v If you are a current customer who did not use Installation Manager earlier,
install the version of Installation Manager that is provided with the installation
package, then upgrade your Sterling B2B Integrator installation.

v If you have a 32-bit Installation Manager installed, you must download the
32-bit Installation Manager V1.8.2 from Fix Central or IBM Passport Advantage,
upgrade it, then proceed with the installation of Sterling B2B Integrator. Ensure
you have the required libraries that support screen presentation of the text.
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Checking for updates

To check for Installation Manager updates, select Search for Installation Manager
updates on the File > Preferences > Updates page. When the check box is
selected, Installation Manager searches for updates when any one of the following
pages are opened from the Installation Manager start page:
v Install Packages
v Modify Packages
v Update Packages

Installation Manager also searches for updates when you click the Check for Other
Versions, Fixes, and Extensions button on the Install Packages page.

Starting Installation Manager

You should start the Installation Manager (and also install Sterling B2B Integrator)
as a non-administrator user.

How you start Installation Manager depends on whether you are using the
Installation Manager agent that is provided with Sterling B2B Integrator or if you
have an Installation Manager instance that is installed on your system. It also
depends on whether you have 32-bit or 64-bit Installation Manager.

Open a command prompt and do one of the following tasks to start the
Installation Manager in GUI mode:
v Go to the IM_<operating_system> directory and type ./userinst or userinst.exe

(Windows) for the following scenario:
– If you do not have Installation Manager installed and are using the

Installation Manager agent that is provided with the Sterling B2B Integrator
media.

– If you have a 64-bit Installation Manager installed.
– If you have Installation Manager installed on a platform that has only one

download available for Installation Manager. For example, AIX, Solaris, HP,
zLinux.

v Go to <installation directory>/Installation Manager/eclipse (for Windows
system, replace / with \) and type ./IBMIM or IBMIM.exe if you have 32-bit
Installation Manager installed on a Linux or Windows system.

For information on starting Installation Manager in command mode for silent
installation, see the Installing or updating with a response file.

For information on starting Installation Manager in command mode to record a
response file, see Recording a response file.

Additional heap memory parameters

The heap memory parameters specify the amount of memory Installation Manager
can use during the installation process. The heap memory pool sizes that are used
by Installation Manager are hardcoded defaults. If these defaults are not sufficient
for your environment, you can specify different values by adding parameters to
the Installation Managerconfig.ini file.

Important: These additional parameters are required only if you are experiencing
Out Of Memory errors during the installation process.
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The following parameters can be added:
v memoryMin=user.sb.INSTALL_<OS>_INIT_HEAP.<amount_of_memory>

v memoryMax=user.sb.INSTALL_<OS>_MAX_HEAP.<amount_of_memory>

Where <OS> is your operating system and <amount_of_memory> is the specified
amount of memory.

Operating
System Parameter Example Entry

Sun-Solaris Initial Heap Size

INSTALL_SUN_INIT_HEAP

memoryMin=user.sb.INSTALL_SUN_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_SUN_MAX_HEAP

memoryMax=user.sb.INSTALL_SUN_MAX_HEAP.3072m

Linux Initial Heap Size

INSTALL_LINUX_INIT_HEAP

memoryMin=user.sb.INSTALL_LINUX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_LINUX_MAX_HEAP

memoryMax=user.sb.INSTALL_LINUX_MAX_HEAP.3072m

AIX Initial Heap Size

INSTALL_AIX_INIT_HEAP

memoryMin=user.sb.INSTALL_AIX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_AIX_MAX_HEAP

memoryMax=user.sb.INSTALL_AIX_MAX_HEAP.3072m

HP-UX Initial Heap Size

INSTALL_HPUX_INIT_HEAP

memoryMin=user.sb.INSTALL_HPUX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_HPUX_MAX_HEAP

memoryMax=user.sb.INSTALL_HPUX_MAX_HEAP.3072m

Windows Initial Heap Size

INSTALL_WIN_INIT_HEAP

memoryMin=user.sb.INSTALL_WIN_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_WIN_MAX_HEAP

memoryMax=user.sb.INSTALL_WIN_MAX_HEAP.3072m

Guidelines for IPv6 addresses:

The use of IPv6 addresses in an installation of Sterling B2B Integrator requires
certain guidelines.

Before you use an IPv6 address during an installation, see the IPv6 Capabilities
section in System Requirements.

Consider the following IPv6 address information when you plan the installation:
v If you use an IPv6 address, use a fully qualified address that includes square

brackets around the address, and a zero (0) between colons where there are no
other numbers. For example, use [fe80:0:0:0:213:72ff:fe3c:21bf] instead of
fe80::213:72ff:fe3c:21bf.
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v If you are installing with an IPv6 address, comment out the host name mapping
to the IPv4 address and retain the mapping to the IPv6 address in the host file
in the /etc/sysconfig/networking/profiles/default/hosts directory.

v You must install with a host name, not an IPv6 address, otherwise the
Lightweight JDBC adapter and Graphical Process Modeler (GPM) do not work.

v If you are using an Oracle database, do not use an IPv6 address for the host
name.

v If you are using an IPv6 address and are going to configure Sterling B2B
Integrator as a dual stack host, after you complete the installation, you need to
add the IPv6 address (as the admin_host.3 property) to the
noapp.properties_platform_ifcresources_ext .in file.

Installing or updating with a response file (V5.2.6 or later):

You can install or update (apply fix pack or interim fix) Sterling B2B Integrator
with silent mode by using the sample response files or converting your existing
response file to the required format.

Installing in a UNIX/Linux non-cluster environment using the IBM Installation
Manager in GUI mode:

You can install Sterling B2B Integrator in a UNIX/Linux non-cluster environment
with the IBM Installation Manager in a graphical user interface (GUI) mode. Use
the X Window System for this installation.

Before you begin

v Complete the “Installation Checklist for UNIX/Linux Non-Cluster Environment”
on page 242.

v Install an X Window windowing system (for example Cygwin or Xming) for
UNIX/Linux operating systems on your PC.

v Install and configure a Telnet client (for example PuTTY) for use with the X
Window System. The following parameters must be set:

– X-11 forwarding must be enabled.
– X display location must be set to localhost.

v If you are using the Standards Processing Engine (SPE) application with Sterling
B2B Integrator, you must install SPE before you install Sterling B2B Integrator.

v If you are using the EBICS Banking Server application with Sterling B2B
Integrator, the data encryption for storage within the installation location is not
supported.

v Set the ulimit and language as follows:
– ulimit -n 4096
– ulimit -u 16000
– export LANG=en_US

About this task

To install Sterling B2B Integrator in a Unix/Linux non-cluster environment with
the Installation Manager in GUI mode:

Important: Following is a list of changes related to installing or upgrading to
Sterling B2B Integrator V5.2.6:
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v You can install and upgrade through the user interface or silent installation
mode (response files). Console mode installation and upgrade is not supported.

v Sterling B2B Integrator JAR file is included in the repository. Therefore it is not
required to manually select the JAR file when installing or upgrading.

v You must use Installation Manager V1.8.2 to install or upgrade Sterling B2B
Integrator. InstallService is disabled, and cannot be used. You can use
InstallService, only for a specific scenario related to Sterling File Gateway. For
more information, see step 14.

Procedure

1. Start the X Window System client on your PC.
Minimize the window after it opens.

2. Open a console window and log on to the UNIX/Linux host server where
Sterling B2B Integrator is installed.

3. From the installation media, copy the compressed installation package to a
UNIX/Linux directory on the host where Sterling B2B Integrator is installed.

4. Decompress the installation package on the host server.
5. Open the InstallationManager folder in the directory structure that is created

when the installation package is decompressed. Several
IM_OperatingSystem.zip files are displayed.

6. Decompress the file for your operating system.
v IM_AIX.zip (for AIX)
v IM_HPIA.zip (for HP-UX Itanium)
v IM_Linux.zip (for Linux)
v IM_LinuxPPC.zip (for Linux)
v IM_Solaris.zip (for Solaris)
v IM_Win.zip (for Solaris)
v IM_zLinux.zip (for Linux for System z)

This action creates a new IM_OperatingSystem folder.

Important: Installation Manager V1.8.2 is required to install Sterling B2B
Integrator V5.2.6.

7. Decompress the Common_Repo.zip from the installation package. The action
creates two new folders b2birepo and gmrepo. The IM_OperatingSystem,
b2birepo, and gmrepo folders must be at the same level in a directory.

Important: gmrepo contains the repository file required to install Global
Mailbox. For information about Global Mailbox, see Global Mailbox overview.

8. Open a command prompt and do one of the following tasks to start the
Installation Manager:
a. Go to the IM_<operating_system> directory and type ./userinst for the

following scenarios:
v If you do not have the Installation Manager installed and are using the

Installation Manager agent provided with V5.2.6.
v If you have a 64-bit Installation Manager installed.
v If you have the Installation Manager installed on a platform that has

only one download available for Installation Manager. For example, AIX,
Solaris, HP, zLinux.
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b. Go to <installation directory>/Installation Manager/eclipse and type
./IBMIM, if you have 32-bit Installation Manager installed on your Linux
system.

9. On the Installation Manager home page, click Install.

Important: If IM_<operating_system> and b2birepo directories are not in the
same directory or if you already have Installation Manager installed, then you
get a message saying that there no packages to install or Installation Manager
could not connect to the repositories. You must add the Sterling B2B
Integrator repository files to the Installation Manager repository. For more
information about adding repository files, see Repository preferences.

10. On the Install Packages screen, select IBM Sterling B2B Integrator. This
action selects the versions also. Click Next.

11. Review the license agreement and select the option I accept the terms in the
license agreement.
If you do not accept the agreement, the installation process does not continue.

12. Select the location for the shared resources directory and click Next. This
directory is used by the Installation Manager for the Sterling B2B Integrator
installation and other installations.
The shared resources directory cannot be a subdirectory of the directory for
the installation of Sterling B2B Integrator. The shared resources directory must
be empty.

13. Choose Create a new package group and specify the path to Sterling B2B
Integrator installation directory.

14. Select the required features to be installed. The available options are:
v IBM Sterling B2B Integrator

v IBM Sterling File Gateway

Important: From Sterling B2B Integrator V5.2.6 onwards, Sterling File
Gateway V2.2.6 is automatically installed if IBM Sterling File Gateway is
selected. Any additional post installation tasks are not required to start
Sterling File Gateway. It is strongly suggested to install Sterling File
Gateway when installing Sterling B2B Integrator V5.2.6. If for any reason
Sterling File Gateway is not installed with Sterling B2B Integrator, you
cannot install Sterling File Gateway later using the Installation Manager.
You must use InstallService to install it. For information about installing
Sterling File Gateway by using InstallService, see Installing Sterling File
Gateway (V2.2.6 or later).

v FIPS Module

v AS2 Edition Module

v Financial Services Module

v EBICS Banking Server Module

v B2B Advanced Communications Integration Module

Important: When installing Sterling B2B Integrator, select B2B Advanced
Communications Integration Module to install Sterling B2B Integrator bridge.
Sterling B2B Integrator bridge is required for communication between Sterling
B2B Integrator and B2B Advanced Communications. If you are installing
Global Mailbox and Sterling B2B Integrator, then B2B Advanced
Communications Integration Module (Sterling B2B Integrator bridge) is
installed by default, because Global Mailbox uses the storage module of B2B
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Advanced Communications. However, you must configure the adapter
containers and adapters for Sterling B2B Integrator bridge after installing.

Important: Sterling B2B Integrator is selected by default. Select only the
licenses and features that were defined by your IBM contract. If you are
unsure which to select, the installation can proceed without a selection and
complete successfully. Startup and operation of the software, however,
requires one of the licenses to be selected. See “License modifications” on
page 58 to apply licenses after the installation.

Important: You must manually install the EBICS client. For more information
about installing the EBICS Client manually, see the EBICS Client User Guide.

15. Type the path to your JDK directory and click Next.
16. Specify the configuration for the features to install and click Next.

v FIPS Compliance Mode (Must enable FIPS Module)

v NIST 800-131a Compliance Mode

– off (default value)
– strict

v SPE Integration Module (Requires pre-install of SPE, WTX optional)

If you select the SPE option, you are prompted for the following
information:
– SPE installation directory
– (Optional) WebSphere Transformation Extender (WTX) installation

directory
– SPE UI port
For more information, see the documentation for the integration of Sterling
B2B Integrator and SPE.

17. Type the path to the JCE policy file and click Next.
18. Enter the following server location information and click Next:

a. Type the explicit IP address or host name for the server or use the default
value of localhost.

b. Type the initial port number or use the default value of 8080.
19. Enter the system passphrase information and click Next:

a. Type a passphrase.
b. Confirm the passphrase.

20. Type the email information and click Next:
a. Type the email address to which you want system alert messages sent.
b. Type the SMTP mail server (IP address or host name) that you want to use

for system alert messages and other administrative notices.
21. Enter the following database information and click Next.

a. Select the database vendor that you want to use:
v Oracle
v Microsoft SQL Server
v DB2
v MySQL

b. Select all of the following options that apply to this installation:
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Choices: Action

(Not for MySQL) This installation is for a
cluster node 2 or higher

Do not select this option because this
installation is a non-cluster installation.

(Not for MySQL) Apply database schema
automatically?

The default is to automatically apply the
DDL (Data Definition Language) statements
that apply the database schema.

If you want to manually create the database
schema, then clear the Apply database
schema automatically check box and
continue with the remaining installation
steps.
Important: If you manually apply the
schema, the installation stops without error
later in the installation process so that you
can manually apply the schema.

22. Type the following database connection information. Do not click Next until
you configure the JDBC driver in the next steps.
v User name
v Password (and confirmation)
v Catalog name
v Host
v Port

23. Select a JDBC driver or drivers and click Next:
a. Click Add to browse to the file location for the appropriate JDBC driver or

drivers:
v (Oracle, Microsoft SQL Server, and MySQL only) Absolute path and file

name for one JDBC driver file.
v (DB2 only) Absolute paths and file names for two JDBC driver files. Use

the Type-4 JDBC driver. This type of driver converts JDBC calls into the
network protocol that is used directly by DB2, allowing a direct call
from the system to the DB2 server.

b. Click Test to confirm that the driver is supported for the database and
Sterling B2B Integrator.

Tip: Make sure that you select the driver path in the Database driver field
before you click Test.
The Installation Manager must successfully validate the connection to the
database before you can continue with the installation. If there is a
validation failure, you can view the system log to determine more
information about the failure. Perform the following tasks:
1) Open the user’s application directory: local_path/IBM/Installation

Manager/logs

2) Open theindex.xml file in a browser.
3) Identify the log file that is based on the time stamp of when you

started the installation.
4) Click the installation file to view a listing of errors that occurred

during that installation.
24. Determine which of the following options apply to this installation. Select the

applicable options and click Next:
v Verbose install?
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v This installation is an upgrade from a prior version

Do not select this option because this installation is a new installation.
25. Determine what performance configurations apply to this installation and

click Next. Accept the default value or type the appropriate value.
v Number of Processor Cores

v Physical Memory (MB) allocated to Sterling B2B Integrator

26. Review the installation package summary information. Click Install to apply
your installation settings to the installation.
If you did not select the option to automatically apply the database schema,
the installation stops and you must perform these additional steps to complete
the installation with manual DDL statements:
a. Open the installation directory.
b. Locate the InstallSI.log file and open it with a file editor.
c. Search the file for these error messages:
v <SI_Install>/repository/scripts/EFrame_IndexAdds.sql must be

applied to the database.

v <SI_Install>//repository/scripts/EFrame_Sequence.sql must be
applied to the database.

v <SI_Install>//repository/scripts/EFrame_TableChanges.sql must be
applied to the database. Exiting installation..."

Important: If you do not find these error messages in the log file, the
installation failed because of another reason and you must resolve that
error and attempt the installation again. If you find these messages,
continue with the remaining steps.

d. Edit each .sql script for the database. These changes might include
changing the SQL delimiter or adding table space options.

e. Log in to the database as the database schema user.
f. Run the following SQL files manually in this order:

Important: When you are running the scripts, you must run the SQL
scripts in the specified order.
v EFrame_IndexDrops.sql

v EFrame_TableChanges.sql

v EFrame_IndexAdds.sql

v EFrame_TextIndexAdds.sql

v EFrame_Sequence.sql

v EFrame_TextIndexModify.sql

v EFrame_TextIndexUpdates.sql

v EFrame_TextIndexUpgrade.sql

v EFrame_Static.sql

Important: ActiveMQ uses dynamically generated table names that are
based on the name of the installation node. Table generation is not
included in these SQL scripts, but is performed automatically during the
initial start of Sterling B2B Integrator or when a new cluster node is added.
Table generation might fail if security restrictions reduced the Sterling B2B
Integrator database user permissions. To avoid this issue, ensure that the
DBADM role permissions are enabled during the initial startup. If further
issues arise, contact IBM customer support for guidance.
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g. Exit from the database.
h. Open the parent directory of the Sterling B2B Integrator installation

directory.
i. Uninstall the Sterling B2B Integrator offering to clear out the Installation

Manager metadata about the installation, and the delete (or rename as a
backup) the Sterling B2B Integrator installation directory.

j. Restart the installation wizard and provide the same installation options
that you provided before you cleared the Apply database schema
automatically check box. If you have recorded a response file (as suggested
in step 9), you can use the response file to install Sterling B2B Integrator.

The Installation Progress screen indicates which component of the installation
is in process.
A status bar below the Repository Information heading displays the progress
of the component installation. When the installation completes, a large green
circle with a check mark displays with the message The packages are
installed. A link is provided to view the installation log file.

27. Click Finish. The Installation Manager closes and you are returned to your
desktop.
Check the InstallSI.log file to verify that all of the components were
installed properly.

28. If you are using the AIX operating system and are using IPv6:
a. Open the /install_dir/install/properties directory.
b. Add the following value to the sandbox.config file: IPV4STACK=false
c. Open the /install_dir/install/bin directory.
d. Enter the ./setupfiles.sh command.

29. Determine whether you need to apply a fix pack or interim fix to the
installation. For information about fix pack or interim fix installation, see
“Applying a Fix Pack (V5.2.6 or later)” on page 625 and “Applying an interim
fix (V5.2.6 or later)” on page 635.

Validating the Installation
After installing Sterling B2B Integrator, you should validate the installation to
ensure that everything is working according to your needs.

Installation validation checklist:

As part of the installation, you need to run validation tests to ensure that the
software installation was successful.

Complete the following tasks:

# Validate Installation Checklist Your Notes

1 Start Sterling B2B Integrator.

2 Access Sterling B2B Integrator.

3 Validate the installation.

4 Stop Sterling B2B Integrator.

Starting Sterling B2B Integrator in a UNIX/Linux noncluster environment:

After you run the upgrade software, you can start Sterling B2B Integrator.
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Before you begin

If you are starting Sterling B2B Integrator after upgrading the application from
version 5.1.0.4 to 5.2.5, change the values of the following properties in the
centralops.properties file to 600. This action prevents the run.sh command from
timing out before Sterling B2B Integrator starts. The centralops.properties file is
in the install_dir/install/properties directory.
v OpsServer.commandTimeout

v PassPhrase.urlTimeout

Procedure

1. Open the /install_dir/install/bin directory.
2. Enter ./run.sh.
3. Enter your passphrase. The final startup processes run, concluding with the

following message:
Open your Web browser to http://host:port/dashboard

Where host:port is the IP address and port number where Sterling B2B
Integrator is located on your system. Depending on system load, it might take
several minutes for the UI to be ready.

4. Record the URL address so that you can access Sterling B2B Integrator.

Accessing Sterling B2B Integrator:

You can access Sterling B2B Integrator through a web browser.

Procedure

1. Open a browser window and enter the address that is displayed at the end of
the start.

2. On the login page, enter the default user ID and password. The default login is
at an administrative level. One of your first tasks as an administrator is to
change the administrative password and to register other users with other
levels of permission.

Validating the installation with a sample business process:

You can validate the installation by testing a sample business process.

Procedure

1. From the Administration Menu, click Business Process > Manager.
2. In the Process Name field, type Validation_Sample_BPML and click Go!

3. Click execution manager.
4. Click execute.
5. Click Go! The Status: Success message is displayed on the upper left side of

the page.

Stop Sterling B2B Integrator (Hard Stop):
About this task

A hard stop halts the system without waiting for business processes to finish. Hard
stops may result in loss of data in unfinished processes.

To run a hard stop:
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Procedure

1. Navigate to /install_dir/install/bin.
2. Enter ./hardstop.sh.
3. Enter your passphrase.

Stopping Sterling B2B Integrator (Soft Stop):

A soft stop of Sterling B2B Integrator halts the system after all the business
processes finish running.

About this task

v In the user interface, click Operations > System > Troubleshooterand then click
Soft Stop.

v You can soft stop Sterling B2B Integrator from the command-line interface.

For more information about the softstop user interface and command line options,
see the performance management documentation.

Procedure

1. To soft stop from the command-line interface, navigate to the
/install_dir/install/bin directory.

2. Enter the following command:
./softstop.sh

3. Enter your passphrase.

Post-Installation Configuration
After installing Sterling B2B Integrator and validating the installation, you may
need to do additional configuration depending on your system and business needs.

Postinstallation configuration checklist for noncluster environment:

After you install Sterling B2B Integrator, you need to complete some
postinstallation configuration.

Complete the items that are listed in the postinstallation checklist:

# Postinstallation configuration checklist Your Notes

1 Upon installation, several default user accounts
are automatically created to get you started. For
security purposes, the system administrator
should update all default user account passwords
immediately after installation is completed. See
“Changing default user account passwords” on
page 40.

2 If you are using an IPv6 address in a dual stack
configuration, complete the Add the IPv6 Address
for the Dual Stack Configuration.

3 Download Sterling B2B Integrator Tools.

4 Determine whether you need to modify any
property files.
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# Postinstallation configuration checklist Your Notes

5 If you installed Sterling B2B Integrator on the
HP-UX or Solaris operating system with the IBM
Hybrid JDK 1.7 SR5, do the following task:

1. Open the install_dir/install/bin directory.

2. Enter the following command:

./updateXercesJars.sh

6 “Configure a Non-English Environment” on page
47

7 “Configure Browser Settings for a Different
Language” on page 50

Changing default user account passwords:

When you install Sterling B2B Integrator, several default user accounts are
automatically created to get you started. One of the first actions you must take
after installation is to update these accounts with unique passwords, because the
default ones can be known by all Sterling B2B Integrator customers.

About this task

Default user account passwords are preset at installation. For security purposes,
the system administrator should update all default user account passwords
immediately after installation is completed.

Default user accounts are listed below in the same order as they appear in the UI
under Accounts > User Accounts > List All. You can use this table to track the
user accounts you want to update.

User Account Name Update password

MBX_daemon

admin (*)

aft_user (*)

anon

as2_user

commandlineuser

dash_oper (*)

dash_part (*)

dash_prtspon (*)

dash_sponsor (*)

fg_architect

fg_operator

fg_provisioner

fg_sysadmin (*)

gmbx_user

ja_turbine
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User Account Name Update password

jane

jane_doe

joe_employee

joe_manager

joe_supplier

john

sd_buyer

sd_supplier

turbine

ws_buyer

ws_director

ws_employee

ws_finance

ws_hr

ws_manager

ws_purchaser

ws_supplier

(*) denotes a super user

To change the password for a user account, perform the following tasks.

Procedure

1. Log into Sterling B2B Integrator using ID = admin and password = password.
2. Go to Accounts > User Accounts. Under the List section click Go! All default

user account names are listed.
3. Click Edit next to the user account name you want to update the password for.
4. In the New Password and Confirm New Password fields, enter a new, secure

password for this User ID.

Note: Passwords must be at least six characters long.
5. Click Save and Finish.

What to do next

Repeat steps 3 - 5 for all user account names you want to update.

Add the IPv6 Address for Dual Stack Configuration:
About this task

If you are using IPv6 and have Sterling B2B Integrator configured in a dual stack,
you need to add the IPv6 address to the admin host list.

To add the IPv6 address:

Procedure

1. Navigate to the installation directory that contains the noapp.properties file.
2. Open the noapp.properties_platform_ifcresources_ext .in file.
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3. Add following line to the properties file:
admin_host.3=FULL_IPv6_ADDRESS

Where FULL_IPv6_ADDRESS is the IPv6 address of the machine. (Make sure
you surround the IPv6 address with square brackets.)

4. Save and close the file.
5. Run the setupfiles.sh.
6. Start Sterling B2B Integrator.

Download of the Sterling B2B Integrator tools:

After you install Sterling B2B Integrator, you can install tools like the Map Editor
and the Graphical Process Modeler (GPM).

Sterling B2B Integrator includes tools that run on a desktop or personal computer.
After you install Sterling B2B Integrator, you can install the following tools:
v Map Editor and associated standards

Note: The Map Editor requires a 32-bit JDK. This JDK is not provided with the
product download or media. For more information, see System Requirements.

v Graphical Process Modeler (GPM)
v Web Template Designer
v (If licensed) MESA Developer Studio plug-ins, including MESA Developer

Studio Software Development Kit (SDK) and MESA Developer Studio Skin
Editor

v (If licensed) Reporting Services, which require MESA Developer Studio if you
want to use the plug-ins to create fact models and custom reports

Attention: Conflicting IP addresses can cause problems when you download a
desktop tool.

Property files configuration in a UNIX environment: Property files contain
properties that control the operation of Sterling B2B Integrator. For example, the
REINIT_DB property in the sandbox.cfg file controls whether or not a database is
initialized when you install Sterling B2B Integrator.

By modifying the values of these properties, you can customize Sterling B2B
Integrator to suit your business and technical needs. Most property files are in the:
v For UNIX, /install_dir/install/properties directory
v For Windows, \install_dir\install\properties directory

After installing Sterling B2B Integrator, most property files and scripts do not need
any further configuration for basic operation. However, if you want to customize
any specific operations, for example setting a different logging level - you will
need to edit ( or in some cases, create) certain property or .xml files.

Before changing any property files, refer to Working with Property Files
documentation for general information about how to work with Property Files.

Areas where you might need to make specific property files changes after an
installation include:
v LDAP user authentication
v Prevention of cross-site script vulnerabilities
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v Logging configuration
v Process-specific property file settings

Configure a Non-English Environment:

You can install Sterling B2B Integrator in an English or a non-English environment.
The base language for the Configurator can be switched only once.

Use the following checklist to change to a non-English environment:

# Non-English Environment Checklist Your Notes

1 Install the Sterling B2B Integrator Language Pack.

2 Load the Sterling B2B Integrator Language Pack
Factory Defaults.

3 Load the Sterling B2B Integrator Language Pack
translators.

4 Configure Encodings.

5 Configure Locales.

Language Settings: Language settings for Java applications involve both character
sets and encoding:
v A character set is a set of characters (letters, numbers, and symbols such as #, $,

and &) that are recognized by computer hardware and software.
v An encoding is a representation of data in a particular character set. An

encoding set is a group of encodings.

For information about basic and extended encoding sets, see http://
download.oracle.com/javase/1.5.0/docs/guide/intl/encoding.doc.html.

The default encoding set includes:
v UTF-8 (default)
v IS0-8859-1
v ISO-8859-5
v US-ASCII
v ISO_8859-1
v EUC-JP
v UTF-16
v ISO-2022-JP

Sterling B2B Integrator provides two property files that contain supported
encoding sets. These properties files reside in the /install_dir/install/properties
directory.
v encodings.properties – Contains the default encoding set used in the user

interface.
v encodings_large.properties – Contains all supported encoding sets.

You are not limited to the encodings in the encoding.properties file. Sterling B2B
Integrator enables you to configure the encodings properties files to expand the
number of encodings you can use.

Install the Language Pack:
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About this task

Before installing the language pack be sure that you have successfully installed
Sterling B2B Integrator.

To install the Sterling B2B Integrator language pack:

Procedure

1. Insert the language CDs into your CD-ROM drive.
2. Navigate to the directory that is appropriate for your operating system.
v If you are using AIX, open the AIX directory.
v If you are using HP-UX, open the HP directory.
v If you are using Solaris, open the Sun directory.
v If you are using Red Hat Linux, open the Linux directory.
v If you are using SUSE Linux, open the Linux directory.

3. Enter ./setup.bin.

Load the Language Pack Translations:
About this task

Prior to loading the Sterling B2B Integrator Language Pack factory defaults, be sure
that you have successfully completed all instructions in the database chapter.

To load the language pack translation with custom localization literals:

Procedure

1. Run the LocalizedStringReconciler tool in the IMPORT mode from the
/install_dir/install/bin directory. Enter: ./ant.sh -f
localizedstringreconciler.xml import -Dsrc=/install_dir/database/
FactorySetup/XMLS This tool first inserts the value specified in the
<from_language>_<from_country>_ycplocalizedstrings_<to_language>
_<to_country>.properties file present in the /install_dir/database/FactorySetup/
XMLS/<language>_<country> directory into the database.
The basefilename refers to the file present in the /database/FactorySetup/XMLS
directory, for which the translations are to be imported into the database.

2. Verify that your locale settings such as currency, time format, and date are
correct.

Configure Encodings:
About this task

To configure your encoding set:

Procedure

1. Stop Sterling B2B Integrator and wait for shutdown to complete.
2. Navigate to /install_dir/install/properties.
3. Open the encodings_large.properties file.
4. Select the encodings you want to add to the encodings.properties file.
5. Open the encodings.properties.in file.
6. At the end of the encodings.properties.in file, add the encodings you selected

from the encodings_large.properties file. When adding encodings from one file
to the other, first copy the encodings as they appear in the
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encodings_large.properties file. After adding the new encodings, ensure that
the index numbers are consecutive. If the index numbers are not consecutive,
change the index number or numbers as needed. For example, encoding54
cannot follow encoding6. In this example, change encoding54 to encoding7.
The first name in the definition (before the comma) is the name that will
appear in the Sterling B2B Integrator user interface. You can change this name
to make it more descriptive. For example: encoding4 = 819,ISO8859_1 may be
changed to encoding4 = WesternEurope,ISO8859_1. ISO8859_1 is the Java
canonical name and should not be changed.

7. Update the first line in the encodings.properties.in file (numberof). Change
numberof to the number of encodings added to the file. For example, if the
current value is numberof = 6 and you add 5 new encodings, the new value is
numberof = 11.
numberof indicates the total number of encodings located in the file. You must
update numberof to ensure that the encodings you added will be visible in the
user interface.

8. Navigate to /install_dir/install/bin.
9. Enter ./setupfiles.sh.

10. Start Sterling B2B Integrator.

Configure Locale:
About this task

Sterling B2B Integrator runs in any locale that Java supports. If you want to run
the in a non-default locale, then configure your environment to the specific locale
you want to use.

To configure locale (default is English):

Procedure

1. Enter local-a. A list of locales is displayed.
2. Enter export LANG <locale>. Where <locale> is the language, for example to set

the locale to Japanese, locale = ja_JP.
3. Enter export LC_ALL <locale>. Some UNIX shells require the setenv command

instead of the export command.

Configure Browser Settings for a Different Language:

Some browsers and operating systems require additional configuration in order to
correctly render the Sterling B2B Integrator user interface in certain languages.

Use the procedures provided in this section to properly configure a browser to
display the Sterling B2B Integrator user interface in the appropriate language.

Tip: If your browser is unable to display the user interface properly or you see a
mixture of English and another language, this is an indication that the browser is
configured incorrectly. You may also need to install additional fonts on the Sterling
B2B Integrator server.
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Support for other languages:

The Sterling B2B Integrator user interface includes support for several languages.

Attention: Sterling B2B Integrator product code is designed to work with Latin
based English only input. The use of any other type of input might have uncertain
results and is not supported.

The Sterling B2B Integrator user interface includes support for the following
languages:
v French
v German
v Italian
v Japanese
v Korean
v Polish
v Portuguese (Brazilian)
v Simplified Chinese
v Traditional Chinese
v Dutch

Four of these languages involve expanded Unicode character sets:
v Japanese
v Korean
v Simplified Chinese
v Traditional Chinese

The implementation of these languages in your environment might require the
addition of new Unicode fonts on your server:

If... then...

Sterling B2B Integrator is on a server that
already supports these languages

You do not need to install any additional
fonts.

You are installing on a server that is only
setup for the Latin alphabet and you have
users who need to view the Sterling B2B
Integrator user interface in any of the Asian
languages

You need to have the fonts for these
languages installed.

A way to test the implementation of a language is to create a user with one of the
new languages and setup their browser to use that language as it's primary
language. Log in to the system and review the user interface. If you see a mixture
of English and the new language, your configuration is not correct. You need to
verify that the browser is set up correctly and review the fonts that are installed on
the server.

The installation of more fonts/languages on the server should be done in
coordination with your technical support team. Be sure to include a Unicode Sans
Serif font on your server.

Important: While multiple languages are supported, a user account should be
configured to use one specific language to avoid user interface display issues.
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Add a Custom Language Preference Code:
About this task

In order for your browser to display the Sterling B2B Integrator user interface and
address bar text correctly in a foreign language, you must specify the appropriate
language preference code for the browser.

Sterling B2B Integrator supports the following language preference codes:
v de
v en
v en-US
v es
v fr
v it
v ja
v ko
v pt-BR
v zh
v zh-TW
v du

Your browser must be configured to use one of these specific language preference
codes to view the Sterling B2B Integrator user interface.

Note: Most browsers provide a default listing of language preference codes.
However, Sterling B2B Integrator requires the use of the specific codes as listed
here. For example, you cannot use the default German (Germany) [de-DE], you
must use [de].

You may need to add these supported codes as a custom language preference code
in your browser.

Note: The instructions for configuring a browser’s display will differ for each
browser. Refer to your chosen browser’s documentation for specific instructions on
configuring that browser’s display.

The following is an example of how to configure a client machine display for an IE
window.

Procedure

1. Open a browser window.
2. Select Tools > Internet Options.
3. At the bottom of the window under Appearance, click Languages.
4. Click Add to display the Add Language window.
5. In the User defined: text box, enter the appropriate language preference code.
6. Click OK. The added code should display in the Language: listing in the

Language Preference window. An example entry would be, User Defined
[de].

7. (Optional) Move the added language up to be the first one listed if there are
multiple languages listed.
a. Select the newly added language.
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b. Click Move up.
The newly added language should now appear first in the Language
listing.

8. Click OK to save your Language Preference settings.
9. Click OK to close the Internet Options window.

10. Close your browser window.
11. Open a new browser window and access the Sterling B2B Integrator user

interface to verify your changes have been applied.

Change Default Browser Font:
About this task

Some languages require the use of special fonts to properly display the Sterling
B2B Integrator user interface. The client computer must be configured to display
these types of fonts. Each Windows client must be configured appropriately.

Note: The instructions for configuring a browser’s display will differ for each
browser. Refer to your chosen browser’s documentation for specific instructions on
configuring that browser’s display.

The following is an example of how to change the default browser font for an
Internet Explorer (IE) window.

To configure a client machines display for IE:

Procedure

1. Determine which fonts are needed to support your needed language and
verify they are installed on the server.

Note: The installation of additional fonts/languages on the server should be
done in coordination with your technical support team. Be sure to include a
Unicode Sans Serif font on your server.

2. Open an IE browser window.
3. Select Tools > Internet Options.
4. At the bottom of the window under Appearance, click Fonts.
5. From the Language Script drop-down menu, change the Latin based value to

the appropriate script for your needed language.

Note: If your encoding is not available, you may need to install a new
version of Internet Explorer, but make sure you install the appropriate
international options.

6. Select a Webpage font and a Plain text font appropriate for the new language.
A Plain text font is one in which all the characters take up the same amount
of space and is associated with older computer terminals.

Note: If no fonts are listed in the menus, then you need to install fonts
designed for that encoding.

7. Click OK to close the Fonts window.
8. Click OK again to close the Internet Options window.
9. Close your browser window.

10. Open a new browser window and access the Sterling B2B IntegratorSterling
B2B Integrator user interface to verify your changes have been applied.
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Set the Client Character Display:
About this task

To use special characters, such as for various languages, the client computer must
be configured to display these types of characters. In order for Unicode characters
to display correctly in the application, each Windows client must be configured
appropriately.

Note: The instructions for configuring a browser’s display will differ for each
browser. Refer to your chosen browser’s documentation for specific instructions on
configuring that browser’s display.

The following is an example of how to configure a client machine display for an
Internet Explorer (IE) window.

To configure a client machines display for IE:

Procedure

1. Open an IE browser window.
2. Select View > Encoding > Auto-Select.

Clearing Browser and Java Plugin Caches Before Initial Deployment:
About this task

Once the Sterling B2B Integrator is ready for deployment, each user must clear the
browser and Java Plugin caches on their client machines before launching Sterling
B2B Integrator. This requirement applies to all browsers.

To clear the browser and java caches, do the following:

Procedure

1. From the browser menu bar, select Settings > Control Panel > Internet
Options.

2. Select the General tab, and in the Temporary Internet Files panel, click Delete
Files. The Delete Files dialog displays.

3. Check the Delete All Offline Content checkbox. Click OK until the Internet
Properties window closes. The browser cache is cleared.

4. From the Windows start menu, select Settings > Control Panel > Java.
5. Select the General tab, and in the Temporary Internet Files panel, click Settings.

The Temporary Files Settings dialog displays.
6. In the Disk Space panel, click Delete Files. The Delete Temporary Files pop-up

window displays.
7. Click OK until the Java Control Panel window closes.

General Internet Explorer Browser Settings: When using Sterling B2B Integrator
without any customizations, you need to set the General Browser settings for your
Internet Explorer in order to obtain the best browser performance.

Note: This can impact the display of reports and search listings.

To set your general browser settings:
1. From the Internet Explorer menu, select Tools > Internet Options.

The Internet Options window opens to the General tab.
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2. Locate the Browsing history section and click Settings.
The Temporary Internet Files and History Settings window opens.

3. Below Check for newer versions of stored pages: select the Everytime I visit
the webpage option.

4. Click OK to save your changes.
5. Click OK to apply the changes.
6. Close the browser window and re-open it.

The browser is now set to check for updates to pages everytime a page is
accessed rather than relying upon a cached version.

Internet Explorer Security Settings:
About this task

When using Sterling B2B Integrator without any customizations, you need to set
security settings for your Internet Explorer to obtain the best browser performance.

To configure the Internet Explorer security and privacy settings:

Procedure

1. From the Internet Explorer menu, select Tools > Internet Options.
2. Click the Security tab.
3. Select the Web content zone from which Sterling B2B Integrator is accessed.
4. Set the security level to Medium-low.
5. Click Custom Level and set your security settings according to the following

table:

Internet Explorer Security Setting Sterling B2B Integrator

.NET Framework

Loose XAML Enable

XAML browser applications Enable

XPS documents Enable

.NET Framework-reliant Components

Permissions for components with manifests High Safety

Run components not signed with Authenticode Enable

Run components signed with Authenticode Enable

ActiveX Controls and Plugins

Allow previously unused ActiveX controls to run
without prompt

Enable

Allow Scriptlets Enable

Automatic prompting for ActiveX controls Enable

Binary and script behaviors Enabled

Display video and animation on a webpage that
does not use external media player

Disable

Download signed ActiveX controls Prompt

Download unsigned ActiveX controls Prompt

Initialize and script ActiveX controls not marked as
safe for scripting

Prompt
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Internet Explorer Security Setting Sterling B2B Integrator

Run ActiveX controls and plugins Prompt/Enable

Script ActiveX controls marked as safe for scripting Enable

Downloads

Automatic prompting for file downloads Enable

File download Enable

Font download Prompt

Enable .NET Framework setup Enable

Java VM

Java permissions Medium safety

Miscellaneous

Access data sources across domains Enable

Allow META REFRESH Enable

Allow scripting of Internet Explorer web browser
control

Enable

Allow script-initiated windows without size or
position constraints

Enable

Allow webpages to use restricted protocols for
active contents

Prompt

Allow websites to open windows without address
or status bars

Enable

Display mixed content Prompt

Do not prompt for client certificate selection when
no certificates or only one certificate exists

Enable

Drag and drop or copy and paste files Prompt

Include local directory path when uploading files
to a server

Enable

Installation of desktop items Prompt

Launching applications and unsafe files Prompt

Launching programs and files in an IFRAME Prompt

Navigate sub-frames across different domains Enable

Open files based on content, not file extension Enable

Software channel permissions Medium safety

Submit non-encrypted form data Prompt

Use Phishing Filter Disable

Use Pop-up Blocker Disable

Userdata persistence Enable

Websites in less privilged web content zone can
navigate into this zone

Prompt

Scripting

Active scripting Enable

Allow Programmatic clipboard access Prompt

Allow status bar updates via script Enable
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Internet Explorer Security Setting Sterling B2B Integrator

Allow websites to prompt for information using
scripted windows

Enable

Scripting of Java applets Enable

User Authentication

Logon Prompt for user name and password

6. Click OK to save your settings.
7. Click OK to save the new settings and Apply to implement the settings. The

new settings are applied when a new browser window is opened.

System Maintenance
From time to time, you might need to perform system maintenance activities.

These activities might include:
v Performing a Checksum
v Adding or removing a license

System Maintenance: From time to time, you may need to perform system
maintenance activities. These activities might include any or all of the following:
v Performing a checksum
v Modifying the license files

DB Checksum Tool:

A checksum is a simple redundancy check used to detect errors in data. The DB
Checksum tool generates the difference in resource checksum between the default
resource and the latest system resource from the database.

In Sterling B2B Integrator, a verification process compares the checksum between
the existing default resource and the resource that was added after applying a fix
pack or upgrading. The DB Checksum tool, a resource difference tool generates a
granular report of the changes in the system that was not permitted to be set as
defaults.

Performing a checksum:

Use a command to run the DB Checksum tool.

Procedure

To run the DB Checksum tool:
1. Open the /install_dir/install/bin directory.
2. Enter the following command:

./db_checksum_tool.sh [-d] [-i [1 | 2 | 3 | 4 | 5]]
[-r [wfd | map | schema | sii | template]] [-o <output file>] [-g]

Where:
v -d is the mode to dump the difference of resource checksum between the

default resource and latest system resource.
v -i is the resource type integer (optional).
v 1 is WFD.
v 2 is MAP.
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v 3 is SCHEMA.
v 4 is SII.
v 5 is TEMPLATE.
v -r is the resource name (optional). For example, wfd, map, schema, sii, or

template.
v -o is the file name to output all the messages (optional).
v -g is the file name that lists all the ignored resources (optional).
v -h is the help screen.

The DB Checksum tool performs the relevant checksum operation that is based
on the command options and generates the output message.

License modifications:

After the installation finishes, you can modify the software licenses that you
loaded with the AddLicenseSet command.

The AddLicenseSet command is in the bin directory of your UNIX or Windows
installation. After the initial installation, the license files are in the following
directories:
v UNIX - /install_dir/install/properties/licensefiles
v Windows - \install_dir\install\properties\licensefiles
v iSeries - /install_dir/properties/licensefiles

You can add licenses or review the license list from the UI. On the Administration
Menu, click System > B2B Console > Operations > System > Licenses.

AddLicenseSet Command Parameters

Use the AddLicenseSet command to modify a single license file or the entire license
file directory.

To use the AddLicenseSet command, you must do the following:
v Open the bin directory
v Include the absolute path to the license file directory or to a license file

The AddLicenseSet command has the following parameters:

AddLicenseSet Parameter Description

-reload Use this parameter to reload the license files.

This parameter deletes all of the license files from the
database before the new files are loaded. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/
old_licenses

v Windows - \install_dir\install\logs\security\
old_licenses

v iSeries - /install_dir/logs/security/old_licenses
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AddLicenseSet Parameter Description

-upgrade Use this parameter during an upgrade only.

This parameter deletes all of the old license files from the
database and installs the new license files. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/upgrade

v Windows -\install_dir\install\logs\security\upgrade

v iSeries -/install_dir/logs/security/old_licenses

The AddLicenseSet command will check if Sterling B2B Integrator is running. If it
is running, the command will call the Ops server to refresh the license from the
database. If you have any problems with your licenses after running the
AddLicenseSet command, stop and restart Sterling B2B Integrator.

License Modification: Examples:

There are several different ways you can use the AddLicenseSet command to
modify your licenses.

UNIX Examples

From the install_dir/bin directory:

Scenario Command usage (UNIX example)

Reload a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -reload

Reload all of the license files
in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -reload

Upgrade a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -upgrade

Windows Examples

From the install_dir\bin directory:

Scenario Command usage (Windows example)

Reload a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -reload

Reload all of the license files
in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -reload

Upgrade a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -upgrade

Installing and Configuring Perimeter Servers
A perimeter server is an optional software tool for communications management.
A perimeter server can be installed in a demilitarized zone (DMZ). A DMZ is a
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computer host or small network inserted as a neutral zone between a company's
private network and their public network. A perimeter server requires a
corresponding perimeter client.

The perimeter server manages the communications flow between outer layers of
your network and the TCP-based transport adapters. A perimeter server can solve
problems with network congestion, security, and scalability, especially in
high-volume, Internet-gateway environments.

Installation Guidelines for Perimeter Servers with Sterling B2B Integrator: The
installation program installs a perimeter client and a local mode server. The local
mode server is useful for testing purposes or in environments that do not require a
secure solution. However, if you require high-volume, secure connections, you
must install a perimeter server in a remote zone, either a more secure or less
secure network than your integration server.

Consider the following before you install a perimeter server:
v Licensing for a perimeter server is determined by the licensing restrictions on

the corresponding B2B adapters.
v Each perimeter server is limited to two TCP/IP addresses:

– Internal interface is the TCP/IP address that the perimeter server uses to
communicate with Sterling B2B Integrator.

– External interface is the TCP/IP address that the perimeter server uses to
communicate with trading partners. To use additional TCP/IP addresses,
install additional perimeter servers.

v You can have multiple perimeter servers installed on the same computer
interacting with one instance of Sterling B2B Integrator. To install a perimeter
server on a computer with an existing instance, install the new perimeter server
in a different installation directory.

v The combination of internal TCP/IP address and port must be unique for all
perimeter servers installed on one computer.
– If a perimeter server is installed using the wildcard address, then all ports

must be unique. The assigned ports are not available for use by adapters that
use the server or any other perimeter server on that computer.

– The internal and external interface may use the same TCP/IP address.
However, the port used by the perimeter server is not available to the
adapters that use the server.

Perimeter Server Installation Methods: You can install perimeter server either in
silent mode or in interactive mode. The default installation mode is silent. In the
silent mode, you should specify the details in a silent file, whereas in the
interactive mode, you should enter the value each time a prompt appears.

Perimeter Server Information Gathering Checklist: Before you install the
perimeter server, you need to gather the following information and answer the
following questions:

Perimeter Server Information Gathering
Checklist Your Notes

Path to java

Path to the Sterling B2B Integrator
installation directory
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Perimeter Server Information Gathering
Checklist Your Notes

Will this perimeter server be installed in a
less secure network?

TCP/IP address or the DNS address that the
perimeter server will listen on.

Listening port for the perimeter server.

Local port that the perimeter server will use
to connect to Sterling B2B Integrator.

Port number must be higher than 1024.

Perimeter Server Security Vulnerabilities: When Sterling B2B Integrator is
deployed with a remote perimeter server in a more secure network zone, there is a
security vulnerability. An intruder may compromise the host where the proxy
resides, and take over the persistent connection to the perimeter server residing in
the more secure zone. If this happens, the perimeter server will relay all the
intruder's network requests past the firewall into this internal zone.

To prevent an intrusion, limit the activities the remote perimeter server can
perform on behalf of the proxy to specifically those activities that the proxy needs
to do for its operation.

Control these limitations by using a configuration residing in the secure network
zone with the remote perimeter server, inaccessible by the proxy that could become
compromised.

Installing a perimeter server in a less secure network in a UNIX or Linux
environment:

Install a perimeter server in a UNIX or Linux environment in interactive mode.

Procedure

1. Copy the .jar installation files from the installation media to a UNIX/Linux
directory. If you are using FTP to copy the file, make sure that your session is
set to binary mode.

2. Enter: /path_to_java/java -jar /install_dir/install/packages/
ps_filename.jar –interactive

The program verifies the operating system, minimum fix pack level, and the
location and version of the JDK.

3. Enter the full path name of the installation directory.
4. If there is an existing installation in the directory you specify, you can update

it using the same settings. Answer the question:
There is an existing install at that location, update it while keeping
existing settings?

If yes, the installation proceeds without more entries.

Note: If you want to change any of the settings, you must use a new
directory, or delete the old installation before you reinstall the perimeter
server. You cannot overwrite an existing installation, and you cannot use an
existing directory that does not contain a valid installation.

5. Confirm that the installation directory is correct.
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The program verifies the amount of available disk space.
6. Answer the question:

Is this server in a less secure network than the integration server?

Yes

7. Answer the question:
Will this server need to operate on specific network interfaces?

If yes, the program returns a list of the network interfaces available on your
host. Select the interfaces for the server to use.

8. Enter the TCP/IP address or DNS name for the internal interface to use to
communicate with the integration server (Sterling B2B Integrator). Press Enter
to use a wildcard for this address.

9. Verify the TCP/IP address or DNS name for the internal interface.
10. Enter the TCP/IP address or DNS name for the external interface to use to

communicate with trading partners. Press Enter to use a wildcard for this
address.

11. Verify the TCP/IP address or DNS name for the external interface.
12. Enter the port that the perimeter server listens on for the connection from the

integration server (Sterling B2B Integrator). The port number must be higher
than 1024.

13. Verify the port.
When the perimeter server is installed, the following message is displayed:
Installation of Perimeter Service is finished

14. Change to the installation directory.
15. Enter ./startupPs.sh to start the perimeter server.

Installing a perimeter server in a more secure network in a UNIX or Linux
environment:

Install a perimeter server in a more secure network in a UNIX or Linux
environment in interactive mode

Before you begin

v Sterling B2B Integrator must be installed.
v Complete the Perimeter Server information gathering checklist.

Procedure

1. Enter: /path_to_java/java -jar /install_dir/install/packages/
ps_filename.jar –interactive

The installation program verifies the operating system, minimum fix pack
level, and the location and version of the JDK.

2. Enter the full path name for the Sterling B2B Integrator installation directory
and press Enter.
If there is an existing installation in the directory you specify, you can update
it using the same settings. Enter yes, and installation proceeds without more
entries.

3. Enter yes to confirm that the installation directory is correct.
The program verifies the amount of available disk space.

4. Is this server in a less secure network than the integration server, enter no.
This installation is for a more secure network.
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5. Answer the question: Will this perimeter server need to operate on
specific network interface?

v Enter yes to select from a list network interfaces available.
v Enter no.

6. Enter the TCP/IP address or DNS name that the integration server listens on
for the connection from this perimeter server.

7. Enter yes to confirm the TCP/IP address or DNS name.
8. Enter the port that the integration server listens on for the connection from

this server. The port number must be higher than 1024.
9. Enter the local port number that the perimeter server uses for the connection

to the integration server.
The port number must be higher than 1024. Specify a port number of zero for
the operating system to select any unused port.

10. Enter yes to confirm the port number.
After the installation is complete, the following messages are displayed:
Installation of Perimeter Service is finished

To start this Perimeter Server change to the install directory and run
the startup script.

You will also need to configure this server in your integration server
(SI) UI.

Silent Installation Method for an External Perimeter Server: You can install an
external perimeter server using a silent install file. The perimeter server can be
installed on the same machine where you have installed Sterling B2B Integrator or
on a separate machine. It is recommended to install the perimeter server on an
separate machine.

To use the silent installation method, you first create the silent install file and then
you use to complete the installation.

Create the Silent Installation File for an External Perimeter Server:
About this task

Create a silent installation file with the following variables:

Entry Description

INSTALL_DIR (Required) The installation directory that stores perimeter server
files and related directories. This directory must exist prior to
running the silent install.

REVERSE_CONNECT (Optional) Determines if the perimeter server is to be installed in a
more secure network zone. Valid values:

v Y - more secure network zone

v N - less secure network zone

PS_PORT (Required) Determines the perimeter server port to interact with
the system.

PS_SECURE_IF (Required) Determines the TCP/IP address or DNS name for the
internal interface to communicate with the integration server
(Sterling B2B Integrator). You can use a wildcard (*) for this
address.

PS_EXTERNAL_IF (Required) Determines the TCP/IP address or DNS name for the
external interface to communicate with the trading partners. You
can use a wildcard (*) for this address.
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Entry Description

REMOTE_ADDR (Optional) Determines the remote perimeter server address.

(Not required if REVERSE_CONNECT=N)

REMOTE_PORT (Optional) Determines the remote perimeter server port.

(Not required if REVERSE_CONNECT=N)

MAX_JVM_HEAP (Required) Determines the maximum Java heap size allocated to
the JVM.

Installing an external perimeter server with a silent installation file:

Install an external perimeter server with a silent installation file.

About this task

Before you begin, create the silent installation file.

Procedure

1. From the installation media, copy SI.jar to a UNIX/Linux directory.
2. Set up your silent installation file and record its location.
3. Go to your working directory.
4. To start the installation, enter: /absolutePath/bin/java -jar

/install_dir/install/packages/ps_filename.jar -f silent.txt

The installation starts. You can follow the progress of the installation on screen.
The installation program verifies support for your operating system and JDK. It
also verifies that you have enough space for the installation.
When the installation is finished, the system displays the following message:
Installation has completed successfully.

5. Determine whether you must apply any fix packs to the installation. Refer to
Installation Maintenance to install the latest fix pack.

Install a Fix Pack in a Remote Perimeter Server UNIX or Linux Environment:
About this task

Remote perimeter servers are not automatically updated by a fix pack. You must
reinstall the perimeter server using the new perimeter server installation file
supplied with the fix pack.

To update a Remote Perimeter Server:

Procedure

1. Update your installation with the latest fix pack. Obtain the fix pack from the
Support Center web site.

2. Locate your perimeter server fix pack in the /install_dir/install/packages
directory of your installation. Download the file from the Support Center web
site. These files have a name that identifies a version number. For example,
ps_2006.jar.

3. Copy the file to a directory on the remote server.
4. Stop the perimeter server, enter ./stopPs.sh.
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5. To begin the installation, enter : /absolutePath/bin/java -jar filename.jar
-interactive

absolutePath is the directory name where the Java version is installed.
The program verifies the operating system, required patch level, and the
location and version of the JDK.

6. Enter the full path to the installation directory. If you do not want to change
any settings for your perimeter server, specify the same directory where the
remote perimeter server was originally installed.

7. Answer the question:
There is an existing install at that location, update it while keeping
existing settings?

If yes, the installation will proceed without additional entries.

Note: If you want to change any of the settings, you must use a new directory,
or delete the old installation before performing the new installation. You cannot
overwrite an existing installation, and you cannot use an existing directory that
does not contain a valid installation. The existing installation must be Sterling
B2B Integrator 5.0 or later.
When the perimeter server is installed, the following message is displayed:
Installation of Perimeter Service is finished

8. Change to the installation directory.
9. Enter ./startupPs.sh to start the perimeter server.

Grant Permissions for Specific Activities for a Perimeter Server:
About this task

Before you begin:
v Remote perimeter server must be installed for a more secure zone.
v Know what permissions you want to grant
v Understand the content of the restricted.policy file. The first two grant sections

in the restricted.policy file are required for correct perimeter server operation.
Do not modify these sections.

Procedure

1. Install a remote perimeter server, choosing the option for a more secure
network zone.

2. At the installation prompt Is this server in a less secure network than the integration
server?, select No, which is the option for a more secure network zone.

3. Navigate to the perimeter server installation directory.
4. Open the restricted.policy file.
5. Add permission lines for each back-end server that you intend to allow the

proxy to access. There are commented out examples for each type of server.
The first two grant sections are required for correct perimeter server operation.
Do not modify these sections.
For example, you can grant permission to a target FTP Server. In the example,
servers are configured to listen on the following ports: 33001 (for FTP), 33002
(for HTTP), and 1364 (for C:D). These port numbers can be edited.
// To restrict or permit the required Host/Server to communicate with the
PS, update the “ftphost/htttphost/snode” with that of the Server IP and
provide the appropriate PORT number where the Server will listen. //
// For each target FTP Server
// permission java.net.SocketPermission "10.117.15.87:33001", "connect"; //
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Control connection.
// permission java.net.SocketPermission "10.117.15.87:lowPort-highPort",

"connect"; // Passive data connections.
// 10.117.15.87 indicates IP of the FTP Server for which the permission is

granted by PS for communicating with client //
// For each target HTTP Server
//
// permission java.net.SocketPermission "10.117.15.87:33002", "connect";
// 10.117.15.87 indicates IP of the HTTP Server for which the permission

is granted by PS for communicating with client //

// For each target C:D snode
//
// permission java.net.SocketPermission "snode:1364", "connect";
// 10.117.15.87 indicates IP of the Connect Direct Node for which

the permission is granted by PS for communication //

6. In the perimeter server installation directory, there is the perimeter server
settings file called remote_perimeter.properties. Edit it to change the "restricted"
setting to a value of true to turn on restrictions.

7. In the future, any attempt by the perimeter server to access disallowed network
resources will be rejected and logged in the perimeter server log written to the
perimeter server installation directory.

Perform DNS Lookup on Remote Perimeter Server:
About this task

By default, a perimeter server performs DNS lookup in the main server JVM. If
you have limited DNS in your secure area, you can configure the remote perimeter
server to look up trading partner addresses in the DMZ.

To enable DNS lookup, add the following property to
customer_overrides.properties. Set the value to true:

Property Name Description

perimeter.*.forceRemoteDNS=true Forces resolution of DNS names at remote
perimeter server.

Set the value to true to configure remote
perimeter servers to look up trading partner
addresses.

Start Perimeter Servers in UNIX or Linux:
About this task

To start a perimeter server in UNIX or Linux:

Procedure

1. Navigate to the perimeter server installation directory.
2. Enter ./startPSService.sh.

Stop Perimeter Servers in UNIX or Linux:
About this task

To stop a perimeter server in UNIX or Linux:
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Procedure

1. Navigate to the perimeter server installation directory.
2. Enter ./stopPSService.sh.

Using IBM Sterling Gentran:Server for UNIX with Sterling B2B
Integrator
Sterling B2B Integrator has the ability to access information located in Sterling
Gentran:Server for UNIX. You can configure this immediately following the
installation or at a later date.

By configuring Sterling B2B Integrator to run with Sterling Gentran:Server for
UNIX, you can:
v View data from your Sterling Gentran:Server trading partners
v Start or stop Sterling Gentran:Server data managers
v View which data managers are running
v View, search, and track Sterling Gentran:Server Life Cycle event records

The following restrictions apply:
v You must have an UNIX or Linux environment
v You must be using one of the following Sterling Gentran:Server for UNIX

products:
– Sterling Gentran:Server for UNIX with Process Control Manager (PCM)
– Sterling Gentran:Server for UNIX with EC Workbench (ECW)
– Sterling Gentran:Server for UNIX with Advanced Data Distribution (ADD)

Install and Configure Attunity® Data Connect:
About this task

If you want Sterling B2B Integrator to use the trading partner information in your
Sterling Gentran:Server for UNIX, you must install and configure Attunity Data
Connect. The Attunity Data Connect software provides JDBC access to the Gentran
DISAM database fields where the trading partner information is stored.

To install and configure Attunity Data Connect:

Procedure

1. Install Attunity Data Connect 3.3 or later using the installation procedures
provided with the Attunity Data Connect software.

2. Ensure the Attunity Data Connect software runs as expected.
3. Create a new DISAM data source and refresh the Attunity Data Connect

server. See the Attunity Data Connect documentation for the procedure.
4. Locate the following metadata description files in the /install_dir/tp_import/

gentran/disam_mapping directory:

Find this file

Replace this string
$YOUR_DATASOURCE
with ..

Replace this string
$YOUR_GENTRAN with ..

TP_MAST.XML the name of the data source
for your Sterling
Gentran:Server for UNIX
system

the path to the root directory
of Sterling Gentran:Server for
UNIX
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Find this file

Replace this string
$YOUR_DATASOURCE
with ..

Replace this string
$YOUR_GENTRAN with ..

TRADACOM.XML the name of the data source
for your Sterling
Gentran:Server for UNIX
system

the path to the root directory
of Sterling Gentran:Server for
UNIX

ORGANIZATION.XML the name of the data source
for your Sterling
Gentran:Server for UNIX
system

the path to the root directory
of Sterling Gentran:Server for
UNIX

TP_MISC.XML the name of the data source
for your Sterling
Gentran:Server for UNIX
system

the path to the root directory
of Sterling Gentran:Server for
UNIX

5. Run the Attunity Data Connect Dictionary (ADD) Editor.
6. Select the DISAM data source you created in Step 3.
7. Import the metadata description files you updated in Step 4. See the Attunity

Data Connect documentation for the procedure.
8. Verify that the metadata description files are included in the list of tables.
9. Save your changes.

10. Exit the Attunity Data Connect Dictionary (ADD) Editor.

Configure Sterling B2B Integrator To Run with IBM Sterling Gentran:Server for
UNIX:
About this task

To configure Sterling B2B Integrator to run with Sterling Gentran:Server:

Procedure

1. Set the umask to 002 in Sterling B2B Integrator.
2. Is Sterling B2B Integrator installed on a different computer than Sterling

Gentran:Server?
v If No, then continue to Step 3.
v If Yes, then NFS mount the $EDI_ROOT of Sterling Gentran:Server onto the

Sterling B2B Integrator host. Continue to Step 3.
3. Verify that the remote shell (rsh or remsh) is working. If you are unable to use

the rsh/rmesh shell and can only use ssh shell, change the GS_RSHELL
variable located in sandbox.cfg file.

4. Navigate to /install_dir/bin.
5. Stop Sterling B2B Integrator, enter ./softstop.sh.

For more information about the softstop command line options, refer to the
performance management documentation.

Note: If you are in a clustered environment, softstop suspends all the
scheduled business processes. It is recommended to run a hardstop when
stopping individual nodes in a cluster.

6. Enter ./configGSUnix.sh. This command starts the configuration.
7. Press Enter to continue the configuration.
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8. If you currently use Sterling Gentran:Server Life Cycle and want to configure
Tracking and Ops, then you need to enter the following the database
information:
v Database vendor
v Absolute path to the JDBC drivers
v Database user name
v Database password
v Database (catalog) name
v Database host name using either the IP address or name of the computer

where the data base is installed
v Database port number

9. Is Sterling Gentran:Server installed on the same computer as Sterling B2B
Integrator?
v If Yes, enter EDI_ROOT for the local computer and continue with next step.
v If No, enter the host name where Sterling Gentran:Server is installed, and

the EDI root where Sterling Gentran:ServerSterling Gentran:Server is
mounted. Verify the EDI root is installed.

10. Enter the version number for Sterling Gentran:Server.
v Enter 1 for version 5.3.
v Enter 2 for version 6.0.

11. If you want to configure Sterling B2B Integrator to view Trading Partner
Administration, then you need to enter the following Sterling Gentran:Server
database information:
v Absolute path to the JDBC drivers (for example, /attunity_install_dir/java
v Database user name
v Database password
v Database (catalog) name
v Database host name where Attunity Data Connect is installed
v Attunity port number

12. Enter yes and press Enter to continue the configuration. After the installation
completed, the following message is displayed: Deployment to the application
server successful.

13. Enter ./run.sh.

IBM Sterling Gentran:Server for UNIX and Sterling B2B Integrator Migration
Information: When you are migrating maps and setting up processes in Sterling
B2B Integrator from Sterling Gentran:Server for UNIX, Sterling Gentran:Server for
UNIX now displays translation errors, if any, in the envelope segments and does
not process the erroneous envelope segments.

Sterling Gentran:Server for UNIX 6.0 and 6.1 allowed EDI envelope segments (ISA,
GS, ST, SE, GE, IEA, UNB, UNH, UNT, and UNZ) with errors to be processed
successfully. This has been corrected and Sterling Gentran:Server for UNIX now
issues translation errors when using X12 or EDIFACT deenvelope processes. The
functional acknowledgments display the errors in the envelope segments.

The following examples illustrate scenarios where Sterling Gentran:Server for
UNIX allowed successful processing of EDI segments with errors:
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v Sterling Gentran:Server for UNIX did not display an error when the segment
count in the UNT or SE segments did not reflect the correct count of segments in
a transaction.

v Sterling Gentran:Server for UNIX did not display an error when the use of
segment delimiters in the Map Input properties did not match the data. The user
could not specify a delimiter in a map with multiple data files that used
different delimiters. The user had to use the Syntax Record and specify the
positions of the delimiters.

User Documentation
The user documentation is available from an online documentation site on the
web.

Providing the documentation in an online environment allows for frequent updates
of content that is based on user feedback and usability.

If you need a printed copy of the documentation, you can print topics of
information through your Internet browser, or you can download documents in
PDF format, after you add it to a collection on IBM Knowledge Center.

To access the documentation site from within Sterling B2B Integrator or one of its

tools, select the help 
 

icon. The system must reside on a computer that supports
Internet access and an Internet browser.

Improving your access to online documentation:

You can improve your access to online documentation by using several methods.

About this task

After you access the IBM Knowledge Center, you can perform the following tasks:
v Enter a word or phrase and search the entire library for information.
v Move through a hierarchy of contents pages to identify the topic you want to

read or print.
v Print topics by using your browser's Print function.
v Add documents to your collection and download them in PDF format.

Uninstall Sterling B2B Integrator
Before you begin

If you have installed Sterling B2B Integrator software using IIM, then perform
these steps to unregister Sterling B2B Integrator packages from the IIM registry:
v Launch IIM.
v Click Uninstall and select the required Sterling B2B Integrator package (Media,

FixPack, or Interim Fix).
v Confirm and click Uninstall.

About this task

To uninstall Sterling B2B Integrator from a UNIX or Linux environment:
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Procedure
1. Stop Sterling B2B Integrator and wait for shutdown to complete. If you begin

removing files before all business processes and Sterling B2B Integrator are
stopped, you may be unable to remove Sterling B2B Integrator successfully.

2. Back up the file system and database.
This step is optional. However, by backing up the file system and database,
you are ensured that Sterling B2B Integrator is completely recoverable.

3. Remove the installation directory by entering the following command in the
parent directory of your installation directory: rm -rf install_dir

4. If you use an Oracle, Microsoft SQL Server, or DB2 database, these remain
intact even after you remove the Sterling B2B Integrator from the server. If you
no longer want to reference the data, contact your database administrator about
removing unwanted tables and recovering the database space where Sterling
B2B Integrator used to reside.

5. Manually remove the JDK:
a. Navigate into the _uninst subdirectory of your JDK installation directory
b. Enter ./uninstall.sh

6. After you remove Sterling B2B Integrator from the server, you can remove
Eclipse, and any tools that were downloaded to the desktop, including the
following:
v Map Editor and associated standards

Refer to the Map Editor Guide for information about removing the Map
Editor.

v Graphical Process Modeler
Refer to the Graphical Process Modeler Guide for information about removing
the Graphical Process Modeler.

v Web Template Designer
Refer to the Web Extensions Guide for information about removing the Web
Template Designer.

v (If licensed) MESA Developer Studio plug-ins, including:
– MESA Developer Studio Software Development Kit (SDK)
– MESA Developer Studio Skin Editor
Refer to the MESA Developer Studio guide for information about removing
MESA Developer Studio.

v (If licensed) Reporting Services, which requires MESA Developer Studio if
you want to use the plug-ins to create fact models and custom reports.
Refer to the MESA Developer Studio guide for information about removing
Reporting Services.
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Troubleshooting Tips: UNIX/Linux Non-Cluster Environment

Situation Message or Symptom Explanation/Resolution

Installing You encounter errors
or problems during
installation.

Explanation

The installation creates several log files that you can use to
diagnose problems like the failure of an installation.

Resolution

Examine the log files generated during installation:

v ant.install.log (in the install_dir directory)

v install_dir/PreInstallSI.log

Installing When you entered an
absolute path during
installation, a message
indicated that the
command was not
found.

Explanation

You entered an incorrect path. Check the information entered.

Resolution

Enter the correct path.

Installing a desktop
tool or resource

Cannot download any
of the following:

v Map Editor and
associated
standards

v Graphical Process
Modeler

v Web Template
Designer

v (If licensed) MESA
Developer Studio
plug-ins, including:

– MESA Developer
Studio Software
Development Kit
(SDK)

– MESA Developer
Studio Skin
Editor

v (If licensed)
Reporting Services,
which requires
MESA Developer
Studio if you want
to use the plug-ins
to create fact
models and custom
reports.

Explanation

When you install Sterling B2B Integrator, system files are created
that contain an internal IP address. If you install Sterling B2B
Integrator behind a firewall, and your firewall is configured to
accept an external IP address from a client computer, you may not
be able to download the desktop tools and resources. The firewall
will reject the internal IP address from a client residing outside of
the firewall.

Resolution

Modify the system files that contain the invalid IP address. Follow
these steps:

1. Navigate to /install_dir/install/bin.

2. Stop Sterling B2B Integrator.

3. Enter the following command followed by the external IP
address:

./patchJNLP.sh external_IP_address

4. Restart Sterling B2B Integrator.
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Situation Message or Symptom Explanation/Resolution

Installing Memory and ulimit
errors.

Explanation

The installation fails with memory and ulimit errors.

Resolution

v Refer to the Viewing and Editing Performance Configuration Settings
in the Performance Management documentation. Modify your
memory setting accordingly.

v Refer to the Operating System Configuration Checklist and tune the
ulimit settings.

Installing (HP-UX
11.31)

When entering your
email address the @
key is not recognized.

Explanation

The @ key is being mapped to kill or eol, it needs to be mapped to
another character.

Resolution

This resolution only applies to HP-UX 11.31.

Map the @ key to another character.

Note: If you need want to see what the key is mapped to, use the
stty -a command.

e-Invoice Upgrade:
Oracle Add Constraint
Error

When you upgrade
Sterling e-Invoicing
and are using an
Oracle database, if the
upgrade fails with the
error message name is
already used by an
existing object, this
occurs because the
default behavior for
the "drop constraint"
command changed in
Oracle 10.

Explanation

The index that is used to support the constraint is now only
removed if the index was generated by the create constraint
command. The indexes for Sterling e-Invoicing are always
generated from constraints during an install. If you receive this
error during a Sterling e-Invoicing upgrade, it is because of how
the database was restored, the version of Oracle you are using, and
because the Oracle imp command exported the indexes and
constraints separately. There is no way to determine when the imp
command will not add a create index command to the export file if
it was generated by a constraint – but if it does add the command,
the database restore process loses the association of the constraint
and its underlying index. The database script that runs during a
Sterling e-Invoicing upgrade executes two steps: 1. First, it drops
the unique constraint so the next step can redefine it using
additional columns. However, the drop constraint command does
not remove the underlying index if the association with its index
was lost. 2. The next command that redefines this constraint
requires a different index definition, but in this scenario the name
of the index the constraint wants to use already exists, which
causes the name is already used by an existing object error.

Resolution

If you receive this error message, the solution for this problem is to
drop the index and rerun the Sterling e-Invoicing upgrade. The
drop index command you should use is: drop index
UNQ_EINV_CANON
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Situation Message or Symptom Explanation/Resolution

Apply a fix pack or
Upgrade

The
/install_dir/
install/
installed_data
directory is created (if
clustered, on each
node) during an
upgrade or when
applying a fix pack.

This directory can
become very large and
take up needed space
on the file system.

Explanation

The information in this directory is used when applying a fix pack
or upgrading, but is not required afterward. The
deployment/cleanup tasks for the upgrade or fix pack do not
remove this directory.

Resolution

The directory can be manually removed to increase the available
space for the file system:

1. Navigate to /install_dir/install

2. Enter

rm -r installed_data

iSeries Installation (V5.2.6 or later)
You may follow different installation and upgrade scenarios when you install and
upgrade Sterling B2B Integrator in an iSeries environment.

Installation Scenarios

Important: Review the following Sterling B2B Integrator installation and upgrade
scenarios.

Scenario Instructions

Version 5.1.x is installed and it needs to be
upgraded to V5.2.6.

See “Upgrading (V5.2.6 or later)” on page
320

Version 5.2.x is installed and it needs to be
upgraded to V5.2.6.

See Applying a fix pack (V5.2.6 or later)

Version 5.2.6 is being installed as the base
release.

Review this document and use the
installation instructions.

Prerequisite knowledge for installation in the iSeries
environment
The installation of Sterling B2B Integrator requires background knowledge in
different areas.

Before you begin the installation, you must be knowledgeable on the following
topics:
v Application servers
v Database administration
v System Requirements for this release of Sterling B2B Integrator.

Intended audience
This document can be used by different members of your organization.

This document is intended for use by:
v System administrators
v Installation engineers
v Database administrators.
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Assumptions for this guide
The procedures in this guide are accurate as of the publication date and are
specific to this version of the document.

Install the Software

Installation checklist for the iSeries environment:

Use this checklist to install Sterling B2B Integrator in an iSeries environment.

The checklist contains the following information:
v Brief descriptions for tasks (detailed procedures are provided after the checklist)
v Information that you need to gather to complete the installation

When you create a name, such as an account name, permissions name, profile
name, or database name, follow these conventions:
v The first character must be alphabetic
v The remaining characters can be alphanumeric, but it's best to avoid special

characters
v Do not use spaces or apostrophes.

Tip: You might want to make a copy of the following checklist and use it to record
the information you collect.

# iSeries Installation Checklist Your Notes

1 Review your IBM contract to determine what
software you licensed. You need to know this License
Information so that you can select the correct
components/features to install.

2 Use the system requirements to verify that your
system hardware and software meet the
requirements that are specified for this release.

3 For systems with multiple IP addresses, verify that
the IP address on which Sterling B2B Integrator
exists is accessible by any client computer that is
running a browser interface.

Attention: If you do not verify the IP address,
your system might not operate properly after you
install Sterling B2B Integrator. A good test is to ping
the IP address from your iSeries command line.

4 If you are using a non-English environment, confirm
that you are using the appropriate character set.

5 Configure the system to view Sterling B2B Integrator
files by using Windows Explorer.

6 Map a network drive to your working directory.

7 Specify the QCCSID (Coded Character Set) for this
installation.

8 Record the collection name for the database.

9 Record the system passphrase.
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# iSeries Installation Checklist Your Notes

10 Record the administrative email address.

This address is where system alerts messages are
sent.

11 Record the SMTP Server IP address.

This address is where alert messages are sent.

12 Record the Initial Port Number.

13 Record the Hostname (catalog name) on which you
plan to install the software.

14 Determine the host IP address for Sterling B2B
Integrator.

This step is required even if you have only 1 IP
address for your system.

15 Create the Sterling B2B Integrator user profile and
the associated password.

Be sure to record the user password so you can
enter it during installation.

16 Set the JDK for your user profile.

Create a .profile file in the /home directory for your
user profile that will point to the J9 JDK 1.7 64-bit
JDK.

If you have multiple JDKs loaded on your system,
you need to point your user profile to correct
version of the JDK. Verify that your user profile
points to the correct JDK.

17 Verify that your user profile is pointing to a job
queue in a subsystem.

18 Record the path to the Sterling B2B Integrator JAR
file.

The JAR file can exist in any directory on your
system. During installation, you use this directory,
but this directory is not the final directory where
Sterling B2B Integrator exists.

19 Record the directory name where you plan to install
the software.

The Sterling B2B Integrator installation directory
must be a new directory and cannot already exist. A
large subdirectory tree is created under this
directory. During installation, this directory is
referred to as install_dir.

20 Record the path to the Core License file
(Core_License.xml).

21 Download the JCE distribution file.

22 Install the Sterling B2B Integrator software.

The Sterling B2B Integrator installation program automatically sets the umask to
002 during the installation. However, iSeries system administrators should consider

Installing and upgrading (V5.2.6 or later) 289



placing an appropriate umask command such as umask 002 in their global or user
login script because the default of 000 might allow many IFS files to be
world-writable. Consult the IBM iSeries Information Center for more information
on the umask command and customizing your Qshell environment.

License information:

A separate license is required for each Sterling B2B Integrator feature that you
purchased. During installation, you must choose the license files according to what
you purchased. Product licenses do not require an activation key.

IBM assumes customers will only install and use the products they purchased. IBM
reserves the right to inspect installs for compliance at any time.

After the installation finishes, if you determine that you need to modify licenses
files, see “License modifications” on page 58.

Product Licenses for Sterling B2B Integrator

Sterling B2B Integrator Standard and Enterprise Edition includes:
v MESA Studio
v eInvoicing
v Report Services
v all services and adapters not listed below

Sterling B2B Integrator Standard and Enterprise Financial Edition includes
everything listed above plus:
v CHIPS
v SWIFTNet
v NACHA ACH CTX adapter
v FEDWIRE
v Fin Serv XML standard
v FIPS Mode
v Image Cash Letter service
v EBICS

Verification of the system requirements:

Before you begin the installation, verify that your system meets the hardware and
software requirements that are specified for this release.

The hardware requirements that are listed in the System Requirements are the
minimum requirements. Your system requirements might exceed these
requirements if you are running other applications on the same machine as Sterling
B2B Integrator.

The installation strictly enforces the following system requirements:
v Operating system version must match requirement exactly.
v The minimum patch level for the operating system is enforced, but you can

apply higher patch levels.
v JDK version must match requirement exactly.
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v The disk space is a minimum for the installation. The system must be separately
sized to handle whatever load is going to be put on the system.

v Database version must match exactly.
v JDBC driver version supports exact matches and wildcard matches.

If any of these requirements are not met, the installation fails. If the installation
fails, review the installation log for a list of non-compliant items.

Viewing files in an iSeries environment:

In the iSeries environment, you must configure your system to view Sterling B2B
Integrator files with Windows Explorer.

About this task

Use the NetServer component of IBM i to set up file shares that are accessible
through Windows networking. You must set up a file share to a working directory
in your iSeries Integrated File System (IFS).

Mapping a network drive (iSeries):

In the iSeries environment, you must map a network drive to the working
directory for Sterling B2B Integrator.

About this task

For more information, refer to the documentation on the IBM website.

Specifying the QCCSID (iSeries):

In the iSeries environment, you must specify the QCCSID (Coded Character Set)
for Sterling B2B Integrator.

About this task

Refer to the IBM National Language Support Guide for valid coded character sets.
It is recommended that you use the coded character set 037 for the United States
English system.

Procedure

To specify the QCCSID:
1. From an iSeries command line, enter DSPSYSVAL SYSVAL(QCCSID).
2. Determine if the QCCSID set to 65535.
3. If the QCCSID value is set to 65535, then perform one of the following actions:
v Change the CCSID to a specific coded character set.

Enter CHGSYSVAL SYSVAL(QCCSID) VALUE(xxx), where xxx represents your
coded character set and then IPL your iSeries.

v Keep the QCCSID at 65535 and specify a specific CCSID other than 65535
when you create your Sterling B2B Integrator user profile.

4. If the QCCSID value is not set to 65535, continue with the next installation or
upgrade task.
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DB2 database configuration (iSeries):

In an iSeries environment, Sterling B2B Integrator uses the DB2 database that is
included in the IBM i operating system. The installation process creates a new
collection for Sterling B2B Integrator.

Before you install the Sterling B2B Integrator software, you must determine and
record the collection name and the catalog name:
v The collection name is the name of the collection (or library) that contains the

database, journal, and journal receiver for your Sterling B2B Integrator system.
This collection must not yet exist. Example: SIxxdb, where xx represents the
version you are installing.

v The catalog name is the database name of your iSeries system, as defined by the
WRKRDBDIRE command. Generally, this value is the name of your system.

All database files are required to be journaled when those files are being used by
the translator in Sterling B2B Integrator. If your application files are not currently
journaled, and you plan to access these files through Sterling B2B Integrator, refer
to the IBM manuals for instructions on journaling physical files.

Sizing

Database sizing is designed to give you estimates of the database growth and to
help you plan the disk requirements.

Capacity Planning

There are many factors to consider when you are estimating the amount of disk
space that is required for Sterling B2B Integrator. As a result, trying to consider all
growth factors is impractical because the user might not know the answers to
many questions that are required to do a detailed forecast. Over the years, the cost
of disks dramatically decreased, while their capacity and speed increased. How
information system managers order disk capacity also changed from purchasing
disk arrays that are dedicated to a particular database server and project to the
concept of SANS.

Sterling B2B Integrator provides a way to estimate your initial disk requirements.
Adjust your estimates to the confidence that you have in your data estimates when
you are making the final purchase decision. After the initial purchase and
production deployment, track the disk growth for future purchase forecasts.

Tracking and Estimating Future Disk Requirements

Track your actual database storage usage and the number of database records
regularly. Correlating these two metrics helps you plan your future disk
requirements. Moreover, determining the average space that is used for each order
line or shipment line helps you accurately predict your future growth
requirements.

Determination of port numbers (iSeries):

During installation, you are prompted to specify the initial port number.

Use the following port number guidelines:
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v A range of 200 consecutive open ports between 10000 - 65535 are required for
this installation.

v The initial port number represents the beginning port number in the range.
v Make sure that port numbers in the port range are not used by any other

applications on your system.

After your installation, refer to the install_dir/install/properties/sandbox.cfg
file for all of the port assignments.

In an iSeries environment, you can also view the port numbers currently in use on
your system by using one of these methods:
v Select from the iSeries Navigator Network > TCP/IP Configuration >

Connections.

v
Enter WRKTCPSTS on an iSeries command line and select Option 3 (Work with
TCP/IP connection status). Press F14 to sort the port numbers in numerical
sequence.

v
Enter NETSTAT *CNN on an iSeries command line and press Enter. Press F14 to
sort the port numbers in numerical sequence.

Creating a user profile (iSeries):

In the iSeries environment, you must create a user profile for accessing the Sterling
B2B Integrator databases. You use this user profile when you enter the installation
command.

About this task

If your system value QCCSID is set to 65535, then set the CCSID parameter to a
specific coded character set other than 65535 on the CRTUSRPRF command. See the
IBM National Language Support Guide for valid coded character sets. For more
information about creating user profiles, see the operating system documentation .

The job description that is assigned to the user profile must have a job queue
defined that allows at least 10 active jobs. If the maximum number of active jobs is
less than 10, Sterling B2B Integrator does not install correctly. This guideline also
applies to starting Sterling B2B Integrator after the installation.

Setting the JDK for your user profile:

To set the JDK for your user profile, you must create a .profile file in the /home
directory for the user.

Sterling B2B Integrator V5.2.6 or later on iSeries requires the J9 JDK 1.7. Create the
.profile file to set the JDK to J9 JDK 1.7.

Creating a .profile File:

A .profile file includes a pointer to the J9 JDK 1.7 directory that you can use in
Sterling B2B Integrator.
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Procedure

To create a .profile file in an iSeries environment:
1. Log on with the Sterling B2B Integrator user profile.
2. Create a home directory for the Sterling B2B Integrator user profile. From an

iSeries command line, enter MKDIR /home/appuser, where appuser represents the
Sterling B2B Integrator user profile.

3. Type EDTF and press F4.
4. Type /home/appuser/.profile and press Enter. An edit session is displayed.
5. On the first line, type the following command:

export JAVA_HOME=/QOpenSys/QIBM/ProdData/JavaVM/jdk70/64bit

Important: Make sure that there is not a space in the first position of this line.
If there is a space, the system does not recognize the proper JDK and the
installation might fail.

6. Press F2.
7. Press F3.
8. Enter WRKUSRPRF to verify that the Sterling B2B Integrator user profile home

directory is pointing to the /home/appuser directory.
9. Verify that the user id is pointing to the correct JDK:

a. From an iSeries command line, type qsh to enter Qsh mode.
b. Type java –version.
c. Press Enter.

Verify that the information listed reflects the JDK that you are using.

Verifying the user profile job queue requirements (iSeries):

A user profile must point to a job queue in a subsystem that meets certain
requirements.

About this task

Verify that your user profile is pointing to a job queue in a subsystem that meets
the following requirements:
v The subsystem has at least 4 GB (8 GB recommended) of dedicated memory in a

private (non-shared) pool.
v The Max Active (maximum number of threads) parameter is set to at least 2000.

This information can be viewed on the WRKSYSSTS screen and is broken down
by subsystem. If you do not know which system pool your subsystem is defined
to, press F14.

v The maximum jobs in the subsystem are set to *NOMAX.
v The Max Active parameter that is defined in the Job Queue is set to *NOMAX.

Downloading the JCE distribution file:

The Java Cryptography Extension (JCE) is a set of Java packages from IBM that
provides a framework and implementations for encryption, key generation and key
agreement, and Message Authentication Code (MAC) algorithms.
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About this task

If you are installing Sterling B2B Integrator outside of the United States, check to
see if you can get the JCE unlimited strength jurisdiction policy files. The
unlimited strength jurisdiction policy files can be exported only to countries to
which the United States permits the export of higher-level encryption.

Procedure

To obtain the JCE distribution file:
1. Browse to the Unrestricted SDK JCE policy files website.
2. Enter your IBM ID and password. If you do not have an IBM ID, follow the

IBM registration instructions.
3. Click Sign in.
4. Select the Files for Java 5.0 SR16, Java 6 SR13, Java 6 SR5 (J9 VM2.6), Java 7

SR4, and all later releases check box and click Continue.
5. Review your personal information and the license agreement.
6. Select the I agree check box and click I confirm to continue.
7. Click Download now.
8. Save the unrestricted.zip file to your system.
9. Record the directory and the .zip file name. You need this information during

the installation process.

Determining the IP address (iSeries):

The installation of Sterling B2B Integrator on iSeries requires an IP address.

Procedure

To determine the IP address of your iSeries installation:
1. Enter WKRTCPSTS *IFC.

If this command brings up multiple IP addresses, another way to check your IP
address is to ping your catalog name from an iSeries command line. This
method displays the resolved IP address for your system.

2. Record the IP address to use for the Sterling B2B Integrator installation.

Translator requirements (iSeries):

All database files are required to be journaled when they are used by the translator
in Sterling B2B Integrator.

If your application files are not currently journaled, and you plan to access these
files through Sterling B2B Integrator, refer to the IBM manuals for instructions on
journaling physical files.

Untarring the Sterling B2B Integrator File:

The installation of Sterling B2B Integrator requires that you first untar the
installation jar file.
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Procedure

Before you install the Sterling B2B Integrator product that you downloaded, you
must perform the following steps to untar the jar file:
1. After downloading the file, type qsh from an iSeries command line and press

Enter.
2. Type set and press Enter. A list of variables is displayed on the screen. You

are looking for QIBM_CCSID. It will look like QIBM_CCSID=0. Record the value of
this parameter.

3. Type export QIBM_CCSID=819 and press Enter.
4. Change to the directory where the tar file is located.
5. Type set to verify that the QIBM_CCSID parameter is set to 819.
6. Type tar –xvf name.of.tarfile.tar and press Enter.
7. After it has performed the untar, set the CCSID parameter back to the original

value.
8. Type export QIBM_CCSID=0 and press Enter, where the 0 represents the value

in step 2.
9. Type set and press Enter to verify the QIBM_CCSID parameter is set to what it

was in step 2.
10. You need to verify that the untar was successful. At this point you will still be

in the directory where the SI.jar file was untarred. Type jar –tf SI.jar and
press Enter. If you get file names to scroll up on the screen, the untar worked.
If you get the $ prompt back with no additional information, then the untar
was not successful and you will have to untar again.

Results

You are now ready to continue.

Installing in an iSeries environment:

You can install Sterling B2B Integrator in an iSeries environment.

Before you begin

CAUTION:
Sterling B2B Integrator must be installed behind a company firewall for security
purposes. For more information about secure deployment options, see the
security topics in the Sterling B2B Integrator Knowledge Center.

v Complete the “Installation checklist for the iSeries environment” on page 288.
v Download Sterling B2B Integrator and decompress the downloaded file to an

empty directory. Use this directory wherever there is a reference to the
installation source directory in the following instructions.

Important: To decompress the files, see “Untarring the Sterling B2B Integrator
File” on page 295.

v If you are using the EBICS Banking Server application with Sterling B2B
Integrator, the data encryption for storage within the installation location is not
supported.
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About this task

You can use only the batch mode to run this installation. You cannot use the
interactive mode.

Procedure

1. Depending on the location of the installation source directory, choose one of
the following methods to copy the installation JAR file to the iSeries server:
v If the installation source directory is on your computer, copy or FTP the

Sterling B2B Integrator JAR file from the installation source directory to the
absolute path in the IFS root or QOpenSys file system.

v If the installation source directory is in your iSeries, enter the following
command:
cp /qopt/Sterling Integrator.jar absolutePath/Sterling Integrator.jar

Record the absolute path.
2. Copy the instsijar.savf file from the iSeries directory on the installation

source directory to the mapped network drive.
3. Determine whether a save file that is named INSTSIJAR exists in QGPL on

your iSeries server.
v If the INSTSIJAR file exists, clear the save file by entering the command

CLRSAVF FILE(QGPL/INSTSIJAR).
v If the INSTSIJAR file does not exist, enter the command CRTSAVF

FILE(QGPL/INSTSIJAR) to create a save file on your iSeries server.
4. Copy the instsijar.savf file that you copied from the installation source

directory to the save file that is created in QGPL. Enter the following
command:
CPYFRMSTMF
FROMSTMF(’/directory/filename of the savf’/) TOMBR(’/QSYS.LIB/QGPL
.LIB/INSTSIJAR.FILE’) MBROPT(*REPLACE)
CVTDTA(*NONE)

5. Enter the following command to restore the installation objects:
RSTLIB SAVLIB(INSTSIJAR) DEV(*SAVF) SAVF(QGPL/INSTSIJAR) MBROPT(*ALL) ALWOBJDIF(*ALL)

6. Log in to your iSeries using the user profile you created during
preinstallation.

7. Enter the command ADDLIBLE LIB(INSTSIJAR) from an iSeries command line
to add the installation programs to your library list.

8. Enter the command INSTSIJAR and press F4 to prompt the command. The
system displays the list of configuration parameters that are needed to install
Sterling B2B Integrator.

9. Refer to the installation checklist and enter the following configuration
parameters.
v Collection name
v Upgrade from the prior version (default is No, because this installation is a

new installation)
v System passphrase (enter and verify)
v Administrative email address
v IP address for SMTP Server
v TCP/IP port number
v Catalog name
v Host IP address
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v Sterling B2B Integrator user profile
v Sterling B2B Integrator user password
v Full path to the Sterling B2B Integrator JAR file

10. Press Page Down and enter these parameters:
v Full path to the Sterling B2B Integrator installation directory
v Full path to the core license file
v Full path to the JCE distribution file

11. Select License/Features, and enter YES to select:
v Sterling B2B Integrator, Sterling File Gateway, or both
v NIST 800-131a Compliance Mode (choose *OFF or *STRICT)
v FIPS Module
v AS2 Edition Module
v Financial Services Module
v EBICS Banking Server Module
Select only the licenses/features that are defined by your IBM contract. If you
are unsure which to select, the installation can proceed without making a
selection and completes successfully. Startup and operation of the software,
however, requires one of the licenses to be selected. See “License
modifications” on page 58 to apply licenses after the installation.

12. Verify the parameters and press Enter. The installation runs in batch mode.
The installation process takes 2 - 3 hours to complete. The installation time
depends on the size of your iSeries server. Monitor the installation process to
verify that no Java exception errors are generated.
To monitor the progress of the installation, enter the WRKLNK command to view
the log file (gisinstall.log). This file exists in the same directory where you
placed the installation JAR file. In addition to the job that you submitted,
various BCI jobs, command shells, and JVMs appear and disappear in your
batch subsystem. This processing is normal.

13. (Optional, but recommended) Check IBM Fix Central to see if further fix packs
or interim fixes are available. If so, download and install as needed. See
“Installing a fix pack or interim fix” on page 307 for instructions.

What to do next

Check the InstallSI.log file to verify that all of the components were installed
properly.

Installing Sterling B2B Integrator version 5.2.6 on iSeries as a fix pack:

You can install Sterling B2B Integrator V5.2.6 as a fix pack.

Before you begin

To run Sterling B2B Integrator on iSeries, you must have a V7R1 or V7R2 iSeries
operating system with JDK 1.7 installed. Before you apply the fix pack, you might
need to take one of following actions:
v If you are running the Classic JDK, you must move your instance of Sterling B2B

Integrator to a V7R1 or V7R2 iSeries operating system.
Then, update to JDK 1.7 with the UPDATEJDK command. See “Updating your JDK
on iSeries” on page 313.
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v If you are running the J9 JDK 1.6 version on a V6R1 iSeries operating system,
you must move your instance of Sterling B2B Integrator to a V7R1 or V7R2
iSeries operating system.
Then, update to JDK 1.7 with the UPDATEJDK command. See “Updating your JDK
on iSeries” on page 313.

v If you are running the J9 JDK 1.6 version on a V71 iSeries operating system, you
must update to JDK 1.7 with the UPDATEJDK command. See “Updating your JDK
on iSeries” on page 313.

About this task

You must run this installation in interactive mode.

Procedure

1. Download the fix pack from the installation media.
2. Stop the system.
3. Perform a full backup of the installation directory, including all subdirectories.
4. Perform a backup of the database.
5. If you edited any property files, ensure that the associated .properties.in

files have the most current changes. Property files are overwritten with the
contents of the associated .properties.in files during the fix pack installation.

6. Sign on with your user profile and enter QSH (Qshell mode).
7. In QSH, open the /install_dir/bin directory and enter the following

command:
cd /install_dir/bin

8. Enter the following command:
./InstallService.sh path/patch_SI_fix pack_number.jar

where:
path is the fully qualified directory where the fix pack jar resides
fix pack_number is the fix pack number

If the fix pack attempts to modify the database schema and the modification
fails, you receive an error message about the failure. The message provides the
error message code from the database and the SQL command that failed. The
failure information is also logged to the system.log and InstallService.log
files in the /install_dir/install/logs directory.
Attention: Running InstallService.sh removes any previously installed
interim fix to prevent conflicts with what is being installed.

9. Press Enter to continue.
Information about the fix pack is displayed. After the fix pack is applied, the
following message is displayed:
Deployment to application server successful

When the $ is displayed, the fix pack process completes.
10. Start the system.

Validate the Installation

Installation validation checklist:

As part of the installation, you need to run validation tests to ensure that the
software installation was successful.
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Complete the following tasks:

# Validate Installation Checklist Your Notes

1 Start Sterling B2B Integrator.

2 Access Sterling B2B Integrator.

3 Validate the installation.

4 Stop Sterling B2B Integrator.

Starting Sterling B2B Integrator (iSeries):

The startup of Sterling B2B Integrator after installation requires several steps.

Before you begin

If you are starting Sterling B2B Integrator after upgrading from version 5.1.0.4,
change the values of the following properties in the centralops.properties file to
600. This action prevents the start command from timing out before Sterling B2B
Integrator starts. The centralops.properties file is in the install_dir/install/
properties directory.
v OpsServer.commandTimeout

v PassPhrase.urlTimeout

Procedure

To start Sterling B2B Integrator in an iSeries environment:
1. Sign onto iSeries with your Sterling B2B Integrator user profile.
2. Submit a batch job by entering the following command:

SBMJOB CMD(QSH CMD(’umask 002 ; cd install_dir/bin ; ./run.sh’))JOB(SIMAIN)

The job queue to which you submit the command must allow at least 10 active
jobs. If the maximum number of active jobs is less than 10, Sterling B2B
Integrator does not start completely.
To reduce keying errors at startup, create a command language (CL) program
similar to the following example:
PGM
SBMJOB CMD(QSH CMD(’umask 002 ; cd install_dir/bin ; ./run.sh’)) +
JOB(SIMAIN)
ENDPGM

3. Wait for the startup to complete. This process takes 10 - 15 minutes.
Startup creates a spool file. When the startup is finished, open the QPRINT spool
file and check the end of the file for a message about how to connect to
Sterling B2B Integrator. For example, you might see the following type of
message:
Open your Web browser to http://host:port/dashboard

where host:port is the IP address and port number where Sterling B2B
Integrator exists on your system.
Make a note of the address so you can access Sterling B2B Integrator later. It
might take several minutes for Sterling B2B Integrator to be available from the
web browser, even after the URL message is displayed.

4. Optional: To verify that Sterling B2B Integrator started normally and
completely, view the system by using the WRKACTJOB command.
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Verify that the SIMAIN job ended and there are at least four QP0ZSPWP jobs
(of yours) left running in your Sterling B2B Integrator batch subsystem.

5. Prepare your browser to log in to Sterling B2B Integrator. Configure your
browser so that there is direct connection between the web browser and iSeries.
Do not configure the browser to use any proxy server between you and iSeries
(unless it is a requirement of your network).

Accessing Sterling B2B Integrator:

You can access Sterling B2B Integrator through a web browser.

Procedure

1. Open a browser window and enter the address that is displayed at the end of
the start.

2. On the login page, enter the default user ID and password. The default login is
at an administrative level. One of your first tasks as an administrator is to
change the administrative password and to register other users with other
levels of permission.

Validating the installation with a sample business process:

You can validate the installation by testing a sample business process.

Procedure

1. From the Administration Menu, click Business Process > Manager.
2. In the Process Name field, type Validation_Sample_BPML and click Go!

3. Click execution manager.
4. Click execute.
5. Click Go! The Status: Success message is displayed on the upper left side of

the page.

Stopping Sterling B2B Integrator (iSeries):

Stopping Sterling B2B Integrator on iSeries requires several steps.

Procedure

To stop Sterling B2B Integrator in an iSeries environment:
1. Sign on to iSeries with your Sterling B2B Integrator user profile.
2. Enter the following commands:

QSH
cd /install_dir/bin
./hardstop.sh

To reduce keying errors at shutdown, create a command language (CL)
program similar to the following example:
PGM
QSH CMD(’cd /install_dir/bin ; ./hardstop.sh’)
ENDPGM

3. Wait for shutdown to complete.
The length of this process is determined by how many temporary objects must
be cleaned up and how many spool files must be created.
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To ensure that you do not restart Sterling B2B Integrator before shutdown is
complete, monitor shutdown through either the ps command in Qshell or the
WRKACTJOB display. Verify that the five QP0ZSPWP jobs are complete and
disappear.

4. Enter the ./stopDAVServer.sh command to stop the WebDAV server.

Post Installation Configuration

Postinstallation configuration checklist in an iSeries environment:

After you install Sterling B2B Integrator on iSeries, you must configure several
items.

After you install Sterling B2B Integrator, you need to complete some
postinstallation configuration. Complete the items that are listed in the
postinstallation configuration checklist:

Item Postinstallation Configuration Checklist Your Notes

1 Upon installation, several default user accounts
are automatically created to get you started. For
security purposes, the system administrator
should update all default user account passwords
immediately after installation is completed. See
“Changing default user account passwords” on
page 40.

2 Download Sterling B2B Integrator tools.

3 Determine if you need to modify any property
files.

4 Change the Network Interface Bindings.

5 “Support for other languages” on page 50

Changing default user account passwords:

When you install Sterling B2B Integrator, several default user accounts are
automatically created to get you started. One of the first actions you must take
after installation is to update these accounts with unique passwords, because the
default ones can be known by all Sterling B2B Integrator customers.

About this task

Default user account passwords are preset at installation. For security purposes,
the system administrator should update all default user account passwords
immediately after installation is completed.

Default user accounts are listed below in the same order as they appear in the UI
under Accounts > User Accounts > List All. You can use this table to track the
user accounts you want to update.

User Account Name Update password

MBX_daemon

admin (*)

aft_user (*)

anon
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User Account Name Update password

as2_user

commandlineuser

dash_oper (*)

dash_part (*)

dash_prtspon (*)

dash_sponsor (*)

fg_architect

fg_operator

fg_provisioner

fg_sysadmin (*)

gmbx_user

ja_turbine

jane

jane_doe

joe_employee

joe_manager

joe_supplier

john

sd_buyer

sd_supplier

turbine

ws_buyer

ws_director

ws_employee

ws_finance

ws_hr

ws_manager

ws_purchaser

ws_supplier

(*) denotes a super user

To change the password for a user account, perform the following tasks.

Procedure

1. Log into Sterling B2B Integrator using ID = admin and password = password.
2. Go to Accounts > User Accounts. Under the List section click Go! All default

user account names are listed.
3. Click Edit next to the user account name you want to update the password for.
4. In the New Password and Confirm New Password fields, enter a new, secure

password for this User ID.

Note: Passwords must be at least six characters long.
5. Click Save and Finish.
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What to do next

Repeat steps 3 - 5 for all user account names you want to update.

Download of the Sterling B2B Integrator tools:

After you install Sterling B2B Integrator, you can install tools like the Map Editor
and the Graphical Process Modeler (GPM).

Sterling B2B Integrator includes tools that run on a desktop or personal computer.
After you install Sterling B2B Integrator, you can install the following tools:
v Map Editor and associated standards

Note: The Map Editor requires a 32-bit JDK. This JDK is not provided with the
product download or media. For more information, see System Requirements.

v Graphical Process Modeler (GPM)
v Web Template Designer
v (If licensed) MESA Developer Studio plug-ins, including MESA Developer

Studio Software Development Kit (SDK) and MESA Developer Studio Skin
Editor

v (If licensed) Reporting Services, which require MESA Developer Studio if you
want to use the plug-ins to create fact models and custom reports

Attention: Conflicting IP addresses can cause problems when you download a
desktop tool.

Properties files configuration in an iSeries environment:

Properties files contain properties that control the operation of Sterling B2B
Integrator.

For example, the REINIT_DB property in the sandbox.cfg file controls whether a
database is initialized when you install Sterling B2B Integrator.

By modifying the values of these properties, you can customize Sterling B2B
Integrator to suit your business and technical needs. Most properties files are in
the install_dir/install/properties directory.

After you install Sterling B2B Integrator, most properties files and scripts do not
need any further configuration for basic operation. However, if you want to
customize any specific operations, for example a different logging level, you need
to edit (or in some cases, create) certain property or .xml files.

Before you change any property files, see the properties file documentation for
general information about how to edit properties files.

You might need to make specific properties files changes after an installation in the
following areas:
v LDAP user authentication
v Prevention of cross-site script vulnerabilities
v Logging configuration
v Process-specific property file settings
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Changing the network interface bindings:

To increase the security of the Administrator Console user interface, Sterling B2B
Integrator binds only to specific network interfaces.

About this task

After installing, if the URL returns the error message Page cannot be displayed,
you can adjust the property settings to correct the problem.

Procedure

To change the network interface bindings:
1. On the server where Sterling B2B Integrator resides, edit the

noapp.properties_platform_ifcresources_ext.in file.
2. Locate the admin_host parameter:
v Where hostname1 is the name of primary network interface, which is the one

given highest priority by Sterling B2B Integrator.
v Where localhost is the name of the network interface on the server where

Sterling B2B Integrator resides.
admin_host.1 = hostname1

admin_host.2 = localhost

3. If no interface is being displayed, edit hostname1 so that it correctly identifies
the primary network interface that accesses Sterling B2B Integrator.

4. If an additional network interface needs to access Sterling B2B Integrator, add
an additional admin_host entry. For example:
v admin_host.1 = hostname1

v admin_host.2 = localhost

v admin_host.3 = hostname2

5. Stop Sterling B2B Integrator.
6. Open the install_dir/install/bin directory.
7. Enter the setupfiles.sh command.
8. Restart Sterling B2B Integrator.

Support for other languages:

The Sterling B2B Integrator user interface includes support for several languages.

Attention: Sterling B2B Integrator product code is designed to work with Latin
based English only input. The use of any other type of input might have uncertain
results and is not supported.

The Sterling B2B Integrator user interface includes support for the following
languages:
v French
v German
v Italian
v Japanese
v Korean
v Polish
v Portuguese (Brazilian)
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v Simplified Chinese
v Traditional Chinese
v Dutch

Four of these languages involve expanded Unicode character sets:
v Japanese
v Korean
v Simplified Chinese
v Traditional Chinese

The implementation of these languages in your environment might require the
addition of new Unicode fonts on your server:

If... then...

Sterling B2B Integrator is on a server that
already supports these languages

You do not need to install any additional
fonts.

You are installing on a server that is only
setup for the Latin alphabet and you have
users who need to view the Sterling B2B
Integrator user interface in any of the Asian
languages

You need to have the fonts for these
languages installed.

A way to test the implementation of a language is to create a user with one of the
new languages and setup their browser to use that language as it's primary
language. Log in to the system and review the user interface. If you see a mixture
of English and the new language, your configuration is not correct. You need to
verify that the browser is set up correctly and review the fonts that are installed on
the server.

The installation of more fonts/languages on the server should be done in
coordination with your technical support team. Be sure to include a Unicode Sans
Serif font on your server.

Important: While multiple languages are supported, a user account should be
configured to use one specific language to avoid user interface display issues.

System Maintenance

Determining the need for a fix pack in an iSeries environment:

Fix packs contain cumulative fixes for a specific version of Sterling B2B Integrator.

About this task

Fix packs are available on IBM Fix Central. Because each fix pack contains the fixes
from previous fix packs, you need to install only the most recent fix pack.

Information about a fix pack is in a PDF file with a similar name to the fix pack,
and is available for download with the fix pack JAR file.

Before you install the fix pack, review the following items:
v Preserve your custom changes to system resources.
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v The fix pack installation might use one or more fix pack property override files.
Do not alter these files.

v Property changes made directly in .properties or .properties.in files might be
overwritten during the fix pack installation. Properties that are overridden by
the customer_overrides.properties file are not affected. IBM recommends that
you maintain property file changes by using (when possible) the
customer_overrides.properties file. For more information, see the
documentation for using the customer_overrides.properties file.

v If you edited any of the cdinterop files, you must back them up before you
apply the fix pack. The cdinterop files do not have initialization (.in) files. After
you apply the fix pack, use the backup version of the files in your upgraded
installation. These files include the following files:
– cdinterop-proxy-records.properties

– cdinterop-spoe-auth.properties

– cdinterop-spoe-policy.properties

– cdinterop-user-records.properties

v Information about the upgraded installation is automatically logged to the
/install_dir/install/logs/InstallService.log file.

v If you need to roll back a fix pack, see “Fix Pack Changes Report” on page 309.
v During fix pack installation, the dbVerify utility compares the list of standard

indexes with the indexes that are present in the database and drops the custom
indexes. Recreate the custom indexes after the fix pack installation is complete.

Installing a fix pack or interim fix:

When available, you should install fix packs or interim fixes for Sterling B2B
Integrator in iSeries to keep your system current.

Procedure

To install the latest fix pack or interim fix for Sterling B2B Integrator in an iSeries
environment:
1. Open the IBM Fix Central website.
2. Download the most recent fix pack or interim fix for your version of Sterling

B2B Integrator and record the absolute path to the downloaded file. Do not
rename the file. If you use FTP, you must use Binary mode.

3. Log in to the server where Sterling B2B Integrator is installed with the user ID
and password that was used for the installation.

4. Stop Sterling B2B Integrator.
5. Perform a full backup of the Sterling B2B Integrator installation directory,

including all subdirectories.
6. Perform a backup of the database.
7. If you edited any property files, ensure that the associated .properties.in

files have the most current changes. Property files are overwritten with the
contents of the associated .properties.in files during the installation.

8. Sign on with your Sterling B2B Integrator user profile and enter into the QSH
(Qshell) mode.

9. In QSH, navigate to the /install_dir/bin directory where install_dir is the
Sterling B2B Integrator installation directory.

10. Enter:
./InstallService.sh <path>/<file_name>
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Where:
<path> is the fully qualified path to the fix pack or interim fix file
<file_name> is the name of the fix pack or interim fix file

If the fix pack or interim fix attempts to modify the database schema and the
modification fails, you receive an error message about the failure. The
message provides the error message code from the database and the SQL
command that failed. The failure information is also logged to the system.log
file (in the /install_dir/install directory) and to the fix pack.log file.
Attention: Running InstallService.sh removes any previously installed
interim fix to prevent conflicts with what is being installed.

11. Press Enter to continue.
Information about the fix pack or interim fix is displayed. After the fix pack or
interim fix is applied, the following message is displayed:
Deployment to application server successful

When the $ is displayed, the process completes.
12. Start Sterling B2B Integrator.

Preserving custom changes for system resources:

When you update Sterling B2B Integrator, you can preserve your custom changes
to system resources like workflow definitions and maps.

About this task

During updates, the system can identify when you make a custom change to
Sterling B2B Integrator versus a change through an upgrade or fix pack.

When a fix pack, installation or upgrade is performed, a baseline record of system
resources is created. This baseline is not affected by any subsequent customer
changes. When another fix pack is installed, the resources in this baseline are
compared to the resources in the existing system. If a baseline and existing
resource are not the same, that means that the existing resource was customized
and was not overwritten by the fix pack.

During an update, the baseline is updated with new system resource information,
but not with custom changes to resources.

DB Checksum tool:

A checksum is a simple redundancy check used to detect errors in data.

In Sterling B2B Integrator, a verification process compares the checksum between
the existing default resource and the resource that was added after applying a fix
pack or upgrading. The DB Checksum tool, a resource difference tool generates a
granular report of the changes in the system that was not permitted to be set as
defaults.

The DB Checksum tool generates the difference in resource checksum between the
default resource and the latest system resource from the database.

Performing a checksum:

Use a command to run the DB Checksum tool.
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Procedure

To run the DB Checksum tool:
1. Open the /install_dir/install/bin directory.
2. Enter the following command:

./db_checksum_tool.sh [-d] [-i [1 | 2 | 3 | 4 | 5]]
[-r [wfd | map | schema | sii | template]] [-o <output file>] [-g]

Where:
v -d is the mode to dump the difference of resource checksum between the

default resource and latest system resource.
v -i is the resource type integer (optional).
v 1 is WFD.
v 2 is MAP.
v 3 is SCHEMA.
v 4 is SII.
v 5 is TEMPLATE.
v -r is the resource name (optional). For example, wfd, map, schema, sii, or

template.
v -o is the file name to output all the messages (optional).
v -g is the file name that lists all the ignored resources (optional).
v -h is the help screen.

The DB Checksum tool performs the relevant checksum operation that is based
on the command options and generates the output message.

Fix Pack Changes Report:

The Fix Pack Changes Report is used to obtain information if you need to roll back
a fix pack.

The fix pack report can be found in the installation directory fix pack_reports
folder. The report contains the following fix pack information:
v Fix pack ID
v Fix pack changes
v Number of files deleted
v Number of JAR files removed
v Number of JAR files added
v Number of files added
v Number of files changed
v Number of properties added
v Number of business processes added
v Number of service instances added
v Number of service definitions added
v Number of templates added
v Number of reports added
v Number of maps added
v Number of schemas added
v Number of business rules added
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For example, the installation directory fix pack_reports folder contains the fix
pack_Report.html file. When you open this file, you can view the fix pack
information.

Example: Fix Pack Changes Report:

The Fix Pack Changes Report includes both summary and detailed report
information.

The following is an example of a Fix Pack Changes Report:
Summary of Changes
Fix Pack ID: Platform_2.0
Fix Pack Changes: 1287
Number of Files Deleted: 0
Number of JARs Removed: 2
Number of JARs Added: 0
Number of Files Added: 3
Number of Files Changed: 3
Number of Properties Added: 4
Number of BPs Added: 4
Number of Service Instances Added: 2
Number of Service Definitions Added: 3
Number of Templates Added: 0
Number of Reports Added: 0
Number of Maps Added: 3
Number of Schemas Added: 3
Number of Business Rules Added: 0
________________________________________
List of JARs Removed:
JAR Removed: /SAMPLE_INSTALL_1/jar/jaf/1_0_2/activation.jar
Time: Wed May 13 15:23:08 EDT 2009
JAR Removed: /SAMPLE_INSTALL_1/jar/commons_logging/1_0_3/commons-logging-api.jar
Time: Wed May 13 15:23:08 EDT 2009
________________________________________
List of Files Added:
File Added: /SAMPLE_INSTALL_1/bin/sql/fix_db2_schema.sql
Time: Wed May 13 15:21:30 EDT 2009
File Added: /SAMPLE_INSTALL_1/bin/sql/fix_db2iseries_schema.sql
Time: Wed May 13 15:21:30 EDT 2009
File Added: /SAMPLE_INSTALL_1/bin/errorQueueManager.sh.in
Time: Wed May 13 15:21:30 EDT 2009
________________________________________
List of Files Changed:
File Changed: /SAMPLE_INSTALL_1/properties/lang/en/Reports_en.properties
File Changed: /SAMPLE_INSTALL_1/properties/lang/es/Reports_es.properties
File Changed: /SAMPLE_INSTALL_1/properties/lang/fr/Reports_fr.properties
________________________________________
List of Properties Added:
Property Added: /SAMPLE_INSTALL_1/properties/filesToRemove.txt
Property Added: /SAMPLE_INSTALL_1/properties/filesToRemove.txt.in
Property Added: /SAMPLE_INSTALL_1/properties/csr.properties.sample
Property Added: /SAMPLE_INSTALL_1/properties/csr.properties.sample.in
________________________________________
List of BPs Added:
BP Added: Schedule_AssociateBPsToDocs.bpml version: 4
Time: Wed May 13 15:23:07 EDT 2009
BP Added: Recovery.bpml version: 17
Time: Wed May 13 15:23:07 EDT 2009
BP Added: Schedule_AutoTerminateService.bpml version: 10
Time: Wed May 13 15:23:07 EDT 2009
BP Added: Schedule_DBMonitorService.bpml version: 1
Time: Wed May 13 15:23:08 EDT 2009
________________________________________
List of Service Instances Added:
Service Instance Added: RetentionProcessor version: 2

310 Installing and upgrading (V5.2.6 or later):



Time: Wed May 13 15:23:28 EDT 2009
Service Instance Added: MESAHttpServerAdapter version: 1
Time: Wed May 13 15:25:11 EDT 2009
________________________________________
List of Service Definitions Added:
Service Definition Added: LockServiceType
Time: Wed May 13 15:22:58 EDT 2009
Service Definition Added: XAPIServiceType
Time: Wed May 13 15:22:59 EDT 2009
Service Definition Added: CleanLockServiceType
Time: Wed May 13 15:22:59 EDT 2009
________________________________________
List of Templates Added:
Template Added: Normalize
Time: Wed May 13 15:23:26 EDT 2009
Template Added: Derive
Time: Wed May 13 15:23:26 EDT 2009
________________________________________
List of Maps Added:
Map Added: IBMPutResponseToXML
Time: Wed May 13 15:24:05 EDT 2009
Map Added: http_headers
Time: Wed May 13 15:24:36 EDT 2009
Map Added: OracleHttpHeaders
Time: Wed May 13 15:24:51 EDT 2009
________________________________________
List of Schemas Added:
Schema Added: E5_V20_Acknowledge_Result.dtd from file: E5_V20_Acknowledge_Result
Time: Wed May 13 15:24:36 EDT 2009
Schema Added: E5_V20_Acknowledge_Submit.dtd from file: E5_V20_Acknowledge_Submit
Time: Wed May 13 15:24:36 EDT 2009
Schema Added: E5_V20_APIs_Result.dtd from file: E5_V20_APIs_Result
Time: Wed May 13 15:24:36 EDT 2009

License modifications:

After the installation finishes, you can modify the software licenses that you
loaded with the AddLicenseSet command.

The AddLicenseSet command is in the bin directory of your UNIX or Windows
installation. After the initial installation, the license files are in the following
directories:
v UNIX - /install_dir/install/properties/licensefiles
v Windows - \install_dir\install\properties\licensefiles
v iSeries - /install_dir/properties/licensefiles

You can add licenses or review the license list from the UI. On the Administration
Menu, click System > B2B Console > Operations > System > Licenses.

AddLicenseSet Command Parameters

Use the AddLicenseSet command to modify a single license file or the entire license
file directory.

To use the AddLicenseSet command, you must do the following:
v Open the bin directory
v Include the absolute path to the license file directory or to a license file

The AddLicenseSet command has the following parameters:
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AddLicenseSet Parameter Description

-reload Use this parameter to reload the license files.

This parameter deletes all of the license files from the
database before the new files are loaded. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/
old_licenses

v Windows - \install_dir\install\logs\security\
old_licenses

v iSeries - /install_dir/logs/security/old_licenses

-upgrade Use this parameter during an upgrade only.

This parameter deletes all of the old license files from the
database and installs the new license files. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/upgrade

v Windows -\install_dir\install\logs\security\upgrade

v iSeries -/install_dir/logs/security/old_licenses

The AddLicenseSet command will check if Sterling B2B Integrator is running. If it
is running, the command will call the Ops server to refresh the license from the
database. If you have any problems with your licenses after running the
AddLicenseSet command, stop and restart Sterling B2B Integrator.

License Modification: Examples:

There are several different ways you can use the AddLicenseSet command to
modify your licenses.

UNIX Examples

From the install_dir/bin directory:

Scenario Command usage (UNIX example)

Reload a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -reload

Reload all of the license files
in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -reload

Upgrade a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -upgrade

Windows Examples

From the install_dir\bin directory:

Scenario Command usage (Windows example)

Reload a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -reload
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Scenario Command usage (Windows example)

Reload all of the license files
in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -reload

Upgrade a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -upgrade

Updating your JDK on iSeries:

Sometimes you need to update the JDK used by Sterling B2B Integrator.

To update from the classic JDK 1.6 to J9 JDK 1.6 or from J9 JDK 1.6 to J9 JDK 1.7,
begin by stopping Sterling B2B Integrator.

To stop Sterling B2B Integrator on iSeries, in QSH, run the command:
./hardstop.sh.

Then perform the following steps as needed:
1. “Preparing the user profile for the new JDK”
2. “Downloading the JDK Update Files” on page 314
3. “Running the Update JDK Program” on page 314

Preparing the user profile for the new JDK:

The Sterling B2B Integrator user profile must be set up to point to the correct JDK.

About this task

Perform the following steps if you are going from the Classic JDK 1.6 to the J9 JDK
1.6 or to J9 JDK 1.7. This will point your Sterling B2B Integrator user profile to the
appropriate JDK:

Procedure

1. Log on to the Sterling B2B Integrator user profile.
2. Create a home directory for the Sterling B2B Integrator user profile.

a. From an iSeries command line, enter: MKDIR /home/appuser, where appuser
represents theSterling B2B Integrator user profile.
If the home directory for your Sterling B2B Integrator user profile already
exists, ignore this step.

b. Enter EDTF and press F4.
c. Enter /home/appuser/.profile and press Enter. An edit session is displayed.
d. If you are converting to J9 JDK 1.6, enter the following on the first line:

export JAVA_HOME=/QOpenSys/QIBM/ProdData/JavaVM/jdk60/64bit

e. If you are converting to J9 JDK 1.7, enter the following on the first line:
export JAVA_HOME=/QOpenSys/QIBM/ProdData/JavaVM/jdk70/64bit

f. Press F2, then F3 to save and exit.
3. Log off and then log back on.

Installing and upgrading (V5.2.6 or later) 313



Results

The Sterling B2B Integrator user profile should now be pointing to the correct JDK.
To verify, perform the following steps:
1. At the iSeries command line, key in qsh and press Enter.
2. Key in java –version to verify that it displays the correct JDK version.

Downloading the JDK Update Files:

You will need to download some files to update your Sterling B2B Integrator JDK
on iSeries.

About this task

To download the upgrade files necessary for upgrading your Sterling B2B
Integrator JDK:

Procedure

1. Is there a saved file named UPDJDKSAVF in QGPL on your iSeries?
v Yes - Enter CLRSAVF FILE(QGPL/UPDJDKSAVF) to clear the save file from your

iSeries.
v No - Enter CRTSAVF FILE(QGPL/UPDJDKSAVF) to create a save file on your

iSeries.
2. Copy the UPDJDKSAVF file from Sterling B2B Integrator Installation

Directory/bin/updjdksavf to the save file created in QGPL by entering:
CPYFRMSTMF FROMSTMF(`Sterling B2B Integrator Installation
Directory/bin/updjdksavf’) TOMBR(`/QSYS.LIB/QGPL.LIB/
UPDJDKSAVF.FILE') MBROPT(*REPLACE) CVTDTA(*NONE)

3. To restore the upgrade objects, enter: RSTLIB SAVLIB(UPDATEJDK) DEV(*SAVF)
SAVF(QGPL/UPDJDKSAVF)

4. To add the installation programs to your library list, enter: ADDLIBLE
LIB(UPDATEJDK)

Running the Update JDK Program:

Run the Update JDK program to update your Sterling B2B Integrator JDK on
iSeries.

About this task

To run the Update JDK program in iSeries:

Procedure

1. Key in UPDATEJDK from an iSeries command line and press F4.
2. For the SI Installation Directory parameter, enter your Sterling B2B Integrator

installation directory.
3. For the JDK switching from parameter:, enter:
v 1 - If you are currently using the Classic JDK 1.6
v 2 - If you are currently using the J9 JDK 1.6

4. For the New JDK parameter:, enter:
v 1 - If you are upgrading to the J9 JDK 1.6
v 2 - If you are upgrading to the J9 JDK 1.7
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5. Press Enter

6. From an iSeries command line, enter qsh to enter into the qshell mode.
7. Change to your Sterling B2B Integrator installdir/bin directory.
8. Enter ./setupfiles.sh. This changes the preliminary files to the new JDK.
9. Key in ./deployer.sh and press Enter. This will change the remaining property

files and point Sterling B2B Integrator to the new JDK location.

Results

Your JDK is now updated and you are ready to start Sterling B2B Integrator.

Uninstall the Software

Uninstalling Sterling B2B Integrator from an iSeries Environment:

When you uninstall Sterling B2B Integrator, the software is automatically removed
from the server.

Procedure

To uninstall the software from an iSeries environment:
1. Stop Sterling B2B Integrator and wait for the shutdown to complete.
2. Sign onto iSeries with your Sterling B2B Integrator user profile.
3. In QSH, change to the directory above the installation directory. For example, if

the installation directory is /product/SI_Install, then change to the /product
directory.

4. Remove the installation directory by entering the following command:
rm -rf install_dir

5. Wait for the command line to return.
6. Select F3 exit from Qshell.
7. Enter DLTLIB <collection name>. For example, DLTLIB (Sterling B2B

Integrator)DB. The following kind of messages are displayed:
Receiver QSQJRN0001 in (Sterling B2B Integrator)DB never fully saved. (I C).

8. Enter I to one or more of these messages until the library is deleted.
9. After you remove the software from the server, you can remove Eclipse and

any tools that were downloaded to the desktop, including the following tools:
v Map Editor and associated standards. Refer to the Map Editor Guide for

information about removing the Map Editor.
v Graphical Process Modeler. Refer to the Graphical Process Modeler Guide for

information about removing the Graphical Process Modeler.
v Web Template Designer. Refer to the Web Extensions Guide for information

about removing the Web Template Designer.
v (If licensed) MESA Developer Studio plug-ins, including the following tools:

– MESA Developer Studio Software Development Kit (SDK).
– MESA Developer Studio Skin Editor.
Refer to the MESA Developer Studio guide for information about removing
MESA Developer Studio.

v (If licensed) Reporting Services, which require MESA Developer Studio if you
want to use the plug-ins to create fact models and custom reports. Refer to
the MESA Developer Studio guide for information about removing Reporting
Services.
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User Documentation

User Documentation:

The user documentation is available from an online documentation site on the
web.

Providing the documentation in an online environment allows for frequent updates
of content that is based on user feedback and usability.

If you need a printed copy of the documentation, you can print topics of
information through your Internet browser, or you can download documents in
PDF format, after you add it to a collection on IBM Knowledge Center.

To access the documentation site from within Sterling B2B Integrator or one of its

tools, select the help 
 

icon. The system must reside on a computer that supports
Internet access and an Internet browser.

Improving your access to online documentation:

You can improve your access to online documentation by using several methods.

About this task

After you access the IBM Knowledge Center, you can perform the following tasks:
v Enter a word or phrase and search the entire library for information.
v Move through a hierarchy of contents pages to identify the topic you want to

read or print.
v Print topics by using your browser's Print function.
v Add documents to your collection and download them in PDF format.

Troubleshooting Tips

Installation and upgrade troubleshooting tips: iSeries environment:

If you have trouble while installing or upgrading Sterling B2B Integrator on iSeries,
different troubleshooting techniques are available.
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Situation Message or Symptom Explanation/Resolution

Installing a desktop
tool or resource

Cannot download any of the
following tools:
Note: MESA Developer Studio
and Reporting Services are
optional features that are
purchased separately from
Sterling B2B Integrator. These
features each require a separate
license in addition to your
license for Sterling B2B
Integrator.

v Map Editor and associated
standards

v Graphical Process Modeler

v Web Template Designer

v (If licensed) MESA Developer
Studio plug-ins (Software
Development Kit (SDK), Skin
Editor)

v (If licensed) Reporting
Services, which require MESA
Developer Studio if you want
to use the plug-ins to create
fact models and custom
reports

Explanation

When you install Sterling B2B
Integrator, system files are
created that contain an internal
IP address. If you install Sterling
B2B Integrator behind a firewall,
and your firewall is configured
to accept an external IP address
from a client computer, you
might not be able to download
the desktop tools and resources.
The firewall rejects the IP
address from a client that exists
outside of the firewall.

Resolution

Modify the system files that
contain the invalid IP address:

1. Open the /install_dir/bin
directory.

2. Stop Sterling B2B Integrator.

3. Enter the following
command followed by the
external IP address:

patchJNLP.sh
external_IP address

4. Restart Sterling B2B
Integrator.

Accessing Attempts to access the URL for
Sterling B2B Integrator display
the message: Page cannot be
displayed.

Resolution

Change the Network Interface
Bindings.

Installing and upgrading (V5.2.6 or later) 317



Situation Message or Symptom Explanation/Resolution

Stopping Ending jobs from Sterling B2B
Integrator when a hardstop is
not successful.

Explanation

There was a problem during the
installation process or the
subsystem was not defined
correctly.

Resolution

1. Enter WRKACTJOB and locate
the job that did not end
successfully.

2. Press F11 twice to obtain the
job number that you want
to end.

3. Press F3 to end the
WRKACTJOB panel.

4. Enter QSH to enter Qshell
mode.

5. Enter ps and press Enter.

6. Locate the pid number that
corresponds to job number
from the WRKACTJOB
panel.

7. Enter kill -kill <pid
number>
kill -kill <pid number>.

8. Review the installation log
to determine the error and
resolution.

9. If the error is due to a
problem with the
installation, then delete the
installation directory and
install the software again.

10. If the error is due to the job
queue having 1 as the
maximum number of active
jobs in the subsystem, then
either change the subsystem
that you start Sterling B2B
Integrator in, or change the
number of maximum active
jobs.
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Situation Message or Symptom Explanation/Resolution

e-Invoice Upgrade:
Oracle Add
Constraint Error

When you upgrade Sterling
e-Invoicing and are using an
Oracle database, the upgrade
fails with the error message name
is already used by an existing
object. This error occurs because
the default behavior for the drop
constraint command changed
in Oracle 10.

The index that is used to
support the constraint is only
removed if the index was
generated by the create
constraint command. The
indexes for Sterling e-Invoicing
are always generated from
constraints during an
installation.

If you receive this error during a
Sterling e-Invoicing upgrade, it
is because of how the database
was restored, the version of
Oracle you are using, and
because the Oracle imp command
exported the indexes and
constraints separately. There is
no way to determine when the
imp command does not add a
create index command to the
export file if it was generated by
a constraint. But if it does add
the command, the database
restore process loses the
association of the constraint and
its underlying index.

The database script that runs
during a Sterling e-Invoicing
upgrade runs two steps:

1. The script drops the unique
constraint so the next step
can redefine it using
additional columns.
However, the drop constraint
command does not remove
the underlying index if the
association with its index
was lost.

2. The next command that
redefines this constraint
requires a different index
definition, but in this
scenario the name of the
index the constraint wants to
use exists, which causes the
error name is already used
by an existing object.

Resolution

If you receive this error message,
the solution for this problem is
to drop the index and rerun the
Sterling e-Invoicing upgrade.
The drop index command that
you should use is:

drop index UNQ_EINV_CANON
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Upgrading (V5.2.6 or later)
Upgrade your Sterling B2B Integrator software to the V5.2.6 release.

Windows Cluster Environment Upgrade (V5.2.6 or later)
You can upgrade the Sterling B2B Integrator software in a Windows cluster
(multiple node) environment.

Clustering is not supported for Sterling B2B Integrator systems that use the
MySQL database.

You should also review these documents:
v System Requirements
v Release Notes
v What's New
v Installation and Upgrade Information

It is important to remember that upgrading involves a full installation of Sterling
B2B Integrator. You need to prepare for an upgrade the same way that you would
prepare for an installation. It is also recommended that you thoroughly test this
process in a test or development environment prior to implementing in a
production environment.

This upgrade does not overwrite your current Sterling B2B Integrator directory
structure on disk. Instead, it creates a new installation of Sterling B2B Integrator
that points to and upgrade the database of your current installation of Sterling B2B
Integrator. This means your original instance will no longer be operational after
performing the upgrade. After the upgrade, you will be starting your Sterling B2B
Integrator instance only from the newly created directory structure.

For new installations, use the Sterling B2B Integrator Windows Cluster Installation
Guide.

Intended audience
This document can be used by different members of your organization.

This document is intended for use by:
v System administrators
v Installation engineers
v Database administrators.

Assumptions for this guide
The procedures in this guide are accurate as of the publication date and are
specific to this version of the document.

Upgrade Scenarios (Clustered)
Upgrading to Sterling B2B Integrator can follow several paths. Keep these
scenarios in mind as you plan for your upgrade:
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Upgrade Scenario High-Level Upgrade Steps

You have V5.2.x installed and want to
upgrade by applying V5.2.6 as a fix pack.

The upgrade steps are as follows:

1. Ensure that your JDK version is
supported. See the system requirements.
Upgrade your JDK if needed. See
“Upgrading your JDK (Windows and
UNIX)” on page 3.

2. Ensure that your operating system and
database versions are supported.

3. See “Applying a Fix Pack (V5.2.6 or
later)” on page 625or “Applying Sterling
B2B Integrator V5.2.6 Fix Pack using a
script” on page 630

You have 5.1.x installed and want to
upgrade to V5.2.6.

The upgrade steps are as follows:

1. Ensure that your JDK version is
supported. See the system requirements.
Upgrade your JDK if needed. See
upgrading your JDK.

2. Ensure that your operating system
version is supported. Upgrade your
operating system if required.

3. Ensure your database version is
supported. Upgrade you database if
required:

a. Export the configuration data.

b. Back up the database.

c. With help from a database
administrator (DBA), copy the
database to the new version.

d. Back up the newly created database.

4. Upgrade to Sterling B2B Integrator V5.2.6
using the full installation media and this
Upgrade Guide.

5. Point to your supported database
version. If the upgrade stops and leaves
the newly created database in an
incomplete state, you can re-start the
upgrade using the backup of the
database.

Upgrade Impacts
This documentation provides information on how system behavior has changed
based on upgrading your instance. You should review this information before you
begin your upgrade. Depending on which version you are upgrading to, you will
need to review one or more topics listed. The upgrade impacts listed for each
subsequent version are specific to that version. There is not a cumulative list.

Upgrade impacts for V5.2.6.2:

Upgrading to Sterling B2B Integrator V5.2.6.2 has unique impacts.

Installing and upgrading (V5.2.6 or later) 321



DB2 requires additional tablespace

When upgrading to V5.2.6.2 or later you must ensure that all tablespaces used by
Sterling B2B Integrator tables have a minimum page size of 8K. Otherwise
installation will fail.

Upgrade impacts for V5.2.6:

Upgrading to Sterling B2B Integrator 5.2.6 has unique impacts.

Support for SSLV3 has been removed - TLS 1.2 is the new default

Due to security concerns, Sterling B2B Integrator no longer supports the use of
SSLV3. You should be aware of the following changes as you upgrade your system
to this version:
v Several properties have been updated to use TLS 1.2 as the default. If your mail

server cannot use TLS 1.2, you can change your SMTP and B2B Mail Client
adapters to use TLS 1.0 or 1.1 instead.

v If any of your 3rd party programs do not support the use of TLS 1.2, you can
change Sterling B2B Integrator to use TLS 1.0 or TLS 1.1.

v In all cases, requests to use "SSLV3" in Sterling B2B Integrator will use instead
TLS 1.0, TLS1.1, or TLS1.2.

v TLS 1.2 is used as the default protocol in secure communications. This change
applies to any system that is upgraded to V5.2.6.

v If your GPM, or WebSphere MQ or OFTP adapters are configured to use older,
non-supported cipher suites (non-TLS 1.2), they will continue to work. However,
if you edit them, only TLS 1.2 will be available to select.

JDK 7 is the only supported JDK version for V5.2.6

There are several impacts due to this change:
v If you are not already using JDK 7, you must upgrade your JDK before

attempting to upgrade Sterling B2B Integrator to V5.2.6. If you currently have
V5.2.4.1 or higher installed, there is a upgradeJDK script available to assist you.
See bin Directory Files for more information.

v Only ciphers that are supported by JDK 7 can be used in Sterling B2B Integrator
V5.2.6. You can update your cipher suites in security.properties.

v Previously defined ciphers in customer_overrides.properties are not changed
upon upgrade to V5.2.6.

v DefaultCipherSuite contains a list of JDK 7 ciphers in V5.2.6 that can be used
when others are not available.

Upgrade impacts for V5.2.5:

Upgrading to Sterling B2B Integrator V5.2.5 has unique impacts.

JDK 7 does not support the TLS_RSA_WITH_3DES_EDE_CBC_MD5 cipher

If you are using JDK 7 with Sterling B2B Integrator V5.2.5, and you want to use a
cipher to secure the Sterling B2B Integrator dashboard, you must set one of the
following values in the dashboardCipherSuite parameter in the
security.properties_platform_asi_ext.in property file or in customer_overrides:
v JDK (includes all strong ciphers except the one not supported by JDK 7)
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v Weak

Do not use Strong or All with JDK 7 or Sterling B2B Integrator will not start.

Reconciliation of HIPAA Level 5 code lists

When you upgrade to Sterling B2B Integrator V5.2.5, customized HIPAA Level 5
code lists from the previous version are preserved in the system where they were
entered, but they are not the default code lists after the upgrade. After the
upgrade, you must manually make any customized code lists the default code lists.

For example, you customized the ICD9 or HCPCSCPT code list in the previous
version of Sterling B2B Integrator. After the upgrade to version 5.2.5, you must
replace the default ICD9 or HCPCSCPT code list with the customized ICD9 or
HCPCSCPT code list.

Properties file change to prevent timeout during start (V5.1.0.4 to V5.2.5 upgrade)

Before you start Sterling B2B Integrator after you upgrade the application from
version V5.1.0.4 to V5.2.5, you must change the values of the following properties
in the centralops.properties file to 600. This action prevents the start command
from timing out before Sterling B2B Integrator starts. The centralops.properties
file is in the properties subdirectory of the installation directory.
v OpsServer.commandTimeout

v PassPhrase.urlTimeout

jGroups upgrade in V5.2.5 prevents Sterling B2B Integrator from starting for
some customers

jGroups is upgraded with V5.2.5. Some of the properties defined in
jgroups_cluster.properties have changed. If you modified these files or added
custom changes for them to customer_overrides.properties, the upgrade changes
are not applied and Sterling B2B Integrator will not start.

This issue is fixed in V5.2.5, Interim Fix 1, where all necessary properties files are
changed for you. You can also disable this fix if desired. See APAR IT06654 for
more information.

Note: The original and modified properties are output to the noapp.log file. This
allows you to see how your properties were modified. Search the log using the
value “Initializing jgroups_cluster.property_string" to see the new and changed
values for the two affected startup properties. The
jgroups_cluster.lock.protocolStack property is also modified with this fix, but is
only written to the log when it is used, not at startup.

If you want to manually fix your installation without applying V5.2.5, Interim Fix
1, complete the following steps:
1. Delete the following options (if they exist) from customer_overrides.properties

for the jgroups.cluster property file. These occur in the
jgroups_cluster.property_sting, jgroups_cluster.distributed_property_string, and
jgroups_cluster.lock.protocolStack files:
v gc_lag
v up_thread
v down_thread
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v join_retry_timeout
v max_xmit_size
v shun

2. Remove the protocol parameter VIEW_SYNC and all of its attributes.
3. In the jgroups_cluster.property_string, replace ‘start_port’ with ‘bind_port’.
4. In the jgroups_cluster.distributed_property_string and

jgroups_cluster.lock.protocolStack properties, add the following items:
v In distribution_property_string the attribute

thread_pool_rejection_policty=run should be added to the protocol ‘TCP’.
For example,
TCP(bind_port=22261;thread_pool_rejection_policy=run)

v In lock.protocolStack: the protocol and attribute CENTAL_LOCK(num_backups=2)
should be added to the end of the property. For example,
lock.protocolStack=UDP(bind_addr=&HOST_ADDR;;bind_port=
&MULTICAST_NODE_PORT3;;mcast_addr=239.255.166.17;<other

protocol parameters here>pbcast.GMS(join_timeout=5000;print_local_

addr=true):CENTRAL_LOCK(num_backups=2)

Upgrade Impacts for V5.2.0: Before you begin an upgrade, you should review the
following information.

Features and Services Not Supported as of V5.2.0

The following features and services are no longer supported:
v Channels portlet
v Federated Systems
v Community Management (AFT Communities are still available)
v Sterling Community Management (SCM) Integration
v Archive Commandline Service
v Sync Engine Data Clean Manager Service
v Sync Engine Task Manager Service

If you need more information, please contact your IBM sales representative.

Port Allocation Changes

If you are upgrading to V5.2, and configured the CLA2 or the SWIFTNet HTTP
Server Adapter, the remote port numbers have changed. The port numbers are as
follows:

Table 1. Remote Port Numbers

Adapter
Name

Version 5.2.0 Base
Port Version 5.2.1 Base Port Version 5.2.2 Base Port Version 5.2.3 Base Port

CLA2 +51 +52 +53 +54

SWIFTNet
HTTP
Server

+52 +53 +54 +55

Note: You should check adapter configurations and the sandbox.cfg file for ports
greater than 51 which may have changed.
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After upgrading to 5.2.x, you need to change any references to the old remote port
numbers. For example, if you have any business processes that use the CLA2
adapter, you will need to update the remote ports in the business process.

Database Table Sizes

While upgrading if you encounter any database table size issues, you may have to
manually adjust the database tables and restart the upgrade process. An upgrade
using the production database in a test environment can be used to help you
determine what tables need to be manually adjusted.

Resource Tags

If you are using resource tags in your current version, you should check all of your
existing resource tags before you start the upgrade process. The resource tags you
should check are:
v Adapter Policies
v Agreements
v Sterling Connect:Direct® Netmaps
v Proxy Servers
v Security Tokens
v SSH Resources
v SWIFTNet Copy Service Profiles
v SWIFTNet Service Profiles

You can check the resource tags by running the following SQL query from the SQL
Manager page (Operations > Support Tools):
SELECT * FROM TAG_RESOURCE_ASSOC WHERE TYPE=41 OR TYPE=42 OR TYPE=43 OR TYPE=44 OR
TYPE=45 OR TYPE=52 OR TYPE=53

The TAG_NAME column in the SQL results will contain the names of any resource
tags that need to be edited or deleted.

If any of the resource tags contain tagged resources using the types listed, remove
those resources from the resource tags or delete the resource tags that contain these
resource types.

Silent Installation Parameters

The following parameters are new or have an updated definition:

What has changed parameter Definition

Parameter definition
has changed

LICENSE_FILE_PATH (Required) Full path to Core_License.xml.
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What has changed parameter Definition

New parameter LICENSE_FILE_#
(where # is a number
between 1 and 99)

(Required) This is required for each license
you install. You must add an entry for each
license file to the silent install file. The
LICENSE_FILE numbering (#) does not
need to be sequential.

For example:

LICENSE_FILE_1= SI_SFG_License.xml

LICENSE_FILE_2= Fin_Serv_License.xml

LICENSE_FILE_3=
SI_SFG_FIPS_License.xml

LICENSE_FILE_4= AS2_License_.xml

LICENSE_FILE_5= EBICS_License_.xml

Channels and Community Management Tabs (Optional)

The Dashboard PSML files are not updated during an upgrade. The PSML file
impacts any custom tabs you may have configured, such as Channels or Operator.
The Channels and Community Management tabs appear in your browser but are
no longer operational.

To remove the Channels and Community Management tabs:

Warning: The psmlRestore command gets the 5200 psml file which resets ALL of
the custom tabs from the previous release.
1. Navigate to the installation directory.
2. Navigate to the bin directory.
3. Enter this command: ./psmlRestore.sh admin

Custom BI Fact Models Need to be Upgraded

Scripts named recreateBITablePKs.cmd.in (Windows) and recreateBITablePKs.sh.in
(UNIX) are now provided which allow you to upgrade any custom BI fact models
tied to a separate BI repository.

BI fact models need to be upgraded to continue to work with the Entity
Framework, which replaced Hibernate usage in the BI framework in version 5.2.0.

Backups Are Not Generated During Install, Upgrade, or When Applying a Fix Pack or
Interim Fix: Before you begin an upgrade, review the following backup
information.

Some of the standard resources installed during install or upgrade use the import
mechanism available to customers to load the standard resources into the database.
The standard import mechanism by default creates a backup of the table
containing the resource prior to importing to provide the ability to restore to the
previous state if later it was decided that the import should not have been
performed. This table backup was also being performed by default during the
basic installation processes. And, since the import mechanism was sometimes used
multiple times during the installation processes, some of the tables were backed up
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several times. Depending on the size of the table, this could add a very large
amount of time to the installation process. Since it is recommended that a backup
is completed prior to beginning any of these installation processes, the default
behavior has changed to not perform the backup by default. If you would like
backups to be performed, then SKIPIMPORTBACKUP=false should be added to the
sandbox.cfg file.

Capitalization Insensitivity for Header Value:
About this task

Before you begin an upgrade, review the following AS3 information.

For AS3, when searching for a header value in a multipart/report, you do not need
to consider whether the header value contains any capitalization. The search has
been enhanced to be capitalization insensitive.

For example, the following searches will result in a match:
v Multipart/Report
v Multipart/report
v multipart/Report
v multipart/report

The search would not find the following as a match:
v MulTiPart/RePorT

CA Certificates Impacts: Before you upgrade, review the following information on
CA certificates.

Users may add multiple copies of the same certificates to the database. Having
multiple copies of the same certificate in the database is not, in principle, a
problem for the system except for the minor amount of wasted storage. Each copy
has a different object ID in the database and is a separate database object.

The specific changes in this release is the ability to easily populate the product
database with the set of authority root certificates distributed with the JVM.

Perimeter Server Installation:
About this task

Before you begin an upgrade, review the following Perimeter Server installation
information.

Silent install is the default installation mode. If you want to complete the Perimeter
Server installation using an interactive mode, you need to use the following
command:
java -jar ps_xxxx.jar -interactive

where ps_xxx.jar is the perimeter server jar file name for the version of Sterling
B2B Integrator you are upgrading to.

Retry Logic Added to WebSphereMQ Suite Adapter PUT Service:
About this task

Before you begin an upgrade, review the following WebSphereMQ Suite Adapter
PUT Service information.
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Retry logic has been added to the WebSphereMQ Suite. To accommodate this new
functionality, you need to configure two new parameters for the PUT service:
v wsmq_send_retryCount
v wsmq_send_retrySleepInterval

To configure the new parameters:

Procedure

1. Log into Sterling B2B Integrator.
2. From the Admin Console Home, you need to start the Graphical Process

Model (GPM).
3. Log into the GPM. You will need a User ID and Password.
4. In the GPM, select View > Stencil > Services.
5. Select File > New.
6. Drag the WebSphereMQ Suite Put Message Service from the All Services

pane into the center pane.
7. Double click the WebSphereMQ Suite Put Message Service.
8. Select the configuration from the Config dropdown.
9. Enter the number of retries in to the wsmq_send_retryCount value.

10. Enter the sleep interval in seconds in to the wsmq_send_retrySleepInterval
value.

11. Save the changes to the service configuration.
12. Exit from the GPM.

Services and Adapters - Show Advance State Button: Before you begin an upgrade,
review the following Show Advance State button information.

The Show Advanced State check box has been removed from the Services
Configuration search screen. Instead, the default has been changed to always show
the advanced state without needing to check a checkbox on the search screen to
display it.

Some Certificate Fields Are Optional:
About this task

Before you begin an upgrade, review the following certificate field information.

When generating certificate keys, the following fields may have been missing in
the release you are upgrading from, but the entries are now optional:
v alt.name.dns
v alt.name.IP

Support for Multiple AS2 Organizations: Before you begin an upgrade, review the
following AS2 schema information.

Sterling B2B Integrator now supports multiple sponsoring organizations and
multiple partners for AS2. During upgrade, the single organization will be flagged
as the default organization.

Once you have upgraded to this version, a prefix designation is used to
differentiate between an AS2 organization (AS2_ORG_) and an AS2 partner
(AS2_PART_). Each of these will require the full configuration of a trading partner
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to allow for a partner to trade with multiple organizations as well as an
organization that trades with multiple partners.

The AS2_TRADEPART_INFO and AS2_EMAIL_INFO tables have been modified
and the AS2_PROFILE table is newly introduced. Updates to these tables will
occur during the SI in-place upgrade process in the following manner:
v Identify the default organization and populates the AS2_PROFILE table with

organization information. A default organization is an AS2 organization profile
named "profile_ORGANIZATION" present in the system before upgrade.

v Identify partner records and populates the AS2_PROFILE table with partner
information.

v Populate the new columns of table AS2_TRADEPART_INFO with the default
organization information.

v Populate the new PROFILE_ID column in the AS2_EMAIL_INFO table with the
profile id of the AS2 organization profile present in the system.

Web Services: Before you begin an upgrade, review the following Web Services
information.

Many of the Web Services configuration settings that were generated from the
WebServices Provider Configuration UI have moved from the property files into
database tables. This change was made to allow a single location of these settings
in cluster environments and to ensure that these settings would not be reset during
a fix pack installation.

After you have completed your upgrade, you should run the
convertWSSoaProperties script found in the installation bin folder. This script reads
the settings from the property file and places them into the proper database tables.
You can then review the results in the WebServices Provider Configuration UI.

Windows 2008 Does Not Start with Response File Install:
About this task

Before you begin an upgrade using IBM Installation Manager and the response file
method, review the following information.

If you used the response file install method for your upgrade, you must manually
run the InstallWindowsService.cmd file to register the service.

Upgrade Planning
Proper planning will help ensure a trouble-free upgrade.

Before you begin an upgrade you should:
v Read and become familiar with this document so that you have a clear

understanding of what the upgrade requires.
v Review upgrade scenarios to determine which scenario you want to use.
v Review and record system configuration information.
v Review and record performance and tuning information.

Upgrade Planning Checklist: To assist you with your upgrade planning, review
the following planning checklist:
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# Upgrade Planning Checklist Your Notes

1 Read through this entire document so that you have a
clear understanding of what the upgrade requires.

2 Download and review the following information from
the Sterling B2B Integrator documentation library.

v System Requirements - With each release, IBM
introduces leading edge technology to improve and
enhance its software. Review the System Requirements
to confirm that your system and databases meet the
requirements for this release.

v Release Notes - Review the release notes to obtain
information about issues and resolutions which have
been identified for this release.

v What's New in this Release - Review this guide to find
out about new features and functionality provided in
this release.

v Installation and Upgrade Information - Lists the
installation and upgrade documents available for this
version of Sterling B2B Integrator.

3 CAUTION:
Before upgrading to the latest product version, contact
your sales representative to verify that it includes all
of your current functionality. Depending on the
timing, even though it's in a higher version that the
one you have installed, a particular mod release or fix
pack might not include all the functionality in your
current version or fix pack.

4 Collect information on third-party libraries used for
adapter configurations that were added to your current
release.

You will need to add each of these libraries to the
upgraded system.

5 Locate any configuration file changes for JDBC adapter
or Lightweight JDBC adapter in your current release.

You will need to copy these changes to the upgraded
system.

6 Record your performance tuning configuration.

You will need to restore these settings after the system
has been upgraded.

7 Review and note the adapters, business processes, and
other configurations in your current release.

This information will help you identify the need for
updating transport messages, third-party adapters, or
configurations to adapters, such as File System or
Command Line adapters.
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# Upgrade Planning Checklist Your Notes

8 Determine if you have edited any of the property files
(.properties or .properties.in).

The upgrade process overwrites these property files,
unless these changes were made using the
customer_overrides.properties file. Your previous
property file edits might not be applicable this version
of the software.

9 Determine if you edited any of the following cdinterop
files:

v cdinterop-proxy-records.properties

v cdinterop-spoe-auth.properties

v cdinterop-spoe-policy.properties

v cdinterop-user-records.properties

You must back them up before upgrading. The
cdinterop files do not have initialization (*.in) files. After
the upgrade, use the backup version of the files in your
upgraded installation.

10 Determine if you have LDAP (Lightweight Directory
Access Protocol) configuration information in the
security.properties file. This information will
automatically be moved to the
authentication_policy.properties file.

11 Determine whether Sterling B2B Integrator is using an
application server (JBoss™, WebLogic® or WebSphere®).

Sterling B2B Integrator does not require an application
server for installation or at runtime.

Sterling B2B Integrator supports integration with JBoss
and WebLogic during the installation. You can also
integrate with WebSphere, JBoss, or WebLogic by using
the Sterling B2B Integrator EJB Adapter. This does not
represent a WebLogic server for deploying the
Application Console.

12 If you use a File System as your document storage
method, determine and record the path to the File
System.

You will need the File System path structure so that
after the upgrade, you can copy/mount the documents
to the new installation directory. The directory structure
(path to the File System) must be the same in the
current and in the upgraded system.

13 Review the EDI Sequence Check Queue to ensure that
no interchanges are in the queue. The EDI Sequence
Check Queue is used for X12 and EDIFACT sequence
and duplicate checking.

14 Determine if you have any JVM Containers configured.

If yes, you will have to reconfigure the JVM containers
after you have upgraded the software.
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Prepare Your System for the Upgrade
To help ensure a trouble-free upgrade, be sure to prepare your system before
beginning the upgrade.

Before you begin the upgrade :
v Complete all Pre-Upgrade Checklists.
v Verify that your system meets all system requirements.
v Obtain the upgrade media.
v Create a process output log (optional).
v (Microsoft SQL Server only) Configure the snapshot feature (optional).
v (DB2 only) Upgrade DB2 to version 10.1 or 10.5, if needed.

Pre-Upgrade System Checklist:

Use the Pre-Upgrade System Checklist to help ensure that your system is ready for
upgrading and reduce the chance of errors or other problems during upgrade.

Before you begin an upgrade:

# Pre-Upgrade System Checklist Your Notes

1 Use the system requirements to verify that your system hardware
and software meet the requirements specified for this release.

Verify you have the correct:

v Patches required by Java™ for the operation system

v Version of the JDK

v JDK Patches

v Absolute path to JDK and patches

v Database must match the version listed in the requirements

If any of the above requirements are not met, the installation will
fail and print/log a report of all items that were non-compliant.

Ensure that you have the correct license file and JCE file.
Important: Do not remove the existing license file or JCE file
from your system. The files specified by the LICENSE_FILE_PATH
and JCE_DIST_FILE parameters in the sandbox.cfg file must be
present during the upgrade, or the upgrade will fail.

2 For systems with multiple IP addresses, verify that the IP address
on which Sterling B2B Integrator resides is accessible by any
client computer that is running a browser interface.

If you do not verify the IP addresses, your system may not
operate properly after installing Sterling B2B Integrator.

3 If you are using a non-English environment, confirm that you are
using the appropriate character set.

4 Verify the file system has adequate free disk space.

5 Obtain the upgrade media.

It is a best practice to check the Product Updates and Downloads
site to ensure you have the latest version of the media.
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# Pre-Upgrade System Checklist Your Notes

6 Backup your Sterling B2B Integrator installation directory and the
database.

If there are problems with your upgraded system, the only way
to ensure that you can roll-back to your previous version is to
back up Sterling B2B Integrator and the database.

7 Archive your data.

Archived data can only be restored from the same version of
Sterling B2B Integrator from which it was archived. If you need to
restore archived data that was archived prior to performing the
upgrade, then you must have a running instance of Sterling B2B
Integrator that matches the version from which the archive was
taken.

8 Purge any unneeded data.

9 Export any business objects that can not be upgraded. Including
business processes, service configurations, trading partners, and
maps.

The exported business object can be imported into the upgraded
system if you need them.

10 Create a process output log.

11 Disable the virus protection software on the server.

If the virus protection software is enabled, the upgrade will fail.

Pre-Upgrade Database Checklist (Cluster Environment): Before you begin an
installation, you need to:

#
Pre-Upgrade Database Checklist (Cluster
Environment) Your Notes

1 If required, copy your Microsoft SQL Server
Database to a supported version.

This is an optional procedure, and it is the
customer's responsibility to perform it. (IBM
Customer Support can not help with this
procedure.)

2 If required, update your Oracle database to a
supported version.

If you plan to import an Oracle database, while
upgrading to this version of Sterling B2B
Integrator, you must import the database without
the indexes.

For example, if you are using the Oracle import
(imp) tool, you should use the INDEXES=N option.
If you attempt upgrading to this version of Sterling
B2B Integrator with indexes turned on, the
upgrade will fail. If you had created any custom
indexes in Oracle database, add them after
performing the upgrade as they are not imported.
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#
Pre-Upgrade Database Checklist (Cluster
Environment) Your Notes

3 If you are using MySQL, a new MySQL database
will be created in this version of Sterling B2B
Integrator and information will be copied from the
MySQL database in your previous version of
Sterling B2B Integrator to the new database.

The MySQL database in your previous version of
Sterling B2B Integrator will still work. When you
copy your database, if you encounter Data
Overflow or Invalid Time Format errors while
copying the WORKFLOW_CONTEXT table, run
this query:

UPDATE WORKFLOW_CONTEXT SET ENTERQ = NULL,
EXITQ = NULL where ENTERQ IS NOT NULL OR EXITQ
IS NOT NULL

Pre-Upgrade Operating System Verification Checklist:

Before you begin the upgrade, you need to verify your operating system
configuration.

For the Operating System Operating System Configuration Checklist Your Notes

HP-UX Operating System Verify these settings:

v Verify kernel parameters and establish the following
minimum settings by running the kctune command:

– kctune max_thread_proc 1024

– kctune maxdsiz 2147483648

– kctune maxdsiz_64bit 8589934592

– kctune maxssiz 369098752

– kctune maxssiz_64bit 536870912

v Run ulimit utility, verify, and establish the following
minimum settings:

– ulimit -d = 2097152 (in kilobytes) or higher

– ulimit -s = 360448 (in kilobytes) or higher
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For the Operating System Operating System Configuration Checklist Your Notes

AIX Operating System You must specify the name of the installation directory
name. The installation process creates the directory and
beneath it, a directory called “install”.

To ensure that /install_dir/install has the necessary
permissions, AIX users must run the following
command on the parent directory of /install_dir/install
before installation:

chmod -R a-s <absolute path>/install_dir_parent

where install_dir_parent is the directory in which
/install_dir/install will be created.

For example, to specify

AIX_1/applications/test1/my_install as your
installation directory, you could run the command from
the AIX_1/applications directory (directly above the
test1 directory):

chmod -R a-s test1

or from another location on the file system:

chmod -R a-s /AIX_1/applications/test1

This ensures that when the my_install directory is
created during installation, it inherits the correct
permissions from test1.

Solaris Operating System Set the following entries in the /etc/security/limits
file:

nofiles = 4096

set rlim_fd_max=4096 (limit is 65535) - hard limit

set rlim_fd_cur=4096 - soft limit

For nofiles, the value shown is an example. The
possible values are unlimited, so the number for nofiles
can be much larger. Revise the value as appropriate for
your business needs.

v To make the setting effective as the hard limit, reboot
the server or run the following command:

kill -1 inetd

v To make the setting effective as the soft limit, use the
parent shell configuration (for example, .profile).
Then, reboot the server.

Linux Operating System You need to disable SELinux by enter the following:

/etc/sysconfig/selinux: SELINUX=disabled

Ensure that /etc/hosts has short-names first for all
entries. For example,
127.0.0.1localhostlocalhost.localdomain

If the base locale is English, verify:

v that the LANG variable is en_US

v LANG variable is exported
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For the Operating System Operating System Configuration Checklist Your Notes

RedHat Enterprise Linux
Operating System

Make the following system changes:

v If the base locale for the system is English, edit the
/etc/sysconfig/i18n file by changing the
SUPPORTED variable from en_US.utf8 to en_US. You
can also allow multiple support using the following
format: en_US.utf8:en_US

v Save and close the /etc/sysconfig/i18n file. Edit the
/etc/security/limits.conf file by adding the
following lines:

– * hard nofile 8196

– * soft nofile 4096

– * hard memlock 3000000

– * soft memlock 3000000

– * hard nproc 16000

– * soft nproc 16000

– * hard stack 512000

– * soft stack 512000

This updates the system ulimits.

For nofile, the values shown are examples. The
possible values are unlimited, so the numbers for hard
nofile and soft nofile can be much larger. Revise
these values as appropriate for your business needs.

v Save and close the /etc/security/limits.conf file.

v Reboot the system.

IBM Installation Manager in UI mode may fail to start
on an RHEL 6.1 or higher x86_64 (64-bit) OS because
Installation Manager is a 32-bit application and is
dependent on some of the 32-bit libraries.

For information on installing the required 32-bit OS
libraries, refer to the IBM Support Website
(https://www-304.ibm.com/support/
docview.wss?uid=swg21459143)

CAUTION:
Due to a known issue with the IBM JDK on RHEL 6.1
or higher, a performance degradation might be seen in
comparison to previous RHEL releases. To avoid this
issue, disable the CFS on RHEL 6.1 or higher.

To disable CFS:

v Log in as root

v Edit /etc/sysctl.conf and add
"kernel.sched_compat_yield = 1"

v Reboot the system

For more information go to the IBM SDK and
Runtime Environment Java Technology Edition
Version 6 Information Center and search for known
limitations on linux.
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For the Operating System Operating System Configuration Checklist Your Notes

SUSE Linux Operating
System

Make the following system changes:

v If the base locale for the system is English, edit the
/etc/sysconfig/i18n file by changing the
SUPPORTED variable from en_US.utf8 to en_US. You
can also allow multiple support using the following
format: en_US.utf8:en_US

v Save and close the /etc/sysconfig/i18n file. Edit the
/etc/security/limits.conf file by adding the
following lines:

– * hard nofile 8196

– * soft nofile 4096

– * hard memlock 3000000

– * soft memlock 3000000

– * hard nproc 16000

– * soft nproc 16000

– * hard stack 512000

– * soft stack 512000

This updates the system ulimits.

For nofile, the values shown are examples. The
possible values are unlimited, so the numbers for hard
nofile and soft nofile can be much larger. Revise
these values as appropriate for your business needs.

v Save and close the /etc/security/limits.conf file.

v Reboot the system.

Verification of the system requirements:

Before you begin the installation, verify that your system meets the hardware and
software requirements that are specified for this release.

The hardware requirements that are listed in the System Requirements are the
minimum requirements. Your system requirements might exceed these
requirements if you are running other applications on the same machine as Sterling
B2B Integrator.

The installation strictly enforces the following system requirements:
v Operating system version must match requirement exactly.
v The minimum patch level for the operating system is enforced, but you can

apply higher patch levels.
v JDK version must match requirement exactly.
v The disk space is a minimum for the installation. The system must be separately

sized to handle whatever load is going to be put on the system.
v Database version must match exactly.
v JDBC driver version supports exact matches and wildcard matches.

If any of these requirements are not met, the installation fails. If the installation
fails, review the installation log for a list of non-compliant items.
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Upgrading your JDK (Windows and UNIX):

Sometimes you need to upgrade your JDK version to support a new version of
Sterling B2B Integrator.

About this task

If you have V5.2.4.1 or higher installed, you can use the upgradeJDK script to
upgrade your version of the JDK. See bin Directory Files for more information.

If you have V5.2.4.0 or lower installed, follow the steps below to upgrade your
JDK.

Procedure

1. Download the new JCE file. For example, the UnrestrictedPolicy.zip policy
file for the IBM JDK.

2. Back up the existing JDK in <Install Dir>/jdk. Change the folder name to
jdk_back)

3. Copy the new IBM JDK (1.7.0 ) folder to the installation Directory. Directory
Name should be jdk )

4. Copy all the jars present in <Install Dir >jdk_back\jre\lib\ext to <install
Dir>jdk\jre\lib\ext directory.

5. If your installation of V5.2.4 or lower was built using the Oracle (SUN) JDK,
continue to the next step. Otherwise skip to step 6.
a. Edit the sandbox.cfg property file.
b. Set JCE_DIST_FILE=<New Path of Supported JCE File>. For example,

JCE_DIST_FILE=D\:\\IBM\\unrestrictedpolicyfiles.zip.
c. Back up the local_policy.jar and US_export_policy.jar files present in

<Install Dir>jdk\jre\lib\security.
d. Unzip the new JCE file. For example, Unrestrictedpolicyfiles.zip file.

Copy local_policy.jar and US_export_policy.jar to <Install
Dir>jdk\jre\lib\security.

6. Run updateJavaSecurity.cmd <path_to_new_jdk><Install Dir>/jdk.
7. Verify that security providers have been updated in <Install

Dir>\jdk\jre\lib\security\java.security.
8. Follow the Upgrade Guide instructions for your upgrade scenario.

Obtain Upgrade Media:
About this task

Before you upgrade, ensure that you have the latest version of the upgrade media
from the Passport Advantage online site or have downloaded the fix pack from Fix
Central..

For the latest version and for online support, go to: http://www.ibm.com/
software/howtobuy/passportadvantage/pao_customers.htm

Note: For V5.2.6, the fix pack download used for upgrading from V5.2.x to V5.2.6
is very large. It includes the new functionality for Global Mailbox. You must
download the full fix pack file to upgrade to V5.2.6 by installing a fix pack even if
you do not plan to install Global Mailbox.

Create Process Output Log:
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About this task

A log of process activity during the upgrade will help if troubleshooting is
required. Output is automatically logged to the upgrade log files (PreInstallSi.log
and InstallSi.log). Use this procedure to generate a separate output log for each
process you want to log.

To create a process output log:

Procedure

1. From any directory, run the script command to record the processes, ensuring
that you have created and specified the name of the file in which to save the
process output.
For example, to start recording output to a file named processoutput.log, type
script processoutput.log at the command line. The processoutput.log file will be
created in the directory where you ran the script command.

2. After the upgrade is complete, enter exit at the command line to stop
recording.

3. You can now retrieve the file containing the process output.
The following example shows a session after starting the script command,
specifying the output to be saved to the file named listing.log, and typing exit
to stop the script command from running:
[2]%script listing.log

Script started, file is listing.log
[3]%ls
Custard.Recipe FavoriteRecipes Curry.Recipe
VindalooCurry.Recipe Jelly.Recipe
[4]%exit
Script done, file is listing.log

Configuring the snapshot feature for Microsoft SQL Server:

The snapshot feature in Microsoft SQL Server allows you to view a read-only copy
of the database even when it is locked. Configuring the snapshot feature can also
reduce deadlocks. To enable the snap shot feature, enter the following command:
ALTER DATABASE db_name SET READ_COMMITTED_SNAPSHOT ON;

Upgrading DB2 to version 10.1 or 10.5:

To upgrade from DB2 9.5 or 9.7 to 10.1 or 10.5, you must make configuration
changes.

Procedure

1. Complete the steps in the following table that pertain to your version of
Sterling B2B Integrator before you proceed to step 2.

Important: Back up all files before you change any settings.

If you are upgrading from ... Do the following steps:

Sterling B2B Integrator 5.1.x Upgrade Sterling B2B Integrator to V5.2.6
and point to your DB2 9.5 or 9.7 database

Sterling B2B Integrator 5.2.x Upgrade your 5.2.x installation to V5.2.6

2. Copy your DB2 9.5 or 9.7 database content to DB2 10.1 or 10.5.
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3. Take a backup of the database driver located at /install_dir/dbjar/jdbc/DB2/
and then replace it with the DB2 10.1 or 10.5 version.

4. Update the following sandbox.cfg file fields with your environment-specific
parameters:
DB_PASS=
DB_SCHEMA_OWNER=
DB_DRIVERS_VERSION=
YANTRA_DB_PORT=
DB_DATA=
DB_HOST=
YANTRA_DB_USER=
DB_PORT=
YANTRA_DB_PASS=
YANTRA_DB_DATA=
YANTRA_DB_HOST=
DB_DRIVERS=
DB_USER=

DB2_PORT=
DB2_USER=
DB2_PASS=
DB2_DATA=
DB2_HOST=

5. Edit the following in the activemq.xml file:
activemq.xml: <value>jdbc:db2//DB_HOST:DB_PORT/DB_DATA</value>

6. Run the setupfiles script.
7. Run the deployer script.
8. Start Sterling B2B Integrator.

Information Gathering Checklist

Information Gathering Checklist for Upgrades (Windows Cluster): Before you
begin the upgrade, you should review the information in the Information
Gathering Checklist. The checklist contains all of the information that you will
need to have while running the upgrade scripts. Supporting information and
details are included at the end of this chapter.

The checklist contains:
v Brief descriptions for tasks (detailed procedures are provided after the checklist)
v Information you need to gather to prior the starting the upgrade

You may want to make a copy of the following checklist and use it to record the
information you collect for each node in the cluster.

The cluster environment does not support the following items:
v MySQL database
v AS2 Edition

#
Information Gathering Checklist for Windows
Cluster Upgrades Your Notes

1 Review your IBM contract to determine what
software you have licensed. You need to know this
License Information so that you can select the correct
components/features to upgrade.
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#
Information Gathering Checklist for Windows
Cluster Upgrades Your Notes

2 Determine which upgrade method you are going to
use:

v IBM Installation Manager (Graphical User
Interface)

v IBM Installation Manager (Response File)

v Apply V5.2.6 as a fix pack (manual)

v Apply V5.2.6 as a fix pack (script)

3 Determine if you are going to run the pre-upgrade
checks during the upgrade.

4 Determine if you are going to use multicast ports.

5 Decide which type of security certificates you will
use:

v The default self-signed SSL (Secure Sockets Layer)
certificate that is automatically installed.

v A Certificate Authority-related certificate that you
install before installing the software.

6 If you are using an Oracle, SQL Server, or DB2
database, decide if you are going to manually or
automatically apply Database Definition Language
(DDL) Statements (schema) to the database.

7 If you are using an Oracle 11.1 database, you must
set it up for native compilation by allocating space
and by setting the plsql_native_library_dir
parameter.

8 Determine if you are going to use FIPS (Federal
Information Processing Standards) mode.

9 Record the Hostname on which you plan to install
the software.

10 Record the Directory Name where you plan to install
the software.

11 Record the Login to host machine.

12 Record the Password to the host machine.

13 Record the path to the JDBC drivers.

14 Record the path to the installation wizard and file
name.

15 Record the path to JDK.

16 Record the path to JCE file.

17 Record the Host IP address.

18 Record the Initial Port Number.

19 Record the System passphase.

20 Record the Administrative e-mail address to which
system alert messages are sent.

21 Record the SMTP Server IP address used for sending
alert messages.

22 Record the Database vendor name.

23 Record the Database user name.
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#
Information Gathering Checklist for Windows
Cluster Upgrades Your Notes

24 Record the Database password.

25 Record the Database (catalog) name.

26 Record the Database host name.

27 For Oracle, Microsoft SQL Server, and DB2 record
the path and file name for the JDBC Driver.

Supporting Information:

Pre-Upgrade Check for Clusters: Pre-upgrade check reviews Oracle, SQL Server, and
DB2 database environments prior to starting the upgrade. This is an optional
installation feature which looks for are common upgrade errors. You only need to
run the pre-check for node 1.

The pre-upgrade checks ensure:
v SI_VERSION table exists
v Database character set is correct for Oracle and DB2
v Schedule start times are not later than the end times
v Passphrase entered matches the existing passphrase in the database
v Database implementation for Oracle Long Raw and BLOB
v User has permission to perform the upgrade
v Collation settings are validated for MS SQL
v OBJECT_NAME is table SCI_ENTITY is no longer than 100 characters
v Default schema you identified during upgrade matches the existing database

If any of these items are not validated, the upgrade fails. You are provided with an
error message and must correct the situations and then restart the upgrade.

License information:

A separate license is required for each Sterling B2B Integrator feature that you
purchased. During installation, you must choose the license files according to what
you purchased. Product licenses do not require an activation key.

IBM assumes customers will only install and use the products they purchased. IBM
reserves the right to inspect installs for compliance at any time.

After the installation finishes, if you determine that you need to modify licenses
files, see “License modifications” on page 58.

Product Licenses for Sterling B2B Integrator

Sterling B2B Integrator Standard and Enterprise Edition includes:
v MESA Studio
v eInvoicing
v Report Services
v all services and adapters not listed below

Sterling B2B Integrator Standard and Enterprise Financial Edition includes
everything listed above plus:
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v CHIPS
v SWIFTNet
v NACHA ACH CTX adapter
v FEDWIRE
v Fin Serv XML standard
v FIPS Mode
v Image Cash Letter service
v EBICS

Multicast ports in node to node communications:

Cluster nodes are configured to communicate with each other using JGroups, an
open source toolkit that provides flexibility for protocol configuration.

JGroups provides rich open management features, along with multiple protocol
support. JGroups supports multicast (UDP) and TCP-based communication
protocols.

When JGroups is configured to use multicast (UDP), all cluster nodes communicate
with each other on a specific IP address and port. The configuration of multicast
ports is based on the installation base port. All clusters that are on the same subnet
that is configured on the same base port send multicasting messages on the same
multicast IP address and port.

To avoid this situation, each cluster on the same subnet needs to be configured on
different base ports. Install your clusters on different port ranges or on different
network segments with multicast forwarding restricted, so that they do not
interfere with each other. The default multicast address is 239.255.166.17. This
address is configurable, with a port range of 10 ports, starting with the multicast
base port for the instance.

All nodes that are participating in the same cluster must be installed on the same
multicast base port (the multicastBasePort property in the
noapp.properties_platform_ifcresources_ext.in file). This value is usually
computed from the system base (non-multicast) port, but can be configured
separately in the noapp.properties_platform_ifcresources_ext.in file, to allow
different nodes in a cluster to be installed at different (non-multicast) port ranges.
Also, all the nodes in the cluster must be installed in the same subnet.

For node to node communications, the properties are defined in the
jgroups_cluster.properties file. The following attributes are used to define
communications:
v property_string - default value is UDP.
v distribution_property_string - default value is TCP. This attribute must never

be set to UDP.

If you want to change the communication for cluster multicast from the UDP
protocol to TCP, you need to change the value of the property_string property in
the jgroups_cluster.properties.in file (after you back up the file). Then, run the
setupfiles command. You can change this value right after the installation or after
you start running the cluster. If you change the file after you start the cluster, you
need to stop all nodes of the cluster, change the value on each node, and then
restart your cluster.
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To change the communication for cluster multicast from the UDP protocol to TCP,
use the following value for the property_string property in the
jgroups_cluster.properties.in file:
property_string=TCP(start_port=any_available_port_number):
TCPPING (initial_hosts=this_instance_host_ip[start_port_number],
theothernode_instance_host_ip[theothernode_start_port_number];port_range=2;
timeout=5000;num_initial_members=3;up_thread=true;down_thread=true):
VERIFY_SUSPECT(timeout=1500):pbcast.NAKACK(down_thread=true;up_thread=true;
gc_lag=100;retransmit_timeout=3000):pbcast.GMS(join_timeout=5000;
join_retry_timeout=2000;shun=false;print_local_addr=true;
down_thread=true;up_thread=true)

For more information about UDP, TCP, and JGroups communications, see the
Sterling B2B Integrator Clustering documentation.

Security certificates:

You can choose between different security certificates before you install Sterling
B2B Integrator.

Before you begin the installation, you must decide which of the following security
certificates to use:
v The default self-signed SSL (Secure Sockets Layer) certificate that is

automatically generated by the installation.
v A Certificate Authority-related certificate that you generate before you install the

software.

If you install with the default SSL certificate, but you later want to switch to a
CA-related certificate, you can change the certificate with the sslCert property in
the noapp.properties_platform_ifcresources_ext.in file.

Port Numbers in a Windows Environment: During installation or an upgrade, you
are prompted to specify the initial port number for Sterling B2B Integrator.

To specify an initial port number, follow these guidelines:
v Sterling B2B Integrator requires a range of 200 consecutive open ports between

1025 and 65535. The port range starts with the initial port number and ends
with the number that equals the initial port number plus 200. For example, if
you specify 10100, then you need to make sure that 10100 through 10199 are not
used by any other applications on your system.

Note: Because of RMI, on occasion, a port number outside the range may be
assigned.

v The initial port number represents the beginning port number in the range.
v Make sure that port numbers in the port range are not used by any other

applications on your system.

During the upgrade, about 50 default ports are pre-assigned for different services.
For example, if you do not want xxx32 (10132) to be a default port, you could
assign that port to xxx97 or another number within the port range.

After your installation or upgrade, refer to the \install_dir\install\properties\
sandbox.cfg file for all of the port assignments.
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Database Definition Language (DDL) Statements: When you install Sterling B2B
Integrator, you can manually apply Database Definition Language (DDL)
statements to your database tables instead of requiring the installation process to
do it directly.

This feature increases database security by reducing the database permissions of
the Sterling B2B Integrator database user. The rights to database objects can be
reserved for a secure user like a customer database administrator (DBA). A
business can require that only a DBA with the proper permissions can make
database changes.

Upgrade the Software

General Windows Cluster Upgrade Information: CAUTION: Sterling File
Gateway should be installed behind a company firewall for security purposes. See
the Perimeter Server and Security topics in the Sterling B2B Integration
documentation library for more information on secure deployment options.

Windows Cluster Information

The cluster environment does not support the following items:
v MySQL database
v AS2 Edition

Upgrading Sterling File Gateway cluster nodes is similar to upgrading a Sterling
File Gateway single node, with the following restrictions on all nodes:
v All nodes must use the same database.
v All nodes must use the same passphrase.
v All nodes must use the same operating system.
v When installing nodes on different machines, the initial port numbers must be

the same. Installing nodes on different machines helps you take more advantage
of the reliability, availability, and scalability features of clustering, including
failover.

v When installing nodes on the same machine, you must install nodes 2 and
higher in different directories and use different initial port numbers. Each initial
port number must be at least 100 higher or lower than other initial port
numbers.

v Nodes must be installed sequentially, one at a time, starting with the first node.
v After installing all of the nodes, nodes must be started sequentially, one at a

time, starting with the first node.
v Obtain a valid Sterling File Gateway license for multiple IP addresses of all the

nodes where Sterling File Gateway will be installed and configured as a cluster.
v To install more than one instance of Sterling File Gateway on the same Windows

server, you must install the second instance in a different directory.
v If you are using FTP to copy the files, verify that your session is set to binary

mode.
v Sterling File Gateway does not support IPv6 installation on Windows. Before

applying an IPv6 address, see the IPv6 Capabilities section in Sterling File
Gateway System Requirements guide.

v If you are installing Sterling File Gateway on VMware, provide the IP address of
the virtual machine, not the IP address of the VMware host. For example, if
10.251.124.160 is the IP address of the VMware host and 10.251.124.156 is the IP
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address of the Windows 2003 server it is hosting, you should use 10.251.124.156
as the correct IP address to install Sterling File Gateway.

v The installation creates subsequent ports based on the initial port number. For
all of the port assignments, see the \install_dir\install\properties\sandbox.cfg
file.

v If you are running the upgrade on an active installation of Sterling File Gateway,
you will need to run the soft stop command to gracefully stop traffic. For more
information, see the Soft Stop documentation in the System Administration
Guide.

General IBM Installation Manager information:

IBM Installation Manager V1.8.2 is required to install Sterling B2B Integrator on all
supported platforms.

Installation Manager is a Java based multiplatform installation application and
provides a consistent approach across various platforms. It does not rely on
platform-specific installation technology or mechanism.

Installation Manager uses the local Sterling B2B Integrator offering repositories to
install or update Sterling B2B Integrator and its add-on features. It determines the
packages that must be installed and displays them including the products, fix
packs, and interim fixes. It checks that all prerequisites and interdependencies are
met before installing the selected product package and feature sets.

Important: The Uninstall option only unregisters Sterling B2B Integrator from
Installation Manager. The uninstall procedure as described in the related sections
must be performed to completely uninstall Sterling B2B Integrator.

Installation Manager must be installed on each computer on which Sterling B2B
Integrator is being installed. If you already have Installation Manager installed on
your computer for use with other IBM applications, it can be used with installing
Sterling B2B Integrator as long as it's the correct version. If you do not have
Installation Manager installed, it is provided as part of the Sterling B2B Integrator
installation media.

Supported bit-versions

A 64-bit version of IBM Installation Manager V 1.8.2 is provided with the Sterling
B2B Integrator installation package. However, you can also install with a 32-bit
version of Installation Manager.

Before you start the installation, consider the following options:
v If you are a new customer, use the version of Installation Manager that is

provided with the Sterling B2B Integrator installation package and install
Sterling B2B Integrator.

v If you have an earlier version of Installation Manager, you can update it to
V1.8.2 using the Installation Manager that is provided with the installation
package, then install Sterling B2B Integrator .

v If you are a current customer who did not use Installation Manager earlier,
install the version of Installation Manager that is provided with the installation
package, then upgrade your Sterling B2B Integrator installation.

v If you have a 32-bit Installation Manager installed, you must download the
32-bit Installation Manager V1.8.2 from Fix Central or IBM Passport Advantage,
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upgrade it, then proceed with the installation of Sterling B2B Integrator. Ensure
you have the required libraries that support screen presentation of the text.

Checking for updates

To check for Installation Manager updates, select Search for Installation Manager
updates on the File > Preferences > Updates page. When the check box is
selected, Installation Manager searches for updates when any one of the following
pages are opened from the Installation Manager start page:
v Install Packages
v Modify Packages
v Update Packages

Installation Manager also searches for updates when you click the Check for Other
Versions, Fixes, and Extensions button on the Install Packages page.

Starting Installation Manager

You should start the Installation Manager (and also install Sterling B2B Integrator)
as a non-administrator user.

How you start Installation Manager depends on whether you are using the
Installation Manager agent that is provided with Sterling B2B Integrator or if you
have an Installation Manager instance that is installed on your system. It also
depends on whether you have 32-bit or 64-bit Installation Manager.

Open a command prompt and do one of the following tasks to start the
Installation Manager in GUI mode:
v Go to the IM_<operating_system> directory and type ./userinst or userinst.exe

(Windows) for the following scenario:
– If you do not have Installation Manager installed and are using the

Installation Manager agent that is provided with the Sterling B2B Integrator
media.

– If you have a 64-bit Installation Manager installed.
– If you have Installation Manager installed on a platform that has only one

download available for Installation Manager. For example, AIX, Solaris, HP,
zLinux.

v Go to <installation directory>/Installation Manager/eclipse (for Windows
system, replace / with \) and type ./IBMIM or IBMIM.exe if you have 32-bit
Installation Manager installed on a Linux or Windows system.

For information on starting Installation Manager in command mode for silent
installation, see the Installing or updating with a response file.

For information on starting Installation Manager in command mode to record a
response file, see Recording a response file.

Additional heap memory parameters

The heap memory parameters specify the amount of memory Installation Manager
can use during the installation process. The heap memory pool sizes that are used
by Installation Manager are hardcoded defaults. If these defaults are not sufficient
for your environment, you can specify different values by adding parameters to
the Installation Managerconfig.ini file.
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Important: These additional parameters are required only if you are experiencing
Out Of Memory errors during the installation process.

The following parameters can be added:
v memoryMin=user.sb.INSTALL_<OS>_INIT_HEAP.<amount_of_memory>

v memoryMax=user.sb.INSTALL_<OS>_MAX_HEAP.<amount_of_memory>

Where <OS> is your operating system and <amount_of_memory> is the specified
amount of memory.

Operating
System Parameter Example Entry

Sun-Solaris Initial Heap Size

INSTALL_SUN_INIT_HEAP

memoryMin=user.sb.INSTALL_SUN_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_SUN_MAX_HEAP

memoryMax=user.sb.INSTALL_SUN_MAX_HEAP.3072m

Linux Initial Heap Size

INSTALL_LINUX_INIT_HEAP

memoryMin=user.sb.INSTALL_LINUX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_LINUX_MAX_HEAP

memoryMax=user.sb.INSTALL_LINUX_MAX_HEAP.3072m

AIX Initial Heap Size

INSTALL_AIX_INIT_HEAP

memoryMin=user.sb.INSTALL_AIX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_AIX_MAX_HEAP

memoryMax=user.sb.INSTALL_AIX_MAX_HEAP.3072m

HP-UX Initial Heap Size

INSTALL_HPUX_INIT_HEAP

memoryMin=user.sb.INSTALL_HPUX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_HPUX_MAX_HEAP

memoryMax=user.sb.INSTALL_HPUX_MAX_HEAP.3072m

Windows Initial Heap Size

INSTALL_WIN_INIT_HEAP

memoryMin=user.sb.INSTALL_WIN_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_WIN_MAX_HEAP

memoryMax=user.sb.INSTALL_WIN_MAX_HEAP.3072m

Installing or updating with a response file (V5.2.6 or later):

You can install or update (apply fix pack or interim fix) Sterling B2B Integrator
with silent mode by using the sample response files or converting your existing
response file to the required format.

Upgrading in a Windows cluster environment with the IBM Installation
Manager in GUI mode:

You can upgrade Sterling B2B Integrator in a Windows cluster environment with
the IBM Installation Manager in a graphical user interface (GUI) mode.
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Before you begin

v Ensure that your system is ready for the upgrade. See “Prepare Your System for
the Upgrade” on page 332.
Attention: Failure to properly prepare your system can cause the upgrade to
fail.

v Complete the “Information Gathering Checklist for Upgrades (Windows
Cluster)” on page 340.

v You must have administrative privileges and a login on the host machine to do
an upgrade.

v If you are using the Standards Processing Engine (SPE) application with Sterling
B2B Integrator, you must upgrade SPE before you upgrade Sterling B2B
Integrator.

v If you are using the EBICS Banking Server application with Sterling B2B
Integrator, the data encryption for storage within the installation location is not
supported.

About this task

This upgrade changes the administrative password to the default password. After
the upgrade, change the password back to the administrative password to
minimize security risks. This is the Admin password for logging into the user
interface (/dashboard or /ws).

Important: Following is a list of changes related to installing or upgrading to
Sterling B2B Integrator V5.2.6:
v You can install and upgrade using IIM through the user interface or (response

files. Console mode installation and upgrade is not supported. IF you already
have V5.2.x installed, you can upgrade using a script.

v Sterling B2B Integrator JAR file is included in the repository. Therefore it is not
required to manually select the JAR file when installing or upgrading.

v You must use Installation Manager V1.8.2 to install or upgrade Sterling B2B
Integrator. InstallService is disabled, and cannot be used. You can use
InstallService, only for a specific scenario related to Sterling File Gateway. For
more information, see step 13.

Procedure

1. Close all open Windows programs and any command prompt windows.
2. From the installation media, copy the compressed upgrade package to a

location on your desktop.
3. Decompress the upgrade package.
4. Open the InstallationManager folder in the directory structure that is created

when the installation package is decompressed. Several
IM_OperatingSystem.zip files are displayed.

5. Decompress the IM_Win.zip file. This action creates the IM_Win folder.

Important: Installation Manager V1.8.2 is required to upgrade to Sterling B2B
Integrator V5.2.6. If Installation Manager was not used to install your current
Sterling B2B Integrator instance, the installation process installs the Installation
Manager when you start the upgrade to Sterling B2B Integrator V5.2.6. After
successful installation, restart the Installation Manager, and proceed with
upgrading to Sterling B2B Integrator V5.2.6.
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6. Decompress the Common_Repo.zip from the installation package. The action
creates two new folders b2birepo and gmrepo. The IM_Win, b2birepo, and
gmrepo folders must be at the same level in a directory.

Important: gmrepo contains the repository file required to install Global
Mailbox. For information about Global Mailbox, see Global Mailbox overview.

7. Do one of the following tasks to start the Installation Manager:
a. Go to the IM_Win directory and double-click userinst.exe for the following

scenarios:
v If you do not have the Installation Manager installed and are using the

Installation Manager agent provided with V5.2.6.
v If you have a 64-bit Installation Manager installed.

b. Go to <installation directory>\Installation Manager\eclipse and
double-click IBMIM.exe, if you have 32-bit Installation Manager installed on
your Windows system.

Important: It is suggested to record a response file. The response file can be
used to install Sterling B2B Integrator after applying database schema
manually or install second and subsequent nodes in a cluster. For more
information, see Installing or updating with a response file.

8. On the Installation Manager home page, click Install.

Important: If IM_<operating_system> and b2birepo directories are not in the
same directory or if you already have Installation Manager installed, then you
get a message saying that there no packages to install or Installation Manager
could not connect to the repositories. You must add the Sterling B2B
Integrator repository files to the Installation Manager repository. For more
information about adding repository files, see Repository preferences.

9. On the Install Packages screen, select IBM Sterling B2B Integrator. This
action selects the versions also. Click Next.

10. Review the license agreement and select the option I accept the terms in the
license agreements to continue.
If you do not accept the agreement, the upgrade process is canceled.

11. Select a location for the Shared Resources directory and a location for the
Installation Manager to reside:
a. Specify a Shared Resources Directory.
b. (Optional if previously installed) Specify an Installation Manager

Directory.

Note: The Shared Resources directory cannot be a sub-directory of the
Installation Manager installation.

The specified Shared Resources and Installation Manager directories must
be empty.

12. Choose Create a new package group and specify the path to Sterling B2B
Integrator installation directory.

13. Select the required features to be installed. The available options are:
v Sterling B2B Integrator

v IBM Sterling File Gateway

Important: If your current installation includes Sterling File Gateway, then
Sterling File Gateway is also updated to V 2.2.6 when upgrading to Sterling
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B2B Integrator V5.2.6. If Sterling File Gateway was not installed, it is not
installed when upgrading to Sterling B2B Integrator V5.2.6, when you select
the IBM Sterling File Gateway option. In this case, to install Sterling File
Gateway when upgrading, you must do one of the following tasks:
– When upgrading Sterling B2B Integrator, if you are installing Sterling

B2B Integrator to a fresh directory, and pointing to the previous database,
then you can install Sterling File Gateway V2.2.6.

– Use InstallService to install Sterling File Gateway. For information
about installing Sterling File Gateway by using InstallService, see
Installing Sterling File Gateway (V2.2.6 or later).

v FIPS Module

v AS2 Edition Module

v Financial Services Module

v EBICS Banking Server Module

v B2B Advanced Communications Integration Module

Important: When upgrading to Sterling B2B Integrator V5.2.6, select B2B
Advanced Communications Integration Module to install Sterling B2B
Integrator bridge. Sterling B2B Integrator bridge is required for
communication between Sterling B2B Integrator and B2B Advanced
Communications. If you are installing Global Mailbox and Sterling B2B
Integrator, then B2B Advanced Communications Integration Module
(Sterling B2B Integrator bridge) is installed by default, because Global Mailbox
uses the storage module of B2B Advanced Communications. However, you
must configure the adapter containers and adapters for Sterling B2B Integrator
bridge after upgrading.

Important:

Sterling B2B Integrator is selected by default. Select only the licenses and
features that were defined by your IBM contract. If you are unsure which to
select, the installation can proceed without a selection and complete
successfully. Startup and operation of the software, however, requires one of
the licenses to be selected. See “License modifications” on page 58 to apply
licenses after the installation.

Features that are not part of your current Sterling B2B Integrator installation
are disabled and you cannot select them when upgrading or applying a fix
pack. To include them in your Sterling B2B Integrator setup, you must first
upgrade to the current version, and then install them separately. If the fix
pack or upgrade JAR includes updates to features that are part of your current
Sterling B2B Integrator installation, the features are upgraded regardless of
whether you select the them or not.

Important: If you are upgrading to Sterling B2B Integrator from a previous
version, you must manually install the EBICS client. For more information
about installing the EBICS Client manually, see the EBICS Client User Guide.

14. Enter the full path to the JDK directory.
15. Specify the configuration for the features to install and click Next.

v FIPS Compliance Mode (Must enable FIPS Module)

v NIST 800-131a Compliance Mode

– off (default value)
– strict
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v SPE Integration Module (Requires pre-install of SPE, WTX optional)

If you select the SPE option, you are prompted for the following
information:
– SPE installation directory
– (Optional) WebSphere Transformation Extender (WTX) installation

directory
– SPE UI port
For more information, see the documentation for the integration of Sterling
B2B Integrator and SPE.

16. Enter the full path to your JCE file.
17. Enter your Installation panel properties information:

a. Enter the explicit IP address for the server or use the default value of
localhost.

b. Enter the Initial Port number or use the default value of 8080.
18. Enter your System Passphrase information:

a. Enter a passphrase.
b. Confirm the passphrase.

19. Enter you E-Mail Information:
a. Enter the E-mail address to which you want system alert messages sent.
b. Enter the SMTP mail server (IP address or host name) that you want to

use for system alert messages and other administrative notices.
20. Specify if you want to Enable FIPS (Federal Information Processing

Standards) mode, select the check box. The default is FIPS mode is disabled.
21. Select the database vendor you want to use:

v Oracle
v Microsoft SQL Server
v DB2
v MySQL
Clustering is not supported for Sterling B2B Integrator systems that use the
MySQL database, even though it appears as an option.

22. Select all options that apply to this node:

Choices: Action

This installation is for a cluster node 2 or
higher (Not applicable for MySQL)

v For node 1: Do not select the check box.

v For node 2 or higher: Select the check box.

Important: In a cluster setup, if you are
upgrading to a new installation directory,
run the startCluster command after
installing the first node (node 1) from the
\install_dir\install\bin directory, on the
host where you installed the node. The
syntax is startCluster.cmd nodeNumber
true. Replace nodeNumber with 1. After you
run the startCluster command for the first
node, the subsequent nodes will have
clustering automatically started by the
installer when they are installed. If you are
upgrading in the existing installation
directory, then it is not required to run the
startCluster command.
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Choices: Action

Apply database schema automatically? (Not
applicable for MySQL)

If yes, no action required. The default is to
automatically apply the DDL statements.

If you want to manually create the database
schema, then clear the Apply database
schema automatically check box and
continue with the remaining upgrade steps.
Important: Once the upgrade starts, it runs
for a short time and stops without error.
When the upgrade stops, you must perform
additional actions as given in Step 29 of this
procedure.

23. Enter the Database Connection Information.
v Database user name.
v Database password (and confirmation).
v Database catalog name.
v Database host name.
v Database port.
v For Oracle, Microsoft SQL Server, and MySQL - Absolute path and file

name for one JDBC driver file.
v For DB2 - Absolute path and file name for the JDBC driver file. Use the

Type-4 JDBC driver. This type of driver converts JDBC calls into the
network protocol used directly by DB2, allowing a direct call from the
system to the DB2 server.

24. Click Add to browse to the file location for the appropriate JDBC driver.
25. Click Test next to the database driver path.

Important: The Installation Manager must successfully validate the connection
to the database before you can continue with the upgrade. If there is a
validation failure you can view the system log to determine more information
about the failure. Perform the following:
a. Identify the location of the user’s application directory. Select Start -> Run

and enter %APPDATA%.
b. Navigate to the user’s application directory: local_path\IBM\Installation

Manager\logs

c. Open the index.xml file in a browser.
d. Identify the log file based upon the timestamp of when you started your

upgrade.
e. Click on the install file to view a listing of errors that occurred during that

upgrade.
26. Determine what Other options apply to this installation. Select the applicable

options:
v Verbose install

v This installation is an upgrade from a prior version - Select this option.

Important: After you select the upgrade option, an additional option is
displayed.

v Would you like to run upgrade pre-check? - To run the pre-check, click
Test.
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27. Specify the Performance configuration that applies to this upgrade. Select the
applicable options:
v Number of Processor Cores - Accept default value or enter appropriate

value.
v Physical Memory (MB) allocated to Sterling B2B Integrator - Accept

default value or enter appropriate value.
28. Review the installation package summary information
29. Click Install to continue.

Important: If you did not select the option to Apply database schema
automatically , the installation stops and you must perform these additional
steps to complete the installation with manual DDL statements:
a. Navigate to your install directory.
b. Locate the InstallSI.log file and open it with a file editor.
c. Search the file for these error messages:
v <SI_Install>/repository/scripts/EFrame_IndexAdds.sql must be applied

to the database.
v <SI_Install>//repository/scripts/EFrame_Sequence.sql must be applied

to the database.
v <SI_Install>//repository/scripts/EFrame_TableChanges.sql must be

applied to the database. Exiting installation..."

Important: If you do not find the above error messages in the log file, the
installation failed because of another reason and you must resolve that
error and attempt the installation again. If you did find these messages,
continue with the remaining steps.

d. Edit each .sql script and make changes appropriate for your database. This
may include changing the SQL delimiter or adding tablespace options.

e. Log in to your database as the DB schema user.
f. Execute the SQL files manually in this order:

Important: When you are executing the scripts, it is important to execute
the SQL scripts in the specified order.
v EFrame_IndexDrops.sql
v EFrame_TableChanges.sql
v EFrame_IndexAdds.sql
v EFrame_TextIndexAdds.sql
v EFrame_Sequence.sql
v EFrame_TextIndexModify.sql
v EFrame_TextIndexUpdates.sql
v EFrame_TextIndexUpgrade.sql
v EFrame_Static.sql

Important: ActiveMQ uses dynamically generated table names based on
the name of the install node. Table generation is not included in the above
scripts, but is performed automatically during the initial start of Sterling
B2B Integrator or when a new cluster node is added. Table generation may
fail if security restrictions have reduced the Sterling B2B Integrator
database user permissions. To avoid this issue, ensure that the DBADM
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role permissions are enabled during the initial startup. If further issues
arise, contact IBM customer support for guidance.

g. Exit from the database.
h. Navigate to the parent directory of install_dir.
i. Uninstall the Sterling B2B Integrator offering to clear out the Installation

Manager metadata about the installation, and the delete (or rename as a
backup) the Sterling B2B Integrator installation directory.

j. Restart the installation wizard and provide the same installation options
that you provided before you cleared the Apply database schema
automatically check box. If you have recorded a response file (as suggested
in step 8), you can use the response file to install Sterling B2B Integrator.

The Installation Progress screen indicates which component of the installation
is currently in process.
A status bar below the Repository Information heading displays the progress
of component installation. When the installation completes, a large green circle
with a checkmark displays with the message The packages are installed. A
link is provided to view the installation log file.
The installation completes automatically. When the installation is finished, the
system displays a dialog box with the message The install completed
successfully.

Installation information is in the InstallSI.log file.
30. Click Finish. The Installation Manager closes and you are returned to your

desktop.
Check the InstallSI.log to verify all the components have installed properly.
You will need to perform the Configure the Sterling B2B Integrator Desktop Icon
for Windows Server 2008 procedure if you use Windows Servers 2008.

31. Upgrade each subsequent node, from node 2 onwards. Navigate to your
working directory. For example, cd parent_install directory.

32. You need to start the Installation Manager for each additional node, click:
install.exe You will follow the same steps as you did for node 1 until you get
to Step 19. When prompted, select the This installation is for a cluster node 2
or higher check box.

33. If you used different base ports for node 2 onward, you need to complete the
following additional steps:

Step Action Your Notes

1 Navigate to \install_dir\install\properties for node 1.

2 In the noapp.properies_platform_ifcresources_ext file, record
the value for multicastBasePort.

3 In the jgroup_cluster.properties file, record the value for
mcast_port.

4 For each subsequent node, you need to perform the remaining
steps.

5 Navigate to \install_dir\install\properties for each node (node
2 and higher).
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Step Action Your Notes

6 In the noapp.properies_platform_ifcresources_ext.in file,
update the value of the multicastBasePort to match the value
for node 1.

For example, replace the string &MULTICAST_NODE_PORT1;
with the port number 45460:

v (before) multicastBasePort=&MULTICAST_NODE_PORT1;

v (after) multicastBasePort=45460

7 In the jgroups_cluster.properties.in file, update all
occurrences of the mcast_port property to match the value for
node 1.

8 After you have updated the attributes for all of the nodes,
enter:

\install_dir\install\bin\setupfiles.cmd for node 2 and higher.

34. After the cluster configuration is complete, go to the \install_dir\install\bin
directory for each node, starting with the first node, enter:
StartWindowsService.cmd

When prompted, enter the passphrase that you entered earlier.
The final startup processes run, concluding with the following messages:
Open your Web browser to http://host:port/dashboard, where host:port is the IP
address and port number where Sterling B2B Integrator resides on your
system.
Depending on system load, it may take several minutes for the user interface
to be ready.
Make a note of the URL address so that you can access Sterling B2B Integrator
later.
To make a dynamic addition of new nodes to the cluster, install new nodes to
the cluster as described above and configure the servers for the cluster.

35. Determine whether you need to apply a fix pack or interim fix to the
installation. For information about fix pack or interim fix installation, see
“Applying a Fix Pack (V5.2.6 or later)” on page 625 and “Applying an interim
fix (V5.2.6 or later)” on page 635.

Configure the Sterling B2B Integrator Desktop Icon for Windows Server 2008:
About this task

User Access Control (UAC) is a security component in Windows Server 2008. If
you enable the UAC, it affects the installation process and the daily processing for
Sterling B2B Integrator. If you disable the UAC, which requires a reboot, the
installation process and daily processing for Sterling B2B Integrator remains the
same as in previously supported Windows version.

If you installed or upgraded Sterling B2B Integrator on a Windows Server 2008 and
you created a desktop icon for Sterling B2B Integrator, you must complete this task
in order for the desktop icon to work.

Procedure

1. Right-click on the Sterling B2B Integrator desktop icon.
2. Click Properties.
3. In the Shortcut tab, click Advanced.
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4. Select the check box for Run as Administrator.
5. Click OK to apply the changes to Advanced Properties.
6. Click OK.

Validate the Software

Validate the Cluster Upgrade Checklist: As part of the upgrade, you need to run
the following tests to ensure that the software upgrade was successful. All of the
following tests are not required. Complete the following tasks:

Number Validate Cluster Upgrade Task Completed

1 Verify the Cluster Environment Settings in Property Files.

2 Configure the Nodes in Windows Cluster.

3 Start the Windows Cluster.

4 Access Sterling B2B Integrator.

5 Validate the Installation (Sample Business Process).

6 Verify the Cluster is Running from the User Interface.

7 Stop a Node in the Windows Cluster Configuration.

8 Stop Sterling B2B Integrator (Windows Cluster).

9 Stop Sterling B2B Integrator in a Windows Cluster Environment (Hardstop or
Softstop).

10 Restart the Windows Cluster.

Determine If You Need to Apply a Fix Pack (Windows):

Fix Packs contain cumulative fixes for a specific version of Sterling B2B Integrator.

About this task

Fix packs are available on the IBM Fix Central web site. Because each fix pack
contains the fixes from previous fix packs, you only need to install the most recent
fix pack.

Note: During installation, the dbVerify utility compares the list of standard indexes
with those present in the database and drops the custom indexes. You should
recreate the custom indexes after the installation is complete.

Fix packs are named using the following naming convention:

si_<release number>_<build number>.jar

Before you install the fix pack, review the following items:
v Preserve your custom changes to system resources.
v The installation may use one or more property override files. These files will be

named propertyFile_patch.properties. Do not alter these files.
v Property changes made directly in *.properties or *.properties.in files may be

overwritten during the installation. Properties overridden using the
customer_overrides.properties file are not affected. IBM recommends that you
maintain property file changes using (when possible) the
customer_overrides.properties file. For more information about this file, refer to
the property file documentation.
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v If you edited any of the cdinterop files, you must back them up before applying
the fix pack. The cdinterop files do not have initialization ( *.in ) files. After
applying the fix pack, use the backup version of the files in your installation.
These files include the following files: cdinterop-proxy-records.properties;
cdinterop-spoe-auth.properties; cdinterop-spoe-policy.properties; and
cdinterop-user-records.properties.

v Information about the installation is automatically logged to
\install_dir\install\logs\InstallService.log.

v If you need to rollback a fix pack, see the Fix Pack Change Report.

Verifying the cluster environment settings in the properties files:

Procedure

To verify the cluster environment is correct, check these properties file settings on
node 2:
1. Verify that the value CLUSTER=true is in the sandbox.cfg property file.
2. Verify that the value CLUSTER=true is in the centralops.properties property

file.
3. Verify that the value CLUSTER=true is in the noapp.properties property file.
4. Verify that the value cluster_env property=true is in the ui.properties

property file.

Configure the Nodes in Windows Cluster:

The first time that you configure a cluster, you need to use the startCluster
command with true option (startCluster.sh nodeNumber true).

About this task

The first time you configure a cluster, you need to use the startCluster command
with true option (startCluster.sh nodeNumber true). Initial configuration should
be the only time you need to use the startCluster command. However. if you
need to use the command again, use the startCluster command with the false
option (startCluster.sh nodeNumber false). The false option prevents any
configuration changes from affecting the system, especially after installation of a fix
pack or interim fix.

Important: For Sterling B2B Integrator V5.2.6 or later, you must run the
startCluster command after installing the first node (node 1) on the host where
you have installed the node. After you run the startCluster command for the first
node, the subsequent nodes will have clustering automatically started by the
installer when they are installed.

To configure the nodes in a Windows cluster environment, you need to perform
the following task for each node, starting with node 1:

Procedure

1. Navigate to \install_dir\install\bin for the node.
2. Enter startCluster.cmd <nodeNumber> <true or false>. Where

<nodeNumber> is the number of the node, true performs database updates and
false prevents database updates. For example for node 1, enter
startCluster.cmd 1 true.
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3. Enter startWindowsService.cmd. Perform this step for each node. The final
startup processes run, concluding with the following message: Open your Web
browser to http://host:port/dashboard where host:port is the IP address and
port number on your system.

4. Record the URL address so that you can access Sterling B2B Integrator.

Starting Sterling B2B Integrator in a Windows cluster environment:

After you run the upgrade software, you can start Sterling B2B Integrator.

Before you begin

If you are starting Sterling B2B Integrator after you upgrade the application from
version 5.1.0.4, change the values of the following properties in the
centralops.properties file to 600. This action prevents the
StartWindowsService.cmd command from timing out before Sterling B2B Integrator
starts. The centralops.properties file is in the install_dir\install\properties
directory.
v OpsServer.commandTimeout

v PassPhrase.urlTimeout

About this task

Perform this task for each node in the cluster, starting with node 1.

Procedure

1. Open the \install_dir\install\bin directory.
2. Enter startWindowsService.cmd.
3. Enter your passphrase.
4. The final startup processes run, concluding with the following message: Open

your Web browser to http://host:port/dashboard

Where host:port is the IP address and port number where Sterling B2B
Integrator is located on your system.
Depending on system load, it might take several minutes for the UI to be ready.

5. Record the URL address so that you can access Sterling B2B Integrator.

What to do next

If you need to release all the locks in a cluster and both nodes are down, use the
restart parameter for node 1.

Note: The restart parameter can be used on only node 1. It cannot be used on
any other nodes.

For example:

For node 1, enter:

startWindowsService.cmd restart

For node 2 and higher, enter:

startWindowsService.cmd
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Accessing Sterling B2B Integrator:

You can access Sterling B2B Integrator through a web browser.

Procedure

1. Open a browser window and enter the address that is displayed at the end of
the start.

2. On the login page, enter the default user ID and password. The default login is
at an administrative level. One of your first tasks as an administrator is to
change the administrative password and to register other users with other
levels of permission.

Validating the installation with a sample business process:

You can validate the installation by testing a sample business process.

Procedure

1. From the Administration Menu, click Business Process > Manager.
2. In the Process Name field, type Validation_Sample_BPML and click Go!

3. Click execution manager.
4. Click execute.
5. Click Go! The Status: Success message is displayed on the upper left side of

the page.

Verifying from the user interface that the cluster is running:

You can use the user interface to verify that the cluster is running, including queue
information and adapter status.

Procedure

1. From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the Queue information for each node.

2. From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the JNDI Tree for each node.

3. From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the host, state, status, adapters, and memory usage
information for each node.

4. From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the adapter status for each node.

Stop a Node in the Windows Cluster Configuration (Hard Stop):
About this task

You can stop a single node Sterling B2B Integrator in a Windows cluster
environment. To run a hardstop, perform this task for each node:

Procedure

1. Navigate to \install_dir\install\bin.
2. Enter StopWindowsService.cmd.
3. Enter your passphrase. You can also perform this task by selecting Operations

> System > Troubleshooter. Then click the shutdown link for the node you
want to stop.
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Stop Sterling B2B Integrator (Windows Cluster):
About this task

To stop the entire cluster in a Windows environment:

Procedure

1. From the Administration Menu, select Operations > System > Troubleshooter.
2. Click Stop the System and wait for shutdown to complete.

Stop Sterling B2B Integrator (Hardstop Windows):
About this task

To stop Sterling B2B Integrator in a Windows environment:

Procedure

1. Navigate to \install_dir\install\bin.
2. Enter StopWindowsService.cmd. Your should receive a message that services

have been stopped. Services include Noapps, Opsserver, WebDav, and
Database-related service.

Stop Cluster (Softstop Windows):
About this task

Soft stop in a cluster environment suspends all scheduled bushiness processes. It is
recommended to run the hardstop command on each of the nodes.

To soft stop the cluster:

Procedure

1. Navigate to \install_dir\install\bin.
2. Enter softstop.cmd. You should receive a message that services have been

stopped. Services include Noapps, Opsserver, WebDav, and Database-related
service.
For more information about the softstop command line options, refer to the
performance management documentation.

Restart the Windows Cluster:
About this task

To restart the entire cluster in a Windows environment:

Procedure

1. Navigate to \install_dir\install\bin.
2. Enter startWindowsService.cmd restart.

What to do next

If you need to release all the locks in a cluster and both nodes are down, use the
restart parameter for Node 1.

Note: The restart parameter can only be used on Node 1. It cannot be used on
any other nodes.

For example:
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For Node 1, enter:

startWindowsService.cmd restart

For Nodes 2 and higher, enter:

startWindowsService.cmd

Post Upgrade Configuration

Post upgrade configuration checklist (Windows cluster):

After the upgrade software finishes running, you must perform some post upgrade
procedures.

Review all of the procedures in the checklist. Some procedures might not be
required.

Task number Task Your notes

1 Upon upgrade, all default user accounts are reset to
their default value. For security purposes, the system
administrator should update all default user account
passwords immediately after upgrade is completed. See
“Changing default user account passwords” on page 40.

2 “Determine If You Need to Apply a Fix Pack
(Windows)” on page 357

3 “Configure Cluster Environment in Windows” on page
365

4 “Change the Network Interface Bindings (Windows)” on
page 366

5 “Disable Services” on page 366

6 “Download of the Sterling B2B Integrator tools” on page
43

7 “Enable Business Processes” on page 367

8 “Property files configuration in a Windows
environment” on page 44

9 “Add cdinterop Files” on page 367

10 “Updating the sandbox.cfg file with a new JCE file” on
page 368

11 “Update the sandbox.cfg file for an IPv4 Address” on
page 43

12 “Add Third-Party Libraries” on page 368

13 “Review the EDI Sequence Check Queue” on page 368

14 “Configure Document File Systems” on page 369

15 “Configure Services and Adapters” on page 369

16 “Configure JDBC Adapter and Lightweight JDBC
Adapter” on page 369

17 “Configure File System Adapter and Command Line2
Adapters” on page 370

18 “Configure Odette FTP Adapter” on page 370
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Task number Task Your notes

19 “Restore Performance Tuning Configuration” on page
373

20 “Add Advanced File Transfer Tab” on page 373

21 “Reconfigure Archive Settings” on page 373

22 “Correct Missing Manager IDs” on page 374

23 “Update the Database (dbupdate) with the startCluster
Command” on page 374

24 “Manage Nodes in a Cluster” on page 45

25 “JMS Cluster Configuration for Failover” on page 41

26 “Configure ActiveMQ for a Cluster Environment
(Windows)” on page 42

27 “Configure Shared File Systems as Document Storage
(Windows Cluster)” on page 44

28 “Add host[port] From all the Nodes to the
jgroups_cluster.property.in for Each Node” on page 44

29 “Configure JVM Containers” on page 378

Changing default user account passwords:

When you install Sterling B2B Integrator, several default user accounts are
automatically created to get you started. One of the first actions you must take
after installation is to update these accounts with unique passwords, because the
default ones can be known by all Sterling B2B Integrator customers.

About this task

Default user account passwords are preset at installation. For security purposes,
the system administrator should update all default user account passwords
immediately after installation is completed.

Default user accounts are listed below in the same order as they appear in the UI
under Accounts > User Accounts > List All. You can use this table to track the
user accounts you want to update.

User Account Name Update password

MBX_daemon

admin (*)

aft_user (*)

anon

as2_user

commandlineuser

dash_oper (*)

dash_part (*)

dash_prtspon (*)

dash_sponsor (*)

fg_architect
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User Account Name Update password

fg_operator

fg_provisioner

fg_sysadmin (*)

gmbx_user

ja_turbine

jane

jane_doe

joe_employee

joe_manager

joe_supplier

john

sd_buyer

sd_supplier

turbine

ws_buyer

ws_director

ws_employee

ws_finance

ws_hr

ws_manager

ws_purchaser

ws_supplier

(*) denotes a super user

To change the password for a user account, perform the following tasks.

Procedure

1. Log into Sterling B2B Integrator using ID = admin and password = password.
2. Go to Accounts > User Accounts. Under the List section click Go! All default

user account names are listed.
3. Click Edit next to the user account name you want to update the password for.
4. In the New Password and Confirm New Password fields, enter a new, secure

password for this User ID.

Note: Passwords must be at least six characters long.
5. Click Save and Finish.

What to do next

Repeat steps 3 - 5 for all user account names you want to update.

Determine If You Need to Apply a Fix Pack (Windows):

Fix Packs contain cumulative fixes for a specific version of Sterling B2B Integrator.
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About this task

Fix packs are available on the IBM Fix Central web site. Because each fix pack
contains the fixes from previous fix packs, you only need to install the most recent
fix pack.

Note: During installation, the dbVerify utility compares the list of standard indexes
with those present in the database and drops the custom indexes. You should
recreate the custom indexes after the installation is complete.

Fix packs are named using the following naming convention:

si_<release number>_<build number>.jar

Before you install the fix pack, review the following items:
v Preserve your custom changes to system resources.
v The installation may use one or more property override files. These files will be

named propertyFile_patch.properties. Do not alter these files.
v Property changes made directly in *.properties or *.properties.in files may be

overwritten during the installation. Properties overridden using the
customer_overrides.properties file are not affected. IBM recommends that you
maintain property file changes using (when possible) the
customer_overrides.properties file. For more information about this file, refer to
the property file documentation.

v If you edited any of the cdinterop files, you must back them up before applying
the fix pack. The cdinterop files do not have initialization ( *.in ) files. After
applying the fix pack, use the backup version of the files in your installation.
These files include the following files: cdinterop-proxy-records.properties;
cdinterop-spoe-auth.properties; cdinterop-spoe-policy.properties; and
cdinterop-user-records.properties.

v Information about the installation is automatically logged to
\install_dir\install\logs\InstallService.log.

v If you need to rollback a fix pack, see the Fix Pack Change Report.

Configure Cluster Environment in Windows:
About this task

For each node in the cluster, starting with node1:

Procedure

1. Navigate to \install_dir\install\bin.
2. On each node, starting with node 1, run the command startCluster.cmd

nodeNumber. Where nodeNumber is the sequential number assigned to each
node starting with 1. For example, on the first two nodes, you would run the
following commands:
For Node 1:
startCluster.cmd 1

When the cluster environment is configured, you will get the message BUILD
SUCCESSFUL.
For Node 2:
startCluster.cmd 2

Enter the passphrase.
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When the cluster environment is configured, you will get the message
Deployment to application server successful.

Change the Network Interface Bindings (Windows):
About this task

To increase the security of the Administrator Console user interface, Sterling B2B
Integrator binds only to specific network interfaces. After installing, if the URL
returns the error message Page cannot be displayed, you can adjust property
settings to correct the problem.

To update the property settings:

Procedure

1. On the server where Sterling B2B Integrator resides, edit the
noapp.properties_platform_ifcresources_ext.in file.

2. Locate the admin_host parameter.
Where hostname1 is the name of primary network interface, the one given
highest priority by Sterling B2B Integrator.
Where localhost is the name of the network interface on the server where
Sterling B2B Integrator resides.
admin_host.1 = hostname1

admin_host.2 = localhost

3. If no interface is being displayed, edit hostname1 so that it correctly identifies
the primary network interface that accesses Sterling B2B Integrator.

4. If an additional network interface needs to access Sterling B2B Integrator, add
an additional admin_host entry. For example:
v admin_host.1 = hostname1

v admin_host.2 = localhost

v admin_host.3 = hostname2

5. Stop Sterling B2B Integrator.
6. Navigate to \install_dir\install\bin.
7. Enter setupfiles.cmd.
8. Restart Sterling B2B Integrator.

Disable Services:
About this task

The upgrade process enables services that might have been disabled before the
upgrade. If you want to disable these services again, you must disable them in
after the upgrade process.

Download of the Sterling B2B Integrator tools:

After you install Sterling B2B Integrator, you can install tools like the Map Editor
and the Graphical Process Modeler (GPM).

Sterling B2B Integrator includes tools that run on a desktop or personal computer.
After you install Sterling B2B Integrator, you can install the following tools:
v Map Editor and associated standards
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Note: The Map Editor requires a 32-bit JDK. This JDK is not provided with the
product download or media. For more information, see System Requirements.

v Graphical Process Modeler (GPM)
v Web Template Designer
v (If licensed) MESA Developer Studio plug-ins, including MESA Developer

Studio Software Development Kit (SDK) and MESA Developer Studio Skin
Editor

v (If licensed) Reporting Services, which require MESA Developer Studio if you
want to use the plug-ins to create fact models and custom reports

Attention: Conflicting IP addresses can cause problems when you download a
desktop tool.

Enable Business Processes:
About this task

During the upgrade process, your customized business processes are preserved,
but they may not be the default business process. Review the business processes
and enable the customized versions.

Property files configuration in a Windows environment: Property files contain
properties that control the operation of Sterling B2B Integrator. For example, the
REINIT_DB property in the sandbox.cfg file controls whether or not a database is
initialized when you install Sterling B2B Integrator.

By modifying the values of these properties, you can customize the Sterling B2B
Integrator to suit your business and technical needs. Most property files are in the
\install_dir\install\properties directory.

After installing Sterling B2B Integrator, most property files and scripts do not need
any further configuration for basic operation. However, if you want to customize
any specific operations, for example setting a different logging level - you will
need to edit ( or in some cases, create) certain property or .xml files.

Before changing any property files, refer to the Working with Property Files
documentation for general information about how to work with Property Files.

Areas where you might need to make specific property files changes after an
installation include:
v LDAP user authentication
v Prevention of cross-site script vulnerabilities
v Logging configuration
v Process-specific property file settings

Add cdinterop Files:
About this task

During the upgrade, the cdinteropt files were replaced. Copy the customized
version into the upgrade.
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Updating the sandbox.cfg file with a new JCE file:

If you upgrade from Sterling B2B Integrator release 5.2.4.2 and you change the JDK
from Sun to IBM, you must manually update the Java Cryptography Extension
(JCE) policy file information in the sandbox.cfg file.

Procedure

1. Open the install_dir\install\properties directory.
2. Open the sandbox.cfg file.
3. Change the JCE_DIST_FILE property to the path to the JCE file that you

specified during the upgrade.
4. Save and close the sandbox.cfg file.
5. Open the install_dir\install\bin directory.
6. Enter the setupfile.cmd command to update your installation with the new

JCE_DIST_FILE property value.

Update the sandbox.cfg file for an IPv4 Address:
About this task

To update the sandbox.cfg file for an IPv4 address (complete this task for each
node in the cluster):

Procedure

1. Navigate to the properties file directory for each node.
2. Open the sandbox.cfg file.
3. Add the following line to the file.

IPV4STACK=true

4. Save and close the file.
5. Navigate to the bin directory for your installation.
6. Run setupfiles.cmd to update your installation.

Add Third-Party Libraries:
About this task

If you added third-party libraries to configure adapters for the previous release,
you need to add each of the libraries again after you complete the upgrade. See the
documentation for each third party adapter you use.

Review the EDI Sequence Check Queue:
About this task

The EDI Sequence Check Queue is used for X12 and EDIFACT sequence and
duplicate checking. You can check the contents of the queue through the UI
(Trading Partner > Document Envelopes > EDI Sequence Check Queue). Any
interchanges that are in the queue will not be able to be processed after upgrade
because the EDI compliance report serialized format has changed.

The EDI Post Processor displays the following error:
The compliance report for interchange <interchange document ID> could not be
deserialized because the format has changed. The entry for this interchange
should be manually removed from the EDI Sequence Check Queue through the UI,
and the inbound deenvelope workflow should be rerun (WF ID <wfid>).
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If you receive this error, you should follow the instructions in the error message to
correct the situation.

Configure Document File Systems:
About this task

If you use a File System as your document storage method, determine and record
the path to the File System.

You will need the File System path structure so that after the upgrade, you can
copy/mount the documents to the new installation directory. The directory
structure (path to the File System) must be the same in the current and in the
upgraded system.

Configure Services and Adapters:
About this task

You may need to reconfigure services and adapters after an upgrade. During an
upgrade, packages for services and adapters are reprocessed to update the service
configurations.

After an upgrade, the configurations of default adapters and services are re-set to
their default configurations. This includes directory paths, which are restored to
their default paths. You need to reconfigure those adapters and services, which
include, but are not limited to:
v All default FTP adapters
v All default SFTP adapters
v Connect:Enterprise UNIX Server Adapter
v OdetteFTP Adapter
v SAP Suite Adapter
v SWIFTNet Client Service
v SWIFTNet Server Adapter

If you modified the standard configuration for a service or adapter, you may need
to reconfigure or reactivate the service or adapter following an upgrade. You may
also need to reconfigure adapters that used directories or scripts in the installation
directory of your previous release.

Examples of services and adapters that commonly need to be reconfigured
following an upgrade include:
v FTP adapter
v System services such as the Alert service and the BP Fault Log adapter

The following adapters need special consideration following an upgrade:
v JDBC Adapter and Lightweight JDBC Adapter
v File System Adapter and Command Line2 Adapters
v Odette FTP Adapter

Configure JDBC Adapter and Lightweight JDBC Adapter:
About this task

Storage locations of the database pool properties that allow the JDBC adapter and
the Lightweight JDBC adapter to communicate with your external database have
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been streamlined. The poolManager.properties file has been eliminated and some
of its pool properties are now included in the jdbc.properties file, along with some
new properties. You will need to manually update your existing
jdbc_customer.properties.in file to add some new database pool properties. If you
do not have a jdbc_customer.properties.in file, create one since customer.properties
are not affected by product updates.

Configure File System Adapter and Command Line2 Adapters:
About this task

You must configure your File System and Command Line2 adapters before you
remove the previous release directory. Reconfigure any File System and Command
Line2 adapters that were configured to use directories or scripts in the installation
directory for the previous release. Ensure that you create new directories and save
scripts outside of the current installation directory and edit each configuration to
use the appropriate directories and scripts.

Consider the following:
v If you are using the Command Line2 adapter and have located the

CLA2Client.jar file anywhere other than the default location, you must replace it
with the new version. For information about the default location and how to
start the Command Line2 adapter, see the Command Line2 adapter.

v If you are upgrading to this version of Sterling B2B Integrator from a version
lower than 4.0.1 and are using the Command Line2 adapter, you must update
the version of the CLA2Client.jar file with the CLA2Client.jar located in the
/install_dir/install/client/cmdline2 UNIX directory or in the
\install_dir\install\client\cmdline2 for Windows. If you installed the
CLA2Client.jar file anywhere other than the default location, you must replace
each copy of the file with the new version. If you only installed it in the default
location, the update occurs automatically during the upgrade process.

v If you are upgrading to this version of Sterling B2B Integrator from a version
prior to 4.0 and are using the Command Line adapter, you must update the
version of the CLAClient.jar file with the CLA2Client.jar located in the
/install_dir/install/client/cmdline2 UNIX directory or in the
\install_dir\install\client\cmdline2 for Windows. If you installed the
CLAClient.jar file anywhere other than the default location, you must replace
each copy of the file with the new version. If you only installed it in the default
location, the update occurs automatically during the upgrade process.

The CLA instances are now pointing to the CLA2 Service definition. After
importing old service instances of CLA onto Sterling B2B Integrator, you need to
reconfigure the imported CLA services to re-set the Remote Name and Remote
Port service configuration parameters. For more information, refer to the
documentation for the Command Line Adapter and Command Line2 Adapter.

Configure Odette FTP Adapter:
About this task

If you use the Odette FTP Adapter and are using the Partner Profile XML file
version 2.00 used in Sterling Gentran Integration Suite 4.3, you must modify it to
match the new Partner Profile version 3.00. To modify the XML file, refer to the
following table:
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Section Name of Structure or Field Action Comment

Partner Profiles <GeneralParameters>

<PartnerProfileVersion>3.00

</PartnerProfileVersion>

</GeneralParameters>

Use correct version label of the
Partner Profile.

New Version
label: 3.00

Physical Partner Description Add field and description
content

Mandatory in
OFTP Partner
database

Physical Partner SubMailbox Add field, if used. Optional

Physical Partner <AuthenticationCertificate

type =”...”>

<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial> Bignumber_string

</Subject>

</AuthenticationCertificate>

Add Structure, if used. OFTP 2.0:
Mandatory for
security only.
Structure may
be repeated.

Physical Partner <AuthenticationCertificate

type =”Private Key”>

<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial>Bignumber_string

</Subject>

</AuthenticationCertificate>

Add Stucture, if used. OFTP 2.0:
Mandatory for
security only.

Physical
Partner/ CAPI

DWindowSize Delete field

Physical
Partner/ IP

IPFilter Uses IPv4 or
IPv6 addresses.

Physical Partner
IP

SSL Add field, if used. OFTP 2.0:
Mandatory for
security only.

Physical Partner
IP

CipherStrength Add field, if used. OFTP 2.0:
Mandatory for
security only.

Physical Partner
IP

<SSLCertificate

type =”...”>

<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial> Bignumber_string

</Subject>

</SSLCertificate>

Add structure, if used. OFTP 2.0:
Mandatory for
security, only.
Structure may
be repeated.

Physical Partner
Contract

Description Add field and description
content.

Mandatory in
OFTP Partner
database.
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Section Name of Structure or Field Action Comment

Physical Partner
Contract

MultipleLoginSessions Now used.

Physical Partner
Contract

DuplicateFilePeriod Rename

DuplicateFileProcessingTestings

To DuplicateFilePeriod

Physical Partner
Contract

SessionLogLevel Add fields. Optional

Physical Partner
Contract

GroupNameList Add fields, if used. Optional

Physical Partner
Contract

SecureAuthentication Add fields. OFTP 2.0:
Mandatory

Physical Partner
Contract

<TimeScheduleTable>

...

<TimeScheduleTable>

Delete structure and create
schedules in the Scheduler.

Initiator
Business
Process and
Business
Process user
fields are still
used.

Physical Partner
Contract

OdetteFTPAPILevel Rename OdetteAPILevel to
OdetteFTPAPILevel

Logical Partner Description Add field and description
content.

Mandatory in
OFTP Partner
database.

Logical Partner <FileServiceCertificate

type =”...”>
<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial>string</Subject>

</FileServiceCertificate>

Add structure, if used. OFTP 2.0:
Mandatory for
security, only.
Structure may
be repeated.

Logical Partner
Contract

Description Add field and description
content.

Mandatory in
OFTP Partner
database.

Logical Partner
Contract

FileTransmissionRetries Rename FileTransmitRetries to
FileTransmissionRetries

Logical Partner
Contract

SignedEERPRequest Add field, if used.

Logical Partner
Contract

EERP/NERPSignatureCheck Add field, if used.

Logical Partner
Contract

File Signing Add field, if used.

Logical Partner
Contract

File Encryption Add field, if used.

Logical Partner
Contract

CipherSuite Add field, if used.

Logical Partner
Contract

File Compression Add field, if used.

Logical Partner
Contract

CharEncoding Add field, if used.

Logical Partner
Contract

Receive VitualFilenamePattern Add field, if used.

Logical Partner
Contract

EERPTimeout Rename WaitForEERP to
EERPTimeout
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Section Name of Structure or Field Action Comment

Logical Partner
Contract

FileScheduleTimeout Add field, if used.

Logical Partner
Contract

InboundBusinessProcess Add field, if used. Optional

Logical Partner
Contract

InboundBusinessProcessUser Add field, if used. Optional, if no
Inbound
business
process is
specified.

After changing the Partner Profile for version 3.00, import the Partner Profile into
the new Odette FTP Partner Profile database. For additional information, see
Odette FTP Partner Profile.

Restore Performance Tuning Configuration:
About this task

Before you begin this procedure, you need to add the Advanced File Transfer Tab.

To restore the performance tuning configuration:

Procedure

1. From the Administration Menu, select Operations > System > Performance >
Tuning.

2. Next to Edit Performance Configuration, click Go!

3. Click Edit settings.

Add Advanced File Transfer Tab:
About this task

The Advanced File Transfer tab will not be enabled by default after an upgrade. If
you have a license for Advanced File Transfer, perform the following steps to add
the Advanced File Transfer tab:

Procedure

1. Log in as Admin.
2. Click Manage Layout.
3. Click Add Pane.
4. Enter the following name: Advanced File Transfer
5. Click Apply.
6. Click the customize icon for the new Advanced File Transfer tab.
7. Click Add Portlet.
8. Select the Add box for Advanced File Transfer Management.
9. Click Apply.

10. Select Clear Borders and Title from the Decoration menu.
11. Click Save and Apply.

Reconfigure Archive Settings:

Installing and upgrading (V5.2.6 or later) 373



About this task

The upgrade does not automatically reconfigure the archive configuration. You
must reconfigure the Backup Directory setting in Archive Manager after an
upgrade.

To reconfigure your Archive settings, use the following procedure:

Procedure

1. From the Administration Menu, select Operations > Archive Manager.
2. Next to Configure Archive Settings, click Go!

3. If a message displays about the UI Lock, click OK to continue.
4. Click Next.
5. Update the Backup Directory field with the correct path information:
6. Click Save.
7. Confirm the settings and click Finish.

Correct Missing Manager IDs:
About this task

If you created a Manager ID with no corresponding User ID in your previous
version, the Manager ID may be missing after upgrading. If this occurs, create a
user in the system with a User ID that matches the missing Manager ID.

Update the Database (dbupdate) with the startCluster Command:
About this task

The startCluster.sh nodeNumber command on node 1 will automatically update
the database, unless you use the command startCluster.sh 1 false. The
startCluster.sh nodeNumber command on all other nodes will not update the
database.

When you configure Sterling B2B Integrator cluster for the first time, you should
run the startCluster.sh command with the database update value set to true
(startCluster.sh 1 true), or just startCluster.sh 1, since on node 1, dbupdate defaults
to true. This makes all cluster-related configurations take effect. The database
update will synchronize the scheduled jobs between the nodes by assigning them
all to node 1.

The startCluster.sh command with the database update value turned off
(startCluster.sh 1 false) prevents any configuration changes from affecting the
system, especially after you install a fix pack or interim fix.

The following services and adapters are associated with node 1 in the cluster:
v File System adapter
v Command Line 2 Adapter
v Connect::Direct Server Adapter
v Connect::Direct Requester Adapter
v Connect:Enterprise for UNIX Server Adapter
v HTTP Server adapter
v HTTP Client adapter
v FTP Client adapter
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v FTP Server adapter
v SFTP Client adapter

The following services and adapters have storage set to database:
v HTTP Server adapter
v Connect:Enterprise for UNIX Extract Service
v Connect::Direct Server Adapter

The default storage for all of the workflows is set to database.

Manage Nodes in a Cluster:
About this task

You can add or remove nodes in a cluster environment. The following
prerequisites should be considered before performing any modification in the
cluster environment:
v New nodes should have the same range of ports available as the current nodes.
v Sterling B2B Integrator license file should be updated to include the IP address

of the new nodes.
v Directory structure on the new nodes should match with the directory structure

of the existing nodes.
v Perimeter servers should be updated with the new IP addresses to ensure proper

configuration.
v Any adapters, services, or business processes assigned to or scheduled to run on

the node being removed should be assigned to run on other nodes.

Add a Node to the Cluster (Windows):

You do not need to stop the cluster environment while adding a new node.

About this task

To add a node into the cluster:

Procedure

1. Install a new Sterling B2B Integrator node to be added into the cluster during
installation. Ensure that the new node being added is not a primary node.

2. Update the jgroups_cluster.properties file and the
jgroups_cluster.properties.in file with the new node details.

3. Configure the new node by running the startcluster.cmd nodeNumber from the
\install_dir\install\bin directory. The node number should be greater than
1.
You should run startCluster.cmd only after you install Sterling B2B Integrator.
You should not run startCluster.cmd when you restart a Sterling B2B
Integrator instance.

4. Start the new node.

Remove a Node from the Cluster:
About this task

To remove a node from the cluster:

Installing and upgrading (V5.2.6 or later) 375



Procedure

1. Reassign or stop any adapters, services, or business processes assigned to or
scheduled to run on the node being removed.

2. Perform backup of the node being removed.
3. Edit the jgroups_cluster.properties file and the

jgroups_cluster.properties.in file in all nodes to remove the IP address of
the node being removed.

4. Restart the cluster environment.

Important: Start node 1 with the restart option to update the node
information.

JMS Cluster Configuration for Failover: To allow proper JMS execution and
failover in the Sterling B2B Integrator cluster environment, you must configure an
external ActiveMQ using the Configure ActiveMQ for a Cluster Environment task.

The following diagram illustrates how the ActiveMQ can be configured to increase
availability and failover.

Configure ActiveMQ for a Cluster Environment (Windows):
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About this task

To configure ActiveMQ for the windows cluster environment:

Procedure

1. Download ActiveMQ 5.2 from http://activemq.apache.org/activemq-520-
release.html for the appropriate OS.

2. Deploy an instance of ActiveMQ 5.2. This can be on the same machine as
Sterling B2B Integrator or on a separate machine.

3. Navigate to \install_dir\install\properties.
4. Copy the activemq.xml file to the AMQ conf directory. This file configures the

ActiveMQ to:
v Use failover clustering,
v Use the SI database for storage
v Configures the AMQ port usage

By default, ActiveMQ is configured to listen at the Sterling B2B Integrator base
port + 64 and the ActiveMQ interface will be at base port + 65
(http://server:base port + 66/admin). The port can be changed by editing the
config file directly. The port number must be higher than 1024.

5. Navigate to \install_dir\install\properties.
6. On each Sterling B2B Integrator node and each Sterling B2B Integrator

container node, the queue configuration must be re-directed to utilize the
ActiveMQ cluster. In each node, add the following to the
customer_overrides.properties:
For FIFO Processing:
fifo.broker.username=
fifo.broker.password=
fifo.broker.url=failover:(tcp://amq_master_hostname:amq_master_port,
tcp://amq_slave_hostname:amq_slave_port)

For adapters running in separate JVM containers:
iwfcqueue.username=
iwfcqueue.password=
iwfcqueue.protocol_config=failover:(tcp://amq_master_hostname:amq_master_port,
tcp://amq_slave_hostname:amq_slave_port)

7. Start the ActiveMQ instances. To start ActiveMQ, it is necessary to supply the
activemq.hostname property with the hostname for the current system. For
example:
activemq.bat -Dactivemq.hostname=ExampleHostname

See http://activemq.org for additional information about running an ActiveMQ
instance.

8. Start Sterling B2B Integrator.

Configure Shared File Systems as Document Storage (Windows Cluster):
About this task

To configure the shared file systems as document storage:

Procedure

1. Navigate to \install_dir\install\properties.
2. Open the jdbc.properties.in file.
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3. Update the value of the document_dir attribute to point to the shared files
system directory where you store documents.

4. Save and close the file.
5. Navigate to \install_dir\install\bin.
6. Enter setupfiles.cmd.
7. Restart Sterling B2B Integrator.

Add host[port] From all the Nodes to the jgroups_cluster.property.in for Each
Node:
About this task

Complete this task for both vertical and horizontal clusters. You will need to
complete this task for each node, starting with node 1.

Before you begin, it is important to note that you should never override
mcast_addr in the jgroup_cluster.properties.

To add the host [port] to the jgroups_cluster.property.in file:

Procedure

1. Navigate to the properties file directory for the node.
2. Determine the initial_hosts port for each node:
v Navigate to the properties file directory for the node.
v Find the initial_hosts from the jgroups_cluster.property

(initial_hosts=host{port}).
v Record the value from the initial_hosts for each node.

3. Open the jgroups_cluster.property.in file.
4. Add the initial_hosts property to the file. For example, if node 1 is on host1

and node 2 is on host2. For node 1, you would add:
initial_hosts=host1[port1],host2[port2]

For node 2, you would add:
initial_hosts=host2[port2],host1[port1]

5. Save and close the file.

Configure JVM Containers:
About this task

After you have upgraded the system, you will need to reconfigure the JVM
containers.

Before you reconfigure the JVM containers, you need to know the container
numbers from the previous installation.

For example, if you configured the container using the command,
setupContainer.sh (or cmd) 1, then the container number is 1.

Use one of the following tasks to reconfigure your containers:
v Set Up Adapter Container - iSeries

v Set Up Adapter Container - UNIX/Linux

v Set Up Adapter Container - Windows
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System Maintenance
From time to time, you may need to perform system maintenance activities.

These activities might include any or all of the following:
v Performing a Checksum
v Adding or removing a license

DB Checksum tool:

A checksum is a simple redundancy check used to detect errors in data.

In Sterling B2B Integrator, a verification process compares the checksum between
the existing default resource and the resource that was added after applying a fix
pack or upgrading. The DB Checksum tool, a resource difference tool generates a
granular report of the changes in the system that was not permitted to be set as
defaults.

The DB Checksum tool generates the difference in resource checksum between the
default resource and the latest system resource from the database.

Perform a Checksum (Windows):
About this task

To run the DB Checksum tool in the Windows environment:

Procedure

1. Navigate to \install_dir\bin.
2. Enter db_checksum_tool.cmd [-d] [-i [1 | 2 | 3 | 4 | 5]] [-r [wfd | map

| schema | sii | template]] [-o <output file>] [-g]

Where:
-d is the mode to dump the difference of resource checksum between the
default resource and latest system resource.
-i is the resource type integer (optional).
1 is WFD.
2 is MAP.
3 is SCHEMA.
4 is SII.
5 is TEMPLATE.
-r is the resource name (optional). For example, wfd, map, schema, sii, or
template.
-o is the file name to output all the messages (optional).
-g is the file name that lists all the ignored resources (optional).
-h is the help screen.
The DB Checksum tool performs the relevant checksum operation based on the
command options and generates the output message.

License modifications:

After the installation finishes, you can modify the software licenses that you
loaded with the AddLicenseSet command.
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The AddLicenseSet command is in the bin directory of your UNIX or Windows
installation. After the initial installation, the license files are in the following
directories:
v UNIX - /install_dir/install/properties/licensefiles
v Windows - \install_dir\install\properties\licensefiles
v iSeries - /install_dir/properties/licensefiles

You can add licenses or review the license list from the UI. On the Administration
Menu, click System > B2B Console > Operations > System > Licenses.

AddLicenseSet Command Parameters

Use the AddLicenseSet command to modify a single license file or the entire license
file directory.

To use the AddLicenseSet command, you must do the following:
v Open the bin directory
v Include the absolute path to the license file directory or to a license file

The AddLicenseSet command has the following parameters:

AddLicenseSet Parameter Description

-reload Use this parameter to reload the license files.

This parameter deletes all of the license files from the
database before the new files are loaded. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/
old_licenses

v Windows - \install_dir\install\logs\security\
old_licenses

v iSeries - /install_dir/logs/security/old_licenses

-upgrade Use this parameter during an upgrade only.

This parameter deletes all of the old license files from the
database and installs the new license files. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/upgrade

v Windows -\install_dir\install\logs\security\upgrade

v iSeries -/install_dir/logs/security/old_licenses

The AddLicenseSet command will check if Sterling B2B Integrator is running. If it
is running, the command will call the Ops server to refresh the license from the
database. If you have any problems with your licenses after running the
AddLicenseSet command, stop and restart Sterling B2B Integrator.

License Modification: Examples:

There are several different ways you can use the AddLicenseSet command to
modify your licenses.

UNIX Examples

From the install_dir/bin directory:
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Scenario Command usage (UNIX example)

Reload a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -reload

Reload all of the license files
in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -reload

Upgrade a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -upgrade

Windows Examples

From the install_dir\bin directory:

Scenario Command usage (Windows example)

Reload a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -reload

Reload all of the license files
in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -reload

Upgrade a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -upgrade

User Documentation
The user documentation is available from an online documentation site on the
web.

Providing the documentation in an online environment allows for frequent updates
of content that is based on user feedback and usability.

If you need a printed copy of the documentation, you can print topics of
information through your Internet browser, or you can download documents in
PDF format, after you add it to a collection on IBM Knowledge Center.

To access the documentation site from within Sterling B2B Integrator or one of its

tools, select the help 
 

icon. The system must reside on a computer that supports
Internet access and an Internet browser.

Improving your access to online documentation:

You can improve your access to online documentation by using several methods.

About this task

After you access the IBM Knowledge Center, you can perform the following tasks:
v Enter a word or phrase and search the entire library for information.
v Move through a hierarchy of contents pages to identify the topic you want to

read or print.
v Print topics by using your browser's Print function.
v Add documents to your collection and download them in PDF format.
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Uninstall Sterling B2B Integrator from a Windows Cluster
Environment
Before you begin

If you have installed Sterling B2B Integrator software using IIM, then perform
these steps to unregister Sterling B2B Integrator packages from the IIM registry:
v Launch IIM.
v Click Uninstall and select the required Sterling B2B Integrator package (Media,

FixPack, or Interim Fix).
v Confirm and click Uninstall.

About this task

To uninstall Sterling B2B Integrator from a Windows environment, perform the
following steps for each node:

Procedure
1. Navigate to \install_dir\install\bin.
2. Enter StopWindowsService.cmd. Wait for the shutdown to complete. If you begin

removing files before all business processes and the system is stopped, you
may be unable to remove the software successfully.

3. Back up the file system and database.
This step is optional. However, by backing up the file system and database,
you are ensured that Sterling B2B Integrator is completely recoverable.

4. Remove the installation directory by entering the following command in the
parent directory of your installation directory: rd /s /q \install_dir\install

5. If you use an Oracle, Microsoft SQL Server, or DB2 database, these remain
intact even after you remove Sterling B2B Integrator from the server. If you no
longer want to reference the data, contact your database administrator about
removing unwanted tables and recovering the database space where Sterling
B2B Integrator used to reside.

6. Navigate into the _uninst subdirectory of your JDK installation directory.
7. To manually remove the JDK, enter uninstall.cmd.
8. After you remove Sterling B2B Integrator from the server, you can remove

Eclipse, and any tools that were downloaded to the desktop, including the
following:
v Map Editor and associated standards

Refer to the Map Editor Guide for information about removing the Map
Editor.

v Graphical Process Modeler
Refer to the Graphical Process Modeler Guide for information about removing
the Graphical Process Modeler.

v Web Template Designer
Refer to the Web Extensions Guide for information about removing the Web
Template Designer.

v (If licensed) MESA Developer Studio plug-ins, including:
– MESA Developer Studio Software Development Kit (SDK)
– MESA Developer Studio Skin Editor
Refer to the MESA Developer Studio guide for information about removing
MESA Developer Studio.
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v (If licensed) Reporting Services, which requires MESA Developer Studio if
you want to use the plug-ins to create fact models and custom reports. Refer
to the MESA Developer Studio guide for information about removing
Reporting Services.

Troubleshooting Tips for Windows Environment

Situation Message or Symptom Explanation/Resolution

Installing You encounter errors or problems during
installation.

Explanation

The installation creates several log files that
you can use to diagnose problems like the
failure of an installation.

Resolution

Examine the log files generated during
installation:

v ant.install.log (in the install_dir directory)

v install_dir\PreInstallSI.log

Installing When you entered an absolute path during
installation, a message indicated that the
command was not found.

Explanation

You entered an incorrect path. Check the
information entered.

Resolution

Enter the correct path.

Installing IM is installed successfully, but SI Fails to
install.

Go to Start Open IM select Help and then
Export logs to a file for analysis.

Installing a desktop
tool or resource

Cannot download any of the following:

v Map Editor and associated standards

v Graphical Process Modeler

v Web Template Designer

v (If licensed) MESA Developer Studio
plug-ins, including:

– MESA Developer Studio Software
Development Kit (SDK)

– MESA Developer Studio Skin Editor

v (If licensed) Reporting Services, which
requires MESA Developer Studio if you
want to use the plug-ins to create fact
models and custom reports.

Explanation

When you install Sterling B2B Integrator,
system files are created that contain an
internal IP address. If you install Sterling
B2B Integrator behind a firewall, and your
firewall is configured to accept an external IP
address from a client computer, you may not
be able to download the desktop tools and
resources. The firewall will reject the internal
IP address from a client residing outside of
the firewall.

Resolution

Modify the system files that contain the
invalid IP address. Follow these steps:

1. Navigate to \install_dir\install\bin.

2. Stop Sterling B2B Integrator.

3. Enter the following command followed
by the external IP address:

patchJNLP.cmd external_IP_address

4. Restart Sterling B2B Integrator.
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Situation Message or Symptom Explanation/Resolution

Cluster Installation or
Upgrade

When configuring TCPS the following
warning can be found in the
activemqbroker.log:

sun.security.provider.certpath.
SunCertPathBuilderException:
unable to find valid certification
path to requested target

Resolution

Add the system certificate to the trust store
using the KeyTool command.

Cluster Installation or
Upgrade

When configuring TCPS the following
warning can be found in the
activemqbroker.log:

Do not mention any
SSL cipher in the ActiveMQconfig.
xml. oracle.net.ns.NetException:
Invalid cipher suites specified.

Resolution

Do not mention any SSL cipher in the
ActiveMQconfig.xml.

e-Invoice Upgrade:
Oracle Add Constraint
Error

When you upgrade Sterling e-Invoicing and
are using an Oracle database, if the upgrade
fails with the error message name is already
used by an existing object, this occurs
because the default behavior for the drop
constraint command changed in Oracle 10.

Explanation

The index that is used to support the
constraint is now only removed if the index
was generated by the create constraint
command. The indexes for Sterling
e-Invoicing are always generated from
constraints during an install. If you receive
this error during a Sterling e-Invoicing
upgrade, it is because of how the database
was restored, the version of Oracle you are
using, and because the Oracle imp command
exported the indexes and constraints
separately. There is no way to determine
when the imp command will not add a
create index command to the export file if it
was generated by a constraint – but if it does
add the command, the database restore
process loses the association of the constraint
and its underlying index. The database script
that runs during a Sterling e-Invoicing
upgrade executes two steps: 1. First, it drops
the unique constraint so the next step can
redefine it using additional columns.
However, the drop constraint command does
not remove the underlying index if the
association with its index was lost. 2. The
next command that redefines this constraint
requires a different index definition, but in
this scenario the name of the index the
constraint wants to use already exists, which
causes the name is already used by an
existing object error.

Resolution

If you receive this error message, the
solution for this problem is to drop the index
and rerun the Sterling e-Invoicing upgrade.
The drop index command you should use is:
drop index UNQ_EINV_CANON
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Situation Message or Symptom Explanation/Resolution

Apply a fix pack or
Upgrade

The \install_dir\install\installed_data
directory is created (if clustered, on each
node) during an upgrade or applying a fix
pack.

This directory can become very large and
take up needed space on the file system.

Explanation

The information in this directory is used
during upgrade or applying a fix pack, but is
not required afterward. The
deployment/cleanup tasks for the upgrade
or fix pack do not remove this directory.

Resolution

The directory can be manually removed to
increase the available space for the file
system:

1. Navigate to \install_dir\install

2. Enter

rd /S installed_data

3. If prompted to confirm deletion, enter Y
for yes.

Windows Non-Cluster Environment Upgrade (V5.2.6 or later)
You can upgrade the Sterling B2B Integrator software in a Windows non-cluster
(single node) environment.

CAUTION: Sterling B2B Integrator should be installed behind a company firewall
for security purposes. See the Perimeter Server and Security topics in the Sterling
B2B Integration documentation library for more information on secure deployment
options.

You should also review the following documents:
v System Requirements
v Release Notes
v What's New
v Installation and Upgrade Information

It is important to remember that upgrading involves a full installation of Sterling
B2B Integrator. You need to prepare for an upgrade the same way that you would
prepare for an installation. It is also recommended that you thoroughly test this
process in a test or development environment prior to implementing in a
production environment.

This upgrade does not overwrite your current Sterling B2B Integrator directory
structure on disk. Instead, it creates a new installation of Sterling B2B Integrator
that will point to and upgrade the database of your current installation of Sterling
B2B Integrator. This means your original instance will no longer be operational
after performing the upgrade. After the upgrade, you will be starting your Sterling
B2B Integrator instance only from the newly created directory structure.

For new installations, use the Sterling B2B Integrator Windows Non-Cluster
Installation Guide.
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Intended audience
This document can be used by different members of your organization.

This document is intended for use by:
v System administrators
v Installation engineers
v Database administrators.

Assumptions for this guide
The procedures in this guide are accurate as of the publication date and are
specific to this version of the document.

Upgrade Scenarios (Non-Clustered)
Upgrading to Sterling B2B Integrator can follow several paths. Keep these
scenarios in mind as you plan for your upgrade:

Upgrade Scenario High-Level Upgrade Steps

You have V5.2.x installed and want to
upgrade by applying V5.2.6 as a fix pack.

The upgrade steps are as follows:

1. Ensure that your JDK version is
supported. See the system requirements.
Upgrade your JDK if needed. See
“Upgrading your JDK (Windows and
UNIX)” on page 3.

2. Ensure that your operating system and
database versions are supported.

3. See “Applying a Fix Pack (V5.2.6 or
later)” on page 625or “Applying Sterling
B2B Integrator V5.2.6 Fix Pack using a
script” on page 630
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Upgrade Scenario High-Level Upgrade Steps

You have 5.1.x installed and want to
upgrade to V5.2.6.

The upgrade steps are as follows:

1. Ensure that your JDK version is
supported. See the system requirements.
Upgrade your JDK if needed. See
upgrading your JDK.

2. Ensure that your operating system
version is supported. Upgrade your
operating system if required.

3. Ensure your database version is
supported. Upgrade you database if
required:

a. Export the configuration data.

b. Back up the database.

c. With help from a database
administrator (DBA), copy the
database to the new version.

d. Back up the newly created database.

4. Upgrade to Sterling B2B Integrator V5.2.6
using the full installation media and this
Upgrade Guide.

5. Point to your supported database
version. If the upgrade stops and leaves
the newly created database in an
incomplete state, you can re-start the
upgrade using the backup of the
database.

Upgrade Impacts
This documentation provides information on how system behavior has changed
based on upgrading your instance. You should review this information before you
begin your upgrade. Depending on which version you are upgrading to, you will
need to review one or more topics listed. The upgrade impacts listed for each
subsequent version are specific to that version. There is not a cumulative list.

Upgrade impacts for V5.2.6.2:

Upgrading to Sterling B2B Integrator V5.2.6.2 has unique impacts.

DB2 requires additional tablespace

When upgrading to V5.2.6.2 or later you must ensure that all tablespaces used by
Sterling B2B Integrator tables have a minimum page size of 8K. Otherwise
installation will fail.

Upgrade impacts for V5.2.6:

Upgrading to Sterling B2B Integrator 5.2.6 has unique impacts.

Support for SSLV3 has been removed - TLS 1.2 is the new default

Due to security concerns, Sterling B2B Integrator no longer supports the use of
SSLV3. You should be aware of the following changes as you upgrade your system
to this version:
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v Several properties have been updated to use TLS 1.2 as the default. If your mail
server cannot use TLS 1.2, you can change your SMTP and B2B Mail Client
adapters to use TLS 1.0 or 1.1 instead.

v If any of your 3rd party programs do not support the use of TLS 1.2, you can
change Sterling B2B Integrator to use TLS 1.0 or TLS 1.1.

v In all cases, requests to use "SSLV3" in Sterling B2B Integrator will use instead
TLS 1.0, TLS1.1, or TLS1.2.

v TLS 1.2 is used as the default protocol in secure communications. This change
applies to any system that is upgraded to V5.2.6.

v If your GPM, or WebSphere MQ or OFTP adapters are configured to use older,
non-supported cipher suites (non-TLS 1.2), they will continue to work. However,
if you edit them, only TLS 1.2 will be available to select.

JDK 7 is the only supported JDK version for V5.2.6

There are several impacts due to this change:
v If you are not already using JDK 7, you must upgrade your JDK before

attempting to upgrade Sterling B2B Integrator to V5.2.6. If you currently have
V5.2.4.1 or higher installed, there is a upgradeJDK script available to assist you.
See bin Directory Files for more information.

v Only ciphers that are supported by JDK 7 can be used in Sterling B2B Integrator
V5.2.6. You can update your cipher suites in security.properties.

v Previously defined ciphers in customer_overrides.properties are not changed
upon upgrade to V5.2.6.

v DefaultCipherSuite contains a list of JDK 7 ciphers in V5.2.6 that can be used
when others are not available.

Upgrade impacts for V5.2.5:

Upgrading to Sterling B2B Integrator V5.2.5 has unique impacts.

JDK 7 does not support the TLS_RSA_WITH_3DES_EDE_CBC_MD5 cipher

If you are using JDK 7 with Sterling B2B Integrator V5.2.5, and you want to use a
cipher to secure the Sterling B2B Integrator dashboard, you must set one of the
following values in the dashboardCipherSuite parameter in the
security.properties_platform_asi_ext.in property file or in customer_overrides:
v JDK (includes all strong ciphers except the one not supported by JDK 7)
v Weak

Do not use Strong or All with JDK 7 or Sterling B2B Integrator will not start.

Reconciliation of HIPAA Level 5 code lists

When you upgrade to Sterling B2B Integrator 5.2.5, customized HIPAA Level 5
code lists from the previous version are preserved in the system where they were
entered. However, they are not the default code lists after the upgrade. After the
upgrade, you must manually make any customized code lists the default code lists.

For example, you customized the ICD9 or HCPCSCPT code list in the previous
version of Sterling B2B Integrator. After the upgrade to 5.2.5, you must replace the
default ICD9 or HCPCSCPT code list with the customized ICD9 or HCPCSCPT
code list.
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Properties file change to prevent timeout during start (5.1.0.4 to 5.2.5 upgrade)

Before you start Sterling B2B Integrator after you upgrade the application from
version 5.1.0.4 to 5.2.5, you must change the values of the following properties in
the centralops.properties file to 600. This action prevents the start command
from timing out before Sterling B2B Integrator starts. The centralops.properties
file is in the properties subdirectory of the installation directory.
v OpsServer.commandTimeout

v PassPhrase.urlTimeout

jGroups upgrade in V5.2.5 prevents Sterling B2B Integrator from starting for
some customers

jGroups is upgraded with V5.2.5. Some of the properties defined in
jgroups_cluster.properties have changed. If you modified these files or added
custom changes for them to customer_overrides.properties, the upgrade changes
are not applied and Sterling B2B Integrator will not start.

This issue is fixed in V5.2.5, Interim Fix 1, where all necessary properties files are
changed for you. You can also disable this fix if desired. See APAR IT06654 for
more information.

Note: The original and modified properties are output to the noapp.log file. This
allows you to see how your properties were modified. Search the log using the
value “Initializing jgroups_cluster.property_string" to see the new and changed
values for the two affected startup properties. The
jgroups_cluster.lock.protocolStack property is also modified with this fix, but is
only written to the log when it is used, not at startup.

If you want to manually fix your installation without applying V5.2.5, Interim Fix
1, complete the following steps:
1. Delete the following options (if they exist) from customer_overrides.properties

for the jgroups.cluster property file. These occur in the
jgroups_cluster.property_sting, jgroups_cluster.distributed_property_string, and
jgroups_cluster.lock.protocolStack files:
v gc_lag
v up_thread
v down_thread
v join_retry_timeout
v max_xmit_size
v shun

2. Remove the protocol parameter VIEW_SYNC and all of its attributes.
3. In the jgroups_cluster.property_string, replace ‘start_port’ with ‘bind_port’.
4. In the jgroups_cluster.distributed_property_string and

jgroups_cluster.lock.protocolStack properties, add the following items:
v In distribution_property_string the attribute

thread_pool_rejection_policty=run should be added to the protocol ‘TCP’.
For example,
TCP(bind_port=22261;thread_pool_rejection_policy=run)

v In lock.protocolStack: the protocol and attribute CENTAL_LOCK(num_backups=2)
should be added to the end of the property. For example,
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lock.protocolStack=UDP(bind_addr=&HOST_ADDR;;bind_port=
&MULTICAST_NODE_PORT3;;mcast_addr=239.255.166.17;<other

protocol parameters here>pbcast.GMS(join_timeout=5000;print_local_

addr=true):CENTRAL_LOCK(num_backups=2)

Upgrade Impacts for V5.2.0: Before you begin an upgrade, you should review the
following information.

Features and Services Not Supported as of V5.2.0

The following features and services are no longer supported:
v Channels portlet
v Federated Systems
v Community Management (AFT Communities are still available)
v Sterling Community Management (SCM) Integration
v Archive Commandline Service
v Sync Engine Data Clean Manager Service
v Sync Engine Task Manager Service

If you need more information, please contact your IBM sales representative.

Port Allocation Changes

If you are upgrading to V5.2, and configured the CLA2 or the SWIFTNet HTTP
Server Adapter, the remote port numbers have changed. The port numbers are as
follows:

Table 2. Remote Port Numbers

Adapter
Name

Version 5.2.0 Base
Port Version 5.2.1 Base Port Version 5.2.2 Base Port Version 5.2.3 Base Port

CLA2 +51 +52 +53 +54

SWIFTNet
HTTP
Server

+52 +53 +54 +55

Note: You should check adapter configurations and the sandbox.cfg file for ports
greater than 51 which may have changed.

After upgrading to 5.2.x, you need to change any references to the old remote port
numbers. For example, if you have any business processes that use the CLA2
adapter, you will need to update the remote ports in the business process.

Database Table Sizes

While upgrading if you encounter any database table size issues, you may have to
manually adjust the database tables and restart the upgrade process. An upgrade
using the production database in a test environment can be used to help you
determine what tables need to be manually adjusted.

390 Installing and upgrading (V5.2.6 or later):



Resource Tags

If you are using resource tags in your current version, you should check all of your
existing resource tags before you start the upgrade process. The resource tags you
should check are:
v Adapter Policies
v Agreements
v Sterling Connect:Direct Netmaps
v Proxy Servers
v Security Tokens
v SSH Resources
v SWIFTNet Copy Service Profiles
v SWIFTNet Service Profiles

You can check the resource tags by running the following SQL query from the SQL
Manager page (Operations > Support Tools):
SELECT * FROM TAG_RESOURCE_ASSOC WHERE TYPE=41 OR TYPE=42 OR TYPE=43 OR TYPE=44 OR
TYPE=45 OR TYPE=52 OR TYPE=53

The TAG_NAME column in the SQL results will contain the names of any resource
tags that need to be edited or deleted.

If any of the resource tags contain tagged resources using the types listed, remove
those resources from the resource tags or delete the resource tags that contain these
resource types.

Silent Installation Parameters

The following parameters are new or have an updated definition:

What has changed parameter Definition

Parameter definition
has changed

LICENSE_FILE_PATH (Required) Full path to Core_License.xml.

New parameter LICENSE_FILE_#
(where # is a number
between 1 and 99)

(Required) This is required for each license
you install. You must add an entry for each
license file to the silent install file. The
LICENSE_FILE numbering (#) does not
need to be sequential.

For example:

LICENSE_FILE_1= SI_SFG_License.xml

LICENSE_FILE_2= Fin_Serv_License.xml

LICENSE_FILE_3=
SI_SFG_FIPS_License.xml

LICENSE_FILE_4= AS2_License_.xml

LICENSE_FILE_5= EBICS_License_.xml
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Channels and Community Management Tabs (Optional)

The Dashboard PSML files are not updated during an upgrade. The PSML file
impacts any custom tabs you may have configured, such as Channels or Operator.
The Channels and Community Management tabs appear in your browser but are
no longer operational.

To remove the Channels and Community Management tabs:

Warning: The psmlRestore command gets the 5200 psml file which resets ALL of
the custom tabs from the previous release.
1. Navigate to the installation directory.
2. Navigate to the bin directory.
3. Enter this command: ./psmlRestore.sh admin

Custom BI Fact Models Need to be Upgraded

Scripts named recreateBITablePKs.cmd.in (Windows) and recreateBITablePKs.sh.in
(UNIX) are now provided which allow you to upgrade any custom BI fact models
tied to a separate BI repository.

BI fact models need to be upgraded to continue to work with the Entity
Framework, which replaced Hibernate usage in the BI framework in version 5.2.0.

Backups Are Not Generated During Install, Upgrade, or When Applying a Fix Pack or
Interim Fix: Before you begin an upgrade, review the following backup
information.

Some of the standard resources installed during install or upgrade use the import
mechanism available to customers to load the standard resources into the database.
The standard import mechanism by default creates a backup of the table
containing the resource prior to importing to provide the ability to restore to the
previous state if later it was decided that the import should not have been
performed. This table backup was also being performed by default during the
basic installation processes. And, since the import mechanism was sometimes used
multiple times during the installation processes, some of the tables were backed up
several times. Depending on the size of the table, this could add a very large
amount of time to the installation process. Since it is recommended that a backup
is completed prior to beginning any of these installation processes, the default
behavior has changed to not perform the backup by default. If you would like
backups to be performed, then SKIPIMPORTBACKUP=false should be added to the
sandbox.cfg file.

Capitalization Insensitivity for Header Value:
About this task

Before you begin an upgrade, review the following AS3 information.

For AS3, when searching for a header value in a multipart/report, you do not need
to consider whether the header value contains any capitalization. The search has
been enhanced to be capitalization insensitive.

For example, the following searches will result in a match:
v Multipart/Report
v Multipart/report
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v multipart/Report
v multipart/report

The search would not find the following as a match:
v MulTiPart/RePorT

CA Certificates Impacts: Before you upgrade, review the following information on
CA certificates.

Users may add multiple copies of the same certificates to the database. Having
multiple copies of the same certificate in the database is not, in principle, a
problem for the system except for the minor amount of wasted storage. Each copy
has a different object ID in the database and is a separate database object.

The specific changes in this release is the ability to easily populate the product
database with the set of authority root certificates distributed with the JVM.

Perimeter Server Installation:
About this task

Before you begin an upgrade, review the following Perimeter Server installation
information.

Silent install is the default installation mode. If you want to complete the Perimeter
Server installation using an interactive mode, you need to use the following
command:
java -jar ps_xxxx.jar -interactive

where ps_xxx.jar is the perimeter server jar file name for the version of Sterling
B2B Integrator you are upgrading to.

Retry Logic Added to WebSphereMQ Suite Adapter PUT Service:
About this task

Before you begin an upgrade, review the following WebSphereMQ Suite Adapter
PUT Service information.

Retry logic has been added to the WebSphereMQ Suite. To accommodate this new
functionality, you need to configure two new parameters for the PUT service:
v wsmq_send_retryCount
v wsmq_send_retrySleepInterval

To configure the new parameters:

Procedure

1. Log into Sterling B2B Integrator.
2. From the Admin Console Home, you need to start the Graphical Process

Model (GPM).
3. Log into the GPM. You will need a User ID and Password.
4. In the GPM, select View > Stencil > Services.
5. Select File > New.
6. Drag the WebSphereMQ Suite Put Message Service from the All Services

pane into the center pane.
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7. Double click the WebSphereMQ Suite Put Message Service.
8. Select the configuration from the Config dropdown.
9. Enter the number of retries in to the wsmq_send_retryCount value.

10. Enter the sleep interval in seconds in to the wsmq_send_retrySleepInterval
value.

11. Save the changes to the service configuration.
12. Exit from the GPM.

Services and Adapters - Show Advance State Button: Before you begin an upgrade,
review the following Show Advance State button information.

The Show Advanced State check box has been removed from the Services
Configuration search screen. Instead, the default has been changed to always show
the advanced state without needing to check a checkbox on the search screen to
display it.

Some Certificate Fields Are Optional:
About this task

Before you begin an upgrade, review the following certificate field information.

When generating certificate keys, the following fields may have been missing in
the release you are upgrading from, but the entries are now optional:
v alt.name.dns
v alt.name.IP

Support for Multiple AS2 Organizations: Before you begin an upgrade, review the
following AS2 schema information.

Sterling B2B Integrator now supports multiple sponsoring organizations and
multiple partners for AS2. During upgrade, the single organization will be flagged
as the default organization.

Once you have upgraded to this version, a prefix designation is used to
differentiate between an AS2 organization (AS2_ORG_) and an AS2 partner
(AS2_PART_). Each of these will require the full configuration of a trading partner
to allow for a partner to trade with multiple organizations as well as an
organization that trades with multiple partners.

The AS2_TRADEPART_INFO and AS2_EMAIL_INFO tables have been modified
and the AS2_PROFILE table is newly introduced. Updates to these tables will
occur during the SI in-place upgrade process in the following manner:
v Identify the default organization and populates the AS2_PROFILE table with

organization information. A default organization is an AS2 organization profile
named "profile_ORGANIZATION" present in the system before upgrade.

v Identify partner records and populates the AS2_PROFILE table with partner
information.

v Populate the new columns of table AS2_TRADEPART_INFO with the default
organization information.

v Populate the new PROFILE_ID column in the AS2_EMAIL_INFO table with the
profile id of the AS2 organization profile present in the system.

Web Services: Before you begin an upgrade, review the following Web Services
information.
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Many of the Web Services configuration settings that were generated from the
WebServices Provider Configuration UI have moved from the property files into
database tables. This change was made to allow a single location of these settings
in cluster environments and to ensure that these settings would not be reset during
a fix pack installation.

After you have completed your upgrade, you should run the
convertWSSoaProperties script found in the installation bin folder. This script reads
the settings from the property file and places them into the proper database tables.
You can then review the results in the WebServices Provider Configuration UI.

Windows 2008 Does Not Start with Response File Install:
About this task

Before you begin an upgrade using IBM Installation Manager and the response file
method, review the following information.

If you used the response file install method for your upgrade, you must manually
run the InstallWindowsService.cmd file to register the service.

MySQL Upgrade Impacts: The MySQL database is no longer bundled with Sterling
B2B Integrator software. Therefore, you will need to install and configure an
external version of the MySQL database prior to upgrading to the new version of
Sterling B2B Integrator.

Upgrade MySQL Checklist (External MySQL): This checklist assumes you are
upgrading from a previous version of Sterling Gentran Integration Suite or Sterling
B2B Integrator directly to Sterling B2B Integrator 5.1 and higher and you are
knowledgeable on the MySQL database.

If you need additional MySQL database information, see the documentation
provided by the vendor at http://dev.mysql.com/doc/refman/5.0/en/.

If you are moving from a version of MySQL earlier than MySQL 5.0, you will need
to export the data from the earlier version to the MySQL 5.0 version using the
following procedure. Your existing Sterling Gentran Integration Suite instance will
no longer function if you upgrade your existing database without making a copy.
After this procedure, you will have two databases:
v A database that you will use in your upgraded version of Sterling B2B Integrator

(Sterling B2B Integrator 5.1 and higher).
v A database that you can use in your old version of Sterling B2B Integrator.

Task Which database MySQL Upgrade Checklist Your Notes

1 New external
database

Install an external MySQL database.

Refer to MySQL documentation for information about
installing the database. Be sure to install the correct
version and patches.

See System Requirements for supported version
information.

2 New external
database

Update the MySQL Parameters.
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Task Which database MySQL Upgrade Checklist Your Notes

3 New external
database

Create the database. For example, you can run the
following command to create the database:

CREATE DATABASE database_name

Refer to MySQL documentation for information about
creating the database.

4 New external
database

Create a user account and grant permissions.

5 New external
database

Install the JDBC Driver for MySQL.

6 Previous database Rename the SCHEMAS table to XMLSCHEMAS to
avoid reserved word collision:

v Only required when moving from MySQL version
earlier than 5.0

v Use the following command:

Alter table SCHEMAS rename to XMLSCHEMAS

7 Previous database Perform a MySQL database export.

As part of the export, you will have a backup copy of
the database.

8 Previous database If you renamed the SCHEMAS table in task 6, you need
to rename the SCHEMAS table, so that your older
version of Sterling B2B Integrator will be operational.

Use the following command:

Alter table XMLSCHEMAS rename to SCHEMAS

9 New external
database

Import the exported data for MYSQL into the new
external database.

Update the MySQL Parameters: Sterling B2B Integrator requires the following
parameter settings in your MySQL database.

The parameter values recommended are minimum values. You can increase the
values based on your requirements or if the database server is used by more than
one instance of Sterling B2B Integrator.

It is recommended to configure a data file for auto extension
(innodb_data_file_path = ibdata1:400M:autoextend).

Parameter Value

max_connections 500

max_allowed_packet 100M

default-table-type INNODB

wait_timeout 31536000

max_write_lock_count 500000

transaction-isolation READ-COMMITTED

character-set-server utf8

binlog_format mixed
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Parameter Value

table_open_cache 512

key_buffer_size 384M

sort_buffer 512K

connect_timeout 15

innodb_data_file_path ibdata1:400M:autoextend

innodb_data_home_dir /install_dir/mysql/var/

innodb_log_group_home_dir /install_dir/mysql/var/

innodb_flush_log_at_trx_commit 1

innodb_mirrored_log_groups 1

innodb_log_files_in_group 3

innodb_file_io_threads 4

innodb_lock_wait_timeout 600

innodb_log_file_size 5M

innodb_log_buffer_size 8M

innodb_buffer_pool_size 128M

innodb_additional_mem_pool_size 32M

Review the innodb_buffer_pool_size and the innodf_additional_mem_pool_size in
the /install_dir/install/mysql/data my.cnf. If the values from the previous Sterling
B2B Integrator tuning.properties are larger than what is in your new my.ini file,
you need to adjust them accordingly.

Create User Account and Grant MySQL Database User Privileges:
About this task

You must grant all privileges on the MySQL database to the Sterling B2B Integrator
administrative user. The following example creates and grants all privileges to the
user in the MySQL database:
GRANT ALL PRIVILEGES ON database_name.* TO user@localhost IDENTIFIED BY 'password’
WITH GRANT OPTION

Where:
v database_name - refers to the name of the database created.
v user - refers to the database user account that will be used by Sterling B2B

Integrator.
v password - refers to the password associated with the database user account.

Once you have granted all the privileges, you will need to FLUSH the privileges to
complete the setup. For example, run this command from the SQL prompt:
FLUSH PRIVILEGES;

Install the JDBC Drivers for MySQL:
About this task

Sterling B2B Integrator requires appropriate JDBC driver for MySQL database.
These drivers are platform independent and architecture independent drivers. See
System Requirements for supported version information.
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After obtaining the correct JDBC driver, record the absolute path to its location on
your system. You must supply this absolute path when installing Sterling B2B
Integrator.

Perform a MySQL Database Export:
About this task

The full backup can be performed using the mysqldump utility. The details on the
usage of this MySQL utility can be found in the MySQL reference documentation.
Since there are many options that are provided with this utility, the following are
the minimum recommendations:
v Specifying the db_name on the mysqlcommand will prevent the subsequent

import from creating a new database. You should specify the db_name of the
Sterling B2B Integrator database.

v --extended-insert: Use multiple-row INSERT syntax that include several VALUES
lists. This results in a smaller dump file and speeds up inserts when the file is
reloaded.

v --quick: This option is useful for dumping large tables. It forces mysqldump to
retrieve rows for a table from the server a row at a time rather than retrieving
the entire row set and buffering it in memory before writing it out.

v --disable-keys: This makes the dump file faster because the indexes are created
after all rows are inserted.

To export the database:

Procedure

1. Perform a backup of the database. For example, enter:
myysqldump –u <internal_mysql_username> -p<password> <db_name>
--host=<internal_mysql_host> --port=<internal_mysql_port> > <dump_file_name>

2. Make a copy the resultant dump file (.dmp) file from the file system on the
source server file system to the file system on the MySQL destination server.
If the MySQL database was created as part of a Sterling B2B Integrator
installation, you can determine the port number by reviewing the
MYSQL_PORT entry in the sandbox.cfg that is in the Sterling B2B Integrator
install directory.

Import the Data to the New Version of MySQL Database:
About this task

Before you begin:
v Make sure the new version of the MySQL database is not in use.
v Know the name of the new database.

To import the exported data:

Procedure

Enter:
mysql -u <external_mysql_username> -p<password> <db_name>
--host=<external_mysql_host> --port=<external_mysql_port> < <dump_file_name>

Where database_name is the name of the new database created in task 3 of the
checklist.
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Upgrade Planning
Proper planning will help ensure a trouble-free upgrade.

Before you begin an upgrade you should:
v Read and become familiar with this document so that you have a clear

understanding of what the upgrade requires.
v Review upgrade scenarios to determine which scenario you want to use.
v Review and record system configuration information.
v Review and record performance and tuning information.

Upgrade Planning Checklist: To assist you with your upgrade planning, review
the following planning checklist:

# Upgrade Planning Checklist Your Notes

1 Read through this entire document so that you have a
clear understanding of what the upgrade requires.

2 Download and review the following information from
the Sterling B2B Integrator documentation library.

v System Requirements - With each release, IBM
introduces leading edge technology to improve and
enhance its software. Review the System Requirements
to confirm that your system and databases meet the
requirements for this release.

v Release Notes - Review the release notes to obtain
information about issues and resolutions which have
been identified for this release.

v What's New in this Release - Review this guide to find
out about new features and functionality provided in
this release.

v Installation and Upgrade Information - Lists the
installation and upgrade documents available for this
version of Sterling B2B Integrator.

3 CAUTION:
Before upgrading to the latest product version, contact
your sales representative to verify that it includes all
of your current functionality. Depending on the
timing, even though it's in a higher version that the
one you have installed, a particular mod release or fix
pack might not include all the functionality in your
current version or fix pack.

4 Collect information on third-party libraries used for
adapter configurations that were added to your current
release.

You will need to add each of these libraries to the
upgraded system.

5 Locate any configuration file changes for JDBC adapter
or Lightweight JDBC adapter in your current release.

You will need to copy these changes to the upgraded
system.

6 Record your performance tuning configuration.

You will need to restore these settings after the system
has been upgraded.
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# Upgrade Planning Checklist Your Notes

7 Review and note the adapters, business processes, and
other configurations in your current release.

This information will help you identify the need for
updating transport messages, third-party adapters, or
configurations to adapters, such as File System or
Command Line adapters.

8 Determine if you have edited any of the property files
(.properties or .properties.in).

The upgrade process overwrites these property files,
unless these changes were made using the
customer_overrides.properties file. Your previous
property file edits might not be applicable this version
of the software.

9 Determine if you edited any of the following cdinterop
files:

v cdinterop-proxy-records.properties

v cdinterop-spoe-auth.properties

v cdinterop-spoe-policy.properties

v cdinterop-user-records.properties

You must back them up before upgrading. The
cdinterop files do not have initialization (*.in) files. After
the upgrade, use the backup version of the files in your
upgraded installation.

10 Determine if you have LDAP (Lightweight Directory
Access Protocol) configuration information in the
security.properties file. This information will
automatically be moved to the
authentication_policy.properties file.

11 Determine whether Sterling B2B Integrator is using an
application server (JBoss™, WebLogic® or WebSphere®).

Sterling B2B Integrator does not require an application
server for installation or at runtime.

Sterling B2B Integrator supports integration with JBoss
and WebLogic during the installation. You can also
integrate with WebSphere, JBoss, or WebLogic by using
the Sterling B2B Integrator EJB Adapter. This does not
represent a WebLogic server for deploying the
Application Console.

12 If you use a File System as your document storage
method, determine and record the path to the File
System.

You will need the File System path structure so that
after the upgrade, you can copy/mount the documents
to the new installation directory. The directory structure
(path to the File System) must be the same in the
current and in the upgraded system.

13 Review the EDI Sequence Check Queue to ensure that
no interchanges are in the queue. The EDI Sequence
Check Queue is used for X12 and EDIFACT sequence
and duplicate checking.
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# Upgrade Planning Checklist Your Notes

14 Determine if you have any JVM Containers configured.

If yes, you will have to reconfigure the JVM containers
after you have upgraded the software.

Prepare Your System for the Upgrade
To help ensure a trouble-free upgrade, be sure to prepare your system before
beginning the upgrade.

Before you begin the upgrade :
v Complete all Pre-Upgrade Checklists.
v Verify that your system meets all system requirements.
v Obtain the upgrade media.
v Create a process output log (optional).
v (Microsoft SQL Server only) Configure the snapshot feature (optional).
v (DB2 only) Upgrade DB2 to version 10.1 or 10.5, if needed.

Pre-Upgrade System Checklist:

Use the Pre-Upgrade System Checklist to help ensure that your system is ready for
upgrading and reduce the chance of errors or other problems during upgrade.

Before you begin an upgrade:

# Pre-Upgrade System Checklist Your Notes

1 Use the system requirements to verify that your system hardware
and software meet the requirements specified for this release.

Verify you have the correct:

v Patches required by Java™ for the operation system

v Version of the JDK

v JDK Patches

v Absolute path to JDK and patches

v Database must match the version listed in the requirements

If any of the above requirements are not met, the installation will
fail and print/log a report of all items that were non-compliant.

Ensure that you have the correct license file and JCE file.
Important: Do not remove the existing license file or JCE file
from your system. The files specified by the LICENSE_FILE_PATH
and JCE_DIST_FILE parameters in the sandbox.cfg file must be
present during the upgrade, or the upgrade will fail.

2 For systems with multiple IP addresses, verify that the IP address
on which Sterling B2B Integrator resides is accessible by any
client computer that is running a browser interface.

If you do not verify the IP addresses, your system may not
operate properly after installing Sterling B2B Integrator.

3 If you are using a non-English environment, confirm that you are
using the appropriate character set.

4 Verify the file system has adequate free disk space.
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# Pre-Upgrade System Checklist Your Notes

5 Obtain the upgrade media.

It is a best practice to check the Product Updates and Downloads
site to ensure you have the latest version of the media.

6 Backup your Sterling B2B Integrator installation directory and the
database.

If there are problems with your upgraded system, the only way
to ensure that you can roll-back to your previous version is to
back up Sterling B2B Integrator and the database.

7 Archive your data.

Archived data can only be restored from the same version of
Sterling B2B Integrator from which it was archived. If you need to
restore archived data that was archived prior to performing the
upgrade, then you must have a running instance of Sterling B2B
Integrator that matches the version from which the archive was
taken.

8 Purge any unneeded data.

9 Export any business objects that can not be upgraded. Including
business processes, service configurations, trading partners, and
maps.

The exported business object can be imported into the upgraded
system if you need them.

10 Create a process output log.

11 Disable the virus protection software on the server.

If the virus protection software is enabled, the upgrade will fail.

Pre-Upgrade Database Checklist (Windows): Before you begin an installation,
you need to:

# Pre-Upgrade Database Checklist Your Notes

1 If required, copy the Microsoft SQL Server 2000 or
2005 Database to a supported SQL Server Database
version.

This is an optional procedure, and it is the
customer's responsibility to perform it. (IBM
Customer Support can not help with this
procedure.)

2 If you are using Oracle 8i with Sterling B2B
Integrator 4.0, upgrade to Oracle 9i before
upgrading to this version of Sterling B2B
Integrator.
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# Pre-Upgrade Database Checklist Your Notes

3 If you plan to import an Oracle 9 or Oracle 10
database, while upgrading to this version of
Sterling B2B Integrator, you must import the
database without the indexes.

For example, if you are using the Oracle import
(imp) tool, you should use the INDEXES=N option.
If you attempt upgrading to this version of Sterling
B2B Integrator with indexes turned on, the
upgrade will fail. If you had created any custom
indexes in Oracle database, add them after
performing the upgrade as they are not imported.

4 If you are using MySQL, a new MySQL database
will be created in this version of Sterling B2B
Integrator and information will be copied from the
MySQL database in your previous version of
Sterling B2B Integrator to the new database.

The MySQL database in your previous version of
Sterling B2B Integrator will still work. When you
copy your database, if you encounter Data
Overflow or Invalid Time Format errors while
copying the WORKFLOW_CONTEXT table, run
this query:

UPDATE WORKFLOW_CONTEXT SET ENTERQ =
NULL, EXITQ = NULL where ENTERQ IS NOT
NULL OR EXITQ IS NOT NULL

Pre-Upgrade Operating System Verification Checklist:

Before you begin the upgrade, you need to verify your operating system
configuration.

For the Operating System Operating System Configuration Checklist Your Notes

HP-UX Operating System Verify these settings:

v Verify kernel parameters and establish the following
minimum settings by running the kctune command:

– kctune max_thread_proc 1024

– kctune maxdsiz 2147483648

– kctune maxdsiz_64bit 8589934592

– kctune maxssiz 369098752

– kctune maxssiz_64bit 536870912

v Run ulimit utility, verify, and establish the following
minimum settings:

– ulimit -d = 2097152 (in kilobytes) or higher

– ulimit -s = 360448 (in kilobytes) or higher
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For the Operating System Operating System Configuration Checklist Your Notes

AIX Operating System You must specify the name of the installation directory
name. The installation process creates the directory and
beneath it, a directory called “install”.

To ensure that /install_dir/install has the necessary
permissions, AIX users must run the following
command on the parent directory of /install_dir/install
before installation:

chmod -R a-s <absolute path>/install_dir_parent

where install_dir_parent is the directory in which
/install_dir/install will be created.

For example, to specify

AIX_1/applications/test1/my_install as your
installation directory, you could run the command from
the AIX_1/applications directory (directly above the
test1 directory):

chmod -R a-s test1

or from another location on the file system:

chmod -R a-s /AIX_1/applications/test1

This ensures that when the my_install directory is
created during installation, it inherits the correct
permissions from test1.

Solaris Operating System Set the following entries in the /etc/security/limits
file:

nofiles = 4096

set rlim_fd_max=4096 (limit is 65535) - hard limit

set rlim_fd_cur=4096 - soft limit

For nofiles, the value shown is an example. The
possible values are unlimited, so the number for nofiles
can be much larger. Revise the value as appropriate for
your business needs.

v To make the setting effective as the hard limit, reboot
the server or run the following command:

kill -1 inetd

v To make the setting effective as the soft limit, use the
parent shell configuration (for example, .profile).
Then, reboot the server.

Linux Operating System You need to disable SELinux by enter the following:

/etc/sysconfig/selinux: SELINUX=disabled

Ensure that /etc/hosts has short-names first for all
entries. For example,
127.0.0.1localhostlocalhost.localdomain

If the base locale is English, verify:

v that the LANG variable is en_US

v LANG variable is exported
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For the Operating System Operating System Configuration Checklist Your Notes

RedHat Enterprise Linux
Operating System

Make the following system changes:

v If the base locale for the system is English, edit the
/etc/sysconfig/i18n file by changing the
SUPPORTED variable from en_US.utf8 to en_US. You
can also allow multiple support using the following
format: en_US.utf8:en_US

v Save and close the /etc/sysconfig/i18n file. Edit the
/etc/security/limits.conf file by adding the
following lines:

– * hard nofile 8196

– * soft nofile 4096

– * hard memlock 3000000

– * soft memlock 3000000

– * hard nproc 16000

– * soft nproc 16000

– * hard stack 512000

– * soft stack 512000

This updates the system ulimits.

For nofile, the values shown are examples. The
possible values are unlimited, so the numbers for hard
nofile and soft nofile can be much larger. Revise
these values as appropriate for your business needs.

v Save and close the /etc/security/limits.conf file.

v Reboot the system.

IBM Installation Manager in UI mode may fail to start
on an RHEL 6.1 or higher x86_64 (64-bit) OS because
Installation Manager is a 32-bit application and is
dependent on some of the 32-bit libraries.

For information on installing the required 32-bit OS
libraries, refer to the IBM Support Website
(https://www-304.ibm.com/support/
docview.wss?uid=swg21459143)

CAUTION:
Due to a known issue with the IBM JDK on RHEL 6.1
or higher, a performance degradation might be seen in
comparison to previous RHEL releases. To avoid this
issue, disable the CFS on RHEL 6.1 or higher.

To disable CFS:

v Log in as root

v Edit /etc/sysctl.conf and add
"kernel.sched_compat_yield = 1"

v Reboot the system

For more information go to the IBM SDK and
Runtime Environment Java Technology Edition
Version 6 Information Center and search for known
limitations on linux.
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For the Operating System Operating System Configuration Checklist Your Notes

SUSE Linux Operating
System

Make the following system changes:

v If the base locale for the system is English, edit the
/etc/sysconfig/i18n file by changing the
SUPPORTED variable from en_US.utf8 to en_US. You
can also allow multiple support using the following
format: en_US.utf8:en_US

v Save and close the /etc/sysconfig/i18n file. Edit the
/etc/security/limits.conf file by adding the
following lines:

– * hard nofile 8196

– * soft nofile 4096

– * hard memlock 3000000

– * soft memlock 3000000

– * hard nproc 16000

– * soft nproc 16000

– * hard stack 512000

– * soft stack 512000

This updates the system ulimits.

For nofile, the values shown are examples. The
possible values are unlimited, so the numbers for hard
nofile and soft nofile can be much larger. Revise
these values as appropriate for your business needs.

v Save and close the /etc/security/limits.conf file.

v Reboot the system.

Verification of the system requirements:

Before you begin the installation, verify that your system meets the hardware and
software requirements that are specified for this release.

The hardware requirements that are listed in the System Requirements are the
minimum requirements. Your system requirements might exceed these
requirements if you are running other applications on the same machine as Sterling
B2B Integrator.

The installation strictly enforces the following system requirements:
v Operating system version must match requirement exactly.
v The minimum patch level for the operating system is enforced, but you can

apply higher patch levels.
v JDK version must match requirement exactly.
v The disk space is a minimum for the installation. The system must be separately

sized to handle whatever load is going to be put on the system.
v Database version must match exactly.
v JDBC driver version supports exact matches and wildcard matches.

If any of these requirements are not met, the installation fails. If the installation
fails, review the installation log for a list of non-compliant items.
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Upgrading your JDK (Windows and UNIX):

Sometimes you need to upgrade your JDK version to support a new version of
Sterling B2B Integrator.

About this task

If you have V5.2.4.1 or higher installed, you can use the upgradeJDK script to
upgrade your version of the JDK. See bin Directory Files for more information.

If you have V5.2.4.0 or lower installed, follow the steps below to upgrade your
JDK.

Procedure

1. Download the new JCE file. For example, the UnrestrictedPolicy.zip policy
file for the IBM JDK.

2. Back up the existing JDK in <Install Dir>/jdk. Change the folder name to
jdk_back)

3. Copy the new IBM JDK (1.7.0 ) folder to the installation Directory. Directory
Name should be jdk )

4. Copy all the jars present in <Install Dir >jdk_back\jre\lib\ext to <install
Dir>jdk\jre\lib\ext directory.

5. If your installation of V5.2.4 or lower was built using the Oracle (SUN) JDK,
continue to the next step. Otherwise skip to step 6.
a. Edit the sandbox.cfg property file.
b. Set JCE_DIST_FILE=<New Path of Supported JCE File>. For example,

JCE_DIST_FILE=D\:\\IBM\\unrestrictedpolicyfiles.zip.
c. Back up the local_policy.jar and US_export_policy.jar files present in

<Install Dir>jdk\jre\lib\security.
d. Unzip the new JCE file. For example, Unrestrictedpolicyfiles.zip file.

Copy local_policy.jar and US_export_policy.jar to <Install
Dir>jdk\jre\lib\security.

6. Run updateJavaSecurity.cmd <path_to_new_jdk><Install Dir>/jdk.
7. Verify that security providers have been updated in <Install

Dir>\jdk\jre\lib\security\java.security.
8. Follow the Upgrade Guide instructions for your upgrade scenario.

Obtain Upgrade Media:
About this task

Before you upgrade, ensure that you have the latest version of the upgrade media
from the Passport Advantage online site or have downloaded the fix pack from Fix
Central..

For the latest version and for online support, go to: http://www.ibm.com/
software/howtobuy/passportadvantage/pao_customers.htm

Note: For V5.2.6, the fix pack download used for upgrading from V5.2.x to V5.2.6
is very large. It includes the new functionality for Global Mailbox. You must
download the full fix pack file to upgrade to V5.2.6 by installing a fix pack even if
you do not plan to install Global Mailbox.

Create Process Output Log:
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About this task

A log of process activity during the upgrade will help if troubleshooting is
required. Output is automatically logged to the upgrade log files (PreInstallSi.log
and InstallSi.log). Use this procedure to generate a separate output log for each
process you want to log.

To create a process output log:

Procedure

1. From any directory, run the script command to record the processes, ensuring
that you have created and specified the name of the file in which to save the
process output.
For example, to start recording output to a file named processoutput.log, type
script processoutput.log at the command line. The processoutput.log file will be
created in the directory where you ran the script command.

2. After the upgrade is complete, enter exit at the command line to stop
recording.

3. You can now retrieve the file containing the process output.
The following example shows a session after starting the script command,
specifying the output to be saved to the file named listing.log, and typing exit
to stop the script command from running:
[2]%script listing.log

Script started, file is listing.log
[3]%ls
Custard.Recipe FavoriteRecipes Curry.Recipe
VindalooCurry.Recipe Jelly.Recipe
[4]%exit
Script done, file is listing.log

Configuring the snapshot feature for Microsoft SQL Server:

The snapshot feature in Microsoft SQL Server allows you to view a read-only copy
of the database even when it is locked. Configuring the snapshot feature can also
reduce deadlocks. To enable the snap shot feature, enter the following command:
ALTER DATABASE db_name SET READ_COMMITTED_SNAPSHOT ON;

Upgrading DB2 to version 10.1 or 10.5:

To upgrade from DB2 9.5 or 9.7 to 10.1 or 10.5, you must make configuration
changes.

Procedure

1. Complete the steps in the following table that pertain to your version of
Sterling B2B Integrator before you proceed to step 2.

Important: Back up all files before you change any settings.

If you are upgrading from ... Do the following steps:

Sterling B2B Integrator 5.1.x Upgrade Sterling B2B Integrator to V5.2.6
and point to your DB2 9.5 or 9.7 database

Sterling B2B Integrator 5.2.x Upgrade your 5.2.x installation to V5.2.6

2. Copy your DB2 9.5 or 9.7 database content to DB2 10.1 or 10.5.
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3. Take a backup of the database driver located at /install_dir/dbjar/jdbc/DB2/
and then replace it with the DB2 10.1 or 10.5 version.

4. Update the following sandbox.cfg file fields with your environment-specific
parameters:
DB_PASS=
DB_SCHEMA_OWNER=
DB_DRIVERS_VERSION=
YANTRA_DB_PORT=
DB_DATA=
DB_HOST=
YANTRA_DB_USER=
DB_PORT=
YANTRA_DB_PASS=
YANTRA_DB_DATA=
YANTRA_DB_HOST=
DB_DRIVERS=
DB_USER=

DB2_PORT=
DB2_USER=
DB2_PASS=
DB2_DATA=
DB2_HOST=

5. Edit the following in the activemq.xml file:
activemq.xml: <value>jdbc:db2//DB_HOST:DB_PORT/DB_DATA</value>

6. Run the setupfiles script.
7. Run the deployer script.
8. Start Sterling B2B Integrator.

Information Gathering Checklist

Information Gathering Checklist for Upgrade (Windows): Before you begin the
upgrade, you should review the information in the Information Gathering
Checklist. The checklist contains all of the information that you will need to have
while running the upgrade scripts. Supporting information and details are
included at the end of this chapter.

The checklist contains:
v Brief descriptions for tasks (detailed procedures are provided after the checklist)
v Information you need to gather to prior the starting the upgrade

You may want to make a copy of the following checklist and use it to record the
information you collect.

#
Information Gathering Checklist for Upgrade
(Windows) Your Notes

1 Review your IBM contract to determine what
software you have licensed. You need to know this
License Information so that you can select the correct
components/features to install.

2 Determine which upgrade method you are going to
use:

v IBM Installation Manager (Graphical User
Interface)

v IBM Installation Manager (Text Based)

v Silent Installation
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#
Information Gathering Checklist for Upgrade
(Windows) Your Notes

3 Determine if you are going to run the pre-upgrade
checks during the upgrade.

4 Decide which type of security certificates you will
use:

v The default self-signed SSL (Secure Sockets Layer)
certificate that is automatically installed.

v A Certificate Authority-related certificate that you
install before installing the software.

5 If you are using an Oracle, SQL Server (2005 or
2008), or DB2 database, decide if you are going to
manually or automatically apply Database Definition
Language (DDL) Statements (schema) to the
database.

6 If you are using an Oracle 11.1 database, you must
set it up for native compilation by allocating space
and by setting the plsql_native_library_dir
parameter.

7 Determine if you are going to use FIPS (Federal
Information Processing Standards) mode.

8 Record the Hostname on which you plan to install
the software.

9 Record the Directory Name where you plan to install
the software.

10 Record the Login to host machine.

11 Record the Password to the host machine.

12 Record the path to the JDBC drivers.

13 Record the path to the installation wizard and file
name.

14 Record the path to JDK.

15 Record the path to JCE file.

16 Record the Host IP address.

17 Record the Initial Port Number.

18 Record the System passphase.

19 Record the Administrative e-mail address to which
system alert messages are sent.

20 Record the SMTP Server IP address used for sending
alert messages.

21 Record the Database vendor name.

22 Record the Database user name.

23 Record the Database password.

24 Record the Database (catalog) name.

25 Record the Database host name.

26 For Oracle, Microsoft SQL Server, MySQL, or DB2,
record the path and file name for the JDBC Driver.
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Supporting Information:

Pre-Upgrade Checks: Pre-upgrade check reviews Oracle, SQL Server, and DB2
database environments prior to starting the upgrade. This is an optional
installation feature which looks for common upgrade errors. The pre-upgrade
checks ensure:
v SI_VERSION table exists
v Database character set is correct for Oracle and DB2
v Schedule start times are not later than the end times
v Passphrase entered matches the existing passphrase in the database
v Database implementation for Oracle Long Raw and BLOB
v User has permission to perform the upgrade
v Collation settings are validated for MS SQL
v OBJECT_NAME in table SCI_ENTITY is no longer than 100 characters
v Default schema you identified during upgrade matches the existing database

If any of these items are not validated, the upgrade fails. You are provided with an
error message and must correct the situations and then restart the upgrade.

License information:

A separate license is required for each Sterling B2B Integrator feature that you
purchased. During installation, you must choose the license files according to what
you purchased. Product licenses do not require an activation key.

IBM assumes customers will only install and use the products they purchased. IBM
reserves the right to inspect installs for compliance at any time.

After the installation finishes, if you determine that you need to modify licenses
files, see “License modifications” on page 58.

Product Licenses for Sterling B2B Integrator

Sterling B2B Integrator Standard and Enterprise Edition includes:
v MESA Studio
v eInvoicing
v Report Services
v all services and adapters not listed below

Sterling B2B Integrator Standard and Enterprise Financial Edition includes
everything listed above plus:
v CHIPS
v SWIFTNet
v NACHA ACH CTX adapter
v FEDWIRE
v Fin Serv XML standard
v FIPS Mode
v Image Cash Letter service
v EBICS

Installing and upgrading (V5.2.6 or later) 411



Security certificates:

You can choose between different security certificates before you install Sterling
B2B Integrator.

Before you begin the installation, you must decide which of the following security
certificates to use:
v The default self-signed SSL (Secure Sockets Layer) certificate that is

automatically generated by the installation.
v A Certificate Authority-related certificate that you generate before you install the

software.

If you install with the default SSL certificate, but you later want to switch to a
CA-related certificate, you can change the certificate with the sslCert property in
the noapp.properties_platform_ifcresources_ext.in file.

Port Numbers in a Windows Environment: During installation or an upgrade, you
are prompted to specify the initial port number for Sterling B2B Integrator.

To specify an initial port number, follow these guidelines:
v Sterling B2B Integrator requires a range of 200 consecutive open ports between

1025 and 65535. The port range starts with the initial port number and ends
with the number that equals the initial port number plus 200. For example, if
you specify 10100, then you need to make sure that 10100 through 10199 are not
used by any other applications on your system.

Note: Because of RMI, on occasion, a port number outside the range may be
assigned.

v The initial port number represents the beginning port number in the range.
v Make sure that port numbers in the port range are not used by any other

applications on your system.

During the upgrade, about 50 default ports are pre-assigned for different services.
For example, if you do not want xxx32 (10132) to be a default port, you could
assign that port to xxx97 or another number within the port range.

After your installation or upgrade, refer to the \install_dir\install\properties\
sandbox.cfg file for all of the port assignments.

Database Definition Language (DDL) Statements: When you install Sterling B2B
Integrator, you can manually apply Database Definition Language (DDL)
statements to your database tables instead of requiring the installation process to
do it directly.

This feature increases database security by reducing the database permissions of
the Sterling B2B Integrator database user. The rights to database objects can be
reserved for a secure user like a customer database administrator (DBA). A
business can require that only a DBA with the proper permissions can make
database changes.

Upgrading DB2 to version 10.1 or 10.5:

To upgrade from DB2 9.5 or 9.7 to 10.1 or 10.5, you must make configuration
changes.
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Procedure

1. Complete the steps in the following table that pertain to your version of
Sterling B2B Integrator before you proceed to step 2.

Important: Back up all files before you change any settings.

If you are upgrading from ... Do the following steps:

Sterling B2B Integrator 5.1.x Upgrade Sterling B2B Integrator to V5.2.6
and point to your DB2 9.5 or 9.7 database

Sterling B2B Integrator 5.2.x Upgrade your 5.2.x installation to V5.2.6

2. Copy your DB2 9.5 or 9.7 database content to DB2 10.1 or 10.5.
3. Take a backup of the database driver located at /install_dir/dbjar/jdbc/DB2/

and then replace it with the DB2 10.1 or 10.5 version.
4. Update the following sandbox.cfg file fields with your environment-specific

parameters:
DB_PASS=
DB_SCHEMA_OWNER=
DB_DRIVERS_VERSION=
YANTRA_DB_PORT=
DB_DATA=
DB_HOST=
YANTRA_DB_USER=
DB_PORT=
YANTRA_DB_PASS=
YANTRA_DB_DATA=
YANTRA_DB_HOST=
DB_DRIVERS=
DB_USER=

DB2_PORT=
DB2_USER=
DB2_PASS=
DB2_DATA=
DB2_HOST=

5. Edit the following in the activemq.xml file:
activemq.xml: <value>jdbc:db2//DB_HOST:DB_PORT/DB_DATA</value>

6. Run the setupfiles script.
7. Run the deployer script.
8. Start Sterling B2B Integrator.

Upgrade the Software

General Windows Upgrade Information:

CAUTION:
Sterling B2B Integrator should be installed behind a company firewall for
security purposes. See the Perimeter Server and Security topics in the Sterling
B2B Integrator documentation library for more information on secure
deployment options.

General Upgrade Guidelines

Review the following are some general guidelines:
v The directory path to SI_<build_number>.jar cannot include any spaces.
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v Do not create the new installation directory manually before the start of the
upgrade. If you create the installation directory before you begin, the upgrade
will fail. The directory name provided during the upgrade process is used to
create the new installation directory.

v The server on which you are installing must have adequate free disk space.
v When creating a name, such as an account name, permissions name, profile

name, or database name, do not use any valid alphanumeric characters and -, :,
$, &, or _. Do not use spaces or apostrophes.

v install_dir refers to the installation directory where the new software will be
installed. Do not use any pre-existing directory name or an old version of the
Sterling B2B Integrator installation directory. If you do, you could inadvertently
overwrite the existing installation.

v parent_install is the directory one level above the install_dir directory.
v Ensure that the parent_install directory has the proper read/write permissions.
v If you are using FTP to copy the files, verify that your session is set to binary

mode.
v Sterling B2B Integrator does not support IPv6 installation on Windows. Before

applying an IPv6 address, see the IPv6 Capabilities section in the System
Requirements guide.

v To install more than one instance of Sterling B2B Integrator on the same
Windows server, you must install the second instance in a different directory.

v If you are installing Sterling B2B Integrator on VMware, provide the IP address
of the virtual machine, not the IP address of the VMware host. For example, if
10.251.124.160 is the IP address of the VMware host and 10.251.124.156 is the IP
address of the Windows 2003 server it is hosting, you should use 10.251.124.156
as the correct IP address to install Sterling B2B Integrator.

v The installation creates subsequent ports based on the initial port number. For
all of the port assignments, see the \install_dir\install\properties\sandbox.cfg
file.

v You need to know what version of the Windows Server you are using.
v If you are running the upgrade on an active installation of Sterling B2B

Integrator, you will need to run the soft stop command to gracefully stop traffic.
For more information on performing a soft stop, see the Soft Stop
documentation in the System Administration Guide on the Sterling B2B
Integrator 5.2 Knowledge Center.

General IBM Installation Manager information:

IBM Installation Manager V1.8.2 is required to install Sterling B2B Integrator on all
supported platforms.

Installation Manager is a Java based multiplatform installation application and
provides a consistent approach across various platforms. It does not rely on
platform-specific installation technology or mechanism.

Installation Manager uses the local Sterling B2B Integrator offering repositories to
install or update Sterling B2B Integrator and its add-on features. It determines the
packages that must be installed and displays them including the products, fix
packs, and interim fixes. It checks that all prerequisites and interdependencies are
met before installing the selected product package and feature sets.
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Important: The Uninstall option only unregisters Sterling B2B Integrator from
Installation Manager. The uninstall procedure as described in the related sections
must be performed to completely uninstall Sterling B2B Integrator.

Installation Manager must be installed on each computer on which Sterling B2B
Integrator is being installed. If you already have Installation Manager installed on
your computer for use with other IBM applications, it can be used with installing
Sterling B2B Integrator as long as it's the correct version. If you do not have
Installation Manager installed, it is provided as part of the Sterling B2B Integrator
installation media.

Supported bit-versions

A 64-bit version of IBM Installation Manager V 1.8.2 is provided with the Sterling
B2B Integrator installation package. However, you can also install with a 32-bit
version of Installation Manager.

Before you start the installation, consider the following options:
v If you are a new customer, use the version of Installation Manager that is

provided with the Sterling B2B Integrator installation package and install
Sterling B2B Integrator.

v If you have an earlier version of Installation Manager, you can update it to
V1.8.2 using the Installation Manager that is provided with the installation
package, then install Sterling B2B Integrator .

v If you are a current customer who did not use Installation Manager earlier,
install the version of Installation Manager that is provided with the installation
package, then upgrade your Sterling B2B Integrator installation.

v If you have a 32-bit Installation Manager installed, you must download the
32-bit Installation Manager V1.8.2 from Fix Central or IBM Passport Advantage,
upgrade it, then proceed with the installation of Sterling B2B Integrator. Ensure
you have the required libraries that support screen presentation of the text.

Checking for updates

To check for Installation Manager updates, select Search for Installation Manager
updates on the File > Preferences > Updates page. When the check box is
selected, Installation Manager searches for updates when any one of the following
pages are opened from the Installation Manager start page:
v Install Packages
v Modify Packages
v Update Packages

Installation Manager also searches for updates when you click the Check for Other
Versions, Fixes, and Extensions button on the Install Packages page.

Starting Installation Manager

You should start the Installation Manager (and also install Sterling B2B Integrator)
as a non-administrator user.

How you start Installation Manager depends on whether you are using the
Installation Manager agent that is provided with Sterling B2B Integrator or if you
have an Installation Manager instance that is installed on your system. It also
depends on whether you have 32-bit or 64-bit Installation Manager.

Installing and upgrading (V5.2.6 or later) 415



Open a command prompt and do one of the following tasks to start the
Installation Manager in GUI mode:
v Go to the IM_<operating_system> directory and type ./userinst or userinst.exe

(Windows) for the following scenario:
– If you do not have Installation Manager installed and are using the

Installation Manager agent that is provided with the Sterling B2B Integrator
media.

– If you have a 64-bit Installation Manager installed.
– If you have Installation Manager installed on a platform that has only one

download available for Installation Manager. For example, AIX, Solaris, HP,
zLinux.

v Go to <installation directory>/Installation Manager/eclipse (for Windows
system, replace / with \) and type ./IBMIM or IBMIM.exe if you have 32-bit
Installation Manager installed on a Linux or Windows system.

For information on starting Installation Manager in command mode for silent
installation, see the Installing or updating with a response file.

For information on starting Installation Manager in command mode to record a
response file, see Recording a response file.

Additional heap memory parameters

The heap memory parameters specify the amount of memory Installation Manager
can use during the installation process. The heap memory pool sizes that are used
by Installation Manager are hardcoded defaults. If these defaults are not sufficient
for your environment, you can specify different values by adding parameters to
the Installation Managerconfig.ini file.

Important: These additional parameters are required only if you are experiencing
Out Of Memory errors during the installation process.

The following parameters can be added:
v memoryMin=user.sb.INSTALL_<OS>_INIT_HEAP.<amount_of_memory>

v memoryMax=user.sb.INSTALL_<OS>_MAX_HEAP.<amount_of_memory>

Where <OS> is your operating system and <amount_of_memory> is the specified
amount of memory.

Operating
System Parameter Example Entry

Sun-Solaris Initial Heap Size

INSTALL_SUN_INIT_HEAP

memoryMin=user.sb.INSTALL_SUN_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_SUN_MAX_HEAP

memoryMax=user.sb.INSTALL_SUN_MAX_HEAP.3072m

Linux Initial Heap Size

INSTALL_LINUX_INIT_HEAP

memoryMin=user.sb.INSTALL_LINUX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_LINUX_MAX_HEAP

memoryMax=user.sb.INSTALL_LINUX_MAX_HEAP.3072m
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Operating
System Parameter Example Entry

AIX Initial Heap Size

INSTALL_AIX_INIT_HEAP

memoryMin=user.sb.INSTALL_AIX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_AIX_MAX_HEAP

memoryMax=user.sb.INSTALL_AIX_MAX_HEAP.3072m

HP-UX Initial Heap Size

INSTALL_HPUX_INIT_HEAP

memoryMin=user.sb.INSTALL_HPUX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_HPUX_MAX_HEAP

memoryMax=user.sb.INSTALL_HPUX_MAX_HEAP.3072m

Windows Initial Heap Size

INSTALL_WIN_INIT_HEAP

memoryMin=user.sb.INSTALL_WIN_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_WIN_MAX_HEAP

memoryMax=user.sb.INSTALL_WIN_MAX_HEAP.3072m

Installing or updating with a response file (V5.2.6 or later):

You can install or update (apply fix pack or interim fix) Sterling B2B Integrator
with silent mode by using the sample response files or converting your existing
response file to the required format.

Upgrading in a Windows non-cluster environment with the IBM Installation
Manager in GUI mode:

You can upgrade Sterling B2B Integrator in a Windows non-cluster environment
with the IBM Installation Manager in a graphical user interface (GUI) mode.

Before you begin

v Ensure that your system is ready for the upgrade. See “Prepare Your System for
the Upgrade” on page 332.
Attention: Failure to properly prepare your system can cause the upgrade to
fail.

v Complete the “Information Gathering Checklist for Upgrade (Windows)” on
page 409.

v You must have administrative privileges and a login on the host machine to do
an upgrade.

v If you are using the Standards Processing Engine (SPE) application with Sterling
B2B Integrator, you must upgrade SPE before you upgrade Sterling B2B
Integrator.

v If you are using the EBICS Banking Server application with Sterling B2B
Integrator, the data encryption for storage within the installation location is not
supported.

v Set the ulimit and language as follows:
– ulimit -n 4096
– ulimit -u 16000
– export LANG=en_US
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About this task

This upgrade changes the administrative password to the default password. After
the upgrade, change the password back to the administrative password to
minimize security risks. This is the Admin password for logging into the user
interface (/dashboard or /ws).

Important: Following is a list of changes related to installing or upgrading to
Sterling B2B Integrator V5.2.6:
v You can upgrade using the user interface or silent installation mode (response

files). Console mode upgrade is not supported.
v Sterling B2B Integrator JAR file is included in the repository. Therefore it is not

required to manually select the JAR file when upgrading.
v You must use Installation Manager V1.8.2 to upgrade Sterling B2B Integrator.

InstallService is disabled, and cannot be used. You can use InstallService
only for a specific scenario related to Sterling File Gateway. For more
information, see step 13.

Procedure

1. Close all open Windows programs and any command prompt windows.
2. From the installation media, copy the compressed upgrade package to a

location on your desktop.
3. Decompress the upgrade package.
4. Open the InstallationManager folder in the directory structure that is created

when the installation package is decompressed. Several
IM_OperatingSystem.zip files are displayed.

5. Decompress the IM_Win.zip file. This action creates a new IM_Win folder.

Important: Installation Manager V1.8.2 is required to upgrade to Sterling B2B
Integrator V5.2.6. If Installation Manager was not used to install your current
Sterling B2B Integrator instance, the installation process installs the Installation
Manager when you start the upgrade to Sterling B2B Integrator V5.2.6. After
successful installation, restart the Installation Manager, and proceed with
upgrading to Sterling B2B Integrator V5.2.6.

6. Decompress the Common_Repo.zip from the installation package. The action
creates two new folders b2birepo and gmrepo. The IM_Win, b2birepo, and
gmrepo folders must be at the same level in a directory.

Important: gmrepo contains the repository file required to install Global
Mailbox. For information about Global Mailbox, see Global Mailbox overview.

7. Do one of the following tasks to start the Installation Manager:
a. Go to the IM_Win directory and double-click userinst.exe for the following

scenarios:
v If you do not have the Installation Manager installed and are using the

Installation Manager agent provided with V5.2.6.
v If you have a 64-bit Installation Manager installed.

b. Go to <installation directory>\Installation Manager\eclipse and
double-click IBMIM.exe, if you have 32-bit Installation Manager installed on
your Windows system.

Important: It is suggested to record a response file. The response file can be
used to install Sterling B2B Integrator after applying database schema

418 Installing and upgrading (V5.2.6 or later):

http://www.ibm.com/support/knowledgecenter/SS3JSW_5.2.0/com.ibm.help.gdha_overview.doc/com.ibm.help.gdha_overview.doc/gdha_overview.html


manually or install second and subsequent nodes in a cluster. For more
information, see Installing or updating with a response file.

8. On the Installation Manager home page, click Install.

Important: If IM_<operating_system> and b2birepo directories are not in the
same directory or if you already have Installation Manager installed, then you
get a message saying that there no packages to install or Installation Manager
could not connect to the repositories. You must add the Sterling B2B
Integrator repository files to the Installation Manager repository. For more
information about adding repository files, see Repository preferences.

9. On the Install Packages screen, select IBM Sterling B2B Integrator. This
action selects the versions also. Click Next.

10. Review the license agreement and select the option I accept the terms in the
license agreements to continue.
If you do not accept the agreement, the upgrade process is canceled.

11. Select a location for the Shared Resources directory and a location for the
Installation Manager to reside:
a. Specify a Shared Resources Directory.
b. (Optional if previously installed) Specify an Installation Manager

Directory.

Note: The Shared Resources directory cannot be a sub-directory of the
Installation Manager installation.

The specified Shared Resources and Installation Manager directories must
be empty.

12. Choose Create a new package group and specify the path to Sterling B2B
Integrator installation directory.

13. Select the required features to be installed. The available options are:
v IBM Sterling B2B Integrator

v IBM Sterling File Gateway

Important: If your current installation includes Sterling File Gateway, then
Sterling File Gateway is also updated to V 2.2.6 when upgrading to Sterling
B2B Integrator V5.2.6. If Sterling File Gateway was not installed, it is not
installed when upgrading to Sterling B2B Integrator V5.2.6, when you select
the IBM Sterling File Gateway option. In this case, to install Sterling File
Gateway when upgrading, you must do one of the following tasks:
– When upgrading Sterling B2B Integrator, if you are installing Sterling

B2B Integrator to a fresh directory, and pointing to the previous database,
then you can install Sterling File Gateway V2.2.6.

– Use InstallService to install Sterling File Gateway. For information
about installing Sterling File Gateway by using InstallService, see
Installing Sterling File Gateway (V2.2.6 or later).

v FIPS Module

v AS2 Edition Module

v Financial Services Module

v EBICS Banking Server Module

v B2B Advanced Communications Integration Module
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Important: When upgrading to Sterling B2B Integrator V5.2.6, select B2B
Advanced Communications Integration Module to install Sterling B2B
Integrator bridge. Sterling B2B Integrator bridge is required for
communication between Sterling B2B Integrator and B2B Advanced
Communications. If you are installing Global Mailbox and Sterling B2B
Integrator, then B2B Advanced Communications Integration Module
(Sterling B2B Integrator bridge) is installed by default, because Global Mailbox
uses the storage module of B2B Advanced Communications. However, you
must configure the adapter containers and adapters for Sterling B2B Integrator
bridge after upgrading.

Important:

IBM Sterling B2B Integrator is selected by default. Select only the licenses
and features that were defined by your IBM contract. If you are unsure which
to select, the installation can proceed without a selection and complete
successfully. Startup and operation of the software, however, requires one of
the licenses to be selected. See “License modifications” on page 58 to apply
licenses after the installation.

Features that are not part of your current Sterling B2B Integrator installation
are disabled and you cannot select them when upgrading or applying a fix
pack. To include them in your Sterling B2B Integrator setup, you must first
upgrade to the current version, and then install them separately. If the fix
pack or upgrade JAR includes updates to features that are part of your current
Sterling B2B Integrator installation, the features are upgraded regardless of
whether you select the them or not.

Important: You must manually install the EBICS client. For more information
about installing the EBICS Client manually, see the EBICS Client User Guide.

14. Enter the full path to the JDK directory.
15. Specify the configuration for the features to install and click Next.

v FIPS Compliance Mode (Must enable FIPS Module)

v NIST 800-131a Compliance Mode

– off (default value)
– strict

v SPE Integration Module (Requires pre-install of SPE, WTX optional)

If you select the SPE option, you are prompted for the following
information:
– SPE installation directory
– (Optional) WebSphere Transformation Extender (WTX) installation

directory
– SPE UI port
For more information, see the documentation for the integration of Sterling
B2B Integrator and SPE.

16. Enter the full path to your JCE file.
17. Enter your Installation panel properties information:

a. Enter the explicit IP address for the server or use the default value of
localhost.

b. Enter the Initial Port number or use the default value of 8080.
18. Enter your System Passphrase information:
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a. Enter a passphrase.
b. Confirm the passphrase.

19. Enter you E-Mail Information:
a. Enter the E-mail address to which you want system alert messages sent.
b. Enter the SMTP mail server (IP address or host name) that you want to

use for system alert messages and other administrative notices.
20. Specify if you want to Enable FIPS (Federal Information Processing

Standards) mode, select the check box. The default is FIPS mode is disabled.
21. Select the database vendor you want to use:

v Oracle
v Microsoft SQL Server
v DB2
v MySQL

22. Select all options that apply to this upgrade:

Choices: Action

This installation is for a cluster node 2 or
higher (Not applicable for MySQL)

Do not select this option.

Apply database schema automatically? (Not
applicable for MySQL)

If yes, no action required. The default is to
automatically apply the DDL statements.

If you want to manually create the database
schema, then clear the Apply database
schema automatically check box and
continue with the remaining upgrade steps.
Important: Once the upgrade starts, it runs
for a short time and stops without error.
When the upgrade stops, you must perform
additional actions as given in Step 28 of this
procedure.

23. Enter the Database Connection Information.
v Database user name.
v Database password (and confirmation).
v Database catalog name.
v Database host name.
v Database port.
v For Oracle, Microsoft SQL Server, and MySQL - Absolute path and file

name for one JDBC driver file.
v For DB2 - Absolute paths and file names for two JDBC driver files. Use the

Type-4 JDBC driver. This type of driver converts JDBC calls into the
network protocol used directly by DB2, allowing a direct call from the
system to the DB2 server.

24. Click Add to browse to the file location for the appropriate JDBC driver.
25. Click Test next to the database driver path.

Note: The Installation Manager must successfully validate the connection to
the database before you can continue with the upgrade. If there is a validation
failure you can view the system log to determine more information about the
failure. Perform the following:
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a. Identify the location of the user’s application directory. Select Start -> Run
and enter %APPDATA%.

b. Navigate to the user’s application directory: local_path\IBM\Installation
Manager\logs

c. Open the index.xml file in a browser.
d. Identify the log file based upon the timestamp of when you started your

upgrade.
e. Click on the install file to view a listing of errors that occurred during that

upgrade.
26. Determine what Other options apply to this installation. Select the applicable

options:
v Verbose install

v This installation is an upgrade from a prior version - Select this option.

Note: After you select the upgrade option, an additional option is
displayed.

v Would you like to run upgrade pre-check? - To run the pre-check, click
Test.

27. Specify the Performance configuration that applies to this upgrade. Select the
applicable options:
v Number of Processor Cores - Accept default value or enter appropriate

value.
v Physical Memory (MB) allocated to Sterling B2B Integrator - Accept

default value or enter appropriate value.
28. Review the installation package summary information. Click Install to

continue.

Attention: If you did not select the option to Apply database schema
automatically, the upgrade stops and you must perform these additional steps
to complete the installation with manual DDL statements:
a. Navigate to your install directory.
b. Locate the InstallSI.log file and open it with a file editor.
c. Search the file for these error messages:
v <SI_Install>/repository/scripts/EFrame_IndexAdds.sql must be

applied to the database.

v <SI_Install>//repository/scripts/EFrame_Sequence.sql must be
applied to the database.

v <SI_Install>//repository/scripts/EFrame_TableChanges.sql must be
applied to the database. Exiting installation..."

Important: If you do not find the above error messages in the log file, the
installation failed because of another reason and you must resolve that
error and attempt the installation again. If you did find these messages,
continue with the remaining steps.

d. Edit each .sql script and make changes appropriate for your database. This
may include changing the SQL delimiter or adding tablespace options.

e. Log in to your database as the DB schema user.
f. Execute the SQL files manually in this order:

Important: When you are executing the scripts, it is important to execute
the SQL scripts in the specified order.
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v EFrame_IndexDrops.sql
v EFrame_TableChanges.sql
v EFrame_IndexAdds.sql
v EFrame_TextIndexAdds.sql
v EFrame_Sequence.sql
v EFrame_TextIndexModify.sql
v EFrame_TextIndexUpdates.sql
v EFrame_TextIndexUpgrade.sql
v EFrame_Static.sql

Important: ActiveMQ uses dynamically generated table names based on
the name of the install node. Table generation is not included in the above
scripts, but is performed automatically during the initial start of Sterling
B2B Integrator or when a new cluster node is added. Table generation may
fail if security restrictions have reduced the Sterling B2B Integrator
database user permissions. To avoid this issue, ensure that the DBADM
role permissions are enabled during the initial startup. If further issues
arise, contact IBM Support for guidance.

g. Exit from the database.
h. Navigate to the parent directory of install_dir.
i. Unisntall the Sterling B2B Integrator offering to clear out the Installation

Manager metadata about the installation, and the delete (or rename as a
backup) the Sterling B2B Integrator installation directory.

j. Restart the installation wizard and provide the same installation options
that you provided before you cleared the Apply database schema
automatically check box. If you have recorded a response file (as suggested
in step 8), you can use the response file to install Sterling B2B Integrator.

The Installation Progress screen indicates which component of the installation
is currently in process.
A status bar below the Repository Information heading displays the progress
of component installation. When the installation completes, a large green circle
with a checkmark displays with the message The packages are installed. A
link is provided to view the installation log file.
The installation completes automatically. When the installation is finished, the
system displays a dialog box with the message The install completed
successfully.

Installation information is in the InstallSI.log file.
29. Click Finish. The Installation Manager closes and you are returned to your

desktop.
Check the InstallSI.log to verify all the components have installed properly.
You must perform the Configure the Sterling B2B Integrator Desktop Icon for
Windows Server 2008 procedure if you use Windows Server 2008.

30. Start Sterling B2B Integrator.
31. Navigate to \install_dir\install\bin and enter: InstallWindowsService.cmd.
32. Enter: StartWindowsService.cmd.

It might take several minutes for the Sterling B2B Integrator components to
initialize and start up.
When startup is finished, a message like the following is displayed:
Open your Web browser to http://host:port/admin/?module=platform
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Where host is the IP address and port is where Sterling B2B Integrator resides
on your system.

33. Determine whether you need to apply a fix pack or interim fix to the
installation. For information about fix pack or interim fix installation, see
“Applying a Fix Pack (V5.2.6 or later)” on page 625 and “Applying an interim
fix (V5.2.6 or later)” on page 635.

Configure the Sterling B2B Integrator Desktop Icon for Windows Server 2008:
About this task

User Access Control (UAC) is a security component in Windows Server 2008. If
you enable the UAC, it affects the installation process and the daily processing for
Sterling B2B Integrator. If you disable the UAC, which requires a reboot, the
installation process and daily processing for Sterling B2B Integrator remains the
same as in previously supported Windows version.

If you installed or upgraded Sterling B2B Integrator on a Windows Server 2008 and
you created a desktop icon for Sterling B2B Integrator, you must complete this task
in order for the desktop icon to work.

Procedure

1. Right-click on the Sterling B2B Integrator desktop icon.
2. Click Properties.
3. In the Shortcut tab, click Advanced.
4. Select the check box for Run as Administrator.
5. Click OK to apply the changes to Advanced Properties.
6. Click OK.

Validate the Upgrade

Validate the Upgrade Checklist (Windows): As part of the upgrade, you need to
run the following tests to ensure that the software upgrade was successful.
Complete the following tasks:

Number Validate Upgrade Tasks Completed

1 Start Sterling B2B Integrator.

3 Access Sterling B2B Integrator.

4 Validate the Installation.

5 Stop Sterling B2B Integrator.

Starting Sterling B2B Integrator in a Windows non-cluster environment:

After you install the software, you can start Sterling B2B Integrator.

Before you begin

If you are starting Sterling B2B Integrator after you upgrade the application from
V5.1, change the values of the following properties in the centralops.properties
file to 600. This action prevents the StartWindowsService.cmd command from
timing out before Sterling B2B Integrator starts. The centralops.properties file is
in the install_dir\install\properties directory.
v OpsServer.commandTimeout
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v PassPhrase.urlTimeout

Procedure

1. Open the \install_dir\install\bin directory.
2. Enter StartWindowsService.cmd. The final start processes run, concluding with

the following messages:
Open your Web browser to http://host:port/dashboard

where host:port is the IP address and port number on your system.
3. Record the URL address so that you can access Sterling B2B Integrator.

Accessing Sterling B2B Integrator:

You can access Sterling B2B Integrator through a web browser.

Procedure

1. Open a browser window and enter the address that is displayed at the end of
the start.

2. On the login page, enter the default user ID and password. The default login is
at an administrative level. One of your first tasks as an administrator is to
change the administrative password and to register other users with other
levels of permission.

Validating the installation with a sample business process:

You can validate the installation by testing a sample business process.

Procedure

1. From the Administration Menu, click Business Process > Manager.
2. In the Process Name field, type Validation_Sample_BPML and click Go!

3. Click execution manager.
4. Click execute.
5. Click Go! The Status: Success message is displayed on the upper left side of

the page.

Stop Sterling B2B Integrator (Windows):
About this task

To stop Sterling B2B Integrator in a Windows environment:

Procedure

1. From the Administration Menu, select Operations > System > Troubleshooter.
2. Click Stop the System and wait for shutdown to complete.

Stop Sterling B2B Integrator (Hardstop Windows):
About this task

To stop Sterling B2B Integrator in a Windows environment:

Procedure

1. Navigate to \install_dir\install\bin.
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2. Enter StopWindowsService.cmd. Your should receive a message that services
have been stopped. Services include Noapps, Opsserver, WebDav, and
Database-related service.

Post Upgrade Configuration

Post upgrade configuration checklist:

After the upgrade software finishes running, you must perform some post upgrade
procedures.

Review all of the procedures in the checklist. Some procedures might not be
required.

Task number Task Your notes

1 Upon installation, several default user accounts are
automatically created to get you started. For security
purposes, the system administrator should update all
default user account passwords immediately after
installation is completed. See “Changing default user
account passwords” on page 40.

2 “Determine If You Need to Apply a Fix Pack
(Windows)” on page 357

3 “Change the Administrative Password” on page 429

4 “Disable Services” on page 366

5 “Download of the Sterling B2B Integrator tools” on page
43

6 “Change the Network Interface Bindings (Windows)” on
page 366

7 “Enable Business Processes” on page 367

8 “Property files configuration in a Windows
environment” on page 44

9 “Add cdinterop Files” on page 367

10 “Updating the sandbox.cfg file with a new JCE file” on
page 368

11 “Review the EDI Sequence Check Queue” on page 368

12 “Configure Document File Systems” on page 369

13 “Add Third-Party Libraries” on page 368

14 “Configure Services and Adapters” on page 369

15 “Configure JDBC Adapter and Lightweight JDBC
Adapter” on page 369

16 “Configure File System Adapter and Command Line2
Adapters” on page 370

17 “Configure Odette FTP Adapter” on page 370

18 “Add Advanced File Transfer Tab” on page 373

19 “Restore Performance Tuning Configuration” on page
373

20 “Reconfigure Archive Settings” on page 373

21 “Correct Missing Manager IDs” on page 374

22 “Configure JVM Containers” on page 378
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Changing default user account passwords:

When you install Sterling B2B Integrator, several default user accounts are
automatically created to get you started. One of the first actions you must take
after installation is to update these accounts with unique passwords, because the
default ones can be known by all Sterling B2B Integrator customers.

About this task

Default user account passwords are preset at installation. For security purposes,
the system administrator should update all default user account passwords
immediately after installation is completed.

Default user accounts are listed below in the same order as they appear in the UI
under Accounts > User Accounts > List All. You can use this table to track the
user accounts you want to update.

User Account Name Update password

MBX_daemon

admin (*)

aft_user (*)

anon

as2_user

commandlineuser

dash_oper (*)

dash_part (*)

dash_prtspon (*)

dash_sponsor (*)

fg_architect

fg_operator

fg_provisioner

fg_sysadmin (*)

gmbx_user

ja_turbine

jane

jane_doe

joe_employee

joe_manager

joe_supplier

john

sd_buyer

sd_supplier

turbine

ws_buyer

ws_director
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User Account Name Update password

ws_employee

ws_finance

ws_hr

ws_manager

ws_purchaser

ws_supplier

(*) denotes a super user

To change the password for a user account, perform the following tasks.

Procedure

1. Log into Sterling B2B Integrator using ID = admin and password = password.
2. Go to Accounts > User Accounts. Under the List section click Go! All default

user account names are listed.
3. Click Edit next to the user account name you want to update the password for.
4. In the New Password and Confirm New Password fields, enter a new, secure

password for this User ID.

Note: Passwords must be at least six characters long.
5. Click Save and Finish.

What to do next

Repeat steps 3 - 5 for all user account names you want to update.

Determine If You Need to Apply a Fix Pack (Windows):

Fix Packs contain cumulative fixes for a specific version of Sterling B2B Integrator.

About this task

Fix packs are available on the IBM Fix Central web site. Because each fix pack
contains the fixes from previous fix packs, you only need to install the most recent
fix pack.

Note: During installation, the dbVerify utility compares the list of standard indexes
with those present in the database and drops the custom indexes. You should
recreate the custom indexes after the installation is complete.

Fix packs are named using the following naming convention:

si_<release number>_<build number>.jar

Before you install the fix pack, review the following items:
v Preserve your custom changes to system resources.
v The installation may use one or more property override files. These files will be

named propertyFile_patch.properties. Do not alter these files.
v Property changes made directly in *.properties or *.properties.in files may be

overwritten during the installation. Properties overridden using the
customer_overrides.properties file are not affected. IBM recommends that you
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maintain property file changes using (when possible) the
customer_overrides.properties file. For more information about this file, refer to
the property file documentation.

v If you edited any of the cdinterop files, you must back them up before applying
the fix pack. The cdinterop files do not have initialization ( *.in ) files. After
applying the fix pack, use the backup version of the files in your installation.
These files include the following files: cdinterop-proxy-records.properties;
cdinterop-spoe-auth.properties; cdinterop-spoe-policy.properties; and
cdinterop-user-records.properties.

v Information about the installation is automatically logged to
\install_dir\install\logs\InstallService.log.

v If you need to rollback a fix pack, see the Fix Pack Change Report.

Change the Administrative Password: This upgrade changes the administrative
password to the default password. After the upgrade, change the password to
minimize security risks. This is the Admin password for logging into the UI.

Disable Services:
About this task

The upgrade process enables services that might have been disabled before the
upgrade. If you want to disable these services again, you must disable them in
after the upgrade process.

Download of the Sterling B2B Integrator tools:

After you install Sterling B2B Integrator, you can install tools like the Map Editor
and the Graphical Process Modeler (GPM).

Sterling B2B Integrator includes tools that run on a desktop or personal computer.
After you install Sterling B2B Integrator, you can install the following tools:
v Map Editor and associated standards

Note: The Map Editor requires a 32-bit JDK. This JDK is not provided with the
product download or media. For more information, see System Requirements.

v Graphical Process Modeler (GPM)
v Web Template Designer
v (If licensed) MESA Developer Studio plug-ins, including MESA Developer

Studio Software Development Kit (SDK) and MESA Developer Studio Skin
Editor

v (If licensed) Reporting Services, which require MESA Developer Studio if you
want to use the plug-ins to create fact models and custom reports

Attention: Conflicting IP addresses can cause problems when you download a
desktop tool.

Change the Network Interface Bindings (Windows):
About this task

To increase the security of the Administrator Console user interface, Sterling B2B
Integrator binds only to specific network interfaces. After installing, if the URL
returns the error message Page cannot be displayed, you can adjust property
settings to correct the problem.
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To update the property settings:

Procedure

1. On the server where Sterling B2B Integrator resides, edit the
noapp.properties_platform_ifcresources_ext.in file.

2. Locate the admin_host parameter.
Where hostname1 is the name of primary network interface, the one given
highest priority by Sterling B2B Integrator.
Where localhost is the name of the network interface on the server where
Sterling B2B Integrator resides.
admin_host.1 = hostname1

admin_host.2 = localhost

3. If no interface is being displayed, edit hostname1 so that it correctly identifies
the primary network interface that accesses Sterling B2B Integrator.

4. If an additional network interface needs to access Sterling B2B Integrator, add
an additional admin_host entry. For example:
v admin_host.1 = hostname1

v admin_host.2 = localhost

v admin_host.3 = hostname2

5. Stop Sterling B2B Integrator.
6. Navigate to \install_dir\install\bin.
7. Enter setupfiles.cmd.
8. Restart Sterling B2B Integrator.

Enable Business Processes:
About this task

During the upgrade process, your customized business processes are preserved,
but they may not be the default business process. Review the business processes
and enable the customized versions.

Property files configuration in a Windows environment: Property files contain
properties that control the operation of Sterling B2B Integrator. For example, the
REINIT_DB property in the sandbox.cfg file controls whether or not a database is
initialized when you install Sterling B2B Integrator.

By modifying the values of these properties, you can customize the Sterling B2B
Integrator to suit your business and technical needs. Most property files are in the
\install_dir\install\properties directory.

After installing Sterling B2B Integrator, most property files and scripts do not need
any further configuration for basic operation. However, if you want to customize
any specific operations, for example setting a different logging level - you will
need to edit ( or in some cases, create) certain property or .xml files.

Before changing any property files, refer to the Working with Property Files
documentation for general information about how to work with Property Files.

Areas where you might need to make specific property files changes after an
installation include:
v LDAP user authentication
v Prevention of cross-site script vulnerabilities
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v Logging configuration
v Process-specific property file settings

Add cdinterop Files:
About this task

During the upgrade, the cdinteropt files were replaced. Copy the customized
version into the upgrade.

Updating the sandbox.cfg file with a new JCE file:

If you upgrade from Sterling B2B Integrator release 5.2.4.2 and you change the JDK
from Sun to IBM, you must manually update the Java Cryptography Extension
(JCE) policy file information in the sandbox.cfg file.

Procedure

1. Open the install_dir\install\properties directory.
2. Open the sandbox.cfg file.
3. Change the JCE_DIST_FILE property to the path to the JCE file that you

specified during the upgrade.
4. Save and close the sandbox.cfg file.
5. Open the install_dir\install\bin directory.
6. Enter the setupfile.cmd command to update your installation with the new

JCE_DIST_FILE property value.

Review the EDI Sequence Check Queue:
About this task

The EDI Sequence Check Queue is used for X12 and EDIFACT sequence and
duplicate checking. You can check the contents of the queue through the UI
(Trading Partner > Document Envelopes > EDI Sequence Check Queue). Any
interchanges that are in the queue will not be able to be processed after upgrade
because the EDI compliance report serialized format has changed.

The EDI Post Processor displays the following error:
The compliance report for interchange <interchange document ID> could not be
deserialized because the format has changed. The entry for this interchange
should be manually removed from the EDI Sequence Check Queue through the UI,
and the inbound deenvelope workflow should be rerun (WF ID <wfid>).

If you receive this error, you should follow the instructions in the error message to
correct the situation.

Configure Document File Systems:
About this task

If you use a File System as your document storage method, determine and record
the path to the File System.

You will need the File System path structure so that after the upgrade, you can
copy/mount the documents to the new installation directory. The directory
structure (path to the File System) must be the same in the current and in the
upgraded system.

Add Third-Party Libraries:
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About this task

If you added third-party libraries to configure adapters for the previous release,
you need to add each of the libraries again after you complete the upgrade. See the
documentation for each third party adapter you use.

Configure Services and Adapters:
About this task

You may need to reconfigure services and adapters after an upgrade. During an
upgrade, packages for services and adapters are reprocessed to update the service
configurations.

After an upgrade, the configurations of default adapters and services are re-set to
their default configurations. This includes directory paths, which are restored to
their default paths. You need to reconfigure those adapters and services, which
include, but are not limited to:
v All default FTP adapters
v All default SFTP adapters
v Connect:Enterprise UNIX Server Adapter
v OdetteFTP Adapter
v SAP Suite Adapter
v SWIFTNet Client Service
v SWIFTNet Server Adapter

If you modified the standard configuration for a service or adapter, you may need
to reconfigure or reactivate the service or adapter following an upgrade. You may
also need to reconfigure adapters that used directories or scripts in the installation
directory of your previous release.

Examples of services and adapters that commonly need to be reconfigured
following an upgrade include:
v FTP adapter
v System services such as the Alert service and the BP Fault Log adapter

The following adapters need special consideration following an upgrade:
v JDBC Adapter and Lightweight JDBC Adapter
v File System Adapter and Command Line2 Adapters
v Odette FTP Adapter

Configure JDBC Adapter and Lightweight JDBC Adapter:
About this task

Storage locations of the database pool properties that allow the JDBC adapter and
the Lightweight JDBC adapter to communicate with your external database have
been streamlined. The poolManager.properties file has been eliminated and some
of its pool properties are now included in the jdbc.properties file, along with some
new properties. You will need to manually update your existing
jdbc_customer.properties.in file to add some new database pool properties. If you
do not have a jdbc_customer.properties.in file, create one since customer.properties
are not affected by product updates.

Configure File System Adapter and Command Line2 Adapters:
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About this task

You must configure your File System and Command Line2 adapters before you
remove the previous release directory. Reconfigure any File System and Command
Line2 adapters that were configured to use directories or scripts in the installation
directory for the previous release. Ensure that you create new directories and save
scripts outside of the current installation directory and edit each configuration to
use the appropriate directories and scripts.

Consider the following:
v If you are using the Command Line2 adapter and have located the

CLA2Client.jar file anywhere other than the default location, you must replace it
with the new version. For information about the default location and how to
start the Command Line2 adapter, see the Command Line2 adapter.

v If you are upgrading to this version of Sterling B2B Integrator from a version
lower than 4.0.1 and are using the Command Line2 adapter, you must update
the version of the CLA2Client.jar file with the CLA2Client.jar located in the
/install_dir/install/client/cmdline2 UNIX directory or in the
\install_dir\install\client\cmdline2 for Windows. If you installed the
CLA2Client.jar file anywhere other than the default location, you must replace
each copy of the file with the new version. If you only installed it in the default
location, the update occurs automatically during the upgrade process.

v If you are upgrading to this version of Sterling B2B Integrator from a version
prior to 4.0 and are using the Command Line adapter, you must update the
version of the CLAClient.jar file with the CLA2Client.jar located in the
/install_dir/install/client/cmdline2 UNIX directory or in the
\install_dir\install\client\cmdline2 for Windows. If you installed the
CLAClient.jar file anywhere other than the default location, you must replace
each copy of the file with the new version. If you only installed it in the default
location, the update occurs automatically during the upgrade process.

The CLA instances are now pointing to the CLA2 Service definition. After
importing old service instances of CLA onto Sterling B2B Integrator, you need to
reconfigure the imported CLA services to re-set the Remote Name and Remote
Port service configuration parameters. For more information, refer to the
documentation for the Command Line Adapter and Command Line2 Adapter.

Configure Odette FTP Adapter:
About this task

If you use the Odette FTP Adapter and are using the Partner Profile XML file
version 2.00 used in Sterling Gentran Integration Suite 4.3, you must modify it to
match the new Partner Profile version 3.00. To modify the XML file, refer to the
following table:

Section Name of Structure or Field Action Comment

Partner Profiles <GeneralParameters>

<PartnerProfileVersion>3.00

</PartnerProfileVersion>

</GeneralParameters>

Use correct version label of the
Partner Profile.

New Version
label: 3.00

Physical Partner Description Add field and description
content

Mandatory in
OFTP Partner
database
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Section Name of Structure or Field Action Comment

Physical Partner SubMailbox Add field, if used. Optional

Physical Partner <AuthenticationCertificate

type =”...”>

<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial> Bignumber_string

</Subject>

</AuthenticationCertificate>

Add Structure, if used. OFTP 2.0:
Mandatory for
security only.
Structure may
be repeated.

Physical Partner <AuthenticationCertificate

type =”Private Key”>

<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial>Bignumber_string

</Subject>

</AuthenticationCertificate>

Add Stucture, if used. OFTP 2.0:
Mandatory for
security only.

Physical
Partner/ CAPI

DWindowSize Delete field

Physical
Partner/ IP

IPFilter Uses IPv4 or
IPv6 addresses.

Physical Partner
IP

SSL Add field, if used. OFTP 2.0:
Mandatory for
security only.

Physical Partner
IP

CipherStrength Add field, if used. OFTP 2.0:
Mandatory for
security only.

Physical Partner
IP

<SSLCertificate

type =”...”>

<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial> Bignumber_string

</Subject>

</SSLCertificate>

Add structure, if used. OFTP 2.0:
Mandatory for
security, only.
Structure may
be repeated.

Physical Partner
Contract

Description Add field and description
content.

Mandatory in
OFTP Partner
database.

Physical Partner
Contract

MultipleLoginSessions Now used.

Physical Partner
Contract

DuplicateFilePeriod Rename

DuplicateFileProcessingTestings

To DuplicateFilePeriod

Physical Partner
Contract

SessionLogLevel Add fields. Optional
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Section Name of Structure or Field Action Comment

Physical Partner
Contract

GroupNameList Add fields, if used. Optional

Physical Partner
Contract

SecureAuthentication Add fields. OFTP 2.0:
Mandatory

Physical Partner
Contract

<TimeScheduleTable>

...

<TimeScheduleTable>

Delete structure and create
schedules in the Scheduler.

Initiator
Business
Process and
Business
Process user
fields are still
used.

Physical Partner
Contract

OdetteFTPAPILevel Rename OdetteAPILevel to
OdetteFTPAPILevel

Logical Partner Description Add field and description
content.

Mandatory in
OFTP Partner
database.

Logical Partner <FileServiceCertificate

type =”...”>
<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial>string</Subject>

</FileServiceCertificate>

Add structure, if used. OFTP 2.0:
Mandatory for
security, only.
Structure may
be repeated.

Logical Partner
Contract

Description Add field and description
content.

Mandatory in
OFTP Partner
database.

Logical Partner
Contract

FileTransmissionRetries Rename FileTransmitRetries to
FileTransmissionRetries

Logical Partner
Contract

SignedEERPRequest Add field, if used.

Logical Partner
Contract

EERP/NERPSignatureCheck Add field, if used.

Logical Partner
Contract

File Signing Add field, if used.

Logical Partner
Contract

File Encryption Add field, if used.

Logical Partner
Contract

CipherSuite Add field, if used.

Logical Partner
Contract

File Compression Add field, if used.

Logical Partner
Contract

CharEncoding Add field, if used.

Logical Partner
Contract

Receive VitualFilenamePattern Add field, if used.

Logical Partner
Contract

EERPTimeout Rename WaitForEERP to
EERPTimeout

Logical Partner
Contract

FileScheduleTimeout Add field, if used.

Logical Partner
Contract

InboundBusinessProcess Add field, if used. Optional

Logical Partner
Contract

InboundBusinessProcessUser Add field, if used. Optional, if no
Inbound
business
process is
specified.
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After changing the Partner Profile for version 3.00, import the Partner Profile into
the new Odette FTP Partner Profile database. For additional information, see
Odette FTP Partner Profile.

Add Advanced File Transfer Tab:
About this task

The Advanced File Transfer tab will not be enabled by default after an upgrade. If
you have a license for Advanced File Transfer, perform the following steps to add
the Advanced File Transfer tab:

Procedure

1. Log in as Admin.
2. Click Manage Layout.
3. Click Add Pane.
4. Enter the following name: Advanced File Transfer
5. Click Apply.
6. Click the customize icon for the new Advanced File Transfer tab.
7. Click Add Portlet.
8. Select the Add box for Advanced File Transfer Management.
9. Click Apply.

10. Select Clear Borders and Title from the Decoration menu.
11. Click Save and Apply.

Restore Performance Tuning Configuration:
About this task

Before you begin this procedure, you need to add the Advanced File Transfer Tab.

To restore the performance tuning configuration:

Procedure

1. From the Administration Menu, select Operations > System > Performance >
Tuning.

2. Next to Edit Performance Configuration, click Go!

3. Click Edit settings.

Reconfigure Archive Settings:
About this task

The upgrade does not automatically reconfigure the archive configuration. You
must reconfigure the Backup Directory setting in Archive Manager after an
upgrade.

To reconfigure your Archive settings, use the following procedure:

Procedure

1. From the Administration Menu, select Operations > Archive Manager.
2. Next to Configure Archive Settings, click Go!

3. If a message displays about the UI Lock, click OK to continue.
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4. Click Next.
5. Update the Backup Directory field with the correct path information:
6. Click Save.
7. Confirm the settings and click Finish.

Correct Missing Manager IDs:
About this task

If you created a Manager ID with no corresponding User ID in your previous
version, the Manager ID may be missing after upgrading. If this occurs, create a
user in the system with a User ID that matches the missing Manager ID.

Configure JVM Containers:
About this task

After you have upgraded the system, you will need to reconfigure the JVM
containers.

Before you reconfigure the JVM containers, you need to know the container
numbers from the previous installation.

For example, if you configured the container using the command,
setupContainer.sh (or cmd) 1, then the container number is 1.

Use one of the following tasks to reconfigure your containers:
v Set Up Adapter Container - iSeries

v Set Up Adapter Container - UNIX/Linux

v Set Up Adapter Container - Windows

System Maintenance
From time to time, you may need to perform system maintenance activities. These
activities might include any or all of the following:
v Performing a checksum
v Modifying the license files

DB Checksum Tool:

A checksum is a simple redundancy check used to detect errors in data. The DB
Checksum tool generates the difference in resource checksum between the default
resource and the latest system resource from the database.

In Sterling B2B Integrator, a verification process compares the checksum between
the existing default resource and the resource that was added after applying a fix
pack or upgrading. The DB Checksum tool, a resource difference tool generates a
granular report of the changes in the system that was not permitted to be set as
defaults.

Perform a Checksum (Windows):
About this task

To run the DB Checksum tool in the Windows environment:

Procedure

1. Navigate to \install_dir\bin.
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2. Enter db_checksum_tool.cmd [-d] [-i [1 | 2 | 3 | 4 | 5]] [-r [wfd | map
| schema | sii | template]] [-o <output file>] [-g]

Where:
-d is the mode to dump the difference of resource checksum between the
default resource and latest system resource.
-i is the resource type integer (optional).
1 is WFD.
2 is MAP.
3 is SCHEMA.
4 is SII.
5 is TEMPLATE.
-r is the resource name (optional). For example, wfd, map, schema, sii, or
template.
-o is the file name to output all the messages (optional).
-g is the file name that lists all the ignored resources (optional).
-h is the help screen.
The DB Checksum tool performs the relevant checksum operation based on the
command options and generates the output message.

License modifications:

After the installation finishes, you can modify the software licenses that you
loaded with the AddLicenseSet command.

The AddLicenseSet command is in the bin directory of your UNIX or Windows
installation. After the initial installation, the license files are in the following
directories:
v UNIX - /install_dir/install/properties/licensefiles
v Windows - \install_dir\install\properties\licensefiles
v iSeries - /install_dir/properties/licensefiles

You can add licenses or review the license list from the UI. On the Administration
Menu, click System > B2B Console > Operations > System > Licenses.

AddLicenseSet Command Parameters

Use the AddLicenseSet command to modify a single license file or the entire license
file directory.

To use the AddLicenseSet command, you must do the following:
v Open the bin directory
v Include the absolute path to the license file directory or to a license file

The AddLicenseSet command has the following parameters:
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AddLicenseSet Parameter Description

-reload Use this parameter to reload the license files.

This parameter deletes all of the license files from the
database before the new files are loaded. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/
old_licenses

v Windows - \install_dir\install\logs\security\
old_licenses

v iSeries - /install_dir/logs/security/old_licenses

-upgrade Use this parameter during an upgrade only.

This parameter deletes all of the old license files from the
database and installs the new license files. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/upgrade

v Windows -\install_dir\install\logs\security\upgrade

v iSeries -/install_dir/logs/security/old_licenses

The AddLicenseSet command will check if Sterling B2B Integrator is running. If it
is running, the command will call the Ops server to refresh the license from the
database. If you have any problems with your licenses after running the
AddLicenseSet command, stop and restart Sterling B2B Integrator.

License Modification: Examples:

There are several different ways you can use the AddLicenseSet command to
modify your licenses.

UNIX Examples

From the install_dir/bin directory:

Scenario Command usage (UNIX example)

Reload a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -reload

Reload all of the license files
in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -reload

Upgrade a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -upgrade

Windows Examples

From the install_dir\bin directory:

Scenario Command usage (Windows example)

Reload a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -reload
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Scenario Command usage (Windows example)

Reload all of the license files
in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -reload

Upgrade a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -upgrade

Uninstall Sterling B2B Integrator from a Windows Non-Cluster
Environment
Before you begin

If you have installed Sterling B2B Integrator software using IIM, then perform
these steps to unregister Sterling B2B Integrator packages from the IIM registry:
v Launch IIM.
v Click Uninstall and select the required Sterling B2B Integrator package (Media,

FixPack, or Interim Fix).
v Confirm and click Uninstall.

About this task

To uninstall Sterling B2B Integrator from a Windows environment:

Procedure
1. Stop Sterling B2B Integrator and wait for shutdown to complete. Navigate to

the install_dir\install\bin directory and enter StopWindowsService.cmd If
you begin removing files before all business processes and the system is
stopped, you may be unable to remove the software successfully.

2. Back up the file system and database.
This step is optional. However, by backing up the file system and database,
you are ensured that Sterling B2B Integrator is completely recoverable.

3. Remove the installation directory by entering the following command in the
parent directory of your installation directory: rd /s /q \install_dir\install

4. If you use an Oracle, Microsoft SQL Server, or DB2 database, these remain
intact even after you remove Sterling B2B Integrator from the server. If you no
longer want to reference the data, contact your database administrator about
removing unwanted tables and recovering the database space where Sterling
B2B Integrator used to reside.

5. Manually remove the JDK:
a. Navigate into the _uninst subdirectory of your JDK installation directory
b. Enter uninstall.cmd

6. After you remove Sterling B2B Integrator from the server, you can remove
Eclipse, and any tools that were downloaded to the desktop, including the
following:
v Map Editor and associated standards

Refer to the Map Editor Guide for information about removing the Map
Editor.

v Graphical Process Modeler
Refer to the Graphical Process Modeler Guide for information about removing
the Graphical Process Modeler.
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v Web Template Designer
Refer to the Web Extensions Guide for information about removing the Web
Template Designer.

v (If licensed) MESA Developer Studio plug-ins, including:
– MESA Developer Studio Software Development Kit (SDK)
– MESA Developer Studio Skin Editor
Refer to the MESA Developer Studio guide for information about removing
MESA Developer Studio.

v (If licensed) Reporting Services, which requires MESA Developer Studio if
you want to use the plug-ins to create fact models and custom reports.
Refer to the MESA Developer Studio guide for information about removing
Reporting Services.

User Documentation
The user documentation is available from an online documentation site on the
web.

Providing the documentation in an online environment allows for frequent updates
of content that is based on user feedback and usability.

If you need a printed copy of the documentation, you can print topics of
information through your Internet browser, or you can download documents in
PDF format, after you add it to a collection on IBM Knowledge Center.

To access the documentation site from within Sterling B2B Integrator or one of its

tools, select the help 
 

icon. The system must reside on a computer that supports
Internet access and an Internet browser.

Improving your access to online documentation:

You can improve your access to online documentation by using several methods.

About this task

After you access the IBM Knowledge Center, you can perform the following tasks:
v Enter a word or phrase and search the entire library for information.
v Move through a hierarchy of contents pages to identify the topic you want to

read or print.
v Print topics by using your browser's Print function.
v Add documents to your collection and download them in PDF format.
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Troubleshooting Tips for Windows Environment

Situation Message or Symptom Explanation/Resolution

Installing You encounter errors or problems during
installation.

Explanation

The installation creates several log files that
you can use to diagnose problems like the
failure of an installation.

Resolution

Examine the log files generated during
installation:

v ant.install.log (in the install_dir directory)

v install_dir\PreInstallSI.log

Installing When you entered an absolute path during
installation, a message indicated that the
command was not found.

Explanation

You entered an incorrect path. Check the
information entered.

Resolution

Enter the correct path.

Installing IM is installed successfully, but SI Fails to
install.

Go to Start Open IM select Help and then
Export logs to a file for analysis.

Installing a desktop
tool or resource

Cannot download any of the following:

v Map Editor and associated standards

v Graphical Process Modeler

v Web Template Designer

v (If licensed) MESA Developer Studio
plug-ins, including:

– MESA Developer Studio Software
Development Kit (SDK)

– MESA Developer Studio Skin Editor

v (If licensed) Reporting Services, which
requires MESA Developer Studio if you
want to use the plug-ins to create fact
models and custom reports.

Explanation

When you install Sterling B2B Integrator,
system files are created that contain an
internal IP address. If you install Sterling
B2B Integrator behind a firewall, and your
firewall is configured to accept an external IP
address from a client computer, you may not
be able to download the desktop tools and
resources. The firewall will reject the internal
IP address from a client residing outside of
the firewall.

Resolution

Modify the system files that contain the
invalid IP address. Follow these steps:

1. Navigate to \install_dir\install\bin.

2. Stop Sterling B2B Integrator.

3. Enter the following command followed
by the external IP address:

patchJNLP.cmd external_IP_address

4. Restart Sterling B2B Integrator.

Cluster Installation or
Upgrade

When configuring TCPS the following
warning can be found in the
activemqbroker.log:

sun.security.provider.certpath.
SunCertPathBuilderException:
unable to find valid certification
path to requested target

Resolution

Add the system certificate to the trust store
using the KeyTool command.
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Situation Message or Symptom Explanation/Resolution

Cluster Installation or
Upgrade

When configuring TCPS the following
warning can be found in the
activemqbroker.log:

Do not mention any
SSL cipher in the ActiveMQconfig.
xml. oracle.net.ns.NetException:
Invalid cipher suites specified.

Resolution

Do not mention any SSL cipher in the
ActiveMQconfig.xml.

e-Invoice Upgrade:
Oracle Add Constraint
Error

When you upgrade Sterling e-Invoicing and
are using an Oracle database, if the upgrade
fails with the error message name is already
used by an existing object, this occurs
because the default behavior for the drop
constraint command changed in Oracle 10.

Explanation

The index that is used to support the
constraint is now only removed if the index
was generated by the create constraint
command. The indexes for Sterling
e-Invoicing are always generated from
constraints during an install. If you receive
this error during a Sterling e-Invoicing
upgrade, it is because of how the database
was restored, the version of Oracle you are
using, and because the Oracle imp command
exported the indexes and constraints
separately. There is no way to determine
when the imp command will not add a
create index command to the export file if it
was generated by a constraint – but if it does
add the command, the database restore
process loses the association of the constraint
and its underlying index. The database script
that runs during a Sterling e-Invoicing
upgrade executes two steps: 1. First, it drops
the unique constraint so the next step can
redefine it using additional columns.
However, the drop constraint command does
not remove the underlying index if the
association with its index was lost. 2. The
next command that redefines this constraint
requires a different index definition, but in
this scenario the name of the index the
constraint wants to use already exists, which
causes the name is already used by an
existing object error.

Resolution

If you receive this error message, the
solution for this problem is to drop the index
and rerun the Sterling e-Invoicing upgrade.
The drop index command you should use is:
drop index UNQ_EINV_CANON
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Situation Message or Symptom Explanation/Resolution

Apply a fix pack or
Upgrade

The \install_dir\install\installed_data
directory is created (if clustered, on each
node) during an upgrade or applying a fix
pack.

This directory can become very large and
take up needed space on the file system.

Explanation

The information in this directory is used
during upgrade or applying a fix pack, but is
not required afterward. The
deployment/cleanup tasks for the upgrade
or fix pack do not remove this directory.

Resolution

The directory can be manually removed to
increase the available space for the file
system:

1. Navigate to \install_dir\install

2. Enter

rd /S installed_data

3. If prompted to confirm deletion, enter Y
for yes.

UNIX/Linux Cluster Environment Upgrade (V5.2.6 or later)
You can upgrade the Sterling B2B Integrator software in a cluster (multiple node)
UNIX/Linux environment.

These instructions include pre-upgrade and post-upgrade processes.

Clustering is not supported for Sterling B2B Integrator systems that use the
MySQL database.

You should also review the following documents:
v System Requirements
v Release Notes
v What's New
v Installation and Upgrade Information

It is important to remember that upgrading involves a full installation of Sterling
B2B Integrator. You need to prepare for an upgrade the same way that you would
prepare for an installation. It is also recommended that you thoroughly test this
process in a test or development environment prior to implementing in a
production environment.

This upgrade does not overwrite your current Sterling B2B Integrator directory
structure on disk. Instead, it creates a new installation of Sterling B2B Integrator
that will point to and upgrade the database of your current installation of Sterling
B2B Integrator. This means your original instance will no longer be operational
after performing the upgrade. After the upgrade, you will be starting your Sterling
B2B Integrator instance only from the newly created directory structure.

For new installations, use the Sterling B2B Integrator UNIX/Linux Cluster
Installation Guide.
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Upgrade Overview

Assumptions for this guide:

The procedures in this guide are accurate as of the publication date and are
specific to this version of the document.

Intended audience:

This document can be used by different members of your organization.

This document is intended for use by:
v System administrators
v Installation engineers
v Database administrators.

Upgrade Scenarios (Clustered): Upgrading to Sterling B2B Integrator can follow
several paths. Keep these scenarios in mind as you plan for your upgrade:

Upgrade Scenario High-Level Upgrade Steps

You have V5.2.x installed and want to
upgrade by applying V5.2.6 as a fix pack.

The upgrade steps are as follows:

1. Ensure that your JDK version is
supported. See the system requirements.
Upgrade your JDK if needed. See
“Upgrading your JDK (Windows and
UNIX)” on page 3.

2. Ensure that your operating system and
database versions are supported.

3. See “Applying a Fix Pack (V5.2.6 or
later)” on page 625or “Applying Sterling
B2B Integrator V5.2.6 Fix Pack using a
script” on page 630
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Upgrade Scenario High-Level Upgrade Steps

You have 5.1.x installed and want to
upgrade to V5.2.6.

The upgrade steps are as follows:

1. Ensure that your JDK version is
supported. See the system requirements.
Upgrade your JDK if needed. See
upgrading your JDK.

2. Ensure that your operating system
version is supported. Upgrade your
operating system if required.

3. Ensure your database version is
supported. Upgrade you database if
required:

a. Export the configuration data.

b. Back up the database.

c. With help from a database
administrator (DBA), copy the
database to the new version.

d. Back up the newly created database.

4. Upgrade to Sterling B2B Integrator V5.2.6
using the full installation media and this
Upgrade Guide.

5. Point to your supported database
version. If the upgrade stops and leaves
the newly created database in an
incomplete state, you can re-start the
upgrade using the backup of the
database.

Upgrade Impacts
This documentation provides information on how system behavior has changed
based on upgrading your instance. You should review this information before you
begin your upgrade. Depending on which version you are upgrading to, you will
need to review one or more topics listed. The upgrade impacts listed for each
subsequent version are specific to that version. There is not a cumulative list.

Upgrade impacts for V5.2.6.2:

Upgrading to Sterling B2B Integrator V5.2.6.2 has unique impacts.

DB2 requires additional tablespace

When upgrading to V5.2.6.2 or later you must ensure that all tablespaces used by
Sterling B2B Integrator tables have a minimum page size of 8K. Otherwise
installation will fail.

Upgrade impacts for V5.2.6:

Upgrading to Sterling B2B Integrator 5.2.6 has unique impacts.

Support for SSLV3 has been removed - TLS 1.2 is the new default

Due to security concerns, Sterling B2B Integrator no longer supports the use of
SSLV3. You should be aware of the following changes as you upgrade your system
to this version:
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v Several properties have been updated to use TLS 1.2 as the default. If your mail
server cannot use TLS 1.2, you can change your SMTP and B2B Mail Client
adapters to use TLS 1.0 or 1.1 instead.

v If any of your 3rd party programs do not support the use of TLS 1.2, you can
change Sterling B2B Integrator to use TLS 1.0 or TLS 1.1.

v In all cases, requests to use "SSLV3" in Sterling B2B Integrator will use instead
TLS 1.0, TLS1.1, or TLS1.2.

v TLS 1.2 is used as the default protocol in secure communications. This change
applies to any system that is upgraded to V5.2.6.

v If your GPM, or WebSphere MQ or OFTP adapters are configured to use older,
non-supported cipher suites (non-TLS 1.2), they will continue to work. However,
if you edit them, only TLS 1.2 will be available to select.

JDK 7 is the only supported JDK version for V5.2.6

There are several impacts due to this change:
v If you are not already using JDK 7, you must upgrade your JDK before

attempting to upgrade Sterling B2B Integrator to V5.2.6. If you currently have
V5.2.4.1 or higher installed, there is a upgradeJDK script available to assist you.
See bin Directory Files for more information.

v Only ciphers that are supported by JDK 7 can be used in Sterling B2B Integrator
V5.2.6. You can update your cipher suites in security.properties.

v Previously defined ciphers in customer_overrides.properties are not changed
upon upgrade to V5.2.6.

v DefaultCipherSuite contains a list of JDK 7 ciphers in V5.2.6 that can be used
when others are not available.

Upgrade impacts for V5.2.5:

Upgrading to Sterling B2B Integrator 5.2.5 has unique impacts.

JDK 7 does not support the TLS_RSA_WITH_3DES_EDE_CBC_MD5 cipher

If you are using JDK 7 with Sterling B2B Integrator V5.2.5, and you want to use a
cipher to secure the Sterling B2B Integrator dashboard, you must set one of the
following values in the dashboardCipherSuite parameter in the
security.properties_platform_asi_ext.in property file or in customer_overrides:
v JDK (includes all strong ciphers except the one not supported by JDK 7)
v Weak

Do not use Strong or All with JDK 7 or Sterling B2B Integrator will not start.

Reconciliation of HIPAA Level 5 code lists

When you upgrade to Sterling B2B Integrator 5.2.5, customized HIPAA Level 5
code lists from the previous version are preserved in the system where they were
entered, but they are not the default code lists after the upgrade. After the
upgrade, you must manually make any customized code lists the default code lists.

For example, you customized the ICD9 or HCPCSCPT code list in the previous
version of Sterling B2B Integrator. After the upgrade to version 5.2.5, you must
replace the default ICD9 or HCPCSCPT code list with the customized ICD9 or
HCPCSCPT code list.
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Properties file change to prevent timeout during start (5.1.0.4 to 5.2.5 upgrade)

Before you start Sterling B2B Integrator after you upgrade the application from
version 5.1.0.4 to 5.2.5, you must change the values of the following properties in
the centralops.properties file to 600. This action prevents the start command
from timing out before Sterling B2B Integrator starts. The centralops.properties
file is in the properties subdirectory of the installation directory.
v OpsServer.commandTimeout

v PassPhrase.urlTimeout

jGroups upgrade in V5.2.5 prevents Sterling B2B Integrator from starting for
some customers

jGroups is upgraded with V5.2.5. Some of the properties defined in
jgroups_cluster.properties have changed. If you modified these files or added
custom changes for them to customer_overrides.properties, the upgrade changes
are not applied and Sterling B2B Integrator will not start.

This issue is fixed in V5.2.5, Interim Fix 1, where all necessary properties files are
changed for you. You can also disable this fix if desired. See APAR IT06654 for
more information.

Note: The original and modified properties are output to the noapp.log file. This
allows you to see how your properties were modified. Search the log using the
value “Initializing jgroups_cluster.property_string" to see the new and changed
values for the two affected startup properties. The
jgroups_cluster.lock.protocolStack property is also modified with this fix, but is
only written to the log when it is used, not at startup.

If you want to manually fix your installation without applying V5.2.5, Interim Fix
1, complete the following steps:
1. Delete the following options (if they exist) from customer_overrides.properties

for the jgroups.cluster property file. These occur in the
jgroups_cluster.property_sting, jgroups_cluster.distributed_property_string, and
jgroups_cluster.lock.protocolStack files:
v gc_lag
v up_thread
v down_thread
v join_retry_timeout
v max_xmit_size
v shun

2. Remove the protocol parameter VIEW_SYNC and all of its attributes.
3. In the jgroups_cluster.property_string, replace ‘start_port’ with ‘bind_port’.
4. In the jgroups_cluster.distributed_property_string and

jgroups_cluster.lock.protocolStack properties, add the following items:
v In distribution_property_string the attribute

thread_pool_rejection_policty=run should be added to the protocol ‘TCP’.
For example,
TCP(bind_port=22261;thread_pool_rejection_policy=run)

v In lock.protocolStack: the protocol and attribute CENTAL_LOCK(num_backups=2)
should be added to the end of the property. For example,
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lock.protocolStack=UDP(bind_addr=&HOST_ADDR;;bind_port=
&MULTICAST_NODE_PORT3;;mcast_addr=239.255.166.17;<other

protocol parameters here>pbcast.GMS(join_timeout=5000;print_local_

addr=true):CENTRAL_LOCK(num_backups=2)

Upgrade Impacts for V5.2.0: Before you begin an upgrade, you should review the
following information.

Features and Services Not Supported as of V5.2.0

The following features and services are no longer supported:
v Channels portlet
v Federated Systems
v Community Management (AFT Communities are still available)
v Sterling Community Management (SCM) Integration
v Archive Commandline Service
v Sync Engine Data Clean Manager Service
v Sync Engine Task Manager Service

If you need more information, please contact your IBM sales representative.

Port Allocation Changes

If you are upgrading to V5.2, and configured the CLA2 or the SWIFTNet HTTP
Server Adapter, the remote port numbers have changed. The port numbers are as
follows:

Table 3. Remote Port Numbers

Adapter
Name

Version 5.2.0 Base
Port Version 5.2.1 Base Port Version 5.2.2 Base Port Version 5.2.3 Base Port

CLA2 +51 +52 +53 +54

SWIFTNet
HTTP
Server

+52 +53 +54 +55

Note: You should check adapter configurations and the sandbox.cfg file for ports
greater than 51 which may have changed.

After upgrading to 5.2.x, you need to change any references to the old remote port
numbers. For example, if you have any business processes that use the CLA2
adapter, you will need to update the remote ports in the business process.

Database Table Sizes

While upgrading if you encounter any database table size issues, you may have to
manually adjust the database tables and restart the upgrade process. An upgrade
using the production database in a test environment can be used to help you
determine what tables need to be manually adjusted.
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Resource Tags

If you are using resource tags in your current version, you should check all of your
existing resource tags before you start the upgrade process. The resource tags you
should check are:
v Adapter Policies
v Agreements
v Sterling Connect:Direct Netmaps
v Proxy Servers
v Security Tokens
v SSH Resources
v SWIFTNet Copy Service Profiles
v SWIFTNet Service Profiles

You can check the resource tags by running the following SQL query from the SQL
Manager page (Operations > Support Tools):
SELECT * FROM TAG_RESOURCE_ASSOC WHERE TYPE=41 OR TYPE=42 OR TYPE=43 OR TYPE=44 OR
TYPE=45 OR TYPE=52 OR TYPE=53

The TAG_NAME column in the SQL results will contain the names of any resource
tags that need to be edited or deleted.

If any of the resource tags contain tagged resources using the types listed, remove
those resources from the resource tags or delete the resource tags that contain these
resource types.

Silent Installation Parameters

The following parameters are new or have an updated definition:

What has changed parameter Definition

Parameter definition
has changed

LICENSE_FILE_PATH (Required) Full path to Core_License.xml.

New parameter LICENSE_FILE_#
(where # is a number
between 1 and 99)

(Required) This is required for each license
you install. You must add an entry for each
license file to the silent install file. The
LICENSE_FILE numbering (#) does not
need to be sequential.

For example:

LICENSE_FILE_1= SI_SFG_License.xml

LICENSE_FILE_2= Fin_Serv_License.xml

LICENSE_FILE_3=
SI_SFG_FIPS_License.xml

LICENSE_FILE_4= AS2_License_.xml

LICENSE_FILE_5= EBICS_License_.xml
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Channels and Community Management Tabs (Optional)

The Dashboard PSML files are not updated during an upgrade. The PSML file
impacts any custom tabs you may have configured, such as Channels or Operator.
The Channels and Community Management tabs appear in your browser but are
no longer operational.

To remove the Channels and Community Management tabs:

Warning: The psmlRestore command gets the 5200 psml file which resets ALL of
the custom tabs from the previous release.
1. Navigate to the installation directory.
2. Navigate to the bin directory.
3. Enter this command: ./psmlRestore.sh admin

Custom BI Fact Models Need to be Upgraded

Scripts named recreateBITablePKs.cmd.in (Windows) and recreateBITablePKs.sh.in
(UNIX) are now provided which allow you to upgrade any custom BI fact models
tied to a separate BI repository.

BI fact models need to be upgraded to continue to work with the Entity
Framework, which replaced Hibernate usage in the BI framework in version 5.2.0.

Backups Are Not Generated During Install, Upgrade, or When Applying a Fix Pack or
Interim Fix: Before you begin an upgrade, review the following backup
information.

Some of the standard resources installed during install or upgrade use the import
mechanism available to customers to load the standard resources into the database.
The standard import mechanism by default creates a backup of the table
containing the resource prior to importing to provide the ability to restore to the
previous state if later it was decided that the import should not have been
performed. This table backup was also being performed by default during the
basic installation processes. And, since the import mechanism was sometimes used
multiple times during the installation processes, some of the tables were backed up
several times. Depending on the size of the table, this could add a very large
amount of time to the installation process. Since it is recommended that a backup
is completed prior to beginning any of these installation processes, the default
behavior has changed to not perform the backup by default. If you would like
backups to be performed, then SKIPIMPORTBACKUP=false should be added to the
sandbox.cfg file.

Capitalization Insensitivity for Header Value:
About this task

Before you begin an upgrade, review the following AS3 information.

For AS3, when searching for a header value in a multipart/report, you do not need
to consider whether the header value contains any capitalization. The search has
been enhanced to be capitalization insensitive.

For example, the following searches will result in a match:
v Multipart/Report
v Multipart/report
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v multipart/Report
v multipart/report

The search would not find the following as a match:
v MulTiPart/RePorT

CA Certificates Impacts: Before you upgrade, review the following information on
CA certificates.

Users may add multiple copies of the same certificates to the database. Having
multiple copies of the same certificate in the database is not, in principle, a
problem for the system except for the minor amount of wasted storage. Each copy
has a different object ID in the database and is a separate database object.

The specific changes in this release is the ability to easily populate the product
database with the set of authority root certificates distributed with the JVM.

Perimeter Server Installation:
About this task

Before you begin an upgrade, review the following Perimeter Server installation
information.

Silent install is the default installation mode. If you want to complete the Perimeter
Server installation using an interactive mode, you need to use the following
command:
java -jar ps_xxxx.jar -interactive

where ps_xxx.jar is the perimeter server jar file name for the version of Sterling
B2B Integrator you are upgrading to.

Retry Logic Added to WebSphereMQ Suite Adapter PUT Service:
About this task

Before you begin an upgrade, review the following WebSphereMQ Suite Adapter
PUT Service information.

Retry logic has been added to the WebSphereMQ Suite. To accommodate this new
functionality, you need to configure two new parameters for the PUT service:
v wsmq_send_retryCount
v wsmq_send_retrySleepInterval

To configure the new parameters:

Procedure

1. Log into Sterling B2B Integrator.
2. From the Admin Console Home, you need to start the Graphical Process

Model (GPM).
3. Log into the GPM. You will need a User ID and Password.
4. In the GPM, select View > Stencil > Services.
5. Select File > New.
6. Drag the WebSphereMQ Suite Put Message Service from the All Services

pane into the center pane.
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7. Double click the WebSphereMQ Suite Put Message Service.
8. Select the configuration from the Config dropdown.
9. Enter the number of retries in to the wsmq_send_retryCount value.

10. Enter the sleep interval in seconds in to the wsmq_send_retrySleepInterval
value.

11. Save the changes to the service configuration.
12. Exit from the GPM.

Services and Adapters - Show Advance State Button: Before you begin an upgrade,
review the following Show Advance State button information.

The Show Advanced State check box has been removed from the Services
Configuration search screen. Instead, the default has been changed to always show
the advanced state without needing to check a checkbox on the search screen to
display it.

Some Certificate Fields Are Optional:
About this task

Before you begin an upgrade, review the following certificate field information.

When generating certificate keys, the following fields may have been missing in
the release you are upgrading from, but the entries are now optional:
v alt.name.dns
v alt.name.IP

Support for Multiple AS2 Organizations: Before you begin an upgrade, review the
following AS2 schema information.

Sterling B2B Integrator now supports multiple sponsoring organizations and
multiple partners for AS2. During upgrade, the single organization will be flagged
as the default organization.

Once you have upgraded to this version, a prefix designation is used to
differentiate between an AS2 organization (AS2_ORG_) and an AS2 partner
(AS2_PART_). Each of these will require the full configuration of a trading partner
to allow for a partner to trade with multiple organizations as well as an
organization that trades with multiple partners.

The AS2_TRADEPART_INFO and AS2_EMAIL_INFO tables have been modified
and the AS2_PROFILE table is newly introduced. Updates to these tables will
occur during the SI in-place upgrade process in the following manner:
v Identify the default organization and populates the AS2_PROFILE table with

organization information. A default organization is an AS2 organization profile
named "profile_ORGANIZATION" present in the system before upgrade.

v Identify partner records and populates the AS2_PROFILE table with partner
information.

v Populate the new columns of table AS2_TRADEPART_INFO with the default
organization information.

v Populate the new PROFILE_ID column in the AS2_EMAIL_INFO table with the
profile id of the AS2 organization profile present in the system.

Web Services: Before you begin an upgrade, review the following Web Services
information.
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Many of the Web Services configuration settings that were generated from the
WebServices Provider Configuration UI have moved from the property files into
database tables. This change was made to allow a single location of these settings
in cluster environments and to ensure that these settings would not be reset during
a fix pack installation.

After you have completed your upgrade, you should run the
convertWSSoaProperties script found in the installation bin folder. This script reads
the settings from the property file and places them into the proper database tables.
You can then review the results in the WebServices Provider Configuration UI.

Upgrade Planning
Proper planning will help ensure a trouble-free upgrade.

Before you begin an upgrade you should:
v Read and become familiar with this document so that you have a clear

understanding of what the upgrade requires.
v Review upgrade scenarios to determine which scenario you want to use.
v Review and record system configuration information.
v Review and record performance and tuning information.

Upgrade Planning Checklist: To assist you with your upgrade planning, review
the following planning checklist:

# Upgrade Planning Checklist Your Notes

1 Read through this entire document so that you have a
clear understanding of what the upgrade requires.

2 Download and review the following information from
the Sterling B2B Integrator documentation library.

v System Requirements - With each release, IBM
introduces leading edge technology to improve and
enhance its software. Review the System Requirements
to confirm that your system and databases meet the
requirements for this release.

v Release Notes - Review the release notes to obtain
information about issues and resolutions which have
been identified for this release.

v What's New in this Release - Review this guide to find
out about new features and functionality provided in
this release.

v Installation and Upgrade Information - Lists the
installation and upgrade documents available for this
version of Sterling B2B Integrator.

3 CAUTION:
Before upgrading to the latest product version, contact
your sales representative to verify that it includes all
of your current functionality. Depending on the
timing, even though it's in a higher version that the
one you have installed, a particular mod release or fix
pack might not include all the functionality in your
current version or fix pack.
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# Upgrade Planning Checklist Your Notes

4 Collect information on third-party libraries used for
adapter configurations that were added to your current
release.

You will need to add each of these libraries to the
upgraded system.

5 Locate any configuration file changes for JDBC adapter
or Lightweight JDBC adapter in your current release.

You will need to copy these changes to the upgraded
system.

6 Record your performance tuning configuration.

You will need to restore these settings after the system
has been upgraded.

7 Review and note the adapters, business processes, and
other configurations in your current release.

This information will help you identify the need for
updating transport messages, third-party adapters, or
configurations to adapters, such as File System or
Command Line adapters.

8 Determine if you have edited any of the property files
(.properties or .properties.in).

The upgrade process overwrites these property files,
unless these changes were made using the
customer_overrides.properties file. Your previous
property file edits might not be applicable this version
of the software.

9 Determine if you edited any of the following cdinterop
files:

v cdinterop-proxy-records.properties

v cdinterop-spoe-auth.properties

v cdinterop-spoe-policy.properties

v cdinterop-user-records.properties

You must back them up before upgrading. The
cdinterop files do not have initialization (*.in) files. After
the upgrade, use the backup version of the files in your
upgraded installation.

10 Determine if you have LDAP (Lightweight Directory
Access Protocol) configuration information in the
security.properties file. This information will
automatically be moved to the
authentication_policy.properties file.
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# Upgrade Planning Checklist Your Notes

11 Determine whether Sterling B2B Integrator is using an
application server (JBoss™, WebLogic® or WebSphere®).

Sterling B2B Integrator does not require an application
server for installation or at runtime.

Sterling B2B Integrator supports integration with JBoss
and WebLogic during the installation. You can also
integrate with WebSphere, JBoss, or WebLogic by using
the Sterling B2B Integrator EJB Adapter. This does not
represent a WebLogic server for deploying the
Application Console.

12 If you use a File System as your document storage
method, determine and record the path to the File
System.

You will need the File System path structure so that
after the upgrade, you can copy/mount the documents
to the new installation directory. The directory structure
(path to the File System) must be the same in the
current and in the upgraded system.

13 Review the EDI Sequence Check Queue to ensure that
no interchanges are in the queue. The EDI Sequence
Check Queue is used for X12 and EDIFACT sequence
and duplicate checking.

14 Determine if you have any JVM Containers configured.

If yes, you will have to reconfigure the JVM containers
after you have upgraded the software.

Prepare Your System for the Upgrade
To help ensure a trouble-free upgrade, be sure to prepare your system before
beginning the upgrade.

Before you begin the upgrade :
v Complete all Pre-Upgrade Checklists.
v Verify that your system meets all system requirements.
v Obtain the upgrade media.
v Create a process output log (optional).
v (Microsoft SQL Server only) Configure the snapshot feature (optional).
v (DB2 only) Upgrade DB2 to version 10.1 or 10.5, if needed.

Pre-Upgrade System Checklist:

Use the Pre-Upgrade System Checklist to help ensure that your system is ready for
upgrading and reduce the chance of errors or other problems during upgrade.

Before you begin an upgrade:
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# Pre-Upgrade System Checklist Your Notes

1 Use the system requirements to verify that your system hardware
and software meet the requirements specified for this release.

Verify you have the correct:

v Patches required by Java™ for the operation system

v Version of the JDK

v JDK Patches

v Absolute path to JDK and patches

v Database must match the version listed in the requirements

If any of the above requirements are not met, the installation will
fail and print/log a report of all items that were non-compliant.

Ensure that you have the correct license file and JCE file.
Important: Do not remove the existing license file or JCE file
from your system. The files specified by the LICENSE_FILE_PATH
and JCE_DIST_FILE parameters in the sandbox.cfg file must be
present during the upgrade, or the upgrade will fail.

2 For systems with multiple IP addresses, verify that the IP address
on which Sterling B2B Integrator resides is accessible by any
client computer that is running a browser interface.

If you do not verify the IP addresses, your system may not
operate properly after installing Sterling B2B Integrator.

3 If you are using a non-English environment, confirm that you are
using the appropriate character set.

4 Verify the file system has adequate free disk space.

5 Obtain the upgrade media.

It is a best practice to check the Product Updates and Downloads
site to ensure you have the latest version of the media.

6 Backup your Sterling B2B Integrator installation directory and the
database.

If there are problems with your upgraded system, the only way
to ensure that you can roll-back to your previous version is to
back up Sterling B2B Integrator and the database.

7 Archive your data.

Archived data can only be restored from the same version of
Sterling B2B Integrator from which it was archived. If you need to
restore archived data that was archived prior to performing the
upgrade, then you must have a running instance of Sterling B2B
Integrator that matches the version from which the archive was
taken.

8 Purge any unneeded data.

9 Export any business objects that can not be upgraded. Including
business processes, service configurations, trading partners, and
maps.

The exported business object can be imported into the upgraded
system if you need them.

10 Create a process output log.
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# Pre-Upgrade System Checklist Your Notes

11 Disable the virus protection software on the server.

If the virus protection software is enabled, the upgrade will fail.

Pre-Upgrade Database Checklist (Cluster Environment): Before you begin an
installation, you need to:

#
Pre-Upgrade Database Checklist (Cluster
Environment) Your Notes

1 If required, copy your Microsoft SQL Server
Database to a supported version.

This is an optional procedure, and it is the
customer's responsibility to perform it. (IBM
Customer Support can not help with this
procedure.)

2 If required, update your Oracle database to a
supported version.

If you plan to import an Oracle database, while
upgrading to this version of Sterling B2B
Integrator, you must import the database without
the indexes.

For example, if you are using the Oracle import
(imp) tool, you should use the INDEXES=N option.
If you attempt upgrading to this version of Sterling
B2B Integrator with indexes turned on, the
upgrade will fail. If you had created any custom
indexes in Oracle database, add them after
performing the upgrade as they are not imported.

3 If you are using MySQL, a new MySQL database
will be created in this version of Sterling B2B
Integrator and information will be copied from the
MySQL database in your previous version of
Sterling B2B Integrator to the new database.

The MySQL database in your previous version of
Sterling B2B Integrator will still work. When you
copy your database, if you encounter Data
Overflow or Invalid Time Format errors while
copying the WORKFLOW_CONTEXT table, run
this query:

UPDATE WORKFLOW_CONTEXT SET ENTERQ = NULL,
EXITQ = NULL where ENTERQ IS NOT NULL OR EXITQ
IS NOT NULL

Pre-Upgrade Operating System Verification Checklist:

Before you begin the upgrade, you need to verify your operating system
configuration.
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For the Operating System Operating System Configuration Checklist Your Notes

HP-UX Operating System Verify these settings:

v Verify kernel parameters and establish the following
minimum settings by running the kctune command:

– kctune max_thread_proc 1024

– kctune maxdsiz 2147483648

– kctune maxdsiz_64bit 8589934592

– kctune maxssiz 369098752

– kctune maxssiz_64bit 536870912

v Run ulimit utility, verify, and establish the following
minimum settings:

– ulimit -d = 2097152 (in kilobytes) or higher

– ulimit -s = 360448 (in kilobytes) or higher

AIX Operating System You must specify the name of the installation directory
name. The installation process creates the directory and
beneath it, a directory called “install”.

To ensure that /install_dir/install has the necessary
permissions, AIX users must run the following
command on the parent directory of /install_dir/install
before installation:

chmod -R a-s <absolute path>/install_dir_parent

where install_dir_parent is the directory in which
/install_dir/install will be created.

For example, to specify

AIX_1/applications/test1/my_install as your
installation directory, you could run the command from
the AIX_1/applications directory (directly above the
test1 directory):

chmod -R a-s test1

or from another location on the file system:

chmod -R a-s /AIX_1/applications/test1

This ensures that when the my_install directory is
created during installation, it inherits the correct
permissions from test1.
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For the Operating System Operating System Configuration Checklist Your Notes

Solaris Operating System Set the following entries in the /etc/security/limits
file:

nofiles = 4096

set rlim_fd_max=4096 (limit is 65535) - hard limit

set rlim_fd_cur=4096 - soft limit

For nofiles, the value shown is an example. The
possible values are unlimited, so the number for nofiles
can be much larger. Revise the value as appropriate for
your business needs.

v To make the setting effective as the hard limit, reboot
the server or run the following command:

kill -1 inetd

v To make the setting effective as the soft limit, use the
parent shell configuration (for example, .profile).
Then, reboot the server.

Linux Operating System You need to disable SELinux by enter the following:

/etc/sysconfig/selinux: SELINUX=disabled

Ensure that /etc/hosts has short-names first for all
entries. For example,
127.0.0.1localhostlocalhost.localdomain

If the base locale is English, verify:

v that the LANG variable is en_US

v LANG variable is exported
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For the Operating System Operating System Configuration Checklist Your Notes

RedHat Enterprise Linux
Operating System

Make the following system changes:

v If the base locale for the system is English, edit the
/etc/sysconfig/i18n file by changing the
SUPPORTED variable from en_US.utf8 to en_US. You
can also allow multiple support using the following
format: en_US.utf8:en_US

v Save and close the /etc/sysconfig/i18n file. Edit the
/etc/security/limits.conf file by adding the
following lines:

– * hard nofile 8196

– * soft nofile 4096

– * hard memlock 3000000

– * soft memlock 3000000

– * hard nproc 16000

– * soft nproc 16000

– * hard stack 512000

– * soft stack 512000

This updates the system ulimits.

For nofile, the values shown are examples. The
possible values are unlimited, so the numbers for hard
nofile and soft nofile can be much larger. Revise
these values as appropriate for your business needs.

v Save and close the /etc/security/limits.conf file.

v Reboot the system.

IBM Installation Manager in UI mode may fail to start
on an RHEL 6.1 or higher x86_64 (64-bit) OS because
Installation Manager is a 32-bit application and is
dependent on some of the 32-bit libraries.

For information on installing the required 32-bit OS
libraries, refer to the IBM Support Website
(https://www-304.ibm.com/support/
docview.wss?uid=swg21459143)

CAUTION:
Due to a known issue with the IBM JDK on RHEL 6.1
or higher, a performance degradation might be seen in
comparison to previous RHEL releases. To avoid this
issue, disable the CFS on RHEL 6.1 or higher.

To disable CFS:

v Log in as root

v Edit /etc/sysctl.conf and add
"kernel.sched_compat_yield = 1"

v Reboot the system

For more information go to the IBM SDK and
Runtime Environment Java Technology Edition
Version 6 Information Center and search for known
limitations on linux.
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For the Operating System Operating System Configuration Checklist Your Notes

SUSE Linux Operating
System

Make the following system changes:

v If the base locale for the system is English, edit the
/etc/sysconfig/i18n file by changing the
SUPPORTED variable from en_US.utf8 to en_US. You
can also allow multiple support using the following
format: en_US.utf8:en_US

v Save and close the /etc/sysconfig/i18n file. Edit the
/etc/security/limits.conf file by adding the
following lines:

– * hard nofile 8196

– * soft nofile 4096

– * hard memlock 3000000

– * soft memlock 3000000

– * hard nproc 16000

– * soft nproc 16000

– * hard stack 512000

– * soft stack 512000

This updates the system ulimits.

For nofile, the values shown are examples. The
possible values are unlimited, so the numbers for hard
nofile and soft nofile can be much larger. Revise
these values as appropriate for your business needs.

v Save and close the /etc/security/limits.conf file.

v Reboot the system.

Verification of the system requirements:

Before you begin the installation, verify that your system meets the hardware and
software requirements that are specified for this release.

The hardware requirements that are listed in the System Requirements are the
minimum requirements. Your system requirements might exceed these
requirements if you are running other applications on the same machine as Sterling
B2B Integrator.

The installation strictly enforces the following system requirements:
v Operating system version must match requirement exactly.
v The minimum patch level for the operating system is enforced, but you can

apply higher patch levels.
v JDK version must match requirement exactly.
v The disk space is a minimum for the installation. The system must be separately

sized to handle whatever load is going to be put on the system.
v Database version must match exactly.
v JDBC driver version supports exact matches and wildcard matches.

If any of these requirements are not met, the installation fails. If the installation
fails, review the installation log for a list of non-compliant items.
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Upgrading your JDK (Windows and UNIX):

Sometimes you need to upgrade your JDK version to support a new version of
Sterling B2B Integrator.

About this task

If you have V5.2.4.1 or higher installed, you can use the upgradeJDK script to
upgrade your version of the JDK. See bin Directory Files for more information.

If you have V5.2.4.0 or lower installed, follow the steps below to upgrade your
JDK.

Procedure

1. Download the new JCE file. For example, the UnrestrictedPolicy.zip policy
file for the IBM JDK.

2. Back up the existing JDK in <Install Dir>/jdk. Change the folder name to
jdk_back)

3. Copy the new IBM JDK (1.7.0 ) folder to the installation Directory. Directory
Name should be jdk )

4. Copy all the jars present in <Install Dir >jdk_back\jre\lib\ext to <install
Dir>jdk\jre\lib\ext directory.

5. If your installation of V5.2.4 or lower was built using the Oracle (SUN) JDK,
continue to the next step. Otherwise skip to step 6.
a. Edit the sandbox.cfg property file.
b. Set JCE_DIST_FILE=<New Path of Supported JCE File>. For example,

JCE_DIST_FILE=D\:\\IBM\\unrestrictedpolicyfiles.zip.
c. Back up the local_policy.jar and US_export_policy.jar files present in

<Install Dir>jdk\jre\lib\security.
d. Unzip the new JCE file. For example, Unrestrictedpolicyfiles.zip file.

Copy local_policy.jar and US_export_policy.jar to <Install
Dir>jdk\jre\lib\security.

6. Run updateJavaSecurity.cmd <path_to_new_jdk><Install Dir>/jdk.
7. Verify that security providers have been updated in <Install

Dir>\jdk\jre\lib\security\java.security.
8. Follow the Upgrade Guide instructions for your upgrade scenario.

Obtain Upgrade Media:
About this task

Before you upgrade, ensure that you have the latest version of the upgrade media
from the Passport Advantage online site or have downloaded the fix pack from Fix
Central..

For the latest version and for online support, go to: http://www.ibm.com/
software/howtobuy/passportadvantage/pao_customers.htm

Note: For V5.2.6, the fix pack download used for upgrading from V5.2.x to V5.2.6
is very large. It includes the new functionality for Global Mailbox. You must
download the full fix pack file to upgrade to V5.2.6 by installing a fix pack even if
you do not plan to install Global Mailbox.

Create Process Output Log:
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About this task

A log of process activity during the upgrade will help if troubleshooting is
required. Output is automatically logged to the upgrade log files (PreInstallSi.log
and InstallSi.log). Use this procedure to generate a separate output log for each
process you want to log.

To create a process output log:

Procedure

1. From any directory, run the script command to record the processes, ensuring
that you have created and specified the name of the file in which to save the
process output.
For example, to start recording output to a file named processoutput.log, type
script processoutput.log at the command line. The processoutput.log file will be
created in the directory where you ran the script command.

2. After the upgrade is complete, enter exit at the command line to stop
recording.

3. You can now retrieve the file containing the process output.
The following example shows a session after starting the script command,
specifying the output to be saved to the file named listing.log, and typing exit
to stop the script command from running:
[2]%script listing.log

Script started, file is listing.log
[3]%ls
Custard.Recipe FavoriteRecipes Curry.Recipe
VindalooCurry.Recipe Jelly.Recipe
[4]%exit
Script done, file is listing.log

Configuring the snapshot feature for Microsoft SQL Server:

The snapshot feature in Microsoft SQL Server allows you to view a read-only copy
of the database even when it is locked. Configuring the snapshot feature can also
reduce deadlocks. To enable the snap shot feature, enter the following command:
ALTER DATABASE db_name SET READ_COMMITTED_SNAPSHOT ON;

Upgrading DB2 to version 10.1 or 10.5:

To upgrade from DB2 9.5 or 9.7 to 10.1 or 10.5, you must make configuration
changes.

Procedure

1. Complete the steps in the following table that pertain to your version of
Sterling B2B Integrator before you proceed to step 2.

Important: Back up all files before you change any settings.

If you are upgrading from ... Do the following steps:

Sterling B2B Integrator 5.1.x Upgrade Sterling B2B Integrator to V5.2.6
and point to your DB2 9.5 or 9.7 database

Sterling B2B Integrator 5.2.x Upgrade your 5.2.x installation to V5.2.6

2. Copy your DB2 9.5 or 9.7 database content to DB2 10.1 or 10.5.
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3. Take a backup of the database driver located at /install_dir/dbjar/jdbc/DB2/
and then replace it with the DB2 10.1 or 10.5 version.

4. Update the following sandbox.cfg file fields with your environment-specific
parameters:
DB_PASS=
DB_SCHEMA_OWNER=
DB_DRIVERS_VERSION=
YANTRA_DB_PORT=
DB_DATA=
DB_HOST=
YANTRA_DB_USER=
DB_PORT=
YANTRA_DB_PASS=
YANTRA_DB_DATA=
YANTRA_DB_HOST=
DB_DRIVERS=
DB_USER=

DB2_PORT=
DB2_USER=
DB2_PASS=
DB2_DATA=
DB2_HOST=

5. Edit the following in the activemq.xml file:
activemq.xml: <value>jdbc:db2//DB_HOST:DB_PORT/DB_DATA</value>

6. Run the setupfiles script.
7. Run the deployer script.
8. Start Sterling B2B Integrator.

Information Gathering Checklist

Information Gathering Checklist for Upgrades (UNIX/Linux Cluster): Before
you begin the upgrade, you should review the information in the Information
Gathering Checklist. The checklist contains all of the information that you will
need to have while running the upgrade scripts. Supporting information and
details are included at the end of this chapter.

The checklist contains:
v Brief descriptions for tasks (detailed procedures are provided after the checklist)
v Information you need to gather to prior the starting the upgrade

You may want to make a copy of the following checklist and use it to record the
information you collect.

The cluster environment does not support the following items:
v MySQL database
v AS2 Edition

#
Information Gathering Checklist for Cluster
Upgrades Your Notes

1 Review your IBM contract to determine what
software you have licensed.You need to know this
License Information so that you can select the correct
components/features to install.
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#
Information Gathering Checklist for Cluster
Upgrades Your Notes

2 Determine which upgrade method you are going to
use:

v IBM Installation Manager (Graphical User
Interface)

v Silent Installation

3 Determine if you are going to run the pre-upgrade
checks during the upgrade.

4 Determine if you are going to use multicast ports.

5 Decide which type of security certificates you will
use:

v The default self-signed SSL (Secure Sockets Layer)
certificate that is automatically installed.

v A Certificate Authority-related certificate that you
install before installing the software.

6 If you are using an Oracle, SQL Server, or DB2
database, decide if you are going to manually or
automatically apply Database Definition Language
(DDL) Statements (schema) to the database.

7 If you are using an Oracle 11.1 database, you must
set it up for native compilation by allocating space
and by setting the plsql_native_library_dir
parameter.

8 Record the Hostname on which you plan to install
the software.

9 Determine if you are going to use FIPS (Federal
Information Processing Standards) mode.

10 Record the Directory Name where you plan to install
the software.

11 Record the Login to host machine.

12 Record the Password to the host machine.

13 Record the path to the JDBC drivers.

14 Record the path to the installation wizard and file
name.

15 Record the path to JDK.

16 Record the path to JCE file.

17 Record the Host IP address.

18 Record the Initial Port Number.

19 Record the System passphase.

20 Record the Administrative e-mail address to which
system alert messages are sent.

21 Record the SMTP Server IP address used for sending
alert messages.

22 Record the Database vendor name.

23 Record the Database user name.

24 Record the Database password.

25 Record the Database (catalog) name.
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#
Information Gathering Checklist for Cluster
Upgrades Your Notes

26 Record the Database host name.

27 For Oracle, Microsoft SQL Server, or DB2, record the
Path and file name for the JDBC Driver.

Supporting Information:

Pre-Upgrade Check for Clusters: Pre-upgrade check reviews Oracle, SQL Server, and
DB2 database environments prior to starting the upgrade. This is an optional
installation feature which looks for are common upgrade errors. You only need to
run the pre-check for node 1.

The pre-upgrade checks ensure:
v SI_VERSION table exists
v Database character set is correct for Oracle and DB2
v Schedule start times are not later than the end times
v Passphrase entered matches the existing passphrase in the database
v Database implementation for Oracle Long Raw and BLOB
v User has permission to perform the upgrade
v Collation settings are validated for MS SQL
v OBJECT_NAME is table SCI_ENTITY is no longer than 100 characters
v Default schema you identified during upgrade matches the existing database

If any of these items are not validated, the upgrade fails. You are provided with an
error message and must correct the situations and then restart the upgrade.

License information:

A separate license is required for each Sterling B2B Integrator feature that you
purchased. During installation, you must choose the license files according to what
you purchased. Product licenses do not require an activation key.

IBM assumes customers will only install and use the products they purchased. IBM
reserves the right to inspect installs for compliance at any time.

After the installation finishes, if you determine that you need to modify licenses
files, see “License modifications” on page 58.

Product Licenses for Sterling B2B Integrator

Sterling B2B Integrator Standard and Enterprise Edition includes:
v MESA Studio
v eInvoicing
v Report Services
v all services and adapters not listed below

Sterling B2B Integrator Standard and Enterprise Financial Edition includes
everything listed above plus:
v CHIPS
v SWIFTNet
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v NACHA ACH CTX adapter
v FEDWIRE
v Fin Serv XML standard
v FIPS Mode
v Image Cash Letter service
v EBICS

Multicast ports in node to node communications:

Cluster nodes are configured to communicate with each other using JGroups, an
open source toolkit that provides flexibility for protocol configuration.

JGroups provides rich open management features, along with multiple protocol
support. JGroups supports multicast (UDP) and TCP-based communication
protocols.

When JGroups is configured to use multicast (UDP), all cluster nodes communicate
with each other on a specific IP address and port. The configuration of multicast
ports is based on the installation base port. All clusters that are on the same subnet
that is configured on the same base port send multicasting messages on the same
multicast IP address and port.

To avoid this situation, each cluster on the same subnet needs to be configured on
different base ports. Install your clusters on different port ranges or on different
network segments with multicast forwarding restricted, so that they do not
interfere with each other. The default multicast address is 239.255.166.17. This
address is configurable, with a port range of 10 ports, starting with the multicast
base port for the instance.

All nodes that are participating in the same cluster must be installed on the same
multicast base port (the multicastBasePort property in the
noapp.properties_platform_ifcresources_ext.in file). This value is usually
computed from the system base (non-multicast) port, but can be configured
separately in the noapp.properties_platform_ifcresources_ext.in file, to allow
different nodes in a cluster to be installed at different (non-multicast) port ranges.
Also, all the nodes in the cluster must be installed in the same subnet.

For node to node communications, the properties are defined in the
jgroups_cluster.properties file. The following attributes are used to define
communications:
v property_string - default value is UDP.
v distribution_property_string - default value is TCP. This attribute must never

be set to UDP.

If you want to change the communication for cluster multicast from the UDP
protocol to TCP, you need to change the value of the property_string property in
the jgroups_cluster.properties.in file (after you back up the file). Then, run the
setupfiles command. You can change this value right after the installation or after
you start running the cluster. If you change the file after you start the cluster, you
need to stop all nodes of the cluster, change the value on each node, and then
restart your cluster.
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To change the communication for cluster multicast from the UDP protocol to TCP,
use the following value for the property_string property in the
jgroups_cluster.properties.in file:
property_string=TCP(start_port=any_available_port_number):
TCPPING (initial_hosts=this_instance_host_ip[start_port_number],
theothernode_instance_host_ip[theothernode_start_port_number];port_range=2;
timeout=5000;num_initial_members=3;up_thread=true;down_thread=true):
VERIFY_SUSPECT(timeout=1500):pbcast.NAKACK(down_thread=true;up_thread=true;
gc_lag=100;retransmit_timeout=3000):pbcast.GMS(join_timeout=5000;
join_retry_timeout=2000;shun=false;print_local_addr=true;
down_thread=true;up_thread=true)

For more information about UDP, TCP, and JGroups communications, see the
Sterling B2B Integrator Clustering documentation.

Security certificates:

You can choose between different security certificates before you install Sterling
B2B Integrator.

Before you begin the installation, you must decide which of the following security
certificates to use:
v The default self-signed SSL (Secure Sockets Layer) certificate that is

automatically generated by the installation.
v A Certificate Authority-related certificate that you generate before you install the

software.

If you install with the default SSL certificate, but you later want to switch to a
CA-related certificate, you can change the certificate with the sslCert property in
the noapp.properties_platform_ifcresources_ext.in file.

UNIX accounts:

In a UNIX or Linux environment, create one UNIX administrative account on the
host server for all of the installations.

For example, if you want to create a test environment and a production
environment, create one UNIX account on the host server. For more information
about creating UNIX accounts, see your operating system documentation.

Port numbers:

During installation, you are prompted to specify the initial port number.

Use the following guidelines for port numbers:
v A range of 200 consecutive open ports (1025 - 65535) is required for this

installation.

Important: Because of RMI, on occasion, a port number outside the range can
be assigned.

v The initial port number represents the beginning port number in the range.
v Make sure that port numbers in the port range are not used by any other

applications on your system.

After your installation, refer to the /install_dir/install/properties/sandbox.cfg
file for all of the port assignments.
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Database Definition Language (DDL) statements:

When you install Sterling B2B Integrator, you can manually apply Database
Definition Language (DDL) statements to your database tables instead of requiring
the installation process to do it directly.

This feature increases database security by reducing the database permissions of
the Sterling B2B Integrator database user. The rights to database objects can be
reserved for a secure user like a customer database administrator (DBA). A
business can require that only a DBA with the proper permissions can make
database changes.

Upgrading DB2 to version 10.1 or 10.5:

To upgrade from DB2 9.5 or 9.7 to 10.1 or 10.5, you must make configuration
changes.

Procedure

1. Complete the steps in the following table that pertain to your version of
Sterling B2B Integrator before you proceed to step 2.

Important: Back up all files before you change any settings.

If you are upgrading from ... Do the following steps:

Sterling B2B Integrator 5.1.x Upgrade Sterling B2B Integrator to V5.2.6
and point to your DB2 9.5 or 9.7 database

Sterling B2B Integrator 5.2.x Upgrade your 5.2.x installation to V5.2.6

2. Copy your DB2 9.5 or 9.7 database content to DB2 10.1 or 10.5.
3. Take a backup of the database driver located at /install_dir/dbjar/jdbc/DB2/

and then replace it with the DB2 10.1 or 10.5 version.
4. Update the following sandbox.cfg file fields with your environment-specific

parameters:
DB_PASS=
DB_SCHEMA_OWNER=
DB_DRIVERS_VERSION=
YANTRA_DB_PORT=
DB_DATA=
DB_HOST=
YANTRA_DB_USER=
DB_PORT=
YANTRA_DB_PASS=
YANTRA_DB_DATA=
YANTRA_DB_HOST=
DB_DRIVERS=
DB_USER=

DB2_PORT=
DB2_USER=
DB2_PASS=
DB2_DATA=
DB2_HOST=

5. Edit the following in the activemq.xml file:
activemq.xml: <value>jdbc:db2//DB_HOST:DB_PORT/DB_DATA</value>

6. Run the setupfiles script.
7. Run the deployer script.
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8. Start Sterling B2B Integrator.

Upgrade the Software

General UNIX/Linux Cluster Upgrade Information: CAUTION: Sterling B2B
Integrator should be installed behind a company firewall for security purposes. See
the Perimeter Server and Security topics in the Sterling B2B Integration
documentation library for more information on secure deployment options.

UNIX/Linux Guidelines

The following are some general guidelines:
v If you are using FTP to copy the files, verify that your session is set to binary

mode.
v The installation directory must have adequate free disk space.
v The installation directory must not already exist because the installation process

creates it.
v If you are using AIX with the DB2 database, the directory path cannot be longer

than 108 bytes.
v The directory path to SI.jar cannot include any spaces.

Cluster Upgrade Information

The cluster environment does not support the following items:
v MySQL database (even though it appears as an option in the wizard)
v AS2 Edition

Upgrading Sterling B2B Integrator cluster nodes is similar to upgrading a Sterling
B2B Integrator single node, with the following restrictions on all nodes:
v All nodes must use the same database.
v All nodes must use the same passphrase.
v All nodes must use the same operating system.
v When installing nodes on different machines, the initial port numbers must be

the same. Installing nodes on different machines helps you take more advantage
of the reliability, availability, and scalability features of clustering, including
failover.

v When installing nodes on the same machine, you must install nodes 2 and
higher in different directories and use different initial port numbers. Each initial
port number must be at least 100 higher or lower than other initial port
numbers.

v Nodes must be installed sequentially, one at a time, starting with the first node.
v After installing all of the nodes, nodes must be started sequentially, one at a

time, starting with the first node.
v The upgrade creates subsequent ports based on the initial port number. For all

of the port assignments, see the /install_dir/install/properties/sandbox.cfg file.
v Before applying an IPv6 address, see IPv6 Capabilities section in Sterling B2B

Integrator System Requirements.
v If you are installing Sterling B2B Integrator on VMware, provide the IP address

of the virtual machine, not the IP address of the VMware host. For example, if
10.251.124.160 is the IP address of the VMware host and 10.251.124.156 is the IP
address of the Windows 2003 server it is hosting, you should use 10.251.124.156
as the correct IP address to install Sterling B2B Integrator.
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v If you are running the upgrade on an active installation of Sterling B2B
Integrator, you will need to run the soft stop command to gracefully stop traffic.
For more information on performing a soft stop, see the Soft Stop
documentation in the System Administration Guide on the Sterling B2B
Integrator 5.2 Information Center.

General IBM Installation Manager information:

IBM Installation Manager V1.8.2 is required to install Sterling B2B Integrator on all
supported platforms.

Installation Manager is a Java based multiplatform installation application and
provides a consistent approach across various platforms. It does not rely on
platform-specific installation technology or mechanism.

Installation Manager uses the local Sterling B2B Integrator offering repositories to
install or update Sterling B2B Integrator and its add-on features. It determines the
packages that must be installed and displays them including the products, fix
packs, and interim fixes. It checks that all prerequisites and interdependencies are
met before installing the selected product package and feature sets.

Important: The Uninstall option only unregisters Sterling B2B Integrator from
Installation Manager. The uninstall procedure as described in the related sections
must be performed to completely uninstall Sterling B2B Integrator.

Installation Manager must be installed on each computer on which Sterling B2B
Integrator is being installed. If you already have Installation Manager installed on
your computer for use with other IBM applications, it can be used with installing
Sterling B2B Integrator as long as it's the correct version. If you do not have
Installation Manager installed, it is provided as part of the Sterling B2B Integrator
installation media.

Supported bit-versions

A 64-bit version of IBM Installation Manager V 1.8.2 is provided with the Sterling
B2B Integrator installation package. However, you can also install with a 32-bit
version of Installation Manager.

Before you start the installation, consider the following options:
v If you are a new customer, use the version of Installation Manager that is

provided with the Sterling B2B Integrator installation package and install
Sterling B2B Integrator.

v If you have an earlier version of Installation Manager, you can update it to
V1.8.2 using the Installation Manager that is provided with the installation
package, then install Sterling B2B Integrator .

v If you are a current customer who did not use Installation Manager earlier,
install the version of Installation Manager that is provided with the installation
package, then upgrade your Sterling B2B Integrator installation.

v If you have a 32-bit Installation Manager installed, you must download the
32-bit Installation Manager V1.8.2 from Fix Central or IBM Passport Advantage,
upgrade it, then proceed with the installation of Sterling B2B Integrator. Ensure
you have the required libraries that support screen presentation of the text.
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Checking for updates

To check for Installation Manager updates, select Search for Installation Manager
updates on the File > Preferences > Updates page. When the check box is
selected, Installation Manager searches for updates when any one of the following
pages are opened from the Installation Manager start page:
v Install Packages
v Modify Packages
v Update Packages

Installation Manager also searches for updates when you click the Check for Other
Versions, Fixes, and Extensions button on the Install Packages page.

Starting Installation Manager

You should start the Installation Manager (and also install Sterling B2B Integrator)
as a non-administrator user.

How you start Installation Manager depends on whether you are using the
Installation Manager agent that is provided with Sterling B2B Integrator or if you
have an Installation Manager instance that is installed on your system. It also
depends on whether you have 32-bit or 64-bit Installation Manager.

Open a command prompt and do one of the following tasks to start the
Installation Manager in GUI mode:
v Go to the IM_<operating_system> directory and type ./userinst or userinst.exe

(Windows) for the following scenario:
– If you do not have Installation Manager installed and are using the

Installation Manager agent that is provided with the Sterling B2B Integrator
media.

– If you have a 64-bit Installation Manager installed.
– If you have Installation Manager installed on a platform that has only one

download available for Installation Manager. For example, AIX, Solaris, HP,
zLinux.

v Go to <installation directory>/Installation Manager/eclipse (for Windows
system, replace / with \) and type ./IBMIM or IBMIM.exe if you have 32-bit
Installation Manager installed on a Linux or Windows system.

For information on starting Installation Manager in command mode for silent
installation, see the Installing or updating with a response file.

For information on starting Installation Manager in command mode to record a
response file, see Recording a response file.

Additional heap memory parameters

The heap memory parameters specify the amount of memory Installation Manager
can use during the installation process. The heap memory pool sizes that are used
by Installation Manager are hardcoded defaults. If these defaults are not sufficient
for your environment, you can specify different values by adding parameters to
the Installation Managerconfig.ini file.

Important: These additional parameters are required only if you are experiencing
Out Of Memory errors during the installation process.
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The following parameters can be added:
v memoryMin=user.sb.INSTALL_<OS>_INIT_HEAP.<amount_of_memory>

v memoryMax=user.sb.INSTALL_<OS>_MAX_HEAP.<amount_of_memory>

Where <OS> is your operating system and <amount_of_memory> is the specified
amount of memory.

Operating
System Parameter Example Entry

Sun-Solaris Initial Heap Size

INSTALL_SUN_INIT_HEAP

memoryMin=user.sb.INSTALL_SUN_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_SUN_MAX_HEAP

memoryMax=user.sb.INSTALL_SUN_MAX_HEAP.3072m

Linux Initial Heap Size

INSTALL_LINUX_INIT_HEAP

memoryMin=user.sb.INSTALL_LINUX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_LINUX_MAX_HEAP

memoryMax=user.sb.INSTALL_LINUX_MAX_HEAP.3072m

AIX Initial Heap Size

INSTALL_AIX_INIT_HEAP

memoryMin=user.sb.INSTALL_AIX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_AIX_MAX_HEAP

memoryMax=user.sb.INSTALL_AIX_MAX_HEAP.3072m

HP-UX Initial Heap Size

INSTALL_HPUX_INIT_HEAP

memoryMin=user.sb.INSTALL_HPUX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_HPUX_MAX_HEAP

memoryMax=user.sb.INSTALL_HPUX_MAX_HEAP.3072m

Windows Initial Heap Size

INSTALL_WIN_INIT_HEAP

memoryMin=user.sb.INSTALL_WIN_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_WIN_MAX_HEAP

memoryMax=user.sb.INSTALL_WIN_MAX_HEAP.3072m

Guidelines for IPv6 addresses:

The use of IPv6 addresses in an installation of Sterling B2B Integrator requires
certain guidelines.

Before you use an IPv6 address during an installation, see the IPv6 Capabilities
section in System Requirements.

Consider the following IPv6 address information when you plan the installation:
v If you use an IPv6 address, use a fully qualified address that includes square

brackets around the address, and a zero (0) between colons where there are no
other numbers. For example, use [fe80:0:0:0:213:72ff:fe3c:21bf] instead of
fe80::213:72ff:fe3c:21bf.
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v If you are installing with an IPv6 address, comment out the host name mapping
to the IPv4 address and retain the mapping to the IPv6 address in the host file
in the /etc/sysconfig/networking/profiles/default/hosts directory.

v You must install with a host name, not an IPv6 address, otherwise the
Lightweight JDBC adapter and Graphical Process Modeler (GPM) do not work.

v If you are using an Oracle database, do not use an IPv6 address for the host
name.

v If you are using an IPv6 address and are going to configure Sterling B2B
Integrator as a dual stack host, after you complete the installation, you need to
add the IPv6 address (as the admin_host.3 property) to the
noapp.properties_platform_ifcresources_ext .in file.

Installing or updating with a response file (V5.2.6 or later):

You can install or update (apply fix pack or interim fix) Sterling B2B Integrator
with silent mode by using the sample response files or converting your existing
response file to the required format.

Upgrading in a UNIX/Linux cluster environment with the IBM Installation
Manager in GUI mode:

You can upgrade Sterling B2B Integrator in a UNIX/Linux cluster environment
with the IBM Installation Manager in a graphical user interface (GUI) mode. Use
the X Window System for this installation.

Before you begin

v Ensure that your system is ready for the upgrade. See “Prepare Your System for
the Upgrade” on page 332.
Attention: Failure to properly prepare your system can cause the upgrade to
fail.

v Complete the “Information Gathering Checklist for Upgrades (UNIX/Linux
Cluster)” on page 465.

v Install an X Window windowing system (for example Cygwin or Xming) for
UNIX/Linux operating systems on your PC.

v Install and configure a Telnet client (for example PuTTY) for use with X
Windows. The following parameters must be set:

– X-11 forwarding must be enabled.
– X display location must be set to localhost.

v If you are using the Standards Processing Engine (SPE) application with Sterling
B2B Integrator, you must upgrade SPE before you upgrade Sterling B2B
Integrator.

v If you are using the EBICS Banking Server application with Sterling B2B
Integrator, the data encryption for storage within the installation location is not
supported.

v Set the ulimit and language as follows:
– ulimit -n 4096
– ulimit -u 16000
– export LANG=en_US
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About this task

This upgrade changes the administrative password to the default password. After
the upgrade, change the password back to the administrative password to
minimize security risks. This is the Admin password for logging into the user
interface (/dashboard or /ws).

Important: Following is a list of changes related to installing or upgrading to
Sterling B2B Integrator V5.2.6:
v You can install and upgrade through the user interface or silent installation

mode (response files). Console mode installation and upgrade is not supported.
v Sterling B2B Integrator JAR file is included in the repository. Therefore it is not

required to manually select the JAR file when installing or upgrading.
v You must use Installation Manager V1.8.2. to install or upgrade Sterling B2B

Integrator. InstallService is disabled, and cannot be used. You can use
InstallService, only for a specific scenario related to Sterling File Gateway. For
more information, see step 14.

Procedure

1. Start the X Windows client on your PC.
Minimize the window once it opens.

2. Open a console window and log on to the UNIX/Linux host machine where
Sterling B2B Integrator will be upgraded.

3. From the installation media, copy the compressed update package to a
UNIX/Linux directory on the host where Sterling B2B Integrator will be
installed.

4. Decompress the upgrade package on the host machine.
5. Open the InstallationManager folder in the directory structure that is created

when the installation package is decompressed. Several
IM_OperatingSystem.zip files are displayed.

6. Decompress the file for your operating system.
v IM_AIX.zip (for AIX)
v IM_HPIA.zip (for HP-UX Itanium)
v IM_Linux.zip (for Linux)
v IM_LinuxPPC.zip (for Linux)
v IM_Solaris.zip (for Solaris)
v IM_Win.zip (for Solaris)
v IM_zLinux.zip (for Linux for System z)

This action creates a new IM_OperatingSystem folder.

Important: Installation Manager V1.8.2 is required to upgrade to Sterling B2B
Integrator V5.2.6. If Installation Manager was not used to install your current
Sterling B2B Integrator instance, the installation process installs the Installation
Manager when you start the upgrade to Sterling B2B Integrator V5.2.6. After
successful installation, restart the Installation Manager, and proceed with
upgrading to Sterling B2B Integrator V5.2.6.

7. Decompress the Common_Repo.zip from the installation package. The action
creates two new folders b2birepo and gmrepo. The IM_OperatingSystem,
b2birepo, and gmrepo folders must be at the same level in a directory.

476 Installing and upgrading (V5.2.6 or later):



Important: gmrepo contains the repository file required to install Global
Mailbox. For information about Global Mailbox, see Global Mailbox overview.

8. Open a command prompt and do one of the following tasks to start the
Installation Manager:
a. Go to the IM_<operating_system> directory and type ./userinst for the

following scenarios:
v If you do not have the Installation Manager installed and are using the

Installation Manager agent provided with V5.2.6.
v If you have a 64-bit Installation Manager installed.
v If you have the Installation Manager installed on a platform that has

only one download available for Installation Manager. For example, AIX,
Solaris, HP, zLinux.

b. Go to <installation directory>/Installation Manager/eclipse and type
./IBMIM, if you have 32-bit Installation Manager installed on your Linux
system.

9. On the Installation Manager home page, click Install.

Important: If IM_<operating_system> and b2birepo directories are not in the
same directory or if you already have Installation Manager installed, then you
get a message saying that there no packages to install or Installation Manager
could not connect to the repositories. You must add the Sterling B2B
Integrator repository files to the Installation Manager repository. For more
information about adding repository files, see Repository preferences.

10. On the Install Packages screen, select IBM Sterling B2B Integrator. This
action selects the versions also. Click Next.

11. Review the license agreement and select the option I accept the terms in the
license agreements to continue.
If you do not accept the agreement, the upgrade process is canceled.

12. Select a location for the Shared Resources directory and a location for the
Installation Manager to reside:
a. Specify a Shared Resources Directory.
b. (Optional if previously installed) Specify an Installation Manager

Directory.

Note: The Shared Resources directory cannot be a sub-directory of the
Installation Manager installation.

The specified Shared Resources and Installation Manager directories must
be empty.

13. Choose Create a new package group and specify the path to Sterling B2B
Integrator installation directory.

14. Select the features that must be upgraded.
The available options are:
v IBM Sterling B2B Integrator

v IBM Sterling File Gateway

Important: If your current installation includes Sterling File Gateway, then
Sterling File Gateway is also updated to V 2.2.6 when upgrading to Sterling
B2B Integrator V5.2.6. If Sterling File Gateway is not installed, then it is not
installed when upgrading to Sterling B2B Integrator V5.2.6, when you select
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the IBM Sterling File Gateway option. In this case, to install Sterling File
Gateway when upgrading, you must do one of the following tasks:
– When upgrading Sterling B2B Integrator, if you are installing Sterling

B2B Integrator to a fresh directory, and pointing to the previous database,
then you can install Sterling File Gateway V2.2.6.

– Use InstallService to install Sterling File Gateway. For information
about installing Sterling File Gateway by using InstallService, see
Installing Sterling File Gateway (V2.2.6 or later).

v FIPS Module

v AS2 Edition Module

v Financial Services Module

v EBICS Banking Server Module

v B2B Advanced Communications Integration Module

Important: When upgrading to Sterling B2B Integrator V5.2.6, select B2B
Advanced Communications Integration Module to install Sterling B2B
Integrator bridge. Sterling B2B Integrator bridge is required for
communication between Sterling B2B Integrator and B2B Advanced
Communications. If you are installing Global Mailbox and Sterling B2B
Integrator, then B2B Advanced Communications Integration Module
(Sterling B2B Integrator bridge) is installed by default, because Global Mailbox
uses the storage module of B2B Advanced Communications. However, you
must configure the adapter containers and adapters for Sterling B2B Integrator
bridge after upgrading.

Important:

Sterling B2B Integrator is selected by default. Select only the licenses and
features that were defined by your IBM contract. If you are unsure which to
select, the installation can proceed without a selection and complete
successfully. Startup and operation of the software, however, requires one of
the licenses to be selected. See “License modifications” on page 58 to apply
licenses after the installation.

Features that are not part of your current Sterling B2B Integrator installation
are disabled and you cannot select them when upgrading or applying a fix
pack. To include them in your Sterling B2B Integrator setup, you must first
upgrade to the current version, and then install them separately. If the fix
pack or upgrade JAR includes updates to features that are part of your current
Sterling B2B Integrator installation, the features are upgraded regardless of
whether you select the them or not.

Important: If you are upgrading to Sterling B2B Integrator from a previous
V5.2.x release, you must manually install the EBICS client. For more
information about installing the EBICS Client manually, see the EBICS Client
User Guide.

15. Enter the full path to your JDK directory.
16. Specify the configuration for the features to upgrade and click Next.

v FIPS Compliance Mode (Must enable FIPS Module)

v NIST 800-131a Compliance Mode

– off (default value)
– strict
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v SPE Integration Module (Requires pre-install of SPE, WTX optional)

If you select the SPE option, you are prompted for the following
information:
– SPE installation directory
– (Optional) WebSphere Transformation Extender (WTX) installation

directory
– SPE UI port
For more information, see the documentation for the integration of Sterling
B2B Integrator and SPE.

17. Enter the full path to your JCE jar file.
18. Enter your Installation panel properties information:

a. Enter the explicit IP address for the server or use the default value of
localhost.

b. Enter the Initial Port number or use the default value of 8080.
19. Enter your System Passphrase information:

a. Enter a passphrase.
b. Confirm the passphrase.

20. Enter the E-Mail Information:
a. Enter the email address to which you want system alert messages sent.
b. Enter the SMTP mail server (IP address or host name) that you want to

use for system alert messages and other administrative notices.
21. Select the database vendor you want to use:

v Oracle
v Microsoft SQL Server
v DB2
v MySQL
Clustering is not supported for Sterling B2B Integrator systems that use the
MySQL database, even though it appears as an option.

22. Select all options that apply to this upgrade:

Choices: Action

This installation is for a cluster node 2 or
higher (Not applicable for MySQL)

If you are installing node 2 or higher in the
cluster setup, select the check box and
specify the node number.
Important: In a cluster setup, if you are
upgrading to a new installation directory,
run the startCluster command after
installing the first node (node 1) from the
/install_dir/install/bin directory, on the
host where you installed the node. The
syntax is startCluster.sh nodeNumber true.
Replace nodeNumber with 1. After you run
the startCluster command for the first
node, the subsequent nodes will have
clustering automatically started by the
installer when they are installed. However, if
you are upgrading in the existing
installation directory, then it is not required
to run the startCluster command.
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Choices: Action

Apply database schema automatically?(Not
applicable for MySQL)

If yes, no action required. The default is to
automatically apply the DDL statements.

If you want to manually create the database
schema, clear the Apply database schema
automatically check box and continue with
the remaining installation steps.
Note: Once the upgrade starts, it runs for a
short time and stops without error. When
the installation stops, you must perform
additional actions as given in Step 30 of this
procedure.

23. Enter the Database Information.
v Database user name.
v Database password (and confirmation).
v Database catalog name.
v Database host name.
v Database port.
v For Oracle, Microsoft SQL Server, and MySQL - Absolute path and file

name for one JDBC driver file.
v For DB2 - Absolute paths and file names for two JDBC driver files. Use the

Type-4 JDBC driver. This type of driver converts JDBC calls into the
network protocol used directly by DB2, allowing a direct call from the
system to the DB2 server.

24. Click Add to browse to the file location for the appropriate JDBC driver.
25. Click Test next to the database driver path.

Note: The Installation Manager must successfully validate the connection to
the database before you can continue with the installation. If there is a
validation failure you can view the system log to determine more information
about the failure.

26. Determine what Other options apply to this upgrade. Select the applicable
options:
v Verbose install

v This installation is an upgrade from a prior version - Select this option.

Note: After you select the upgrade option, an additional option is
displayed.

v Would you like to run upgrade pre-check? - To run the pre-check, click
Test.

27. Specify the Performance configuration that applies to this upgrade. Select the
applicable options:
v Number of Processor Cores - Accept default value or enter appropriate

value.
v Physical Memory (MB) allocated to Sterling B2B Integrator - Accept

default value or enter appropriate value.
28. Specify if you want to generate an installation response file.
29. Review the installation package summary information. Click Install to

continue.
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Important: If you did not select the option to Apply database schema
automatically, the upgrade stops and you must perform these additional steps
to complete the installation with manual DDL statements:
a. Navigate to your install directory.
b. Locate the InstallSI.log file and open it with a file editor.
c. Search the file for these error messages:
v <SI_Install>/repository/scripts/EFrame_IndexAdds.sql must be

applied to the database.

v <SI_Install>//repository/scripts/EFrame_Sequence.sql must be
applied to the database.

v <SI_Install>//repository/scripts/EFrame_TableChanges.sql must be
applied to the database. Exiting installation..."

Important: If you do not find the above error messages in the log file, the
installation failed because of another reason and you must resolve that
error and attempt the installation again. If you did find these messages,
continue with the remaining steps.

d. Edit each .sql script and make changes appropriate for your database. This
may include changing the SQL delimiter or adding tablespace options.

e. Log in to your database as the DB schema user.
f. Execute the SQL files manually in this order:

Note: When you are executing the scripts, it is important to execute the
SQL scripts in the specified order.
v EFrame_IndexDrops.sql
v EFrame_TableChanges.sql
v EFrame_IndexAdds.sql
v EFrame_TextIndexAdds.sql
v EFrame_Sequence.sql
v EFrame_TextIndexModify.sql
v EFrame_TextIndexUpdates.sql
v EFrame_TextIndexUpgrade.sql
v EFrame_Static.sql

Important: ActiveMQ uses dynamically generated table names based on
the name of the install node. Table generation is not included in the above
scripts, but is performed automatically during the initial start of Sterling
B2B Integrator or when a new cluster node is added. Table generation may
fail if security restrictions have reduced the Sterling B2B Integrator
database user permissions. To avoid this issue, ensure that the DBADM
role permissions are enabled during the initial startup. If further issues
arise, contact IBM customer support for guidance.

g. Exit from the database.
h. Navigate to the parent directory of install_dir.
i. Unisntall the Sterling B2B Integrator offering to clear out the Installation

Manager metadata about the installation, and the delete (or rename as a
backup) the Sterling B2B Integrator installation directory.

j. Restart the installation wizard and provide the same installation options
that you provided before you cleared the Apply database schema
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automatically check box. If you have recorded a response file (as suggested
in step 9), you can use the response file to install Sterling B2B Integrator.

The Installation Progress screen indicates which component of the installation
is currently in process.
A status bar below the Repository Information heading displays the progress
of component installation. When the installation completes, a large green circle
with a checkmark displays with the message The packages are installed. A
link is provided to view the installation log file.
The installation completes automatically. When the installation is finished, the
system displays a dialog box with the message The install completed
successfully.

Installation information is in the InstallSI.log file.
30. Click Finish. The Installation Manager closes.

Check the InstallSI.log to verify all the components are installed properly.
31. If you are using the AIX operating system and are using IPv6:

v Navigate to the /install_dir/install/properties
v Add the following to the sandbox.config file: IPV4STACK=false
v Navigate to the /install_dir/install/bin
v Enter ./setupfiles.sh

32. Upgrade each subsequent node, from node 2 onwards. Navigate to your
working directory. For example, cd parent_install directory.

33. You need to start the Installation Manager for each additional node, enter
./userinst

Follow the same steps as you did for node 1 until you get to Step 22. When
prompted, select the This installation is for a cluster node 2 or higher check
box.

34. If you are upgrading multiple nodes on the same machine or used different
base ports for node 2 onward, you need to complete the following additional
steps:

Step Action Your Notes

1 Navigate to /install_dir/install/properties for
node 1.

2 Review the multicastBasePort property in the
noapp.properties_platform_ifcresources_ext file and
the mcast_port property in the
jgroups_cluster.properties file. Record the value of
the multicastBasePort and mcast_port.

3 Navigate to the /install_dir/install/properties
directory of each node (from node 2 onward).

4 Change the multicastBasePort property in the
noapp.properties_platform_ifcresources_ext.in file
to the value of the multicastBasePort property in
the noapp.properties_platform_ifcresources_ext file
in the node 1 installation.

5 Change the mcast_port property in the
jgroups_cluster.properties.in file to the value of the
mcast_port property in the
jgroups_cluster.properties file in the node 1
installation.
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Step Action Your Notes

6 Enter for each node in the cluster:

/install_dir/install/bin/setupfiles.sh

35. After the cluster configuration is complete, go to the /install_dir/install/
bin directory for each node, starting with the first node, enter: ./run.sh.
When prompted, enter the passphrase that you entered earlier. The final
startup processes run, concluding with the following messages: Open your Web
browser to http://host:port/dashboard Where host:port is the IP address and port
number where Sterling B2B Integrator resides on your system. Depending on
system load, it may take several minutes for the user interface to be ready.
Make a note of the URL address so that you can access Sterling B2B Integrator
later. The system returns you to a UNIX/Linux prompt.
To make a dynamic addition of new nodes to the cluster, install new nodes to
the cluster as described above and configure the servers for the cluster.

36. Determine whether you need to apply a fix pack or interim fix to the
installation. For information about fix pack or interim fix installation, see
“Applying a Fix Pack (V5.2.6 or later)” on page 625 and “Applying an interim
fix (V5.2.6 or later)” on page 635.

Validate the Upgrade

Validate the Cluster Upgrade Checklist: As part of the upgrade, you need to run
the following tests to ensure that the software upgrade was successful. Complete
the following tasks:

Number Validate Cluster Upgrade Task Completed

1 Configure the Nodes in the Cluster
Environment.

2 Verify the Cluster Environment Settings in
Property Files.

3 Start the Cluster Environment.

4 Access Sterling B2B Integrator.

5 Validate the Installation (Sample Business
Process).

6 Verify the Cluster is Running from the User
Interface.

7 Stop Sterling B2B Integrator in a Cluster
Environment:

v Stop a Node in a Cluster Environment
(Soft Stop)

v Stop a Node in the Cluster Configuration
(Hard Stop)

v Stop the Cluster

Configuring the nodes in the cluster:

The first time that you configure a cluster, you need to use the startCluster
command with true option (startCluster.sh nodeNumber true).
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About this task

Initial configuration is the only time that you need to use the startcluster
command. However, if you need to use the startcluster command again, use the
false option (startCluster.sh nodeNumber false). The false option prevents any
configuration changes from affecting the system, especially after the installation of
a fix pack or interim fix.

Important: You must run the startCluster command after installing the first node
(node 1) on the host where you have installed the node. After you run the
startCluster command for the first node, the subsequent nodes are automatically
clustered by the installer when they are installed.

Procedure

To configure the nodes, starting with node 1:
1. Open the /install_dir/install/bin directory.
2. Enter ./startCluster.sh nodeNumber <true or false>. Where nodeNumber is

the number of the node, the true option performs database updates and the
false option prevents database updates. For node 1, enter ./startCluster.sh 1
true, and so on.

3. If you are starting node 2 or higher, enter your passphrase. For node 1, you are
not prompted to enter your passphrase.

4. After the cluster starts, the following message is displayed:
BUILD SUCCESSFUL
Total time nn minutes nn seconds
Done with ant script
Running setup files

You can proceed to the next node after the command line appears.

What to do next

After all the nodes are configured, the following message is displayed:
Deployment to application server successful.

Verifying the cluster environment settings in the properties files:

Procedure

To verify the cluster environment is correct, check these properties file settings on
node 2:
1. Verify that the value CLUSTER=true is in the sandbox.cfg property file.
2. Verify that the value CLUSTER=true is in the centralops.properties property

file.
3. Verify that the value CLUSTER=true is in the noapp.properties property file.
4. Verify that the value cluster_env property=true is in the ui.properties

property file.

Starting Sterling B2B Integrator in a UNIX/Linux cluster environment:

After you run the upgrade software, you can start Sterling B2B Integrator.
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Before you begin

If you are starting Sterling B2B Integrator after you upgraded the application from
V5.1, change the values of the following properties in the centralops.properties
file to 600. This action prevents the run.sh command from timing out before
Sterling B2B Integrator starts. The centralops.properties file is in the
install_dir/install/properties directory.
v OpsServer.commandTimeout

v PassPhrase.urlTimeout

About this task

Perform this task for each node in the cluster, starting with node 1.

Procedure

1. Open the /install_dir/install/bin directory on a command line.
2. Enter ./run.sh.
3. Enter your passphrase.
4. After the final start processes run, the following message is displayed:

Open your Web browser to http://host:port/dashboard

The host:port variable is the IP address and port number where Sterling B2B
Integrator is installed on your system.
Depending on system load, it might take several minutes for the UI to be ready.

5. Record the URL address so that you can access Sterling B2B Integrator.

What to do next

If you need to release all the locks in a cluster and both nodes are down, use the
restart parameter for node 1. The restart parameter can be used on only node 1.
It cannot be used on any other nodes.

For example:
v For node 1, enter the following command:

./run.sh restart

v For nodes 2 and higher, enter the following command:
./run.sh

Accessing Sterling B2B Integrator:

You can access Sterling B2B Integrator through a web browser.

Procedure

1. Open a browser window and enter the address that is displayed at the end of
the start.

2. On the login page, enter the default user ID and password. The default login is
at an administrative level. One of your first tasks as an administrator is to
change the administrative password and to register other users with other
levels of permission.

Validating the installation with a sample business process:

You can validate the installation by testing a sample business process.

Installing and upgrading (V5.2.6 or later) 485



Procedure

1. From the Administration Menu, click Business Process > Manager.
2. In the Process Name field, type Validation_Sample_BPML and click Go!

3. Click execution manager.
4. Click execute.
5. Click Go! The Status: Success message is displayed on the upper left side of

the page.

Verifying from the user interface that the cluster is running:

You can use the user interface to verify that the cluster is running, including queue
information and adapter status.

Procedure

1. From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the Queue information for each node.

2. From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the JNDI Tree for each node.

3. From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the host, state, status, adapters, and memory usage
information for each node.

4. From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the adapter status for each node.

Stop a Node in a Cluster Environment (Soft Stop):
About this task

A soft stop halts the system after all the business processes finish running. In a
cluster environment, you need to perform this task on each node, starting with
node 1.

Running the soft stop command in a clustered environment suspends all of the
scheduled business processes. It is recommended to run the hard stop command
when stopping individual nodes of a cluster.

To soft stop in a UNIX or Linux environment:
v You can select Operations > System > Troubleshooter and click Soft Stop.
v You can perform the soft stop from the command line interface.

For more information about the softstop user interface and command line options,
refer to the performance management documentation.

To run a soft stop, from the command line:

Procedure

1. Navigate to /install_dir/install/bin.
2. Enter ./softstop.sh.
3. Enter your passphrase.

Stopping a node in a cluster environment with a hard stop:

A hard stop halts the system immediately, including all of the business processes
that are currently running.
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About this task

You can stop a single node Sterling B2B Integrator in an UNIX or Linux cluster
environment.

To run a hard stop on the entire cluster, you must perform this task for each node.

Procedure

1. Open the /install_dir/install/bin directory on a command line.
2. Enter ./hardstop.sh.

Stopping the cluster:

You can use the UI to stop a cluster installation.

Procedure

1. From the Administration Menu, click Operations > System >
Troubleshooting.

2. Click Stop the System.

Post Upgrade Configuration

Post upgrade configuration checklist:

After the upgrade software finishes running, you must perform some post upgrade
procedures.

Review all of the procedures in the checklist. Some procedures might not be
required.

# Task Your notes

1 Upon upgrade, all default user accounts are reset to
their default value. For security purposes, the system
administrator should update all default user account
passwords immediately after upgrade is completed. See
“Changing default user account passwords” on page 40.

2 “Determine if You need to Apply a Fix Pack in
UNIX/Linux Cluster Environment” on page 490

3 “Update Custom Configurations” on page 490

4 “Update the Database (dbupdate) with the startCluster
Command” on page 374

5 “Configure Shared File Systems as Document Storage”
on page 184

6 “Changes to Network Interface Bindings” on page 492

7 “Disable Services” on page 366

8 “Download of the Sterling B2B Integrator tools” on page
43

9 “Enable Business Processes” on page 367

10 “Property files configuration in a UNIX environment”
on page 183

11 “Add cdinterop Files” on page 367
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# Task Your notes

12 “Updating the sandbox.cfg file with a new JCE file” on
page 494

13 “Add Third-Party Libraries” on page 368

14 “Configure Services and Adapters” on page 369

15 “Configure JDBC Adapter and Lightweight JDBC
Adapter” on page 369

16 “Configure File System Adapter and Command Line2
Adapters” on page 370

17 “Configure Odette FTP Adapter” on page 370

18 “Restore Performance Tuning Configuration” on page
373

19 “Add Advanced File Transfer Tab” on page 373

20 “Reconfigure Archive Settings” on page 373

21 “Review the EDI Sequence Check Queue” on page 368

22 “Correct Missing Manager IDs” on page 374

23 “Configure Document File Systems” on page 369

24 “Manage Nodes in a Cluster” on page 45

25 “JMS Cluster Configuration for Failover” on page 41

26 “Configure ActiveMQ for a Cluster Environment” on
page 181

27 “Add host[port] From all the Nodes to the
jgroups_cluster.property.in for Each Node” on page 44

28 “Configure JVM Containers” on page 378

Changing default user account passwords:

When you install Sterling B2B Integrator, several default user accounts are
automatically created to get you started. One of the first actions you must take
after installation is to update these accounts with unique passwords, because the
default ones can be known by all Sterling B2B Integrator customers.

About this task

Default user account passwords are preset at installation. For security purposes,
the system administrator should update all default user account passwords
immediately after installation is completed.

Default user accounts are listed below in the same order as they appear in the UI
under Accounts > User Accounts > List All. You can use this table to track the
user accounts you want to update.

User Account Name Update password

MBX_daemon

admin (*)

aft_user (*)

anon

as2_user
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User Account Name Update password

commandlineuser

dash_oper (*)

dash_part (*)

dash_prtspon (*)

dash_sponsor (*)

fg_architect

fg_operator

fg_provisioner

fg_sysadmin (*)

gmbx_user

ja_turbine

jane

jane_doe

joe_employee

joe_manager

joe_supplier

john

sd_buyer

sd_supplier

turbine

ws_buyer

ws_director

ws_employee

ws_finance

ws_hr

ws_manager

ws_purchaser

ws_supplier

(*) denotes a super user

To change the password for a user account, perform the following tasks.

Procedure

1. Log into Sterling B2B Integrator using ID = admin and password = password.
2. Go to Accounts > User Accounts. Under the List section click Go! All default

user account names are listed.
3. Click Edit next to the user account name you want to update the password for.
4. In the New Password and Confirm New Password fields, enter a new, secure

password for this User ID.

Note: Passwords must be at least six characters long.
5. Click Save and Finish.
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What to do next

Repeat steps 3 - 5 for all user account names you want to update.

Determine if You need to Apply a Fix Pack in UNIX/Linux Cluster
Environment:
About this task

Fix packs contain cumulative fixes for a specific version of Sterling B2B Integrator.

Fix packs are available from IBM Fix Central.

Because each fix pack contains the fixes from previous fix packs, you only need to
install the most recent fix pack. Fix packs are named using the following naming
convention:

si_<release number>_<build number>.jar

Before you install the fix pack, review the following items:
v Preserve your custom changes to system resources.
v The fix pack installation may use one or more property override files. These files

will be named propertyFile_patch.properties. Do not alter these files.
v Property changes made directly in *.properties or *.properties.in files may be

overwritten during the fix pack installation. Properties overridden using the
customer_overrides.properties file are not affected. You should maintain
property file changes using (when possible) the customer_overrides.properties
file. For more information about this file, refer to the property file
documentation.

v If you edited any of the cdinterop files, you must back them up before applying
the fix pack. The cdinterop files do not have initialization ( *.in ) files. After
applying the fix pack, use the backup version of the files in your installation.
These files include the following files: cdinterop-proxy-records.properties;
cdinterop-spoe-auth.properties; cdinterop-spoe-policy.properties; and
cdinterop-user-records.properties.

v Information about the fix pack installation is automatically logged to
/install_dir/install/logs/InstallService.log.

v If you would need to roll back a fix pack, see the Fix Pack Changes Report.
v During fix pack installation, the dbVerify utility compares the list of standard

indexes with those present in the database and drops the custom indexes. You
should recreate the custom indexes after the fix pack installation is complete.

Update Custom Configurations:
About this task

As part of a default cluster configuration, certain values in the database for service
or adapter configurations, default document storage type, etc., are updated to get
the cluster working. The default settings include no shared or mounted file system
available with “line of sight” from all cluster nodes, etc. Certain service or adapter
configurations are forcibly deployed on node1 and default document storage type
is set up to “Database” for all business processes.

After you install the cluster and evaluate the customer configurations and
requirements, the above conditions might change and custom configurations will
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be incorporated. To keep these custom configuration changes from being
overwritten, the following cluster configuration script has an option to update the
database:

startCluster.sh nodeNumber true/false

Where:
v nodeNumber is the cluster node number
v true to perform database update
v false to prevent any database updates

The first time you configure a cluster, run startCluster.sh with the database update
option set to true to have all cluster-related configurations take effect.

startCluster.sh nodeNumber true

For cluster configurations after the first configuration, you can execute the
startCluster.sh command with the database update option turned off. This prevents
any configuration changes from affecting the system, especially after installing a fix
pack or interim fix.

startCluster.sh nodeNumber false

Update the Database (dbupdate) with the startCluster Command:
About this task

The startCluster.sh nodeNumber command on node 1 will automatically update
the database, unless you use the command startCluster.sh 1 false. The
startCluster.sh nodeNumber command on all other nodes will not update the
database.

When you configure Sterling B2B Integrator cluster for the first time, you should
run the startCluster.sh command with the database update value set to true
(startCluster.sh 1 true), or just startCluster.sh 1, since on node 1, dbupdate defaults
to true. This makes all cluster-related configurations take effect. The database
update will synchronize the scheduled jobs between the nodes by assigning them
all to node 1.

The startCluster.sh command with the database update value turned off
(startCluster.sh 1 false) prevents any configuration changes from affecting the
system, especially after you install a fix pack or interim fix.

The following services and adapters are associated with node 1 in the cluster:
v File System adapter
v Command Line 2 Adapter
v Connect::Direct Server Adapter
v Connect::Direct Requester Adapter
v Connect:Enterprise for UNIX Server Adapter
v HTTP Server adapter
v HTTP Client adapter
v FTP Client adapter
v FTP Server adapter
v SFTP Client adapter
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The following services and adapters have storage set to database:
v HTTP Server adapter
v Connect:Enterprise for UNIX Extract Service
v Connect::Direct Server Adapter

The default storage for all of the workflows is set to database.

Configure Shared File Systems as Document Storage:
About this task

To configure the shared file systems as document storage:

Procedure

1. Navigate to /install_dir/install/properties.
2. Open the jdbc.properties.in file.
3. Update the value of the document_dir attribute to point to the shared files

system directory where you store documents.
4. Save and close the file.
5. Navigate to /install_dir/install/bin.
6. Enter ./setupfiles.sh.
7. Restart Sterling B2B Integrator.

Changes to Network Interface Bindings: To increase the security of the
Administrator Console User Interface, the system only binds to specific network
interfaces. After installing, if the URL returns the error message Page cannot be
displayed, you can adjust property settings to correct the problem.

Update Property File for Network Interface Binding Changes:
About this task

On the server where the system resides, edit the
noapp.properties_platform_ifcresources_ext.in file.

Procedure

1. Locate the admin_host parameter. The default settings are: hostname1 is the
name of primary network interface, the one given highest priority by the
system. localhost is the name of the network interface on the server where the
system resides. Default entries: admin_host.1 = hostname1 and admin_host.2 =
localhost

2. Correct the parameters as necessary.
3. If no interface is being displayed, edit hostname1 so that it correctly identifies

the primary network interface that accesses the system.
4. If an additional network interface needs to access the system, add an additional

admin_host entries. For example: admin_host.3 = hostname2
5. Stop Sterling B2B Integrator.
6. Navigate to the install_dir.
7. Navigate to the bin directory.
8. Run the setupfiles.sh (UNIX) or setup.cmd (Windows).
9. Start Sterling B2B Integrator.

Update Dashboard for Network Interface Binding Changes:
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About this task

For the Dashboard user interface, the system provides unrestricted binding to
network interfaces through the perimeter server. To restrict access to the Dashboard
user interface, you can adjust property settings so that only one network interface
accesses the system.

On the server where the system resides, edit the perimeter.properties.in file.

Procedure

1. Locate the localmode.interface parameter. The default setting is unrestricted.
Unrestricted Setting (Default) localmode.interface=*

2. To restrict access to the Dashboard, enter the network interface that you want
to support. Restricted Setting localmode.interface=hostname1

3. Stop Sterling B2B Integrator.
4. Navigate to the install_dir.
5. Navigate to the bin directory.
6. Run the setupfiles.sh (UNIX) or setup.cmd (Windows).
7. Start Sterling B2B Integrator.

Disable Services:
About this task

The upgrade process enables services that might have been disabled before the
upgrade. If you want to disable these services again, you must disable them in
after the upgrade process.

Download of the Sterling B2B Integrator tools:

After you install Sterling B2B Integrator, you can install tools like the Map Editor
and the Graphical Process Modeler (GPM).

Sterling B2B Integrator includes tools that run on a desktop or personal computer.
After you install Sterling B2B Integrator, you can install the following tools:
v Map Editor and associated standards

Note: The Map Editor requires a 32-bit JDK. This JDK is not provided with the
product download or media. For more information, see System Requirements.

v Graphical Process Modeler (GPM)
v Web Template Designer
v (If licensed) MESA Developer Studio plug-ins, including MESA Developer

Studio Software Development Kit (SDK) and MESA Developer Studio Skin
Editor

v (If licensed) Reporting Services, which require MESA Developer Studio if you
want to use the plug-ins to create fact models and custom reports

Attention: Conflicting IP addresses can cause problems when you download a
desktop tool.

Enable Business Processes:
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About this task

During the upgrade process, your customized business processes are preserved,
but they may not be the default business process. Review the business processes
and enable the customized versions.

Property files configuration in a UNIX environment: Property files contain
properties that control the operation of Sterling B2B Integrator. For example, the
REINIT_DB property in the sandbox.cfg file controls whether or not a database is
initialized when you install Sterling B2B Integrator.

By modifying the values of these properties, you can customize Sterling B2B
Integrator to suit your business and technical needs. Most property files are in the:
v For UNIX, /install_dir/install/properties directory
v For Windows, \install_dir\install\properties directory

After installing Sterling B2B Integrator, most property files and scripts do not need
any further configuration for basic operation. However, if you want to customize
any specific operations, for example setting a different logging level - you will
need to edit ( or in some cases, create) certain property or .xml files.

Before changing any property files, refer to Working with Property Files
documentation for general information about how to work with Property Files.

Areas where you might need to make specific property files changes after an
installation include:
v LDAP user authentication
v Prevention of cross-site script vulnerabilities
v Logging configuration
v Process-specific property file settings

Add cdinterop Files:
About this task

During the upgrade, the cdinteropt files were replaced. Copy the customized
version into the upgrade.

Updating the sandbox.cfg file with a new JCE file:

If you upgrade from Sterling B2B Integrator release 5.2.4.2 to 5.2.5 and you change
the JDK from Sun to IBM, you must manually update the Java Cryptography
Extension (JCE) policy file information in the sandbox.cfg file.

Procedure

1. Open the install_dir/install/properties directory.
2. Open the sandbox.cfg file.
3. Change the JCE_DIST_FILE property to the path to the JCE file that you

specified during the upgrade.
4. Save and close the sandbox.cfg file.
5. Open the install_dir/install/bin directory.
6. Enter the setupfile.sh command to update your installation with the new

JCE_DIST_FILE property value.
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Add Third-Party Libraries:
About this task

If you added third-party libraries to configure adapters for the previous release,
you need to add each of the libraries again after you complete the upgrade. See the
documentation for each third party adapter you use.

Configure Services and Adapters:
About this task

You may need to reconfigure services and adapters after an upgrade. During an
upgrade, packages for services and adapters are reprocessed to update the service
configurations.

After an upgrade, the configurations of default adapters and services are re-set to
their default configurations. This includes directory paths, which are restored to
their default paths. You need to reconfigure those adapters and services, which
include, but are not limited to:
v All default FTP adapters
v All default SFTP adapters
v Connect:Enterprise UNIX Server Adapter
v OdetteFTP Adapter
v SAP Suite Adapter
v SWIFTNet Client Service
v SWIFTNet Server Adapter

If you modified the standard configuration for a service or adapter, you may need
to reconfigure or reactivate the service or adapter following an upgrade. You may
also need to reconfigure adapters that used directories or scripts in the installation
directory of your previous release.

Examples of services and adapters that commonly need to be reconfigured
following an upgrade include:
v FTP adapter
v System services such as the Alert service and the BP Fault Log adapter

The following adapters need special consideration following an upgrade:
v JDBC Adapter and Lightweight JDBC Adapter
v File System Adapter and Command Line2 Adapters
v Odette FTP Adapter

Configure JDBC Adapter and Lightweight JDBC Adapter:
About this task

Storage locations of the database pool properties that allow the JDBC adapter and
the Lightweight JDBC adapter to communicate with your external database have
been streamlined. The poolManager.properties file has been eliminated and some
of its pool properties are now included in the jdbc.properties file, along with some
new properties. You will need to manually update your existing
jdbc_customer.properties.in file to add some new database pool properties. If you
do not have a jdbc_customer.properties.in file, create one since customer.properties
are not affected by product updates.
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Configure File System Adapter and Command Line2 Adapters:
About this task

You must configure your File System and Command Line2 adapters before you
remove the previous release directory. Reconfigure any File System and Command
Line2 adapters that were configured to use directories or scripts in the installation
directory for the previous release. Ensure that you create new directories and save
scripts outside of the current installation directory and edit each configuration to
use the appropriate directories and scripts.

Consider the following:
v If you are using the Command Line2 adapter and have located the

CLA2Client.jar file anywhere other than the default location, you must replace it
with the new version. For information about the default location and how to
start the Command Line2 adapter, see the Command Line2 adapter.

v If you are upgrading to this version of Sterling B2B Integrator from a version
lower than 4.0.1 and are using the Command Line2 adapter, you must update
the version of the CLA2Client.jar file with the CLA2Client.jar located in the
/install_dir/install/client/cmdline2 UNIX directory or in the
\install_dir\install\client\cmdline2 for Windows. If you installed the
CLA2Client.jar file anywhere other than the default location, you must replace
each copy of the file with the new version. If you only installed it in the default
location, the update occurs automatically during the upgrade process.

v If you are upgrading to this version of Sterling B2B Integrator from a version
prior to 4.0 and are using the Command Line adapter, you must update the
version of the CLAClient.jar file with the CLA2Client.jar located in the
/install_dir/install/client/cmdline2 UNIX directory or in the
\install_dir\install\client\cmdline2 for Windows. If you installed the
CLAClient.jar file anywhere other than the default location, you must replace
each copy of the file with the new version. If you only installed it in the default
location, the update occurs automatically during the upgrade process.

The CLA instances are now pointing to the CLA2 Service definition. After
importing old service instances of CLA onto Sterling B2B Integrator, you need to
reconfigure the imported CLA services to re-set the Remote Name and Remote
Port service configuration parameters. For more information, refer to the
documentation for the Command Line Adapter and Command Line2 Adapter.

Configure Odette FTP Adapter:
About this task

If you use the Odette FTP Adapter and are using the Partner Profile XML file
version 2.00 used in Sterling Gentran Integration Suite 4.3, you must modify it to
match the new Partner Profile version 3.00. To modify the XML file, refer to the
following table:

Section Name of Structure or Field Action Comment

Partner Profiles <GeneralParameters>

<PartnerProfileVersion>3.00

</PartnerProfileVersion>

</GeneralParameters>

Use correct version label of the
Partner Profile.

New Version
label: 3.00
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Section Name of Structure or Field Action Comment

Physical Partner Description Add field and description
content

Mandatory in
OFTP Partner
database

Physical Partner SubMailbox Add field, if used. Optional

Physical Partner <AuthenticationCertificate

type =”...”>

<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial> Bignumber_string

</Subject>

</AuthenticationCertificate>

Add Structure, if used. OFTP 2.0:
Mandatory for
security only.
Structure may
be repeated.

Physical Partner <AuthenticationCertificate

type =”Private Key”>

<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial>Bignumber_string

</Subject>

</AuthenticationCertificate>

Add Stucture, if used. OFTP 2.0:
Mandatory for
security only.

Physical
Partner/ CAPI

DWindowSize Delete field

Physical
Partner/ IP

IPFilter Uses IPv4 or
IPv6 addresses.

Physical Partner
IP

SSL Add field, if used. OFTP 2.0:
Mandatory for
security only.

Physical Partner
IP

CipherStrength Add field, if used. OFTP 2.0:
Mandatory for
security only.

Physical Partner
IP

<SSLCertificate

type =”...”>

<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial> Bignumber_string

</Subject>

</SSLCertificate>

Add structure, if used. OFTP 2.0:
Mandatory for
security, only.
Structure may
be repeated.

Physical Partner
Contract

Description Add field and description
content.

Mandatory in
OFTP Partner
database.

Physical Partner
Contract

MultipleLoginSessions Now used.

Physical Partner
Contract

DuplicateFilePeriod Rename

DuplicateFileProcessingTestings

To DuplicateFilePeriod
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Section Name of Structure or Field Action Comment

Physical Partner
Contract

SessionLogLevel Add fields. Optional

Physical Partner
Contract

GroupNameList Add fields, if used. Optional

Physical Partner
Contract

SecureAuthentication Add fields. OFTP 2.0:
Mandatory

Physical Partner
Contract

<TimeScheduleTable>

...

<TimeScheduleTable>

Delete structure and create
schedules in the Scheduler.

Initiator
Business
Process and
Business
Process user
fields are still
used.

Physical Partner
Contract

OdetteFTPAPILevel Rename OdetteAPILevel to
OdetteFTPAPILevel

Logical Partner Description Add field and description
content.

Mandatory in
OFTP Partner
database.

Logical Partner <FileServiceCertificate

type =”...”>
<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial>string</Subject>

</FileServiceCertificate>

Add structure, if used. OFTP 2.0:
Mandatory for
security, only.
Structure may
be repeated.

Logical Partner
Contract

Description Add field and description
content.

Mandatory in
OFTP Partner
database.

Logical Partner
Contract

FileTransmissionRetries Rename FileTransmitRetries to
FileTransmissionRetries

Logical Partner
Contract

SignedEERPRequest Add field, if used.

Logical Partner
Contract

EERP/NERPSignatureCheck Add field, if used.

Logical Partner
Contract

File Signing Add field, if used.

Logical Partner
Contract

File Encryption Add field, if used.

Logical Partner
Contract

CipherSuite Add field, if used.

Logical Partner
Contract

File Compression Add field, if used.

Logical Partner
Contract

CharEncoding Add field, if used.

Logical Partner
Contract

Receive VitualFilenamePattern Add field, if used.

Logical Partner
Contract

EERPTimeout Rename WaitForEERP to
EERPTimeout

Logical Partner
Contract

FileScheduleTimeout Add field, if used.

Logical Partner
Contract

InboundBusinessProcess Add field, if used. Optional
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Section Name of Structure or Field Action Comment

Logical Partner
Contract

InboundBusinessProcessUser Add field, if used. Optional, if no
Inbound
business
process is
specified.

After changing the Partner Profile for version 3.00, import the Partner Profile into
the new Odette FTP Partner Profile database. For additional information, see
Odette FTP Partner Profile.

Restore Performance Tuning Configuration:
About this task

Before you begin this procedure, you need to add the Advanced File Transfer Tab.

To restore the performance tuning configuration:

Procedure

1. From the Administration Menu, select Operations > System > Performance >
Tuning.

2. Next to Edit Performance Configuration, click Go!

3. Click Edit settings.

Add Advanced File Transfer Tab:
About this task

The Advanced File Transfer tab will not be enabled by default after an upgrade. If
you have a license for Advanced File Transfer, perform the following steps to add
the Advanced File Transfer tab:

Procedure

1. Log in as Admin.
2. Click Manage Layout.
3. Click Add Pane.
4. Enter the following name: Advanced File Transfer
5. Click Apply.
6. Click the customize icon for the new Advanced File Transfer tab.
7. Click Add Portlet.
8. Select the Add box for Advanced File Transfer Management.
9. Click Apply.

10. Select Clear Borders and Title from the Decoration menu.
11. Click Save and Apply.

Reconfigure Archive Settings:
About this task

The upgrade does not automatically reconfigure the archive configuration. You
must reconfigure the Backup Directory setting in Archive Manager after an
upgrade.

To reconfigure your Archive settings, use the following procedure:
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Procedure

1. From the Administration Menu, select Operations > Archive Manager.
2. Next to Configure Archive Settings, click Go!

3. If a message displays about the UI Lock, click OK to continue.
4. Click Next.
5. Update the Backup Directory field with the correct path information:
6. Click Save.
7. Confirm the settings and click Finish.

Review the EDI Sequence Check Queue:
About this task

The EDI Sequence Check Queue is used for X12 and EDIFACT sequence and
duplicate checking. You can check the contents of the queue through the UI
(Trading Partner > Document Envelopes > EDI Sequence Check Queue). Any
interchanges that are in the queue will not be able to be processed after upgrade
because the EDI compliance report serialized format has changed.

The EDI Post Processor displays the following error:
The compliance report for interchange <interchange document ID> could not be
deserialized because the format has changed. The entry for this interchange
should be manually removed from the EDI Sequence Check Queue through the UI,
and the inbound deenvelope workflow should be rerun (WF ID <wfid>).

If you receive this error, you should follow the instructions in the error message to
correct the situation.

Correct Missing Manager IDs:
About this task

If you created a Manager ID with no corresponding User ID in your previous
version, the Manager ID may be missing after upgrading. If this occurs, create a
user in the system with a User ID that matches the missing Manager ID.

Configure Document File Systems:
About this task

If you use a File System as your document storage method, determine and record
the path to the File System.

You will need the File System path structure so that after the upgrade, you can
copy/mount the documents to the new installation directory. The directory
structure (path to the File System) must be the same in the current and in the
upgraded system.

Manage Nodes in a Cluster:
About this task

You can add or remove nodes in a cluster environment. The following
prerequisites should be considered before performing any modification in the
cluster environment:
v New nodes should have the same range of ports available as the current nodes.
v Sterling B2B Integrator license file should be updated to include the IP address

of the new nodes.
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v Directory structure on the new nodes should match with the directory structure
of the existing nodes.

v Perimeter servers should be updated with the new IP addresses to ensure proper
configuration.

v Any adapters, services, or business processes assigned to or scheduled to run on
the node being removed should be assigned to run on other nodes.

Add a Node to the Cluster (UNIX or Linux):

You do not need to stop the cluster environment while adding a new node.

About this task

To add a node into the cluster:

Procedure

1. Install a new Sterling B2B Integrator node to be added into the cluster during
installation. Ensure that the new node being added is not a primary node.

2. Update the jgroups_cluster.properties file and the
jgroups_cluster.properties.in file with the new node details.

3. Configure the new node by running startcluster.cmd nodeNumber from the
/<install_dir>/install/bin directory. The node number should be greater
than 1.
You should run startCluster.sh only after you install Sterling B2B Integrator.
You should not run startCluster.sh when you restart a Sterling B2B Integrator
instance.

4. Start the new node.

Remove a Node from the Cluster:
About this task

To remove a node from the cluster:

Procedure

1. Reassign or stop any adapters, services, or business processes assigned to or
scheduled to run on the node being removed.

2. Perform backup of the node being removed.
3. Edit the jgroups_cluster.properties file and the

jgroups_cluster.properties.in file in all nodes to remove the IP address of
the node being removed.

4. Restart the cluster environment.

Important: Start node 1 with the restart option to update the node
information.

JMS Cluster Configuration for Failover: To allow proper JMS execution and
failover in the Sterling B2B Integrator cluster environment, you must configure an
external ActiveMQ using the Configure ActiveMQ for a Cluster Environment task.

The following diagram illustrates how the ActiveMQ can be configured to increase
availability and failover.
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Configure ActiveMQ for a Cluster Environment:
About this task

To configure the ActiveMQ for the cluster environment:

Procedure

1. Download the ActiveMQ 5.2 from http://activemq.apache.org/activemq-520-
release.html for the appropriate OS.

2. Deploy an instance of ActiveMQ 5.2. This can be on the same machine as
Sterling B2B Integrator or on a separate machine.

3. Navigate to /install_dir/install/properties.
4. Copy the activemq.xml file to the AMQ conf directory. This file configures the

ActiveMQ to:
v Use failover clustering
v Use the SI database for storage
v Configures the AMQ port usage

By default, ActiveMQ is configured to listen at the Sterling B2B Integrator base
port + 64 and the ActiveMQ interface will be at base port + 65
(http://server:base port + 66/admin). The port can be changed by editing the
config file. The port number must be higher than 1024.

5. Navigate to /install_dir/install/properties.
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6. On each Sterling B2B Integrator application node and each Sterling B2B
Integrator container node, the queue configuration must be re-directed to utilize
the ActiveMQ cluster. In each node, add the following to the
customer_overrides.properties:
For FIFO Processing:
fifo.broker.username=
fifo.broker.password=
fifo.broker.url=failover:(tcp://amq_master_hostname:amq_master_port,
tcp://amq_slave_hostname:amq_slave_port)

For adapters running in separate JVM containers:
iwfcqueue.username=
iwfcqueue.password=
iwfcqueue.protocol_config=failover:(tcp://amq_master_hostname:amq_master_port,
tcp://amq_slave_hostname:amq_slave_port)

7. Start the ActiveMQ instances. To start ActiveMQ, it is necessary to supply the
activemq.hostname property with the hostname for the current system. For
example:
activemq -Dactivemq.hostname=ExampleHostname

See http://activemq.org for additional information about running an ActiveMQ
instance.

8. Start Sterling B2B Integrator.

Add host[port] From all the Nodes to the jgroups_cluster.property.in for Each
Node:
About this task

Complete this task for both vertical and horizontal clusters. You will need to
complete this task for each node, starting with node 1.

Before you begin, it is important to note that you should never override
mcast_addr in the jgroup_cluster.properties.

To add the host [port] to the jgroups_cluster.property.in file:

Procedure

1. Navigate to the properties file directory for the node.
2. Determine the initial_hosts port for each node:
v Navigate to the properties file directory for the node.
v Find the initial_hosts from the jgroups_cluster.property

(initial_hosts=host{port}).
v Record the value from the initial_hosts for each node.

3. Open the jgroups_cluster.property.in file.
4. Add the initial_hosts property to the file. For example, if node 1 is on host1

and node 2 is on host2. For node 1, you would add:
initial_hosts=host1[port1],host2[port2]

For node 2, you would add:
initial_hosts=host2[port2],host1[port1]

5. Save and close the file.

Configure JVM Containers:
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About this task

After you have upgraded the system, you will need to reconfigure the JVM
containers.

Before you reconfigure the JVM containers, you need to know the container
numbers from the previous installation.

For example, if you configured the container using the command,
setupContainer.sh (or cmd) 1, then the container number is 1.

Use one of the following tasks to reconfigure your containers:
v Set Up Adapter Container - iSeries

v Set Up Adapter Container - UNIX/Linux

v Set Up Adapter Container - Windows

System Maintenance
From time to time, you may need to perform system maintenance activities.

These activities might include any or all of the following:
v Performing a Checksum
v Adding or removing a license

DB Checksum tool:

A checksum is a simple redundancy check used to detect errors in data.

In Sterling B2B Integrator, a verification process compares the checksum between
the existing default resource and the resource that was added after applying a fix
pack or upgrading. The DB Checksum tool, a resource difference tool generates a
granular report of the changes in the system that was not permitted to be set as
defaults.

The DB Checksum tool generates the difference in resource checksum between the
default resource and the latest system resource from the database.

Performing a checksum:

Use a command to run the DB Checksum tool.

Procedure

To run the DB Checksum tool:
1. Open the /install_dir/install/bin directory.
2. Enter the following command:

./db_checksum_tool.sh [-d] [-i [1 | 2 | 3 | 4 | 5]]
[-r [wfd | map | schema | sii | template]] [-o <output file>] [-g]

Where:
v -d is the mode to dump the difference of resource checksum between the

default resource and latest system resource.
v -i is the resource type integer (optional).
v 1 is WFD.
v 2 is MAP.
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v 3 is SCHEMA.
v 4 is SII.
v 5 is TEMPLATE.
v -r is the resource name (optional). For example, wfd, map, schema, sii, or

template.
v -o is the file name to output all the messages (optional).
v -g is the file name that lists all the ignored resources (optional).
v -h is the help screen.

The DB Checksum tool performs the relevant checksum operation that is based
on the command options and generates the output message.

License modifications:

After the installation finishes, you can modify the software licenses that you
loaded with the AddLicenseSet command.

The AddLicenseSet command is in the bin directory of your UNIX or Windows
installation. After the initial installation, the license files are in the following
directories:
v UNIX - /install_dir/install/properties/licensefiles
v Windows - \install_dir\install\properties\licensefiles
v iSeries - /install_dir/properties/licensefiles

You can add licenses or review the license list from the UI. On the Administration
Menu, click System > B2B Console > Operations > System > Licenses.

AddLicenseSet Command Parameters

Use the AddLicenseSet command to modify a single license file or the entire license
file directory.

To use the AddLicenseSet command, you must do the following:
v Open the bin directory
v Include the absolute path to the license file directory or to a license file

The AddLicenseSet command has the following parameters:

AddLicenseSet Parameter Description

-reload Use this parameter to reload the license files.

This parameter deletes all of the license files from the
database before the new files are loaded. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/
old_licenses

v Windows - \install_dir\install\logs\security\
old_licenses

v iSeries - /install_dir/logs/security/old_licenses
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AddLicenseSet Parameter Description

-upgrade Use this parameter during an upgrade only.

This parameter deletes all of the old license files from the
database and installs the new license files. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/upgrade

v Windows -\install_dir\install\logs\security\upgrade

v iSeries -/install_dir/logs/security/old_licenses

The AddLicenseSet command will check if Sterling B2B Integrator is running. If it
is running, the command will call the Ops server to refresh the license from the
database. If you have any problems with your licenses after running the
AddLicenseSet command, stop and restart Sterling B2B Integrator.

License Modification: Examples:

There are several different ways you can use the AddLicenseSet command to
modify your licenses.

UNIX Examples

From the install_dir/bin directory:

Scenario Command usage (UNIX example)

Reload a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -reload

Reload all of the license files
in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -reload

Upgrade a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -upgrade

Windows Examples

From the install_dir\bin directory:

Scenario Command usage (Windows example)

Reload a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -reload

Reload all of the license files
in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -reload

Upgrade a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -upgrade

User Documentation
The user documentation is available from an online documentation site on the
web.
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Providing the documentation in an online environment allows for frequent updates
of content that is based on user feedback and usability.

If you need a printed copy of the documentation, you can print topics of
information through your Internet browser, or you can download documents in
PDF format, after you add it to a collection on IBM Knowledge Center.

To access the documentation site from within Sterling B2B Integrator or one of its

tools, select the help 
 

icon. The system must reside on a computer that supports
Internet access and an Internet browser.

Improving your access to online documentation:

You can improve your access to online documentation by using several methods.

About this task

After you access the IBM Knowledge Center, you can perform the following tasks:
v Enter a word or phrase and search the entire library for information.
v Move through a hierarchy of contents pages to identify the topic you want to

read or print.
v Print topics by using your browser's Print function.
v Add documents to your collection and download them in PDF format.

Uninstall Sterling B2B Integrator from a UNIX/Linux Cluster
Environment
Before you begin

If you have installed Sterling B2B Integrator software using IIM, then perform
these steps to unregister Sterling B2B Integrator packages from the IIM registry:
v Launch IIM.
v Click Uninstall and select the required Sterling B2B Integrator package (Media,

FixPack, or Interim Fix).
v Confirm and click Uninstall.

About this task

To uninstall Sterling B2B Integrator from a UNIX/Linux cluster environment,
perform the following procedure on each node, starting with node 1:

Procedure
1. Stop Sterling B2B Integrator and wait for shutdown to complete. If you begin

removing files before all business processes and Sterling B2B Integrator are
stopped, you may be unable to remove Sterling B2B Integrator successfully.
To stop Sterling B2B Integrator, navigate to /install_dir/install/bin and run the
following command:
./hardstop.sh

2. Back up the file system and database.
This step is optional. However, by backing up the file system and database,
you are ensured that Sterling B2B Integrator is completely recoverable.

3. Remove the installation directory by entering the following command in the
parent directory of your installation directory: rm -rf install_dir
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4. If you use an Oracle, Microsoft SQL Server, or DB2 database, these remain
intact even after you remove Sterling B2B Integrator from the server. If you no
longer want to reference the data, contact your database administrator about
removing unwanted tables and recovering the database space where Sterling
B2B Integrator used to reside.

5. (Optional) To remove the JDK, review and perform the uninstall procedure for
the JDK you are using.

6. After you remove Sterling B2B Integrator from the server, you can remove
Eclipse, and any tools that were downloaded to the desktop, including the
following:
v Map Editor and associated standards

Refer to the Map Editor Guide for information about removing the Map
Editor.

v Graphical Process Modeler
Refer to the Graphical Process Modeler Guide for information about removing
the Graphical Process Modeler.

v Web Template Designer
Refer to the Web Extensions Guide for information about removing the Web
Template Designer.

v (If licensed) MESA Developer Studio plug-ins, including:
– MESA Developer Studio Software Development Kit (SDK)
– MESA Developer Studio Skin Editor
Refer to the MESA Developer Studio guide for information about removing
MESA Developer Studio.

v (If licensed) Reporting Services, which requires MESA Developer Studio if
you want to use the plug-ins to create fact models and custom reports.
Refer to the MESA Developer Studio guide for information about removing
Reporting Services.

Troubleshooting Tips for Cluster Environment

Situation Message or Symptom Explanation/Resolution

Installing You encounter errors or problems
during installation.

Explanation

The installation creates several log files that you
can use to diagnose problems like the failure of
an installation.

Resolution

Examine the log files generated during
installation:

v ant.install.log (in the parent_install directory)

v /install_dir/PreInstallSI.log

v /install_dir/InstallSI.log

Installing When you entered an absolute path
during installation, a message
indicated that the command was not
found.

Explanation

You entered an incorrect path. Check the
information entered.

Resolution

Enter the correct path.
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Situation Message or Symptom Explanation/Resolution

Installing a desktop tool
or resource

Cannot download any of the
following:

v Map Editor and associated
standards

v Graphical Process Modeler

v Web Template Designer

v (If licensed) MESA Developer
Studio plug-ins, including:

– MESA Developer Studio
Software Development Kit
(SDK)

– MESA Developer Studio Skin
Editor

v (If licensed) Reporting Services,
which requires MESA Developer
Studio if you want to use the
plug-ins to create fact models and
custom reports.

Explanation

When you install Sterling B2B Integrator, system
files are created that contain an internal IP
address. If you install Sterling B2B Integrator
behind a firewall, and your firewall is configured
to accept an external IP address from a client
computer, you may not be able to download the
desktop tools and resources. The firewall will
reject the internal IP address from a client residing
outside of the firewall.

Resolution

Modify the system files that contain the invalid IP
address. Follow these steps:

1. Navigate to /install_dir/install/bin.

2. Stop Sterling B2B Integrator.

3. Enter the following command followed by the
external IP address:

./patchJNLP.sh external_IP_address

4. Restart Sterling B2B Integrator.

Installing Memory and ulimit errors. Explanation

The installation fails with memory and ulimit
errors.

Resolution

v Refer to the Viewing and Editing Performance
Configuration Settings in the Performance
Management documentation. Modify your
memory setting accordingly.

v Refer to the Operating System Configuration
Checklist and tune the ulimit settings.

Accessing the URL Attempts to access the URL for
Sterling B2B Integrator display the
message: Page cannot be displayed

Resolution

See the information on Changes to Network Interface
Bindings to update either the property file or the
dashboard.
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Situation Message or Symptom Explanation/Resolution

Node status on a
dual-stack machine

Displays Node went down status in
Node Status page, but the node is up
and running.

Explanation

Sterling B2B Integrator is configured using an
IPv4 address on a dual-stack machine. The Node
Status page displays Node went down status, but
the node is up and running.

Resolution

Modify the
noapp.properties_platform_ifcresources_ext.in and
jgroups_cluster.properties.in files by performing
the following:

1. Identify the IPv6 address of the host machine
from the /etc/hosts file.

2. Navigate to the /install_dir/properties
directory.

3. Edit
noapp.properties_platform_ifcresources_ext.in
file and add the IPv6 address: admin_host.2 =
<IPv6 address>

4. Edit jgroups_cluster.properties.in and modify
the following:

v &HOST_NAME=<IPv6 address>

v mcast_addr=FFFF::<IPv4 address

5. Run the ./setupfiles.sh script to apply the
changes.

Installing (HP-UX 11.31) When entering your email address
the @ key is not recognized.

Explanation

The @ key is being mapped to kill or eol, it needs
to be mapped to another character.

Resolution

This resolution only applies to HP-UX 11.31.

Map the @ key to another character.

Note: If you need want to see what the key is
mapped to, use the stty -a command.

Cluster Installation Cluster is not working properly and
your machine is running dual-stack -
ipv4 and ipv6.

Explanation

You can see the node went down from User
Interface, but the node is running.

Resolution

v Find your ipv6 address in the /etc/hosts file
and update noapp.properties.in file
admin_host.2 = <ipv6_address>.

v Edit jgroups_cluster.properties.in file and
replace &HOST_NAME with the ipv6 address
string and change
mcast_addr=FFFF::239.255.166.17.

v Enter setupfiles.sh.
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Situation Message or Symptom Explanation/Resolution

Cluster Installation or
Upgrade

When configuring TCPS the
following warning can be found in
the activemqbroker.log:

sun.security.provider.certpath.
SunCertPathBuilderException:
unable to find valid certification
path to requested target.

Resolution

Add the system certificate to the trust store using
the KeyTool command.

Cluster Installation or
Upgrade

When configuring TCPS the
following warning can be found in
the activemqbroker.log:
oracle.net.ns.NetException: Invalid
cipher suites specified.

Resolution

Do not mention any SSL cipher in the
ActiveMQconfig.xml.

e-Invoice Upgrade:
Oracle Add Constraint
Error

When you upgrade Sterling
e-Invoicing and are using an Oracle
database, if the upgrade fails with
the error message name is already
used by an existing object, this
occurs because the default behavior
for the drop constraint command
changed in Oracle 10.

Explanation

The index that is used to support the constraint is
now only removed if the index was generated by
the create constraint command. The indexes for
Sterling e-Invoicing are always generated from
constraints during an install. If you receive this
error during a Sterling e-Invoicing upgrade, it is
because of how the database was restored, the
version of Oracle you are using, and because the
Oracle imp command exported the indexes and
constraints separately. There is no way to
determine when the imp command will not add a
create index command to the export file if it was
generated by a constraint – but if it does add the
command, the database restore process loses the
association of the constraint and its underlying
index. The database script that runs during a
Sterling e-Invoicing upgrade executes two steps:
1. First, it drops the unique constraint so the next
step can redefine it using additional columns.
However, the drop constraint command does not
remove the underlying index if the association
with its index was lost. 2. The next command that
redefines this constraint requires a different index
definition, but in this scenario the name of the
index the constraint wants to use already exists,
which causes the name is already used by an
existing object error.

Resolution

If you receive this error message, the solution for
this problem is to drop the index and rerun the
Sterling e-Invoicing upgrade. The drop index
command you should use is: drop index
UNQ_EINV_CANON
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Situation Message or Symptom Explanation/Resolution

Applying a fix pack or
upgrading

The /install_dir/install/
installed_data directory is created
(if clustered, on each node) during
upgrade or applying a fix pack.

This directory can become very large
and take up needed space on the file
system.

Explanation

The information in this directory is used during
upgrade or when applying a fix pack, but is not
required afterward. The deployment/cleanup
tasks for the upgrade do not remove this
directory.

Resolution

The directory can be manually removed to
increase the available space for the file system:

1. Navigate to /install_dir/install

2. Enter

rm -r installed_data

UNIX/Linux Non-Cluster Environment Upgrade (V5.2.6 or later)
You can upgrade the Sterling B2B Integrator software in a UNIX/Linux non-cluster
(single node) environment.

CAUTION: Sterling B2B Integrator should be installed behind a company firewall
for security purposes. See the Perimeter Server and Security topics in the Sterling
B2B Integration documentation library for more information on secure deployment
options.

You should also review the following documents:
v System Requirements
v Release Notes
v What's New
v Installation and Upgrade Information

It is important to remember that upgrading involves a full installation of Sterling
B2B Integrator. You need to prepare for an upgrade the same way that you would
prepare for an installation. It is also recommended that you thoroughly test this
process in a test or development environment prior to implementing in a
production environment.

This upgrade does not overwrite your current Sterling B2B Integrator directory
structure on disk. Instead, it creates a new installation of Sterling B2B Integrator
that will point to and upgrade the database of your current installation of Sterling
B2B Integrator. This means your original instance will no longer be operational
after performing the upgrade. After the upgrade, you will be starting your Sterling
B2B Integrator instance only from the newly created directory structure.

For new installations, use the Sterling B2B Integrator UNIX/Linux Non-Cluster
Installation Guide.
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Upgrade Overview

Intended audience:

This document can be used by different members of your organization.

This document is intended for use by:
v System administrators
v Installation engineers
v Database administrators.

Assumptions for this guide:

The procedures in this guide are accurate as of the publication date and are
specific to this version of the document.

Upgrade Scenarios (Non-Clustered): Upgrading to Sterling B2B Integrator can
follow several paths. Keep these scenarios in mind as you plan for your upgrade:

Upgrade Scenario High-Level Upgrade Steps

You have V5.2.x installed and want to
upgrade by applying V5.2.6 as a fix pack.

The upgrade steps are as follows:

1. Ensure that your JDK version is
supported. See the system requirements.
Upgrade your JDK if needed. See
“Upgrading your JDK (Windows and
UNIX)” on page 3.

2. Ensure that your operating system and
database versions are supported.

3. See “Applying a Fix Pack (V5.2.6 or
later)” on page 625or “Applying Sterling
B2B Integrator V5.2.6 Fix Pack using a
script” on page 630
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Upgrade Scenario High-Level Upgrade Steps

You have 5.1.x installed and want to
upgrade to V5.2.6.

The upgrade steps are as follows:

1. Ensure that your JDK version is
supported. See the system requirements.
Upgrade your JDK if needed. See
upgrading your JDK.

2. Ensure that your operating system
version is supported. Upgrade your
operating system if required.

3. Ensure your database version is
supported. Upgrade you database if
required:

a. Export the configuration data.

b. Back up the database.

c. With help from a database
administrator (DBA), copy the
database to the new version.

d. Back up the newly created database.

4. Upgrade to Sterling B2B Integrator V5.2.6
using the full installation media and this
Upgrade Guide.

5. Point to your supported database
version. If the upgrade stops and leaves
the newly created database in an
incomplete state, you can re-start the
upgrade using the backup of the
database.

Upgrade Impacts
This documentation provides information on how system behavior has changed
based on upgrading your instance. You should review this information before you
begin your upgrade. Depending on which version you are upgrading to, you will
need to review one or more topics listed. The upgrade impacts listed for each
subsequent version are specific to that version. There is not a cumulative list.

Upgrade impacts for V5.2.6.2:

Upgrading to Sterling B2B Integrator V5.2.6.2 has unique impacts.

DB2 requires additional tablespace

When upgrading to V5.2.6.2 or later you must ensure that all tablespaces used by
Sterling B2B Integrator tables have a minimum page size of 8K. Otherwise
installation will fail.

Upgrade impacts for V5.2.6:

Upgrading to Sterling B2B Integrator 5.2.6 has unique impacts.

Support for SSLV3 has been removed - TLS 1.2 is the new default

Due to security concerns, Sterling B2B Integrator no longer supports the use of
SSLV3. You should be aware of the following changes as you upgrade your system
to this version:
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v Several properties have been updated to use TLS 1.2 as the default. If your mail
server cannot use TLS 1.2, you can change your SMTP and B2B Mail Client
adapters to use TLS 1.0 or 1.1 instead.

v If any of your 3rd party programs do not support the use of TLS 1.2, you can
change Sterling B2B Integrator to use TLS 1.0 or TLS 1.1.

v In all cases, requests to use "SSLV3" in Sterling B2B Integrator will use instead
TLS 1.0, TLS1.1, or TLS1.2.

v TLS 1.2 is used as the default protocol in secure communications. This change
applies to any system that is upgraded to V5.2.6.

v If your GPM, or WebSphere MQ or OFTP adapters are configured to use older,
non-supported cipher suites (non-TLS 1.2), they will continue to work. However,
if you edit them, only TLS 1.2 will be available to select.

JDK 7 is the only supported JDK version for V5.2.6

There are several impacts due to this change:
v If you are not already using JDK 7, you must upgrade your JDK before

attempting to upgrade Sterling B2B Integrator to V5.2.6. If you currently have
V5.2.4.1 or higher installed, there is a upgradeJDK script available to assist you.
See bin Directory Files for more information.

v Only ciphers that are supported by JDK 7 can be used in Sterling B2B Integrator
V5.2.6. You can update your cipher suites in security.properties.

v Previously defined ciphers in customer_overrides.properties are not changed
upon upgrade to V5.2.6.

v DefaultCipherSuite contains a list of JDK 7 ciphers in V5.2.6 that can be used
when others are not available.

Upgrade impacts for V5.2.5:

Upgrading to Sterling B2B Integrator 5.2.5 has unique impacts.

JDK 7 does not support the TLS_RSA_WITH_3DES_EDE_CBC_MD5 cipher

If you are using JDK 7 with Sterling B2B Integrator V5.2.5, and you want to use a
cipher to secure the Sterling B2B Integrator dashboard, you must set one of the
following values in the dashboardCipherSuite parameter in the
security.properties_platform_asi_ext.in property file or in customer_overrides:
v JDK (includes all strong ciphers except the one not supported by JDK 7)
v Weak

Do not use Strong or All with JDK 7 or Sterling B2B Integrator will not start.

Reconciliation of HIPAA Level 5 code lists

When you upgrade to Sterling B2B Integrator 5.2.5, customized HIPAA Level 5
code lists from the previous version are preserved in the system where they were
entered, but they are not the default code lists after the upgrade. After the
upgrade, you must manually make any customized code lists the default code lists.

For example, you customized the ICD9 or HCPCSCPT code list in the previous
version of Sterling B2B Integrator. After the upgrade to version 5.2.5, you must
replace the default ICD9 or HCPCSCPT code list with the customized ICD9 or
HCPCSCPT code list.
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Properties file change to prevent timeout during start (5.1.0.4 to 5.2.5 upgrade)

Before you start Sterling B2B Integrator after you upgrade the application from
version 5.1.0.4 to 5.2.5, you must change the values of the following properties in
the centralops.properties file to 600. This action prevents the start command
from timing out before Sterling B2B Integrator starts. The centralops.properties
file is in the properties subdirectory of the installation directory.
v OpsServer.commandTimeout

v PassPhrase.urlTimeout

jGroups upgrade in V5.2.5 prevents Sterling B2B Integrator from starting for
some customers

jGroups is upgraded with V5.2.5. Some of the properties defined in
jgroups_cluster.properties have changed. If you modified these files or added
custom changes for them to customer_overrides.properties, the upgrade changes
are not applied and Sterling B2B Integrator will not start.

This issue is fixed in V5.2.5, Interim Fix 1, where all necessary properties files are
changed for you. You can also disable this fix if desired. See APAR IT06654 for
more information.

Note: The original and modified properties are output to the noapp.log file. This
allows you to see how your properties were modified. Search the log using the
value “Initializing jgroups_cluster.property_string" to see the new and changed
values for the two affected startup properties. The
jgroups_cluster.lock.protocolStack property is also modified with this fix, but is
only written to the log when it is used, not at startup.

If you want to manually fix your installation without applying V5.2.5, Interim Fix
1, complete the following steps:
1. Delete the following options (if they exist) from customer_overrides.properties

for the jgroups.cluster property file. These occur in the
jgroups_cluster.property_sting, jgroups_cluster.distributed_property_string, and
jgroups_cluster.lock.protocolStack files:
v gc_lag
v up_thread
v down_thread
v join_retry_timeout
v max_xmit_size
v shun

2. Remove the protocol parameter VIEW_SYNC and all of its attributes.
3. In the jgroups_cluster.property_string, replace ‘start_port’ with ‘bind_port’.
4. In the jgroups_cluster.distributed_property_string and

jgroups_cluster.lock.protocolStack properties, add the following items:
v In distribution_property_string the attribute

thread_pool_rejection_policty=run should be added to the protocol ‘TCP’.
For example,
TCP(bind_port=22261;thread_pool_rejection_policy=run)

v In lock.protocolStack: the protocol and attribute CENTAL_LOCK(num_backups=2)
should be added to the end of the property. For example,
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lock.protocolStack=UDP(bind_addr=&HOST_ADDR;;bind_port=
&MULTICAST_NODE_PORT3;;mcast_addr=239.255.166.17;<other

protocol parameters here>pbcast.GMS(join_timeout=5000;print_local_

addr=true):CENTRAL_LOCK(num_backups=2)

Upgrade Impacts for V5.2.0: Before you begin an upgrade, you should review the
following information.

Features and Services Not Supported as of V5.2.0

The following features and services are no longer supported:
v Channels portlet
v Federated Systems
v Community Management (AFT Communities are still available)
v Sterling Community Management (SCM) Integration
v Archive Commandline Service
v Sync Engine Data Clean Manager Service
v Sync Engine Task Manager Service

If you need more information, please contact your IBM sales representative.

Port Allocation Changes

If you are upgrading to V5.2, and configured the CLA2 or the SWIFTNet HTTP
Server Adapter, the remote port numbers have changed. The port numbers are as
follows:

Table 4. Remote Port Numbers

Adapter
Name

Version 5.2.0 Base
Port Version 5.2.1 Base Port Version 5.2.2 Base Port Version 5.2.3 Base Port

CLA2 +51 +52 +53 +54

SWIFTNet
HTTP
Server

+52 +53 +54 +55

Note: You should check adapter configurations and the sandbox.cfg file for ports
greater than 51 which may have changed.

After upgrading to 5.2.x, you need to change any references to the old remote port
numbers. For example, if you have any business processes that use the CLA2
adapter, you will need to update the remote ports in the business process.

Database Table Sizes

While upgrading if you encounter any database table size issues, you may have to
manually adjust the database tables and restart the upgrade process. An upgrade
using the production database in a test environment can be used to help you
determine what tables need to be manually adjusted.
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Resource Tags

If you are using resource tags in your current version, you should check all of your
existing resource tags before you start the upgrade process. The resource tags you
should check are:
v Adapter Policies
v Agreements
v Sterling Connect:Direct Netmaps
v Proxy Servers
v Security Tokens
v SSH Resources
v SWIFTNet Copy Service Profiles
v SWIFTNet Service Profiles

You can check the resource tags by running the following SQL query from the SQL
Manager page (Operations > Support Tools):
SELECT * FROM TAG_RESOURCE_ASSOC WHERE TYPE=41 OR TYPE=42 OR TYPE=43 OR TYPE=44 OR
TYPE=45 OR TYPE=52 OR TYPE=53

The TAG_NAME column in the SQL results will contain the names of any resource
tags that need to be edited or deleted.

If any of the resource tags contain tagged resources using the types listed, remove
those resources from the resource tags or delete the resource tags that contain these
resource types.

Silent Installation Parameters

The following parameters are new or have an updated definition:

What has changed parameter Definition

Parameter definition
has changed

LICENSE_FILE_PATH (Required) Full path to Core_License.xml.

New parameter LICENSE_FILE_#
(where # is a number
between 1 and 99)

(Required) This is required for each license
you install. You must add an entry for each
license file to the silent install file. The
LICENSE_FILE numbering (#) does not
need to be sequential.

For example:

LICENSE_FILE_1= SI_SFG_License.xml

LICENSE_FILE_2= Fin_Serv_License.xml

LICENSE_FILE_3=
SI_SFG_FIPS_License.xml

LICENSE_FILE_4= AS2_License_.xml

LICENSE_FILE_5= EBICS_License_.xml
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Channels and Community Management Tabs (Optional)

The Dashboard PSML files are not updated during an upgrade. The PSML file
impacts any custom tabs you may have configured, such as Channels or Operator.
The Channels and Community Management tabs appear in your browser but are
no longer operational.

To remove the Channels and Community Management tabs:

Warning: The psmlRestore command gets the 5200 psml file which resets ALL of
the custom tabs from the previous release.
1. Navigate to the installation directory.
2. Navigate to the bin directory.
3. Enter this command: ./psmlRestore.sh admin

Custom BI Fact Models Need to be Upgraded

Scripts named recreateBITablePKs.cmd.in (Windows) and recreateBITablePKs.sh.in
(UNIX) are now provided which allow you to upgrade any custom BI fact models
tied to a separate BI repository.

BI fact models need to be upgraded to continue to work with the Entity
Framework, which replaced Hibernate usage in the BI framework in version 5.2.0.

Backups Are Not Generated During Install, Upgrade, or When Applying a Fix Pack or
Interim Fix: Before you begin an upgrade, review the following backup
information.

Some of the standard resources installed during install or upgrade use the import
mechanism available to customers to load the standard resources into the database.
The standard import mechanism by default creates a backup of the table
containing the resource prior to importing to provide the ability to restore to the
previous state if later it was decided that the import should not have been
performed. This table backup was also being performed by default during the
basic installation processes. And, since the import mechanism was sometimes used
multiple times during the installation processes, some of the tables were backed up
several times. Depending on the size of the table, this could add a very large
amount of time to the installation process. Since it is recommended that a backup
is completed prior to beginning any of these installation processes, the default
behavior has changed to not perform the backup by default. If you would like
backups to be performed, then SKIPIMPORTBACKUP=false should be added to the
sandbox.cfg file.

Capitalization Insensitivity for Header Value:
About this task

Before you begin an upgrade, review the following AS3 information.

For AS3, when searching for a header value in a multipart/report, you do not need
to consider whether the header value contains any capitalization. The search has
been enhanced to be capitalization insensitive.

For example, the following searches will result in a match:
v Multipart/Report
v Multipart/report
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v multipart/Report
v multipart/report

The search would not find the following as a match:
v MulTiPart/RePorT

CA Certificates Impacts: Before you upgrade, review the following information on
CA certificates.

Users may add multiple copies of the same certificates to the database. Having
multiple copies of the same certificate in the database is not, in principle, a
problem for the system except for the minor amount of wasted storage. Each copy
has a different object ID in the database and is a separate database object.

The specific changes in this release is the ability to easily populate the product
database with the set of authority root certificates distributed with the JVM.

Retry Logic Added to WebSphereMQ Suite Adapter PUT Service:
About this task

Before you begin an upgrade, review the following WebSphereMQ Suite Adapter
PUT Service information.

Retry logic has been added to the WebSphereMQ Suite. To accommodate this new
functionality, you need to configure two new parameters for the PUT service:
v wsmq_send_retryCount
v wsmq_send_retrySleepInterval

To configure the new parameters:

Procedure

1. Log into Sterling B2B Integrator.
2. From the Admin Console Home, you need to start the Graphical Process

Model (GPM).
3. Log into the GPM. You will need a User ID and Password.
4. In the GPM, select View > Stencil > Services.
5. Select File > New.
6. Drag the WebSphereMQ Suite Put Message Service from the All Services

pane into the center pane.
7. Double click the WebSphereMQ Suite Put Message Service.
8. Select the configuration from the Config dropdown.
9. Enter the number of retries in to the wsmq_send_retryCount value.

10. Enter the sleep interval in seconds in to the wsmq_send_retrySleepInterval
value.

11. Save the changes to the service configuration.
12. Exit from the GPM.

Services and Adapters - Show Advance State Button: Before you begin an upgrade,
review the following Show Advance State button information.
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The Show Advanced State check box has been removed from the Services
Configuration search screen. Instead, the default has been changed to always show
the advanced state without needing to check a checkbox on the search screen to
display it.

Some Certificate Fields Are Optional:
About this task

Before you begin an upgrade, review the following certificate field information.

When generating certificate keys, the following fields may have been missing in
the release you are upgrading from, but the entries are now optional:
v alt.name.dns
v alt.name.IP

Support for Multiple AS2 Organizations: Before you begin an upgrade, review the
following AS2 schema information.

Sterling B2B Integrator now supports multiple sponsoring organizations and
multiple partners for AS2. During upgrade, the single organization will be flagged
as the default organization.

Once you have upgraded to this version, a prefix designation is used to
differentiate between an AS2 organization (AS2_ORG_) and an AS2 partner
(AS2_PART_). Each of these will require the full configuration of a trading partner
to allow for a partner to trade with multiple organizations as well as an
organization that trades with multiple partners.

The AS2_TRADEPART_INFO and AS2_EMAIL_INFO tables have been modified
and the AS2_PROFILE table is newly introduced. Updates to these tables will
occur during the SI in-place upgrade process in the following manner:
v Identify the default organization and populates the AS2_PROFILE table with

organization information. A default organization is an AS2 organization profile
named "profile_ORGANIZATION" present in the system before upgrade.

v Identify partner records and populates the AS2_PROFILE table with partner
information.

v Populate the new columns of table AS2_TRADEPART_INFO with the default
organization information.

v Populate the new PROFILE_ID column in the AS2_EMAIL_INFO table with the
profile id of the AS2 organization profile present in the system.

Web Services: Before you begin an upgrade, review the following Web Services
information.

Many of the Web Services configuration settings that were generated from the
WebServices Provider Configuration UI have moved from the property files into
database tables. This change was made to allow a single location of these settings
in cluster environments and to ensure that these settings would not be reset during
a fix pack installation.

After you have completed your upgrade, you should run the
convertWSSoaProperties script found in the installation bin folder. This script reads
the settings from the property file and places them into the proper database tables.
You can then review the results in the WebServices Provider Configuration UI.
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Perimeter Server Installation:
About this task

Before you begin an upgrade, review the following Perimeter Server installation
information.

Silent install is the default installation mode. If you want to complete the Perimeter
Server installation using an interactive mode, you need to use the following
command:
java -jar ps_xxxx.jar -interactive

where ps_xxx.jar is the perimeter server jar file name for the version of Sterling
B2B Integrator you are upgrading to.

MySQL Upgrade Impacts: The MySQL database is no longer bundled with Sterling
B2B Integrator software. Therefore, you will need to install and configure an
external version of the MySQL database prior to upgrading to the new version of
Sterling B2B Integrator.

Upgrade MySQL Checklist (External MySQL): This checklist assumes you are
upgrading from a previous version of Sterling Gentran Integration Suite or Sterling
B2B Integrator directly to Sterling B2B Integrator 5.1 and higher and you are
knowledgeable on the MySQL database.

If you need additional MySQL database information, see the documentation
provided by the vendor at http://dev.mysql.com/doc/refman/5.0/en/.

If you are moving from a version of MySQL earlier than MySQL 5.0, you will need
to export the data from the earlier version to the MySQL 5.0 version using the
following procedure. Your existing Sterling Gentran Integration Suite instance will
no longer function if you upgrade your existing database without making a copy.
After this procedure, you will have two databases:
v A database that you will use in your upgraded version of Sterling B2B Integrator

(Sterling B2B Integrator 5.1 and higher).
v A database that you can use in your old version of Sterling B2B Integrator.

Task Which database MySQL Upgrade Checklist Your Notes

1 New external
database

Install an external MySQL database.

Refer to MySQL documentation for information about
installing the database. Be sure to install the correct
version and patches.

See System Requirements for supported version
information.

2 New external
database

Update the MySQL Parameters.

3 New external
database

Create the database. For example, you can run the
following command to create the database:

CREATE DATABASE database_name

Refer to MySQL documentation for information about
creating the database.

4 New external
database

Create a user account and grant permissions.
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Task Which database MySQL Upgrade Checklist Your Notes

5 New external
database

Install the JDBC Driver for MySQL.

6 Previous database Rename the SCHEMAS table to XMLSCHEMAS to
avoid reserved word collision:

v Only required when moving from MySQL version
earlier than 5.0

v Use the following command:

Alter table SCHEMAS rename to XMLSCHEMAS

7 Previous database Perform a MySQL database export.

As part of the export, you will have a backup copy of
the database.

8 Previous database If you renamed the SCHEMAS table in task 6, you need
to rename the SCHEMAS table, so that your older
version of Sterling B2B Integrator will be operational.

Use the following command:

Alter table XMLSCHEMAS rename to SCHEMAS

9 New external
database

Import the exported data for MYSQL into the new
external database.

Update the MySQL Parameters: Sterling B2B Integrator requires the following
parameter settings in your MySQL database.

The parameter values recommended are minimum values. You can increase the
values based on your requirements or if the database server is used by more than
one instance of Sterling B2B Integrator.

It is recommended to configure a data file for auto extension
(innodb_data_file_path = ibdata1:400M:autoextend).

Parameter Value

max_connections 500

max_allowed_packet 100M

default-table-type INNODB

wait_timeout 31536000

max_write_lock_count 500000

transaction-isolation READ-COMMITTED

character-set-server utf8

binlog_format mixed

table_open_cache 512

key_buffer_size 384M

sort_buffer 512K

connect_timeout 15

innodb_data_file_path ibdata1:400M:autoextend

innodb_data_home_dir /install_dir/mysql/var/
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Parameter Value

innodb_log_group_home_dir /install_dir/mysql/var/

innodb_flush_log_at_trx_commit 1

innodb_mirrored_log_groups 1

innodb_log_files_in_group 3

innodb_file_io_threads 4

innodb_lock_wait_timeout 600

innodb_log_file_size 5M

innodb_log_buffer_size 8M

innodb_buffer_pool_size 128M

innodb_additional_mem_pool_size 32M

Review the innodb_buffer_pool_size and the innodf_additional_mem_pool_size in
the /install_dir/install/mysql/data my.cnf. If the values from the previous Sterling
B2B Integrator tuning.properties are larger than what is in your new my.ini file,
you need to adjust them accordingly.

Create User Account and Grant MySQL Database User Privileges:
About this task

You must grant all privileges on the MySQL database to the Sterling B2B Integrator
administrative user. The following example creates and grants all privileges to the
user in the MySQL database:
GRANT ALL PRIVILEGES ON database_name.* TO user@localhost IDENTIFIED BY 'password’
WITH GRANT OPTION

Where:
v database_name - refers to the name of the database created.
v user - refers to the database user account that will be used by Sterling B2B

Integrator.
v password - refers to the password associated with the database user account.

Once you have granted all the privileges, you will need to FLUSH the privileges to
complete the setup. For example, run this command from the SQL prompt:
FLUSH PRIVILEGES;

Install the JDBC Drivers for MySQL:
About this task

Sterling B2B Integrator requires appropriate JDBC driver for MySQL database.
These drivers are platform independent and architecture independent drivers. See
System Requirements for supported version information.

After obtaining the correct JDBC driver, record the absolute path to its location on
your system. You must supply this absolute path when installing Sterling B2B
Integrator.

Perform a MySQL Database Export:
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About this task

The full backup can be performed using the mysqldump utility. The details on the
usage of this MySQL utility can be found in the MySQL reference documentation.
Since there are many options that are provided with this utility, the following are
the minimum recommendations:
v Specifying the db_name on the mysqlcommand will prevent the subsequent

import from creating a new database. You should specify the db_name of the
Sterling B2B Integrator database.

v --extended-insert: Use multiple-row INSERT syntax that include several VALUES
lists. This results in a smaller dump file and speeds up inserts when the file is
reloaded.

v --quick: This option is useful for dumping large tables. It forces mysqldump to
retrieve rows for a table from the server a row at a time rather than retrieving
the entire row set and buffering it in memory before writing it out.

v --disable-keys: This makes the dump file faster because the indexes are created
after all rows are inserted.

To export the database:

Procedure

1. Perform a backup of the database. For example, enter:
myysqldump –u <internal_mysql_username> -p<password> <db_name>
--host=<internal_mysql_host> --port=<internal_mysql_port> > <dump_file_name>

2. Make a copy the resultant dump file (.dmp) file from the file system on the
source server file system to the file system on the MySQL destination server.
If the MySQL database was created as part of a Sterling B2B Integrator
installation, you can determine the port number by reviewing the
MYSQL_PORT entry in the sandbox.cfg that is in the Sterling B2B Integrator
install directory.

Import the Data to the New Version of MySQL Database:
About this task

Before you begin:
v Make sure the new version of the MySQL database is not in use.
v Know the name of the new database.

To import the exported data:

Procedure

Enter:
mysql -u <external_mysql_username> -p<password> <db_name>
--host=<external_mysql_host> --port=<external_mysql_port> < <dump_file_name>

Where database_name is the name of the new database created in task 3 of the
checklist.

Upgrade Planning
Proper planning will help ensure a trouble-free upgrade.

Before you begin an upgrade you should:
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v Read and become familiar with this document so that you have a clear
understanding of what the upgrade requires.

v Review upgrade scenarios to determine which scenario you want to use.
v Review and record system configuration information.
v Review and record performance and tuning information.

Upgrade Planning Checklist: To assist you with your upgrade planning, review
the following planning checklist:

# Upgrade Planning Checklist Your Notes

1 Read through this entire document so that you have a
clear understanding of what the upgrade requires.

2 Download and review the following information from
the Sterling B2B Integrator documentation library.

v System Requirements - With each release, IBM
introduces leading edge technology to improve and
enhance its software. Review the System Requirements
to confirm that your system and databases meet the
requirements for this release.

v Release Notes - Review the release notes to obtain
information about issues and resolutions which have
been identified for this release.

v What's New in this Release - Review this guide to find
out about new features and functionality provided in
this release.

v Installation and Upgrade Information - Lists the
installation and upgrade documents available for this
version of Sterling B2B Integrator.

3 CAUTION:
Before upgrading to the latest product version, contact
your sales representative to verify that it includes all
of your current functionality. Depending on the
timing, even though it's in a higher version that the
one you have installed, a particular mod release or fix
pack might not include all the functionality in your
current version or fix pack.

4 Collect information on third-party libraries used for
adapter configurations that were added to your current
release.

You will need to add each of these libraries to the
upgraded system.

5 Locate any configuration file changes for JDBC adapter
or Lightweight JDBC adapter in your current release.

You will need to copy these changes to the upgraded
system.

6 Record your performance tuning configuration.

You will need to restore these settings after the system
has been upgraded.
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# Upgrade Planning Checklist Your Notes

7 Review and note the adapters, business processes, and
other configurations in your current release.

This information will help you identify the need for
updating transport messages, third-party adapters, or
configurations to adapters, such as File System or
Command Line adapters.

8 Determine if you have edited any of the property files
(.properties or .properties.in).

The upgrade process overwrites these property files,
unless these changes were made using the
customer_overrides.properties file. Your previous
property file edits might not be applicable this version
of the software.

9 Determine if you edited any of the following cdinterop
files:

v cdinterop-proxy-records.properties

v cdinterop-spoe-auth.properties

v cdinterop-spoe-policy.properties

v cdinterop-user-records.properties

You must back them up before upgrading. The
cdinterop files do not have initialization (*.in) files. After
the upgrade, use the backup version of the files in your
upgraded installation.

10 Determine if you have LDAP (Lightweight Directory
Access Protocol) configuration information in the
security.properties file. This information will
automatically be moved to the
authentication_policy.properties file.

11 Determine whether Sterling B2B Integrator is using an
application server (JBoss™, WebLogic® or WebSphere®).

Sterling B2B Integrator does not require an application
server for installation or at runtime.

Sterling B2B Integrator supports integration with JBoss
and WebLogic during the installation. You can also
integrate with WebSphere, JBoss, or WebLogic by using
the Sterling B2B Integrator EJB Adapter. This does not
represent a WebLogic server for deploying the
Application Console.

12 If you use a File System as your document storage
method, determine and record the path to the File
System.

You will need the File System path structure so that
after the upgrade, you can copy/mount the documents
to the new installation directory. The directory structure
(path to the File System) must be the same in the
current and in the upgraded system.

13 Review the EDI Sequence Check Queue to ensure that
no interchanges are in the queue. The EDI Sequence
Check Queue is used for X12 and EDIFACT sequence
and duplicate checking.
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# Upgrade Planning Checklist Your Notes

14 Determine if you have any JVM Containers configured.

If yes, you will have to reconfigure the JVM containers
after you have upgraded the software.

Prepare Your System for the Upgrade
To help ensure a trouble-free upgrade, be sure to prepare your system before
beginning the upgrade.

Before you begin the upgrade :
v Complete all Pre-Upgrade Checklists.
v Verify that your system meets all system requirements.
v Obtain the upgrade media.
v Create a process output log (optional).
v (Microsoft SQL Server only) Configure the snapshot feature (optional).
v (DB2 only) Upgrade DB2 to version 10.1 or 10.5, if needed.

Pre-Upgrade System Checklist:

Use the Pre-Upgrade System Checklist to help ensure that your system is ready for
upgrading and reduce the chance of errors or other problems during upgrade.

Before you begin an upgrade:

# Pre-Upgrade System Checklist Your Notes

1 Use the system requirements to verify that your system hardware
and software meet the requirements specified for this release.

Verify you have the correct:

v Patches required by Java™ for the operation system

v Version of the JDK

v JDK Patches

v Absolute path to JDK and patches

v Database must match the version listed in the requirements

If any of the above requirements are not met, the installation will
fail and print/log a report of all items that were non-compliant.

Ensure that you have the correct license file and JCE file.
Important: Do not remove the existing license file or JCE file
from your system. The files specified by the LICENSE_FILE_PATH
and JCE_DIST_FILE parameters in the sandbox.cfg file must be
present during the upgrade, or the upgrade will fail.

2 For systems with multiple IP addresses, verify that the IP address
on which Sterling B2B Integrator resides is accessible by any
client computer that is running a browser interface.

If you do not verify the IP addresses, your system may not
operate properly after installing Sterling B2B Integrator.

3 If you are using a non-English environment, confirm that you are
using the appropriate character set.

4 Verify the file system has adequate free disk space.
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# Pre-Upgrade System Checklist Your Notes

5 Obtain the upgrade media.

It is a best practice to check the Product Updates and Downloads
site to ensure you have the latest version of the media.

6 Backup your Sterling B2B Integrator installation directory and the
database.

If there are problems with your upgraded system, the only way
to ensure that you can roll-back to your previous version is to
back up Sterling B2B Integrator and the database.

7 Archive your data.

Archived data can only be restored from the same version of
Sterling B2B Integrator from which it was archived. If you need to
restore archived data that was archived prior to performing the
upgrade, then you must have a running instance of Sterling B2B
Integrator that matches the version from which the archive was
taken.

8 Purge any unneeded data.

9 Export any business objects that can not be upgraded. Including
business processes, service configurations, trading partners, and
maps.

The exported business object can be imported into the upgraded
system if you need them.

10 Create a process output log.

11 Disable the virus protection software on the server.

If the virus protection software is enabled, the upgrade will fail.

Pre-Upgrade Database Checklist: Before you begin an installation, you need to:

# System Verification Tasks Your Notes

If required, copy your Microsoft SQL Server
Database to a supported version.

This is an optional procedure, and it is the
customer's responsibility to perform it. (IBM
Customer Support can not help with this
procedure.)

If you are using Oracle 8i with Sterling B2B
Integrator 4.0, upgrade to Oracle 9i before
upgrading to this version of Sterling B2B
Integrator.
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# System Verification Tasks Your Notes

If you plan to import an Oracle 9 or Oracle 10
database, while upgrading to this version of
Sterling B2B Integrator, you must import the
database without the indexes.

For example, if you are using the Oracle import
(imp) tool, you should use the INDEXES=N option.
If you attempt upgrading to this versin of Sterling
B2B Integrator with indexes turned on, the
upgrade will fail. If you had created any custom
indexes in Oracle database, add them after
performing the upgrade as they are not imported.

Pre-Upgrade Operating System Verification Checklist:

Before you begin the upgrade, you need to verify your operating system
configuration.

For the Operating System Operating System Configuration Checklist Your Notes

HP-UX Operating System Verify these settings:

v Verify kernel parameters and establish the following
minimum settings by running the kctune command:

– kctune max_thread_proc 1024

– kctune maxdsiz 2147483648

– kctune maxdsiz_64bit 8589934592

– kctune maxssiz 369098752

– kctune maxssiz_64bit 536870912

v Run ulimit utility, verify, and establish the following
minimum settings:

– ulimit -d = 2097152 (in kilobytes) or higher

– ulimit -s = 360448 (in kilobytes) or higher
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For the Operating System Operating System Configuration Checklist Your Notes

AIX Operating System You must specify the name of the installation directory
name. The installation process creates the directory and
beneath it, a directory called “install”.

To ensure that /install_dir/install has the necessary
permissions, AIX users must run the following
command on the parent directory of /install_dir/install
before installation:

chmod -R a-s <absolute path>/install_dir_parent

where install_dir_parent is the directory in which
/install_dir/install will be created.

For example, to specify

AIX_1/applications/test1/my_install as your
installation directory, you could run the command from
the AIX_1/applications directory (directly above the
test1 directory):

chmod -R a-s test1

or from another location on the file system:

chmod -R a-s /AIX_1/applications/test1

This ensures that when the my_install directory is
created during installation, it inherits the correct
permissions from test1.

Solaris Operating System Set the following entries in the /etc/security/limits
file:

nofiles = 4096

set rlim_fd_max=4096 (limit is 65535) - hard limit

set rlim_fd_cur=4096 - soft limit

For nofiles, the value shown is an example. The
possible values are unlimited, so the number for nofiles
can be much larger. Revise the value as appropriate for
your business needs.

v To make the setting effective as the hard limit, reboot
the server or run the following command:

kill -1 inetd

v To make the setting effective as the soft limit, use the
parent shell configuration (for example, .profile).
Then, reboot the server.

Linux Operating System You need to disable SELinux by enter the following:

/etc/sysconfig/selinux: SELINUX=disabled

Ensure that /etc/hosts has short-names first for all
entries. For example,
127.0.0.1localhostlocalhost.localdomain

If the base locale is English, verify:

v that the LANG variable is en_US

v LANG variable is exported
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For the Operating System Operating System Configuration Checklist Your Notes

RedHat Enterprise Linux
Operating System

Make the following system changes:

v If the base locale for the system is English, edit the
/etc/sysconfig/i18n file by changing the
SUPPORTED variable from en_US.utf8 to en_US. You
can also allow multiple support using the following
format: en_US.utf8:en_US

v Save and close the /etc/sysconfig/i18n file. Edit the
/etc/security/limits.conf file by adding the
following lines:

– * hard nofile 8196

– * soft nofile 4096

– * hard memlock 3000000

– * soft memlock 3000000

– * hard nproc 16000

– * soft nproc 16000

– * hard stack 512000

– * soft stack 512000

This updates the system ulimits.

For nofile, the values shown are examples. The
possible values are unlimited, so the numbers for hard
nofile and soft nofile can be much larger. Revise
these values as appropriate for your business needs.

v Save and close the /etc/security/limits.conf file.

v Reboot the system.

IBM Installation Manager in UI mode may fail to start
on an RHEL 6.1 or higher x86_64 (64-bit) OS because
Installation Manager is a 32-bit application and is
dependent on some of the 32-bit libraries.

For information on installing the required 32-bit OS
libraries, refer to the IBM Support Website
(https://www-304.ibm.com/support/
docview.wss?uid=swg21459143)

CAUTION:
Due to a known issue with the IBM JDK on RHEL 6.1
or higher, a performance degradation might be seen in
comparison to previous RHEL releases. To avoid this
issue, disable the CFS on RHEL 6.1 or higher.

To disable CFS:

v Log in as root

v Edit /etc/sysctl.conf and add
"kernel.sched_compat_yield = 1"

v Reboot the system

For more information go to the IBM SDK and
Runtime Environment Java Technology Edition
Version 6 Information Center and search for known
limitations on linux.
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For the Operating System Operating System Configuration Checklist Your Notes

SUSE Linux Operating
System

Make the following system changes:

v If the base locale for the system is English, edit the
/etc/sysconfig/i18n file by changing the
SUPPORTED variable from en_US.utf8 to en_US. You
can also allow multiple support using the following
format: en_US.utf8:en_US

v Save and close the /etc/sysconfig/i18n file. Edit the
/etc/security/limits.conf file by adding the
following lines:

– * hard nofile 8196

– * soft nofile 4096

– * hard memlock 3000000

– * soft memlock 3000000

– * hard nproc 16000

– * soft nproc 16000

– * hard stack 512000

– * soft stack 512000

This updates the system ulimits.

For nofile, the values shown are examples. The
possible values are unlimited, so the numbers for hard
nofile and soft nofile can be much larger. Revise
these values as appropriate for your business needs.

v Save and close the /etc/security/limits.conf file.

v Reboot the system.

Verification of the system requirements:

Before you begin the installation, verify that your system meets the hardware and
software requirements that are specified for this release.

The hardware requirements that are listed in the System Requirements are the
minimum requirements. Your system requirements might exceed these
requirements if you are running other applications on the same machine as Sterling
B2B Integrator.

The installation strictly enforces the following system requirements:
v Operating system version must match requirement exactly.
v The minimum patch level for the operating system is enforced, but you can

apply higher patch levels.
v JDK version must match requirement exactly.
v The disk space is a minimum for the installation. The system must be separately

sized to handle whatever load is going to be put on the system.
v Database version must match exactly.
v JDBC driver version supports exact matches and wildcard matches.

If any of these requirements are not met, the installation fails. If the installation
fails, review the installation log for a list of non-compliant items.
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Upgrading your JDK (Windows and UNIX):

Sometimes you need to upgrade your JDK version to support a new version of
Sterling B2B Integrator.

About this task

If you have V5.2.4.1 or higher installed, you can use the upgradeJDK script to
upgrade your version of the JDK. See bin Directory Files for more information.

If you have V5.2.4.0 or lower installed, follow the steps below to upgrade your
JDK.

Procedure

1. Download the new JCE file. For example, the UnrestrictedPolicy.zip policy
file for the IBM JDK.

2. Back up the existing JDK in <Install Dir>/jdk. Change the folder name to
jdk_back)

3. Copy the new IBM JDK (1.7.0 ) folder to the installation Directory. Directory
Name should be jdk )

4. Copy all the jars present in <Install Dir >jdk_back\jre\lib\ext to <install
Dir>jdk\jre\lib\ext directory.

5. If your installation of V5.2.4 or lower was built using the Oracle (SUN) JDK,
continue to the next step. Otherwise skip to step 6.
a. Edit the sandbox.cfg property file.
b. Set JCE_DIST_FILE=<New Path of Supported JCE File>. For example,

JCE_DIST_FILE=D\:\\IBM\\unrestrictedpolicyfiles.zip.
c. Back up the local_policy.jar and US_export_policy.jar files present in

<Install Dir>jdk\jre\lib\security.
d. Unzip the new JCE file. For example, Unrestrictedpolicyfiles.zip file.

Copy local_policy.jar and US_export_policy.jar to <Install
Dir>jdk\jre\lib\security.

6. Run updateJavaSecurity.cmd <path_to_new_jdk><Install Dir>/jdk.
7. Verify that security providers have been updated in <Install

Dir>\jdk\jre\lib\security\java.security.
8. Follow the Upgrade Guide instructions for your upgrade scenario.

Obtain Upgrade Media:
About this task

Before you upgrade, ensure that you have the latest version of the upgrade media
from the Passport Advantage online site or have downloaded the fix pack from Fix
Central..

For the latest version and for online support, go to: http://www.ibm.com/
software/howtobuy/passportadvantage/pao_customers.htm

Note: For V5.2.6, the fix pack download used for upgrading from V5.2.x to V5.2.6
is very large. It includes the new functionality for Global Mailbox. You must
download the full fix pack file to upgrade to V5.2.6 by installing a fix pack even if
you do not plan to install Global Mailbox.

Create Process Output Log:
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About this task

A log of process activity during the upgrade will help if troubleshooting is
required. Output is automatically logged to the upgrade log files (PreInstallSi.log
and InstallSi.log). Use this procedure to generate a separate output log for each
process you want to log.

To create a process output log:

Procedure

1. From any directory, run the script command to record the processes, ensuring
that you have created and specified the name of the file in which to save the
process output.
For example, to start recording output to a file named processoutput.log, type
script processoutput.log at the command line. The processoutput.log file will be
created in the directory where you ran the script command.

2. After the upgrade is complete, enter exit at the command line to stop
recording.

3. You can now retrieve the file containing the process output.
The following example shows a session after starting the script command,
specifying the output to be saved to the file named listing.log, and typing exit
to stop the script command from running:
[2]%script listing.log

Script started, file is listing.log
[3]%ls
Custard.Recipe FavoriteRecipes Curry.Recipe
VindalooCurry.Recipe Jelly.Recipe
[4]%exit
Script done, file is listing.log

Configuring the snapshot feature for Microsoft SQL Server:

The snapshot feature in Microsoft SQL Server allows you to view a read-only copy
of the database even when it is locked. Configuring the snapshot feature can also
reduce deadlocks. To enable the snap shot feature, enter the following command:
ALTER DATABASE db_name SET READ_COMMITTED_SNAPSHOT ON;

Upgrading DB2 to version 10.1 or 10.5:

To upgrade from DB2 9.5 or 9.7 to 10.1 or 10.5, you must make configuration
changes.

Procedure

1. Complete the steps in the following table that pertain to your version of
Sterling B2B Integrator before you proceed to step 2.

Important: Back up all files before you change any settings.

If you are upgrading from ... Do the following steps:

Sterling B2B Integrator 5.1.x Upgrade Sterling B2B Integrator to V5.2.6
and point to your DB2 9.5 or 9.7 database

Sterling B2B Integrator 5.2.x Upgrade your 5.2.x installation to V5.2.6

2. Copy your DB2 9.5 or 9.7 database content to DB2 10.1 or 10.5.
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3. Take a backup of the database driver located at /install_dir/dbjar/jdbc/DB2/
and then replace it with the DB2 10.1 or 10.5 version.

4. Update the following sandbox.cfg file fields with your environment-specific
parameters:
DB_PASS=
DB_SCHEMA_OWNER=
DB_DRIVERS_VERSION=
YANTRA_DB_PORT=
DB_DATA=
DB_HOST=
YANTRA_DB_USER=
DB_PORT=
YANTRA_DB_PASS=
YANTRA_DB_DATA=
YANTRA_DB_HOST=
DB_DRIVERS=
DB_USER=

DB2_PORT=
DB2_USER=
DB2_PASS=
DB2_DATA=
DB2_HOST=

5. Edit the following in the activemq.xml file:
activemq.xml: <value>jdbc:db2//DB_HOST:DB_PORT/DB_DATA</value>

6. Run the setupfiles script.
7. Run the deployer script.
8. Start Sterling B2B Integrator.

Information Gathering Checklist

Information Gathering Checklist for Upgrade (UNIX/Linux Non-Cluster): Before
you begin the upgrade, you should review the information in the Information
Gathering Checklist. The checklist contains all of the information that you will
need to have while running the upgrade scripts. Supporting information and
details are included at the end of this chapter.

The checklist contains:
v Brief descriptions for tasks (detailed procedures are provided after the checklist)
v Information you need to gather to prior the starting the upgrade

You may want to make a copy of the following checklist and use it to record the
information you collect.

# Information Gathering Checklist for Upgrade Your Notes

1
Review your IBM contract to determine what
software you have licensed. You need to know this
License Information so that you can select the correct
components/features to upgrade.

2 Determine which upgrade method you are going to
use:

v IBM Installation Manager (Graphical User
Interface)

v Silent Installation
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# Information Gathering Checklist for Upgrade Your Notes

3 Determine if you are going to run the pre-upgrade
checks during the upgrade.

4 Decide which type of security certificates you will
use:

v The default self-signed SSL (Secure Sockets Layer)
certificate that is automatically installed.

v A Certificate Authority-related certificate that you
install before installing the software.

5 If you are using an Oracle, Microsoft SQL Server, or
DB2 database, decide if you are going to manually
or automatically apply Database Definition
Language (DDL) Statements (schema) to the
database.

6 If you are using an Oracle 11.1 database, you must
set it up for native compilation by allocating space
and by setting the plsql_native_library_dir
parameter.

7 Determine if the database password needs to be
encrypted.

8 Record the Hostname on which you plan to install
the software.

9 Determine if you are going to use FIPS (Federal
Information Processing Standards) mode.

10 Record the Directory Name where you plan to install
the software.

11 Record the Login to host machine.

12 Record the Password to the host machine.

13 Record the path to the JDBC drivers.

14 Record the path to the installation wizard and file
name.

15 Record the path to JDK.

16 Record the path to JCE file.

17 Record the Host IP address.

18 Record the Initial Port Number.

19 Record the System passphase.

20 Record the Administrative e-mail address to which
system alert messages are sent.

21 Record the Database vendor name.

22 Record the Database user name.

23 Record the Database password.

24 Record the Database (catalog) name.

25 Record the Database host name.

26 For Oracle, Microsoft SQL Server, MySQL, or DB2,
record the Path and file name for the JDBC Driver.
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Supporting Information and Detailed Procedures:

Pre-Upgrade Checks: Pre-upgrade check reviews Oracle, SQL Server, and DB2
database environments prior to starting the upgrade. This is an optional
installation feature which looks for common upgrade errors. The pre-upgrade
checks ensure:
v SI_VERSION table exists
v Database character set is correct for Oracle and DB2
v Schedule start times are not later than the end times
v Passphrase entered matches the existing passphrase in the database
v Database implementation for Oracle Long Raw and BLOB
v User has permission to perform the upgrade
v Collation settings are validated for MS SQL
v OBJECT_NAME in table SCI_ENTITY is no longer than 100 characters
v Default schema you identified during upgrade matches the existing database

If any of these items are not validated, the upgrade fails. You are provided with an
error message and must correct the situations and then restart the upgrade.

License information:

A separate license is required for each Sterling B2B Integrator feature that you
purchased. During installation, you must choose the license files according to what
you purchased. Product licenses do not require an activation key.

IBM assumes customers will only install and use the products they purchased. IBM
reserves the right to inspect installs for compliance at any time.

After the installation finishes, if you determine that you need to modify licenses
files, see “License modifications” on page 58.

Product Licenses for Sterling B2B Integrator

Sterling B2B Integrator Standard and Enterprise Edition includes:
v MESA Studio
v eInvoicing
v Report Services
v all services and adapters not listed below

Sterling B2B Integrator Standard and Enterprise Financial Edition includes
everything listed above plus:
v CHIPS
v SWIFTNet
v NACHA ACH CTX adapter
v FEDWIRE
v Fin Serv XML standard
v FIPS Mode
v Image Cash Letter service
v EBICS
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Security certificates:

You can choose between different security certificates before you install Sterling
B2B Integrator.

Before you begin the installation, you must decide which of the following security
certificates to use:
v The default self-signed SSL (Secure Sockets Layer) certificate that is

automatically generated by the installation.
v A Certificate Authority-related certificate that you generate before you install the

software.

If you install with the default SSL certificate, but you later want to switch to a
CA-related certificate, you can change the certificate with the sslCert property in
the noapp.properties_platform_ifcresources_ext.in file.

UNIX accounts:

In a UNIX or Linux environment, create one UNIX administrative account on the
host server for all of the installations.

For example, if you want to create a test environment and a production
environment, create one UNIX account on the host server. For more information
about creating UNIX accounts, see your operating system documentation.

Port numbers:

During installation, you are prompted to specify the initial port number.

Use the following guidelines for port numbers:
v A range of 200 consecutive open ports (1025 - 65535) is required for this

installation.

Important: Because of RMI, on occasion, a port number outside the range can
be assigned.

v The initial port number represents the beginning port number in the range.
v Make sure that port numbers in the port range are not used by any other

applications on your system.

After your installation, refer to the /install_dir/install/properties/sandbox.cfg
file for all of the port assignments.

Database Definition Language (DDL) statements:

When you install Sterling B2B Integrator, you can manually apply Database
Definition Language (DDL) statements to your database tables instead of requiring
the installation process to do it directly.

This feature increases database security by reducing the database permissions of
the Sterling B2B Integrator database user. The rights to database objects can be
reserved for a secure user like a customer database administrator (DBA). A
business can require that only a DBA with the proper permissions can make
database changes.
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Upgrade the Software

General UNIX/Linux Upgrade Information:

CAUTION:
Sterling B2B Integrator should be installed behind a company firewall for
security purposes. See the Perimeter Server and Security topics in the Sterling
B2B Integrator documentation library for more information on secure
deployment options.

Use one of the following methods to upgrade your system:
v Upgrade using the IBM Installation Manager (Graphical User Interface)
v Upgrade using the Silent Installation

General Upgrade Guidelines

The following are some general guidelines:
v Do not create the new upgrade directory manually before the start of the

upgrade. If you create the installation directory before you begin, the upgrade
will fail. The directory name provided during the upgrade process is used to
create the new installation directory.

v The server on which you are installing must have adequate free disk space.
v If you are on Linux, do not use any soft/symbolic links in the path to the

installation package file.
v install_dir refers to the installation directory where the new software will be

installed. Do not use any pre-existing directory name or an old version of the
Sterling B2B Integrator installation directory. If you do, you could inadvertently
overwrite the existing installation.

v parent_install is the directory one level above the install_dir directory.
v Ensure that the parent_install directory has the proper read/write permissions.
v If you are using FTP to copy the files, verify that your session is set to binary

mode.
v If you are using AIX with the DB2 database, the directory path cannot be longer

than 108 bytes.
v The directory path to SI_<build_number>.jar cannot include any spaces.
v The installation creates subsequent ports based on the initial port number. For

all of the port assignments, see the /install_dir/install/properties/sandbox.cfg
file.

v If you are installing Sterling B2B Integrator on VMware, provide the IP address
of the virtual machine, not the IP address of the VMware host. For example, if
10.251.124.160 is the IP address of the VMware host and 10.251.124.156 is the IP
address of the Windows 2003 server it is hosting, you should use 10.251.124.156
as the correct IP address to install Sterling B2B Integrator.

v If you are running the upgrade on an active installation of Sterling B2B
Integrator, you will need to run the soft stop command to gracefully stop traffic.
For more information on performing a soft stop, see the Soft Stop
documentation in the System Administration Guide on the Sterling B2B
Integrator 5.2 Information Center.

General IBM Installation Manager information:

IBM Installation Manager V1.8.2 is required to install Sterling B2B Integrator on all
supported platforms.
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Installation Manager is a Java based multiplatform installation application and
provides a consistent approach across various platforms. It does not rely on
platform-specific installation technology or mechanism.

Installation Manager uses the local Sterling B2B Integrator offering repositories to
install or update Sterling B2B Integrator and its add-on features. It determines the
packages that must be installed and displays them including the products, fix
packs, and interim fixes. It checks that all prerequisites and interdependencies are
met before installing the selected product package and feature sets.

Important: The Uninstall option only unregisters Sterling B2B Integrator from
Installation Manager. The uninstall procedure as described in the related sections
must be performed to completely uninstall Sterling B2B Integrator.

Installation Manager must be installed on each computer on which Sterling B2B
Integrator is being installed. If you already have Installation Manager installed on
your computer for use with other IBM applications, it can be used with installing
Sterling B2B Integrator as long as it's the correct version. If you do not have
Installation Manager installed, it is provided as part of the Sterling B2B Integrator
installation media.

Supported bit-versions

A 64-bit version of IBM Installation Manager V 1.8.2 is provided with the Sterling
B2B Integrator installation package. However, you can also install with a 32-bit
version of Installation Manager.

Before you start the installation, consider the following options:
v If you are a new customer, use the version of Installation Manager that is

provided with the Sterling B2B Integrator installation package and install
Sterling B2B Integrator.

v If you have an earlier version of Installation Manager, you can update it to
V1.8.2 using the Installation Manager that is provided with the installation
package, then install Sterling B2B Integrator .

v If you are a current customer who did not use Installation Manager earlier,
install the version of Installation Manager that is provided with the installation
package, then upgrade your Sterling B2B Integrator installation.

v If you have a 32-bit Installation Manager installed, you must download the
32-bit Installation Manager V1.8.2 from Fix Central or IBM Passport Advantage,
upgrade it, then proceed with the installation of Sterling B2B Integrator. Ensure
you have the required libraries that support screen presentation of the text.

Checking for updates

To check for Installation Manager updates, select Search for Installation Manager
updates on the File > Preferences > Updates page. When the check box is
selected, Installation Manager searches for updates when any one of the following
pages are opened from the Installation Manager start page:
v Install Packages
v Modify Packages
v Update Packages

Installation Manager also searches for updates when you click the Check for Other
Versions, Fixes, and Extensions button on the Install Packages page.
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Starting Installation Manager

You should start the Installation Manager (and also install Sterling B2B Integrator)
as a non-administrator user.

How you start Installation Manager depends on whether you are using the
Installation Manager agent that is provided with Sterling B2B Integrator or if you
have an Installation Manager instance that is installed on your system. It also
depends on whether you have 32-bit or 64-bit Installation Manager.

Open a command prompt and do one of the following tasks to start the
Installation Manager in GUI mode:
v Go to the IM_<operating_system> directory and type ./userinst or userinst.exe

(Windows) for the following scenario:
– If you do not have Installation Manager installed and are using the

Installation Manager agent that is provided with the Sterling B2B Integrator
media.

– If you have a 64-bit Installation Manager installed.
– If you have Installation Manager installed on a platform that has only one

download available for Installation Manager. For example, AIX, Solaris, HP,
zLinux.

v Go to <installation directory>/Installation Manager/eclipse (for Windows
system, replace / with \) and type ./IBMIM or IBMIM.exe if you have 32-bit
Installation Manager installed on a Linux or Windows system.

For information on starting Installation Manager in command mode for silent
installation, see the Installing or updating with a response file.

For information on starting Installation Manager in command mode to record a
response file, see Recording a response file.

Additional heap memory parameters

The heap memory parameters specify the amount of memory Installation Manager
can use during the installation process. The heap memory pool sizes that are used
by Installation Manager are hardcoded defaults. If these defaults are not sufficient
for your environment, you can specify different values by adding parameters to
the Installation Managerconfig.ini file.

Important: These additional parameters are required only if you are experiencing
Out Of Memory errors during the installation process.

The following parameters can be added:
v memoryMin=user.sb.INSTALL_<OS>_INIT_HEAP.<amount_of_memory>

v memoryMax=user.sb.INSTALL_<OS>_MAX_HEAP.<amount_of_memory>

Where <OS> is your operating system and <amount_of_memory> is the specified
amount of memory.
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Operating
System Parameter Example Entry

Sun-Solaris Initial Heap Size

INSTALL_SUN_INIT_HEAP

memoryMin=user.sb.INSTALL_SUN_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_SUN_MAX_HEAP

memoryMax=user.sb.INSTALL_SUN_MAX_HEAP.3072m

Linux Initial Heap Size

INSTALL_LINUX_INIT_HEAP

memoryMin=user.sb.INSTALL_LINUX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_LINUX_MAX_HEAP

memoryMax=user.sb.INSTALL_LINUX_MAX_HEAP.3072m

AIX Initial Heap Size

INSTALL_AIX_INIT_HEAP

memoryMin=user.sb.INSTALL_AIX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_AIX_MAX_HEAP

memoryMax=user.sb.INSTALL_AIX_MAX_HEAP.3072m

HP-UX Initial Heap Size

INSTALL_HPUX_INIT_HEAP

memoryMin=user.sb.INSTALL_HPUX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_HPUX_MAX_HEAP

memoryMax=user.sb.INSTALL_HPUX_MAX_HEAP.3072m

Windows Initial Heap Size

INSTALL_WIN_INIT_HEAP

memoryMin=user.sb.INSTALL_WIN_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_WIN_MAX_HEAP

memoryMax=user.sb.INSTALL_WIN_MAX_HEAP.3072m

Guidelines for IPv6 addresses:

The use of IPv6 addresses in an installation of Sterling B2B Integrator requires
certain guidelines.

Before you use an IPv6 address during an installation, see the IPv6 Capabilities
section in System Requirements.

Consider the following IPv6 address information when you plan the installation:
v If you use an IPv6 address, use a fully qualified address that includes square

brackets around the address, and a zero (0) between colons where there are no
other numbers. For example, use [fe80:0:0:0:213:72ff:fe3c:21bf] instead of
fe80::213:72ff:fe3c:21bf.

v If you are installing with an IPv6 address, comment out the host name mapping
to the IPv4 address and retain the mapping to the IPv6 address in the host file
in the /etc/sysconfig/networking/profiles/default/hosts directory.

v You must install with a host name, not an IPv6 address, otherwise the
Lightweight JDBC adapter and Graphical Process Modeler (GPM) do not work.

v If you are using an Oracle database, do not use an IPv6 address for the host
name.
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v If you are using an IPv6 address and are going to configure Sterling B2B
Integrator as a dual stack host, after you complete the installation, you need to
add the IPv6 address (as the admin_host.3 property) to the
noapp.properties_platform_ifcresources_ext .in file.

Installing or updating with a response file (V5.2.6 or later):

You can install or update (apply fix pack or interim fix) Sterling B2B Integrator
with silent mode by using the sample response files or converting your existing
response file to the required format.

Upgrading in a UNIX/Linux non-cluster environment with the IBM Installation
Manager in GUI mode:

You can upgrade Sterling B2B Integrator in a UNIX/Linux non-cluster
environment with the IBM Installation Manager in a graphical user interface (GUI)
mode. Use the X Window System for this installation.

Before you begin

v Ensure that your system is ready for the upgrade. See “Prepare Your System for
the Upgrade” on page 332.
Attention: Failure to properly prepare your system can cause the upgrade to
fail.

v Complete the “Information Gathering Checklist for Upgrade (UNIX/Linux
Non-Cluster)” on page 536.

v Install an X Window windowing system (for example Cygwin or Xming) for
UNIX/Linux operating systems on your PC.

v Install and configure a Telnet client (for example PuTTY) for use with the X
Window System. The following parameters must be set:

– X-11 forwarding must be enabled.
– X display location must be set to localhost.

v If you are using the Standards Processing Engine (SPE) application with Sterling
B2B Integrator, you must upgrade SPE before you upgrade Sterling B2B
Integrator.

v If you are using the EBICS Banking Server application with Sterling B2B
Integrator, the data encryption for storage within the installation location is not
supported.

v Set the ulimit and language as follows:
– ulimit -n 4096
– ulimit -u 16000
– export LANG=en_US

About this task

This upgrade changes the administrative password to the default password. After
the upgrade, change the password back to the administrative password to
minimize security risks. This password is the Admin password for logging in to
the user interface (/dashboard or /ws).

Important: Following is a list of changes related to installing or upgrading to
Sterling B2B Integrator V5.2.6:
v You can install and upgrade through the user interface or silent installation

mode (response files). Console mode installation and upgrade is not supported.
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v Sterling B2B Integrator JAR file is included in the repository. Therefore it is not
required to manually select the JAR file when installing or upgrading.

v You must use Installation Manager V1.8.2 to install or upgrade Sterling B2B
Integrator. InstallService is disabled, and cannot be used. You can use
InstallService, only for a specific scenario related to Sterling File Gateway. For
more information, see step 14.

Procedure

1. Start the X Window System client on your PC.
Minimize the window after it opens.

2. Open a console window and log on to the UNIX/Linux host server where
Sterling B2B Integrator is upgraded.

3. From the installation media, copy the compressed update package to a
UNIX/Linux directory on the host where Sterling B2B Integrator is installed.

4. Decompress the upgrade package on the host server.
5. Open the InstallationManager folder in the directory structure that is created

when the installation package is decompressed. Several
IM_OperatingSystem.zip files are displayed.

6. decompress the file for your operating system.
v IM_AIX.zip (for AIX)
v IM_HPIA.zip (for HP-UX Itanium)
v IM_Linux.zip (for Linux)
v IM_LinuxPPC.zip (for Linux)
v IM_Solaris.zip (for Solaris)
v IM_Win.zip (for Solaris)
v IM_zLinux.zip (for Linux for System z)

This action creates a new IM_<OperatingSystem> folder.

Important: Installation Manager V1.8.2 is required to upgrade to Sterling B2B
Integrator V5.2.6. If Installation Manager was not used to install your current
Sterling B2B Integrator instance, the installation process installs the Installation
Manager when you start the upgrade to Sterling B2B Integrator V5.2.6. After
successful installation, restart the Installation Manager, and proceed with
upgrading to Sterling B2B Integrator V5.2.6.

7. Decompress the Common_Repo.zip from the installation package. The action
creates two new folders b2birepo and gmrepo. The IM_OperatingSystem,
b2birepo, and gmrepo folders must be at the same level in a directory.

Important: gmrepo contains the repository file required to install Global
Mailbox. For information about Global Mailbox, see Global Mailbox overview.

8. Open a command prompt and do one of the following tasks to start the
Installation Manager:
a. Go to the IM_<operating_system> directory and type ./userinst for the

following scenarios:
v If you do not have the Installation Manager installed and are using the

Installation Manager agent provided with V5.2.6.
v If you have a 64-bit Installation Manager installed.
v If you have the Installation Manager installed on a platform that has

only one download available for Installation Manager. For example, AIX,
Solaris, HP, zLinux.

Installing and upgrading (V5.2.6 or later) 545

http://www.ibm.com/support/knowledgecenter/SS3JSW_5.2.0/com.ibm.help.gdha_overview.doc/com.ibm.help.gdha_overview.doc/gdha_overview.html


b. Go to <installation directory>/Installation Manager/eclipse and type
./IBMIM, if you have 32-bit Installation Manager installed on your Linux
system.

9. On the Installation Manager home page, click Install.

Important: If IM_<operating_system> and b2birepo directories are not in the
same directory or if you already have Installation Manager installed, then you
get a message saying that there no packages to install or Installation Manager
could not connect to the repositories. You must add the Sterling B2B
Integrator repository files to the Installation Manager repository. For more
information about adding repository files, see Repository preferences.

10. On the Install Packages screen, select IBM Sterling B2B Integrator. This
action selects the versions also. Click Next.

11. Review the license agreement and select the option I accept the terms in the
license agreements to continue.
If you do not accept the agreement, the upgrade process is canceled.

12. Select a location for the Shared Resources directory and a location for the
Installation Manager:
a. Specify a Shared Resources Directory.
b. (Optional if previously installed) Specify an Installation Manager

Directory.

Important: The Shared Resources directory cannot be a subdirectory of the
Installation Manager installation.

The specified Shared Resources and Installation Manager directories must
be empty.

13. Choose Create a new package group and specify the path to Sterling B2B
Integrator installation directory.

14. Select the required features to upgrade. The available options are:
v IBM Sterling B2B Integrator

v IBM Sterling File Gateway

Important: If your current installation includes Sterling File Gateway, then
Sterling File Gateway is also updated to V 2.2.6 when upgrading to Sterling
B2B Integrator V5.2.6. If Sterling File Gateway was not installed, it is not
installed when upgrading to Sterling B2B Integrator V5.2.6, when you select
the IBM Sterling File Gateway option. In this case, to install Sterling File
Gateway when upgrading, you must do one of the following tasks:
– When upgrading Sterling B2B Integrator, if you are installing Sterling

B2B Integrator to a fresh directory, and pointing to the previous database,
then you can install Sterling File Gateway V2.2.6.

– Use InstallService to install Sterling File Gateway. For information
about installing Sterling File Gateway by using InstallService, see
Installing Sterling File Gateway (V2.2.6 or later).

v FIPS Module

v AS2 Edition Module

v Financial Services Module

v EBICS Banking Server Module

v B2B Advanced Communications Integration Module

546 Installing and upgrading (V5.2.6 or later):

https://www-01.ibm.com/support/knowledgecenter/SSDV2W_1.8.2/com.ibm.cic.agent.ui.doc/topics/t_specifying_repository_locations.html
http://www.ibm.com/support/knowledgecenter/SS4TGX_2.2.0/com.ibm.help.sfg_installation_226.doc/sfg_installation_overview.html


Important: When upgrading to Sterling B2B Integrator V5.2.6, select B2B
Advanced Communications Integration Module to install Sterling B2B
Integrator bridge. Sterling B2B Integrator bridge is required for
communication between Sterling B2B Integrator and B2B Advanced
Communications. If you are installing Global Mailbox and Sterling B2B
Integrator, then B2B Advanced Communications Integration Module
(Sterling B2B Integrator bridge) is installed by default, because Global Mailbox
uses the storage module of B2B Advanced Communications. However, you
must configure the adapter containers and adapters for Sterling B2B Integrator
bridge after upgrading.

Important:

Sterling B2B Integrator is selected by default. Select only the licenses and
features that were defined by your IBM contract. If you are unsure which to
select, the installation can proceed without a selection and complete
successfully. Startup and operation of the software, however, requires one of
the licenses to be selected. See “License modifications” on page 58 to apply
licenses after the installation.

Features that are not part of your current Sterling B2B Integrator installation
are disabled and you cannot select them when upgrading or applying a fix
pack. To include them in your Sterling B2B Integrator setup, you must first
upgrade to the current version, and then install them separately. If the fix
pack or upgrade JAR includes updates to features that are part of your current
Sterling B2B Integrator installation, the features are upgraded regardless of
whether you select the them or not.

Important: If you are upgrading from a previous V5.2.x release, you must
manually install the EBICS client. For more information about installing the
EBICS Client manually, see the EBICS Client User Guide.

15. Enter the full path to your JDK directory.
16. Specify the configuration for the features to upgrade and click Next.

v FIPS Compliance Mode (Must enable FIPS Module)

v NIST 800-131a Compliance Mode

– off (default value)
– strict

v SPE Integration Module (Requires pre-install of SPE, WTX optional)

If you select the SPE option, you are prompted for the following
information:
– SPE installation directory
– (Optional) WebSphere Transformation Extender (WTX) installation

directory
– SPE UI port
For more information, see the documentation for the integration of Sterling
B2B Integrator and SPE.

17. Enter the full path to your JCE jar file.
18. Enter your Installation panel properties information:

a. Enter the explicit IP address for the server or use the default value of
localhost.

b. Enter the Initial Port number or use the default value of 8080.
19. Enter your System Passphrase information:
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a. Enter a passphrase.
b. Confirm the passphrase.

20. Enter you E-Mail Information:
a. Enter the email address to which you want system alert messages sent.
b. Enter the SMTP mail server (IP address or host name) that you want to

use for system alert messages and other administrative notices.
21. Specify if you want to Enable FIPS (Federal Information Processing

Standards) mode. To enable FIPS, select the check box.
The default is FIPS mode is disabled.

22. Select the database vendor you want to use:
v Oracle
v Microsoft SQL Server
v DB2
v MySQL

23. Select all options that apply to this installation:

Choices: Action

This installation is for a cluster node 2
or higher (Not applicable for MySQL)

Do not select this option.

Apply database schema automatically?
(Not applicable for MySQL)

If yes, no action is required. The default is to
automatically apply the DDL statements.

If you want to manually create the database
schema, then clear the Apply database schema
automatically check box and continue with the
remaining installation steps.
Important: After the upgrade starts, it runs for a
short time and stops without error. When the
upgrade stops, you must perform additional
actions as given in Step 31 of this procedure.

24. Enter the Database Information.
v Database user name.
v Database password (and confirmation).
v Database catalog name.
v Database host name.
v Database port.
v (Oracle, Microsoft SQL Server, and MySQL only) Absolute path and file

name for one JDBC driver file.
v (DB2 only) Absolute paths and file names for two JDBC driver files. Use the

Type-4 JDBC driver. This type of driver converts JDBC calls into the
network protocol that is used directly by DB2, allowing a direct call from
the system to the DB2 server.

25. Click Add to browse to the file location for the appropriate JDBC driver.
26. Click Test next to the database driver path.

Important: The Installation Manager must successfully validate the connection
to the database before you can continue with the installation. If there is a
validation failure, you can view the system log to determine more information
about the failure.
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27. Determine what Other options apply to this installation. Select the applicable
options:
v Verbose install

v This installation is an upgrade from a prior version - Select this option.

Important: After you select the upgrade option, an additional option is
displayed.

v Would you like to run upgrade pre-check? - To run the pre-check, click
Test.

28. Specify the Performance configuration that applies to this installation. Select
the applicable options:
v Number of Processor Cores - Accept the default value or enter the

appropriate value.
v Physical Memory (MB) allocated to Sterling B2B Integrator - Accept

default value or enter the appropriate value.
29. Specify if you want to generate an installation response file:
30. Review the installation package summary information. Click Install to

continue.

Important: If you did not select the option to the Apply database schema
automatically field, the upgrade stops and you must perform these additional
steps to complete the upgrade with manual DDL statements:
a. Open your installation directory.
b. Locate the InstallSI.log file and open it with a file editor.
c. Search the file for these error messages:
v <SI_Install>/repository/scripts/EFrame_IndexAdds.sql must be

applied to the database.

v <SI_Install>/repository/scripts/EFrame_Sequence.sql must be
applied to the database.

v <SI_Install>/repository/scripts/EFrame_TableChanges.sql must be
applied to the database. Exiting installation..."

Important: If you do not find these error messages in the log file, the
installation failed because of another reason and you must resolve that
error and attempt the installation again. If you did find these messages,
continue with the remaining steps.

d. Edit each .sql script to make changes appropriate for your database.
These changes might include changing the SQL delimiter or adding
tablespace options.

e. Log in to your database as the DB schema user.
f. Run the SQL files manually in this order:

Important: When you are running the scripts, it is important to run the
SQL scripts in the specified order.
1) EFrame_IndexDrops.sql

2) EFrame_TableChanges.sql

3) EFrame_IndexAdds.sql

4) EFrame_TextIndexAdds.sql

5) EFrame_Sequence.sql

6) EFrame_TextIndexModify.sql
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7) EFrame_TextIndexUpdates.sql

8) EFrame_TextIndexUpgrade.sql

9) EFrame_Static.sql

Important: ActiveMQ uses dynamically generated table names based on
the name of the installation node. Table generation is not included in these
scripts, but is performed automatically during the initial start of Sterling
B2B Integrator or when a new cluster node is added. Table generation
might fail if security restrictions reduced the Sterling B2B Integrator
database user permissions. To avoid this issue, ensure that the DBADM
role permissions are enabled during the initial startup. If further issues
arise, contact IBM customer support for guidance.

g. Exit from the database.
h. Open the parent directory of the install_dir directory.
i. Unisntall the Sterling B2B Integrator offering to clear out the Installation

Manager metadata about the installation, and the delete (or rename as a
backup) the Sterling B2B Integrator installation directory.

j. Restart the installation wizard and provide the same installation options
that you provided before you cleared the Apply database schema
automatically check box. If you have recorded a response file (as suggested
in step 9), you can use the response file to install Sterling B2B Integrator.

The Installation Progress screen indicates which component of the installation
is in process.
A status bar below the Repository Information heading displays the progress
of component installation. When the installation completes, a large green circle
with a check mark displays with the message The packages are installed. A
link is provided to view the installation log file.
The installation completes automatically. When the installation is finished, the
system displays a dialog box with the message The install completed
successfully.

Installation information is in the InstallSI.log file.
31. Click Finish. The Installation Manager closes.

Check the InstallSI.log to verify all of the components were installed
properly.

32. Determine whether you need to apply a fix pack or interim fix to the
installation. For information about fix pack or interim fix installation, see
“Applying a Fix Pack (V5.2.6 or later)” on page 625 and “Applying an interim
fix (V5.2.6 or later)” on page 635.

Validate the Upgrade

Validate the Upgrade Checklist: As part of the upgrade, you need to run the
following tests to ensure that the software upgrade was successful. Complete the
following tasks:

Number Validate Installation Task Completed

1 Start Sterling B2B Integrator.

2 Access Sterling B2B Integrator.

3 Validate the Installation.

4 Stop Sterling B2B Integrator.
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Starting Sterling B2B Integrator in a UNIX/Linux noncluster environment:

After you run the upgrade software, you can start Sterling B2B Integrator.

Before you begin

If you are starting Sterling B2B Integrator after upgrading the application from
version 5.1.0.4 to 5.2.5, change the values of the following properties in the
centralops.properties file to 600. This action prevents the run.sh command from
timing out before Sterling B2B Integrator starts. The centralops.properties file is
in the install_dir/install/properties directory.
v OpsServer.commandTimeout

v PassPhrase.urlTimeout

Procedure

1. Open the /install_dir/install/bin directory.
2. Enter ./run.sh.
3. Enter your passphrase. The final startup processes run, concluding with the

following message:
Open your Web browser to http://host:port/dashboard

Where host:port is the IP address and port number where Sterling B2B
Integrator is located on your system. Depending on system load, it might take
several minutes for the UI to be ready.

4. Record the URL address so that you can access Sterling B2B Integrator.

Accessing Sterling B2B Integrator:

You can access Sterling B2B Integrator through a web browser.

Procedure

1. Open a browser window and enter the address that is displayed at the end of
the start.

2. On the login page, enter the default user ID and password. The default login is
at an administrative level. One of your first tasks as an administrator is to
change the administrative password and to register other users with other
levels of permission.

Validating the installation with a sample business process:

You can validate the installation by testing a sample business process.

Procedure

1. From the Administration Menu, click Business Process > Manager.
2. In the Process Name field, type Validation_Sample_BPML and click Go!

3. Click execution manager.
4. Click execute.
5. Click Go! The Status: Success message is displayed on the upper left side of

the page.

Stop Sterling B2B Integrator (Hard Stop):
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About this task

A hard stop halts the system without waiting for business processes to finish. Hard
stops may result in loss of data in unfinished processes.

To run a hard stop:

Procedure

1. Navigate to /install_dir/install/bin.
2. Enter ./hardstop.sh.
3. Enter your passphrase.

Stopping Sterling B2B Integrator (Soft Stop):

A soft stop of Sterling B2B Integrator halts the system after all the business
processes finish running.

About this task

v In the user interface, click Operations > System > Troubleshooterand then click
Soft Stop.

v You can soft stop Sterling B2B Integrator from the command-line interface.

For more information about the softstop user interface and command line options,
see the performance management documentation.

Procedure

1. To soft stop from the command-line interface, navigate to the
/install_dir/install/bin directory.

2. Enter the following command:
./softstop.sh

3. Enter your passphrase.

Post Upgrade Configuration

Post upgrade configuration checklist:

After the upgrade software finishes running, you must perform some post upgrade
procedures.

Review all of the procedures in the checklist. Some procedures may not be
required.

Task number Task Your notes

1 Upon upgrade, all default user accounts are reset to
their default value. For security purposes, the system
administrator should update all default user account
passwords immediately after upgrade is completed. See
“Changing default user account passwords” on page 40.

2 “Determine if You Need to Apply a Fix Pack in
UNIX/Linux Environment” on page 555

3 “Disable Services” on page 366

4 “Download of the Sterling B2B Integrator tools” on page
43
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Task number Task Your notes

5 “Changes to Network Interface Bindings” on page 492

6 “Enable Business Processes” on page 367

7 “Property files configuration in a UNIX environment”
on page 183

8 “Add cdinterop Files” on page 367

9 “Updating the sandbox.cfg file with a new JCE file” on
page 494

10 “Review the EDI Sequence Check Queue” on page 368

11 “Configure Document File Systems” on page 369

12 “Add Third-Party Libraries” on page 368

13 “Configure Services and Adapters” on page 369

14 “Configure JDBC Adapter and Lightweight JDBC
Adapter” on page 369

15 “Configure File System Adapter and Command Line2
Adapters” on page 370

16 “Configure Odette FTP Adapter” on page 370

17 “Add Advanced File Transfer Tab” on page 373

18 “Restore Performance Tuning Configuration” on page
373

19 “Reconfigure Archive Settings” on page 373

20 “Correct Missing Manager IDs” on page 374

21 “Configure JVM Containers” on page 378

Changing default user account passwords:

When you install Sterling B2B Integrator, several default user accounts are
automatically created to get you started. One of the first actions you must take
after installation is to update these accounts with unique passwords, because the
default ones can be known by all Sterling B2B Integrator customers.

About this task

Default user account passwords are preset at installation. For security purposes,
the system administrator should update all default user account passwords
immediately after installation is completed.

Default user accounts are listed below in the same order as they appear in the UI
under Accounts > User Accounts > List All. You can use this table to track the
user accounts you want to update.

User Account Name Update password

MBX_daemon

admin (*)

aft_user (*)

anon

as2_user
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User Account Name Update password

commandlineuser

dash_oper (*)

dash_part (*)

dash_prtspon (*)

dash_sponsor (*)

fg_architect

fg_operator

fg_provisioner

fg_sysadmin (*)

gmbx_user

ja_turbine

jane

jane_doe

joe_employee

joe_manager

joe_supplier

john

sd_buyer

sd_supplier

turbine

ws_buyer

ws_director

ws_employee

ws_finance

ws_hr

ws_manager

ws_purchaser

ws_supplier

(*) denotes a super user

To change the password for a user account, perform the following tasks.

Procedure

1. Log into Sterling B2B Integrator using ID = admin and password = password.
2. Go to Accounts > User Accounts. Under the List section click Go! All default

user account names are listed.
3. Click Edit next to the user account name you want to update the password for.
4. In the New Password and Confirm New Password fields, enter a new, secure

password for this User ID.

Note: Passwords must be at least six characters long.
5. Click Save and Finish.
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What to do next

Repeat steps 3 - 5 for all user account names you want to update.

Determine if You Need to Apply a Fix Pack in UNIX/Linux Environment:

Fix packs contain cumulative fixes for a specific version of Sterling B2B Integrator.
Fix packs are available from the IBM Fix Central web site.

About this task

Because each fix pack contains the fixes from previous fix packs, you only need to
install the most recent fix pack.

Information about a fix pack is located in a PDF file with a similar name.

Before you install the fix pack, review the following items:
v Preserve your custom changes to system resources.
v The fix pack installation may use one or more property override files. These files

will be named propertyFile_patch.properties. Do not alter these files.
v Property changes made directly in *.properties or *.properties.in files may be

overwritten when applying the fix pack. Properties overridden using the
customer_overrides.properties file are not affected. IBM recommends that you
maintain property file changes using (when possible) the
customer_overrides.properties file. For more information about this file, refer to
the property file documentation.

v If you edited any of the cdinterop files, you must back them up before applying
the fix pack. The cdinterop files do not have initialization ( *.in ) files. After
applying the fix pack, use the backup version of the files in your upgraded
installation. These files include the following files: cdinterop-proxy-
records.properties; cdinterop-spoe-auth.properties; cdinterop-spoe-
policy.properties; and cdinterop-user-records.properties.

v Information about the fix pack installation is automatically logged to
/install_dir/install/logs/InstallService.log.

v If you would need to roll back a fix pack, see the Fix Pack Changes Report.
v When installing a fix pack, the dbVerify utility compares the list of standard

indexes with those present in the database and drops the custom indexes. You
should recreate the custom indexes after the installation is complete.

Disable Services:
About this task

The upgrade process enables services that might have been disabled before the
upgrade. If you want to disable these services again, you must disable them in
after the upgrade process.

Download of the Sterling B2B Integrator tools:

After you install Sterling B2B Integrator, you can install tools like the Map Editor
and the Graphical Process Modeler (GPM).

Sterling B2B Integrator includes tools that run on a desktop or personal computer.
After you install Sterling B2B Integrator, you can install the following tools:
v Map Editor and associated standards
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Note: The Map Editor requires a 32-bit JDK. This JDK is not provided with the
product download or media. For more information, see System Requirements.

v Graphical Process Modeler (GPM)
v Web Template Designer
v (If licensed) MESA Developer Studio plug-ins, including MESA Developer

Studio Software Development Kit (SDK) and MESA Developer Studio Skin
Editor

v (If licensed) Reporting Services, which require MESA Developer Studio if you
want to use the plug-ins to create fact models and custom reports

Attention: Conflicting IP addresses can cause problems when you download a
desktop tool.

Changes to Network Interface Bindings: To increase the security of the
Administrator Console User Interface, the system only binds to specific network
interfaces. After installing, if the URL returns the error message Page cannot be
displayed, you can adjust property settings to correct the problem.

Update Property File for Network Interface Binding Changes:
About this task

On the server where the system resides, edit the
noapp.properties_platform_ifcresources_ext.in file.

Procedure

1. Locate the admin_host parameter. The default settings are: hostname1 is the
name of primary network interface, the one given highest priority by the
system. localhost is the name of the network interface on the server where the
system resides. Default entries: admin_host.1 = hostname1 and admin_host.2 =
localhost

2. Correct the parameters as necessary.
3. If no interface is being displayed, edit hostname1 so that it correctly identifies

the primary network interface that accesses the system.
4. If an additional network interface needs to access the system, add an additional

admin_host entries. For example: admin_host.3 = hostname2
5. Stop Sterling B2B Integrator.
6. Navigate to the install_dir.
7. Navigate to the bin directory.
8. Run the setupfiles.sh (UNIX) or setup.cmd (Windows).
9. Start Sterling B2B Integrator.

Update Dashboard for Network Interface Binding Changes:
About this task

For the Dashboard user interface, the system provides unrestricted binding to
network interfaces through the perimeter server. To restrict access to the Dashboard
user interface, you can adjust property settings so that only one network interface
accesses the system.

On the server where the system resides, edit the perimeter.properties.in file.
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Procedure

1. Locate the localmode.interface parameter. The default setting is unrestricted.
Unrestricted Setting (Default) localmode.interface=*

2. To restrict access to the Dashboard, enter the network interface that you want
to support. Restricted Setting localmode.interface=hostname1

3. Stop Sterling B2B Integrator.
4. Navigate to the install_dir.
5. Navigate to the bin directory.
6. Run the setupfiles.sh (UNIX) or setup.cmd (Windows).
7. Start Sterling B2B Integrator.

Enable Business Processes:
About this task

During the upgrade process, your customized business processes are preserved,
but they may not be the default business process. Review the business processes
and enable the customized versions.

Property files configuration in a UNIX environment: Property files contain
properties that control the operation of Sterling B2B Integrator. For example, the
REINIT_DB property in the sandbox.cfg file controls whether or not a database is
initialized when you install Sterling B2B Integrator.

By modifying the values of these properties, you can customize Sterling B2B
Integrator to suit your business and technical needs. Most property files are in the:
v For UNIX, /install_dir/install/properties directory
v For Windows, \install_dir\install\properties directory

After installing Sterling B2B Integrator, most property files and scripts do not need
any further configuration for basic operation. However, if you want to customize
any specific operations, for example setting a different logging level - you will
need to edit ( or in some cases, create) certain property or .xml files.

Before changing any property files, refer to Working with Property Files
documentation for general information about how to work with Property Files.

Areas where you might need to make specific property files changes after an
installation include:
v LDAP user authentication
v Prevention of cross-site script vulnerabilities
v Logging configuration
v Process-specific property file settings

Add cdinterop Files:
About this task

During the upgrade, the cdinteropt files were replaced. Copy the customized
version into the upgrade.
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Updating the sandbox.cfg file with a new JCE file:

If you upgrade from Sterling B2B Integrator release 5.2.4.2 to 5.2.5 and you change
the JDK from Sun to IBM, you must manually update the Java Cryptography
Extension (JCE) policy file information in the sandbox.cfg file.

Procedure

1. Open the install_dir/install/properties directory.
2. Open the sandbox.cfg file.
3. Change the JCE_DIST_FILE property to the path to the JCE file that you

specified during the upgrade.
4. Save and close the sandbox.cfg file.
5. Open the install_dir/install/bin directory.
6. Enter the setupfile.sh command to update your installation with the new

JCE_DIST_FILE property value.

Review the EDI Sequence Check Queue:
About this task

The EDI Sequence Check Queue is used for X12 and EDIFACT sequence and
duplicate checking. You can check the contents of the queue through the UI
(Trading Partner > Document Envelopes > EDI Sequence Check Queue). Any
interchanges that are in the queue will not be able to be processed after upgrade
because the EDI compliance report serialized format has changed.

The EDI Post Processor displays the following error:
The compliance report for interchange <interchange document ID> could not be
deserialized because the format has changed. The entry for this interchange
should be manually removed from the EDI Sequence Check Queue through the UI,
and the inbound deenvelope workflow should be rerun (WF ID <wfid>).

If you receive this error, you should follow the instructions in the error message to
correct the situation.

Configure Document File Systems:
About this task

If you use a File System as your document storage method, determine and record
the path to the File System.

You will need the File System path structure so that after the upgrade, you can
copy/mount the documents to the new installation directory. The directory
structure (path to the File System) must be the same in the current and in the
upgraded system.

Add Third-Party Libraries:
About this task

If you added third-party libraries to configure adapters for the previous release,
you need to add each of the libraries again after you complete the upgrade. See the
documentation for each third party adapter you use.

Configure Services and Adapters:
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About this task

You may need to reconfigure services and adapters after an upgrade. During an
upgrade, packages for services and adapters are reprocessed to update the service
configurations.

After an upgrade, the configurations of default adapters and services are re-set to
their default configurations. This includes directory paths, which are restored to
their default paths. You need to reconfigure those adapters and services, which
include, but are not limited to:
v All default FTP adapters
v All default SFTP adapters
v Connect:Enterprise UNIX Server Adapter
v OdetteFTP Adapter
v SAP Suite Adapter
v SWIFTNet Client Service
v SWIFTNet Server Adapter

If you modified the standard configuration for a service or adapter, you may need
to reconfigure or reactivate the service or adapter following an upgrade. You may
also need to reconfigure adapters that used directories or scripts in the installation
directory of your previous release.

Examples of services and adapters that commonly need to be reconfigured
following an upgrade include:
v FTP adapter
v System services such as the Alert service and the BP Fault Log adapter

The following adapters need special consideration following an upgrade:
v JDBC Adapter and Lightweight JDBC Adapter
v File System Adapter and Command Line2 Adapters
v Odette FTP Adapter

Configure JDBC Adapter and Lightweight JDBC Adapter:
About this task

Storage locations of the database pool properties that allow the JDBC adapter and
the Lightweight JDBC adapter to communicate with your external database have
been streamlined. The poolManager.properties file has been eliminated and some
of its pool properties are now included in the jdbc.properties file, along with some
new properties. You will need to manually update your existing
jdbc_customer.properties.in file to add some new database pool properties. If you
do not have a jdbc_customer.properties.in file, create one since customer.properties
are not affected by product updates.

Configure File System Adapter and Command Line2 Adapters:
About this task

You must configure your File System and Command Line2 adapters before you
remove the previous release directory. Reconfigure any File System and Command
Line2 adapters that were configured to use directories or scripts in the installation
directory for the previous release. Ensure that you create new directories and save
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scripts outside of the current installation directory and edit each configuration to
use the appropriate directories and scripts.

Consider the following:
v If you are using the Command Line2 adapter and have located the

CLA2Client.jar file anywhere other than the default location, you must replace it
with the new version. For information about the default location and how to
start the Command Line2 adapter, see the Command Line2 adapter.

v If you are upgrading to this version of Sterling B2B Integrator from a version
lower than 4.0.1 and are using the Command Line2 adapter, you must update
the version of the CLA2Client.jar file with the CLA2Client.jar located in the
/install_dir/install/client/cmdline2 UNIX directory or in the
\install_dir\install\client\cmdline2 for Windows. If you installed the
CLA2Client.jar file anywhere other than the default location, you must replace
each copy of the file with the new version. If you only installed it in the default
location, the update occurs automatically during the upgrade process.

v If you are upgrading to this version of Sterling B2B Integrator from a version
prior to 4.0 and are using the Command Line adapter, you must update the
version of the CLAClient.jar file with the CLA2Client.jar located in the
/install_dir/install/client/cmdline2 UNIX directory or in the
\install_dir\install\client\cmdline2 for Windows. If you installed the
CLAClient.jar file anywhere other than the default location, you must replace
each copy of the file with the new version. If you only installed it in the default
location, the update occurs automatically during the upgrade process.

The CLA instances are now pointing to the CLA2 Service definition. After
importing old service instances of CLA onto Sterling B2B Integrator, you need to
reconfigure the imported CLA services to re-set the Remote Name and Remote
Port service configuration parameters. For more information, refer to the
documentation for the Command Line Adapter and Command Line2 Adapter.

Configure Odette FTP Adapter:
About this task

If you use the Odette FTP Adapter and are using the Partner Profile XML file
version 2.00 used in Sterling Gentran Integration Suite 4.3, you must modify it to
match the new Partner Profile version 3.00. To modify the XML file, refer to the
following table:

Section Name of Structure or Field Action Comment

Partner Profiles <GeneralParameters>

<PartnerProfileVersion>3.00

</PartnerProfileVersion>

</GeneralParameters>

Use correct version label of the
Partner Profile.

New Version
label: 3.00

Physical Partner Description Add field and description
content

Mandatory in
OFTP Partner
database

Physical Partner SubMailbox Add field, if used. Optional
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Section Name of Structure or Field Action Comment

Physical Partner <AuthenticationCertificate

type =”...”>

<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial> Bignumber_string

</Subject>

</AuthenticationCertificate>

Add Structure, if used. OFTP 2.0:
Mandatory for
security only.
Structure may
be repeated.

Physical Partner <AuthenticationCertificate

type =”Private Key”>

<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial>Bignumber_string

</Subject>

</AuthenticationCertificate>

Add Stucture, if used. OFTP 2.0:
Mandatory for
security only.

Physical
Partner/ CAPI

DWindowSize Delete field

Physical
Partner/ IP

IPFilter Uses IPv4 or
IPv6 addresses.

Physical Partner
IP

SSL Add field, if used. OFTP 2.0:
Mandatory for
security only.

Physical Partner
IP

CipherStrength Add field, if used. OFTP 2.0:
Mandatory for
security only.

Physical Partner
IP

<SSLCertificate

type =”...”>

<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial> Bignumber_string

</Subject>

</SSLCertificate>

Add structure, if used. OFTP 2.0:
Mandatory for
security, only.
Structure may
be repeated.

Physical Partner
Contract

Description Add field and description
content.

Mandatory in
OFTP Partner
database.

Physical Partner
Contract

MultipleLoginSessions Now used.

Physical Partner
Contract

DuplicateFilePeriod Rename

DuplicateFileProcessingTestings

To DuplicateFilePeriod

Physical Partner
Contract

SessionLogLevel Add fields. Optional

Physical Partner
Contract

GroupNameList Add fields, if used. Optional
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Section Name of Structure or Field Action Comment

Physical Partner
Contract

SecureAuthentication Add fields. OFTP 2.0:
Mandatory

Physical Partner
Contract

<TimeScheduleTable>

...

<TimeScheduleTable>

Delete structure and create
schedules in the Scheduler.

Initiator
Business
Process and
Business
Process user
fields are still
used.

Physical Partner
Contract

OdetteFTPAPILevel Rename OdetteAPILevel to
OdetteFTPAPILevel

Logical Partner Description Add field and description
content.

Mandatory in
OFTP Partner
database.

Logical Partner <FileServiceCertificate

type =”...”>
<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial>string</Subject>

</FileServiceCertificate>

Add structure, if used. OFTP 2.0:
Mandatory for
security, only.
Structure may
be repeated.

Logical Partner
Contract

Description Add field and description
content.

Mandatory in
OFTP Partner
database.

Logical Partner
Contract

FileTransmissionRetries Rename FileTransmitRetries to
FileTransmissionRetries

Logical Partner
Contract

SignedEERPRequest Add field, if used.

Logical Partner
Contract

EERP/NERPSignatureCheck Add field, if used.

Logical Partner
Contract

File Signing Add field, if used.

Logical Partner
Contract

File Encryption Add field, if used.

Logical Partner
Contract

CipherSuite Add field, if used.

Logical Partner
Contract

File Compression Add field, if used.

Logical Partner
Contract

CharEncoding Add field, if used.

Logical Partner
Contract

Receive VitualFilenamePattern Add field, if used.

Logical Partner
Contract

EERPTimeout Rename WaitForEERP to
EERPTimeout

Logical Partner
Contract

FileScheduleTimeout Add field, if used.

Logical Partner
Contract

InboundBusinessProcess Add field, if used. Optional

Logical Partner
Contract

InboundBusinessProcessUser Add field, if used. Optional, if no
Inbound
business
process is
specified.
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After changing the Partner Profile for version 3.00, import the Partner Profile into
the new Odette FTP Partner Profile database. For additional information, see
Odette FTP Partner Profile.

Add Advanced File Transfer Tab:
About this task

The Advanced File Transfer tab will not be enabled by default after an upgrade. If
you have a license for Advanced File Transfer, perform the following steps to add
the Advanced File Transfer tab:

Procedure

1. Log in as Admin.
2. Click Manage Layout.
3. Click Add Pane.
4. Enter the following name: Advanced File Transfer
5. Click Apply.
6. Click the customize icon for the new Advanced File Transfer tab.
7. Click Add Portlet.
8. Select the Add box for Advanced File Transfer Management.
9. Click Apply.

10. Select Clear Borders and Title from the Decoration menu.
11. Click Save and Apply.

Restore Performance Tuning Configuration:
About this task

Before you begin this procedure, you need to add the Advanced File Transfer Tab.

To restore the performance tuning configuration:

Procedure

1. From the Administration Menu, select Operations > System > Performance >
Tuning.

2. Next to Edit Performance Configuration, click Go!

3. Click Edit settings.

Reconfigure Archive Settings:
About this task

The upgrade does not automatically reconfigure the archive configuration. You
must reconfigure the Backup Directory setting in Archive Manager after an
upgrade.

To reconfigure your Archive settings, use the following procedure:

Procedure

1. From the Administration Menu, select Operations > Archive Manager.
2. Next to Configure Archive Settings, click Go!

3. If a message displays about the UI Lock, click OK to continue.
4. Click Next.
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5. Update the Backup Directory field with the correct path information:
6. Click Save.
7. Confirm the settings and click Finish.

Correct Missing Manager IDs:
About this task

If you created a Manager ID with no corresponding User ID in your previous
version, the Manager ID may be missing after upgrading. If this occurs, create a
user in the system with a User ID that matches the missing Manager ID.

Configure JVM Containers:
About this task

After you have upgraded the system, you will need to reconfigure the JVM
containers.

Before you reconfigure the JVM containers, you need to know the container
numbers from the previous installation.

For example, if you configured the container using the command,
setupContainer.sh (or cmd) 1, then the container number is 1.

Use one of the following tasks to reconfigure your containers:
v Set Up Adapter Container - iSeries

v Set Up Adapter Container - UNIX/Linux

v Set Up Adapter Container - Windows

System Maintenance
From time to time, you may need to perform system maintenance activities. These
activities might include any or all of the following:
v Performing a checksum
v Modifying the license files

DB Checksum tool:

A checksum is a simple redundancy check used to detect errors in data.

In Sterling B2B Integrator, a verification process compares the checksum between
the existing default resource and the resource that was added after applying a fix
pack or upgrading. The DB Checksum tool, a resource difference tool generates a
granular report of the changes in the system that was not permitted to be set as
defaults.

The DB Checksum tool generates the difference in resource checksum between the
default resource and the latest system resource from the database.

Performing a checksum:

Use a command to run the DB Checksum tool.
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Procedure

To run the DB Checksum tool:
1. Open the /install_dir/install/bin directory.
2. Enter the following command:

./db_checksum_tool.sh [-d] [-i [1 | 2 | 3 | 4 | 5]]
[-r [wfd | map | schema | sii | template]] [-o <output file>] [-g]

Where:
v -d is the mode to dump the difference of resource checksum between the

default resource and latest system resource.
v -i is the resource type integer (optional).
v 1 is WFD.
v 2 is MAP.
v 3 is SCHEMA.
v 4 is SII.
v 5 is TEMPLATE.
v -r is the resource name (optional). For example, wfd, map, schema, sii, or

template.
v -o is the file name to output all the messages (optional).
v -g is the file name that lists all the ignored resources (optional).
v -h is the help screen.

The DB Checksum tool performs the relevant checksum operation that is based
on the command options and generates the output message.

License modifications:

After the installation finishes, you can modify the software licenses that you
loaded with the AddLicenseSet command.

The AddLicenseSet command is in the bin directory of your UNIX or Windows
installation. After the initial installation, the license files are in the following
directories:
v UNIX - /install_dir/install/properties/licensefiles
v Windows - \install_dir\install\properties\licensefiles
v iSeries - /install_dir/properties/licensefiles

You can add licenses or review the license list from the UI. On the Administration
Menu, click System > B2B Console > Operations > System > Licenses.

AddLicenseSet Command Parameters

Use the AddLicenseSet command to modify a single license file or the entire license
file directory.

To use the AddLicenseSet command, you must do the following:
v Open the bin directory
v Include the absolute path to the license file directory or to a license file

The AddLicenseSet command has the following parameters:
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AddLicenseSet Parameter Description

-reload Use this parameter to reload the license files.

This parameter deletes all of the license files from the
database before the new files are loaded. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/
old_licenses

v Windows - \install_dir\install\logs\security\
old_licenses

v iSeries - /install_dir/logs/security/old_licenses

-upgrade Use this parameter during an upgrade only.

This parameter deletes all of the old license files from the
database and installs the new license files. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/upgrade

v Windows -\install_dir\install\logs\security\upgrade

v iSeries -/install_dir/logs/security/old_licenses

The AddLicenseSet command will check if Sterling B2B Integrator is running. If it
is running, the command will call the Ops server to refresh the license from the
database. If you have any problems with your licenses after running the
AddLicenseSet command, stop and restart Sterling B2B Integrator.

License Modification: Examples:

There are several different ways you can use the AddLicenseSet command to
modify your licenses.

UNIX Examples

From the install_dir/bin directory:

Scenario Command usage (UNIX example)

Reload a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -reload

Reload all of the license files
in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -reload

Upgrade a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -upgrade

Windows Examples

From the install_dir\bin directory:

Scenario Command usage (Windows example)

Reload a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -reload
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Scenario Command usage (Windows example)

Reload all of the license files
in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -reload

Upgrade a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -upgrade

Uninstall Sterling B2B Integrator
Before you begin

If you have installed Sterling B2B Integrator software using IIM, then perform
these steps to unregister Sterling B2B Integrator packages from the IIM registry:
v Launch IIM.
v Click Uninstall and select the required Sterling B2B Integrator package (Media,

FixPack, or Interim Fix).
v Confirm and click Uninstall.

About this task

To uninstall Sterling B2B Integrator from a UNIX or Linux environment:

Procedure
1. Stop Sterling B2B Integrator and wait for shutdown to complete. If you begin

removing files before all business processes and Sterling B2B Integrator are
stopped, you may be unable to remove Sterling B2B Integrator successfully.

2. Back up the file system and database.
This step is optional. However, by backing up the file system and database,
you are ensured that Sterling B2B Integrator is completely recoverable.

3. Remove the installation directory by entering the following command in the
parent directory of your installation directory: rm -rf install_dir

4. If you use an Oracle, Microsoft SQL Server, or DB2 database, these remain
intact even after you remove the Sterling B2B Integrator from the server. If you
no longer want to reference the data, contact your database administrator about
removing unwanted tables and recovering the database space where Sterling
B2B Integrator used to reside.

5. Manually remove the JDK:
a. Navigate into the _uninst subdirectory of your JDK installation directory
b. Enter ./uninstall.sh

6. After you remove Sterling B2B Integrator from the server, you can remove
Eclipse, and any tools that were downloaded to the desktop, including the
following:
v Map Editor and associated standards

Refer to the Map Editor Guide for information about removing the Map
Editor.

v Graphical Process Modeler
Refer to the Graphical Process Modeler Guide for information about removing
the Graphical Process Modeler.

v Web Template Designer
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Refer to the Web Extensions Guide for information about removing the Web
Template Designer.

v (If licensed) MESA Developer Studio plug-ins, including:
– MESA Developer Studio Software Development Kit (SDK)
– MESA Developer Studio Skin Editor
Refer to the MESA Developer Studio guide for information about removing
MESA Developer Studio.

v (If licensed) Reporting Services, which requires MESA Developer Studio if
you want to use the plug-ins to create fact models and custom reports.
Refer to the MESA Developer Studio guide for information about removing
Reporting Services.

User Documentation
The user documentation is available from an online documentation site on the
web.

Providing the documentation in an online environment allows for frequent updates
of content that is based on user feedback and usability.

If you need a printed copy of the documentation, you can print topics of
information through your Internet browser, or you can download documents in
PDF format, after you add it to a collection on IBM Knowledge Center.

To access the documentation site from within Sterling B2B Integrator or one of its

tools, select the help 
 

icon. The system must reside on a computer that supports
Internet access and an Internet browser.

Improving your access to online documentation:

You can improve your access to online documentation by using several methods.

About this task

After you access the IBM Knowledge Center, you can perform the following tasks:
v Enter a word or phrase and search the entire library for information.
v Move through a hierarchy of contents pages to identify the topic you want to

read or print.
v Print topics by using your browser's Print function.
v Add documents to your collection and download them in PDF format.

Troubleshooting Tips: UNIX/Linux Non-Cluster Environment

Situation Message or Symptom Explanation/Resolution

Installing You encounter errors
or problems during
installation.

Explanation

The installation creates several log files that you can use to
diagnose problems like the failure of an installation.

Resolution

Examine the log files generated during installation:

v ant.install.log (in the install_dir directory)

v install_dir/PreInstallSI.log
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Situation Message or Symptom Explanation/Resolution

Installing When you entered an
absolute path during
installation, a message
indicated that the
command was not
found.

Explanation

You entered an incorrect path. Check the information entered.

Resolution

Enter the correct path.

Installing a desktop
tool or resource

Cannot download any
of the following:

v Map Editor and
associated
standards

v Graphical Process
Modeler

v Web Template
Designer

v (If licensed) MESA
Developer Studio
plug-ins, including:

– MESA Developer
Studio Software
Development Kit
(SDK)

– MESA Developer
Studio Skin
Editor

v (If licensed)
Reporting Services,
which requires
MESA Developer
Studio if you want
to use the plug-ins
to create fact
models and custom
reports.

Explanation

When you install Sterling B2B Integrator, system files are created
that contain an internal IP address. If you install Sterling B2B
Integrator behind a firewall, and your firewall is configured to
accept an external IP address from a client computer, you may not
be able to download the desktop tools and resources. The firewall
will reject the internal IP address from a client residing outside of
the firewall.

Resolution

Modify the system files that contain the invalid IP address. Follow
these steps:

1. Navigate to /install_dir/install/bin.

2. Stop Sterling B2B Integrator.

3. Enter the following command followed by the external IP
address:

./patchJNLP.sh external_IP_address

4. Restart Sterling B2B Integrator.

Installing Memory and ulimit
errors.

Explanation

The installation fails with memory and ulimit errors.

Resolution

v Refer to the Viewing and Editing Performance Configuration Settings
in the Performance Management documentation. Modify your
memory setting accordingly.

v Refer to the Operating System Configuration Checklist and tune the
ulimit settings.
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Situation Message or Symptom Explanation/Resolution

Installing (HP-UX
11.31)

When entering your
email address the @
key is not recognized.

Explanation

The @ key is being mapped to kill or eol, it needs to be mapped to
another character.

Resolution

This resolution only applies to HP-UX 11.31.

Map the @ key to another character.

Note: If you need want to see what the key is mapped to, use the
stty -a command.

e-Invoice Upgrade:
Oracle Add Constraint
Error

When you upgrade
Sterling e-Invoicing
and are using an
Oracle database, if the
upgrade fails with the
error message name is
already used by an
existing object, this
occurs because the
default behavior for
the "drop constraint"
command changed in
Oracle 10.

Explanation

The index that is used to support the constraint is now only
removed if the index was generated by the create constraint
command. The indexes for Sterling e-Invoicing are always
generated from constraints during an install. If you receive this
error during a Sterling e-Invoicing upgrade, it is because of how
the database was restored, the version of Oracle you are using, and
because the Oracle imp command exported the indexes and
constraints separately. There is no way to determine when the imp
command will not add a create index command to the export file if
it was generated by a constraint – but if it does add the command,
the database restore process loses the association of the constraint
and its underlying index. The database script that runs during a
Sterling e-Invoicing upgrade executes two steps: 1. First, it drops
the unique constraint so the next step can redefine it using
additional columns. However, the drop constraint command does
not remove the underlying index if the association with its index
was lost. 2. The next command that redefines this constraint
requires a different index definition, but in this scenario the name
of the index the constraint wants to use already exists, which
causes the name is already used by an existing object error.

Resolution

If you receive this error message, the solution for this problem is to
drop the index and rerun the Sterling e-Invoicing upgrade. The
drop index command you should use is: drop index
UNQ_EINV_CANON

Apply a fix pack or
Upgrade

The
/install_dir/
install/
installed_data
directory is created (if
clustered, on each
node) during an
upgrade or when
applying a fix pack.

This directory can
become very large and
take up needed space
on the file system.

Explanation

The information in this directory is used when applying a fix pack
or upgrading, but is not required afterward. The
deployment/cleanup tasks for the upgrade or fix pack do not
remove this directory.

Resolution

The directory can be manually removed to increase the available
space for the file system:

1. Navigate to /install_dir/install

2. Enter

rm -r installed_data
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iSeries Upgrade (V5.2.6 or later)
You can upgrade the Sterling B2B Integrator software in an iSeries environment.

These instructions include the pre-upgrade and post-upgrade processes. They also
include information for using the DB2 database with Sterling B2B Integrator.

It is important to remember that upgrading involves a full installation of Sterling
B2B Integrator. You need to prepare for an upgrade the same way that you would
prepare for an installation.

This upgrade does not overwrite your current Sterling B2B Integrator directory
structure on disk. Instead, it creates a new installation of Sterling B2B Integrator
and uses a copy of your original instance's database to upgrade to the new
version. After the upgrade, both instances will be operational.

For new installations, use the Sterling B2B Integrator iSeries Installation Guide.

Before You Begin the Upgrade

Before You Begin the iSeries Upgrade: Before you begin the upgrade, review the
following checklist.

# Before You Begin Checklist Your Notes

1 You must have a new license file to use the new
licensed features of your upgraded installation.

2 Read through this entire document so that you have a
clear understanding of what the upgrade requires.

3 Download the following documents from the online
Documentation Library:

v Release notes

v System Requirements -

With each release, IBM introduces leading edge
technology to improve and enhance its software.
Review the System Requirements to confirm that
your system and databases meet the requirements,
and also to manage any necessary upgrades or
changes before upgrading.

4 Archive and purge any unneeded data before
upgrading.

Archived data can only be restored from the same
version and fix pack of Sterling B2B Integrator from
which it was archived. If you need to restore archived
data that was archived prior to performing the
upgrade, then you must have a running instance of
Sterling B2B Integrator that matches the version and
fix pack from which the archive was taken.

5 Back up your database. Export your business
processes, trading partners, maps, etc.

6 Review and note the adapters, business processes, and
other configurations in your current version. This will
help identify any need for updating transport
messages, third-party adapters, or configurations to
adapters, such as the File System and Command Line
Adapters.
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# Before You Begin Checklist Your Notes

7 If you have edited a pre-defined business process, be
aware that the upgrade process overwrites
pre-defined business processes. Your customized
business process is preserved in the system, but it is
no longer the default process.

8 If you have edited any property files (.properties or
.properties.in), be aware that the upgrade process
overwrites these property files, unless these changes
were made using the customer_overrides.properties
file. Your previous property file edits might not be
applicable in this release.

9 If you edited any of the following cdinterop files, you
must back them up before upgrading. The cdinterop
files do not have initialization (*.in) files. After the
upgrade, use the backup version of the files in your
upgraded installation.

v cdinterop-proxy-records.properties

v cdinterop-spoe-auth.properties

v cdinterop-spoe-policy.properties

v cdinterop-user-records.properties

10 You should not upgrade Sterling B2B Integrator on an
interim fix. Apply the latest fix pack prior to
upgrading Sterling B2B Integrator.

11 Always install and test your upgrade in a
non-production environment before upgrading your
production environment.

Special Tasks and Considerations (iSeries): Before you begin upgrading, be
aware of the following special tasks and considerations, depending on your type of
upgrade:
v If you have LDAP (Lightweight Directory Access Protocol) configuration

information in the security.properties file, this information will automatically be
moved to the authentication_policy.properties file.

v If your version of Sterling B2B Integrator is integrated with the JBoss™,
WebLogic®, or WebSphere® application server,
Sterling B2B Integrator can be installed without integration to an application
server and does not require an application server for installation or at runtime.
(However, Sterling B2B Integrator still supports integration with JBoss,
WebLogic, and WebSphere.) After you upgrade, you can restore integration with
your application server if desired. To do so, use the Sterling B2B Integrator EJB
Adapter. For more information, refer to the documentation for the EJB Adapter.

Upgrade Impacts
This documentation provides information on how system behavior has changed
based on upgrading your instance. You should review this information before you
begin your upgrade. Depending on which version you are upgrading to, you will
need to review one or more topics listed. The upgrade impacts listed for each
subsequent version are specific to that version. There is not a cumulative list.

572 Installing and upgrading (V5.2.6 or later):



Upgrade Impacts for V5.2.0:

Before you begin an upgrade, you should review and understand any impacts of
the upgrade.

Features/Services Not Supported

The following features/services are no longer supported:
v Channels portlet
v Federated Systems
v Community Management (AFT Communities are still available)
v Sterling Community Management (SCM) Integration
v Archive Commandline Service
v Sync Engine Data Clean Manager Service
v Sync Engine Task Manager Service

If you need more information, please contact your IBM sales representative.

Memory Requirement Change

Sterling B2B Integrator now requires at least 4 GB (8 GB recommended) of
dedicated memory in a private (non-shared) pool.

Port Allocation Changes in 5.2.0

If you are upgrading to 5.2.0, and have configured the CLA2 or the SWIFTNet
HTTP Server Adapter, the remote port numbers have changed for 5.2.0. The port
numbers are as follows:

Table 5. Remote Port Numbers

Adapter Name
Version 5.2.0
Base Port

Version 5.2.1
Base Port

Version 5.2.2
Base Port

Version 5.2.3
Base Port

CLA2 +51 +52 +53 +54

SWIFTNet HTTP
Server

+52 +53 +54 +55

After upgrading to 5.2.x, you need to change any references to the old remote port
numbers. For example, if you have any business processes that use the CLA2
adapter, you will need to update the remote ports in the business process.

Database Table Sizes

While upgrading if you encounter any database table size issues, you may have to
manually adjust the database tables and restart the upgrade process. An upgrade
using the production database in a test environment can be used to help you
determine what tables need to be manually adjusted.

Resource Tags

If you are using resource tags in your current version, you should check all of your
existing resource tags before you start the upgrade process. The resource tags you
should check are:
v Adapter Policies
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v Agreements
v Sterling Connect:Direct Netmaps
v Proxy Servers
v Security Tokens
v SSH Resources
v SWIFTNet Copy Service Profiles
v SWIFTNet Service Profiles

You can check the resource tags by running the following SQL query from the SQL
Manager page (Operations > Support Tools):
SELECT * FROM TAG_RESOURCE_ASSOC WHERE TYPE=41 OR TYPE=42 OR TYPE=43 OR TYPE=44 OR

TYPE=45 OR TYPE=52 OR TYPE=53

The TAG_NAME column in the SQL results will contain the names of any resource
tags that need to be edited or deleted.

If any of the resource tags contain tagged resources using the types listed, remove
those resources from the resource tags or delete the resource tags that contain these
resource types.

Silent Installation Parameters

The following parameters are new or have an updated definition:

What has changed parameter Definition

Parameter definition
has changed

LICENSE_FILE_PATH (Required) Full path to Core_License.xml.

New parameter LICENSE_FILE_#
(where # is a number
between 1 and 99)

(Required) This is required for each license
you install. You must add an entry for each
license file to the silent install file. The
LICENSE_FILE numbering (#) does not
need to be sequential.

For example:

LICENSE_FILE_1= SI_SFG_License.xml

LICENSE_FILE_2= Fin_Serv_License.xml

LICENSE_FILE_3=
SI_SFG_FIPS_License.xml

LICENSE_FILE_4= AS2_License_.xml

LICENSE_FILE_5= EBICS_License_.xml

Channels and Community Management Tabs (Optional)

The Dashboard PSML files are not updated during an upgrade. The PSML file
impacts any custom tabs you may have configured, such as Channels or Operator.
The Channels and Community Management tabs appear in your browser but are
no longer operational.

To remove the Channels and Community Management tabs:
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Warning: The psmlRestore command gets the 5200 psml file which resets ALL of
the custom tabs from the previous release.
1. Navigate to the installation directory.
2. Navigate to the bin directory.
3. Enter this command: ./psmlRestore.sh admin

Custom BI Fact Models Need to be Upgraded

Scripts named recreateBITablePKs.cmd.in (Windows) and recreateBITablePKs.sh.in
(UNIX) are now provided which allow you to upgrade any custom BI fact models
tied to a separate BI repository.

BI fact models need to be upgraded to continue to work with the Entity
Framework, which replaced Hibernate usage in the BI framework in version 5.2.0.

Backups Are Not Generated During Install, Upgrade, or When Applying a Fix Pack or
Interim Fix: Before you begin an upgrade, review the following backup
information.

Some of the standard resources installed during install or upgrade use the import
mechanism available to customers to load the standard resources into the database.
The standard import mechanism by default creates a backup of the table
containing the resource prior to importing to provide the ability to restore to the
previous state if later it was decided that the import should not have been
performed. This table backup was also being performed by default during the
basic installation processes. And, since the import mechanism was sometimes used
multiple times during the installation processes, some of the tables were backed up
several times. Depending on the size of the table, this could add a very large
amount of time to the installation process. Since it is recommended that a backup
is completed prior to beginning any of these installation processes, the default
behavior has changed to not perform the backup by default. If you would like
backups to be performed, then SKIPIMPORTBACKUP=false should be added to the
sandbox.cfg file.

Capitalization Insensitivity for Header Value:
About this task

Before you begin an upgrade, review the following AS3 information.

For AS3, when searching for a header value in a multipart/report, you do not need
to consider whether the header value contains any capitalization. The search has
been enhanced to be capitalization insensitive.

For example, the following searches will result in a match:
v Multipart/Report
v Multipart/report
v multipart/Report
v multipart/report

The search would not find the following as a match:
v MulTiPart/RePorT

CA Certificates Impacts: Before you upgrade, review the following information on
CA certificates.
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Users may add multiple copies of the same certificates to the database. Having
multiple copies of the same certificate in the database is not, in principle, a
problem for the system except for the minor amount of wasted storage. Each copy
has a different object ID in the database and is a separate database object.

The specific changes in this release is the ability to easily populate the product
database with the set of authority root certificates distributed with the JVM.

Retry Logic Added to WebSphereMQ Suite Adapter PUT Service:
About this task

Before you begin an upgrade, review the following WebSphereMQ Suite Adapter
PUT Service information.

Retry logic has been added to the WebSphereMQ Suite. To accommodate this new
functionality, you need to configure two new parameters for the PUT service:
v wsmq_send_retryCount
v wsmq_send_retrySleepInterval

To configure the new parameters:

Procedure

1. Log into Sterling B2B Integrator.
2. From the Admin Console Home, you need to start the Graphical Process

Model (GPM).
3. Log into the GPM. You will need a User ID and Password.
4. In the GPM, select View > Stencil > Services.
5. Select File > New.
6. Drag the WebSphereMQ Suite Put Message Service from the All Services

pane into the center pane.
7. Double click the WebSphereMQ Suite Put Message Service.
8. Select the configuration from the Config dropdown.
9. Enter the number of retries in to the wsmq_send_retryCount value.

10. Enter the sleep interval in seconds in to the wsmq_send_retrySleepInterval
value.

11. Save the changes to the service configuration.
12. Exit from the GPM.

Services and Adapters - Show Advance State Button: Before you begin an upgrade,
review the following Show Advance State button information.

The Show Advanced State check box has been removed from the Services
Configuration search screen. Instead, the default has been changed to always show
the advanced state without needing to check a checkbox on the search screen to
display it.

Some Certificate Fields Are Optional:
About this task

Before you begin an upgrade, review the following certificate field information.

When generating certificate keys, the following fields may have been missing in
the release you are upgrading from, but the entries are now optional:
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v alt.name.dns
v alt.name.IP

Support for Multiple AS2 Organizations: Before you begin an upgrade, review the
following AS2 schema information.

Sterling B2B Integrator now supports multiple sponsoring organizations and
multiple partners for AS2. During upgrade, the single organization will be flagged
as the default organization.

Once you have upgraded to this version, a prefix designation is used to
differentiate between an AS2 organization (AS2_ORG_) and an AS2 partner
(AS2_PART_). Each of these will require the full configuration of a trading partner
to allow for a partner to trade with multiple organizations as well as an
organization that trades with multiple partners.

The AS2_TRADEPART_INFO and AS2_EMAIL_INFO tables have been modified
and the AS2_PROFILE table is newly introduced. Updates to these tables will
occur during the SI in-place upgrade process in the following manner:
v Identify the default organization and populates the AS2_PROFILE table with

organization information. A default organization is an AS2 organization profile
named "profile_ORGANIZATION" present in the system before upgrade.

v Identify partner records and populates the AS2_PROFILE table with partner
information.

v Populate the new columns of table AS2_TRADEPART_INFO with the default
organization information.

v Populate the new PROFILE_ID column in the AS2_EMAIL_INFO table with the
profile id of the AS2 organization profile present in the system.

Web Services: Before you begin an upgrade, review the following Web Services
information.

Many of the Web Services configuration settings that were generated from the
WebServices Provider Configuration UI have moved from the property files into
database tables. This change was made to allow a single location of these settings
in cluster environments and to ensure that these settings would not be reset during
a fix pack installation.

After you have completed your upgrade, you should run the
convertWSSoaProperties script found in the installation bin folder. This script reads
the settings from the property file and places them into the proper database tables.
You can then review the results in the WebServices Provider Configuration UI.

Upgrade impacts for V5.2.5:

Upgrading to Sterling B2B Integrator 5.2.5 has unique impacts.

JDK 7 does not support the TLS_RSA_WITH_3DES_EDE_CBC_MD5 cipher

If you are using JDK 7 with Sterling B2B Integrator V5.2.5, and you want to use a
cipher to secure the Sterling B2B Integrator dashboard, you must set one of the
following values in the dashboardCipherSuite parameter in the
security.properties_platform_asi_ext.in property file or in customer_overrides:
v JDK (includes all strong ciphers except the one not supported by JDK 7)
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v Weak

Do not use Strong or All with JDK 7 or Sterling B2B Integrator will not start.

Reconciliation of HIPAA Level 5 code lists

When you upgrade to Sterling B2B Integrator V5.2.5, customized HIPAA Level 5
code lists from the previous version are preserved in the system where they were
entered, but they are not the default code lists after the upgrade. After the
upgrade, you must manually make any customized code lists the default code lists.

For example, you customized the ICD9 or HCPCSCPT code list in the previous
version of Sterling B2B Integrator. After the upgrade to version 5.2.5, you must
replace the default ICD9 or HCPCSCPT code list with the customized ICD9 or
HCPCSCPT code list.

Properties file change to prevent timeout during start (V5.1.0.4 to 5.2.5 upgrade)

Before you start Sterling B2B Integrator after you upgrade the application from
V5.1.0.4 to 5.2.5, you must change the values of the following properties in the
centralops.properties file to 600. This action prevents the start command from
timing out before Sterling B2B Integrator starts. The centralops.properties file is
in the properties subdirectory of the installation directory.
v OpsServer.commandTimeout

v PassPhrase.urlTimeout

jGroups upgrade in V5.2.5 prevents Sterling B2B Integrator from starting for
some customers

jGroups is upgraded with V5.2.5. Some of the properties defined in
jgroups_cluster.properties have changed. If you modified these files or added
custom changes for them to customer_overrides.properties, the upgrade changes
are not applied and Sterling B2B Integrator will not start.

This issue is fixed in V5.2.5, Interim Fix 1, where all necessary properties files are
changed for you. You can also disable this fix if desired. See APAR IT06654 for
more information.

Note: The original and modified properties are output to the noapp.log file. This
allows you to see how your properties were modified. Search the log using the
value “Initializing jgroups_cluster.property_string" to see the new and changed
values for the two affected startup properties. The
jgroups_cluster.lock.protocolStack property is also modified with this fix, but is
only written to the log when it is used, not at startup.

If you want to manually fix your installation without applying V5.2.5, Interim Fix
1, complete the following steps:
1. Delete the following options (if they exist) from customer_overrides.properties

for the jgroups.cluster property file. These occur in the
jgroups_cluster.property_sting, jgroups_cluster.distributed_property_string, and
jgroups_cluster.lock.protocolStack files:
v gc_lag
v up_thread
v down_thread
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v join_retry_timeout
v max_xmit_size
v shun

2. Remove the protocol parameter VIEW_SYNC and all of its attributes.
3. In the jgroups_cluster.property_string, replace ‘start_port’ with ‘bind_port’.
4. In the jgroups_cluster.distributed_property_string and

jgroups_cluster.lock.protocolStack properties, add the following items:
v In distribution_property_string the attribute

thread_pool_rejection_policty=run should be added to the protocol ‘TCP’.
For example,
TCP(bind_port=22261;thread_pool_rejection_policy=run)

v In lock.protocolStack: the protocol and attribute CENTAL_LOCK(num_backups=2)
should be added to the end of the property. For example,
lock.protocolStack=UDP(bind_addr=&HOST_ADDR;;bind_port=
&MULTICAST_NODE_PORT3;;mcast_addr=239.255.166.17;<other

protocol parameters here>pbcast.GMS(join_timeout=5000;print_local_

addr=true):CENTRAL_LOCK(num_backups=2)

Upgrade impacts for V5.2.6:

Upgrading to Sterling B2B Integrator 5.2.6 has unique impacts.

Support for SSLV3 has been removed - TLS 1.2 is the new default

Due to security concerns, Sterling B2B Integrator no longer supports the use of
SSLV3. You should be aware of the following changes as you upgrade your system
to this version:
v Several properties have been updated to use TLS 1.2 as the default. If your mail

server cannot use TLS 1.2, you can change your SMTP and B2B Mail Client
adapters to use TLS 1.0 or 1.1 instead.

v If any of your 3rd party programs do not support the use of TLS 1.2, you can
change Sterling B2B Integrator to use TLS 1.0 or TLS 1.1.

v In all cases, requests to use "SSLV3" in Sterling B2B Integrator will use instead
TLS 1.0, TLS1.1, or TLS1.2.

v TLS 1.2 is used as the default protocol in secure communications. This change
applies to any system that is upgraded to V5.2.6.

v If your GPM, or WebSphere MQ or OFTP adapters are configured to use older,
non-supported cipher suites (non-TLS 1.2), they will continue to work. However,
if you edit them, only TLS 1.2 will be available to select.

JDK 7 is the only supported JDK version for V5.2.6

There are several impacts due to this change:
v If you are not already using JDK 7, you must upgrade your JDK before

attempting to upgrade Sterling B2B Integrator to V5.2.6. If you currently have
V5.2.4.1 or higher installed, there is a upgradeJDK script available to assist you.
See bin Directory Files for more information.

v Only ciphers that are supported by JDK 7 can be used in Sterling B2B Integrator
V5.2.6. You can update your cipher suites in security.properties.

v Previously defined ciphers in customer_overrides.properties are not changed
upon upgrade to V5.2.6.
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v DefaultCipherSuite contains a list of JDK 7 ciphers in V5.2.6 that can be used
when others are not available.

Prepare Your iSeries for the Upgrade
To run Sterling B2B Integrator V5.2.6 on iSeries, you must have a V7R1 or V7R2
iSeries operating system with JDK 1.7 installed.

To verify system compatibility and prepare for the upgrade, perform the following
tasks:
1. Review the Sterling B2B Integrator System Requirements document. Your system

must meet the minimum requirements that are documented, while your
database and JDBC driver versions must match the documented requirements.
Complete any necessary upgrades or changes in preparation for the upgrade.

2. Collect information on any third-party libraries used for adapter configuration
that were added to your current release. You must add each of these libraries
later in the upgrade process.

3. Locate any configuration file changes for the JDBC adapter or the Lightweight
JDBC adapter in your current release. Later in the upgrade process, you will
copy these changes to this release.

4. Record your performance tuning configuration. You will restore these settings
later in the upgrade process.

5. Back up Sterling B2B Integrator and your current database

CAUTION:
If there are problems with your upgraded system, the only way to ensure that
you can roll back to your previous version is to back up Sterling B2B Integrator
and your database.

After you successfully back up Sterling B2B Integrator and your database, you are
ready to upgrade the software. Before you begin, see the Release Notes.

Checklist for iSeries Pre-Upgrade:

Use this checklist to upgrade Sterling B2B Integrator in an iSeries environment.

The checklist contains:
v Brief descriptions for tasks (detailed procedures are provided after the checklist)
v Information you need to gather to complete the installation

Note: When creating a name, such as an account name, permissions name, profile
name, or database name, follow these conventions:
v The first character must be alphabetic
v The remaining characters may be alphanumeric, but it's best to avoid special

characters
v Do not use spaces or apostrophes

You may want to make a copy of the following checklist and use it to record the
information you collect.
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Step iSeries Installation Checklist Your Notes

1 Use the system requirements to verify that your
system hardware and software meet the
requirements specified for this release.

Ensure that you have the correct license file and JCE
file.
Important: Do not remove the existing license file or
JCE file from your system. The files specified by the
LICPATH and JCEPATH parameters in the sandbox.cfg
file must be present during the upgrade, or the
upgrade will fail.

2 For systems with multiple IP addresses, verify that
the IP address on which Sterling B2B Integrator
resides is accessible by any client computer that is
running a browser interface.

Caution: If you do not verify the IP address, your
system may not operate properly after installing
Sterling B2B Integrator. A good test is to ping the IP
address from your iSeries command line.

3 If you are using a non-English environment, confirm
that you are using the appropriate character set.

4 Configure the system to view Sterling B2B Integrator
files using Windows Explorer.

5 Map a network drive to your working directory.

6 Specify the QCCSID (Coded Character Set) for this
installation.

7 Record the collection name for the database.

8 Record the system passphrase.

9 Record the administrative email address.

This address is where system alerts messages are
sent.

10 Record the SMTP Server IP address.

This address is where alert messages are sent.

11 Record the Initial Port Number.

12 Record the Hostname (catalog name) on which you
plan to install the software.

13 Determine the Host IP address for Sterling B2B
Integrator.

This is required even if you only have one IP
address for your system.

14 Create the Sterling B2B Integrator user profile and
the associated password.

Be sure to record the user password so you can
enter it during installation.
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Step iSeries Installation Checklist Your Notes

15 Set the JDK for your User Profile.

Create a .profile file in the /home directory for your
user profile.

Verify that your user profile points to the correct
JDK.

16 Verify that your user profile is pointing to a job
queue in a subsystem.

17 Record the path to the Sterling B2B Integrator jar
file.

The jar file can reside in any directory on your
system. During installation, you use this directory,
but this is not the final directory where Sterling B2B
Integrator resides.

18 Record the Directory Name where you plan to install
the software.

The Sterling B2B Integrator installation directory
must be a new directory and cannot already exist. A
large subdirectory tree will be created under this
directory. During installation, this directory is
referred to as install_dir.

19 Record the path to the Core License file
(Core_License.xml).

20 Download the JCE distribution file.

21 Identify the JDK that will be used for Sterling B2B
Integrator.

22 Install the Sterling B2B Integrator software.

The Sterling B2B Integrator installation program will automatically set the umask
to 002 during the installation. However, iSeries system administrators should
consider placing an appropriate umask command such as umask 002 in their
global or user login script because the default of 000 could allow many IFS files to
be world-writable. Please consult the IBM iSeries Information Center for more
information on umask and customizing your Qshell environment.

Verification of the system requirements:

Before you begin the installation, verify that your system meets the hardware and
software requirements that are specified for this release.

The hardware requirements that are listed in the System Requirements are the
minimum requirements. Your system requirements might exceed these
requirements if you are running other applications on the same machine as Sterling
B2B Integrator.

The installation strictly enforces the following system requirements:
v Operating system version must match requirement exactly.
v The minimum patch level for the operating system is enforced, but you can

apply higher patch levels.
v JDK version must match requirement exactly.
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v The disk space is a minimum for the installation. The system must be separately
sized to handle whatever load is going to be put on the system.

v Database version must match exactly.
v JDBC driver version supports exact matches and wildcard matches.

If any of these requirements are not met, the installation fails. If the installation
fails, review the installation log for a list of non-compliant items.

Downloading the JCE distribution file:

The Java Cryptography Extension (JCE) is a set of Java packages from IBM that
provides a framework and implementations for encryption, key generation and key
agreement, and Message Authentication Code (MAC) algorithms.

About this task

If you are installing Sterling B2B Integrator outside of the United States, check to
see if you can get the JCE unlimited strength jurisdiction policy files. The
unlimited strength jurisdiction policy files can be exported only to countries to
which the United States permits the export of higher-level encryption.

Procedure

To obtain the JCE distribution file:
1. Browse to the Unrestricted SDK JCE policy files website.
2. Enter your IBM ID and password. If you do not have an IBM ID, follow the

IBM registration instructions.
3. Click Sign in.
4. Select the Files for Java 5.0 SR16, Java 6 SR13, Java 6 SR5 (J9 VM2.6), Java 7

SR4, and all later releases check box and click Continue.
5. Review your personal information and the license agreement.
6. Select the I agree check box and click I confirm to continue.
7. Click Download now.
8. Save the unrestricted.zip file to your system.
9. Record the directory and the .zip file name. You need this information during

the installation process.

Determination of port numbers (iSeries):

During installation, you are prompted to specify the initial port number.

Use the following port number guidelines:
v A range of 200 consecutive open ports between 10000 - 65535 are required for

this installation.
v The initial port number represents the beginning port number in the range.
v Make sure that port numbers in the port range are not used by any other

applications on your system.

After your installation, refer to the install_dir/install/properties/sandbox.cfg
file for all of the port assignments.

In an iSeries environment, you can also view the port numbers currently in use on
your system by using one of these methods:
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v Select from the iSeries Navigator Network > TCP/IP Configuration >
Connections.

v
Enter WRKTCPSTS on an iSeries command line and select Option 3 (Work with
TCP/IP connection status). Press F14 to sort the port numbers in numerical
sequence.

v
Enter NETSTAT *CNN on an iSeries command line and press Enter. Press F14 to
sort the port numbers in numerical sequence.

Configure the System to View Files:

In the iSeries environment, you must configure your system to view Sterling B2B
Integrator files using Windows Explorer.

Use the NetServer component of IBM i to set up file shares that are accessible
through Windows networking. You must set up a file share to a working directory
in your iSeries Integrated File System (IFS).

Map a Network Drive (iSeries): In the iSeries environment, you must map a
network drive to the working directory for Sterling B2B Integrator. For more
information, refer to the documentation on the IBM Web site.

Specifying the QCCSID (iSeries):

In the iSeries environment, you must specify the QCCSID (Coded Character Set)
for Sterling B2B Integrator.

About this task

Refer to the IBM National Language Support Guide for valid coded character sets.
It is recommended that you use the coded character set 037 for the United States
English system.

Procedure

To specify the QCCSID:
1. From an iSeries command line, enter DSPSYSVAL SYSVAL(QCCSID).
2. Determine if the QCCSID set to 65535.
3. If the QCCSID value is set to 65535, then perform one of the following actions:
v Change the CCSID to a specific coded character set.

Enter CHGSYSVAL SYSVAL(QCCSID) VALUE(xxx), where xxx represents your
coded character set and then IPL your iSeries.

v Keep the QCCSID at 65535 and specify a specific CCSID other than 65535
when you create your Sterling B2B Integrator user profile.

4. If the QCCSID value is not set to 65535, continue with the next installation or
upgrade task.

Creating a user profile (iSeries):

In the iSeries environment, you must create a user profile for accessing the Sterling
B2B Integrator databases. You use this user profile when you enter the installation
command.

584 Installing and upgrading (V5.2.6 or later):



About this task

If your system value QCCSID is set to 65535, then set the CCSID parameter to a
specific coded character set other than 65535 on the CRTUSRPRF command. See the
IBM National Language Support Guide for valid coded character sets. For more
information about creating user profiles, see the operating system documentation .

The job description that is assigned to the user profile must have a job queue
defined that allows at least 10 active jobs. If the maximum number of active jobs is
less than 10, Sterling B2B Integrator does not install correctly. This guideline also
applies to starting Sterling B2B Integrator after the installation.

License information:

A separate license is required for each Sterling B2B Integrator feature that you
purchased. During installation, you must choose the license files according to what
you purchased. Product licenses do not require an activation key.

IBM assumes customers will only install and use the products they purchased. IBM
reserves the right to inspect installs for compliance at any time.

After the installation finishes, if you determine that you need to modify licenses
files, see “License modifications” on page 58.

Product Licenses for Sterling B2B Integrator

Sterling B2B Integrator Standard and Enterprise Edition includes:
v MESA Studio
v eInvoicing
v Report Services
v all services and adapters not listed below

Sterling B2B Integrator Standard and Enterprise Financial Edition includes
everything listed above plus:
v CHIPS
v SWIFTNet
v NACHA ACH CTX adapter
v FEDWIRE
v Fin Serv XML standard
v FIPS Mode
v Image Cash Letter service
v EBICS

Prepare the Database (iSeries):

In an iSeries environment, Sterling B2B Integrator uses the DB2 database that is
included in IBM i.

The installation process creates a new collection for Sterling B2B Integrator. Before
you install, you must determine and record the collection name and the catalog
name.
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v The collection name is the name of the collection (or library) that contains the
database, journal, and journal receiver for your Sterling B2B Integrator system.
This collection must not already exist.

v The catalog name is the database name of your iSeries system, as defined by the
WRKRDBDIRE command. Generally, this value is the name of your system.

All database files are required to be journaled when being used by the translator in
Sterling B2B Integrator. If your application files are not currently journaled, and
you plan to access these files through Sterling B2B Integrator, refer to the IBM
manuals for instructions on journaling physical files.

Setting the JDK for your user profile:

To set the JDK for your user profile, you must create a .profile file in the /home
directory for the user.

Sterling B2B Integrator V5.2.6 or later on iSeries requires the J9 JDK 1.7. Create the
.profile file to set the JDK to J9 JDK 1.7.

Creating a .profile File:

A .profile file includes a pointer to the J9 JDK 1.7 directory that you can use in
Sterling B2B Integrator.

Procedure

To create a .profile file in an iSeries environment:
1. Log on with the Sterling B2B Integrator user profile.
2. Create a home directory for the Sterling B2B Integrator user profile. From an

iSeries command line, enter MKDIR /home/appuser, where appuser represents the
Sterling B2B Integrator user profile.

3. Type EDTF and press F4.
4. Type /home/appuser/.profile and press Enter. An edit session is displayed.
5. On the first line, type the following command:

export JAVA_HOME=/QOpenSys/QIBM/ProdData/JavaVM/jdk70/64bit

Important: Make sure that there is not a space in the first position of this line.
If there is a space, the system does not recognize the proper JDK and the
installation might fail.

6. Press F2.
7. Press F3.
8. Enter WRKUSRPRF to verify that the Sterling B2B Integrator user profile home

directory is pointing to the /home/appuser directory.
9. Verify that the user id is pointing to the correct JDK:

a. From an iSeries command line, type qsh to enter Qsh mode.
b. Type java –version.
c. Press Enter.

Verify that the information listed reflects the JDK that you are using.

Upgrading Sterling B2B Integrator in an iSeries environment
To upgrade Sterling B2B Integrator, follow the steps in the Run the Upgrade
Installation Program in iSeries topic. These steps include special instructions for
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upgrading. Before running the upgrade program, refer to the Before You Begin the
Upgrade section. After running the upgrade program, refer to the Post Upgrade
Validation and Post Upgrade Configuration sections.

In the iSeries environment, you must map a network drive to the working
directory for Sterling B2B Integrator. For more information, refer to the
documentation on the IBM Web site.

When running the installation program (see Run the Upgrade Installation Program in
iSeries), enter the following information exactly the same as your existing
installation:
v Collection name – The name of your copied database
v IP address
v Passphrase

This upgrade changes the administrative password to the default password. After
the upgrade, change the password back to the administrative password to
minimize security risks. This is the Admin password for logging into the UI
(/dashboard or /ws). You also need to change all other default passwords.

Untar the Sterling B2B Integrator Jar File:
About this task

The following procedure describes how to untar the Sterling B2B Integrator jar file.
During the upgrade, you will reference this procedure.

Procedure

1. After the Sterling B2B Integrator jar file has been downloaded, key in qsh
from an iSeries command line and press Enter.

2. Key in set and press the Enter key.
This will list variables on the screen. Look for the QIBM_CCSID variable. It
will look like QIBM_CCSID=0. Write down what it is set to.

3. Key in export QIBM_CCSID=819 and press Enter.
4. Navigate to the directory where the tar file is located.
5. Key in set to verify that the QIBM_CCSID is set to 819.
6. Key in tar -xvf name.of.tarfile.tar and press Enter.
7. After it has performed the untar, you need to set the CCSID back.
8. Key in export QIBM_CCSID=0 and press Enter, where the 0 represents the value

in step 2.
9. Key in set and press Enter to verify that QIBM_CCSID is set to what it was

in step 2.
10. You need to verify that the untar was successful. At this point you will still be

in the directory where the SI.jar was untarred to. Key in jar -tf SI.jar and
press Enter. If you get file names to scroll up on the screen, the untar worked.
If you get the $ prompt back with no additional information, then the untar
was not successful and you will have to untar again. You are now ready to
continue with the install.

Upgrading in an iSeries environment:

You can upgrade Sterling B2B Integrator in an iSeries environment.
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Before you begin

Ensure that your system is ready for the upgrade. See “Prepare Your iSeries for the
Upgrade” on page 580.

Attention: Failure to properly prepare your system can cause the upgrade to fail.

If you are using the EBICS Banking Server application with Sterling B2B Integrator,
the data encryption for storage within the installation location is not supported.

About this task

These instructions assume that you have downloaded Sterling B2B Integrator or a
Service Pack (SP) and uncompressed the downloaded file to an empty directory.
Use this directory wherever there is a reference to the installation source directory
in the following instructions.

Note: To uncompress the files, see Untar the Sterling B2B Integrator File.

To upgrade Sterling B2B Integrator in an iSeries environment, you run an
installation program. Refer to the information you recorded in the checklist and
follow the steps below.

Before your upgrade installation, shut down your base installation. This will free
up the port number that you used in your base installation.

Procedure

1. Go to the installation source directory.
2. Depending on the location of the installation source directory, choose one

method. Be sure to record the absolute path that you use.
v If the installation source directory is on your PC, copy or FTP the file

SI_<build_number>.jar from that directory to the absolutePath in the IFS root
or QOpenSys file system.

v If the installation source directory is in iSeries, enter the following
command on the command line: cp /qopt/SI_<build_number>.jar
absolutePath/SI_<build_number>.jar

3. Copy the file instsijar.savf from the iSeries directory to the mapped
network drive. Steps 4 through 6 will download the installation programs
required for the upgrade.

4. Answer the question Is there a save file called INSTSIJAR in QGPL on
your iSeries?

v If YES, clear the save file by entering CLRSAVF FILE(QGPL/INSTSIJAR).
v If NO, enter CRTSAVF FILE(QGPL/INSTSIJAR) to create a save file on your

iSeries.
5. Copy the instsijar.savf file that you copied in step 3 to the save file created

in QGPL by entering: CPYFRMSTMF FROMSTMF(‘/directory/filename of the
savf/) TOMBR(‘/QSYS.LIB/QGPL.LIB/INSTSIJAR.FILE') MBROPT(*REPLACE)
CVTDTA(*NONE)

6. Enter the following command to restore the installation objects:
RSTLIB SAVLIB(INSTSIJAR) DEV(*SAVF) SAVF(QGPL/INSTSIJAR) MBROPT(*ALL) ALWOBJDIF(*ALL)

7. Log in to your iSeries using the user profile you created during
preinstallation.
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8. Copy (back up and restore) the DB2 database for your previous version of
Sterling B2B Integrator for iSeries into this version of Sterling B2B Integrator,
using the following steps.
The following procedure uses Sterling B2B Integrator 5.0 as an example.
Change the commands as necessary for your version of Sterling B2B
Integrator.
v Ensure that no one is using Sterling B2B Integrator 5.0 or this version of the

Sterling B2B Integrator database.
v The save and restore procedure must be done by the iSeries System Security

Officer (QSECOFR) or by a user with *SECADM authority. To create a save
file to hold your Sterling B2B Integrator 5.0 database, type:
CRTSAVF FILE(QGPL/SAVE50DB)

If the save file already exists, type in:
CLRSAVF FILE(QGPL/SAVE50DB)

v Save your Sterling B2B Integrator 5.0 database into the new save file using
the following command:
SAVLIB LIB(SI50DB) DEV(*SAVF) SAVF(QGPL/SAVE50DB)

SI50DB represents your Sterling B2B Integrator 5.0 database (collection).
v Create the collection again that will hold this version of the Sterling B2B

Integrator database, by first signing on to your iSeries using the user profile
that you will use to run Sterling B2B Integrator.

v From an iSeries command line, type STRSQL to get to an interactive SQL
session.

v Type create collection SIxxDB.
SIxx1DB represents this version of the Sterling B2B Integrator database.
The create collection command creates a collection (library), called SIxxDB,
that contains a journal, journal receiver, and several logical views.

v After the create command finishes, exit your SQL interactive session
without saving.

v To restore your Sterling B2B Integrator 5.0 database to the same collection
(library name) that you just created in step f from above, type:
RSTLIB SAVLIB(SI50DB) DEV(*SAVF) SAVF(QGPL/SAVE50DB) RSTLIB(SIxxDB)

SI50DB represents your Sterling Integrator 5.0 database.
SIxxDB represents this version of the Sterling B2B Integrator database.
You should receive a message similar to the following message, ### objects
restored. 20 not restored to SIxxDB.

Note: The 20 objects that are not restored are the journal and journal receiver
files. This is expected.

9. Enter ADDLIBLE LIB(INSTSIJAR) from an iSeries command line to add the
installation programs to your library list.

10. Journaling needs to be set up appropriately on the newly copied database. To
accomplish this, enter FIXJRNS and press F4. You will be prompted for old
collection and new collection information, as follows:
v If the old collection exists on the same iSeries machine as the new

collection, when the restore took place, the newly restored files were
journaled to the old collection. By running this command, it will un-journal
the files from the old collection and journal them to the new collection.

v If the old collection exists on a different iSeries machine and it was
transferred and restored onto the iSeries box where you will be performing
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the upgrade, none of the files were journaled. This command will journal
the files to the new collection. When running this command, enter *NONE
for the Old Collection parameter and enter the new collection in the New
Collection parameter.
Based on the information above, fill in the appropriate answer for the Old
Collection parameter. Key in the collection name for the new Sterling B2B
Integrator system and press Enter. This will run interactively and correctly
journal all of your physical files that have just been restored into your
newly created collection that will be used in your upgrade process.

11. Enter INSTSIJAR and press F4 to prompt the command. The system displays
the list of configuration parameters needed to install Sterling B2B Integrator.

12. For each configuration parameter listed, enter the value you want to use.
Refer to your notes in the preinstallation checklist.
v Collection Name - This collection name must be the newly created

collection to which you restored your old database in step 8.
v Upgrade from the prior Sterling B2B Integrator version (*YES or *NO) -

Answer *YES to this parameter to upgrade your previous version of
Sterling B2B Integrator to this version of Sterling B2B Integrator. When you
answer *YES to this prompt, it will convert your older copied database to
this version of the database structure.

v Sterling B2B Integrator System Passphrase - Enter this information exactly
the same as in your existing installation.

v Verify Sterling B2B Integrator System Passphrase.
v Administrative e-mail address - It is recommended that you not change the

Administrative e-mail address during an upgrade. If you change this
address, you will have to update adapters, business processes and other
items that include this information.

v IP Address for SMTP Server - Enter this information exactly the same as in
your existing installation.

v TCP/IP Port Number
v Catalog Name
v Host IP Address
v Sterling B2B Integrator User Profile
v Sterling B2B Integrator User Password
v Full Path to Sterling B2B Integrator Jar File

13. Press Page Down for the remaining parameters:
v Sterling B2B Integrator install directory. Be sure to enter a complete path

name.
v Full license path name. Be sure to enter a complete path and file name.
v JCE distribution file. Be sure to enter a complete path and file name.

14. Select License/Features, enter YES to select:
v Sterling B2B Integrator, Sterling File Gateway, or both
v NIST 800-131a Compliance Mode (choose *OFF or *STRICT)
v FIPS Module
v AS2 Edition Module
v Financial Services Module
v EBICS Banking Server Module
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Note: Select only the licenses/features that have been defined by your IBM
contract. If you are unsure which to select, the installation can proceed
without making a selection and will complete successfully. Start up and
operation of the software, however, requires one of the licenses to be selected.
See License Modification to apply licenses post-install.

Note: Sterling File Gateway requires additional installation steps. See the
Sterling File Gateway Installation Guide for more information

15. Verify the parameters you entered and press Enter.
The installation process takes between two and three hours to complete. The
installation time depends upon the size of your iSeries. Monitor the
installation process to verify that no JAVA exception errors are generated.
The install runs in batch mode. To monitor the progress of the install, use the
WRKLNK command display function to view the log file (gisinstall.log). This
file resides in the same directory where you placed the SI.jar file. In addition
to the job you submitted, various BCI jobs, command shells, and JVMs appear
and disappear in your batch subsystem. This processing is normal.

16. (Optional, but recommended) Check IBM Fix Central to see if further fix packs
or interim fixes are available. If so, download and install as needed. See
“Installing a fix pack or interim fix” on page 307 for instructions.

Post Upgrade Validation

Post Upgrade Validation Checklist for iSeries:

# Post Upgrade Validation Checklist for iSeries Your Notes

1 Start Sterling B2B Integrator (iSeries).

2 Access Sterling B2B Integrator.

3 Validate the Installation.

4 Stop Sterling B2B Integrator (iSeries).

Starting Sterling B2B Integrator (iSeries):

The startup of Sterling B2B Integrator after installation requires several steps.

Before you begin

If you are starting Sterling B2B Integrator after upgrading from version 5.1.0.4,
change the values of the following properties in the centralops.properties file to
600. This action prevents the start command from timing out before Sterling B2B
Integrator starts. The centralops.properties file is in the install_dir/install/
properties directory.
v OpsServer.commandTimeout

v PassPhrase.urlTimeout

Procedure

To start Sterling B2B Integrator in an iSeries environment:
1. Sign onto iSeries with your Sterling B2B Integrator user profile.
2. Submit a batch job by entering the following command:

SBMJOB CMD(QSH CMD(’umask 002 ; cd install_dir/bin ; ./run.sh’))JOB(SIMAIN)
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The job queue to which you submit the command must allow at least 10 active
jobs. If the maximum number of active jobs is less than 10, Sterling B2B
Integrator does not start completely.
To reduce keying errors at startup, create a command language (CL) program
similar to the following example:
PGM
SBMJOB CMD(QSH CMD(’umask 002 ; cd install_dir/bin ; ./run.sh’)) +
JOB(SIMAIN)
ENDPGM

3. Wait for the startup to complete. This process takes 10 - 15 minutes.
Startup creates a spool file. When the startup is finished, open the QPRINT spool
file and check the end of the file for a message about how to connect to
Sterling B2B Integrator. For example, you might see the following type of
message:
Open your Web browser to http://host:port/dashboard

where host:port is the IP address and port number where Sterling B2B
Integrator exists on your system.
Make a note of the address so you can access Sterling B2B Integrator later. It
might take several minutes for Sterling B2B Integrator to be available from the
web browser, even after the URL message is displayed.

4. Optional: To verify that Sterling B2B Integrator started normally and
completely, view the system by using the WRKACTJOB command.
Verify that the SIMAIN job ended and there are at least four QP0ZSPWP jobs
(of yours) left running in your Sterling B2B Integrator batch subsystem.

5. Prepare your browser to log in to Sterling B2B Integrator. Configure your
browser so that there is direct connection between the web browser and iSeries.
Do not configure the browser to use any proxy server between you and iSeries
(unless it is a requirement of your network).

Accessing Sterling B2B Integrator:

You can access Sterling B2B Integrator through a web browser.

Procedure

1. Open a browser window and enter the address that is displayed at the end of
the start.

2. On the login page, enter the default user ID and password. The default login is
at an administrative level. One of your first tasks as an administrator is to
change the administrative password and to register other users with other
levels of permission.

Validating the installation with a sample business process:

You can validate the installation by testing a sample business process.

Procedure

1. From the Administration Menu, click Business Process > Manager.
2. In the Process Name field, type Validation_Sample_BPML and click Go!

3. Click execution manager.
4. Click execute.
5. Click Go! The Status: Success message is displayed on the upper left side of

the page.
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Stopping Sterling B2B Integrator (iSeries):

Stopping Sterling B2B Integrator on iSeries requires several steps.

Procedure

To stop Sterling B2B Integrator in an iSeries environment:
1. Sign on to iSeries with your Sterling B2B Integrator user profile.
2. Enter the following commands:

QSH
cd /install_dir/bin
./hardstop.sh

To reduce keying errors at shutdown, create a command language (CL)
program similar to the following example:
PGM
QSH CMD(’cd /install_dir/bin ; ./hardstop.sh’)
ENDPGM

3. Wait for shutdown to complete.
The length of this process is determined by how many temporary objects must
be cleaned up and how many spool files must be created.
To ensure that you do not restart Sterling B2B Integrator before shutdown is
complete, monitor shutdown through either the ps command in Qshell or the
WRKACTJOB display. Verify that the five QP0ZSPWP jobs are complete and
disappear.

4. Enter the ./stopDAVServer.sh command to stop the WebDAV server.

Post Upgrade Configuration

Post Upgrade Configuration Checklist for iSeries:

# Post Upgrade Configuration Checklist for iSeries Your Notes

1 Upon upgrade, all default user accounts are reset
to their default value. For security purposes, the
system administrator should update all default
user account passwords immediately after upgrade
is completed. See “Changing default user account
passwords” on page 40.

2 “Download of the Sterling B2B Integrator tools” on
page 43

3 “Properties files configuration in an iSeries
environment” on page 304

4 “Performing Initial Administrative Setups in
Sterling B2B Integrator” on page 596

5 Add Third-Party Libraries

6 Configure Services and Adapters

7 JDBC Adapter and Lightweight JDBC Adapter

8 File System Adapter and Command Line2
Adapters

9 Odette FTP Adapter

10 Restore Performance Tuning Configuration

11 Change the Network Interface Bindings
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# Post Upgrade Configuration Checklist for iSeries Your Notes

12 Advanced File Transfer Tab

13 Reconfigure Archive Settings

14 Correct Missing Manager IDs

Changing default user account passwords:

When you install Sterling B2B Integrator, several default user accounts are
automatically created to get you started. One of the first actions you must take
after installation is to update these accounts with unique passwords, because the
default ones can be known by all Sterling B2B Integrator customers.

About this task

Default user account passwords are preset at installation. For security purposes,
the system administrator should update all default user account passwords
immediately after installation is completed.

Default user accounts are listed below in the same order as they appear in the UI
under Accounts > User Accounts > List All. You can use this table to track the
user accounts you want to update.

User Account Name Update password

MBX_daemon

admin (*)

aft_user (*)

anon

as2_user

commandlineuser

dash_oper (*)

dash_part (*)

dash_prtspon (*)

dash_sponsor (*)

fg_architect

fg_operator

fg_provisioner

fg_sysadmin (*)

gmbx_user

ja_turbine

jane

jane_doe

joe_employee

joe_manager

joe_supplier

john

sd_buyer
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User Account Name Update password

sd_supplier

turbine

ws_buyer

ws_director

ws_employee

ws_finance

ws_hr

ws_manager

ws_purchaser

ws_supplier

(*) denotes a super user

To change the password for a user account, perform the following tasks.

Procedure

1. Log into Sterling B2B Integrator using ID = admin and password = password.
2. Go to Accounts > User Accounts. Under the List section click Go! All default

user account names are listed.
3. Click Edit next to the user account name you want to update the password for.
4. In the New Password and Confirm New Password fields, enter a new, secure

password for this User ID.

Note: Passwords must be at least six characters long.
5. Click Save and Finish.

What to do next

Repeat steps 3 - 5 for all user account names you want to update.

Download of the Sterling B2B Integrator tools:

After you install Sterling B2B Integrator, you can install tools like the Map Editor
and the Graphical Process Modeler (GPM).

Sterling B2B Integrator includes tools that run on a desktop or personal computer.
After you install Sterling B2B Integrator, you can install the following tools:
v Map Editor and associated standards

Note: The Map Editor requires a 32-bit JDK. This JDK is not provided with the
product download or media. For more information, see System Requirements.

v Graphical Process Modeler (GPM)
v Web Template Designer
v (If licensed) MESA Developer Studio plug-ins, including MESA Developer

Studio Software Development Kit (SDK) and MESA Developer Studio Skin
Editor

v (If licensed) Reporting Services, which require MESA Developer Studio if you
want to use the plug-ins to create fact models and custom reports
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Attention: Conflicting IP addresses can cause problems when you download a
desktop tool.

Properties files configuration in an iSeries environment:

Properties files contain properties that control the operation of Sterling B2B
Integrator.

For example, the REINIT_DB property in the sandbox.cfg file controls whether a
database is initialized when you install Sterling B2B Integrator.

By modifying the values of these properties, you can customize Sterling B2B
Integrator to suit your business and technical needs. Most properties files are in
the install_dir/install/properties directory.

After you install Sterling B2B Integrator, most properties files and scripts do not
need any further configuration for basic operation. However, if you want to
customize any specific operations, for example a different logging level, you need
to edit (or in some cases, create) certain property or .xml files.

Before you change any property files, see the properties file documentation for
general information about how to edit properties files.

You might need to make specific properties files changes after an installation in the
following areas:
v LDAP user authentication
v Prevention of cross-site script vulnerabilities
v Logging configuration
v Process-specific property file settings

Performing Initial Administrative Setups in Sterling B2B Integrator: If you are
installing Sterling B2B Integrator for the first time, you need to perform some
initial administrative setups before users can use the application. For example, the
system administrator for Sterling B2B Integrator must register users, grant
permissions, and run several performance reports so that benchmarks are
established for tuning the system in the future.

Add Third-Party Libraries:
About this task

If you added third-party libraries to configure adapters for the previous release,
you need to add each of the libraries again after you complete the upgrade. See the
documentation for each third party adapter you use.

Configure Services and Adapters:
About this task

You may need to reconfigure services and adapters after an upgrade. During an
upgrade, packages for services and adapters are reprocessed to update the service
configurations.

After an upgrade, the configurations of default adapters and services are re-set to
their default configurations. This includes directory paths, which are restored to
their default paths. You need to reconfigure those adapters and services, which
include, but are not limited to:
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v All default FTP adapters
v All default SFTP adapters
v Connect:Enterprise UNIX Server Adapter
v OdetteFTP Adapter
v SAP Suite Adapter
v SWIFTNet Client Service
v SWIFTNet Server Adapter

If you modified the standard configuration for a service or adapter, you may need
to reconfigure or reactivate the service or adapter following an upgrade. You may
also need to reconfigure adapters that used directories or scripts in the installation
directory of your previous release.

Examples of services and adapters that commonly need to be reconfigured
following an upgrade include:
v FTP adapter
v System services such as the Alert service and the BP Fault Log adapter

The following adapters need special consideration following an upgrade:
v JDBC Adapter and Lightweight JDBC Adapter
v File System Adapter and Command Line2 Adapters
v Odette FTP Adapter

Configure JDBC Adapter and Lightweight JDBC Adapter:
About this task

Storage locations of the database pool properties that allow the JDBC adapter and
the Lightweight JDBC adapter to communicate with your external database have
been streamlined. The poolManager.properties file has been eliminated and some
of its pool properties are now included in the jdbc.properties file, along with some
new properties. You will need to manually update your existing
jdbc_customer.properties.in file to add some new database pool properties. If you
do not have a jdbc_customer.properties.in file, create one since customer.properties
are not affected by product updates.

Configure File System Adapter and Command Line2 Adapters:
About this task

You must configure your File System and Command Line2 adapters before you
remove the previous release directory. Reconfigure any File System and Command
Line2 adapters that were configured to use directories or scripts in the installation
directory for the previous release. Ensure that you create new directories and save
scripts outside of the current installation directory and edit each configuration to
use the appropriate directories and scripts.

Consider the following:
v If you are using the Command Line2 adapter and have located the

CLA2Client.jar file anywhere other than the default location, you must replace it
with the new version. For information about the default location and how to
start the Command Line2 adapter, see the Command Line2 adapter.

v If you are upgrading to this version of Sterling B2B Integrator from a version
lower than 4.0.1 and are using the Command Line2 adapter, you must update
the version of the CLA2Client.jar file with the CLA2Client.jar located in the
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/install_dir/install/client/cmdline2 UNIX directory or in the
\install_dir\install\client\cmdline2 for Windows. If you installed the
CLA2Client.jar file anywhere other than the default location, you must replace
each copy of the file with the new version. If you only installed it in the default
location, the update occurs automatically during the upgrade process.

v If you are upgrading to this version of Sterling B2B Integrator from a version
prior to 4.0 and are using the Command Line adapter, you must update the
version of the CLAClient.jar file with the CLA2Client.jar located in the
/install_dir/install/client/cmdline2 UNIX directory or in the
\install_dir\install\client\cmdline2 for Windows. If you installed the
CLAClient.jar file anywhere other than the default location, you must replace
each copy of the file with the new version. If you only installed it in the default
location, the update occurs automatically during the upgrade process.

The CLA instances are now pointing to the CLA2 Service definition. After
importing old service instances of CLA onto Sterling B2B Integrator, you need to
reconfigure the imported CLA services to re-set the Remote Name and Remote
Port service configuration parameters. For more information, refer to the
documentation for the Command Line Adapter and Command Line2 Adapter.

Configure Odette FTP Adapter:
About this task

If you use the Odette FTP Adapter and are using the Partner Profile XML file
version 2.00 used in Sterling Gentran Integration Suite 4.3, you must modify it to
match the new Partner Profile version 3.00. To modify the XML file, refer to the
following table:

Section Name of Structure or Field Action Comment

Partner Profiles <GeneralParameters>

<PartnerProfileVersion>3.00

</PartnerProfileVersion>

</GeneralParameters>

Use correct version label of the
Partner Profile.

New Version
label: 3.00

Physical Partner Description Add field and description
content

Mandatory in
OFTP Partner
database

Physical Partner SubMailbox Add field, if used. Optional

Physical Partner <AuthenticationCertificate

type =”...”>

<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial> Bignumber_string

</Subject>

</AuthenticationCertificate>

Add Structure, if used. OFTP 2.0:
Mandatory for
security only.
Structure may
be repeated.
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Section Name of Structure or Field Action Comment

Physical Partner <AuthenticationCertificate

type =”Private Key”>

<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial>Bignumber_string

</Subject>

</AuthenticationCertificate>

Add Stucture, if used. OFTP 2.0:
Mandatory for
security only.

Physical
Partner/ CAPI

DWindowSize Delete field

Physical
Partner/ IP

IPFilter Uses IPv4 or
IPv6 addresses.

Physical Partner
IP

SSL Add field, if used. OFTP 2.0:
Mandatory for
security only.

Physical Partner
IP

CipherStrength Add field, if used. OFTP 2.0:
Mandatory for
security only.

Physical Partner
IP

<SSLCertificate

type =”...”>

<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial> Bignumber_string

</Subject>

</SSLCertificate>

Add structure, if used. OFTP 2.0:
Mandatory for
security, only.
Structure may
be repeated.

Physical Partner
Contract

Description Add field and description
content.

Mandatory in
OFTP Partner
database.

Physical Partner
Contract

MultipleLoginSessions Now used.

Physical Partner
Contract

DuplicateFilePeriod Rename

DuplicateFileProcessingTestings

To DuplicateFilePeriod

Physical Partner
Contract

SessionLogLevel Add fields. Optional

Physical Partner
Contract

GroupNameList Add fields, if used. Optional

Physical Partner
Contract

SecureAuthentication Add fields. OFTP 2.0:
Mandatory

Physical Partner
Contract

<TimeScheduleTable>

...

<TimeScheduleTable>

Delete structure and create
schedules in the Scheduler.

Initiator
Business
Process and
Business
Process user
fields are still
used.

Physical Partner
Contract

OdetteFTPAPILevel Rename OdetteAPILevel to
OdetteFTPAPILevel
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Section Name of Structure or Field Action Comment

Logical Partner Description Add field and description
content.

Mandatory in
OFTP Partner
database.

Logical Partner <FileServiceCertificate

type =”...”>
<Subject>string</Subject>

<Issuer>string</Issuer>

<Serial>string</Subject>

</FileServiceCertificate>

Add structure, if used. OFTP 2.0:
Mandatory for
security, only.
Structure may
be repeated.

Logical Partner
Contract

Description Add field and description
content.

Mandatory in
OFTP Partner
database.

Logical Partner
Contract

FileTransmissionRetries Rename FileTransmitRetries to
FileTransmissionRetries

Logical Partner
Contract

SignedEERPRequest Add field, if used.

Logical Partner
Contract

EERP/NERPSignatureCheck Add field, if used.

Logical Partner
Contract

File Signing Add field, if used.

Logical Partner
Contract

File Encryption Add field, if used.

Logical Partner
Contract

CipherSuite Add field, if used.

Logical Partner
Contract

File Compression Add field, if used.

Logical Partner
Contract

CharEncoding Add field, if used.

Logical Partner
Contract

Receive VitualFilenamePattern Add field, if used.

Logical Partner
Contract

EERPTimeout Rename WaitForEERP to
EERPTimeout

Logical Partner
Contract

FileScheduleTimeout Add field, if used.

Logical Partner
Contract

InboundBusinessProcess Add field, if used. Optional

Logical Partner
Contract

InboundBusinessProcessUser Add field, if used. Optional, if no
Inbound
business
process is
specified.

After changing the Partner Profile for version 3.00, import the Partner Profile into
the new Odette FTP Partner Profile database. For additional information, see
Odette FTP Partner Profile.

Restore Performance Tuning Configuration (iSeries):
About this task

To restore your original performance tuning configuration to the new release, use
the Performance Tuning Wizard. You use the wizard to re-enter the settings you
saved earlier.
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To restore the performance tuning configuration:

Procedure

1. From the Administration Menu, select Operations > System > Performance
>Tuning.

2. Under Edit, click Go!

3. Click Edit settings.
4. Complete the Performance Tuning Wizard, using the settings you obtained

from the previous release.

Changing the network interface bindings:

To increase the security of the Administrator Console user interface, Sterling B2B
Integrator binds only to specific network interfaces.

About this task

After installing, if the URL returns the error message Page cannot be displayed,
you can adjust the property settings to correct the problem.

Procedure

To change the network interface bindings:
1. On the server where Sterling B2B Integrator resides, edit the

noapp.properties_platform_ifcresources_ext.in file.
2. Locate the admin_host parameter:
v Where hostname1 is the name of primary network interface, which is the one

given highest priority by Sterling B2B Integrator.
v Where localhost is the name of the network interface on the server where

Sterling B2B Integrator resides.
admin_host.1 = hostname1

admin_host.2 = localhost

3. If no interface is being displayed, edit hostname1 so that it correctly identifies
the primary network interface that accesses Sterling B2B Integrator.

4. If an additional network interface needs to access Sterling B2B Integrator, add
an additional admin_host entry. For example:
v admin_host.1 = hostname1

v admin_host.2 = localhost

v admin_host.3 = hostname2

5. Stop Sterling B2B Integrator.
6. Open the install_dir/install/bin directory.
7. Enter the setupfiles.sh command.
8. Restart Sterling B2B Integrator.

Add Advanced File Transfer Tab:
About this task

The Advanced File Transfer tab will not be enabled by default after an upgrade. If
you have a license for Advanced File Transfer, perform the following steps to add
the Advanced File Transfer tab:
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Procedure

1. Log in as Admin.
2. Click Manage Layout.
3. Click Add Pane.
4. Enter the following name: Advanced File Transfer
5. Click Apply.
6. Click the customize icon for the new Advanced File Transfer tab.
7. Click Add Portlet.
8. Select the Add box for Advanced File Transfer Management.
9. Click Apply.

10. Select Clear Borders and Title from the Decoration menu.
11. Click Save and Apply.

Reconfigure Archive Settings:
About this task

The upgrade does not automatically reconfigure the archive configuration. You
must reconfigure the Backup Directory setting in Archive Manager after an
upgrade.

To reconfigure your Archive settings, use the following procedure:

Procedure

1. From the Administration Menu, select Operations > Archive Manager.
2. Next to Configure Archive Settings, click Go!

3. If a message displays about the UI Lock, click OK to continue.
4. Click Next.
5. Update the Backup Directory field with the correct path information:
6. Click Save.
7. Confirm the settings and click Finish.

Correct Missing Manager IDs:
About this task

If you created a Manager ID with no corresponding User ID in your previous
version, the Manager ID may be missing after upgrading. If this occurs, create a
user in the system with a User ID that matches the missing Manager ID.

Installation Maintenance

Determining the need for a fix pack in an iSeries environment:

Fix packs contain cumulative fixes for a specific version of Sterling B2B Integrator.

About this task

Fix packs are available on IBM Fix Central. Because each fix pack contains the fixes
from previous fix packs, you need to install only the most recent fix pack.

Information about a fix pack is in a PDF file with a similar name to the fix pack,
and is available for download with the fix pack JAR file.
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Before you install the fix pack, review the following items:
v Preserve your custom changes to system resources.
v The fix pack installation might use one or more fix pack property override files.

Do not alter these files.
v Property changes made directly in .properties or .properties.in files might be

overwritten during the fix pack installation. Properties that are overridden by
the customer_overrides.properties file are not affected. IBM recommends that
you maintain property file changes by using (when possible) the
customer_overrides.properties file. For more information, see the
documentation for using the customer_overrides.properties file.

v If you edited any of the cdinterop files, you must back them up before you
apply the fix pack. The cdinterop files do not have initialization (.in) files. After
you apply the fix pack, use the backup version of the files in your upgraded
installation. These files include the following files:
– cdinterop-proxy-records.properties

– cdinterop-spoe-auth.properties

– cdinterop-spoe-policy.properties

– cdinterop-user-records.properties

v Information about the upgraded installation is automatically logged to the
/install_dir/install/logs/InstallService.log file.

v If you need to roll back a fix pack, see “Fix Pack Changes Report” on page 309.
v During fix pack installation, the dbVerify utility compares the list of standard

indexes with the indexes that are present in the database and drops the custom
indexes. Recreate the custom indexes after the fix pack installation is complete.

Installing a fix pack or interim fix:

When available, you should install fix packs or interim fixes for Sterling B2B
Integrator in iSeries to keep your system current.

Procedure

To install the latest fix pack or interim fix for Sterling B2B Integrator in an iSeries
environment:
1. Open the IBM Fix Central website.
2. Download the most recent fix pack or interim fix for your version of Sterling

B2B Integrator and record the absolute path to the downloaded file. Do not
rename the file. If you use FTP, you must use Binary mode.

3. Log in to the server where Sterling B2B Integrator is installed with the user ID
and password that was used for the installation.

4. Stop Sterling B2B Integrator.
5. Perform a full backup of the Sterling B2B Integrator installation directory,

including all subdirectories.
6. Perform a backup of the database.
7. If you edited any property files, ensure that the associated .properties.in

files have the most current changes. Property files are overwritten with the
contents of the associated .properties.in files during the installation.

8. Sign on with your Sterling B2B Integrator user profile and enter into the QSH
(Qshell) mode.

9. In QSH, navigate to the /install_dir/bin directory where install_dir is the
Sterling B2B Integrator installation directory.
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10. Enter:
./InstallService.sh <path>/<file_name>

Where:
<path> is the fully qualified path to the fix pack or interim fix file
<file_name> is the name of the fix pack or interim fix file

If the fix pack or interim fix attempts to modify the database schema and the
modification fails, you receive an error message about the failure. The
message provides the error message code from the database and the SQL
command that failed. The failure information is also logged to the system.log
file (in the /install_dir/install directory) and to the fix pack.log file.
Attention: Running InstallService.sh removes any previously installed
interim fix to prevent conflicts with what is being installed.

11. Press Enter to continue.
Information about the fix pack or interim fix is displayed. After the fix pack or
interim fix is applied, the following message is displayed:
Deployment to application server successful

When the $ is displayed, the process completes.
12. Start Sterling B2B Integrator.

Preserving custom changes for system resources:

When you update Sterling B2B Integrator, you can preserve your custom changes
to system resources like workflow definitions and maps.

About this task

During updates, the system can identify when you make a custom change to
Sterling B2B Integrator versus a change through an upgrade or fix pack.

When a fix pack, installation or upgrade is performed, a baseline record of system
resources is created. This baseline is not affected by any subsequent customer
changes. When another fix pack is installed, the resources in this baseline are
compared to the resources in the existing system. If a baseline and existing
resource are not the same, that means that the existing resource was customized
and was not overwritten by the fix pack.

During an update, the baseline is updated with new system resource information,
but not with custom changes to resources.

DB Checksum tool:

A checksum is a simple redundancy check used to detect errors in data.

In Sterling B2B Integrator, a verification process compares the checksum between
the existing default resource and the resource that was added after applying a fix
pack or upgrading. The DB Checksum tool, a resource difference tool generates a
granular report of the changes in the system that was not permitted to be set as
defaults.

The DB Checksum tool generates the difference in resource checksum between the
default resource and the latest system resource from the database.
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Performing a checksum:

Use a command to run the DB Checksum tool.

Procedure

To run the DB Checksum tool:
1. Open the /install_dir/install/bin directory.
2. Enter the following command:

./db_checksum_tool.sh [-d] [-i [1 | 2 | 3 | 4 | 5]]
[-r [wfd | map | schema | sii | template]] [-o <output file>] [-g]

Where:
v -d is the mode to dump the difference of resource checksum between the

default resource and latest system resource.
v -i is the resource type integer (optional).
v 1 is WFD.
v 2 is MAP.
v 3 is SCHEMA.
v 4 is SII.
v 5 is TEMPLATE.
v -r is the resource name (optional). For example, wfd, map, schema, sii, or

template.
v -o is the file name to output all the messages (optional).
v -g is the file name that lists all the ignored resources (optional).
v -h is the help screen.

The DB Checksum tool performs the relevant checksum operation that is based
on the command options and generates the output message.

Fix Pack Changes Report:

The Fix Pack Changes Report is used to obtain information if you need to roll back
a fix pack.

The fix pack report can be found in the installation directory fix pack_reports
folder. The report contains the following fix pack information:
v Fix pack ID
v Fix pack changes
v Number of files deleted
v Number of JAR files removed
v Number of JAR files added
v Number of files added
v Number of files changed
v Number of properties added
v Number of business processes added
v Number of service instances added
v Number of service definitions added
v Number of templates added
v Number of reports added
v Number of maps added
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v Number of schemas added
v Number of business rules added

For example, the installation directory fix pack_reports folder contains the fix
pack_Report.html file. When you open this file, you can view the fix pack
information.

Example: Fix Pack Changes Report:

The Fix Pack Changes Report includes both summary and detailed report
information.

The following is an example of a Fix Pack Changes Report:
Summary of Changes
Fix Pack ID: Platform_2.0
Fix Pack Changes: 1287
Number of Files Deleted: 0
Number of JARs Removed: 2
Number of JARs Added: 0
Number of Files Added: 3
Number of Files Changed: 3
Number of Properties Added: 4
Number of BPs Added: 4
Number of Service Instances Added: 2
Number of Service Definitions Added: 3
Number of Templates Added: 0
Number of Reports Added: 0
Number of Maps Added: 3
Number of Schemas Added: 3
Number of Business Rules Added: 0
________________________________________
List of JARs Removed:
JAR Removed: /SAMPLE_INSTALL_1/jar/jaf/1_0_2/activation.jar
Time: Wed May 13 15:23:08 EDT 2009
JAR Removed: /SAMPLE_INSTALL_1/jar/commons_logging/1_0_3/commons-logging-api.jar
Time: Wed May 13 15:23:08 EDT 2009
________________________________________
List of Files Added:
File Added: /SAMPLE_INSTALL_1/bin/sql/fix_db2_schema.sql
Time: Wed May 13 15:21:30 EDT 2009
File Added: /SAMPLE_INSTALL_1/bin/sql/fix_db2iseries_schema.sql
Time: Wed May 13 15:21:30 EDT 2009
File Added: /SAMPLE_INSTALL_1/bin/errorQueueManager.sh.in
Time: Wed May 13 15:21:30 EDT 2009
________________________________________
List of Files Changed:
File Changed: /SAMPLE_INSTALL_1/properties/lang/en/Reports_en.properties
File Changed: /SAMPLE_INSTALL_1/properties/lang/es/Reports_es.properties
File Changed: /SAMPLE_INSTALL_1/properties/lang/fr/Reports_fr.properties
________________________________________
List of Properties Added:
Property Added: /SAMPLE_INSTALL_1/properties/filesToRemove.txt
Property Added: /SAMPLE_INSTALL_1/properties/filesToRemove.txt.in
Property Added: /SAMPLE_INSTALL_1/properties/csr.properties.sample
Property Added: /SAMPLE_INSTALL_1/properties/csr.properties.sample.in
________________________________________
List of BPs Added:
BP Added: Schedule_AssociateBPsToDocs.bpml version: 4
Time: Wed May 13 15:23:07 EDT 2009
BP Added: Recovery.bpml version: 17
Time: Wed May 13 15:23:07 EDT 2009
BP Added: Schedule_AutoTerminateService.bpml version: 10
Time: Wed May 13 15:23:07 EDT 2009
BP Added: Schedule_DBMonitorService.bpml version: 1
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Time: Wed May 13 15:23:08 EDT 2009
________________________________________
List of Service Instances Added:
Service Instance Added: RetentionProcessor version: 2
Time: Wed May 13 15:23:28 EDT 2009
Service Instance Added: MESAHttpServerAdapter version: 1
Time: Wed May 13 15:25:11 EDT 2009
________________________________________
List of Service Definitions Added:
Service Definition Added: LockServiceType
Time: Wed May 13 15:22:58 EDT 2009
Service Definition Added: XAPIServiceType
Time: Wed May 13 15:22:59 EDT 2009
Service Definition Added: CleanLockServiceType
Time: Wed May 13 15:22:59 EDT 2009
________________________________________
List of Templates Added:
Template Added: Normalize
Time: Wed May 13 15:23:26 EDT 2009
Template Added: Derive
Time: Wed May 13 15:23:26 EDT 2009
________________________________________
List of Maps Added:
Map Added: IBMPutResponseToXML
Time: Wed May 13 15:24:05 EDT 2009
Map Added: http_headers
Time: Wed May 13 15:24:36 EDT 2009
Map Added: OracleHttpHeaders
Time: Wed May 13 15:24:51 EDT 2009
________________________________________
List of Schemas Added:
Schema Added: E5_V20_Acknowledge_Result.dtd from file: E5_V20_Acknowledge_Result
Time: Wed May 13 15:24:36 EDT 2009
Schema Added: E5_V20_Acknowledge_Submit.dtd from file: E5_V20_Acknowledge_Submit
Time: Wed May 13 15:24:36 EDT 2009
Schema Added: E5_V20_APIs_Result.dtd from file: E5_V20_APIs_Result
Time: Wed May 13 15:24:36 EDT 2009

License modifications:

After the installation finishes, you can modify the software licenses that you
loaded with the AddLicenseSet command.

The AddLicenseSet command is in the bin directory of your UNIX or Windows
installation. After the initial installation, the license files are in the following
directories:
v UNIX - /install_dir/install/properties/licensefiles
v Windows - \install_dir\install\properties\licensefiles
v iSeries - /install_dir/properties/licensefiles

You can add licenses or review the license list from the UI. On the Administration
Menu, click System > B2B Console > Operations > System > Licenses.

AddLicenseSet Command Parameters

Use the AddLicenseSet command to modify a single license file or the entire license
file directory.

To use the AddLicenseSet command, you must do the following:
v Open the bin directory
v Include the absolute path to the license file directory or to a license file
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The AddLicenseSet command has the following parameters:

AddLicenseSet Parameter Description

-reload Use this parameter to reload the license files.

This parameter deletes all of the license files from the
database before the new files are loaded. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/
old_licenses

v Windows - \install_dir\install\logs\security\
old_licenses

v iSeries - /install_dir/logs/security/old_licenses

-upgrade Use this parameter during an upgrade only.

This parameter deletes all of the old license files from the
database and installs the new license files. The old license
files are saved to the following locations:

v UNIX - /install_dir/install/logs/security/upgrade

v Windows -\install_dir\install\logs\security\upgrade

v iSeries -/install_dir/logs/security/old_licenses

The AddLicenseSet command will check if Sterling B2B Integrator is running. If it
is running, the command will call the Ops server to refresh the license from the
database. If you have any problems with your licenses after running the
AddLicenseSet command, stop and restart Sterling B2B Integrator.

License Modification: Examples:

There are several different ways you can use the AddLicenseSet command to
modify your licenses.

UNIX Examples

From the install_dir/bin directory:

Scenario Command usage (UNIX example)

Reload a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -reload

Reload all of the license files
in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -reload

Upgrade a single license file ./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

./AddLicenseSet.sh /install_dir/install/properties/
licensefiles/ -upgrade

Windows Examples

From the install_dir\bin directory:

Scenario Command usage (Windows example)

Reload a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -reload
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Scenario Command usage (Windows example)

Reload all of the license files
in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -reload

Upgrade a single license file AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\SI_SFG_License.xml -upgrade

Upgrade all of the license
files in the directory

AddLicenseSet.cmd\install_dir\install\properties\
licensefiles\ -upgrade

Updating your JDK on iSeries
Sometimes you need to update the JDK used by Sterling B2B Integrator.

To update from the classic JDK 1.6 to J9 JDK 1.6 or from J9 JDK 1.6 to J9 JDK 1.7,
begin by stopping Sterling B2B Integrator.

To stop Sterling B2B Integrator on iSeries, in QSH, run the command:
./hardstop.sh.

Then perform the following steps as needed:
1. “Preparing the user profile for the new JDK” on page 313
2. “Downloading the JDK Update Files” on page 314
3. “Running the Update JDK Program” on page 314

Preparing the user profile for the new JDK:

The Sterling B2B Integrator user profile must be set up to point to the correct JDK.

About this task

Perform the following steps if you are going from the Classic JDK 1.6 to the J9 JDK
1.6 or to J9 JDK 1.7. This will point your Sterling B2B Integrator user profile to the
appropriate JDK:

Procedure

1. Log on to the Sterling B2B Integrator user profile.
2. Create a home directory for the Sterling B2B Integrator user profile.

a. From an iSeries command line, enter: MKDIR /home/appuser, where appuser
represents theSterling B2B Integrator user profile.
If the home directory for your Sterling B2B Integrator user profile already
exists, ignore this step.

b. Enter EDTF and press F4.
c. Enter /home/appuser/.profile and press Enter. An edit session is displayed.
d. If you are converting to J9 JDK 1.6, enter the following on the first line:

export JAVA_HOME=/QOpenSys/QIBM/ProdData/JavaVM/jdk60/64bit

e. If you are converting to J9 JDK 1.7, enter the following on the first line:
export JAVA_HOME=/QOpenSys/QIBM/ProdData/JavaVM/jdk70/64bit

f. Press F2, then F3 to save and exit.
3. Log off and then log back on.
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Results

The Sterling B2B Integrator user profile should now be pointing to the correct JDK.
To verify, perform the following steps:
1. At the iSeries command line, key in qsh and press Enter.
2. Key in java –version to verify that it displays the correct JDK version.

Downloading the JDK Update Files:

You will need to download some files to update your Sterling B2B Integrator JDK
on iSeries.

About this task

To download the upgrade files necessary for upgrading your Sterling B2B
Integrator JDK:

Procedure

1. Is there a saved file named UPDJDKSAVF in QGPL on your iSeries?
v Yes - Enter CLRSAVF FILE(QGPL/UPDJDKSAVF) to clear the save file from your

iSeries.
v No - Enter CRTSAVF FILE(QGPL/UPDJDKSAVF) to create a save file on your

iSeries.
2. Copy the UPDJDKSAVF file from Sterling B2B Integrator Installation

Directory/bin/updjdksavf to the save file created in QGPL by entering:
CPYFRMSTMF FROMSTMF(`Sterling B2B Integrator Installation
Directory/bin/updjdksavf’) TOMBR(`/QSYS.LIB/QGPL.LIB/
UPDJDKSAVF.FILE') MBROPT(*REPLACE) CVTDTA(*NONE)

3. To restore the upgrade objects, enter: RSTLIB SAVLIB(UPDATEJDK) DEV(*SAVF)
SAVF(QGPL/UPDJDKSAVF)

4. To add the installation programs to your library list, enter: ADDLIBLE
LIB(UPDATEJDK)

Running the Update JDK Program:

Run the Update JDK program to update your Sterling B2B Integrator JDK on
iSeries.

About this task

To run the Update JDK program in iSeries:

Procedure

1. Key in UPDATEJDK from an iSeries command line and press F4.
2. For the SI Installation Directory parameter, enter your Sterling B2B Integrator

installation directory.
3. For the JDK switching from parameter:, enter:
v 1 - If you are currently using the Classic JDK 1.6
v 2 - If you are currently using the J9 JDK 1.6

4. For the New JDK parameter:, enter:
v 1 - If you are upgrading to the J9 JDK 1.6
v 2 - If you are upgrading to the J9 JDK 1.7
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5. Press Enter

6. From an iSeries command line, enter qsh to enter into the qshell mode.
7. Change to your Sterling B2B Integrator installdir/bin directory.
8. Enter ./setupfiles.sh. This changes the preliminary files to the new JDK.
9. Key in ./deployer.sh and press Enter. This will change the remaining property

files and point Sterling B2B Integrator to the new JDK location.

Results

Your JDK is now updated and you are ready to start Sterling B2B Integrator.

Moving Sterling B2B Integrator to another iSeries
You can move Sterling B2B Integrator from one iSeries to another.

About this task

To move Sterling B2B Integrator to a different iSeries:

Procedure
1. On the old iSeries, perform the following steps:

a. Ensure that Sterling B2B Integrator has been stopped.
b. Create a save file to hold the database using the following command:

CRTSAVF mylib/SIDBASE

c. Create a save file to hold the install directory using the following command:
CRTSAVF mylib/INSTALLDIR

d. Save the database with the following command: SAVLIB LIB(dbname)
DEV(*SAVF) SAVF(mylib/SIDBASE), replacing dbname with the collection name
of the production Sterling B2B Integrator instance.

e. Save the install directory using the following command: SAV
DEV('/QSYS.LIB/mylib.LIB/INSTALLDIR.FILE') OBJ(('/installdir')),
replacing installdir with the installation directory of production Sterling B2B
Integrator instance.

2. On the new iSeries, create a Sterling B2B Integrator user profile that matches
the user profile from your old iSeries. Set up the correct JDK for this new
profile.

3. On the new iSeries, sign on with your Sterling B2B Integrator user id and
password. Then perform the following steps:
a. Create a save file to hold the database using the following command:

CRTSAVF mylib/SIDBASE

b. Create a save file to hold the install directory using the following command:
CRTSAVF mylib/INSTALLDIR

c. Create a collection for the new database.
1) Key in STRSQL and press Enter.
2) On the interactive sql line, key in CREATE COLLECTION newcoll , replacing

newcoll with the name of the collection from your old Sterling B2B
Integrator database collection.

3) Press Enter.
4) Once created, press F3 and select option 1 to exit.

d. FTP the two save files from the old iSeries to the new iSeries box to the
target box For example:
v Get mylib/SIDBASE mylib/SIDBASE
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v Get mylib/INSTALLDIR mylib/INSTALLDIR

e. Restore the database into the new collection with the following command:
RSTLIB SAVLIB(dbname) DEV(*SAVF) SAVF(mylib/SIDBASE) RSTLIB(newcoll)

f. Restore the production Sterling B2B Integrator instance into a new location
with the following command: RST DEV('/QSYS.LIB/mylib.lib/
INSTALLDIR.FILE') OBJ(('/installdir')) replacing installdir with the
installation directory where the production instance of Sterling B2B
Integrator resided on the old iSeries.

g. Once the installation directory has been restored, update the following in
the installdir/properties/sandbox.cfg file, if applicable.
v IP address
v Host name
v User ID and Password

h. If you are not updating the jdk at this point, from QSH:
1) Change to your Sterling B2B Integrator installdir/bin directory.
2) Key in ./setupfiles.sh

Results

This completes the process of moving your Sterling B2B Integrator instance.

Setting up a new iSeries for Sterling B2B Integrator
You may set up Sterling B2B Integrator on a new iSeries.

About this task

To set up Sterling B2B Integrator on a new iSeries:

Procedure
1. Setting up the domain is very important. From an iSeries command line, key in:

GO CFGTCP You will then need to set up three different option screens.
2. Option 1 - Work with TCP/IP interfaces. On this screen, you need to have the

IP address for the box as well as a loopback entry. Here is an example screen:
Work with TCP/IP Interfaces System: NOGO
Type options, press Enter.

1=Add 2=Change 4=Remove 5=Display 9=Start 10=End
Internet Subnet Line Line

Opt Address Mask Description Type
xx.xx.xxx.xx xxx.xxx.xxx.x ETHLINE01 *ELAN
xxx.x.x.x xxx.x.x.x *LOOPBACK *NONE

3. Option 10 - Work with TCP/IP Host Table Entries You also need to set up your
IP address and loop back entry here. This is where you put in the host name.
Here is a sample of an iSeries box with the name of NOGO. You may also have
a few extra entries for other boxes as well.
Work with TCP/IP Host Table Entries System: NOGO
Type options, press Enter.

1=Add 2=Change 4=Remove 5=Display 7=Rename
Internet Host

Opt Address Name
xx.xx.xxx.xxx hostname.xxx.mysite.com

hostname
xx.xx.xxx.xx OTHERBOX5
xx.xx.xxx.xxx hostname-old
xxx.x.x.x LOOPBACK

LOCALHOST
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4. The last one to set up is option 12 - Change TCP/IP Domain. Here you identify
the host name and the domain name. Here is an example of this screen:

Change TCP/IP Domain (CHGTCPDMN)
Type choices, press Enter.
Host name . . . . . . . . . . . ’hostname’
Domain name . . . . . . . . . . ’domain.MYSITE.COM’
Domain search list . . . . . . . ’domain.mysite.com workstn-qa.local

sci.localdomain.mysite.com’
Host name search priority . . . *LOCAL *REMOTE, *LOCAL, *SAME
Domain name server:
Internet address . . . . . . . ’xxx.xx.xxx.xx’

This screen has caused issues in the past with the Domain name server
(Internet address). If the DNS server is old and doesn't recognize IPv6, then
having IP addresses in this field can cause serious issues and your Sterling B2B
Integrator instance will not start up. If this occurs, remove the IP addresses
from the domain name server internet address field.

Uninstall the Software

Uninstalling Sterling B2B Integrator from an iSeries Environment:

When you uninstall Sterling B2B Integrator, the software is automatically removed
from the server.

Procedure

To uninstall the software from an iSeries environment:
1. Stop Sterling B2B Integrator and wait for the shutdown to complete.
2. Sign onto iSeries with your Sterling B2B Integrator user profile.
3. In QSH, change to the directory above the installation directory. For example, if

the installation directory is /product/SI_Install, then change to the /product
directory.

4. Remove the installation directory by entering the following command:
rm -rf install_dir

5. Wait for the command line to return.
6. Select F3 exit from Qshell.
7. Enter DLTLIB <collection name>. For example, DLTLIB (Sterling B2B

Integrator)DB. The following kind of messages are displayed:
Receiver QSQJRN0001 in (Sterling B2B Integrator)DB never fully saved. (I C).

8. Enter I to one or more of these messages until the library is deleted.
9. After you remove the software from the server, you can remove Eclipse and

any tools that were downloaded to the desktop, including the following tools:
v Map Editor and associated standards. Refer to the Map Editor Guide for

information about removing the Map Editor.
v Graphical Process Modeler. Refer to the Graphical Process Modeler Guide for

information about removing the Graphical Process Modeler.
v Web Template Designer. Refer to the Web Extensions Guide for information

about removing the Web Template Designer.
v (If licensed) MESA Developer Studio plug-ins, including the following tools:

– MESA Developer Studio Software Development Kit (SDK).
– MESA Developer Studio Skin Editor.
Refer to the MESA Developer Studio guide for information about removing
MESA Developer Studio.
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v (If licensed) Reporting Services, which require MESA Developer Studio if you
want to use the plug-ins to create fact models and custom reports. Refer to
the MESA Developer Studio guide for information about removing Reporting
Services.

User Documentation

User Documentation:

The user documentation is available from an online documentation site on the
web.

Providing the documentation in an online environment allows for frequent updates
of content that is based on user feedback and usability.

If you need a printed copy of the documentation, you can print topics of
information through your Internet browser, or you can download documents in
PDF format, after you add it to a collection on IBM Knowledge Center.

To access the documentation site from within Sterling B2B Integrator or one of its

tools, select the help 
 

icon. The system must reside on a computer that supports
Internet access and an Internet browser.

Improving your access to online documentation:

You can improve your access to online documentation by using several methods.

About this task

After you access the IBM Knowledge Center, you can perform the following tasks:
v Enter a word or phrase and search the entire library for information.
v Move through a hierarchy of contents pages to identify the topic you want to

read or print.
v Print topics by using your browser's Print function.
v Add documents to your collection and download them in PDF format.

Troubleshooting Tips

Installation and upgrade troubleshooting tips: iSeries environment:

If you have trouble while installing or upgrading Sterling B2B Integrator on iSeries,
different troubleshooting techniques are available.
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Situation Message or Symptom Explanation/Resolution

Installing a desktop
tool or resource

Cannot download any of the
following tools:
Note: MESA Developer Studio
and Reporting Services are
optional features that are
purchased separately from
Sterling B2B Integrator. These
features each require a separate
license in addition to your
license for Sterling B2B
Integrator.

v Map Editor and associated
standards

v Graphical Process Modeler

v Web Template Designer

v (If licensed) MESA Developer
Studio plug-ins (Software
Development Kit (SDK), Skin
Editor)

v (If licensed) Reporting
Services, which require MESA
Developer Studio if you want
to use the plug-ins to create
fact models and custom
reports

Explanation

When you install Sterling B2B
Integrator, system files are
created that contain an internal
IP address. If you install Sterling
B2B Integrator behind a firewall,
and your firewall is configured
to accept an external IP address
from a client computer, you
might not be able to download
the desktop tools and resources.
The firewall rejects the IP
address from a client that exists
outside of the firewall.

Resolution

Modify the system files that
contain the invalid IP address:

1. Open the /install_dir/bin
directory.

2. Stop Sterling B2B Integrator.

3. Enter the following
command followed by the
external IP address:

patchJNLP.sh
external_IP address

4. Restart Sterling B2B
Integrator.

Accessing Attempts to access the URL for
Sterling B2B Integrator display
the message: Page cannot be
displayed.

Resolution

Change the Network Interface
Bindings.

Installing and upgrading (V5.2.6 or later) 615



Situation Message or Symptom Explanation/Resolution

Stopping Ending jobs from Sterling B2B
Integrator when a hardstop is
not successful.

Explanation

There was a problem during the
installation process or the
subsystem was not defined
correctly.

Resolution

1. Enter WRKACTJOB and locate
the job that did not end
successfully.

2. Press F11 twice to obtain the
job number that you want
to end.

3. Press F3 to end the
WRKACTJOB panel.

4. Enter QSH to enter Qshell
mode.

5. Enter ps and press Enter.

6. Locate the pid number that
corresponds to job number
from the WRKACTJOB
panel.

7. Enter kill -kill <pid
number>
kill -kill <pid number>.

8. Review the installation log
to determine the error and
resolution.

9. If the error is due to a
problem with the
installation, then delete the
installation directory and
install the software again.

10. If the error is due to the job
queue having 1 as the
maximum number of active
jobs in the subsystem, then
either change the subsystem
that you start Sterling B2B
Integrator in, or change the
number of maximum active
jobs.
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Situation Message or Symptom Explanation/Resolution

e-Invoice Upgrade:
Oracle Add
Constraint Error

When you upgrade Sterling
e-Invoicing and are using an
Oracle database, the upgrade
fails with the error message name
is already used by an existing
object. This error occurs because
the default behavior for the drop
constraint command changed
in Oracle 10.

The index that is used to
support the constraint is only
removed if the index was
generated by the create
constraint command. The
indexes for Sterling e-Invoicing
are always generated from
constraints during an
installation.

If you receive this error during a
Sterling e-Invoicing upgrade, it
is because of how the database
was restored, the version of
Oracle you are using, and
because the Oracle imp command
exported the indexes and
constraints separately. There is
no way to determine when the
imp command does not add a
create index command to the
export file if it was generated by
a constraint. But if it does add
the command, the database
restore process loses the
association of the constraint and
its underlying index.

The database script that runs
during a Sterling e-Invoicing
upgrade runs two steps:

1. The script drops the unique
constraint so the next step
can redefine it using
additional columns.
However, the drop constraint
command does not remove
the underlying index if the
association with its index
was lost.

2. The next command that
redefines this constraint
requires a different index
definition, but in this
scenario the name of the
index the constraint wants to
use exists, which causes the
error name is already used
by an existing object.

Resolution

If you receive this error message,
the solution for this problem is
to drop the index and rerun the
Sterling e-Invoicing upgrade.
The drop index command that
you should use is:

drop index UNQ_EINV_CANON
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Installing or updating with a response file (V5.2.6 or later)
You can install or update (apply fix pack or interim fix) Sterling B2B Integrator
with silent mode by using the sample response files or converting your existing
response file to the required format.

Sample response files (V5.2.6 or later)
Sample response files are provided with Sterling B2B Integrator. The response file
is an XML file that can be modified and used to install Sterling B2B Integrator and
its features.

You must edit the provided sample response files with information specific to your
installation environment. Follow the instructions in the sample response file to
replace values that are designated within $$<variable>$$. You can then use the file
to install initial and additional Sterling B2B Integrator nodes.

You can also record a response file using the GUI install mode and use the file to
install initial and additional nodes. While recording the response file, you can use
the skipInstall option to skip actual installation and record the file. For more
information, see “Recording a response file (V5.2.6 or later)” on page 621.

Response files can be used in either silent or GUI installation modes. In GUI mode,
the user interface is prepopulated with the data from the response file.

The following sample response files are packaged with Sterling B2B Integrator:

responseFile_GM_Prereqs_V526.xml
This file is Global Mailbox specific and must be used to install Cassandra
and ZooKeeper.

responseFile_B2Bi_GM_V526.xml

Use this file to install Sterling B2B Integrator. It can also be used to install
Global Mailbox.

responseFile_update_B2Bi.xml
Use this file to upgrade from Sterling B2B Integrator V5.2.x and to apply
fix packs.

Additionally, the following sample response files can be used to install an interim
fix:
v responseFile_iFix_GM.xml

v responseFile_iFix_B2Bi_GM.xml

v responseFile_iFix_B2Bi.xml

Sample response files for interim fix installation are located in the
ResponseFiles/SampleResponseFiles directory of the interim fix package.

When using the sample response files or files that you might have recorded, you
must modify values for parameters specific to your installation environment and
also based on whether you are installing initial or additional Sterling B2B
Integrator nodes.

The following table provides details about parameters that must be modified based
on your installation scenario:
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Remember: You must also modify the variables enclosed in $$<variable>$$ within
the response file.

Installation scenario
Parameters that must be
modified Must be modified to what?

Why the parameter must
be modified?

Installing first Sterling B2B
Integrator node.

v user.sb.CLUSTER

v user.CLUSTER_NODE_NUM

Sample response file -
responseFile_B2Bi_GM
_V526.xml

Set user.sb.CLUSTER to
false and do not specify
any value for
user.CLUSTER_NODE_NUM.

Setting user.sb.CLUSTER to
false indicates that the
node is not yet clustered
and not specifying value
for user.CLUSTER_NODE_NUM
indicates that the node is a
single or first node.

Installing second and
subsequent Sterling B2B
Integrator nodes.

v user.sb.CLUSTER

v user.CLUSTER_NODE_NUM

v features

Sample response file -
responseFile_B2Bi_GM
_V526.xml

Set the following values for
the parameters:

v user.sb.CLUSTER=’true’

v user.CLUSTER_NODE_NUM -
Specify the node number
in the cluster (2 or
higher)

Setting user.sb.CLUSTER to
true indicates that the node
is part of a cluster. The
value set for
user.CLUSTER_NODE_NUM
indicates the node number
in the cluster.

Installing the following
optional Sterling B2B
Integrator features:

v Sterling File Gateway

v FIPS Module

v AS2 Edition Module

v Financial Services
Module

v EBICS Banking Server
Module

v B2B Advanced
Communications
Integration Module

features

Sample response file -
responseFile_B2Bi_GM
_V526.xml

You must add the feature
name to the features
parameter. For example,
features=’main.feature,
initial.external
.ds.feature,
filegateway.feature,
fips.feature,
as2.feature,
financial.feature,
ebics.features,
meigIntegration.feature’

To install optional Sterling
B2B Integrator features.

Installing two nodes of a
cluster installation on the
same server.

user.sb.PORT1

Sample response file -
responseFile_B2Bi_GM
_V526.xml

NA The difference between the
value of user.sb.PORT1 on
any two nodes of a cluster
installation on the same
machine must be at least
200.
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Installation scenario
Parameters that must be
modified Must be modified to what?

Why the parameter must
be modified?

Database connection
information in different
data centers when installing
initial and additional
Sterling B2B Integrator
nodes.

v
user.sb.DB_CREATE_SCHEMA

v user.sb.DB_USER

v user.sb.DB_PASS

v user.dbconfirmPassword

v user.sb.DB_DATA

v user.sb.DB_HOST

v user.sb.DB_PORT

v user.sb.DB_DRIVERS

v
user.sb.USE_SERVICE_NAME

v user.sb.ORACLE_JDBC_URL

Sample response file -
responseFile_B2Bi_GM
_V526.xml

NA Modify database connection
information to point to the
database specific to the
data center, where you are
installing Sterling B2B
Integrator nodes.

Set the
user.sb.DB_CREATE_SCHEMA
parameter to true for the
first node in a cluster. For
subsequent nodes, set it to
false.

Installing on a Sterling B2B
Integrator node that uses a
non-DB2 database.

user.sb.DB_VENDOR Set to the type of database.

v DB2 (Default)

v Oracle

v MSSQL2005 (Use for both
SQL Server 2005 and
SQL Server 2008)

v MSSQL2012

The user.sb.DB_VENDOR
parameter specifies the type
of database used by the
Sterling B2B Integrator
node.

Upgrading from Sterling B2B Integrator V5.2.x

When you upgrade from Sterling B2B Integrator V5.2.x, you can use the sample
response file, responseFile_update_B2Bi.xml for reference. You can also use the
sample file for reference when installing fix packs.

You must begin by changing your current installation properties file to the XML
format response file. For more information about changing your installation
properties file to XML format response file, see “Converting Sterling B2B Integrator
.txt silent file to XML (V5.2.6 or later)” on page 623.

Encrypting passwords

You must encrypt values for the following properties by using the imutilsc utility
in the <IIM install_dir>/eclipse/tools directory:
v user.RestAuthPass

v user.RestAuthPassConfirm

v user.sb.DB_PASS

v user.dbconfirmPassword

To encrypt you must go to the <IIM install_dir>/eclipse/tools directory, type
the imutilsc encryptString <string to encrypt> command, and then paste the
output as the property value. For example, to encrypt storage passphrase type
imutilsc encryptString <passphrase of storage>.
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Recording a response file (V5.2.6 or later)
A response file is an XML file with configuration information required for
installing or upgrading. You can record a response file when installing and
updating Sterling B2B Integrator and use the response files to install or update
additional nodes.

About this task

A response file is an XML file with configuration information from a previous
installation. It provides the input that is required for installation or upgrade. Most
of the configuration details and other information that is required for installing and
updating Sterling B2B Integrator nodes are recorded in the response file. However,
you must modify values for some parameters based on whether you are installing
or updating initial or additional nodes or clustered and non-clustered
environments.

To record a response file:

Procedure

To start the Installation Manager and provide the command to record a response
file, do one of the following tasks, based on your operating system and Installation
Manager setup:
v Go to the IM_<operating_system> folder and use one of the following

commands, if you do not have the Installation Manager installed and you are
using the Installation Manager agent provided with V5.2.6, if you have installed
a 64-bit Installation Manager, or if you have the Installation Manager installed
on a platform that has only one download available for Installation Manager. For
example, AIX, Solaris, HP, zLinux, or Windows:
– ./userinst -record /response_files/<response_filename>.xml (AIX, Solaris,

HP, zLinux)
– userinst.exe -record c:\response_files\<response_filename>.xml

(Windows)
For example, on an AIX system, to record a response file test_response.xml and
save it in the /response_files directory, type ./userinst -record
/response_files/test_response.xml

v Go to the <installation directory>/Installation Manager/eclipse folder (for
Windows systems, change / to \), and use one of the following commands based
on your operating system, if you have a 32-bit Installation Manager installed on
a Linux or Windows system:
– ./IBMIM -record /response_files/<response_filename>.xml (Linux)
– IBMIM.exe -record c:\response_files\<response_filename>.xml (Windows)
For example, on a Linux system, to record a response file test_response.xml
and save it in the /response_files directory, type ./IBMIM -record
/response_files/test_response.xml

Installing or updating with a response file (V5.2.6 or later)
You can use the response files that are recorded when installing or updating
Sterling B2B Integrator. You can also use the sample response files that are
provided with Sterling B2B Integrator V5.2.6.
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Before you begin

Ensure that you have the appropriate response file to use for installing or updating
(applying fix pack or interim fix) Sterling B2B Integrator and the databases
installed and configured.

Ensure that IBM Installation Manager is installed. If the userinstc command is run
without IBM Installation Manager installed, it does not install or update Sterling
B2B Integrator, but installs IBM Installation Manager instead.

About this task

A response file is an XML file with configuration information that can be used for
installing or updating Sterling B2B Integrator. Most of the configuration details and
other information that is required for installing and updating Sterling B2B
Integrator nodes are recorded in the response file. However, you must modify
values for some parameters based on whether you are installing or updating initial
or additional nodes or clustered and non-clustered environments. For more
information about parameters that must be modified, see “Sample response files
(V5.2.6 or later)” on page 618.

Silent installations minimize the requirement to reenter the same information or
potential errors while keying in the configuration information. Nevertheless, you
must change values of some parameters because the server and the environment
where you install the additional nodes might differ.

Important: Because the silent mode allows reuse of most of the configuration and
reduces mistakes when manually keying in information on the user interface, using
the appropriate response file to install Sterling B2B Integrator is the preferred
method, over using the user interface.

To install or update (fix pack or interim fix) Sterling B2B Integrator node using a
response file:

Tip: You can record a response file when updating your current installation and
use the file to update additional nodes.

Procedure

To start the Installation Manager and provide the command to install using a
response file, do one of the following tasks, based on your operating system and
Installation Manager setup:
v Go to the IM_<operating_system> folder and use one of the following

commands, if Installation Manager is not installed and you are using the
Installation Manager agent provided with V5.2.6, if you installed a 64-bit
Installation Manager, or if you have the Installation Manager installed on a
platform that has only one download available for Installation Manager. For
example, AIX, Solaris, HP, zLinux, or Windows:
– ./userinstc input <response_file> -acceptLicense -log <log_file> (AIX,

Solaris, HP, zLinux)
– userinstc.exe input <response_file> -acceptLicense -log <log_file>

(Windows)
For example, on an AIX system, if the response file is located at /response_files
and if you want to save the log file in /mylog, type ./userinstc input
/response_files/install.xml -acceptLicense -log /mylog/install_log.xml
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v Go to the <installation directory>/Installation Manager/eclipse/tools (for
Windows systems, change / to \), and use one of the following commands
based on your operating system, if you have a 32-bit Installation Manager
installed on a Linux or Windows system:
– ./imcl input response_file -acceptLicense -log log_file (Linux)
– imcl.exe input response_file -acceptLicense -log log_file (Windows)
For example, on a Linux system, if the response file is located at
/response_files and if you want to save the log file in /mylog, type ./imcl
input /response_files/install.xml -acceptLicense -log /mylog/
install_log.xml

Converting Sterling B2B Integrator .txt silent file to XML
(V5.2.6 or later)

You must convert your .txt silent file to XML file in a format that can be used for
installing with Installation Manager, to install or upgrade to Sterling B2B Integrator
using the response file method if you want to reuse the contents of the .txt silent
file.

Before you begin

You must have the silent file that was used to install your current Sterling B2B
Integrator.

About this task

You can install or upgrade to Sterling B2B Integrator V5.2.6 using the user interface
or the response file method. To install using a response file, the file must be in an
XML format that can be used for installing with Installation Manager. You cannot
use the .txt silent files, as the Installation Manager does not support it. Instead of
re-creating the silent file in XML file, you can convert your existing .txt silent file
to XML file, by using the SilentFileToXml utility. The utility is packaged with
Sterling B2B Integrator.

To convert a .txt silent file to an XML file by using the SilentFileToXml utility:

Procedure
1. Go to the folder where you downloaded the latest version of Sterling B2B

Integrator.
2. Extract the compressed media file.
3. Open the ResponseFiles > SilentInstallationFileConverter folder and the

extract the SilentFileToXml.zip file. The following contents are extracted:

plugins
A folder which contains libraries that are required by the utility.

SilentFileToXml.jar
The utility JAR file.

SilentFileToXml_README.txt
A readme file with information and details about the utility.

Important: The plugins folder and the JAR file must be in the same directory,
at the same level.

4. Open a command prompt.
5. Type the following command to run the JAR file in the following format:
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java -jar SilentFileToXml.jar <input-properties-file> <output-xml-file>

v <input-properties-file> is the file to be converted from the .txt format to
XML.

v <output-xml-file> is the new file in the XML format

For more information, see the examples.

Example

java -jar SilentFileToXml.jar silent525install.txt silent526install.xml

java -jar SilentFileToXml.jar /home/user/installationFiles/
silent5242install.properties /home/user/installDirectory/
silent526install.xml

What to do next

After running the utility, the XML file that is created might not have all the entries
that are required to upgrade Sterling B2B Integrator to the latest version. Therefore,
you must manually add the new entries to the XML file.

Following is a list of the entries that must be added or modified in the XML file:

repository location
Set this to the absolute path of the Sterling B2B Integrator repository that is
extracted from Common_Repo.zip.

Variable sharedLocation
Set this to the absolute path of the IBMIMShared directory. It typically is in a
path of the following form: /home/your-username/IBM/IBMIMShared/

Data key user.CLUSTER_NODE_NUM
If you are installing node 2 or higher of a clustered Sterling B2B Integrator
system, enter in the cluster node number to this property. If you are not,
this value can be left blank.

Data keys cic.selector.os, cic.selector.arch, and cic.selector.ws
For information to determine correct values for these entries, see
Command-line arguments for the imcl command.

It is not required to modify the properties that are given by <preference
name=...>, nor any <data key=...> property not given in the above list.

To include additional features such as Sterling File Gateway, EBICS, and B2B
Advanced Communications integration module, add the features to the list of
features to install in the <offering profile=..."> section. For example,
features=’main.feature,filegateway.feature,fips.feature,as2.feature,
financial.feature,ebics.feature,meigIntegration.feature’

Important: The meigIntegration.feature corresponds to B2B Advanced
Communications bridge component for Sterling B2B Integrator.

For more information about the standard response files, file format, and additional
features, see “Sample response files (V5.2.6 or later)” on page 618.

The following parameters must be encrypted (and their original values are
encrypted by the utility by default):
v user.sb.DB_PASS

624 Installing and upgrading (V5.2.6 or later):

http://www-01.ibm.com/support/knowledgecenter/SSDV2W_1.8.2/com.ibm.cic.commandline.doc/topics/r_tools_imcl.html


v user.sb.APSERVER_PASS

v user.confirmPassphrase

v user.dbconfirmPassword

If you modify the passphrase in the new file, password encryption can be done
with the following command:
-bash-3.2$ ./imutilsc encryptString Password
NnO7aEXCW36ozr3feBXWTQ==
-bash-3.2$ pwd
/fullpath/IBM/InstallationManager/eclipse/tools

For more information about passphrase encryption, see Installation Manager
command-line arguments for silent mode.

Applying a Fix Pack (V5.2.6 or later)
A cumulative collection of fixes that is released between scheduled refresh packs,
manufacturing refreshes, or releases. A fix pack updates the system to a specific
maintenance level.

Important: To install or update to Sterling B2B Integrator V5.2.6, you must use
IBM Installation Manager. You can use the silent mode or the graphical user
interface mode to install or update to Sterling B2B Integrator V5.2.6 and later
versions. InstallService remains enabled for a very limited number of special
situations. Use installService only as directed by specific documentation or on
advice of customer support. One specific scenario where you must use
InstallService is to install Sterling File Gateway if you had not installed it when
installing Sterling B2B Integrator. For information about installing Sterling File
Gateway by using InstallService, see Installing Sterling File Gateway (2.2.2 and
higher). For more information about Sterling File Gateway V2.2.6 installation
changes, see Using Installation Manager to install Sterling File Gateway.

Information about the fix pack installation is automatically logged to
/install_dir/install/logs/InstallService.log.

To roll back a fix pack, see the “Fix Pack Changes Report” on page 309 topic.

Important: Use the fix pack installation information in this section to install or
apply fix packs to Sterling B2B Integrator nodes on Windows and Linux/UNIX
operating systems by using the user interface. For information about fix pack
installation for iSeries, see appropriate topics in iSeries installation and upgrade
sections.

For information to install a fix pack with a response file, see “Installing or
updating with a response file (V5.2.6 or later)” on page 621.

Preserving custom changes
When updating (applying a fix pack or interim fix or upgrading from one version
to another) your Sterling B2B Integrator installation, you must preserve the
customization of the system resources, property files, and cdinterop files.
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Preserving system resource customization

Customization of some system resources such as, workflow definitions and maps
are preserved during a fix pack, interim fix, or media upgrade (from one version to
another, for example, 5.1.x to 5.2.x).

When you install Sterling B2B Integrator, a baseline record of the system resources
is created. This baseline record is not affected by any customization from the
customers. When you install a fix pack, interim fix, or upgrade your Sterling B2B
Integrator installation, the resources in this baseline are compared with the
resources in the existing system. If a baseline and existing resource are not the
same, it means that the existing resource was customized and is not overwritten
during the update.

During the fix pack, interim fix, or upgrade, the baseline record is updated with
new system resource information, specific to the update. However, it is not
updated with information about the customized resources.

Preserving property file customization

Property changes made directly in *.properties or *.properties.in files are
overwritten when applying the fix pack or interim fix. Properties that are
overridden using the customer_overrides.properties file are not affected. It is
suggested to maintain property file changes using (when possible) the
customer_overrides.properties file.

If you edited any of the cdinterop files, you must back them up before applying
the fix pack. The cdinterop files do not have initialization ( *.in ) files. After
applying the fix pack, use the backup version of the files in your upgraded
installation. Following is a list of cdinterop files:
v cdinterop-proxy-records.properties

v cdinterop-spoe-auth.properties

v cdinterop-spoe-policy.properties

v cdinterop-user-records.properties

Important: The fix pack installation might use one or more property override files.
These files are named propertyFile_patch.properties. Do not alter these files.

Applying Sterling B2B Integrator V5.2.6 or later Fix Pack to
V5.2.x

Update your Sterling B2B Integrator V5.2.x clustered or non-clustered installation
to V5.2.6 or later.

Before you begin

Complete the following tasks before you update Sterling B2B Integrator V5.2.x to
V5.2.6 or later:
v Ensure that a supported version of the IBM JDK is installed. For required

version information, see Prerequisites > Java in the Detailed System
Requirements for your operating system. If you need to upgrade your JDK, see
Upgrading your JDK for instructions.

Important: Using an incorrect JDK can cause installation failure.
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Remember: You must install the IBM JDK on the system in a location other than
the Sterling B2B Integrator installation directory. The required JDK version is
provided with the Sterling B2B Integrator V5.2.6 or later media. You can use the
JDK provided or install the JDK from any other relevant source. Ensure that the
JDK version is the same or greater than the one provided with the Sterling B2B
Integrator V5.2.6 or later media.

v Download the latest fix pack image from IBM Fix Central or IBM Passport
Advantage.

v Extract the package to a folder, go to the media directory, and locate the
following files:
– IM_<operating system>.zip in the InstallationManager folder
– Common_Repo.zip

v Extract the files to a common directory. After you extract the files, the directory
must have the following subdirectories:
– IM_<operating system>

– b2birepo

– gmrepo

v For Linux servers, set the ulimit and language as follows:
– ulimit -n 4096

– ulimit -u 16000

– export LANG=en_US

About this task

Installation Manager V1.8.2 is required to install or update to Sterling B2B
Integrator V5.2.6. You can update to V5.2.6 through the user interface or silent
installation mode (response files), as console mode is not supported from V5.2.6
and later. Also, from V5.2.6 onwards, Sterling B2B Integrator JAR file is included in
the repository. Therefore it is not required to manually select the appropriate JAR
file.

You can install the fix pack to one node at a time or bring down the entire cluster.
Installing the fix pack to one node at a time, does not impact the functioning of the
cluster, thereby avoiding any interruption to the transactions and trading partners.
Whereas, if you stop the complete cluster, there will be some downtime during
which the transactions cannot be processed. You must decide the type of update
based on your requirement and considering the type of update in the fix pack. For
example, if the fix pack contains updates to the database or database schema, then
you must bring down all the nodes (the complete cluster), apply the fix pack, and
restart the cluster.

Important: If the fix pack contains updates to the database schema, then you must
create a backup of the current database before applying the fix pack. If for some
reason the update is interrupted or stopped midway, you must manually revert the
database changes by using the backup, and then restart fix pack installation. Refer
to the fix pack release notes for details about the updates contained in the fix pack.

To apply Sterling B2B Integrator V5.2.6 fix pack to Sterling B2B Integrator V5.2.x
by using the user interface:

Important: The following procedure can be used for Unix/Linux and Windows
operating systems.
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In addition to installing a fix pack through the user interface, you can install it by
using a script provided with V5.2.6 or through silent installation mode. For more
information, see “Applying Sterling B2B Integrator V5.2.6 Fix Pack using a script”
on page 630 and “Installing or updating with a response file (V5.2.6 or later)” on
page 28.

For information to install a fix pack with a response file, see “Installing or
updating with a response file (V5.2.6 or later)” on page 621.

Procedure
1. Verify that the Sterling B2B Integrator database is up and ready to accept

connections.
2. Based on whether you are stopping a single node or all the nodes (cluster), do

one of the following tasks:
v To stop a single node, go to the \<install_dir>\install\bin (Windows) or

/<install_dir>/install/bin (UNIX or Linux) directory, open a command
prompt and enter the StopWindowsService.cmd (Windows) or ./hardstop.sh
(UNIX or Linux) command. Wait until the perimeter server of the node is
down before installing the fix pack.

v To stop the cluster, open the Sterling B2B Integrator user interface
(dashboard), and complete the following tasks:
– From the Administration menu, select Operations > System >

Troubleshooting.
– Click Stop the System.

3. Perform a full backup of the Sterling B2B Integrator installation directory,
including all subdirectories.

Important: If for some reason the update is interrupted or stopped midway,
you must manually revert the changes by using the backed up files, and then
restart fix pack installation.

4. Perform a backup of the database.
5. If you edited any property files, ensure that the associated properties.in files

have the most current changes. Property files are overwritten with the
contents of the associated properties.in files during fix pack installation.

6. Go to the directory where you extracted the IM_<operating system>.zip file.
7. Open a command prompt and do one of the following tasks to start the

Installation Manager:
a. Go to the IM_<operating_system> directory and type ./userinst or

userinst.exe (Windows) for the following scenarios:
v If you do not have the Installation Manager installed and are using the

Installation Manager agent provided with V5.2.6.
v If you have a 64-bit Installation Manager installed.
v If you have the Installation Manager installed on a platform that has

only one download available for Installation Manager. For example, AIX,
Solaris, HP, zLinux.

b. Go to <installation directory>/Installation Manager/eclipse (for
Windows system, replace / with \) and type ./IBMIM or IBMIM.exe
(Windows), if you have 32-bit Installation Manager installed on a Linux or
Windows system.

8. Follow the prompt to install Installation Manager 1.8.2 and restart the
Installation Manager by using the Restart button or by using the command
that you used to start the Installation Manager.
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Important: If Installation Manager version lesser than V1.8.2 is installed on
the server, the installer detects this and prompts for the upgrade.

9. To update to Sterling B2B Integrator V5.2.6, complete the following steps:
10. If you used Installation Manager to install your current Sterling B2B Integrator

version, then click Update on the Installation Manager home page. Else, click
Install and make sure to select the current installation directory to update to
V5.2.6.
If you did not use Installation Manager to install the current Sterling B2B
Integrator, the Installation Manager does not know that the product is already
installed and does not have the information that it needs to know about it for
Installation Manager to run the update flow. Therefore, you must select the
Install option and select the current installation directory to install V5.2.6 fix
pack. It is a limitation of the Installation Manager.

11. Select Sterling B2B Integrator and click Next.
12. Verify that Version 5.2.6.0 is selected and click Next.
13. Read and accept the license terms and click Next.
14. Select the features to install and click Next.

Important: If your current Sterling B2B Integrator installation includes
Sterling B2B Integrator and you select Sterling File Gateway, then Sterling File
Gateway is updated to V 2.2.6. However, if Sterling File Gateway was not
installed, it is not updated, even if you select the IBM Sterling File Gateway.
In this case, to install Sterling File Gateway, when applying V5.2.6 fix pack,
you must do one of the following tasks:
v If upgrading from V5.1.x to Sterling B2B Integrator V5.2.6, install Sterling

B2B Integrator to a new directory, and point to the previous database.
v Run the InstallService.sh or InstallService.cmd command. For more

information, see Installing Sterling File Gateway (V2.2.6 or later).

Important: Features that are not part of your current Sterling B2B Integrator
installation are disabled and you cannot select them when upgrading or
applying a fix pack. To include them in your Sterling B2B Integrator setup,
you must first upgrade to the current version, and then install them
separately. If the fix pack or upgrade JAR includes updates to features that are
part of your current Sterling B2B Integrator installation, the features are
upgraded regardless of whether you select the them or not.

15. Verify the JDK directory and click Next.

Important: The JDK specified here cannot be the jdk sub-directory in the
Sterling B2B Integrator installation directory. Selecting the jdk sub-directory in
the Sterling B2B Integrator installation directory might corrupt the JDK.

16. Verify the JCE policy file and click Next.
17. Type the system passphrase, confirm the passphrase, and click Next.
18. Verify the update details and click Update.
19. Click Finish to complete updating to Sterling B2B Integrator V5.2.6.
20. Repeat the steps for each node.

Attention: For node 2 and higher, you must update the value of REINIT_DB
to false. When REINIT_DB is false, database updates are not applied during
each fix pack. The REINIT_DB attribute is in the \<install_dir>\install\
properties\sandbox.cfg file.

21. If you stopped the Sterling B2B Integrator cluster, restart the cluster.
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Applying Sterling B2B Integrator V5.2.6 Fix Pack using a
script

In Sterling B2B Integrator V5.2.6 or later, a script that can be used to install the fix
pack is provided with the media.

Before you begin

Complete the following tasks before you update Sterling B2B Integrator V5.2.x to
V5.2.6 or later:
v Ensure that a supported version of the IBM JDK is installed. For required

version information, see Prerequisites > Java in the Detailed System
Requirements for your operating system. If you need to upgrade your JDK, see
Upgrading your JDK for instructions.

Important: Using an incorrect JDK can cause installation failure.

Remember: You must install the IBM JDK on the system in a location other than
the Sterling B2B Integrator installation directory. The required JDK version is
provided with the Sterling B2B Integrator V5.2.6 or later media. You can use the
JDK provided or install the JDK from any other relevant source. Ensure that the
JDK version is the same or greater than the one provided with the Sterling B2B
Integrator V5.2.6 or later media.

v Download the latest fix pack image from IBM Fix Central or IBM Passport
Advantage.

v Extract the package to a folder, go to the media directory, and locate the
following files:
– IM_<operating system>.zip in the InstallationManager folder
– Common_Repo.zip

v Extract the files to a common directory. After you extract the files, the directory
must have the following subdirectories:
– IM_<operating system>

– b2birepo

– gmrepo

v For Linux servers, set the ulimit and language as follows:
– ulimit -n 4096

– ulimit -u 16000

– export LANG=en_US

About this task

Restriction: You cannot use the script for the following installation scenarios:
v If you installed or updated your existing Sterling B2B Integrator by using the

Installation Manager.
v If you currently have a 32-bit version of the Installation Manager installed on

your Linux system that is not running on IBM z Systems.
v To install the fix pack in a Windows operating system.
v To install Global Mailbox.
v To install the fix pack on more than one Sterling B2B Integrator per machine.

The script installs or updates Installation Manager V1.8.2, updates Sterling B2B
Integrator V5.2.1 or higher to V5.2.6 by populating necessary update parameters in
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a silent response XML file (update.xml), and invokes Installation Managers silent
installation mode by using the populated silent response XML as the input.

Using the script to apply fix pack is another option. It does not replace the existing
options of applying the fix pack through Installation Manager user interface or by
using a manually modified response file. You can choose the method to apply the
fix pack based on your requirements and convenience.

The script is supported on the following operating systems:
v Linux, on the following hardware:

– x86-64
– IBM z Systems

v Solaris
v AIX
v HP-UX

To use the fix pack script to apply Sterling B2B Integrator V5.2.6 patch:

Procedure
1. Download the Sterling B2B Integrator V5.2.6 fix pack from IBM Fix Central or

IBM Passport Advantage.
2. Decompress the Media_IM_5020600.zip.

Important: Do not decompress the Common_Repo.zip or IM_<OS>.zip files. The
script decompresses the compressed files when it runs.

3. Run the following command from the UpdateScript/ directory $ update.sh
<full_path_to_b2bi_install_dir> <ProfileID> -acceptLicenses
<system_passphrase>

Important: system_passphrase is an optional parameter used to specify the
system passphrase, which must be set if the system passphrase is not stored in
a property file.

Applying a Fix Pack to Sterling B2B Integrator V5.2.6 or later
Update Sterling B2B Integrator V5.2.6 or later clustered or non-clustered
installation with a fix pack.

Before you begin

Complete the following tasks before you apply a fix pack to your V5.2.6 or later
installation:
v Ensure that a supported version of the IBM JDK is installed. For required

version information, see Prerequisites > Java in the Detailed System
Requirements for your operating system. If you need to upgrade your JDK, see
Upgrading your JDK for instructions.

Important: Using an incorrect JDK can cause installation failure.

Remember: You must install the IBM JDK on the system in a location other than
the Sterling B2B Integrator installation directory. The required JDK version is
provided with the Sterling B2B Integrator V5.2.6 or later media. You can use the
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JDK provided or install the JDK from any other relevant source. Ensure that the
JDK version is the same or greater than the one provided with the Sterling B2B
Integrator V5.2.6 or later media.

v Download the latest fix pack image from IBM Fix Central or IBM Passport
Advantage.

v Extract the package to a folder, go to the media directory and locate the
following files:
– IM_<operating system>.zip in the InstallationManager folder
– Common_Repo.zip

v Extract the files to a common directory. After you extract the files, the directory
must have the following subdirectories:
– IM_<operating system>

– b2birepo

– gmrepo

v For Linux servers, set the ulimit and language as follows:
– ulimit -n 4096

– ulimit -u 16000

– export LANG=en_US

About this task

You can install the fix pack to one node at a time or bring down the entire cluster.
Installing the fix pack to one node at a time, does not impact the functioning of the
cluster, thereby avoiding any interruption to the transactions and trading partners.
Whereas, if you stop the complete cluster, there will be some downtime during
which the transactions cannot be processed. You must decide the type of update
based on your requirement and considering the update in the fix pack. For
example, if the fix pack contains updates to the database or database schema, then
you must bring down all the nodes (the complete cluster), apply the fix pack, and
restart the cluster.

Important: If the fix pack contains updates to the database schema, then you must
create a backup of the current database before applying the fix pack. If for some
reason the update is interrupted or stopped midway, you must manually revert the
database changes by using the backup, and then restart fix pack installation.

To install a fix pack to Sterling B2B Integrator V5.2.6 or later installation by using
the user interface:

Important: For information to install a fix pack with a response file, see “Installing
or updating with a response file (V5.2.6 or later)” on page 621.

Procedure
1. Verify that the Sterling B2B Integrator database is up and ready to accept

connections.
2. Based on whether you are stopping a single node or all the nodes (cluster), do

one of the following tasks:
v To stop a single node, go to the \<install_dir>\install\bin (Windows) or

/<install_dir>/install/bin (UNIX or Linux) directory, open a command
prompt and enter the StopWindowsService.cmd (Windows) or ./hardstop.sh
(UNIX or Linux) command. Wait until the perimeter server of the node is
completely down before installing the fix pack.
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v To stop the cluster, open the Sterling B2B Integrator user interface
(dashboard), and complete the following tasks:
– From the Administration menu, select Operations > System >

Troubleshooting.
– Click Stop the System.

3. Perform a full backup of the Sterling B2B Integrator installation directory,
including all subdirectories.

Important: If for some reason the update is interrupted or stopped midway,
you must manually revert the changes by using the backed up files, and then
restart fix pack installation.

4. Perform a back up of the database.
5. If you edited any property files, ensure that the associated properties.in files

have the most current changes. Property files are overwritten with the
contents of the associated properties.in files during the fix pack installation.

6. Is the database password encrypted? If Yes, decrypt the password.
7. Close all command prompt windows.
8. Open a command prompt and do one of the following tasks to start the

Installation Manager:
a. Go to the IM_<operating_system> directory and type ./userinst or

userinst.exe (Windows) for the following scenarios:
v If you do not have the Installation Manager installed and are using the

Installation Manager agent provided with V5.2.6.
v If you have a 64-bit Installation Manager installed.
v If you have the Installation Manager installed on a platform that has

only one download available for Installation Manager. For example, AIX,
Solaris, HP, zLinux.

b. Go to <installation directory>/Installation Manager/eclipse (for
Windows system, replace / with \) and type ./IBMIM or IBMIM.exe
(Windows), if you have 32-bit Installation Manager installed on a Linux or
Windows system.

9. On the Installation Manager home page, click File > Preferences > Add
Repository.

Tip: By default, IBM Installation Manager will attempt to connect to the
internet. If the server does not have internet access, this behavior can be
modified by disabling the Search service repositories during installation and
updates option in the preferences while adding the repository. After adding
the repository, reenable the option.

10. Click Browse and select the updated repository.config file in the b2birepo
folder. The repository file is located at
<directory_where_Common_Repo.zip_was_extracted>/b2birepo/
repository.config.

11. On the Installation Manager home page, click Update.
12. On the Update Packages page, Sterling B2B Integrator and Global Mailbox

options are displayed. Select Sterling B2B Integrator and select Update all
packages with recommended updates and recommended fixes and click
Next. Wait for the installer to read the updates and resolve references. You can
also see information about the installed packages and installation directory on
the page.
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13. The packages to be updated are selected by default. Verify the selection, and
click Next.
If there are more than one updates in the repository, the latest update is
displayed if you select the Show recommended only option. You can select
the recommended repository by using the Select Recommended option.

14. The features and applications (Sterling B2B Integrator) that must be updated
are selected by default. Verify the selection and click Next.
To see if the current installation or update has any dependencies or
prerequisites, select the Show dependencies check box.

15. Verify the JDK directory and click Next.

Important: The JDK specified here cannot be the jdk sub-directory in the
Sterling B2B Integrator installation directory. Selecting the jdk sub-directory in
the Sterling B2B Integrator installation directory might corrupt the JDK.

16. Verify the JCE policy file and click Next.
17. Type the system passphrase, confirm the passphrase, and click Next.
18. Review the summary information about the updates and click Update.

Important: You cannot install or remove any of the features listed on this
page. However, if you select any feature that was not part of the original
installation, an appropriate error message is displayed indicating the same.

19. Notice the progress of the update and click Finish after the update completes.
20. Repeat the steps for other Sterling B2B Integrator nodes.

Attention: For node 2 and higher, you must update the value of REINIT_DB
to false. When REINIT_DB is false, database updates are not applied during
each fix pack. The REINIT_DB attribute is in the \<install_dir>\install\
properties\ sandbox.cfg file.

21. If you stopped the Sterling B2B Integrator cluster, restart the cluster.

What to do next

To verify the fix pack installation, go to the Rollback panel and check that the
appropriate version number is displayed. For example, if the fix pack contained
updates to Global Mailbox, then the version must show as 1.0.0.1.

Fix Pack Changes Report
The Fix Pack Changes Report is used to obtain information if you need to roll back
a fix pack.

The fix pack report can be found in the installation directory fix pack_reports
folder. The report contains the following fix pack information:
v Fix pack ID
v Fix pack changes
v Number of files deleted
v Number of JAR files removed
v Number of JAR files added
v Number of files added
v Number of files changed
v Number of properties added
v Number of business processes added
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v Number of service instances added
v Number of service definitions added
v Number of templates added
v Number of reports added
v Number of maps added
v Number of schemas added
v Number of business rules added

For example, the installation directory fix pack_reports folder contains the fix
pack_Report.html file. When you open this file, you can view the fix pack
information.

Applying an interim fix (V5.2.6 or later)
A cumulative collection of fixes that is released between scheduled refresh packs,
manufacturing refreshes, or releases. An interim fix updates the system to a
specific maintenance level.

Important: To apply interim fix to Sterling B2B Integrator V5.2.6 and higher
versions, you must use IBM Installation ManagerV1.8.2. You can use the silent
mode or the graphical user interface mode to apply the interim fix. InstallService
remains enabled for a very limited number of special situations. Use
InstallService only as directed by specific documentation or on advice of
customer support. One specific scenario where you must use InstallService is to
install Sterling File Gateway if you had not installed it when installing Sterling B2B
Integrator. For information about installing Sterling File Gateway by using
InstallService, see Installing Sterling File Gateway (2.2.2 and higher). For more
information about Sterling File Gateway V2.2.6 installation changes, see Using
Installation Manager to install Sterling File Gateway.

Uninstalling an interim fix is a complex and manual process. To uninstall an
interim fix, contact IBM Support by creating a Problem Management Record
(PMR).

Important: Use the interim fix installation information in this section to install or
apply interim fixes to Sterling B2B Integrator nodes on Windows and Linux/UNIX
operating systems. For information about interim fix installation for iSeries, see
appropriate topics in iSeries installation and upgrade sections.

For information to install a fix pack with a response file, see “Installing or
updating with a response file (V5.2.6 or later)” on page 621.

Preserving custom changes
When updating (apply a fix pack or interim fix or upgrade from one version to
another) your Sterling B2B Integrator installation, you must preserve the
customization of the system resources, property files, cdinterop files.

Preserving system resource customization

Customization of some system resources such as, workflow definitions and maps
are preserved during a fix pack, interim fix, or media upgrade (from one version to
another, for example, 5.1.x to 5.2.x).
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When you install Sterling B2B Integrator, a baseline record of the system resources
is created. This baseline record is not affected by any customization from the
customers. When you install a fix pack, interim fix, or upgrade your Sterling B2B
Integrator installation, the resources in this baseline are compared with the
resources in the existing system. If a baseline and existing resource are not the
same, it means that the existing resource was customized and is not overwritten
during the update.

During the fix pack, interim fix, or upgrade, the baseline record is updated with
new system resource information, specific to the update. However, it is not
updated with information about the customized resources.

Preserving property file customization

Property changes made directly in *.properties or *.properties.in files are
overwritten when applying the fix pack or interim fix. Properties that are
overridden using the customer_overrides.properties file are not affected. It is
suggested to maintain property file changes using (when possible) the
customer_overrides.properties file.

If you edited any of the cdinterop files, you must back them up before applying
the fix pack. The cdinterop files do not have initialization ( *.in ) files. After
applying the fix pack, use the backup version of the files in your upgraded
installation. These files include the following files:
v cdinterop-proxy-records.properties

v cdinterop-spoe-auth.properties

v cdinterop-spoe-policy.properties

v cdinterop-user-records.properties

Important: The fix pack installation might use one or more property override files.
These files are named propertyFile_patch.properties. Do not alter these files.

Installing an Interim Fix
Update your Sterling B2B Integrator V5.2.6 clustered or non-clustered installation
with an interim fix.

Before you begin

Complete the following tasks before you apply an interim fix to V5.2.6 installation:
v Download the latest interim fix image from IBM Fix Central.
v Extract the package to a folder, go to the media directory and locate the

following files:
– IM_<operating system>.zip in the InstallationManager folder
– Common_Repo.zip

v Extract the files to a common directory. After you extract the files, the directory
must have the following subdirectories:
– IM_<operating system>

– b2birepo

– gmrepo

v For Linux servers, set the ulimit and language as follows:
– ulimit -n 4096

– ulimit -u 16000
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– export LANG=en_US

About this task

You can install the interim fix to one node at a time or bring down the entire
cluster. Installing the interim fix to one node at a time, does not impact the
functioning of the cluster, thereby avoiding any interruption to the transactions
and trading partners. Whereas, if you stop the complete cluster, there will be some
downtime during which the transactions cannot be processed. You must decide the
type of update based on your requirement and considering the update in the
interim fix. For example, if the interim fix contains updates to the database or
database schema, then you must bring down all the nodes (the complete cluster),
apply the fix, and restart the cluster.

Important: If the interim fix contains updates to the database schema, then you
must create a backup of the current database before applying the interim fix. If for
some reason the update is interrupted or stopped midway, you must manually
revert the database changes by using the backup, and then restart interim fix
installation. Refer to the download document for details of fixes included in the
interim fix.

If Global Mailbox is installed, refer to the following information: Installing an
interim fix.

To install an interim fix to Sterling B2B Integrator V5.2.6 and higher by using the
user interface:

Important: For information to install a fix pack with a response file, see “Installing
or updating with a response file (V5.2.6 or later)” on page 621.

Procedure
1. Verify that the Sterling B2B Integrator database is up and ready to accept

connections.
2. Based on whether you are stopping a single node or all the nodes (cluster), do

one of the following tasks:
v To stop a single node, go to the \<install_dir>\install\bin (Windows) or

/<install_dir>/install/bin (UNIX or Linux) directory, open a command
prompt and enter the StopWindowsService.cmd (Windows) or ./hardstop.sh
(UNIX or Linux) command. Wait until the perimeter server of the node is
completely down before installing the interim fix.

v To stop the cluster, open the Sterling B2B Integrator user interface
(dashboard), and complete the following tasks:
– From the Administration menu, select Operations > System >

Troubleshooting.
– Click Stop the System.

3. Perform a full backup of the Sterling B2B Integrator installation directory,
including all subdirectories.

Important: If for some reason the update is interrupted or stopped midway,
you must manually revert the changes by using the backed up files, and then
restart interim fix installation.

4. Perform a back up of the database.
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5. If you edited any property files, ensure that the associated properties.in files
have the most current changes. Property files are overwritten with the
contents of the associated properties.in files during the interim fix
installation.

6. Is the database password encrypted? If Yes, decrypt the password.
7. Close all command prompt windows.
8. To start the Installation Manager and provide the path to the input file, type

<IIMInstallationDirectory>/eclipse/launcher -input
<pathToExtractedFixMedia>/fixInput.xml on the command line for Linux
servers or type <IIMInstallationDirectory>\eclipse\launcher -input
<pathToExtractedFixMedia>\fixInput.xml for Windows servers.

Important: You must install an interim fix by using an installed instance of
Installation Manager. Therefore, you must launch Installation Manager from
the <IIMInstallationDirectory>/eclipse/launcher directory and not from the
IM_<operatingsystem> directory.

9. On the Installation Manager home page, click Update.
10. On the Update Packages page all the installed packages are listed. Based on

the information from the release notes or interim fix notification, select the
package that must be updated and click Next. Alternatively, you can select
Update all packages with recommended updates and recommended fixes
and click Next. Wait for the installer to read the updates and resolve
references. You can also see information about the installed packages and
installation directory on the page.

11. The packages to be updated are selected by default. Verify the selection, and
click Next.
If there are more than one updates in the repository, the latest update is
displayed if you select the Show recommended only option. You can select
the recommended repository by using the Select Recommended option.

12. The features and applications (Sterling B2B Integrator) that must be updated
are selected by default. Verify the selection and click Next.
To see if the current installation or update has any dependencies or
pre-requisites, select the Show dependencies check box.

13. Review the summary information about the updates and click Update.

Important: You cannot install or remove any of the features listed on this
page. However, if you select any feature that was not part of the original
installation, an appropriate error message is displayed indicating the same.

14. Notice the progress of the update and click Finish after the update completes.
15. Repeat the steps for other Sterling B2B Integrator nodes.

Attention: For node 2 and higher, you must update the value of REINIT_DB
to false. When REINIT_DB is false, database updates are not applied during
each interim fix. The REINIT_DB attribute is in the \<install_dir>\install\
properties\sandbox.cfg file.

16. If you stopped the Sterling B2B Integrator cluster, restart the cluster.

What to do next

To verify the interim fix installation, go to the Rollback panel and check that the
appropriate version number is displayed.
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Notices

This information was developed for products and services offered in the US. This
material might be available from IBM in other languages. However, you may be
required to own a copy of the product or product version in that language in order
to access it.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of
express or implied warranties in certain transactions, therefore, this statement may
not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
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websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

The performance data and client examples cited are presented for illustrative
purposes only. Actual performance results may vary depending on specific
configurations and operating conditions.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBMproducts.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

Statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to actual people or business enterprises is entirely
coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
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IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work must
include a copyright notice as shown in the next column.

© 2015.
Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. 2015.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the web at "Copyright and
trademark information" at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.
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Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise®, Gentran®,
Gentran®:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce®, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.

Terms and conditions for product documentation
Permissions for the use of these publications are granted subject to the following
terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the IBM
website.

Personal use

You may reproduce these publications for your personal, noncommercial use
provided that all proprietary notices are preserved. You may not distribute, display
or make derivative work of these publications, or any portion thereof, without the
express consent of IBM.

Commercial use

You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make
derivative works of these publications, or reproduce, distribute or display these
publications or any portion thereof outside your enterprise, without the express
consent of IBM.

Rights

Except as expressly granted in this permission, no other permissions, licenses or
rights are granted, either express or implied, to the publications or any
information, data, software or other intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its
discretion, the use of the publications is detrimental to its interest or, as
determined by IBM, the above instructions are not being properly followed.

You may not download, export or re-export this information except in full
compliance with all applicable laws and regulations, including all United States
export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.
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